# Contents

1. Welcome to TIBCO WebFOCUS® ................................................................. 13

   Signing in to TIBCO WebFOCUS ............................................................. 13
   Navigating TIBCO WebFOCUS® Hub ...................................................... 15
      Banner ................................................................................................. 15
      Tools .................................................................................................... 16
      Help .................................................................................................... 17
      User Profile ......................................................................................... 17
   Home Area ............................................................................................... 18
   Workspaces Area ..................................................................................... 21
      Page Toolbar ......................................................................................... 21
      Resources Tree ....................................................................................... 25
      My Workspace ....................................................................................... 26
      Global Resources ................................................................................... 27
   Content Section ....................................................................................... 27
   Folder and Item Properties ...................................................................... 31
   Application Directories Area .................................................................... 37
   Portals Area ............................................................................................. 38
   Management Center Area ........................................................................ 39
   Search Content & Data Area ................................................................... 41
      Text Input Bar ....................................................................................... 43
      Search Filters ......................................................................................... 44
      Results Toolbar ...................................................................................... 45
      Results Section ....................................................................................... 46
      Indexing Content and Data ................................................................... 48
   Viewing the Hub on Mobile Devices ....................................................... 49
   Configuring and Using Your TIBCO WebFOCUS Environment ............. 52
      Creating New Workspaces and Folders .................................................. 52
      Dragging and Dropping Folders and Files .............................................. 54
      Dragging Indicators ................................................................................ 55
      Dropping Indicators ............................................................................... 55
   Adding Content to Favorites .................................................................... 55
   Adding Thumbnails to Content Items ...................................................... 56
Using TIBCO WebFOCUS Mobile App to View In-Document Analytics Reports............. 106

2. Accessing Data .................................................................................................................. 109
   Preparing Spreadsheets for Upload .................................................................................... 109
   Uploading Data Files ......................................................................................................... 114
     Changing A Target Connection When Uploading Files.................................................... 117
     Changing A Target Application When Uploading Files.................................................. 119
     Choosing Columns to Load When Uploading Files............................................................ 121
     Processing Format Conversion Errors when Uploading Data............................................ 122
   Pivoting Data ...................................................................................................................... 125
     Pivot Columns with Date Headers....................................................................................... 127
   Connecting to Data Files .................................................................................................... 128
   Joining Data ........................................................................................................................ 134
   Creating HOLD Files ......................................................................................................... 142
   Editing Metadata ................................................................................................................. 145
     Creating Folders................................................................................................................... 147
     Assigning DV Roles............................................................................................................ 149
   Preparing and Managing Data .............................................................................................. 150
   Extending Metadata With Reporting Objects ........................................................................ 153
     Reporting Object Tool ........................................................................................................ 153
       Running a Reporting Object From the Browser......................................................... 158
         Expected Behavior of Running a Reporting Object..................................................... 158
     Properties of a Reporting Object....................................................................................... 159
     Components of a Reporting Object.................................................................................. 159
     Preprocessing Other Component...................................................................................... 159
     Joins................................................................................................................................. 164
     Virtual Fields (DEFINE Statements).................................................................................. 165
     Filters................................................................................................................................. 168
     Selection Criteria (WHERE Statements)........................................................................... 171
     Report Component............................................................................................................ 171
     Chart Component............................................................................................................. 172
     Postprocessing Other Component.................................................................................... 173
   Changing Metadata Classification Values When Uploading Data Files.............................. 174
## 3. Visualizing Data

Navigating the TIBCO WebFOCUS Designer Interface ........................................... 202
  Using the Data Tab. .......................................................................................... 202
  Using the Visualization Tab. ........................................................................... 206
    Using the TIBCO WebFOCUS Designer Toolbar. .......................................... 207
    Using the Visualization Toolbar. .................................................................. 209
  Accessing Resources From the TIBCO WebFOCUS Designer Sidebar .................. 212
    Viewing the Structure of a Visualization. ...................................................... 213
    Accessing Fields and Variables. .................................................................... 215
  Adding Filters to Pages Assembled From External Content. ................................. 227
  Accessing Containers and Widgets. ................................................................... 229
  Adding Existing Content to a Visualization. .................................................... 230
  Adding Text and Buttons to a Control AreaAdding Controls, Buttons, and Labels to a Filter Cell. ................................................................. 233
  Generating Analytic Insights. .......................................................................... 235
  Modifying Object Properties. ........................................................................... 235
  Using the TIBCO WebFOCUS Designer Canvas. .............................................. 241
  Filtering a Visualization From the Filter Toolbar. ............................................. 244
  Changing Content Types. .................................................................................. 245

Navigating TIBCO WebFOCUS Designer With Keyboard Controls............................... 250

Basic Guidelines for Building Accessible Pages in WebFOCUS Designer ................. 251

Creating Content in TIBCO WebFOCUS Designer .................................................. 260

Selecting a Data Source ......................................................................................... 263

Configuring Sample Data Settings .......................................................................... 267

Creating Charts .................................................................................................. 268
  Creating Vertical Stacked Bar Charts. ............................................................... 270
  Creating Horizontal Bar Charts. ........................................................................ 274
  Creating Vertical Side-by-Side Bar Charts. ......................................................... 277
  Creating Ring Pie Charts. .................................................................................. 280
  Creating Absolute Line Charts. ......................................................................... 282
Creating Vertical Stacked Area Charts ............................................ 285
Creating Scatter/Bubble Charts .................................................. 287
Creating Circle Plot Charts ...................................................... 290
Creating Treemap Charts .......................................................... 293
Creating Matrix Marker Charts .................................................. 295
Creating Statistical Box Plot Charts .......................................... 298
Creating Multi-Layer Maps in TIBCO WebFOCUS Designer ............ 301
Creating Choropleth Maps in TIBCO WebFOCUS Designer .......... 306
Creating Bubble Maps in TIBCO WebFOCUS Designer .................. 309
Creating Data Grids ............................................................ 320
Creating Waterfall Charts ....................................................... 322
Creating Gauge Charts ........................................................... 325
Creating Funnel Charts ........................................................... 328
Creating Mekko Charts ........................................................... 331
Creating Tag Clouds .................................................................. 333
Creating Streamgraphs .............................................................. 335
Creating Charts Using a Chart Extension ..................................... 337
Displaying Measure Values in Charts ......................................... 342
Formatting Charts .............................................................. 345
  Customizing Charts ............................................................ 345
  Controlling Font Display in a Chart ........................................... 349
  Adding Headings and Footings to a Chart ................................. 352
  Formatting Legends in a Chart ............................................... 357
  Using Axis Options in a Chart ................................................. 360
    Controlling the Display of Time-Based Axes .......................... 366
  Formatting Series in a Chart .................................................. 369
  Formatting Matrix Charts ...................................................... 381
  Formatting Box Plots ........................................................... 383
  Formatting Data Grid Charts ................................................. 386
  Customizing a Gauge Chart ................................................... 392
  Adding a Theme to a Chart ................................................... 393
  Adding Color to Charts ....................................................... 399
  Changing the Size of Charts and Risers .................................... 410
Setting General and Columnar Report Properties .................................................. 552
Applying Themes to Reports ........................................................................... 552
Formatting Text in a Report ........................................................................ 553
Formatting Cells in a Report ........................................................................ 554
Controlling Column Width .......................................................................... 557
Adding Margins to Report Headings and Footings ............................................. 558
Formatting Column Group Labels in a Report .................................................. 558
Styling Column and Row Totals in a Report ...................................................... 559
Setting Page Layout Options ......................................................................... 560
Converting Reports to Excel Tables ................................................................. 562
Adding Filters to a Visualization ................................................................. 564
Adding Static Filters to Content .................................................................. 566
Adding Prompted Filters to a Visualization ..................................................... 574
Filtering a Chart with Visual Selections ....................................................... 580
Chaining Filter Control Selections .................................................................. 583
Applying Prompted Filters From External Content .......................................... 587
Filtering Large and Streaming Data Sources ................................................. 594
Summarizing Numeric Data Using Filters .................................................... 598
Working With Required Parameters .............................................................. 604
Working With Single and Multiple Select Lists ............................................. 605
   Working With Double List Controls ......................................................... 609
   Working With Toggle Controls .................................................................. 612
Working With Slider Controls on a Page ....................................................... 616
Working With Date Controls ....................................................................... 621
   Setting Time Rangesa Time Zone in Date-Time Controls ......................... 624
Styling Filter Controls in a Visualization ....................................................... 631
Choosing an Event Model for Your Page Filter .............................................. 639
Using Global Name to Synchronize Filter Controls ......................................... 642
Bookmarking Control Selections in a Page .................................................... 645
Setting Dynamic Default Values for Filter Controls ..................................... 647
Adding Headers and Footers to Content ....................................................... 654
Setting Conditional Styling Based on Data Values ......................................... 659
Changing a Field Format ............................................................................. 663
4. Organizing Content Into Pages ............................................................ 783

Creating Pages ................................................................................... 784
Styling Pages .................................................................................... 788
  Working With Content Containers.................................................. 788
  Resizing Content on a Page.............................................................. 792
  Editing Page, Section, and Container Properties............................ 792
  Hiding Content From Devices.......................................................... 796
  Automatically Advancing Slides in a Carousel Container............... 799
  Applying Themes and Styles to Pages.............................................. 800
  Customizing Default Styling Options for Assembled Page Filters..... 805
  Applying Custom CSS and JavaScript Code to a Page...................... 809
5. Building Portal Applications ........................................... 873
   Creating Portals .......................................................... 874
   Defining a Portal Structure .......................................... 879
   Running Portals ......................................................... 882
   Targeting a Page to Open When Running a Portal .......... 884
   Enabling and Sharing Personal Pages .............................. 888
   Customizing Portals .................................................... 890
   Applying Themes to Portals ........................................... 891
   Adding Icons to Portal Levels ....................................... 894
   Customising User Menu Options .................................... 897
   Using a JavaScript Function to Navigate to a Designer Portal Page ........................ 899
      Stage One: Creating Parameterized Content. .................. 899
Stage Two: Setting Up a Portal for the Hyperlinks ........................................... 901
Stage Three: Creating Hyperlinks in a Source Report ..................................... 901
Stage Four: Add the Source Report to a Page in the Portal ............................... 904
Stage Five: Finalize the Configuration of the JavaScript Function ....................... 905

Configuring Dynamically Customized Designer Portals for Multiple SaaS Tenant Groups ...... 906
Understanding the Configuration Requirements for Designer Portals That Use Multiple
Themes or Logos ............................................................................................................. 908
Assigning Customized Logos to Tenant Workspaces for Designer Portals .................... 910
Creating Tenant-Specific Theme CSS Files for Designer Portals ............................... 911
Creating Tenant-Specific Designer Portal Pages ....................................................... 912
Creating a Centralized Designer Portal for Common Use ........................................... 915
Adding Tenant-Specific Portal Pages to the Centralized Designer Portal ..................... 917
Publishing Content ......................................................................................................... 918
Testing the Designer Portal User Experience ............................................................. 918

Configuring Dynamically Customized Collaborative Portals for Multiple SaaS Tenant Groups . . .918
Assigning Customized Logos to Tenant Workspaces .................................................. 921
Creating Tenant-Specific Theme CSS Files ................................................................. 923
Creating Tenant-Specific Portal Pages ........................................................................ 925
Creating a Centralized Portal for Common Use ........................................................... 926
Adding Tenant-Specific Portal Pages to the Centralized Portal ..................................... 927
Publishing Content ......................................................................................................... 928
Testing the Portal User Experience .............................................................................. 928

6. Scheduling and Distributing Content ................................................................. 931
Creating Event-based Schedules ................................................................................... 931
Alert Reporting .............................................................................................................. 931
Components of an Alert ................................................................................................. 932
Alert Assist Overview ..................................................................................................... 938
The Life of an Alert ........................................................................................................ 942
Creating and Scheduling an Alert .................................................................................. 944
Checking Scheduled Alerts .......................................................................................... 950

Legal and Third-Party Notices ..................................................................................... 951
Welcome to TIBCO WebFOCUS®

WebFOCUS® is the reporting engine that turns corporate data into meaningful information. It enables any executive, manager, analyst, employee, partner, or customer to execute smarter decision-making. The platform delivers many rich new capabilities and integrates the four critical elements that any enterprise needs: business intelligence, performance management, advanced analytics, and data integrity.

Depending on the role you play in your organization, using WebFOCUS, you can:

- Connect and edit data
- Author reports and visualizations
- Perform predictive and location analytics
- Build applications
- Run and schedule procedures
- Share your data
- And more

In this chapter:

- Signing in to TIBCO WebFOCUS
- Navigating TIBCO WebFOCUS® Hub
- Configuring and Using Your TIBCO WebFOCUS Environment
- Editing Source Code Files
- Introducing the TIBCO WebFOCUS® Mobile App

Signing in to TIBCO WebFOCUS

You can launch WebFOCUS from any web browser, using the address created during the installation. The sign-in page and default start page may be different depending on the configuration requirements of your organization.
To learn more about the installation process, see the TIBCO WebFOCUS® Installation and Configuration manual.

**Procedure: How to Launch WebFOCUS**

1. In your browser, go to the following page:

   http[s]://hostname:port/ibi_apps

   where:

   **hostname:port**

   Are the host name and HTTP port of the web server or application server.

   The default WebFOCUS Sign In page opens, as shown in the following image.

   ![](image)

2. Type your user name and password.

3. Click **Sign in**.

   The WebFOCUS Hub loads and shows all the content that you are authorized to see.

   **Note:** You can also reconfigure WebFOCUS to run the WebFOCUS Home Page, Legacy Home Page, or a custom welcome page after sign-in. This behavior is configured by setting the `Redirect /ibi_apps` to setting on the BI Portal page, in the Administration Console.
Navigating TIBCO WebFOCUS® Hub

When you first sign in to WebFOCUS®, the Hub opens. It serves as a centralized place for working with your data, creating, organizing, searching and sharing content, scheduling reports and procedures, and performing client and server administrative tasks. These functions are controlled by the permissions that are assigned to the role of a user. To learn more about the available roles in WebFOCUS, see the TIBCO WebFOCUS® Security and Administration technical content.

Banner

The banner, shown in the following image, is located on the top of your WebFOCUS Hub. It is accessible from every area of the Hub.

The hamburger button, located in the upper left corner, takes you to the Main Menu. Here you can navigate to the areas of your Hub. This menu also gives you direct access to the TIBCO WebFOCUS tools, such as InfoAssist, TIBCO WebFOCUS® Infographics, ReportCaster schedule status, ReportCaster Explorer, and Magnify Search.

The plus button opens the New menu, which provides access to the following options and tools.

- **Create Visualizations.** Opens WebFOCUS Designer in author mode so you can start creating new content from data.

- **Assemble Visualizations.** Opens WebFOCUS Designer allowing you to assemble visualizations from existing content.

- **Get Data.** Opens the Get Data dialog box, where you can upload a file or create a data connection to an existing database.

- **Get Data (Advanced).** Opens the Get Data dialog box in advanced mode, where you can upload a file or create a data connection and edit the synonyms.

- **Create Data Flow.** Opens the TIBCO WebFOCUS® Reporting Server, where you can create a new data flow.

- **Create DBMS SQL Flow.** Opens the WebFOCUS® Reporting Server, where you can create a new DBMS SQL flow.
Create Cluster Business View. Opens the WebFOCUS Reporting Server, where you can configure a cluster business view.

Explore Data. Opens the Explore Data tool, where you can ask questions and get answers about data.

Next to the plus button, you can see the name of the area that is currently on display.

In the Workspaces area, the banner also displays the View toggle, which allows you to switch between Normal and Admin views of your resources.

Normal view. The view of the repository that allows you to see and manage your own private content. This setting is enabled by default.

Admin view. The view of the repository that allows you to see and manage the private content of other users.

Note: The View toggle is only visible to administrators.

In the Application Directories area, the banner also displays the server selection drop-down list. To learn more about configuring multiple servers for your environment, see the TIBCO WebFOCUS Security and Administration technical content.

In the right corner of the banner, you can access the following buttons and menus.

Tools

The Tools button provides access to the following menus.

Stop Requests. Terminates outstanding interactive requests that are running.

Manage My Agents. Navigates to the WebFOCUS Reporting Server in a new browser window, where you can view and manage your agents.

View Deferred Report Status. Opens a Deferred Status report in a new browser window, which allows you to view the status of deferred reports and manage them.

View Sessions. Opens the Session Viewer in a new browser window, which shows the status of the current session.

Edit My Profile. Enables you to make changes to your current server user profile settings.

Session Log. Provides access to the following options:

View Session Log. Navigates to the Server Session Log in a new browser window where you can view your session log.
- **Clear Session Log.** Clears the current session log.

- **View Login Info.** Opens the View Login Info in a new browser window, where you can see information about the WebFOCUS instance you are currently running.

**Help**

The Help button provides access to the following menus.

- **Help.** Provides access to the following options:
  - **Web Client Help.** Opens the WebFOCUS Online Help plugin in a new browser window.

- **Community (myibi).** Opens the myibi customer community page in a new browser window.

- **Technical Resources (KB).** Opens the TIBCO WebFOCUS KnowledgeBase in a new browser window.

- **About WebFOCUS.** Opens the About WebFOCUS dialog box, which contains information about the current release of the product, as well as web client and reporting server details.

- **License.** Directs you to the End User License Agreement document.

**User Profile**

The User profile button contains the following action menus.

- **Switch Home Page.** Provides access to the following options.
  - **WebFOCUS Home Page.** Opens the WebFOCUS Home Page in a new browser window.
  - **Legacy Home Page.** Opens the Legacy Home Page in a new browser window.

- **Change Language.** Opens the Change Language dialog box, where you can change the language of your WebFOCUS environment.

- **Change Password.** Opens the Change Password dialog box, where you can reset a password for your account.

- **Reset View.** Resets the WebFOCUS Hub to the default view and displays the Home area with the Recents view in focus.
Note: By default, the last place you visited on the Hub is remembered by WebFOCUS and opens automatically when you return to your environment. Clicking Reset View deletes the memory of your previous Hub location.

- **Sign Out.** Signs you out of WebFOCUS.

**Home Area**

The Home area is what you see when you first login to WebFOCUS. It provides quick access to the items that you worked on, your private and favorite content, the items that were shared with you or your group by other users, as well as helpful resources that you can use to start your journey with WebFOCUS. An example of the Home area is shown in the following image.

The Home area is comprised of five views:

- Recently worked on
- Shared with me
- My workspace
- Getting Started
- Favorites
When you create a new item, edit an item, or run an item anywhere in the environment, this item appears in the Recently worked on view, which consists of two tabs: Content and Data. Under the Content tab, you can see recent items from the TIBCO WebFOCUS® Client side. The Data tab displays recent items from the WebFOCUS Reporting Server. Both types of items have shortcut menus that vary depending on the nature of the item and your permissions. You can remove an item from this view by right-clicking it and clicking Remove from Recents.

The Shared with me view shows all of the content items that were shared with you or your group, by other users, or the items that were shared with all users in your environment. The items display in the order in which they were shared, descending from the newest to the oldest. From the Shared with Me view, you can run and edit items, as well as view and edit their properties.

The My workspace view is a centralized location for all your private content. Whenever you create an item inside My Workspace in the Resources tree, as well as inside the My Content folder in any other workspace, this item is private. The My workspace view automatically displays all private items from everywhere in your repository. The shortcut menu options inside the My Workspace view are identical to those inside the My Content folders in your repository.

The Getting Started view offers an introduction to WebFOCUS in the form of educational resources and analytical content examples. Once you no longer need this information, you can customize the Getting Started view to display any other workspace in your repository, as described in Customizing the Getting Started View on page 68.

Saving content items as favorites anywhere in the repository or server applications, automatically adds them to the Favorites view. Similar to the Recently worked on view, your Favorites are divided into two tabs: Content and Data. Under the Content tab, you can see the items that you saved as favorites from the WebFOCUS® Client side. The Data tab displays the favorite items from the WebFOCUS Reporting Server. To save an item as a Favorite, right-click it and then click Add to Favorites. To remove an item from the Favorites view, right-click it and then click Remove from Favorites.
Everywhere in the Home area, you can switch between the tile and list views, by clicking the List view and Tile view icons in the upper-right corner of the canvas. In the list view, you can sort each column by clicking the column title. You can also specify which columns display in the list by clicking the Select Display Columns button and selecting the desired columns from the list. An example of an expanded columns menu is shown in the following image.

You can set up an individual selection of columns for each view of the Home area. For example, you can add the Owner column to the list in the Shared with me view to see which user shared an item with you; or you can add the Workspace column to the list in the My workspace view to see where each item resides in the repository.
Workspaces Area

The Workspaces area is where most of your content management takes place. Here, you can organize your repository structure, create and interact with content items, create sample content, work with data, and perform other tasks. The Workspaces area is shown in the following image.

Page Toolbar

The page toolbar is shown in the following image.

You can use the page toolbar to move between folders in your repository, create and sort content, search the contents of a workspace or folder, change the view of items in the content section, and refresh content in a workspace or folder you select.
When you drill into the folders in your repository, the page toolbar generates a breadcrumb trail that you can use to move between folders. You can move back one folder or multiple folders in a single click. You can click a folder name to view the contents of that folder. You can also click arrows between the folders, to see the file structure that is currently displaying, as shown in the following image. In this example, the selected folder appears in bold.

You can use the +Content button to create analytical content with InfoAssist, upload files and spreadsheets, connect to data, build portals and pages, schedule procedures, and generate sample content using the options available to you for a workspace or folder. The following image shows an example of the +Content menu an advanced or basic user has access to for a workspace or folder.

The +Content menu only displays the items that you can create for the workspace or folder that is currently selected. The items displayed in the +Content menu are also subject to permissions. You can only see the items that are available to you based on your role. To learn more about roles, see the WebFOCUS Security and Administration technical content.
You also can toggle the view of your content between tile view and list view in a workspace or folder. By default, content displays in tile view. Click the *Tile view* icon or *List view* icon to change your view.

The tile view allows you to see the thumbnails of your items, which you can customize to add transparency to your display. You can sort the items in the tile view by using the *Sort by* drop-down list shown in the following image. Once you select a sort option other than the default one, you can reverse the sort order by clicking the *Reverse sort order* button.

![Sort by drop-down list](image)

**Note:** You can also create a customized sorting order, by configuring the Sort Order property for the item.

The list view is useful when you need to see a large number of items at a glance. You can easily identify the item types by their icons, which mirror the icons in the *+Content* menu. An example of a list view is shown in the following image.

![List view example](image)
In this view, you can sort your items by clicking any column title. Each column features a three-step toggle sorting: ascending, descending, and return to the default. You can also specify which columns display in the content section by clicking the Select Display Columns button, and selecting the columns you want to view from the list. An example of an expanded columns menu is shown in the following image.

When you hover over an item that contains a summary, this summary displays as a tooltip in both tile and list views.

Finally, to refresh all content in a selected workspace or folder, click the Refresh button.
Resources Tree

The Resources tree provides a way to view your repository structure and navigate between workspaces and folders that are available to you. The following image shows an example of a Resources tree.

You can use the New workspace button and New folder button on top of the Resources tree to add new workspaces and folders to your repository. These buttons mirror the icons for workspaces and folders that display inside the tree.

You can expand or collapse workspaces and folders by clicking the arrows next to them. When you click a folder, its contents display in the content section. You can also right-click a folder to access a shortcut menu of available options. From the shortcut menu, you can perform the following actions:

- Expand or Collapse a folder
- Duplicate a folder
- Cut or Copy a folder
- Paste content or another folder inside a folder
- Delete a folder
- Allow or suppress access to a folder
- Show or hide a folder
- Configure security rules for a folder
View and edit properties for a folder

You can also customize the width of the Resources tree. To do so, place your cursor on top of the right edge of the Resources tree area, as shown in the following image, and drag the edge to achieve the desired width. Your new width is remembered, and displays the next time you sign in to WebFOCUS.

You can also collapse the Resources tree to allow more room for the content section. To collapse the Resources tree, click the arrow on the right side of the tree. Click the arrow again to expand the Resources tree.

My Workspace

My Workspace is the default workspace where all your newly created content will reside, unless you specify an alternative location.

Note: Multiple workspaces are available in the full version of WebFOCUS. Optionally, you can make a different workspace or top-level folder a default saving location by configuring the Default Workspace Repository Path setting in the Administration Console. See the WebFOCUS® Security and Administration technical content for more details.

Content that you create in My Workspace will automatically display in My Workspace view along with other private content you might have.

Use the Plus button or the +Content menu to create content.

Note: To access the +Content menu inside My Workspace, navigate to the My Content folder inside it.
Global Resources

Administrators have access to a Global Resources folder on the Workspaces level in the Resources tree. The Global Resources folder, identified by the distinct icon 📁, contains three subfolders: Page Templates, Page Templates (Legacy), and Themes. These subfolders contain files that are used to style and format your portals and content in WebFOCUS Designer and Portal Page Designer. The Global Resources folder is shown in the following image.

Content Section

The content section displays the items contained within a workspace or folder that is currently selected. An example of the content section is shown in the following image.

If a resource contains folders and items, the folders are always displayed first, followed by the items. Items shown in the content section include reports, charts, pages, portals, and more.
You can right-click any folder or item to access the shortcut menu of options. The following options are available when you right-click a folder or item in the content section.

**Expand/Collapse**
Expands or collapses a folder. This option is only available for folders.

**Run**
Runs the report procedure or schedule.

**Run in new window**
Runs the selected item in a new browser window or tab.

**Run deferred**
Submits a report procedure or a schedule for deferred execution.

**Run with SQL trace**
Runs a report and includes an SQL trace of the report results.

*Note:* The Run with SQL Trace option is not available for visualizations.

**Run with different connection credentials**
Prompts for database credentials prior to running an item.

*Note:* This option is only available to users who have been granted the Run Procedures with Different Connection Credentials privilege. It is used when running items that draw data from databases that are configured to use individual credentials. For more information, see the WebFOCUS Security and Administration content.

**Schedule**
Launches the scheduling tool, where you can schedule a report procedure to be run. Scheduling options include Email, FTP, Printer, Report Library, and Repository.

**View log**
Launches the Schedule Log Options dialog box, where you can select whether to view the most recent log report for the schedule, or specify a time range for which to obtain log reports. This option is only available for schedules.

**View**
Enables you to launch the URL or download a copy of the file to your browser. This option is available for URLs, Excel Workbooks, PDF, HTML, and Image Files.

**Edit**
Edits an item with the tool that was used to create it.

**Edit with text editor**
Edits an item in the Text Editor.

**Create shortcut**
Creates a shortcut to this item.
Duplicate
Makes a copy of the folder or item with an underscore and number appended to the title, for example, duplicating Sales_Report creates Sales_Report_1 in the same location. The number is incremented each time a duplicate is created.

Cut, Copy, and Paste
Cuts, copies, or pastes the folder and its contents or item.

Copy and update paths
Copies one or more items from one location to another with the internal path references automatically updated to be consistent with the target location. This option is available for charts, reports, documents, visualizations, pages, workbooks, schedules, and HTML files created in TIBCO WebFOCUS® App Studio.

Note: This feature only works when copying items between the folders that reside on the same hierarchical level in the repository.

Note: When you run the item that has been moved using this option, a warning might appear alerting you that the item has been modified outside of InfoAssist. This does not affect the behavior of the item at run time. Save the item in InfoAssist to prevent this warning from reappearing.

Delete
Deletes the folder and its contents or item.

Publish/Unpublish
Allows or suppresses public access to the content.

Show/Hide
Shows or hides the folder or item.

Share/Unshare
Shares content with all users that are permitted to access this content. Unshare stops sharing content with all users.
Security
Provides access to the following options:

Rules
Opens the rules defined for the folder or item. Here you can modify the rules for a given item.

Rules on this resource
Shows the security rules for the folder or item.

Effective policy
Shows the defined rules that specify the permitted functionality on the folder or item.

Owner
Allows you to set the resource owner, either Published (no specific owner), or a specific group or user.

Customizations
Provides access to the following options:

Remove my customizations
Removes your own customizations from a portal and its pages.

Remove customizations for all users
Removes all user customizations and custom pages created at run time.

Note: These options are only available for portals and portal pages.

Manage alias
Opens the Manage Alias dialog box, where you can create an alias for the selected portal. This feature is only available to Administrators. This option is only available for portals.

Open item location
Redirects to the folder where the item is located. This option is only available for portals in the Portals view.

Comments
Provides access to the following options:

View comments
Opens the blog item and expands all comments.

Remove all comments
Clears all comments from the blog.

Note: These options are only available for blogs.

Unlink
Removes the page from all portals. This option is only available for portal pages.
Add to Favorites
Adds the item to the Favorites folder.

Remove favorite
Removes the Favorite from the list. This option is only available for Favorites.

Properties
Opens the Properties panel to display the properties of the folder or item.

Folder and Item Properties
Authorized users can select the Properties option to review information about a folder or item, including when it was created, the date it was last modified, title, name, and settings that control the WebFOCUS Reporting Server and applications it will access. There are also settings that control the functionality available to users when they access the folder, run, or schedule an item.

The following image shows the Properties panel for a bar chart.

The General Properties tab includes the following settings:

- **Title.** Displays the value that you can use to identify the content in the Resources tree.
- **Name.** Refers to the unique name of the item or folder. You can change the name of the resource by editing this field.
- **Summary.** Displays a detailed explanation that provides additional information about the item.

- **Path.** Contains the full path of the folder or item in the WebFOCUS repository and the **Copy path** button.

- **Created.** Shows the date the folder or item was created.

- **Modified.** Shows the date the folder or item properties were last modified, and identifies the user that modified them.

- **Accessed** Shows the date the folder or item was last opened, and identifies the user that opened it.

- **Tool.** Specifies the type of an item.

- **Owner.** Identifies the user who created the folder or item.

- **Size.** Displays N/A bytes for folders. For items, displays the size in bytes.

- **Publish.** Provides an option to publish or unpublish the folder or item. An unpublished item displays the Not Published icon in the tile view and a checkmark in the Not Published column in the list view.

- **Show.** Provides an option to show or hide the folder or item. A hidden item displays the Not Shown icon in the tile view and a checkmark in the Hidden column in the list view.
The Advanced tab, which is shown in the following images, allows you to customize the functionality and behavior of the folder or item.
The Advanced Properties tab includes the following properties.

Explorer/Portal Properties:

- **Thumbnail.** Allows you to preview and change the thumbnail for an item.
- **Sort order.** Specifies the order to list the folder in the tree or item within other items in a folder.

  **Note:** The sort order setting does not take effect in the Portals view. It is only valid in the Content, and Favorites views.

- **Language.** Indicates the current language of your environment and contains the *Manage options* button, which opens the Language Properties dialog box, where you can select a language.

- **Menu Icon.** Allows you to enter a CSS class for a custom menu icon that will display in the list view.

- **Load in iframe.** Grants or suppresses permission to load an item in an iFrame container.

- **Default width.** Sets a default width value for the item, when it is displayed inside a portal at run time.

- **Default height.** Sets a default height value for the item, when it is displayed inside a portal at run time.

Search Properties:

- **Tags.** Adds tag values to the items that display in the search results and portal lists.

- **Intent phrases.** Allows you to specify how you can interact with the repository item when using Mobile Voice.

  **Note:** You cannot add intent phrases to My Content items. For more information on intent phrases, see the *Using TIBCO WebFOCUS® Mobile Voice* technical content.

Interactive Reporting Properties:

- **Prompt for parameters.** Indicates whether to display the Autoprompt HTML page to allow the user to view and select parameter values. When this check box is clear, users will still be prompted if there are any parameters that do not have a value supplied.

- **Enable AutoLinking.** Establishes drill-down links from column data to the target reports that you link together.

- **AutoLink target.** Identifies a report as the target report that is run when the drill-down link is triggered.
**Note:** The Auto Linking between reports only works if the target report contains a parameterized field that corresponds to one of the fields in the primary Auto Link report. For more information on Auto Linking, see the *WebFOCUS InfoAssist User’s Manual.*

- **Enable AutoDrill.** Creates drill-down links in reports and charts that contain hierarchical data.

- **Run with OLAP.** OLAP-enables the report.

- **Use title for deferred report description.** Indicates whether or not to prompt for a custom deferred report description. If selected, this option gives you an alternative to being prompted for a custom deferred report description. If you want to disable prompting for custom deferred report descriptions for all reports, see the Custom Deferred Report Description setting content in the *WebFOCUS Security and Administration* technical content.

- **Schedule only.** Indicates that the report can only be scheduled using ReportCaster when the user does not have write access. This option is not available for reporting objects.

- **Only run as deferred report.** Runs the report in deferred mode.

- **Only allow user to run.** Specifies to not allow users to use InfoAssist with a reporting object. Depending on the effective policy, users can only use the Run or Run Deferred options.

- **Allow user to run.** Allows a user not permitted to access the Reporting Object tool to run the reporting object interactively, using the Run or Run Deferred options.

**Scheduling and Library Content Properties:**

- **Restrict schedule to Library only.** Prevents emails distribution for security-sensitive scheduled reports, and restricts them to the library distribution only.
The Query Detail Properties tab, which is shown in the following image, is only available for reports, charts, and visualizations. It shows which data elements, parameters, and conditions were used in an item.

The Server Properties tab, which is shown in the following image, allows you to manage the server and application path settings.
To change the server, select the **Assign Server** check box, and then select a server from the list. You can also change the application path in the same way.

By default, the Properties panel remains open while you browse between folders and items, allowing you to configure several resources quickly without closing the panel. To close the Properties panel, click the **Close** button in the upper-right corner of the panel.

**Application Directories Area**

The Application Directories area opens the Reporting Server browser interface, where you can select a server from the list of configured reporting servers, as well as view and manage your server environment. The Application Directories area is shown in the following image.

![Application Directories Area](image)

From this area, you can perform the following tasks:

- Select a reporting server from the server selection drop-down list, located in the banner of the area.

  **Note:** For more information on how to configure multiple Reporting Servers, see the *TIBCO WebFOCUS Security and Administration* technical content.

- Select, add, and configure data adapters.
- Create and manage adapter metadata.
- Control data access and security.
- Configure remote servers.
- Configure, edit, and run applications and deferred query processing.
- Configure communications and special services.
- Operate, monitor, tune, and troubleshoot your server.
- Edit configuration files.
- Migrate from a previous server release.
- Control aspects of your own environment.

For more information on how to use the Reporting Server browsing interface, see the TIBCO WebFOCUS® Reporting Server Administration technical content.

**Portals Area**

The Portals area displays all the portals that are currently available in your repository in one centralized location. Depending on your permissions, you can run and edit a portal from this directory. You can also add a portal to Favorites and view its properties. An example of the Portals area is shown in the following image.
There are three types of portals that can be accessed in the Portals area: basic, collaborative, and designer. These types of portals are distinguished by their icons. In the tile view, basic portals display with the vertical stack icon, while the icon for collaborative and designer portals shows the vertical stack inside a circle. The following image displays the two different icons annotated.

In the list view, you can see the icons in the Type column. Designer portals display with the distinct desktop icon, while all other types of portals are represented by the circle icon, as shown in the following image.

Note: If you need to create a basic portal in your environment, you must do that from the Portals node of the Legacy Home Page.

In the list view, you can modify your display by using the Select Display Columns button and selecting the columns that are useful for this type of content. For example, you can add the Path column and use the values displayed in this column to build a direct shareable URL to a specific portal.

Management Center Area

The Management Center area contains tools for configuring your WebFOCUS Reporting Server and WebFOCUS Client administrative options. This directory is only visible to administrators.
The Management Center area is shown in the following image.

On the left side of the screen, you can access the menu, which is divided in two sections:

- **Client Administration.** Contains options for configuring the WebFOCUS Client.
- **Server Administration.** Contains options for configuring the WebFOCUS Reporting Server.

The Client Administration section provides access to the following options:

- **Administration Console.** Opens the Administration Console, where you configure, administer, and monitor the components of the WebFOCUS environment.
- **Security Center.** Opens the Security Center where you can define users and groups, and grant access permissions.
- **Private Resources.** Opens the Manage Private Resources window, where you can view and administer private resources for groups and users.
- **Import Packages.** Provides access to the Import facility of the Change Management feature, where you can upload and import files and packages.
- **Export Packages.** Provides access to the Export facility of the Change Management feature, which is used for moving application components between WebFOCUS environments.
Magnify Console. Opens the Magnify Console, where you can specify settings, configure security, and perform maintenance and diagnostic tasks for Magnify.

Note: For more information on how to use the Client Administration options, see the WebFOCUS Security and Administration technical content.

The Server Administration section provides access to the following options:

Server Selection List. Allows you to select among Reporting Servers that are currently configured in your environment.

Note: For more information on how to configure multiple Reporting Servers, see the TIBCO WebFOCUS Security and Administration technical content.

Server Preferences. Opens the WebFOCUS Reporting Server Preferences interface, where you can indicate preferences for Run Options, Reporting Server browser interface appearance, Reporting Options, and Diagnostic Options.

Access Control. Opens the Access Control page of the Reporting Server browsing interface, where you can manage security providers, edit Access Control and Encryption settings, as well as register and show privileges for users, groups, and roles.

Server Workspaces. Opens the Server Workspaces page of the Reporting Server browsing interface, which provides a complete list of system variables and global variables.

Resource Management. Provides access to the Resource Management tools, Resource Analyzer and Resource Governor. These tools allow you to discover how your data is being used, and then use that information to optimize your environment and improve performance.

Scalability. Opens the Scalability page of the Reporting Server browsing interface, where you can stress-test your environment and run diagnostic procedures.

Note: For more information on how to use the Server Administration options, see the WebFOCUS® Reporting Server Administration technical content.

Search Content & Data Area

The Search Content & Data area of the Hub provides access to the search utility. This robust and intuitive functionality allows you to quickly bring in search results from the entire TIBCO WebFOCUS environment. You can search for analytical content, master files, individual data files, databases, and more, viewing all your results at once or divided between content and data.
With the WebFOCUS search feature, you can:

- Search for keywords across the entire WebFOCUS environment.
- Run search from TIBCO WebFOCUS Client, TIBCO WebFOCUS Reporting Server, or the entire WebFOCUS environment.
- View the entire list of items that match a keyword, in tile and list views.
- Use syntax to filter your search results and run Boolean search queries.
- Narrow your search by applying multiple filters.
- Interact with items in the search results section and easily locate them in their original directories.

The Search Content & Data area is shown in the following image.

The Search Content & Data area consists of the following sections:

- Text Input Bar
- Search Filters
- Results Toolbar
- Results Section
Text Input Bar

The Text Input Bar is where most of your search-related activity happens. Here you can enter a search term to quickly display all content and/or data items that match that term. Above the input bar, there are three buttons: All Items, Content, and Data. You can use these buttons to toggle between only content and only data results, as well as the option to see all results in the same search event. An example of the Text Input Bar is shown in the following image.

![Text Input Bar Example](image)

In addition to searching for a single term, you can refine your search directly within your input bar by using syntax. The table below lists the syntax symbols that you can use and explains how they affect the results of your search.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Usage Example</th>
</tr>
</thead>
</table>
| *      | Multiple unspecified characters. | Input: sa*  
Result: sale, sales, safe, safety  
Will not find: Items that do not start with sa. |
Result: sales, saves  
Will not find: samples |
| " "   | Search the exact wording inside the quotation marks, including special characters. | Input: "sale?"  
Result: sale?  
Will not find: sales |
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Usage Example</th>
</tr>
</thead>
</table>
| +      | Marks a term as required for results. | **Input:** +sales category  
**Result:** Items that include sales and both sales and category.  
**Will not find:** Items that only include category. |

Using these symbols, you can make your search as precise or as wide as you like. To search for several optional terms, simply type them inside the input bar separated by a blank space. You can even combine several required and several optional search terms in one string. For example:

**Input:** +sales +category product retail  
**Result:** Items that include sales and category; and, optionally, product and/or retail.  
**Will not find:** Items that only include product or retail or both.

Keep in mind, that you do not need to put and or or into the search syntax to create Boolean operators. Use the above system to specify required and optional terms. If you do put and or or into the syntax, the tool treats these words as additional search terms. For example:

**Input:** sales and category  
**Result:** Items that contain sales, and, and category, or combinations of the three terms.  
**Will not find:** Exclusively items that include both sales and category.

Once you are happy with your keyword or search query syntax, click **Search** or simply press Enter on your keyboard. Otherwise, click **Clear** to remove your query from the Text Input Bar.

**Search Filters**

It is the best practice to opt for the search filters when searching for items in large or hierarchically complex repositories. By narrowing the search query, you can significantly improve the response time of your search event and make your search results more precise.

You can use the following filters to narrow your search:

- **Search by.** This filter allows you to select a category by which you run your search. Once you select a category, the keyword in the Text Input Bar becomes a search term in this particular category. The available options are: All categories, Title, Summary, Tags, and File Name. You can multi-select values in this filter. The default value is All categories.
Type. If you know the type of item you are searching for, such as document, data source, image, portal, etc., you can specify it in this filter to narrow your search results to this file type. You can multi-select values in this filter. The default value is All types.

Content in. This filter can be used when you want to narrow your search to a workspace. This filter is specific to the WebFOCUS Client and is inactive when the Data button is enabled above the Text Input Bar. You can multi-select values in this filter. The default value is All workspaces.

Data in. If you know in which reporting server and/or application directory your search target resides, you can use this filter to narrow your query by making selections in two drop-down lists: Reporting Servers and Application Directories. This filter is specific to the WebFOCUS Reporting Server and is inactive when the Content button is enabled above the Text Input Bar. You can multi-select items in this filter. The default values are: All reporting servers and All application directories.

Note: To learn more about enabling multiple servers, see the TIBCO WebFOCUS Security and Administration technical content.

Once you have made your selections, click Search to see your results display in the Results section. Otherwise, click Clear to bring your search options to their default state.

Results Toolbar

The Results Toolbar is located above the Results section. Similar to the Page Toolbar in the Workspaces area, the Results Toolbar allows you to customize how you view the items that currently display in the Results section. An example of the Results Toolbar is shown in the following image.

The Results Toolbar features the following elements and controls:

Search Results count. Indicates the total number of search results after the search query is run.

Sort by. Provides a drop-down list of sorting options that you can use to quickly locate an item in the results section. The options include: User-Defined Sort, Title, Name, Summary, Type, Path, Created On, Last Modified, Owner, Size, and Tags. The default value is User-Defined Sort, which is derived from the Sort Order property configurations of the displayed items. This list is only available in the tile view.

Sort items in ascending or descending order. Alternates between ascending and descending orders for the selected sort option. This button is only available in the tile view.
View as tiles. Displays your search results in the tile view.

View as list. Displays your search results in the list view.

Select Display Columns. Allows you to specify which columns display in the Results section. This button is only active in the list view.

Results Section

The Results section displays the items that match your search query. An example of the Results section is shown in the following image.

![Results Section Image]

You can right-click any item to access its shortcut menu options. The following shortcut menu options are available in the Results section.

Run

Runs the item in the new browser window. This option is only available for the types of items that can be run.

Edit

Edits an item with the tool that was used to create it. This option is only available for the types of items that can be edited.

Edit with text editor

Edits an item in the Text Editor.

Locate Item

Opens the directory where the item resides and selects the item.
You can also toggle the view of your search results between the tile and list views by clicking the View as tiles and View as list buttons on the Results Toolbar. By default, the items display in the tile view.

The tile view allows you to see the thumbnails of your items. You can sort the items in the tile view by using the Sort by dropdown list in the Results Toolbar. Additionally, you can use the Sort items in ascending or descending order button to reverse the sort order. When you hover over an item that contains summary, the summary displays as a tooltip in both tile and list views.

The list view is useful when you need to see a large number of items at a glance. In this view, you can sort your items by clicking any column title. Each column features a two-step toggle sorting: ascending and descending. You can also specify which columns display in the list view by clicking the Select Display Columns button, and selecting the columns you want to view from the list.

You can customize the width of the search results section by placing your cursor on top of the right edge of the section, as shown in the following image, then clicking and dragging it to achieve the desired width. Your new width is remembered, and displays the next time you sign in to WebFOCUS.

You can navigate between the pages of your search results using the pagination bar on the bottom of the Results section. These options make it easy to view large amounts of data quickly, without scrolling. An example of the pagination bar is shown in the following image.
The pagination bar contains two components: a record count that dynamically changes as you move between pages and a set of controls that you can use to advance pages, return to pages, or enter specific page numbers. You can use the Items per page dropdown list to increase or decrease the number of items displayed on a single page. The First Page, Previous Page, Next Page, and Last Page buttons allow you to navigate between pages. The page number in the middle indicates the current number of the page you are viewing. You can click this number, and enter a new number to jump to a different page.

**Indexing Content and Data**

On occasion, you might need to index the content and data in your environment to ensure they appear correctly in your search results. Indexing in WebFOCUS is a quick and simple process. Once your content and data are indexed, all subsequent changes to the repository content and data directories are indexed automatically by WebFOCUS.

**Procedure:** How to Index Content and Data

1. Sign in to WebFOCUS as a developer or administrator.
2. In the WebFOCUS Hub, in Application Directories area, from the Servers dropdown list, select the server that you want to index.
   
   **Note:** For more information on how to configure multiple Reporting Servers, see the [TIBCO WebFOCUS Security and Administration](https://tibco.com) technical content.
3. Right-click the Applications node, and then click Properties.
   
   The Properties panel opens. The following search index options are available:

   **Files:**

   - **Files from all application directories**
     
     Indexes files in the WebFOCUS Reporting Server and the files that belong to the mapped directories, as configured in the properties under the Location group below.

   - **Files only from application directories in defined application path**
     
     Indexes only the files that appear in the application directories in defined application paths.

   **Location:**

   - **All regular directories & marked mapped directories.**
     
     Indexes application directories under the APPROOT and the application directories with the Include in search index option enabled.

   - **All mapped directories.**
     
     Indexes every mapped directory regardless of whether it has the Include in search index option enabled.
4. Select an indexing option and click Save.
   Your Reporting Server data is now indexed.

5. Navigate to the Workspaces area and switch to the Admin view, as shown in the following image.

   ![Image showing switch between Normal and Admin views]

   **Note:** You must be signed in as an administrator to switch between Normal and Admin views.

6. In the Resources tree, right-click the Workspaces node, and then click Properties.
   The Properties panel opens.

7. Click Refresh Search Index.
   Your WebFOCUS Client content is now indexed.

**Viewing the Hub on Mobile Devices**

The WebFOCUS Hub is optimized for viewing on mobile devices. It automatically adjusts to a smaller screen or browser width. Additionally, there are several interface and functionality changes that occur when you access WebFOCUS across different devices. From the tablet or phone, the Hub only allows browsing or searching for content and running visualizations.
When you view the Hub on a mobile device, you get access to the features and elements that are optimal for mobile browsing and interaction. Most navigation elements are hidden from view to allow more space for your content. The hamburger menu \(\equiv\) in the upper left corner of your display lets you navigate between the four available areas: Home, Workspaces, Portals, and Searching WebFOCUS. The expanded hamburger menu is shown in the following image.
You can navigate between the views of the Home area by tapping the arrow next to the Home area title, as shown in the following images.

The banner menus are also hidden in the mobile view. To access the functionality available from the banner, you need to use the full desktop version of the software. The Sign Out option is available from the user menu in the upper-right corner of your mobile display.

You can run content in the mobile view by double-tapping an item. Select shortcut menu options are also available on mobile devices. To access the shortcut menu options, tap and hold the item. The shortcut menu options are context sensitive, and vary, depending on the item or element you want to access.

To navigate between workspaces and folders on a mobile device, use the Resources tree or the breadcrumb trail in the Workspaces area. The arrows between the directories on the breadcrumb trail allow you to switch between different folders.

You can also search, switch between list and tile views, refresh and sort content in the mobile view. These functions behave in the same way as they do in the full desktop view.
Configuring and Using Your TIBCO WebFOCUS Environment

From the WebFOCUS Hub, you can create new workspaces or folders to organize content in your environment. You can also add thumbnails to view content easily, and add content to the Favorites view. Additionally, you can create blogs, URLs, shortcuts and other essential items that can enhance your content, if these items are enabled by your administrator.

This topic provides information about how you can create workspaces, configure folders, and further customize and use your WebFOCUS environment.

Creating New Workspaces and Folders

Your WebFOCUS Hub is the central location for all WebFOCUS tasks. Setting it up in a way that is convenient, secure, and efficient helps you get the most out of your work. The Workspaces area opens the content section, and provides access to the available workspaces. Workspaces and folders that are located in the Resources tree organize all of your content items. Authorized users can create additional workspaces or folders, as well as customize the default structure of their view.

Procedure: How to Create a Workspace

1. In the Workspaces area, in the Resources tree, click Workspaces.
2. Click the New workspace button above the Resources tree, as shown in the following image.

The New Workspace dialog box opens.

3. From the Type drop-down list, click the type of workspace you want to create.

   The options include:

   - **Enterprise workspace.** Supports installations of WebFOCUS that affect a single enterprise and are organized by department, and content, within that enterprise.

   - **Tenant workspace.** Supports installations of WebFOCUS that affect multiple enterprises, and are organized by the tenant clients of a software as a service vendor.
4. Type a Title for your workspace.
   
   **Note:** The workspace title can be 256 characters or fewer.

   The Name field populates with the same text as the Title, automatically. You can edit the Name at any time.

   **Note:** The workspace name can be 64 characters or fewer.

5. Select the *Create Reporting Server Application* check box if you want to add an application folder to the WebFOCUS Reporting Server for your new workspace.

6. Click *OK*.

   The content section refreshes, and your new workspace now appears in the Resources tree. Expand the new workspace in the Resources tree to view the My Content and Hidden Content folders. These folders are automatically created with the new workspace.

   ![My Content. Stores all of your personal folders and content. You can share these items to make them available to other users. To share a resource, right-click the item and then click Share.](image)

   **Note:** Shared resources appear in a Shared Content folder for users with which you shared the resources.

   ![Hidden Content. Store all of your current procedures, utility items, and other resources that you do not want to show to other users. The Hidden Content folder displays the Not shown icon](image)

   Additionally, by default, four new user groups are automatically created in the Security Center. Those users include Basic Users, Advanced Users, Developers, and Group Administrators. By assigning users to these groups, you can quickly grant privileges according to these predefined roles. Sales workspace users that were created in the Security Center are shown in the following image.

![Sales Basic Users Advanced Users Developers Group Administrators](image)

   For more information about workspaces and users, see the WebFOCUS Security and Administration technical content.

**Procedure:** How to Create a Folder

1. In the Resources tree, select the workspace or folder where you want to create a new folder.
2. Click the New folder button above the Resources tree; alternatively, click the +Content button, point to Other, and then click Folder.

The New Folder dialog box opens.

3. Type a Title for your folder.

The Name field populates with the same text, automatically. You can edit the Name at any time.

4. Click OK.

The new folder is created and is now available in the Resources tree. Unlike a new workspace, a new folder is not published by default, so when it first appears in the content section, it displays the Not published icon. Additionally, the title shown in the Resources tree is italicized. An example of a new folder is shown in the following image.

![Example of a new folder](image)

To publish a new folder, right-click it, and then click Publish. By default, when you publish a folder, you automatically publish all its contents as well.

**Dragging and Dropping Folders and Files**

You can drag and drop folders or files from the content section to other folders within the content section, or to other folders within the repository tree. You can also drag and drop folders from the repository tree to other folders within the repository tree, or to other folders within the content section.
You can drag and drop items, or press and hold the Ctrl key to drag and drop copies of items. Drag and drop functions the same as the cut-and-paste options from the context menu. Drag and drop while holding the Ctrl key functions the same as the copy-and-paste options from the shortcut menu.

**Note:** You can select multiple items by holding the Ctrl key while selecting each item.

**Dragging Indicators**

When dragging an item, a thumbnail displays for that specific item type. If you select multiple items, a thumbnail for one of the dragged items displays.

If you drag an item over an area where it cannot be dropped, a No icon \( \circ \) displays.

**Dropping Indicators**

When dropping an item, a Warning message displays, as shown in the following image:

![Warning dialog box](image)

Click Yes to move the item.

Click Cancel to cancel the operation.

**Adding Content to Favorites**

You can create a list of favorites to easily access the items that are most important to you. When you save content as a favorite, it automatically appears in the Favorites view of the Home area. Here, you can interact with your content and view its properties.

**Procedure:** How to Add Content to Favorites

1. Right-click an item in the Home, Portals, Workspaces, or Application Directories area of the WebFOCUS Hub, and then click Add to Favorites.

   **Note:** Standalone portal pages cannot be added as favorites. You can add them to collaborative portals, and then add collaborative portals as favorites.

2. Navigate to the Home area by clicking the Home icon on the side navigation bar or by selecting Home from the hamburger menu, then click Favorites.
The item is displayed in the Favorites view, as shown in the following image.

Note that your Favorites view is divided into two tabs: Content and Data. Under the Content tab, you can see the items that you saved as favorites from the WebFOCUS Client side. The Data tab displays the items that reside in the WebFOCUS Reporting Server. Both types of items have shortcut menus that vary depending on the nature of the item and your permissions. You can remove an item from this view by right-clicking it and clicking \textit{Remove from Favorites}.

\textbf{Adding Thumbnails to Content Items}

To provide additional context to your items and simplify navigation, you can add custom thumbnails to your content items. These thumbnails might be created from any image files on your machine. You can also create thumbnails from the image files that can be found in your repository.

There are two types of thumbnails in WebFOCUS:

- \textbf{Default}. Assigned to an item by WebFOCUS in the absence of a custom thumbnail.
- \textbf{Custom}. Created either from an uploaded image or from a screenshot in InfoAssist.
Examples of custom and default thumbnails are shown in the following image.

![Examples of custom and default thumbnails](image_url)

Thumbnails are only visible in the tile view.

**Procedure:**  How to Add Thumbnails to Content

1. Right-click a content item to which you want to add a thumbnail, and then click *Properties*.

   The Properties panel opens.

2. Click the *Advanced tab*.

3. In the Thumbnail property, choose one of the following options:
   - **Default.** Populates the thumbnail with the default graphic, as shown in the following image. This is a default option.
   - **Embedded.** Enables you to choose a custom image from your machine.

   In the Open dialog box, select an image file and click *Open*. The custom image displays in the preview section of the Thumbnail property, as shown in the following image.
To change an image, click Browse and select another image file.

- Link. Opens the Select dialog box, where you can navigate to any available image file in your repository, as shown in the following image.

To change an image, click Browse and select another image file in your repository.

4. Once the thumbnail is selected, click Save in the Properties panel.

The thumbnail displays in your repository.

**Assigning Tags to Content Items**

To refine a search for content within a workspace or folder in your repository, you can assign tags to content items. These tags provide additional search criteria that you can use to identify related content items quickly. Tags display as a column in the list view.

**Procedure: How to Assign Tags to Content**

1. Right-click a content item that you want to assign to a tag, and then click Properties.

   The Properties panel opens.

2. Click the Advanced tab.

3. In the Tags field, type the name of your tag, and then click Save.
To test the tag you assigned to the item, perform a search. The tag and item should appear in the search results. An example of a Product tag is shown in the following images.

You can assign multiple tags to a single item, by separating them with a comma, as shown in the following image.

Creating Shortcuts

You can create shortcuts to repository files and Master files. Once a shortcut to a Master file is created, you can use it to build visualizations and reports. Once a shortcut to a repository file is created, you can copy, delete, edit, and run this item. You can also publish and share your shortcuts to make them available for other users and groups.
Procedure: How to Create a Shortcut to a Repository File

1. Select the workspace or folder where you want your new shortcut to reside.
2. In the +Content menu, point to Other, and click Shortcut.
   The New Shortcut dialog box opens.
3. Click Browse.
   The Select dialog box opens.
4. Using the breadcrumb trail, navigate to the resource of your choice, such as folder, report, chart, or visualization, and then click Select.
   The Title field populates with the name of the original item and the word Shortcut. For example, if you create a shortcut to the item Chart1, the shortcut title will be Chart1 - Shortcut.
5. Optionally, you can edit the Title and populate the Summary field.
6. Click OK.
   The new shortcut appears in the selected location.

Procedure: How to Create a Shortcut to a Master File

1. Select the workspace or folder where you want your new shortcut to reside.
2. In the +Content menu, point to Other, and click Shortcut.
   The New Shortcut dialog box opens.
3. Click the Master file radio button, as shown in the following image
4. Click Browse.  
   The Select dialog box opens.

5. Navigate to the Master File to which you want to create a shortcut, and then click Select.  
   The Title field populates with the name of the original item.

6. Optionally, edit the Title and populate the Summary field.

7. Click OK.  
   The new shortcut appears in the selected directory.

Creating URLs

You can create URLs to web pages and store them within the repository. These URLs can further enhance analytics, by providing an additional interactive context to your data. You can run a URL straight from your repository, use it in a portal, or add it to a personal page. If your URL is optimized for use in an iFrame, you can embed it within a container on a page. You can also publish and share a URL to make it available to other users and groups.

**Note:** Some web pages cannot be run inside an iFrame or inside the preview Run window on the WebFOCUS Hub. You can run these web pages in a new browser tab or window.

**Procedure:** How to Create a URL

1. Select the workspace or folder where you want your new URL to reside.

2. In the +Content menu, point to Other, and click URL.  
   The New URL dialog box opens.

3. Type a Title for the URL, type the address of the URL, and then click OK.  
   The URL now appears in your selected location.

**Procedure:** How to Embed an iFrame-Optimized URL in a Portal or Page

1. Copy an iFrame-optimized URL from the web, as shown in the following image.
2. Select the workspace or folder where you want your new URL to reside.

3. In the +Content menu, point to Other, and click URL.

   The New URL dialog box opens.

4. Populate the Title field, and paste the copied URL in the URL field.

5. Remove any iFrame related syntax that surrounds your URL. Examples are shown in the following images.

   ![URL example](image1)

   ![URL example](image2)

6. Click OK to close the New URL dialog box.

   Your URL item is complete and ready to be displayed in a portal or page.

7. Click the plus button and then click Assemble Visualizations.

   The WebFOCUS Designer opens.

8. Add your new URL to the page.
The URL content displays within the container, similar to other content items, as shown in the following image.

![Image of TIBCO WebFOCUS Designer](image)

**Note:** This procedure is applicable to portal pages and collaborative portals.

### Creating Blogs

You can create blogs and include them in your pages and portals. A blog is an interactive content item that operates as commonly seen blogs on the internet, and allows users to post and view comments. Blogs abide by the same security rules that apply to other items in the repository. You can publish, unpublish, hide, and move blogs between workspaces or folders. You can also share blogs with other users and groups.

**Note:** This feature is available in the full version of WebFOCUS.

### Procedure: How to Create a Blog

1. Select the workspace or folder where you want your new blog to reside.
2. In the +Content menu, point to Other, and click Blog.

   The New Blog dialog box opens.

3. Type the requested information in the dialog box, as follows.

   - **Title.** Identifies the blog in the Resources tree.
   - **Summary.** Provides an optional explanation of the blog. It is displayed in the tooltip, when you hover over the blog.

4. Click **OK.**

   The Comments window opens.
5. Click the Add comment link to add a new comment.
6. Once you are done adding and editing comments, click Post, and close the Comments window.
7. You can optionally interact with comments using the following commands:

- Click the Refresh icon to refresh comments.
- Click the Search button, and type a keyword or keywords in the search field, to search through comments. You can specify the search criteria by clicking the drop-down arrow and selecting search criteria, such as user name, content, or meta tags.
- Click the Remove All button to remove all comments from all users. Remove All is only available to users with the Manage Comments privilege.

You can now publish, share, and add your blog to a portal page or portal.

Uploading Files

In addition to creating content using WebFOCUS, you can upload other files, such as images and documents. These files can be used to enhance visualizations and shared with other users and groups.

Procedure: How to Upload Files From The +Content Menu

1. Select the workspace or folder where you want your uploaded file or files to reside.
2. Click the +Content button, point to Other, and then click Upload File.
   The Open dialog box opens.
3. Select one or multiple files from your machine and click Open.
   The file uploads to your selected directory, and the Upload completed message appears, as shown in the following image.
4. Close the *Upload completed* message and proceed with using the uploaded file.

**Note:** When you upload an image, such as a .bmp, .jpg, jpeg, .gif, or .png file, to the repository, an embedded thumbnail of the image automatically generates in the WebFOCUS Explorer. To change the thumbnail that appears in the WebFOCUS Explorer, right-click the thumbnail, and open the Properties panel. Click the *Advanced* tab, and modify the thumbnail.

**Procedure:** How to Upload Files by Dragging to the Explorer

1. In the Workspaces area, select the workspace or folder where you want your uploaded file or files to reside.

2. Drag one or multiple files from your machine directly to the explorer, as shown in the following image.

The file uploads to your selected directory and the *Upload completed* message shows the status of each uploaded file. If an upload fails, the error appears in red in the *Upload completed* message.

3. Close the *Upload completed* message and proceed with using the uploaded files.

**Note:** When you upload an image, such as a .bmp, .jpg, jpeg, .gif, or .png file, to the repository, an embedded thumbnail of the image automatically generates in the WebFOCUS Explorer. To change the thumbnail that appears in the WebFOCUS Explorer, right-click the thumbnail, and open the Properties panel. Click the *Advanced* tab, and modify the thumbnail.
Sharing Content in TIBCO WebFOCUS

Each workspace in the repository, comes with the private My Content folder. Whenever you create content inside the My Content folder, it automatically displays in the My workspace view of the Home area. This content remains private and only visible to you, unless you share it with other users and groups. You can share content in one of two ways:

- **Share with all users.** This method makes the content available to all users that have access to the workspace.
- **Share with specific users and groups.** This method allows you to choose which users and groups are able to access to your private content.

In both scenarios, you can revoke access to your content by right-clicking it and clicking **Unshare**.

**Procedure:** How to Share Content With All Users

1. Navigate to a private content item in one of the following ways.
   - a. In the Resources tree, navigate to a workspace of your choice and open the My Content folder.
   - b. Open Home area and navigate to the My workspace view.
2. Right-click the item that you want to share, and then click **Share**.

   When viewing the item inside the My Content folder, notice that the Share icon now displays on the tile, as shown in the following image.

   ![Share Icon](image)

   The item is now shared with all users that have access to this workspace.

3. To unshare the item, right-click it, and then select **Unshare**.

**Procedure:** How to Share Content With Specific Users and Groups

1. Navigate to a private content item in one of the following ways.
   - a. In the Resources tree, navigate to a workspace of your choice and open the My Content folder.
b. Open Home area and navigate to the My workspace view.

2. Right-click the item that you want to share, and then select **Share with**.

   The Share with Others dialog box opens.

   **Note:** If your sharing privilege does not allow you to open the Share with Others dialog box, you can share or unshare your item by clicking the **Share** option. In this case, the item is shared with every user that has access to the workspace in which the item resides.

3. In the Search field, type the name of the user or group with which you want to share this item.

4. Click the correct entity from the drop-down list, as shown in the following image.

   ![](image)

   The name now displays below the Search field. The item is shared.

5. Optionally, add more users or groups.
You can narrow your search by clicking an arrow and selecting *Users* or *Groups*, as shown in the following image.

![Share with Others dialog box](image)

**Note:** You can also share the item with all users by selecting the *Share with everyone* check box.

6. Once you have selected your options, click **OK**.

The icon now indicates that the item is shared. You can unshare it at any time or go back to the Share with Others dialog box and edit your choices.

**Customizing the Getting Started View**

The Getting Started view in the Home area of the Hub is designed to help you with your initial interactions with WebFOCUS. This view corresponds with the workspace of the same name and contains educational resources and analytical content examples. You can use these materials to familiarize yourself with your environment and its main functions. Once you no longer need this information, you can customize the Getting Started view to display any other workspace in your repository.

**Procedure: How to Customize the Getting Started View**

1. Sign in to WebFOCUS Hub as an administrator.
2. In the Workspaces area, create a new or select an existing workspace that you want to display in place of the Getting Started view in your Home area.
3. Populate your new workspace with the content of your choice.
**Note:** Keep in mind that folders do not display in the Home area view, so make sure to add your items on the workspace level.

4. Right-click your workspace, click *Properties*, and, on the Properties panel, copy the repository path, as shown in the following image.

![Properties: Custom View](image)

5. In the Management Center area, in the Administration Console, navigate to *Application Settings*, and click *BI Portal*.

6. In the *Default List Repository Path* setting, replace the path with the one you copied, and click *Save*.

7. Refresh your browser window and navigate to the Home area.
The workspace displays instead of the Getting Started view, as shown in the following image.

To revert back to the Getting Started view, insert the path to the Getting Started workspace in the Default List Repository Path setting.

Using Keyboard Shortcuts

You can use keyboard shortcuts to perform the common actions shown in the following table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>DEL</td>
</tr>
</tbody>
</table>

The relevant shortcut keys display next to their corresponding options in the shortcut menu, as shown in the following images.
Editing Source Code Files

The Editor enables you to create, view, and edit the source code for WebFOCUS procedures (FOCEXECs), Master, HTML, JavaScript, WebFOCUS StyleSheet, Cascading Style Sheet, Text, SQL, R, and Python files.

Additionally, the Editor supports user-friendly features, such as syntax highlighting, code folding, line numbering, autocomplete, and display of a status bar and indent guides. These features speed productivity by enabling better clarity in helping you understand, debug, and work with your source code.

The Editor offers the ability to run WebFOCUS procedures (FOCEXECs) or HTML pages directly from the Editor. You can also save source code with a different name.

Note: If you create a chart or report in WebFOCUS Designer, you can edit it in the Editor, save it, and open it again in WebFOCUS Designer. Be aware, however, that if your changes are not compatible with WebFOCUS Designer, they may be reverted or cause issues on loading. In such cases, it is recommended to edit the item using only the Editor from that point forward.
Accessing the Editor

You can launch the Editor in one of the following ways, from the Workspaces view:

- From the Resources tree, right-click a file you want to modify, and then click Edit with text editor.

- To create a new file, select a workspace or folder, click the +Content button, point to Other, and click Text Editor.

- From the WebFOCUS Home Page, right-click a file you want to modify, and then click Edit or Edit with text editor.

- To create a new file, from the WebFOCUS Home Page, in the Action Bar, click the Other tab, and then click the Text Editor icon.

If you are creating a new file, you are prompted to select a file type in the New Text Resource pane. File types are grouped into the following three categories:

- Content
- Web
- Data Science

From the Content category, you can choose FOCEXEC (fex), WebFOCUS Style Sheet (sty), Plain Text (txt), or SQL Script (sql), as shown in the following image.
From the Web category, you can choose HTML (htm), Cascading Style Sheet (css), or JavaScript (js), as shown in the following image.

**New Text Resource**

Select a file type

- Content
- Web
- Data Science

**HTML (htm)**

**CSS**

Cascading Style Sheet (css)

**JS**

JavaScript (js)

From the Data Science category, you can choose R Script (r) or Python Script (py), as shown in the following image.

**New Text Resource**

Select a file type

- Content
- Web
- Data Science

**R**

R Script (r)

**Python**

Python Script (py)
Once you choose a file type, the prompt closes and the Editor launches in a new browser tab or window, depending on your browser setting. Default file names begin with the word New, followed by the type of file, for example, New FOCEXEC File, New HTML File, and so on. Small glyphs consistent with the file type appear on the left side of the tab to help identify the type of file, as shown in the following image.

If you hover the mouse over a Title in a tab, the full path to the location of the file displays, as shown in the following image. This path is helpful in differentiating files of the same name and type, in different locations.

```
    |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
|   |
Navigating the Editor Interface

The main components of the Editor interface are shown in the following annotated image.

The Editor interface components are identified as follows:

- **Toolbar.** Contains common file tasks, such as Open, Close, Save, and Save As, as well as preferences, such as line numbering, code folding, autocomplete, status bar, and indent guides.

- **File Tabs.** When multiple tabs are open, clicking a file tab lets you select the file that you want to edit. You can close a tab by clicking the X to the right of the file name in the tab. There is an asterisk (*) next to the file name to indicate that changes have not been saved in the file. If you choose to save a file, the standard Save, or Save As for new files, logic is used. Closing the last open tab exits the Editor. There is no limit to the number of tabs that can be opened. If many files are being edited, and they overflow the boundaries of the screen, you can use the left (<) and right (>) arrows to display the hidden tabs.

- **Sidebar.** Displays line numbers and code folding controls, if these are on. If there is syntax validation, the Editor sidebar displays syntax error markers.
Canvas. The canvas is the main editing area. This is where you type code and see your enabled preferences. In addition to using the toolbar to select your task, you can also use right-click menus on the canvas to select tasks.

Status Bar. Displays contextual information about the file being edited, such as length in characters of the text, total number of lines, line number where the cursor is positioned, column number where the cursor is positioned, and keyboard input modes, such as Insert, Caps Lock, and Num Lock.

Using the Editor Toolbar

The Editor toolbar presents commonly used functions, organized into a series of menu groups. The toolbar is shown in the following image.

The following table lists and describes the functions that you can access from the Editor toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Editor Application menu" /></td>
<td>Editor Application menu. Opens a menu of file-related commands.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save. Opens the Save As dialog box, where you can save a new file.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Reset. Reverts the contents of a tab to its last saved state.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo. Reverses the last action, such as typing, pasting, or deleting text.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo. Restores a previously undone action.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy. Copies your selection to the clipboard.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="icon1.png" alt="Cut icon" /></td>
<td><strong>Cut.</strong> Deletes your selection and places it on the clipboard.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Paste icon" /></td>
<td><strong>Paste.</strong> Pastes your selection from the clipboard to the location indicated by the cursor.</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Preview icon" /></td>
<td><strong>Preview.</strong> Runs and displays the output of a report or HTML page.</td>
</tr>
<tr>
<td><img src="icon4.png" alt="Search icon" /></td>
<td><strong>Search.</strong> Opens the Search and Replace pane, where you can search for and replace text in a file.</td>
</tr>
<tr>
<td><img src="icon5.png" alt="Help icon" /></td>
<td><strong>Help.</strong> Opens the Help system, which provides documentation on the Editor interface.</td>
</tr>
</tbody>
</table>

**Editor Application Menu**

The Editor Application menu opens a menu of file-related commands, as shown in the following image. The Editor icon is always active and is located in the upper-left corner of the Editor interface.
Editor options include:

- **New.** Displays a submenu of all file types that you can create in the Editor. You can create FOCEXC, HTML, JavaScript, WebFOCUS StyleSheet, Cascading Style Sheet, Text, SQL, R, and Python files, as shown in the following image.

- **Open.** Opens an existing file.

  **Note:** You can open supported file types from the default Reporting Server or WebFOCUS Repository.

- **Save.** Saves the active file.

- **Save As.** Saves the active file, in one of several file types, with a new file name.

- **Close.** Closes the active file.

- **Exit.** Closes the active file and exits the Editor.
Edit Group

The Edit group on the toolbar is shown in the following image.

From the Edit group, you can perform the following actions:

- **Save.** Saves the active file.
- **Reset.** Reverts the contents of a tab to its last saved state. Clicking Reset displays a dialog box, warning that unsaved changes will be lost. Clicking OK on the dialog box confirms the reset action and unsaved changes are not applied. Clicking Cancel returns you to the page where recent changes are still available. The Reset option is not available when an existing file is unchanged or a new file has not been saved.
- **Undo.** Reverses the last action, such as typing, pasting, or deleting text. You can also press Ctrl+Z to undo the last action. If there are no changes to a page, the Undo option is not active. To undo multiple actions, including actions that have been saved, you can click the Undo option or press Ctrl+Z repeatedly.
- **Redo.** Restores a previously undone action. You can also press Ctrl+Y to restore a previously undone action. If the Redo option does not apply, the option is not active. To redo multiple actions, including actions that have been saved, you can click the Redo option or press Ctrl+Y repeatedly.
- **Copy.** Copies your selection to the clipboard. You can also press Ctrl+C to copy text.
- **Cut.** Deletes your selection and places it on the clipboard. You can also press Ctrl+X to delete text.
- **Paste.** Pastes your selection from the clipboard to the location indicated by the cursor. You can also press Ctrl+V to paste text.

Preview Group

The Preview group on the toolbar is shown in the following image.
Clicking the Preview button runs and displays the output of a report or HTML page. This option is only available for FOEXEC files and HTML pages.

**Search Group**

The Search group on the toolbar is shown in the following image.

![Search button](image)

Clicking the Search button opens the Search and Replace dialog box, where you can search for and replace text in the file you are currently editing.

**Options Group**

The Options group on the toolbar is shown in the following image.

![Options button](image)

Clicking the Options button displays a submenu of preferences, which enable you to manage your code. Options include line numbering, code folding, autocomplete, status bar, and indent guides, as shown in the following image. You can selectively turn these features off or on in a file.
Help Group

The Help group on the toolbar is shown in the following image.

Clicking the Help button opens the Help system, which provides documentation on the Editor interface.

Syntax Highlighting

Syntax highlighting improves readability and makes debugging procedures easier. This color-coded highlighting is applied to the source code for WebFOCUS procedures to distinguish keywords, comments, functions, arithmetic and logical operators, constants, and quoted strings.

Highlighting is supported for HTML, JavaScript, CSS, R, Python, and SQL files.

The following image is an example of highlighting in a WebFOCUS procedure (FOCEXEC) that is opened in the Editor.

---

**Saving Files**

You can save a file in the Editor in one of the following ways:

- Click the Save button on the toolbar.
- Select Save or Save As from the Application menu.
Procedure: How to Save a Procedure File

1. Create a new procedure (FOCEXEC) in the Editor.
   The default file name is New FOCEXEC File *. Since the file has not been saved, an asterisk (*) appears to the right of the file name. When the file is saved, the asterisk is removed.

2. Click the Save button on the toolbar or select Save from the Editor Application menu.
   The Save As dialog box opens.

3. On the Save As dialog box, navigate to the WebFOCUS Repository or Reporting Server where you want to save the file.
   □ Select the Repository tab to navigate to an available domain for saving the file, as shown in the following image.
Select the Server tab to choose a Reporting Server application directory for saving the file, as shown in the following image.

Note:

- If you are accessing a Reporting Server configured as the default or a server assigned to the domain that requires credentials, you will be prompted for credentials when you:
  - Run an open file that has not been saved.
  - Save a file to the Reporting Server.
  - You can save supported file types to the default Reporting Server or WebFOCUS Repository.
  - You can open supported file types from the default Reporting Server or WebFOCUS Repository.

4. In the Title input box, type a title, which is the display name for the file. By default, the Name value is the Title value in all lowercase letters and underscores (_), instead of spaces. The Name value is processed by the Reporting Server.

5. From the Type drop-down list, select a file type. Supported file types are FOEXEC, WebFOCUS StyleSheet, Cascading Style Sheet, HTML, SQL, JavaScript, Text, R, Python, and Properties.
**Note:** You can save a plain text file as a Properties file from the Save As dialog box. This file type is not available from the New file submenu.

The following image shows a Save As dialog box with the location of the file, Title and Name values, and FOCEXEC selected as the file type.

The Save As dialog box also contains the following:

- Search option to search the list of available files.
- View button to change from Tile view to List view. You can customize the columns displayed in the Tile or List view. Available columns are Title, Name, Summary, Last modified, Created on, Size, and Owner.
- Refresh option to refresh the display of the window.

6. Click Save.
When the file is saved, the Title displays on the tab and the asterisk (*) is removed, as shown in the following image.

![Gross Profits for New York City](image)

```
1 TABLE FILE retail_samples/wf_retail
2 SUM GROSS_PROFIT_US COGS_US REVENUE_US
3 BY CITY_NAME AS 'City'
4 HEADING
5 "<STATE_PROV_NAME City Breakout"
6 WHERE COUNTRY_NAME EQ 'United States' AND STATE_PROV_NAME EQ 'New York';
7 ON TABLE NOTOTAL
8 ON TABLE SET SQUEEZE ON
9 ON TABLE SET STYLE *
10 TYPE=REPORT, TITLETEXT='City Breakout',$
11 TYPE=HEADING, JUSTIFY=CENTER,$
12 ENDSIZE
13 END
14
```

**Note:** The Save icon and the Save option on the File menu are no longer active.

### Previewing Output

The Preview option on the Editor toolbar lets you run and display a preview of your report or HTML page. This option is only available for FOCEXEC files and HTML pages.

To run and preview the output of a procedure in the Editor, click the Preview button on the toolbar.
The procedure runs and the output displays, as shown in the following image.

### New York City Breakout

<table>
<thead>
<tr>
<th>City</th>
<th>Product Category</th>
<th>Gross Profit</th>
<th>Cost of Goods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adams</td>
<td>Accessories</td>
<td>$1,173.16</td>
<td>$2,518.00</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$2,092.79</td>
<td>$6,478.00</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$560.95</td>
<td>$995.00</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$710.92</td>
<td>$1,782.00</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$1,927.47</td>
<td>$5,020.00</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$889.33</td>
<td>$3,757.00</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$2,715.15</td>
<td>$6,555.00</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$924.92</td>
<td>$1,957.00</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$1,016.88</td>
<td>$2,893.00</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$1,396.15</td>
<td>$3,399.00</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$1,314.47</td>
<td>$4,260.00</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$109.00</td>
<td>$190.00</td>
</tr>
<tr>
<td>Afton</td>
<td>Accessories</td>
<td>$597.11</td>
<td>$1,230.00</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$668.93</td>
<td>$1,337.00</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$420.46</td>
<td>$870.00</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$1,304.32</td>
<td>$5,512.00</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$940.67</td>
<td>$2,021.00</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$212.99</td>
<td>$587.00</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$337.08</td>
<td>$1,460.00</td>
</tr>
<tr>
<td>Akron</td>
<td>Accessories</td>
<td>$804.96</td>
<td>$2,083.00</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$335.15</td>
<td>$665.00</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$242.98</td>
<td>$329.00</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$1,174.87</td>
<td>$4,207.00</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$2,640.07</td>
<td>$5,337.00</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$209.98</td>
<td>$540.00</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$330.00</td>
<td>$488.00</td>
</tr>
<tr>
<td>Albany</td>
<td>Accessories</td>
<td>$43,983.58</td>
<td>$102,489.00</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>$49,402.85</td>
<td>$101,705.00</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$34,025.21</td>
<td>$65,100.00</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>$64,799.74</td>
<td>$212,271.00</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>$80,896.88</td>
<td>$188,275.00</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>$19,677.86</td>
<td>$65,376.00</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>$14,979.52</td>
<td>$31,102.00</td>
</tr>
</tbody>
</table>

### Preferences for Managing Code

The Options menu, invoked from the Options button on the toolbar, presents preferences that help you manage your code.
You can selectively turn these preferences off or on in a file, as shown in the following image.

Preferences include:

- **Line numbering.** Displays line numbers, including blank lines, in the sidebar. The default value is on.

- **Code folding.** Allows you to selectively collapse and expand sections of a currently edited file, so that you can look at the code structurally. The default value is on.

- **Autocomplete.** Allows progressive addition and suggestion of code as you type. Autocomplete is available for FOEXEC, HTML, JavaScript, CSS, and Python files. Autocomplete is not supported for SQL, R, STY, and TXT files. The default value is on.

- **Status bar.** Displays contextual information for the active file being edited. The default value is on.

- **Indent guides.** Visually displays indent levels in code. The Tab key moves four columns at a time, putting invisible tab characters into the file. The default value is on.

**Line Numbering**

The Editor supports line numbering, which displays line numbers for each line you create in the Editor, including blank lines. The line numbers appear in the sidebar. This is useful when you need to refer to specific lines in a file.

You can selectively turn line numbering off or on from the Options menu on the toolbar. The default value is on.
The following image displays a WebFOCUS procedure, with line numbers in the sidebar, for each line of code.

```
1  TABLE FILE retail_samples/wf_retail
2  SUM GROSS_PROFIT_US COSG_US REVENUE_US
3  BY CITY_NAME AS 'City'
4
5  HEADING
6  "STATE_PROV_NAME City Breakout"
7
8  WHERE COUNTRY_NAME EQ 'United States' AND STATE_PROV_NAME EQ 'New York';

10  ON TABLE NOTOTAL
11  ON TABLE SET SQUEEZE ON
12
13  ON TABLE SET STYLE =
14  TYPE=REPORT, TITLETEXT='City Breakout',$
15  TYPE=HEADING, JUSTIFY=CENTRE,$
16  ENDS
17
18  END
19
20
```

**Code Folding**

The Editor supports code folding, which lets you selectively collapse and expand sections of code in a file you are currently editing. This is useful when you need to manage large amounts of code, and view only those subsections that are relevant.

You can selectively turn code folding off or on from the Options menu on the toolbar. The default value is on.

Code folding is supported in a FOCEXEC for WebFOCUS DEFINE, TABLE, GRAPH, Dialogue Manager, and inline Stylesheet code. It is also supported for JavaScript, CSS, HTML, and Python files. Code folding is not supported for SQL and R files.
The following image displays a WebFOCUS procedure, with the code-folding toggle icons included in the sidebar (lines 1, 14, 15, 23, 26, and 27).

To collapse the DEFINE statement, click the code-folding toggle icon on the DEFINE FILE command line (line 1). Note that lines 1 through 14 are collapsed, as shown in the following image.

---

```
1. Welcome to TIBCO WebFOCUS®
User’s Guide  89
```
To collapse the inline StyleSheet code, click the code-folding toggle icon on the ON TABLE SET STYLE command line (line 23). Note that lines 23 through 26 are collapsed, as shown in the following image.

To collapse the TABLE request, click the code-folding toggle icon on the TABLE FILE command line (line 15). Note that lines 15 through 27 are collapsed, as shown in the following image.
The following procedure shows the code folding icons on comment lines (lines 1 and 3) and Dialogue Manager commands (lines 4 and 6).

```
1. Welcome to TIBCO WebFOCUS®
User’s Guide
91
```
To collapse the Dialogue Manager commands, click the code folding icon on line 4. Note that lines 4 through 6 are collapsed, as shown in the following image.

```plaintext
1 /* The following procedure sums Gross Profit, Cost of Goods, and Revenue */
4 -DEFAULT &STATE_PROV_NAME='New York'
7 TABLE FILE retail_samples/wf_retail
8 SUM GROSS_PROFIT_US COGS_US REVENUE_US
9 BY CITY_NAME AS 'City'
10 HEADING
11 "<STATE_PROV_NAME City Breakout"
12 WHERE COUNTRY_NAME EQ 'United States' AND STATE_PROV_NAME EQ 'New York';
13 ON TABLE NOTOTAL
14 ON TABLE SET SQUEEZE ON
15 ON TABLE SET STYLE *
16 TYPE=REPORT, TITLETEXT='City Breakout,'$
17 TYPE=HEADING, JUSTIFY= CENTER,$
18 ENDSTYLE
19 END
```

**Reference:** Usage Notes for Code Folding

- The code folding icons appear if there is more than one line for a block of code or commands for which code folding is supported.

- To expand a section of code that is collapsed, you can click the code-folding toggle icon or the double-headed arrow icon at the end of the command line.

- Comment lines, which begin with a dash followed by an asterisk (-*), are collapsed separately from other Dialogue Manager commands.

- Adding a blank line between blocks of similar code, such as comment lines or Dialogue Manager commands, separates the block of code and a new segment for code folding is created.

- In files, where nested blocks of code are indicated by starting and ending curly brackets { }, such as JavaScript and CSS files, code-folding icons are enabled on the lines where the open and close curly brackets are displayed.

- If the cursor is currently in a block of code, you can press Alt+0 to collapse all other regions, except for the block of code currently in focus.

- You can also press Shift+Alt+0 to expand all regions of code.
When using Search and Replace features, if the search criteria is met within any collapsed lines, the lines are automatically expanded to show the search criteria found.

Autocomplete

Autocomplete is a function that allows progressive suggestion of code as you type.

You can selectively turn Autocomplete off or on from the Options menu on the toolbar. The default value is on.

When typing code, a list of suggestions will display below the text, in alphabetical order. You can use the up and down arrow keys to navigate to the desired value and press Enter to select the value.

The suggestion list displays one of the following labels, on the right of each suggestion:

- **WebFOCUS keyword.** Indicates that a command is a WebFOCUS keyword, such as CLEAR and COLUMN, in the following example.

- **local.** Is used for words that are not WebFOCUS keywords, such as CITY_NAME. The label, local, will be displayed on the second or later attempts to type the word.

**Note:** In the following example, the variables COG_US and CITY_NAME are not WebFOCUS keywords, they are local to the syntax. On the second attempt or later attempt to type the letter C, both variables display as local, as shown in the following image.

Autocomplete is available for FOCEXEC, HTML, JavaScript, CSS, and Python files. Autocomplete is not supported for SQL, R, STY, and TXT files.
Procedure: How to Create a Simple Procedure With Autocomplete

1. On the Editor toolbar, from the Options menu, select Autocomplete.
2. Create a new GRAPH request.
3. Type the letter G in the Editor.

Note that the command GRAPH is suggested, as shown in the following image.

![New FOCEXEC File* ![Autocomplete Suggestions]

Note also that GRAPH is a WebFOCUS keyword.

4. Scroll and press Enter to select GRAPH.
5. Type the letters FI in the Editor.

Note that the command FILE is suggested, as shown in the following image.

![New FOCEXEC File* ![Autocomplete Suggestions]

6. Scroll and press Enter to select FILE.
7. Type the name of the Master File.

Note: Autocomplete is not supported for Master Files.
8. Type the letter P in the Editor.

Note that the command PRINT is suggested, as shown in the following image.

![New FOCEXEC File* ×
1 ▼ GRAPH FILE retail_samples/wf_retail
2 P
3 POSITION WebFOCUS keyword
   POSITV WebFOCUS keyword
   POST WebFOCUS keyword
   PRDNOR WebFOCUS keyword
   PRDUNI WebFOCUS keyword
   PRINT WebFOCUS keyword
   PTOA WebFOCUS keyword
   PUTDDREC WebFOCUS keyword

9. Scroll and press Enter to select PRINT.
10. Type a field from the Master File, for example, CITY_NAME.
11. Press Enter to move to the next line and then type the letter E in the Editor.
12. The command END is suggested, as shown in the following image.

![New FOCEXEC File* ×
1 ▼ GRAPH FILE retail_samples/wf_retail
2 E
3 PRINT CITY_NAME
   ECHO WebFOCUS keyword
   EDIT WebFOCUS keyword
   ELSE WebFOCUS keyword
   ENCRYPT WebFOCUS keyword
   END WebFOCUS keyword
   ENDCALL CASE WebFOCUS keyword
   ENDFROMCASE WebFOCUS keyword
   ENDFOR WebFOCUS keyword
   ENDSTYLE WebFOCUS keyword

13. Scroll and press Enter to select END.

**Status Bar**

The Status bar displays contextual information for an open file at the bottom of the Editor.

You can selectively turn the status bar off or on from the Options menu on the toolbar. The default value is on.
Note: The Status bar is global for the Editor environment. If you uncheck the Status Bar option in one tab, this is applied to all open tabs, including any new tabs you create in the Editor.

The following values display in the Status bar:

- **Length.** Length, in characters, of the text in the active file.
- **Lines.** Total number of lines in the current file, including blank lines.
- **Line.** Line number of cursor position.
- **Column.** Column number of the cursor position.
- **Insert.** Indicates the status of insert or overtype mode. This setting is controlled by the Insert key on your keyboard. When the value for Insert is ON, your keyboard is in insert mode, and text is placed in front of the cursor position. When the value for Insert is OFF, your keyboard is in overtype mode, and existing characters are overwritten.
- **Caps Lock.** Indicates the status of Caps Lock. This setting is controlled by the Caps Lock key on your keyboard. No value is shown when Caps Lock is off. The value on the Status bar will not change when you press the Caps Lock key. The value is detected and changed to CAPS when you type a character on the keyboard.
- **Num Lock.** Indicates the status of Num Lock, when working with the numeric keypad. This setting is controlled by the Num Lock key on your keyboard. No value is shown when Num Lock is off. The value on the Status bar will not change when you press the Num Lock key. The value is detected and changed to NUM when you type a number using the numeric keypad.

The following image shows an example of values displayed in the Status bar.


**Indent Guides**

Indent guides are useful in helping you understand the structure of code by showing indentation levels and to quickly find where a block of code starts and ends.

You can selectively turn indent lines off or on from the Options menu on the toolbar. The default value is on.
Clicking the Tab key inserts a 4-space indent. The indent guides are represented by vertical light gray lines, as shown in the following image.

Using Search and Replace

The Search button on the toolbar opens the Search and Replace pane, where you can search for and replace text in the file you are currently editing.

You can click the Search icon again to toggle the Search and Replace pane off or on. You can also close the Search and Replace pane by clicking the X in the upper-right corner of the screen.

The Search and Replace pane is shown in the following image.

The Search and Replace pane contains the following options:

- **Find**. Finds the search criteria specified in the Find input box.
Replace With. Replaces the search criteria specified in the Find input box with the criteria specified in the Replace With input box.

Match case. Locates the search criteria specified in the Find Input box when there is an exact match of the criteria and case in the Editor. This option is off, by default.

Match whole word only. Locates an exact match, whole word only, for the search criteria specified in the Find input box. This option is off, by default.

Wrap around. If the search reaches the bottom of the file, it automatically continues to search from the top of the file and ends at the current position of the cursor. If this option is not selected, search ends at the bottom of the file, regardless of where the cursor is located. This option is on, by default.

Find Next. Finds the next instance of the search criteria specified in the Find input box, using the selected options.

Replace. Finds the next instance of the search criteria specified in the Find input box, using the selected options. The search criteria is replaced with the criteria specified in the Replace With input box, and the next instance is highlighted.

Replace All. Finds all instances of the search criteria specified in the Find input box and replaces them with the criteria specified in the Replace With input box.

Note:

You can also press also Ctrl+F or Ctrl+H to open the Search and Replace pane.

If the search criteria is not found, a message displays, indicating that the text was not found.
Working With the Editor Canvas

The Editor canvas is the main editing area. This is where you type code and see your enabled preferences, if any. The right-click menu options only work in this area, but the shortcut keys are always available. The code canvas is shown in the following image.

Right-click menu options include:

- **Copy.** Copies your selection to the clipboard. You can also press Ctrl+C to copy text.
- **Cut.** Deletes your selection and places it on the clipboard. You can also press Ctrl+X to delete text.
- **Paste.** Pastes your selection from the clipboard to the location indicated by the cursor. You can also press Ctrl+V to paste text.
- **Select All.** Selects all text in the active file. You can also press Ctrl+A to select all text.
- **Clear.** Deletes the selected text. You can also use the Delete key to delete the selected text.
Undo. Reverses the last action, such as typing, pasting, or deleting text. You can also press Ctrl+Z to undo the last action. If there are no changes to a page, the Undo option is not active. To undo multiple actions, including actions that have been saved, you can click the Undo option or press Ctrl+Z repeatedly.

Redo. Restores a previously undone action. You can also press Ctrl+Y to restore a previously undone action. If the Redo option does not apply, the option is not active. To redo multiple actions, including actions that have been saved, you can click the Redo option or press Ctrl+Y repeatedly.

Uppercase. Changes selected lines of text from lowercase to uppercase. If the selected text is mixed case, all text is converted to uppercase. If the selected text is uppercase, no change occurs.

Lowercase. Changes selected lines of text from uppercase to lowercase. If the selected text is mixed case, all text is converted to lowercase. If the selected text is lowercase, no change occurs.

Comment/Uncomment. Adds the dash asterisk (-*) characters in a FOCEXEC at the beginning of a line of syntax in which the cursor is inserted. These characters indicate a comment. When multiple lines of code are selected, the comment is inserted on each selected line. When the comment is selected a second time, comments on selected lines are removed.

Introducing the TIBCO WebFOCUS® Mobile App

The WebFOCUS® Mobile App is a simple, intuitive app that empowers users to perform reporting and analysis right from their mobile devices. The WebFOCUS mobile app delivers rich, deep, highly interactive analytic functionality, fully exploiting the native device gestures that are already familiar to the user. With the WebFOCUS app, you can manipulate data from a variety of sources in an almost unlimited number of ways in just a couple of taps. The app allows you to manage business dashboards and content, even when you are not connected to the Internet.
The WebFOCUS mobile app is displayed in the following image.

With the WebFOCUS mobile app, you can:

- Run reports, graphs, and dashboards online, from any corporate data in any source.
- Sort, filter, drill down, roll-up, calculate, and more, in both online and offline modes.
- Fully support native device characteristics, gestures, charting, menus, and controls within content.
- Open and catalog documents received as email attachments.
- Find and retrieve content using native search capabilities.
- Share content with other members of your organization.

**Configuring TIBCO WebFOCUS Mobile App**

To download WebFOCUS mobile app on an iOS device, simply type `webfocus` in the search field in the App Store and choose the WebFOCUS app.

On an Android™-based device, connect to the Google Play store, navigate to the WebFOCUS mobile app, and tap *Install*.

Once the app is installed on your device, you can start configuring a connection to your WebFOCUS environment.

**Prerequisites to Using the TIBCO WebFOCUS Mobile App**

To perform online analytics, you must connect to the Wifi network that your company uses or configure a VPN connection on a remote device.
Procedure: How to Configure a Connection in TIBCO WebFOCUS Mobile App

1. Tap the WebFOCUS mobile app icon.
   The app opens and displays the Sites screen.

2. Tap the + icon to add a connection.
   The Add Site screen displays.

3. Populate the fields, as described below.

   **HTTPS**
   Specifies whether the server is on an HTTP or HTTPS site.

   **Host name**
   The Host name, or IP address, of the machine that is hosting the WebFOCUS client.

   **Host port**
   The port number to the WebFOCUS client.

   **Context path**
   The application context path. For example, /ibi_apps.

   **Host title**
   The name of your WebFOCUS client connection. The name can be anything you want it to be.

   **Note:** The Host title only shows as a field when you configure the connection for the first time. If you edit an existing environment, the host title does not show as an option.

   **User name**
   The user name you use to log in to your WebFOCUS client.

   **Password**
   The password you use to log in to your WebFOCUS client.

   **New interface**
   Enable this option to connect to the WebFOCUS Home Page. This option is only available when connecting to a WebFOCUS 8.2 Version 04 environment or higher. The default value is Off.

   **Use SSO**
   Enable this option to use a single sign on (SSO) solution to sign in to the environment. If such solution is enabled, the screen redirects to the SSO login screen within the app. The default value is Off.

   **Note:** For more information on configuring pre-authentication with a single sign on (SSO) solution, see the WebFOCUS Security and Administration technical content.
4. **Tap Test Connection.**

If your configuration is correct, a message appears on the bottom of the screen confirming that the site settings are valid, as shown in the following image.

![Test Connection Message]

**Note:** If the connection is unsuccessful, you will see an error message identifying the field that causes an issue.

5. **Tap SAVE.**

The Sites screen displays, and the new connection is added, as shown in the following image.

![Sites Screen]

6. **Tap the newly configured connection.**

The WebFOCUS Home Page loads.
Navigating the TIBCO WebFOCUS Home Page on a Mobile App

The Home Page is the default landing page that opens when you first sign in to WebFOCUS from the WebFOCUS app, as shown in the following image.

The Home Page serves as a centralized place for viewing and sharing content, and performing searches. There are several interface and functionality changes that occur when you navigate the Home Page on the WebFOCUS mobile app, allowing you to view the content saved in your environment.
When you view the Home Page on the WebFOCUS app, the banner navigation is hidden from view to allow more space for your content. You can bring the banner navigation back by tapping the menu button on the navigation bar. The sidebar allows you to navigate between the Home, My Workspace, Shared with Me, and Workspaces views on the Home Page, as shown in the following image.

The banner menus are also hidden in the mobile app view. To access the functionality available from the banner menus, you need to use the full desktop version of the software. The Change Password and Sign Out options are available from the sidebar and also from the user menu in the upper right corner of your mobile display.

**Note:** Depending on the type and size of your device, your display might switch to the full version of WebFOCUS in the landscape view.

You can run content in the WebFOCUS app by double-tapping an item. Select shortcut menu options are also available from the app. To access the shortcut menu options, tap and hold the item. The shortcut menu options are context-sensitive, and vary, depending on the item or element you want to access.
To navigate between workspaces and folders inside the WebFOCUS app, use the Resources tree or the breadcrumb trail in the Workspaces view. The arrows between the directories on the breadcrumb trail allow you to switch between different folders. Tap the ellipsis to navigate between the levels that are hidden from view.

You can also search, switch between list and grid views, refresh and sort content from the mobile app. These functions behave in the same way as they do in the full desktop view.

**Using TIBCO WebFOCUS Mobile App to View In-Document Analytics Reports**

An In-Document Analytics report is an interactive report that is designed for offline analysis. It contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

Viewing In-Document Analytics reports on mobile devices is only possible if JavaScript is enabled in the web browser. Some browsers may function differently depending on the operating system. WebFOCUS mobile app makes it easy to view any In-Document Analytics report on any iOS or Android-based device.

**Procedure: How to View an In-Document Analytics Report in the WebFOCUS App**

In this example, we download an In-Document Analytics report from an email attachment and open it in the WebFOCUS mobile app.

1. In the mail app of your mobile device, open an email with the In-Document Analytics report attachment and then tap on the attached report to download it.

   The message displays informing you that JavaScript is needed for opening the report, as shown in the following image.

2. Tap the Share icon.

   The Share options that are enabled on your device display.
3. Tap *Copy to WebFOCUS*, as shown in the following image.

![Image of Copy to WebFOCUS option]

**Note:** Depending on your device and its preferences, you may need to scroll and tap *More* to see the *Copy to WebFOCUS* option.
The WebFOCUS ReportViewer screen opens inside the WebFOCUS mobile app, displaying the report. You can now work with the report, online and offline, and use its interactive features, as shown in the following image.
Accessing Data

Learn how to access all your data from a single streamlined environment using WebFOCUS. You can connect to various data sources, configure adapters, add or change connections, upload and profile data files before loading them, pivot columns to rows, and Join multiple tables. Then visualize your data and use it to create charts, reports, and other content.

In this chapter:

- Preparing Spreadsheets for Upload
- Uploading Data Files
- Pivoting Data
- Connecting to Data Files
- Joining Data
- Creating HOLD Files
- Editing Metadata
- Preparing and Managing Data
- Extending Metadata With Reporting Objects
- Changing Metadata Classification Values When Uploading Data Files
- Running Predictive Analytics on Your Data
- Running Datasets Against Saved Models

Preparing Spreadsheets for Upload

Uploading data to WebFOCUS can be made easier if you first familiarize yourself with the data file, and then ensure that it is properly formatted for upload, so that geographic data, hierarchies, and other important aspects of your data are recognized. This is important because the synonym created for your uploaded data provides the basis for quality analytical content.
You can use the following techniques to prepare your data for the uploading process.

**Naming Conventions and Microsoft Excel Sheet Names**

For Excel spreadsheets, the name of the file is not important, but the name of the worksheet that contains your data is used to generate the synonym name. For the best results, note the following guidelines:

- Ensure that the worksheet name is meaningful. For example, Store Sales is better than Sheet1.
- Remove special characters from the worksheet name. Spaces will be converted to underscores, but all non-alphanumeric characters should be removed from the name, such as the following:
  /`~!@#$%^()-+={}|;,
- Remove or replace NLS characters with standard alphanumeric characters.

The following image shows a worksheet with a meaningful name, Retail Sales.

While you have an opportunity to edit the worksheet name within the Upload workflow, editing in Excel may be preferable. Note that your spreadsheet data and column titles may contain National Language Support data and special characters.

For CSV files, there is no worksheet name, so the CSV file name is used to generate the synonym name. For this reason, all of the limitations identified for Excel worksheet names apply to the CSV file name. Be sure to check and adjust the file name prior to the upload.
Removing Introductory Information

Sometimes, an Excel spreadsheet contains formatted headings in the first few rows. This information cannot be imported into WebFOCUS and should be removed. Delete the introductory rows and save the file before uploading. Alternatively, you can define a data range within your worksheet and leave the introductory information in place. The following image shows an example spreadsheet with a heading and subheadings highlighted.

Placing Column Titles in the First Row

For data to be useful in WebFOCUS, your data columns must be identified and properly described in the synonym that is generated during the upload process. You can make this easier by ensuring that the first few rows of your Excel spreadsheet contain column titles that are meaningful to you and to other users who will be using it. An example of meaningful column titles is shown in the following image.

If your spreadsheet has more than one row of column titles, WebFOCUS can merge the information when creating the synonym. You will be given an option to specify how many first rows of the Excel file contain title information in the Upload workflow.
Removing Aggregated Information

Excel spreadsheets may contain subtotals, grand totals, and other non-data row information. Data aggregation is performed by WebFOCUS, so you should remove these kinds of rows from your spreadsheet and save the file before uploading it.

Using Excel Name Ranges

Data ranges defined within your Excel worksheet can be helpful for the following reasons:

- Your worksheet may have introductory information, such as formatted headings or non-data information, in the first few columns.
- You may not want to import all of the data columns found on your worksheet.

You can define a data range in your worksheet to remove the data that you want WebFOCUS to process during upload, and leave your spreadsheet in its original format. An example of this is shown in the following image.

Preparing Hierarchical Data Columns

WebFOCUS recognizes columns of data that have hierarchical relationships. This is useful because the field names are arranged more logically in InfoAssist and because it facilitates Auto-drill capabilities in the content. Auto-drill lets you drill up and down a field hierarchy automatically, making the content engaging and useful.
To help WebFOCUS recognize hierarchical columns correctly, ensure that the column titles begin with a common word or words, and are arranged left-to-right in the correct top-to-bottom direction, as shown in the following image. In the Upload workflow, you can define and edit dimension hierarchies prior to creating the synonym. You can also do this prior to the upload in Excel.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store Name</td>
<td>Product Category</td>
<td>Product Subcategory</td>
<td>Sale Date</td>
<td>Revenue</td>
<td>Cost of Goods</td>
<td>Gross Profit</td>
</tr>
<tr>
<td>Des Moines</td>
<td>Video Production Video</td>
<td>Video Editing</td>
<td>9/5/2013</td>
<td>3487.45</td>
<td>2288</td>
<td>1199.45</td>
</tr>
<tr>
<td>Dayton</td>
<td>Video Production Video</td>
<td>Video Editing</td>
<td>9/1/2013</td>
<td>13371.56</td>
<td>9459</td>
<td>3912.56</td>
</tr>
<tr>
<td>Dayton</td>
<td>Video Production Video</td>
<td>Video Editing</td>
<td>12/1/2013</td>
<td>19097.49</td>
<td>13386</td>
<td>5711.49</td>
</tr>
<tr>
<td>South Salt Lake</td>
<td>Video Production</td>
<td>Video Editing</td>
<td>12/1/2013</td>
<td>10763.83</td>
<td>8138</td>
<td>2625.83</td>
</tr>
<tr>
<td>Brussels</td>
<td>Accessories Universal</td>
<td>Remote Controls</td>
<td>3/2/2010</td>
<td>10060.72</td>
<td>7822</td>
<td>2238.72</td>
</tr>
<tr>
<td>Brussels</td>
<td>Accessories Universal</td>
<td>Remote Controls</td>
<td>4/1/2010</td>
<td>12839.15</td>
<td>9456</td>
<td>3383.15</td>
</tr>
<tr>
<td>Brussels</td>
<td>Accessories Universal</td>
<td>Remote Controls</td>
<td>5/1/2010</td>
<td>8848.13</td>
<td>6942</td>
<td>2856.13</td>
</tr>
<tr>
<td>Brussels</td>
<td>Accessories Universal</td>
<td>Remote Controls</td>
<td>6/1/2010</td>
<td>10357.7</td>
<td>7584</td>
<td>2773.7</td>
</tr>
<tr>
<td>Brussels</td>
<td>Accessories Universal</td>
<td>Remote Controls</td>
<td>7/1/2010</td>
<td>10979.11</td>
<td>8283</td>
<td>2696.11</td>
</tr>
</tbody>
</table>

Removing Date Formulas

Spreadsheets may contain a date column where the values are computed by Excel using a formula. You need to convert these computed values into simple values before uploading a spreadsheet. To remove date formulas, select a column, right-click, and then click Copy. Then, right-click the selected column again and select Values. This can be found under the Paste Options menu, which is highlighted in the following image. Menu options may vary by Excel release. Now you can see that each cell contains a date value, and WebFOCUS can decompose your dates into useful components for use in InfoAssist.
Uploading Data Files

You can upload delimited, Excel, JSON, or XML files into WebFOCUS, where you can preview and modify the data before loading it to a database, then create visualizations or prepare it for future analysis.

Procedure: How to Upload Data Files

1. On the WebFOCUS Hub, click the plus menu, and then click Get Data, or, on the WebFOCUS Home Page, click the Get Data button.

The Get Data dialog box opens, as shown in the following image.

2. Under Local Files, click your upload file type. You can select from the following file types: Delimited Files, Excel, JSON, or XML. An Excel file can contain a single worksheet or multiple worksheets. Delimited, JSON, and XML files are individual data sources.
3. In the Open dialog box for your operating system, select the file that you want to upload, and then click **Open**.

This opens a preview, as shown in the following image. In this example, we are showing a multi-worksheet Excel file.

Your file will be loaded to the default data store of the displayed Adapter. You can click the Adapter name to select an adapter folder and connection where your data is loaded. For more information see *Changing a Target Connection When Uploading Files*.

You can click the Application Folder name to select an application folder and specify where your synonym is created. For more information see *Changing a Target Application When Uploading Files*.

You can change the name of your worksheet by clicking inside the Name field and typing a new name. From the Actions column, click the **Preview** or **Hide** buttons to control the preview of sample data.
You can select individual worksheets to preview or load. A single-sheet Excel file, or the first worksheet of a multi-sheet Excel file, is automatically previewed.

You can modify your data, such as changing the number of skipped rows or header rows, displaying your data as formatted or raw, or choosing from more advanced and customized file options.

Uploaded Excel worksheets are examined for leading rows that contain titles or other extraneous information before the header rows and data values. These leading rows are automatically skipped. The number of rows to be skipped is displayed in the Skipped Rows field, and can be changed.

**Note:** If uploading a CSV or other delimited file, the data preview toolbar displays a Missing Value field. The characters in this field indicate a missing value in your data source, for example: "NULL". To see the Missing Value field when uploading an Excel file, click the More button, and then expand the Advanced group.

You can click the Choose Columns icon to select which columns you want to load to the target database or data store. For more information see Choosing Columns to Load When Uploading Files.

Column drop-down menu options let you change geographic roles and data types, or rename columns.

Numeric fields are generally classified as measures. If the name of a numeric field implies that it is more likely to be a dimension than a measure, it is classified as a dimension by default. For example, fields ending with _ID such as ORDER_ID are classified as dimensions. This allows you to create content that more accurately represents your data.

To change field classifications from dimensions to measures, select Convert to measure.

To change field classifications from measures to dimensions, select Convert to dimension.

4. Click the Load button next to the worksheet you want to load.

Your worksheet loads, and its load status is updated, as shown in the following image.
You can still make changes to your worksheet after it is initially loaded, and then click the Reload button to load your changes. Once your file is uploaded, you can create your own visualizations by clicking Visualize Data.

Changing A Target Connection When Uploading Files

When using Get Data to upload a file, with appropriate permission, you can override the default Adapter and Connection settings by selecting an alternative configured adapter from your current profile.

**Procedure:** How to Change a Target Connection

When uploading an Excel or delimited file, you can select an adapter folder and specify the connection where your data is loaded.

1. Upload an Excel or delimited file using Get Data.

   The Preview page opens, as shown in the following image.

   ![UI Preview Image](image)

   The Adapter column remains blank until your data is loaded. Once you load a file, the Adapter column displays the adapter and connection where your data was loaded.

2. Click the Adapter name.
The Database Location dialog box opens, and displays the adapters configured on your server, as shown in the following image.

3. Click an available adapter, and then click Select.

The Configure Connections dialog box opens, and displays the connections configured for the adapter you selected, as shown in the following image.

4. Click an available connection and then click Select.

The Preview page displays.

5. Click Load.
Your selected connection displays in the Adapter column, as shown in the following image.

![Image of Adapter column]

Your data is saved by default to this connection for subsequent file loads.

**Changing A Target Application When Uploading Files**

When using Get Data to upload a file, with appropriate permission, you can override the default Application setting where the synonym is created by selecting an application folder from your current application path.

**Procedure: How to Change a Target Application**

When uploading an Excel or delimited file to create a synonym, you can select an application folder and specify where your synonym is created.

1. Upload an Excel or delimited file using Get Data.

   The Preview page opens, as shown in the following image.

   ![Image of Preview page]

   The Application Folder column remains blank until your data is loaded. If you have previously loaded a file, the Application Folder column displays the application where you created your synonym.

2. Click the Application Folder name.
The Select Application Folder dialog box opens and displays your application folders in your current application path, as shown in the following image.

You can click the View icon to switch between the Grid view, as shown above, and the List view, as shown in the following image.

You can click the Choose Columns icon to select which columns to display in the List view.

3. Click your target application folder.
4. Click Select.

The Preview page displays.

5. Click Load.
Your selected application displays in the Application Folder column, as shown in the following image.

![Application Folder]

Your data is saved by default to this application folder for subsequent file loads.

**Choosing Columns to Load When Uploading Files**

When using Get Data to upload a file, you can choose which columns will be loaded to the target database or data store, so you only load the columns you need.

**Procedure: How to Choose Columns to Load**

When uploading an Excel or delimited file, you can choose the columns that you want to be loaded.

1. Upload an Excel or delimited file using Get Data.

   The Preview page displays, as shown in the following image.

   ![Preview Page]

2. Click the Choose Columns icon.

   The Choose Columns dialog box displays. All columns are selected by default.
3. Clear the check boxes for the columns you do not want to be loaded, as shown in the following image.

You can return the columns to their original selected settings by clicking *Reset to defaults*.

4. Click **OK**.

The Preview page displays, and shows only the columns you want to be loaded, as shown in the following image.

**Note:** You can click the *Choose Columns* icon again to change which columns you want to be loaded.

5. Click **Load** to load your data.

### Processing Format Conversion Errors when Uploading Data

When uploading data from a delimited or Excel file, a format conversion error can occur, such as when a numeric field contains a non-numeric value. You have load options to control how to process rows that contain format errors, and to control how many format errors are allowed before processing stops.
The following conversion error load options are available when uploading files:

- **Conversion error processing.**

  You can select options *Reject* or *Ignore*. Reject, the default value, skips rows with incorrect data, and gives a warning message. Ignore replaces the values causing errors with default values, and continues processing the records.

- **Conversion error limit.**

  You can enter values of 0 to 999999. This sets a limit for the number of records allowed with warnings about data conversion errors. 0 is the default value, which allows unlimited warning messages.

These load options are available when uploading files in the Simple Mode or the Advanced Mode.

**Procedure:** How to Process Format Conversion Errors in Simple Mode

1. Upload a desktop file using Get Data. For more information, see *Uploading Data Files*.

   The Uploading Data page opens, as shown in the following image.

![Uploading Data Page](image)

2. Click **More**.

   The More File Options dialog box opens. Under Source Load Options, the conversion error options display, as shown in the following image.

![More File Options Dialog Box](image)

   You can select *Reject* or *Ignore* from the Conversion error processing dropdown menu. You can also enter a value in the Conversion error limit field.
3. Click Save and Redo Prepare to save your changes.

**Procedure: How to Process Format Conversion Errors in Advanced Mode**

1. On the WebFOCUS Hub, click the plus menu, select Get Data (Advanced), click a desktop file type, and then select a file to upload, or, on the WebFOCUS Home Page, click the plus menu, click Prepare and Manage Data, click Get Data, click Advanced Mode, click a desktop file type, and then select a file to upload.

The Uploading Data page opens, as shown in the following image.

2. Click the Advanced Options vertical ellipsis.

3. From the menu, select Load Options.

The Load Options dialog box opens. Under Source Load Options, the conversion error options display, as shown in the following image.

You can select Reject or Ignore from the Conversion error processing dropdown menu. You can also enter a value in the Conversion error limit field.
4. Click OK to save your changes.

**Pivoting Data**

Some data files may contain repeating values, such as sales figures for a series of years. When uploading a spreadsheet or delimited file with columns of repeating values, you can preview these columns and transform them into rows.

**Procedure: How to Pivot Columns Into Rows**

1. On the WebFOCUS Hub, click the plus menu, and then click Get Data, or on the WebFOCUS Home Page, click the Get Data button.

   The Get Data dialog box opens, as shown in the following image.

   ![](image)

2. Under Local Files, click your Delimited or Excel file type for upload. An Excel file can contain a single worksheet or multiple worksheets. A delimited file is an individual data source.
3. In the Open dialog box for your operating system, which is shown in the following image, select the file that you want to upload, and then click Open.

![Open dialog box](image1.png)

This opens a preview, as shown in the following image. In this example, we are showing a multi-worksheet Excel file. The previewed worksheet contains columns for each year from 1960 to 2012.

![Previewed worksheet](image2.png)

4. To multi-select all the year columns, click inside the first year column, hold down the Shift key, and click inside the last year column.

5. Click the menu button in any of the selected year columns, and click Multiple columns to rows, as shown in the following image.

![Pivot table](image3.png)
The repeating year columns now display as rows, as shown in the following image.

<table>
<thead>
<tr>
<th>Country Name, Afghanistan</th>
<th>Indicator, Name, GDP per capita (current U.S.)</th>
<th>Indicator Code, Y19OFFPPCAPCD</th>
<th>Pivot Value</th>
<th></th>
<th>Pivot Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angola</td>
<td>AGO GDP per capita (current U.S.)</td>
<td>Y19OFFPPCAPCD</td>
<td>831,304200</td>
<td>1984</td>
<td>1984</td>
</tr>
<tr>
<td>Angola</td>
<td>AGO GDP per capita (current U.S.)</td>
<td>Y19OFFPPCAPCD</td>
<td>831,304200</td>
<td>1987</td>
<td>1987</td>
</tr>
<tr>
<td>Angola</td>
<td>AGO GDP per capita (current U.S.)</td>
<td>Y19OFFPPCAPCD</td>
<td>831,304200</td>
<td>1990</td>
<td>1990</td>
</tr>
</tbody>
</table>

6. Click the menu button in the Pivot Value column, click *Rename*, and type a new column title in the dialog box that reflects the numeric cell you are describing. For example: *Amount*.

7. Click *OK*.

8. Click the menu button in the Pivot key column, click *Rename*, and type a new column title in the dialog box that reflects the numeric cell you are describing. For example: *Year*.

9. Click *OK*.

The column titles are renamed, as shown in the following image.

To revert your pivoting changes, click *Remove Pivot*.

**Pivot Columns with Date Headers**

If the repeating columns have headers that are dates, the fields are recognized as date values when pivoted into rows, so you can report from the table using date functions.

An uploaded data file with selected repeating columns that have date headers is shown in the following image.

**Procedure:** How to Select Columns to Pivot Using the Context Menu

From the preview page, you can easily select columns to pivot using the context menu.

1. Click a column context menu icon.
The context menu opens, as shown in the following image.

2. Hover over the Pivot option.
3. Click the Starting Column field dropdown arrow.
4. Select the starting column of your pivot column range.
5. Click the Ending Column field dropdown arrow.
6. Select the ending column of your pivot column range.
7. Click OK.

The context menu closes, and the sheet preview refreshes to show the resulting pivot value and key columns.

**Connecting to Data Files**

You can connect to various data sources and create synonyms, configure new adapters, add connections to existing adapters, or change adapter connections. Then use your connected data for content creation or analysis.

**Procedure: How to Connect to Data Files**

1. On the WebFOCUS Hub, click the plus menu, and then click Get Data, or, on the WebFOCUS Home Page, click the Get Data button.
The Get Data dialog box opens, as shown in the following image.

2. Under Server Files, click a configured adapter.

The Configure Connections dialog opens, as shown in the following image.

3. Double-click an available connection.
The Create Synonym dialog box opens, as shown in the following image.

4. Select a data source for synonym creation.
5. Click the *Add* button.

Your synonym opens in WebFOCUS Designer, where you can create content. Click the *DATA* tab to view your synonym, as shown in the following image.
Procedure: How to Configure a New Adapter

1. Open the Get Data dialog box, as shown in the following image.

Depending on your version of WebFOCUS and your permissions, you may have the option to configure a new adapter.

2. Under the Server Files area, click the New Connection icon.

The Available adapter dialog box opens, as shown in the following image.

3. Right-click an adapter and click Configure.
A parameters panel opens, as shown in the following image.

4. Enter your parameters in the panel.
   See the information specific for your adapter in the Adapter Administration technical content.

5. Click Test, if available, to test your configuration.

6. Click Configure.
   Your configured adapter will display in the Get Data dialog box.

**Procedure: How to Add a Connection**

1. From the Get Data dialog box, under Server Files, click a configured adapter.
The Configure Connections dialog box opens, as shown in the following image.

2. Click the New Connection icon. A parameters panel opens.
3. Enter your connection parameters.
   See the information specific for your adapter in the Adapter Administration technical content.
4. Click Test, if available, to test your connection.
5. Click Configure.
   Your configured connection will display in the Configure Connections dialog box.

**Procedure:** How to Change a Connection

1. From the Get Data dialog box, under Server Files, click a configured adapter.
The Configure Connections dialog box opens, as shown in the following image.

2. Right-click a connection.
3. Select Properties from the shortcut menu.
   A parameters panel opens.
4. Change your connection parameters.
   See the information specific for your adapter in the Adapter Administration technical content.
5. Click Test, if available, to test your connection.
6. Click Configure.
   Your changed connection will display in the Configure Connections dialog box.

Joining Data

You can Join data sources from the data tab in WebFOCUS Designer, and then use your joined data to create new content from within the Visualization tab.

The joined data structure is not applied permanently to the metadata. This allows you to virtually join multiple data sources as if they were a single data source, from which you can report in a single request. This can increase the number of relevant fields available for use in your content, giving you an expanded selection of data specific to your charting purposes.
The Join is created when fields that match in your original data source and second data source are identified. For example, you can Join two data sources on a Join field of ID Product, using just one data source in your chart. You can then create content using your Joined data source.

The following image shows an example of joined data in WebFOCUS Designer.

**Procedure: How to Create a Basic Join**

You can Join data sources based on shared fields to enhance the data available to you, and then create charts based on the joined data source.

1. From the WebFOCUS Designer Visualization tab, click the Data tab.
Your data source displays as a synonym on the Data tab canvas, and sample data displays in a tabular format similar to a spreadsheet, as shown in the following image.

2. From the Data panel, drag a synonym to the Join bubble of the synonym to which you want to connect it, as shown in the following image.

![Diagram showing synonym dragged to Join bubble](image)

**Note:** You can also drag a synonym to the Union bubble. While a join adds columns to existing rows based on a relationship between columns in the two data sources, a union adds new rows by combining the results of two queries that have a common domain and number of columns. For more information about unions, see *Creating a Data Flow* in the TIBCO WebFOCUS Reporting Server Administration manual.
A Join object is added between the two synonyms on the canvas as shown in the following image.

The canvas provides the following toolbar options:

- **Get Data.** Opens the Get Data dialog box, where you can select additional data sources to be joined with your original data source.

- **Insert Join.** Displays potential Join candidates from a relational database, including confidence scores, as shown in the following image.
- **Clear Join.** Removes the Join from the data flow. You can also right-click the Join object or a synonym joined to the original data source, and click *Delete* to remove the Join.

  **Note:** Before removing a recursive Join (when a table is joined to itself) you must remove any fields with active content from the first instance of the table.

The canvas provides the following menu options:

- **Flow view.** An icon represents each synonym, and an icon that displays the type of join represents each join.

- **Model view.** A list box represents each synonym, and a vector between the joined synonyms represents each join.

- **Arrangement.** Select a Layout option to define the spacing between objects on the canvas, or click *Auto Arrange* to reset the display of objects in the canvas to the default arrangement:
  - Vertically spread out.
  - Vertically compressed.
  - Vertically compressed with long H-space.
  - Default.
  - Auto Arrange.

- **More options.** Sets the following Join defaults:
  - **Insert child segment with snowflakes.** No is the default, which inserts only the segment selected. You can select Yes to insert the selected segment and all of its descendants.
  - **Display full component names.** Yes is the default. Full component names are field names qualified/prefixed with the synonym and segment name.
  - **Use Monotree.** Yes is the default. The monotree view displays the current folder in the Data panel and provides navigation to other folders. Select No to display all folders in a traditional tree view.
  - **Show undo/redo button with history.** No is the default. Select Yes to display the history button.
Click the pencil icon to display a Join configurator and data profiler, as shown in the following image.

Using the Join configurator, you can change the join type or change expressions and operators. Check the Multiple check box to indicate a one-to-many Join. The following Join types are available:

- **Inner.** Returns only records where the selected join fields match between the left-side table and the right-side table. If there are no matches, no records are returned.

- **Left Outer.** Returns all records from the left-side table, and only matched records from the right-side table.

- **Right Outer.** Returns all records from the right-side table, and only matched records from the left-side table.

- **Full Outer.** Returns all records, matched and unmatched, from the left-side table and the right-side table. This type of Join can potentially return very large result-sets and can take longer to run.
Click **Suggestions** to display Join Suggestions, including a confidence score based on any database relationships and the number of matching names in the fields, as shown in the following image.

![Join Clauses and Suggestions](image)

Click the plus sign (+) to add the suggestion to the join pair list.
In the *Join Profiler* tab, a join analyzer chart displays the number of matching values from each part of the join and the total number of values included in the data source as a result of the join, and a key fields grid showing LHS and RHS match states, as shown in the following image.

You can click the table bars or numbers to display the matching fields in the report, and then click the *Clear selections* icon to clear the matches and return the report to show all values.

In the *Sample Data* tab, the values for the field being joined in each synonym are displayed, as shown in the following image.
To create content from your Join, click the Visualization tab and then click Save to save your content.

Creating HOLD Files

A HOLD file is the stored output of an executed extract, that you can use as the source for WebFOCUS reports and visualizations. A HOLD file can be used immediately within the same procedure that creates it, or selected as the data source for new reports and visualizations.

A HOLD file is valuable when you want to do the following:

- Extract fields from a large data source for faster and more efficient retrieval in subsequent requests. This reduces processing time, enabling you to create reports and charts rapidly against a smaller, more specialized data set. This improves efficiency while giving you the flexibility that you need when working with smaller subsets of your data.

- Store virtual field values or summary values calculated in one request for further processing in another request. This allows you to reuse calculated values, decreasing the effort required to recreate certain scenarios.

Procedure: How to Create HOLD Files in TIBCO WebFOCUS Designer

You can use WebFOCUS Designer to create and save HOLD files to be used immediately within your current visualization or saved as new data sources for future reports and visualizations.

1. From the Hub page, click the plus menu.
2. Click Create Visualizations.
   The Select Data Source dialog box opens.
3. Select a data source.
4. Click Prepare/Extract Data.

   Note: You can click Create Visualization to display your data in WebFOCUS Designer's Visualization tab. Then click the Data tab to prepare or extract data.
5. Add an additional data source to the flow.

For example, to create a Join, drag another data source from the Applications tree on top of your original data source on the canvas. The resulting Join is shown in the following image.

For more information on Joins, see Joining Data.

6. Right-click on the Select Columns node.

7. Select Edit.
The Select Editor dialog box opens, as shown in the following image.

8. Edit your data as needed.
9. Click OK.
10. Right-click on the Select Columns node.
11. Select Stage Permanent Extract (Target).

The Stage Permanent Extract dialog box opens, as shown in the following image.

You can select the properties of your HOLD file, including the application directory for storage, the name of the extract, and the file type of the extract.

HOLD files can be saved permanently for future and repeated use, or saved temporarily for current use. This gives you the flexibility to use and store HOLD files as needed, based on how you want to use the files that you create. If you select Create Session Extract, the HOLD file will be saved temporarily to the foccache directory, and will be useable for the current session only. For any saved visualization specifying a HOLD file extract, the HOLD file will be recreated any time that visualization is executed.
12. Click OK.

Your changes have been made, and your staged extract displays in the flow, as shown in the following image.

![Staged Extract Display](image)

You must run the flow to finish creating the extract.

13. Click the Run arrow icon.

Your HOLD file is created and saved to your chosen location. It can be used immediately on the Visualization tab, or selected from your list of data sources for future reports and visualizations.

**Note:** You can switch back and forth between the Data and Visualization tabs. Modifying your data flow may change or delete any associated visualizations. For more info on creating visualizations, see *Creating Content in TIBCO WebFOCUS Designer*.

## Editing Metadata

Metadata is data about data, and describes the characteristics of your data sources, or synonyms. Metadata can be generated whenever data is created, acquired, added to, deleted from, or updated.

Depending on your version of WebFOCUS and your permissions, you may have access to additional metadata options, so you can edit previously created synonyms.

You can edit previously created synonyms in the following ways:

- From the WebFOCUS Hub, click *Applications Directories*, or, from the WebFOCUS Home page, click the plus sign and then click *Prepare and Manage Data*. 
The Applications page opens, from which you can edit your synonym, or choose from other options.

**Procedure: How to Edit a Metadata Object**

1. From the Applications page, in the Application Directories tree, click a folder to expand it, then right-click on a procedure or metadata file in the file panel and select **Open**, as shown in the following image using a synonym as an example object.

   ![Application Directories Tree](image)

   **Note:** to edit as text, select **Metadata Management**, and then select **Edit as Text** or **Edit Access File as Text**.

   The Synonym Editor opens, where you can modify your synonym, as shown in the following image.
2. Make edits to the synonym, as needed.

3. To save your synonym, click the upper-left Tool Menu icon and select the Save menu option.

4. To close the Synonym Editor, click the upper-left Tool Menu icon and select the Close menu option.

Creating Folders

When you are working within a WebFOCUS Business View panel, you can edit your data by selecting from folder and field shortcut menu options. These options are also available in the Table/Column and Output views.

You can create folders to organize your data. Folders function as segments to provide a view of the synonym, and define the accessible fields and their relationships. Folder relationships are the same as segment relationships, with parent folders, child folders, and sibling folders. Once you create a new folder, you can add data fields and assign roles. Synonym folder structures can be predefined or flexible.

Predefined folder structures are categorized as Measure Groups, Dimensions, Hierarchies, and Attributes, and are created by default when using the WebFOCUS Upload or Connect to Data workflows. In a predefined folder structure, a Measure Group contains measures or facts that are numeric values, such as Gross Profit or Cost of Goods Sold, that you may want to aggregate. All numeric values that can logically be summed can be categorized as Measures. All other fields are categorized as Dimensions, Hierarchies, or Levels.

Flexible folder structures allow you to insert any number of folders at any level to represent the Business need. A folder can contain any type of field categorized as a Measure or Dimension. However, it is good practice to keep different field types in separate folders.
Within a WebFOCUS Business View panel, you can create a new folder by right-clicking a folder or field, pointing to *Manage Folders*, and then clicking *New Folder*, as shown in the following image of a predefined folder structure.

When editing or creating a synonym, you can click the icons at the top of the Business View panel to create a populated, predefined folder structure, or an unpopulated, predefined folder structure, as shown in the following image.
**Note:** You can start to create a new flexible folder structure by right-clicking the synonym name path, pointing to *Insert*, and then clicking *Folder*, as shown in the following image.

---

### Assigning DV Roles

Categorization can be assigned using the DV Role option. When editing a synonym within a WebFOCUS Business View panel, you can assign a DV role to a folder or field by right-clicking the folder or field, clicking *DV Role*, and then clicking a DV Role option, as shown in the following image of a predefined folder structure.

You can explicitly assign a DV Role to a folder or field, or have it automatically inherit a role from its parent. If you explicitly assign a DV Role, that role moves with the object when dragged to a different location within the Business View structure. If you do not explicitly assign a DV Role, the role changes when the object is dragged under a new parent. However, if the object is dragged under a parent with a field with a Drill Level role, it inherits that role.
A folder can only have one drill level field hierarchy. However, you can use the same fields in multiple hierarchies by placing each hierarchy in a separate folder. A folder with a drill level hierarchy is not limited to the hierarchy and can contain other fields with different DV Roles.

You can assign the following DV Roles.

- **Dimension.** A dimension is a way to categorize data or sort output. You can use a dimension to analyze and compare measures. Dimension fields are generally alphanumerical fields, such as Product.

  Dimension fields can be organized into hierarchies to define the relationships between them, and provide information for the AUTODRILL feature. For example, a Geography hierarchy can contain the Continent, Country, State, and City fields. When AUTODRILL is turned on, automatic drilldown links are created in the report or chart output.

  A dimension field, when double-clicked or dragged onto the report or chart canvas in the WebFOCUS tools, is automatically added to the request as a vertical (BY) sort field. A folder can be assigned the role Dimension. A field can be assigned the role Dimension (Standalone) or Dimension (Drill Level). When it is assigned the role Dimension (Drill Level), it becomes part of a hierarchy, where the levels depend on the order of the fields in the folder. You can also define dimension fields that are not part of a dimension hierarchy.

- **Measure.** You can use a measure to aggregate data. A measure field, when double-clicked or dragged onto the report or chart canvas in the WebFOCUS tools, will automatically be added to the request as an aggregated value (SUM), if it is numeric. A folder or field can be assigned the role Measure.

- **Attribute.** An attribute is a field or collection of fields that add additional information about a dimension. An attribute field, when double-clicked or dragged onto the report or chart canvas in the WebFOCUS tools, will automatically be added to the request as an aggregated value (SUM), if it is numeric, or as a vertical sort field (BY), if it is alphanumerical.

- **Folder.** A folder is a virtual segment in a Business View. It can be assigned the roles Dimension, Measure, or Attribute.

  **Note:** When a folder is inserted as a child of a field, the attribute PARENT_FIELD describes this relationship. By default, such a folder and its fields will be assumed to have the Attribute role.

### Preparing and Managing Data

After uploading or connecting to data by clicking *Get Data* from the Reporting Server browser interface, you can return to the Reporting Server browser interface to prepare or manage more data, or if you choose, visualize your data in WebFOCUS Designer.
From the WebFOCUS Hub, click *Applications Directories*, or, from the WebFOCUS Home page, click the plus menu `➕`, and then click *Prepare and Manage Data*.

The Reporting Server browser interface opens, as shown in the following image.

**Procedure:** How to Upload Data from the Reporting Server Browser Interface

1. From the Reporting Server browser interface, click *Get Data*.

   The Get Data dialog box opens, as shown in the following image.

2. Under Local Files, click your upload file type.

3. In the Open dialog box for your operating system, select the file that you want to upload, and then click *Open*.

   The Uploading Data preview page opens, and your file or worksheets are displayed.
4. Click Load.

Your file or worksheet is loaded, as shown in the following image.

![Image of the Get Data dialog box.](image)

5. Click Prepare and Manage Data to return to the Reporting Server browser interface and prepare or manage more data, or if you choose, click Visualize Data to open WebFOCUS Designer.

**Note:** For more information, see Uploading Data Files.

**Procedure:** How to Connect to Data from the Reporting Server Browser Interface

1. From the Reporting Server browser interface, click Get Data.

The Get Data dialog box opens, as shown in the following image.

![Image of the Get Data dialog box.](image)

2. Under Server Files, click a configured adapter.

The Configure Connections dialog opens.
3. Double-click an available connection.
   The Create Synonym dialog box opens.
4. Select a data source for synonym creation.
5. Click Add.
   An intermediate Create Synonym Status page opens, as shown in the following image.

6. Click Prepare and Manage Data to return to the Reporting Server browser interface and prepare or manage more data, or if you choose, click Visualize Data to open WebFOCUS Designer.

   **Note:** For more information, see *Connecting to Data Sources*.

### Extending Metadata With Reporting Objects

With WebFOCUS Managed Reporting, a developer can easily transform complex views of data into simple objects labeled with common business terminology that every user can understand, such as Weekly Sales or Revenue. Developers create Reporting Objects that present available data using terms and formats meaningful to users. Users can then use Reporting Objects as templates for the creation of a wide range of reports and charts.

This topic describes Reporting Objects and how you can use them in WebFOCUS.

### Reporting Object Tool

Reporting Objects are stored in folders in the tree within workspace folders under the Content folder. They can include selection criteria (WHEREs), JOINs, virtual fields(DEFINEs), filters, and other WebFOCUS statements, as well as reports or charts supplied as templates.
**Note:** A Reporting Object will not show in the repository when the user cannot functionally use the Reporting Object.

The browser Reporting Object tool allows you to create, edit, test, run, or delete a Reporting Object or its components. The main interface, as shown in the following image, consists of a static Quick Launch toolbar, a ribbon of context-sensitive options, and a window that displays the components of the Reporting Object with which you are working.

![Reporting Object Tool Quick Launch Toolbar](image)

**Reference:** Reporting Object Tool Quick Launch Toolbar

The Reporting Object tool Quick Launch toolbar is a static menu whose commands apply to the entire Reporting Object, not simply to the particular component that you have selected. The following table describes each command in the Reporting Object tool Quick Launch toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut Keys</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>Shortcut Keys</td>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Ctrl+S</td>
<td>Save</td>
<td>Saves the Reporting Object.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Z</td>
<td>Undo</td>
<td>Undoes the last action.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Y</td>
<td>Redo</td>
<td>Repeats the last action.</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>View code</td>
<td>Displays Reporting Object code in a read-only window.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+R</td>
<td>Run</td>
<td>Runs the Reporting Object.</td>
</tr>
</tbody>
</table>

**Reference:** Reporting Object Tool Ribbon

The Reporting Object tool ribbon is a menu whose commands apply to what you have selected, whether that is the Reporting Object as a whole, a particular component, or an individual example of a component. For example, a particular filter or filter group, if you have selected one, rather than selecting the entire Filter component.

The following table describes each command on the Reporting Object tool ribbon.
### Button | Command | Description
--- | --- | ---
| ![New](image) | New | Creates a new join, DEFINE statement, filter, or WHERE statement.
| ![Open](image) | Open | Launches InfoAssist to create or edit a report or chart, or launches the appropriate tool to create or edit a join, DEFINE statement, filter, or WHERE statement.
| ![Edit](image) | Edit | Opens component source code in the text editor.
| ![Properties](image) | Properties | Renames the selected filter or filter group.
| ![Run](image) | Run | Runs the selected component.
| ![Delete](image) | Delete | Deletes the selected item.
### Button | Command | Description
--- | --- | ---
Delete All | Delete All | Deletes all items of the type selected, for example, all WHERE statements, all filters in a particular group, or all filters in every group if the Filter component itself is selected.

**Procedure:** How to Create a Reporting Object

1. From the WebFOCUS Hub or WebFOCUS Home Page, open the Workspaces area.
2. Select the Workspace in which you want to create the Reporting Object, click the +Create button, point to Data, and click Reporting Object. The Reporting Object tool opens in a new browser window, with an Open dialog box.
3. Select a Master File and click OK.

   The Reporting Object tool interface appears.

**Procedure:** How to Edit a Reporting Object

From the WebFOCUS Hub or WebFOCUS Home Page, in the Workspaces area, right-click the Reporting Object and select Edit.

**Note:** Double-clicking the Reporting Object runs the Reporting Object rather than allowing you to edit it.

**Procedure:** How to Save a Reporting Object

1. Press Ctrl+S or click the Save icon on the Quick Launch toolbar.

   The Save dialog box opens.

2. Type the name of the new Reporting Object in the Title field and click OK.

   From now on, clicking Save or pressing Ctrl+S saves the Reporting Object without launching the Save dialog box.
Running a Reporting Object From the Browser

You can run a Reporting Object or any individual component of it from the browser. You can run a Reporting Object in the following ways:

- Select the object in the Reporting Object tool and click Run, or right-click the object and select Run.
- Right-click the Reporting Object in the Workspaces view and select Run or Run Deferred.

The Run option in the Reporting Object tool is enabled regardless of the setting of the Only Run as a Deferred Report property.

Expected Behavior of Running a Reporting Object

When you select and run a Reporting Object, the expected behavior is as follows:

- When you define a Report or Chart component, all components of the Reporting Object run.
- When you define a Report and Chart component, an HTML page opens, which enables you to select which component to run.
- When you define filters in a Reporting Object, an HTML page opens, which enables you to select from the defined filters of the Reporting Object.
- When you define parameters in a report or chart and the Reporting Object Prompt for Parameters property is specified, an HTML page opens, which prompts you for parameter values.
- Reporting Object components are validated prior to run time. This means that errors are found and corrected more easily, since errors in individual components are detected prior to run time.

- If you attempt to run a Reporting Object that is created without using the Report or Chart component, you receive the message:

  Your request did not return any output to display.

Possible causes:
- No data rows matched the specified selection criteria.
- Output was directed to a destination such as a file or printer.
- An error occurred during the parsing or running of the request.
Properties of a Reporting Object

From the WebFOCUS Hub or WebFOCUS Home Page, in the Workspaces area, you can view or edit the properties of a Reporting Object by right-clicking the object and selecting Properties. The Properties panel opens, displaying properties of the selected file.

Components of a Reporting Object

A Reporting Object may contain any of the following types of components, which are run in the order of precedence, as listed:

- Preprocessing Other (custom code that runs before all other components)
- Joins
- DEFINE statements
- Filters, when applicable
- WHERE statements
- Report or chart templates
- Postprocessing Other (custom code that runs after all other components)

Users using the Reporting Object to create a report do not see the DEFINE statements, WHERE statements, or JOIN commands defined in the Reporting Object, which are issued automatically every time a user accesses the Reporting Object. However, the report or chart components, including headers, footers, and styling features, are visible to authorized users who can use them to create their own customized report.

The filters defined in the Filter component are applied only if the user of the Reporting Object activates them when the report or chart based on the Reporting Object is run.

Preprocessing Other Component

The Preprocessing Other component contains custom code that must run before all other components. You can use the text editor in the component to create and edit code or to paste the code that you have copied from another application.

To create or edit a Preprocessing Other component, do one of the following:

- Double-click the component.
- Select the component and click Edit on the ribbon.
- Right-click the component and select Edit.

The Preprocessing Other text editor appears.
See *Creating Reports With WebFOCUS Language* for more information about using the WebFOCUS language to code procedures.

**Note:**

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- Commands in the Preprocessing Other component should not return a displayable answer set.

- InfoAssist previews in the Report component and the Chart component are disabled if the Preprocessing Other component contains the syntax:

  ```
  -OLAP ON
  ```

  To avoid this issue, enable OLAP through the Reporting Object properties instead of the Preprocessing Other component. For more information on the Reporting Object properties, see *Properties of a Reporting Object* on page 159.

**Reference:** **Considerations for Amper Auto Prompting With the Preprocessing and Postprocessing Other Components**

When using Amper Auto prompting, users may be prompted to supply amper variable values for parameters that the private user content does not reference. These scenarios are directly related to the internal processing of reports created using a Reporting Object.

Auto prompting considerations and expected behavior must be understood when referencing amper variables within a Reporting Object. For information on the Amper Auto prompting facility, see *Developing Reporting Applications*. The specification of values for the amper variables in the Reporting Object Other component using –DEFAULT, –DEFAULTH, or –SET commands will assign a default value for amper variables in a report request to avoid a FOC error for not specifying a value. A consideration for –DEFAULTH and –SET is that Amper Auto prompting does not prompt for amper variables that have values assigned using –DEFAULTH and –SET.
Whether a user is prompted by the Amper Auto prompting facility for amper variables assigned a default value using the –DEFAULT command is dependent on the setting of the WebFOCUS Client configuration parameter, IBIMR_prompting. When IBIMR_prompting is set to XMLPROMPT, users are prompted for amper variable values, and default values are displayed in fields in which the default values have been specified. When IBIMR_prompting is set to XMLRUN, users are not prompted for values when all amper variables have been assigned a default value. For more information on setting the IBIMR_prompting parameter, see WebFOCUS Security and Administration.

Reference: Creating a Reporting Object That Uses a HOLD File

Suppose that your company has a data warehouse and you need a Reporting Object that uses an extract from that data warehouse. In your Preprocessing Other component, you create a HOLD file from the data warehouse, and then you use that HOLD file in each Reporting Object component. You can clear the JOIN command and delete the HOLD file in the Postprocessing Other component so that it is not mistakenly used again the next time that the Reporting Object is used.

This task has the following steps:

1. Create a HOLD file in the Preprocessing Other component.
2. Create a new Join component with two joins.
3. Use the Report component to create a new report in InfoAssist.
4. Clear the JOIN command and delete the HOLD file in the Postprocessing Other component.
5. Run the Reporting Object, and then view the object source to verify that the output is correct.
6. Verify that the HOLD file does not exist in the location in which it was created.

Example: Creating a HOLD File With the Preprocessing Other Component

1. Create a Reporting Object with the baseapp and ibisamp selected as the application paths and employee as the Master File.
   
   For more information on creating a Reporting Object, see Properties of a Reporting Object on page 159.

2. Select the Preprocessing Other component and click Edit.

3. Type the following code:
```
APP HOLD IBISAMP
TABLE FILE EMPLOYEE
PRINT EMPLOYEE.EMPINFO.DEPARTMENT AS 'NEWDEP'
EMPLOYEE.EMPINFO.CURR_SAL AS 'NEWCURR_SAL'
BY EMPLOYEE.EMPINFO.EMP_ID AS 'EMP_ID'
BY EMPLOYEE.EMPINFO.HIRE_DATE AS 'NEHWIRE_DATE'
ON TABLE HOLD AS WINFILE FORMAT FOCUS INDEX EMP_ID
END
```

4. Click Save, and then close the text editor.

5. To verify that the component works properly, select the Preprocessing Other component and click Run.

The following output is produced:

```
0 NUMBER OF RECORDS IN TABLE= 12 LINES= 12
```

**Example: Creating a New Join Component With Two Joins**

1. Select the *Join* component and click *New*.

   The Join component is prefilled with the data from the employee Master File.

2. Click *Add New*, select the winfile Master File, and click *OK*.

3. Click the *Add New* button, select the jobfile Master File, and click *OK*.

4. Click *OK* to close the Join tool, saving your changes.

5. Click *View Code* in the Reporting Object Quick Launch toolbar to review the code.

   The following code for the Join component displays:

   ```
   -*COMPONENT=Join_J001
   JOIN EMPLOYEE.EMPINFO.EMP_ID IN IBISAMP/EMPLOYEE
   TO UNIQUE WINFILE.SEG01.EMP_ID IN IBISAMP/WINFILE TAG J001 AS J001
   END
   -*COMPONENT=Join_J002
   JOIN EMPLOYEE.PAYINFO.JOBCODE IN IBISAMP/EMPLOYEE
   TO UNIQUE JOBFILE.JOBSEG.JOBCODE IN IBISAMP/JOBFILE TAG J002 AS J002
   END
   ```

**Example: Creating a Report With the Report Component**

1. Double-click the *Report* component.

   InfoAssist is launched.

2. Drag the NEWCURR_SAL measure from the Data pane to the canvas.
3. Drag the EMP_ID dimension to the left of the NEWCURR_SAL column in the canvas, and select *Drop as sort*.

4. Drag the NEWHIRE_DATE dimension to the left of the NEWCURR_SAL column in the canvas, and select *Drop as sort*.

5. Drag the NEWDEP dimension to the left of the NEWCURR_SAL column in the canvas, and select *Drop as sort*.

   The report is displayed as a table with four columns, sorted by EMP_ID.

6. Save the report and exit InfoAssist.

7. To verify that the component works properly, click *Run* on the Quick Launch toolbar.

   The report that you created in InfoAssist is displayed in the browser.

**Example:** Deleting the Join in the Postprocessing Other Component

1. Select the *Postprocessing Other* component and click *Edit*.

2. Type the following:

   JOIN CLEAR *
   ? JOIN

3. Click Save, and then click *Exit*.

4. To verify that the Reporting Object works properly, click *Run* on the Quick Launch toolbar.

   The report that you created in InfoAssist is displayed in the browser.

5. Right-click the report webpage and select *View source*.

   **Note:** Depending on your browser, information may display differently.

6. Scroll to the bottom of the source window.

   The following comment is displayed:

   ```
   <!--
   0 NUMBER OF RECORDS IN TABLE= 12 LINES= 12
   0 NUMBER OF RECORDS IN TABLE= 12 LINES= 12
   0 HOLDING HTML FILE ON PC DISK ...
   JOINS CURRENTLY ACTIVE
   HOST    CROSSREFERENCE
   FIELD    FILE    TAG     FIELD    FILE    TAG AS ALL WH
   ------    ----    ---     -----    ----    --- -- --- --
   EMPLOYEE.EM>EMPLOYEE    WINFILE.SEG> WINFILE J0 J0 Y N
   EMPLOYEE.PA>EMPLOYEE    JOBFILE.JOB> JOBFILE J1 J1 Y N
   0 NO JOINS CURRENTLY IN EFFECT
   -->
   ```
Joins

A join is a temporary connection between two or more data sources that share at least one common field. After you join two data sources, each time that WebFOCUS retrieves a record from the first data source (the host file), it also retrieves the matching records from the second data source (the target file).

For more information on joining data sources, see the WebFOCUS InfoAssist User’s Manual.

Note:

- When you join two TIBCO FOCUS® data sources, the target file field must be indexed or the join must be a WHERE-based join. If you attempt to link to a non-indexed target file, the Reporting Object tool offers you the opportunity to create a WHERE-based join. For more information on creating WHERE-based joins, see Join Group in the WebFOCUS InfoAssist User’s Manual.

- Since every procedure creates a new session on the Reporting Server when it is run, the duration of your connection is always limited to a single procedure. Therefore, any join issued at the beginning of a procedure is in effect only for those report requests that are called in the same procedure.

Procedure: How to Create a Join

1. Right-click the Joins component and select New, or select the Join component and click New on the ribbon.

   The Join tool opens, displaying the data source associated with the Reporting Object.

2. Create a join using the Join tool.

   For more information on using the Join tool, see Join Group in the WebFOCUS InfoAssist User’s Manual.

3. When you are finished, click OK to return to the Reporting Object tool.

Procedure: How to Delete a Join

To delete a join, right-click the join and select Delete, or select the join and click Delete on the Quick Launch toolbar.

Procedure: How to Rename a Join

1. In the Join tool, select a join by clicking its connector line, and then click Edit on the Join toolbar.

   The Edit Join dialog box opens.
2. Type a new description in the Description box and click OK to return to the Join tool. The new description appears under the Join component in the Reporting Object tool. The internal name used for the join remains the same name assigned to the join when you created it.

Procedure: How to View or Edit Join Syntax in a Text Editor

1. Select the join and click Edit on the ribbon, or right-click the join and select Edit. The join code is displayed in a text editor.

2. Make the desired changes and click Save to return to the Reporting Object tool. To exit without making any changes, click Close.

Virtual Fields (DEFINE Statements)

A virtual field is a field whose value is not stored in the data source but can be calculated from the data that is there. A virtual field takes up no storage space. It is created only when a user accesses the Reporting Object that includes the virtual field.

You use the Define tool to create a virtual field. Using this tool, you specify the virtual field name and format, and the expression that defines the field. An expression enables you to combine fields, constants, predefined functions, and operators into an operation that produces a single value. When you define a virtual field, you must specify a field format type, length, and appropriate display options.

For more information about defining fields, see Data Tab in the WebFOCUS InfoAssist User’s Manual.

Procedure: How to Create a Virtual Field

1. Right-click the Defines component and select New, or select the Define component and click New on the ribbon.
Extending Metadata With Reporting Objects

The Define tool dialog box opens, as shown in the following image.

2. Create a virtual field using the Define tool.

For more information about the Define tool, see Data Tab in the WebFOCUS InfoAssist User's Manual.

3. Click OK to save the virtual field and return to the Reporting Object tool.

The virtual field now appears in the field list when a user accesses this Reporting Object.
Note:

- The field list shown in the Define tool is not updated to display new virtual fields until you exit from the Define tool and reopen it. If you are creating a virtual field (DEFINE statement) that uses a previously created virtual field in the expression, you must save the first virtual field before creating the second one.

To save the first virtual field, exit from the Define tool by clicking OK. Reopen the Define tool to create the second field. Alternatively, you can type the name of the first virtual field in the expression instead of selecting it from the field list. In this case, you do not need to exit and reopen the Define tool.

- Since every procedure creates a new session on the Reporting Server when it is run, the duration of your connection is always limited to a single procedure. Therefore, any DEFINE statements issued at the beginning of a procedure are in effect only for those report requests that are called in the same procedure.

Procedure: How to Edit a Virtual Field

Existing virtual fields appear under the Defines node, as shown in the following image.

![Diagram of Define tool]

1. Right-click the virtual field that you want to edit and select Open, or select the virtual field and click Open on the ribbon.
   The Define tool dialog box opens, displaying the selected field.
2. Make changes to the field name, expression, or format, and click OK to return to the Reporting Object tool.

Procedure: How to View or Edit a Virtual Field in the Text Editor

1. Right-click the virtual field that you want to view or edit as text and select Edit, or select the virtual field and click Edit on the ribbon.
The Text Editor opens, displaying the selected field.

2. Make changes to the field name, expression, or format, and click OK to return to the Reporting Object tool.

**Procedure: How to Delete a Virtual Field**

1. Right-click the virtual field that you want to delete and select Delete, or select the virtual field and click Delete on the ribbon.

2. To delete all virtual fields at once, right-click the Defines component and select Delete All, or select the component and click Delete All on the ribbon.

**Filters**

Filters enable users to quickly select predefined criteria that limit the data included in a report or chart. Filters are selection criteria (WHERE statements) that you create for users, who then select the filters needed to limit the data in a report or chart without having to create their own selection criteria.

In order to create a filter, you must create the filter group and define the filters that make up the group.

**Note:** The Undo and Redo functions are not available for the Filter component until you have created at least one filter.

For more information about filters, see the *Using Filters to Customize the Display of Data* topic in the *WebFOCUS InfoAssist User's Manual*.

**Procedure: How to Create a Filter Group**

1. Right-click the Filters component and select New, or select the Filter component and click New on the ribbon.

   The Reporting Object Filter Group dialog box opens.

2. In the Filter Group Name field, type a descriptive name for the filter group folder.

   Make the filter group name as explicit as possible, because users depend on this name to select the correct filter to apply to their reports.

3. Click OK.

   You are returned to the Reporting Object tool. The filter group folder appears below the Filter component node.
Procedure: How to Define a Filter

1. Right-click the Filter group to which you would like to add a filter and select New, or select the Filter group folder and click New on the Quick Launch toolbar.

The Reporting Object Filter dialog box opens.

2. In the Filter Name field, type a descriptive name for the filter and click Add New if you plan to create multiple filters, or click OK if you plan to create only one filter.

Make the filter names as explicit as possible, because users depend on these names to select the correct filter to apply to their reports.

The Advanced Filter dialog box opens, as shown in the following image.

![Advanced Filter dialog box]

3. Use the Advanced Filter dialog box to create the filter.

For more information about defining filters, see Data Tab in the WebFOCUS InfoAssist User's Manual.

4. When you have created the filter, click OK.

If you clicked Add new in step 2, the New Filter dialog box opens. If you clicked OK in step 2, you are returned to the Reporting Object tool.
Procedure: How to Edit a Filter

Existing filters appear under the Filter group beneath the Filters node, as shown in the following image.

1. Right-click the filter that you want to edit and select Open, or select the filter and click Open on the ribbon.

   The Advanced Filter dialog box opens, displaying the selected filter.

2. Make your changes and click OK to return to the Reporting Object tool.

Procedure: How to Rename a Filter or Filter Group

1. Right-click the filter or filter group that you want to rename and select Properties, or select the filter or filter group and click Properties on the ribbon.

2. Type the new filter or filter group name in place of the current one and click OK.

Procedure: How to Delete a Filter or a Filter Group

1. Right-click the filter or filter group that you want to delete and select Delete, or select the filter or filter group and click Delete on the ribbon.

2. To delete all filters at once, right-click the Filter component and select Delete All, or select the component and click Delete All on the ribbon.

Procedure: How to View or Edit a Filter in the Text Editor

1. Right-click the filter that you want to view or edit as text and select Edit, or select the filter and click Edit on the ribbon.

   The text editor opens, displaying the selected filter.
2. Make your changes and click OK to return to the Reporting Object tool.

**Reference:**  Filter Considerations With Amper Auto Prompting

When Amper Auto prompting is used (*Prompt for Parameters* is selected in the Reporting Object properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefine selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

**Selection Criteria (WHERE Statements)**

WHERE statements or selection criteria, restrict the data retrieved to only those records that meet the conditions that you specify. Filters are selection criteria that run when the user selects the filter in WebFOCUS. Other selection criteria run when the user opens the Reporting Object, preventing data values that do not meet the criteria from being available to the user.

For more information on WHERE statements, see *Field Tab* in the *WebFOCUS InfoAssist User’s Manual*.

**Procedure:**  How to Create Selection Criteria

1. Right-click the *Where Statements* component and select New, or select the component and click New on the ribbon.
   - The New Filter dialog box opens.
2. Double-click the red text or press F12 to edit the WHERE statement.
   - For more information on creating selection criteria, see the *Using Filters to Customize the Display of Data* topic in the *WebFOCUS InfoAssist User’s Manual*.
3. When you have created the selection criterion, click OK to return to the Reporting Object tool.

**Report Component**

The Report component creates a report template and saves it in a Reporting Object. Authorized users can use the report template to create a report that suits their needs and then save the new report.

To create a report template, double-click the *Report* component, or right-click the component and select Open. InfoAssist opens, allowing you to create a report template.

For more information on using InfoAssist, see the *WebFOCUS InfoAssist User’s Manual*. 
Note:

- To open the report source code in the text editor instead of InfoAssist, right-click the Report component and select Edit. Manual changes to the code may make the report incompatible with InfoAssist.

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- If the Reporting Object contains both a report and a chart, the user is asked whether to run the object as a report or chart. The Reporting Object cannot be run simultaneously as both.

- When Amper Auto prompting is used (Prompt for Parameters is selected in the Reporting Objects properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefined selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

Chart Component

The Chart component works exactly like the Report component. The Chart component creates a chart template and saves it in a Reporting Object. Authorized users can use the chart template to create a chart that suits their needs and then save the new chart.

To create a chart template, double-click the Chart component, or right-click the component and select Open. InfoAssist opens, allowing you to create a chart template.

For more information on using InfoAssist, see the WebFOCUS InfoAssist User’s Manual.

Note:

- To open the chart source code in the text editor instead of InfoAssist, right-click the Chart component and select Edit. Manual changes to the code may make the chart incompatible with InfoAssist.

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- If the Reporting Object contains both a report and a chart, the user is asked whether to run the object as a report or chart. The Reporting Object cannot be run simultaneously as both.
When Amper Auto prompting is used (Prompt for Parameters is selected in the Reporting Object properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of private reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefine selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

**Postprocessing Other Component**

The Postprocessing Other component contains custom code that must run after all other components. You can use the text editor in the component to create and edit code, or to paste the code that you have copied from another application.

To create or edit a Postprocessing Other component, double-click the component, or select the component and click Edit on the ribbon. Alternatively, right-click the component and select Edit. The Postprocessing Other dialog box opens.

See *Creating Reports With WebFOCUS Language* for more information about using the WebFOCUS language to code procedures.

**Note:**

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.
- Commands in the Postprocessing Other component should not return a displayable answer set.
- InfoAssist previews in the Report component and the Chart component are disabled if the Postprocessing Other component contains the syntax: 

```
-OLAP ON
```

To avoid this issue, enable OLAP through the Reporting Object properties instead of the Postprocessing Other component. For more information on the Reporting Object properties, see *Properties of a Reporting Object* on page 159.

For information on Amper Auto Prompting, see *Considerations for Amper Auto Prompting With the Preprocessing and Postprocessing Other Components* on page 160.
Changing Metadata Classification Values When Uploading Data Files

When uploading a data file, you can view the recommended metadata classification values for each character-valued column. You can choose to keep the recommended values, or to change them.

Including classification values in your data improves the accuracy of mapping column tables correctly to each other. This is useful if you are integrating data from multiple sources, or if integrating data into a system with a predefined hierarchy.

**Note:** For more information, see the TIBCO WebFOCUS Installation and Configuration manual for your platform.

**Procedure:** How to Change Metadata Classification Values When Uploading Data Files in Simple Mode

You can change the metadata classification values for your data during the upload process.

1. Upload a desktop file using Get Data. For more information see *Uploading Data Files*.

   The Uploading Data page opens, as shown in the following image.

   ![Uploading Data Page](image)

   If the Metadata Classification feature has been installed, the Uploading Data page displays a Classify button.

2. Click the Classify button.
The Recommended Classifications page opens, as shown in the following image.

When a recommended classification can be made, the columns that were classified have a Confidence Level associated with them, which indicates the probability that the classification is correct.

You can select from a column list of classifications, or enter your own classification, by typing into the text box next to the column. Clicking a column drop-down arrow shows the list of classifications, and indicates which is recommended, as shown in the following image.

3. **Click Apply Changes.**
Your changes are applied, as indicated by a green message bar at the top of the page, as shown in the following image.

4. Click the Load button to load your data.

Once your data is loaded, with the proper permissions to edit synonyms, you can leverage further capabilities by accessing the Reporting Server browser interface.

Procedure: How to Change Metadata Classification Values When Uploading Data Files in Advanced Mode

You can change the metadata classification values for your data during the upload process in advanced mode.

1. On the WebFOCUS Hub, click the plus menu, select Get Data (Advanced), click a desktop file type, and then select a file to upload, or, on the WebFOCUS Home Page, click the plus menu, click Prepare and Manage Data, click Get Data, click Advanced Mode, click a desktop file type, and then select a file to upload.
Your data opens in the Uploading Data page, as shown in the following image.

2. From the canvas, right-click the canvas data file and select **Classify Data** from the context menu, as shown in the following image.
The Classify dialog box opens, as shown in the following image.

When a recommended classification can be made, the columns that were classified have a Confidence Level associated with them, which indicates the probability that the classification is correct.
You can select from a column list of classifications, or enter your own classification, by typing into the text box next to the column. Clicking a column drop-down arrow shows the list of classifications, and indicates which is recommended, as shown in the following image.

3. Click Apply Changes.

You are returned to the Uploading Data page. Your changes are applied, as indicated by a classification icon next to the name of the canvas data file, as shown in the following image.
4. Click the **Load and Report** button to load your data.

Once your data is loaded, with the proper permissions to edit synonyms, you can leverage further capabilities by accessing the Reporting Server browser interface.

**Running Predictive Analytics on Your Data**

When creating a Data Flow, you can easily run predictive analytics on your data sets using Machine Learning functions, without prior knowledge of advanced statistics.

Train and run multiple iterations of predictive models in parallel, evaluate and compare models actively, and select which model you want to save. Then you can re-run your model against new data sets.

**Note:** For more information, see the TIBCO WebFOCUS Installation and Configuration manual for your platform.

**Procedure:** **How to Access Predictive Models**

After you create a Data Flow, you can select from different model algorithms to run against your data set.

1. From the WebFOCUS Hub, click **Application Directories**, then click an application, or, from the WebFOCUS Reporting Server browser interface, click an application. Then right-click a data set, and select **Flow**, as shown in the following image.
The Data Flow opens, as shown in the following image.

2. From the side panel, click **Models**.

The Train Models panel opens, as shown in the following image.

The following models display within the Train Models panel:

- Binary Classification
- Regression
- Anomaly Detection

Now you can select a model to train and run against your data.

**Procedure:** **How to Train Binary Classification Models**

These models predict binary values based on four different algorithms: Random Forest, K-Nearest-Neighbors, Logistic Regression, and Extreme Gradient Boosting.
Note: When running the Binary Classification model algorithm, smaller-sized data files may not generate a model. Larger-sized files are recommended for best results.

1. Double-click or drag and drop the Binary Classification model to the canvas. The Configure dialog box displays, as shown in the following image.

You can click the Target dropdown menu to select a different target. All numeric Field measures are selected by default as Predictors. You can add or remove Predictors by selecting or unselecting the check boxes.

2. Click Apply.
Your selected model type appears on the dataflow canvas, as shown in the following image.

3. Click the *Train and Predict* icon to train your model.

The Compare Model Evaluation Results dialog opens, as shown in the following image.
The model algorithms run in parallel, allowing you to easily compare results and determine which model is best. You can filter which model comparisons you want to see by selecting or deselecting the model check boxes.

4. Close the Compare Model Evaluation Results dialog box to return to the canvas.

**Note:** To re-open the Compare Model Evaluation Results dialog box, click the Compare icon on the canvas toolbar.

Your model data displays in the following tabs. You can select different model algorithm options from the model drop-down menu. The best model is selected by default.

- **Result.** A preview of the first 50 rows of your new data set. Target and predicted columns are highlighted yellow.

- **Evaluation.** A chart that demonstrates the accuracy of the selected model.
- **Confusion Matrix.** A report that includes the performance metrics and hyperparameter values.

- **ROC.** The effect of the decision-threshold on various metrics is shown in the ROC curve.

- **Precision-Recall.** The Precision-Recall curve is independent of the true negatives.
Feature Importances. The most important features in your data set.

Note: Feature Importances is available for the Random Forest model only.

Training Log. A report that includes the performance metrics and hyperparameter values.

Procedure: How to Train Regression Models

These models predict numeric values based on four different regression algorithms: Random Forest, K-Nearest-Neighbors, Polynomial Regression, and Extreme Gradient Boosting.

1. Double-click or drag and drop the Regression model to the canvas.
The Configure dialog box displays, as shown in the following image.

You can click the Target dropdown menu to select a different target. All numeric Field measures are selected by default as Predictors. You can add or remove Predictors by selecting or unselecting the check boxes.

2. Click Apply.

Your selected model type appears on the dataflow canvas, as shown in the following image.
3. Click the *Train and Predict* icon to train your model.

The Compare Model Evaluation Results dialog opens, as shown in the following image.

![Compare Model Evaluation Results Dialog](image)

The model algorithms run in parallel, allowing you to easily compare results and determine which model is best. The best model has the lowest Root Mean Square Error value, and a scatter plot with dots closest to the red line. You can filter which model comparisons you want to see by selecting or deselected the model check boxes.

4. Close the Compare Model Evaluation Results dialog box to return to the canvas.

**Note:** To re-open the Compare Model Evaluation Results dialog box, click the *Compare* icon on the canvas toolbar.
Your model data displays in the following tabs. You can select different model algorithm options from the model drop-down menu. The best model is selected by default.

- **Result.** A preview of the first 50 rows of your new data set. Target and predicted columns are highlighted yellow.

![Model Data Preview](image)

- **Evaluation.** A chart that demonstrates the accuracy of the selected model.

![Evaluation Chart](image)

- **Feature Importances.** The most important features in your data set.

![Feature Importance Chart](image)

**Note:** Feature Importances is available for the Random Forest model only.
Training Log. A report that includes the performance metrics and hyperparameter values.

Procedure: How to Train Anomaly Detection Models

These models detect anomalies, based on one clustering algorithm: Isolation Forest.

1. Double-click or drag and drop the Anomaly Detection model to the canvas.

The Configure dialog box displays, as shown in the following image.
All numeric Field measures are selected by default as Predictors. You can add or remove Predictors by selecting or unselecting the check boxes.

2. Click **Apply**.

Your selected model type appears on the dataflow canvas, as shown in the following image.

![Dataflow Canvas](image)

3. Click the **Train and Predict** icon to train your model.

Your model data displays in the following tabs, using the Isolation Forest model algorithm.

- **Result**: A preview of the first 50 rows of your new data set. Target and predicted columns are highlighted yellow.
- **Anomaly Scores.** A chart that demonstrates the accuracy of the selected model.

![Anomaly Detection Chart](chart.png)

- **Training Log.** A report that includes the performance metrics and hyperparameter values.

![Training Log](log.png)

**Procedure:** How to Edit Predictive Models

After your model is generated, you can edit your model target, predictors, and hyperparameters. Hyperparameters have default values that are unique to each model.

To edit your model target and predictors, right-click the canvas model node, point to **Edit Settings**, and then click **Target and Predictors**.

To edit your model hyperparameters, right-click the canvas model node, point to **Edit Settings**, point to **Hyperparameters**, and then click a model algorithm type.
You can also click the Model Editor icon to change targets, predictors, and hyperparameters.

**Procedure: How to Save Predictive Models**

When training a model, you can save it from the Compare Model Evaluation Results dialog box. After running a model, you can save it from the tabbed panel beneath the canvas. You can then re-run your saved model against new data sets.

1. Click the Save icon to save your model.

   The Save dialog opens, as shown in the following image.

![Save Trained Model dialog](image)

You can change the model algorithm, name, or location, and add a description.

2. Click Save.
Your model is saved to your selected folder location, as shown in the following image.

Trained models are saved with evaluation results, logs, and associated files, to run the model at a later time.

**Running Datasets Against Saved Models**

After you save a predictive model, you can load it and run other datasets against it, in order to learn more about your data.
The following binary classification model was previously trained and saved. The model includes a Customer Status column that shows values of Active or Churn, as shown in the following image.

**Note:** This model is selected in Step 7 below.
You may want to run a different customer dataset against this predictive model. For example, if you want to know which customers will remain active and which will churn. A dataset that does not include a customer status column is shown in the following image.

![Dataset Image](image)

**Note:** This dataset is selected in Step 2 below.

For more information about training and saving models, see *Running Predictive Analytics On Your Data*.

**Procedure: How to Run Datasets Against Saved Models**

1. From the WebFOCUS Hub, click the plus menu, and then click *Create Data Flow*.
   The TIBCO WebFOCUS Reporting Server browser interface opens.
2. Drag a dataset onto the canvas.
3. From the left panel, click *Functions*.
4. Click the *Machine Learning (Python-based)* function folder, as shown in the following image.

5. Click the *RUN_MODEL* function, as shown in the following image.

**Note:** There are two RUN_MODEL functions. RUN_MODEL loads and runs the ML Model. RUN_MODEL2 loads and runs the ML Model and overrides predictors.
The Properties dialog box opens, as shown in the following image.

6. In the Python_MFD Parameters field, click the file icon.

   The Model Function dialog opens.

7. Select the model to be loaded and run, as shown in the following image.

8. Click OK.

   The Properties dialog box is updated with your selected model.

9. Click OK.
The model Metadata dialog opens, as shown in the following image.

![Model Metadata Dialog](image)

**Note:** The dataset now includes a Customer Status Predicted column.

10. Click **OK**.

You are returned to the data flow, as shown in the following image.

![Data Flow](image)

The dataset now predicts which customers will remain active and which will churn, as determined by the predictive model, based on values in the dataset.

11. From the WebFOCUS toolbar menu, select **Save As** to save your updated dataset.
WebFOCUS Designer is a web-based development tool that you can use to quickly and easily create content from your data and use that content to create pages, within a single visualization or by assembling multiple distinct content items into a separate visualization. You can manage your data using data flows and use that data to create charts, reports, and interactive and responsive pages, all in one place.

Using WebFOCUS Designer, you can prepare raw data from a variety of sources in a data flow, and turn it into easily usable and understandable data sources for subsequent analysis. You can also join multiple data sources as if they were a single data source, and then create new content from your joined data. WebFOCUS Designer provides you with a simple, but powerful, set of features to create content directly within a visualization using a variety of chart types and tabular report layouts, allowing you to communicate the information in your data as effectively as possible. You can continue adding as much new content to a visualization as you want, each in its own container or grouped into multi-content containers using tab, accordion, or carousel behavior. Alternatively, you can create these pages using existing content such as charts, reports, images, and URLs that you have saved in your environment. With the interactive page canvas, you can resize and rearrange resources in the visualization into your preferred layout. Additionally, interactive filter behavior allows you to control the display of data in the visualization with ease, and In-Document Analytic capabilities allow you to continue interacting with your content beyond design time.

In this chapter:

- Navigating the TIBCO WebFOCUS Designer Interface
- Creating Content in TIBCO WebFOCUS Designer
- Selecting a Data Source
- Configuring Sample Data Settings
- Creating Charts
- Creating Reports
- Adding Filters to a Visualization
- Using Quick Transforms to Apply Analytical Functions to Data Fields
- Using Dynamic Grouping for Dimension Field Values
- Creating Numeric Ranges With Binning
- Enabling Field Selection at Run Time With Field List Parameters
- Enabling Hierarchical Drilling in TIBCO WebFOCUS Designer With Auto Drill
- Enabling Drill Anywhere to Analyze Field Relationships
Navigating the TIBCO WebFOCUS Designer Interface

WebFOCUS Designer is divided into a Data tab, which provides options to prepare, profile, and join your data sources, and a Visualization tab, where you can create charts and reports using that data and arrange your content on a page. When creating a visualization with existing content, only the Visualization tab is available, since you do not specify a data source.

Using the Data Tab

To access the Data tab, select DATA on the WebFOCUS Designer toolbar.
The WebFOCUS Designer Data tab with a data source on the canvas is shown in the following image.

![Data tab with data source](image)

The Data tab includes the following tools and components.

- **WebFOCUS Designer Toolbar.** Provides features that affect the entire data flow and visualization. It includes the following options:
  - **Application menu.** Includes the following options:
    - **New.** Creates a new visualization in WebFOCUS Designer.
    - **Open.** Opens an existing chart, report, page, or visualization in WebFOCUS Designer.
    - **Save.** Saves the current visualization.
    - **Save As.** Saves the current visualization as a new file.
    - **Close.** Closes WebFOCUS Designer.
  - **Advanced Options.** Includes diagnostic information to help you validate and troubleshoot your data flow. The following options are available:
    - **View Source.** Displays the source syntax of the data flow, including all synonyms and Joins.
    - **Session Log.** Opens the Session Log dialog box, which includes a record of server configuration and activity.
    - **Clear Session Log.** Deletes all entries from the session log.
    - **Clear Undo/Redo History.** Deletes all undo and redo records.
    - **Undo.** Undoes the previous action.
    - **Redo.** Available when you have undone an action. Redoes the last undone action.
- **View.** Allows you to hide or show the Join Editor and Resources tree.

- **Resources tree.** Allows you to select synonyms from your application path that join to the data source to use for your visualization.

- **Canvas.** Shows the tables in your data flow. You can drag a synonym from the Resources tree onto a data source in the canvas to create a join.

- **Canvas toolbar.** Provides options to configure your data flow or the canvas interface. The following options are available:
  - **Get Data.** Opens the Get Data dialog, where you can select additional data sources to be joined with your original data source.
  - **Insert Join.** Displays potential Join candidates from a relational database, including confidence scores.
  - **Clear Join.** Removes the Join from the data flow. You can also right-click the Join object or a synonym joined to the original data source, and click *Delete* to remove the Join.
    - **Note:** Before deleting a recursive Join (when a table is joined to itself) you must remove any fields with active content from the first instance of the table.
  - **Insert Union.** Displays potential Union candidates from a relational database, including confidence scores.
  - **Delete All.** Removes the Union from the data flow. You can also right-click the Union object or a synonym united with the original data source, and click *Delete* to remove the Union.

- **Canvas options.** Displays the following options:
  - **Flow view.** An icon represents each synonym, and a container that displays the type of join represents each join.
  - **Model view.** A list box represents each synonym, and a vector between the joined synonyms represents each join.
  - **Arrangement.** Select a Layout option to define the spacing between objects on the canvas, or click *Auto Arrange* to reset the display of objects in the canvas to the default arrangement:
    - **Vertically spread out.**
    - **Vertically compressed.**
Vertically compressed with long H-space.

Default.

Auto Arrange.

More options. Sets the following Join defaults:

Insert child segment with snowflakes. No is the default, which inserts only the segment selected. You can select Yes to insert the selected segment and all of its descendants.

Display full component names. Yes is the default. Full component names are field names qualified/prefixed with the synonym and segment name.

Use Monotree. Yes is the default. The monotree view displays the current folder in the Data panel and provides navigation to other folders. Select No to display all folders in a traditional tree view.

Show undo/redo button with history. No is the default. Select Yes to display the history button.

Data sheet. The current state of your data is reflected in the Data sheet, which shows a data sample in a tabular format similar to a spreadsheet. The Data sheet appears when you select a synonym on the canvas.

Join Configurator. When a join has been created, allows you to modify it by changing the join type, the join operator and expression, and the fields used in the join.

Sample data. When a join has been created and you select the Sample Data tab, sample values for the joined synonyms are displayed together in a single table.

Join Profiler. When a join has been created and you select the Join Profiler tab, a join analyzer chart displays the number of matching values from each part of the join and the total number of values included in the data source as a result of the join. To the right of this chart, a key fields grid shows LHS and RHS match states.

To create joins in WebFOCUS Designer, drag a synonym from the Resources tree onto a synonym in the canvas to which you want to create a join. A join is created automatically based on common field names and values, but you can change the default join using the Join Configurator. For more information, see Joining Data on page 134.
Using the Visualization Tab

The data flow defined in the Data tab is used to create content in the Visualization tab. In the Visualization tab, you can create charts and reports and arrange them on a page in different types of containers, or you can create a visualization from charts, reports, images, and more that you have created and saved previously. If you are creating a visualization with existing content, you can access items in your workspaces and add them to your visualization.

To create a visualization with new content, on the WebFOCUS Hub, click the plus button and then click Create Visualizations. Alternatively, on the WebFOCUS Home Page, click Visualize Data, or click the plus button and then click Create New Visualization. To assemble existing content into a visualization, click the plus button on the Hub or Home Page and then click Assemble Visualizations.

The Visualization tab displays, as shown in the following image.

The Visualization tab includes the following tools and components.

1. WebFOCUS Designer toolbar
2. Visualization toolbar
3. Sidebar
4. Resources panel
5. Properties panel
6. Canvas
7. Filter toolbar
8. Content picker

The position of each item is indicated by the associated number in the following image.

Using the TIBCO WebFOCUS Designer Toolbar

The WebFOCUS Designer toolbar includes a set of options and controls that affect the entire interface or the entire visualization. The toolbar is shown in the following image.

The following table lists the controls that you can access from the WebFOCUS Designer toolbar.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>WebFOCUS DESIGNER Menu.</strong> Opens a menu that includes the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New.</strong> Creates a new visualization in whichever mode you are using, allowing you to create new content or to assemble a visualization from existing content.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Open.</strong> Opens an existing chart, report, page, or visualization.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Saving Options.</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Save.</strong> Saves the current visualization. When the visualization contains a single chart or report, you can choose to save it as a FOCEXC procedure (single chart or report file) or as a page (file that supports multiple charts and reports in a user defined layout). If the visualization contains multiple charts or reports, the visualization is always saved as a page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Save As.</strong> Saves the current visualization as a new file.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Export As.</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Data.</strong> For single items only, download a data extract, with the fields used in your content, as a .xlsx Excel spreadsheet.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Image.</strong> For single items only, download a .png image of your chart or report in its current state.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Close.</strong> Closes WebFOCUS Designer.</td>
</tr>
<tr>
<td></td>
<td><strong>Save.</strong> Opens the Save dialog box, where you can save the visualization to a specific location in your environment.</td>
</tr>
<tr>
<td></td>
<td>When the visualization contains a single chart or report, it saves as a single chart or report file. When the visualization contains multiple items, whether it was previously saved as a single item or you are saving it for the first time, it is saved as a compound document with multiple content items within it.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>🔄</td>
<td><strong>Undo.</strong> Undoes the previous action.</td>
</tr>
<tr>
<td>⏯️</td>
<td><strong>Redo.</strong> Redoes the last undone action. Available when you have undone an action.</td>
</tr>
<tr>
<td>📁</td>
<td><strong>Data and Visualization tabs.</strong> Allows you to toggle between the Data tab, where you can add joins to your data source, and the Visualization tab, where you can create new content items or import existing items in a responsive page.</td>
</tr>
<tr>
<td>💾</td>
<td><strong>Hide/show panes.</strong> Allows you to hide or show the Resources panel, Properties panel with Settings and Format tabs, and Content picker.</td>
</tr>
<tr>
<td>🌐</td>
<td><strong>Help.</strong> Launches the online Help content.</td>
</tr>
</tbody>
</table>

### Using the Visualization Toolbar

The Visualization toolbar includes contains options that are specific to the WebFOCUS Designer Visualization tool. The Visualization toolbar is only accessible from the Visualization tab. The Visualization toolbar is shown in the following image.

The following table lists the controls that you can access from the Visualization toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎯</td>
<td><strong>Add data.</strong> When creating a visualization with new content, click this button to select a data source. This button is not available when building a visualization from existing content.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Add container" /></td>
<td><strong>Add container.</strong> Adds a new panel container to a page. If the visualization is being created with new content, you can build a new chart or report in the container. If the visualization is being assembled from existing content, you can drag a content item into the new container.</td>
</tr>
<tr>
<td><img src="image" alt="Convert to page" /></td>
<td><strong>Convert to page.</strong> When creating a single content item, converts the visualization from a single item to a page.</td>
</tr>
<tr>
<td><img src="image" alt="Filter options" /></td>
<td><strong>Filter options.</strong> When creating a visualization with new content, allows you to enable or disable on-chart filtering and determine filter chaining behavior.</td>
</tr>
<tr>
<td><img src="image" alt="Add to filter bar" /></td>
<td><strong>Add to filter bar.</strong> When you add external content with parameters to a page, this button appears. Click it to create filters on the Filter toolbar for all parameters. Expand the menu and click <em>Choose filters to add to page</em> to select which specific filters to create.</td>
</tr>
</tbody>
</table>
| ![Live data](image) | **Settings.** When creating new content, opens the Canvas Data Limit dialog box, where you can change the following settings:  
- **Preview data.** Allows you to choose to show a representative data sample, live data in order from the data source, or generic test data values in the canvas at design time when creating new content.  
- **Record limit.** When sample data or live data are selected, allows you to specify the number of records from the data source to display in the canvas at design time when creating a chart.  
- **Enforce limit.** When using live data, determines whether the record limit should be applied post-retrieval, to aggregated records, or at the source, to records in the data source.  
These settings affect all new content items on the page. For more information, see *Configuring Sample Data Settings* on page 267. |
### Icon Description

**Output Format.** Allows you to select an output format for stand-alone charts and reports. The following options are available:

- AHTML
- HTML5
- HTML
- PPTX
- XLSX
- Select at runtime

Pages created from new content always use the Interactive output format. For more information, see [Changing Output Formats in a Chart or Report](#) on page 756.

**Info.** When creating a visualization using external, existing content, enables an informational mode that changes the view of all content items on the canvas to display their paths in the repository and parameters configured within these items. This is useful to identify which filters affect which items.

**Run in new window.** Runs a preview of the page in a new browser tab, allowing you to keep a run-time view of your content available as you develop it. When you click Run in new window again, the content is reloaded in the same new tab.
Accessing Resources From the TIBCO WebFOCUS Designer Sidebar

The sidebar contains tabs that allow you to access, modify, and view properties for different elements and items in a visualization. Each tab in the sidebar displays a related set of resources and options in the Resources panel. The tab selected in the sidebar is indicated by a line next to it, as shown in the following image, where the Fields tab is selected.
Viewing the Structure of a Visualization

The Outline tab provides a high-level overview of all of the items in a visualization, including all pages, page sections, visualization containers, and content items. The Resources panel when the Outline tab is selected is shown in the following image.

When you first open WebFOCUS Designer, the visualization consists of a single chart or report. Only this item appears in the outline. You can right-click the item to view its WebFOCUS language source syntax.

Once additional visualizations are added, page, section, visualization, and content levels appear in the Outline, as the visualization transforms from a single content item to a page.

The item that you select for editing in the canvas is highlighted in the outline. You can also click an item in the outline to select it, as an alternative to selecting it from the canvas.

You can right-click an item in the outline to access a relevant set of options. For example, if you right-click a section, you can rename it or add a new visualization to it if you are creating new content. You can right-click a container to rename or delete it. Right-click a content item to rename it, duplicate it, or to remove it if it’s in a multi-content container. If the item was created in the visualization, you can view the WebFOCUS source syntax or save the item as a separate file.
When the visualization has been transformed into a page, the outline also includes the JavaScript and CSS options, which allow you to add custom code to style and add run-time behavior to your visualization. This code can reference classes that you specify for visualization components using the Classes property.
Accessing Fields and Variables

You can click the Fields tab to display fields from the data source in the Resources panel. The Resources panel when the Fields tab is selected is shown in the following image.

You can use these fields to create content by double-clicking them, dragging them into a bucket on the Properties panel, or dragging them directly onto your content on the canvas. The bucket to which the field is added determines how the values display in your content.
If you drag a field onto an empty area of the canvas, a new container is created. If you drag a field onto the title bar of a container, you are presented with the option to replace the content in the container or add the content to the container as a new tab, accordion panel, or carousel slide. If you drag a field onto a chart, report, or map, then it is added to that content item in the default bucket for the field type.

Right-clicking a field provides further options, depending on the type of field. These options include the ability to add the field to the chart or the filter toolbar, use a dimension field as a measure or a measure field as a dimension, create bins for measure fields, or create a define field using the selected field. You can also create a define using the menu to the right of the Dimensions and Measures sections.

You can control how fields and variables are presented by using the View Selector menu, which is shown in the following image.

The following options are available:

- **Field layout.** Choose how the fields in your data source are organized. Folder view is the default.
  - **Folder view.** Organizes fields into folders based on segments and field hierarchies defined in the data source.
- **Flat view.** Lists all fields in alphabetical order on the same level instead of grouping them into folders.

- **Split dimensions/measures.** By default, dimension fields and measure fields in the data source are separated into different sections of the Fields tab, highlighting the different roles they perform in sorting and aggregating the values in your content. You can deselect this setting to show all fields in a single pane. This option is unavailable when viewing the Variables tab.

- **Field identifier.** You can choose how fields are identified in the Fields tab. By default, field titles display. You can choose to show the field name or field path and name instead.

  - **Show title.** Displays field titles in the Fields tab. The field title is a logical name defined in the data source that is used in axis labels, column headers, tooltips, and other areas.

  - **Show name.** Displays field names. The field name is the literal name of the field listed in the data source.

  - **Show path and name.** Displays qualified field names. This option shows the field name, as well as the file and segment where the field is located.

- **Enforce paths.** Selecting *Enforce paths* means that any joins in your data are automatically checked to ensure that all fields are connected. If a field is used from a table that is not joined to another table whose fields are being used, Enforce paths will not allow that field or any other fields from the disconnected table to be used, ensuring that the request executes successfully. This option is deselected, by default.

You can search for a field or a variable using the search bar. Type a text string into the search bar text box to filter for fields or variables whose titles or names contain that string. The list of fields or variables refreshes dynamically to display values that contain the string. The string can appear at any point in the field name or title.

To clear the search query, delete your search query or click the X button in the search bar, as shown in the following image.

![Search Bar](image)

The search bar X button is browser dependent, so it may not appear in certain web browsers. For example, it is available in Google Chrome, but not in Mozilla Firefox.
The fields in your data source are available from the Fields tab. By default, if the data source uses folders to organize the fields that it contains, these folders are reflected in the Fields tab. This folder organization is called a business view. For dimension fields, these folders could be field hierarchies defined in the data source or segments in the data based on different tables that have been joined together. Measures can also be grouped based on segments.

Icons identify whether a folder is a basic folder or a hierarchy, and whether a field is a character, geography, date, or numeric field. Calculated fields are indicated by a function symbol added to the field icon.

By default, the Fields tab is divided into two sections, one for dimension fields and one for measure fields.

Dimension fields are categories that sort and organize the values in your data. For example, product categories, customer names, geographic locations, and dates are all commonly used as dimensions. In a chart, each value in a dimension field often defines a separate section of the chart. For example, each dimension value might be represented by a riser in a bar chart, a slice in a pie chart, or a point in a scatter plot.

Dimension fields in your data source can be organized into hierarchies, where the top field is the most general and the bottom field is the most specific. The following image shows a hierarchy of product fields.

Note: Hierarchies in cube data sources do not include a Values list in WebFOCUS Designer.
Some dimension fields can also be expanded to show attributes. Attributes are other fields that provide additional information about field values. Each attribute field value is correlated to a value of the field that it describes. For example, in the following image, the attribute fields for the Customer City field, listed in the Customer, City Details folder, provide information such as the latitude, longitude, and population of each city value.

Measure fields supply quantitative values for each category defined in a chart or report, often providing aggregated values in a report or sizing components, applying a color scale, or appearing in tooltips in a chart or map. Measure fields typically use a numeric field format. You can add up to 16 measure fields to a chart or report.
To add a field to your content, double-click the field or drag it from the Resources panel on the Fields tab into a bucket or onto the canvas. When creating a chart, different buckets are configured to use different kinds of fields. For example, in a vertical bar chart, a measure field added to the Vertical bucket is used as a measure to aggregate the sort values in the chart by determining the height of each bar. On the other hand, putting a dimension field in the Vertical bucket creates matrix rows for each dimension value, breaking the chart into multiple smaller charts. Therefore, you will typically use at least one measure field in this bucket to define different bar heights. Similarly, you will typically use a dimension field in the Horizontal bucket for a bar chart in order to determine the values that each bar represents. If you use a measure field in the Horizontal bucket using the Add as dimension option, a bar will be generated for each value in the measure field.

Some chart buckets accept both measures and dimensions but display them differently. For example, the Color bucket in a bar chart creates a color scale for measure fields, and assigns colors to values in a legend for dimension fields.

In a chart, if a bucket is designed to use only measure fields or only dimension fields, you cannot drag an incompatible field into it from the Fields tab. To indicate this, the cursor changes to a cancel sign when pointing to an invalid bucket. For example, when creating a vertical bar chart, you cannot drop a measure field into the Horizontal bucket, or a dimension field into the size bucket.

Instead, to add a measure field to a dimension bucket, right-click the field in the Fields tab and click Add as dimension. The field is added to the default dimension bucket, and appears in blue, indicating that it is a dimension, as shown in the following image.

Similarly, to use a dimension field as a measure, right-click it and click Add as measure. The field is converted to a measure by applying the CNT. aggregation function, which provides a count of data records, and added to the default measure bucket. The field appears in green, indicating that it is a measure, as shown in the following image.

You can then move the field into another bucket that accepts measure fields.
You can also right-click the aggregated dimension field in a measure bucket and point to *Aggregate* to change the prefix operator aggregation from count (CNT.) to count distinct (CNT.DST.), which provides the number of distinct values for the field, or percent of count (PCT.CNT.), which computes percentages based on the number of instances found.

The Tooltip bucket, meanwhile, behaves somewhat differently. The Tooltip is a measure bucket that displays field values in the tooltip when you point to an area of a chart. Unlike other measure buckets, you can drag a dimension field directly into the Tooltip bucket. The dimension is aggregated using the FST. prefix operator, so the first value of the field is displayed in the tooltip. This ensures that the dimension field generates only one value for the tooltip. The Tooltip bucket is best used when each area of the chart is associated with a single value of the selected tooltip fields. As with any bucket, you can right-click a field in the Tooltip bucket and point to *Aggregate* to change the aggregation.

Since reports simply display field values based on the rules for each bucket, with no dependencies based on field type, they do not have these limitations. All distinct values are shown for any field dropped into the Rows or Column Groups buckets, while values are aggregated for any field added to the Summaries bucket.

The Rows bucket creates a row for each unique value in each field within it, while the Column Groups bucket creates a set of measure columns for each unique value. These buckets sort the aggregated or detail values in the report. You can add multiple fields to the Rows and Column Groups buckets to display more granular information in a report.

The Summaries bucket aggregates measure field values for each sort value of the Rows and Column Groups fields in the report. Adding multiple fields to the Summaries bucket creates multiple measure columns in the report. These measure columns are repeated for each column group value, if there are any fields in the Column Groups bucket.
While the Summaries bucket is the default measure bucket, it is not the only option for displaying measure values. You can use the display options to change the Summaries bucket to the Counts, Details, or Details with counter bucket to display different information for the fields within it. The display options can be accessed above the buckets from the Calculation Options menu, as shown in the following image.

The Counts bucket, enabled by selecting the Counts display option, aggregates values in the report by displaying the number of records for each field within it, for each sort value. The Details bucket, enabled by selecting the Details display option, does not aggregate the values of the fields within it. Instead, it displays all values for the selected fields. The Details with counter bucket, enabled by selecting the Details with counter display option, displays all values for the selected fields, similar to the Details bucket, and also counts the rows for each primary sort field value.
You can add fields to other areas, as well. If you drag a field to the Filter toolbar, you can create a filter for the field. If the field is a character field, you can select values from a list. If the field is a numeric field, you can use a slider to specify filter values. If the field is a date field, you can use a calendar to select dates or use a predefined date range.

If you drag a field into a header or footer, the field is used as a parameter to dynamically provide a value in the header or footer text. The first value found for the field is displayed at run time. Using a field in the header or footer is especially useful if that field is also used to filter your content or if it is used as a multipage field in a chart or to create breaks in a report. The following image shows WebFOCUS Designer with the Customer Country field added to the header of a chart that is filtered to only show data for the United States.
The following image shows the chart at run time. The chart header displays United States, which is the value of the Customer Country parameter.

You can manipulate fields from the Fields tab as well. You can right-click a field to add it to your content, create a filter for it, or create a calculated DEFINE field using the field that you selected. If you right-click a dimension field, you can add it to the chart as a measure. When you do this, an aggregation function that calculates a count of the dimension values is applied to the Dimension, and the field is placed in the bucket.

Similarly, you can right-click a measure field and add it as a dimension. In this case, the measure value in each row of the data source is used as a sort value in the chart. You can right-click a dimension and click Group values to create groups, or right-click a measure and point to Bin values to create bins. Groups are groups of related values, and bins are ranges of values. You can use groups and bins to create new sort fields for your content. For example, bins are used in histograms to plot the distribution of data values. Each bin value generates in a bar in the histogram.
You can right-click a measure or dimension once they are added to your content to access additional options. For example, if you right-click a dimension added to a chart, you can change the location of the axis, the sort order, create a compute, and more, as shown in the following image.
If you right-click a measure added to a chart, you can set it to use a logarithmic scale, which is useful when there are large disparities between values on the same axis, set sorting, apply an aggregation function, use a quick transform, and more, as shown in the following image.

<table>
<thead>
<tr>
<th>Add to filter toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log scale</td>
</tr>
<tr>
<td>Shape</td>
</tr>
<tr>
<td><strong>No sort</strong></td>
</tr>
<tr>
<td>Sort ascending</td>
</tr>
<tr>
<td>Sort descending</td>
</tr>
<tr>
<td>Sort limit</td>
</tr>
<tr>
<td>Format data</td>
</tr>
<tr>
<td>Aggregate</td>
</tr>
<tr>
<td>Quick transform</td>
</tr>
<tr>
<td>New calculation...</td>
</tr>
<tr>
<td>Rename</td>
</tr>
<tr>
<td>Hide</td>
</tr>
<tr>
<td>Remove</td>
</tr>
</tbody>
</table>
In the Fields tab of the Data pane, you can also create a calculation that runs before aggregation (DEFINE) or after aggregation (COMPUTE) by clicking the ellipsis buttons on the top right of the Dimensions and Measures panes, and clicking *Add calculation*, as shown in the following image.

![Add calculation](image)

The Variables tab contains a list of variables and preset filters defined in your data source, as well as default system variables. To add a variable to the chart to use as a filter, drag it into the Filter toolbar.

**Adding Filters to Pages Assembled From External Content**

When you assemble a page from existing content, using the Assemble Visualizations option, the Filters tab on the sidebar allows you to display and chain filter controls. When you add an existing chart or report to a page, WebFOCUS Designer identifies any parameters present in the item. A badge appears on the Filters tab on the sidebar, indicating that you can add filters to the page, as shown in the following image.

![Filters](image)

When you open the Filters tab, the *Add all filters to page* button and a list of parameters from the content items on the page display. Click *Add all filters to page* to create filter controls for all of the listed parameters, or right-click each one and click *Add to page* to add them individually. Once added, the visibility icon next to the parameter is no longer faded.

Below each parameter on the Filters tab is an expandable list of Bindings. The Bindings list shows the data source and target items on the page that are associated with each parameter, providing information about each filter. Click a target item in a Bindings list to briefly highlight the border of that item on the page in order to easily locate it.
**Note:** Numeric, date, and date-time filter bindings do not indicate the associated data source, but you can click the Info button on the Visualization toolbar to see which data sources are used for the associated target items in order to determine the data source for each filter parameter.

Filters for fields that are part of the same hierarchy in the data source are automatically chained. This means that when you select a value from one of the filter controls, the other controls are filtered and updated based on the value that you select, ensuring that you can only select valid filter values. You can also manually apply chaining by dragging one parameter onto another in the parameter list. The filter becomes a child, for chaining purposes, of the field onto which it was placed. To unchain a parameter, drag it into the empty space between the Add all filters to page button and the top parameter in the list. The parameter is removed from the chaining hierarchy and moved to the bottom of the list.

Chaining relationships are indicated by indents in the parameter list. Filter controls are chained to any filters indented under it in the list. For example, in the following image, the Category filter is chained to the Product Model filter, so when you select a category, the list of available models in the filter control updates.

![Filters](image)

In this example, selections from the Category filter do not affect the Region or Store Type filters, since they are not part of the same chaining hierarchy, and, since filtering in an assembled page is unidirectional, values selected from the Product Model filter do not chain back up to the Category filter.
Accessing Containers and Widgets

The Container tab provides a selection of container types and widgets that you can use in your visualization.

The Container tab is shown in the following image.

Using this tab, you can select empty containers and widgets that you can drag to the canvas and populate with the content of your choice.

The types of containers available to you include the following:

- Panel
- Tabbed
- Carousel
- Accordion
- Grid
- Panel group
The panel, tabbed, carousel, and accordion container types are used to hold content, such as charts, reports, or images. You can add multiple content items to a tabbed, carousel, or accordion container and navigate between them using the paging behavior of the container.

When assembling a visualization from existing content, you can add multiple filter controls to cells in a grid container as an alternative to or in addition to the Filter toolbar, providing more freedom in the placement of your filter controls. The panel group container, meanwhile, can contain multiple other containers within it, allowing you to keep them together when responsive folding occurs in the visualization.

The Container tab also allows you to access the Link Tile and Explorer widgets. The Link Tile widget allows you to click through from a content item displayed on the page to a target item from your Repository. You can configure the Link Tile using the Link Tile options on the Settings tab of the Properties panel. The Explorer widget allows you to embed the Workspaces view of the Hub into a WebFOCUS Designer page that can be added to a portal, allowing users to create new content and access existing files in the Repository.

Adding Existing Content to a Visualization

You can add existing content to a visualization from the Content tab. This content can be a WebFOCUS procedure such as a chart or report, a URL, an image, and more.
The Content area provides access to the Resources tree, where you can navigate to your content. The initial view of the Resources tree displays the directory in which the page is created. You can navigate to other workspaces and folders using the back arrow. Each item on the tree is represented by a thumbnail, making it easy to locate content. The following images show the Resources tree displaying two different levels of the repository hierarchy. The first image shows folders and items within the Portal folder.
The second image shows the content in the Small Widgets folder, within the Portal folder. You can click the name of the folder, in this case, Small Widgets, to return to the parent folder.

You can use the search bar to find an item more easily. Once you have typed a search term, to return to the view of all items, delete the text in the search bar, or, in certain browsers, click the X button.

Drag a content item onto the visualization canvas or into a container to add it. If you drag content onto a container that already contains content, you are asked whether you want to replace the content in the container or add a new tab, accordion panel, or carousel slide to it.
Adding Text and Buttons to a Control Area

Adding Controls, Buttons, and Labels to a Filter Cell

When assembling existing content into a visualization, you can use the Control tab to add empty filter controls, a text label, or Submit and Reset buttons to a cell in a filter control area, such as the Filter toolbar or a grid container.

The Control tab is shown in the following image.

![Control tab image]

You can add empty controls to the Filter toolbar or a filter grid if you want to select the particular types of filters to use in your page before binding specific filter parameters to them. To add an empty filter control, drag one of the following filter controls into a filter cell:

- Button set
- Calendar
- Checkbox
- Double list box
- Dropdown
- Input
- Radio
- Slider
- Submit
- Toggle
Some filter controls can only be used under specific conditions. For example, the calendar control can only be used with date and date-time fields, and the slider can only be used with numeric fields. The toggle control only takes the first two values from your data set, so it best used with Boolean fields. Others are best suited to selecting either a single value or multiple values. For example, the check box and double list box are commonly used with multi-select parameters, while the radio button control is commonly used with single-select parameters. Still others, like the input edit box and toggle control, can only accept a single value, and so should always be used with single-select parameters.

You can use a text label to add contextual information to a filter cell. The Submit and Reset buttons, meanwhile, change the filter behavior so that instead of refreshing the page to apply filtering whenever a user makes a control selection, the page does not refresh until the user clicks Submit. This is useful when you have many filter controls on a page. The Reset button allows the user to reset all filter controls to their default selections. The options on the Control tab cannot be used when creating new content in a visualization.

Once added, you can choose to delete either the Submit button or the Reset button to include the functionality of just one of these buttons.

To add a text label or Submit and Reset buttons to a visualization, drag the object into a cell in the Filter toolbar, a modal filter window, or a grid container.
Generating Analytic Insights

You can click the Insights tab on the sidebar to easily run advanced analyses and generate visualizations and narratives on your data set, without manually preparing and analyzing your data, or having prior knowledge of data science or statistics. An example of the Insights tab with some generated content is shown in the following image.

To learn more about Automated Insights, see *Generating Instant Insights in TIBCO WebFOCUS Designer*.

Modifying Object Properties

You can view and modify the properties of an item on the page, including content, containers, filter controls, and pages, from the Properties panel. The Properties panel includes configuration options on the Settings tab and styling and formatting options on the Format tab. The Properties panel appears to the right of the Resources panel, and changes based on the item that you have selected in the canvas.
The Properties panel for a bar chart is shown in the following image.
When you select a chart or report, the Properties panel shows a list of buckets on the Settings tab. Drag a field from the Resources panel with the Fields tab selected into a bucket to add it to your content. The buckets that you place your fields into determine how they are displayed.

When creating a chart, depending on the type of chart that you create, you may see some of the following buckets:

- Vertical
- Horizontal
- Size
- Color
- Tooltip
- Animate
- MultiPage
- Measure
- Detail
- Location
- Group

When creating a report, you can use the Rows and Column Groups buckets to sort a report based on the values of the fields in those buckets. The Summaries bucket aggregates measure field values based on these sort values.

The Settings tab also includes the Filter bucket. The Filter bucket allows you to create static filters specific to a content item, as opposed to the Filter toolbar, which creates prompted filters that affect the entire visualization. To create a static filter, drag a field from the Resources panel into the Filter bucket. You can specify filter values using the Add Filter dialog box with a set of controls appropriate to the type of field that you are filtering.
You can use the display options, available from menus above the buckets on the Settings tab, to change the display of values in your content. When creating a report, the display options allow you to change the Summaries bucket to the Counts, Details, or Details with counter bucket to display different information for the fields within it, as shown in the following image.
When creating a chart, the display options additionally allow you to modify its structure, depending on the chart type. The layout display options for a bar chart are shown in the following image.

In addition to changing the display of measure values and the layout of the chart, you can swap the axes in eligible charts and clear the fields from all buckets.

The menu to the right of each bucket label also provides different options for charts and reports, depending on the bucket. These options include the ability to clear the bucket, create a new calculation in a report, or split the y-axis for multiple measures in a bar, line, or area chart.
When placed in certain sort buckets, fields display icons indicating the sort order of the field and provide an option to use the field as a matrix row or column if it is used as a dimension, or switch y axes to create a dual-axis chart, if the field is used as a measure in certain chart types. In the following image, the Vertical bucket contains a matrix row field and a vertical axis measure field.

![Vertical Bucket](image)

You can also right-click a field in a bucket to access options pertaining to that field. These options include field format, sorting, aggregation options, and more.

Below the field container buckets in the Display area, you can access the Filters and Content areas. The Filters area includes the Filters bucket. You can drag a field into the Filters bucket to create a static filter. Static filters affect only the selected content item, and cannot be modified at run time.

The Content area includes a variety of options to modify the structure and behavior of the chart. You can show or hide the header and footer areas for charts and reports, add row and column totals to reports, and enable Auto Drill and Auto Linking for single content items. For single-content charts only, you can also enable automatic refresh and enable Insight. Auto Drill, Auto Linking, and Insight provide run-time interactivity to your content, expanding the amount of information accessible from a single item. Automatic refresh allows you to reflect changes to your data source in real time by updating your content at set intervals.

When editing content, the Format tab provides access to options to style your content and change the output format. For a report, you can change the theme and, for a stand-alone report, the output format. The theme applies an overall set of styling properties to the entire report, while the output format allows you to change the type of file generated at run time.
When editing a chart, the Format tab provides access to even more options. You can use the Quick Access menu at the top of the Format tab to access styling options for different sections of a chart, such as the legend, axes, or different series. You can also access options for different sections of a chart by right-clicking an area of the chart on the canvas and clicking Style. The General options include the ability to change the theme and output format, as well as styling the chart frame and background color.

When you select a container in a visualization that has been transformed into a page, the available options on the Properties panel allow you to style the container and configure its behavior within the visualization as a whole. On the Settings tab, you can change display settings such as whether to include a title or toolbar on the container and on which types of devices the container should be visible. You can also allow content customization and provide cascading style sheet class names that you can use in custom CSS and JavaScript code. The Format tab allows you to change the style of the container. The Style options are based on the selected theme, which you can change using the Theme option on the Format tab when you select an entire page. The selected theme is also applied to content in the visualization, by default, although you can specify a different theme for each chart or report.

When you select a section of a page, which is a horizontal area of the visualization that contains one or more rows of containers, you can use the Settings tab to assign CSS classes, make the section collapsible, and set the height of the section. On the Format tab, you can select a style to change the background color of the section. You can add more sections to the visualization by right-clicking the first section, in the space directly surrounding the containers in the visualization, and clicking Insert section above or Insert section below.

You can select an entire page of a visualization by clicking the page toolbar or the area of the canvas below all of the sections on a page, or by using the outline. When you select the page, you can use the Settings tab to assign CSS classes and show or hide the title and toolbar for the page. On the Format tab, you can change the theme for the entire page, the page margins and maximum width of the page, and the appearance of the page heading text.

Using the TIBCO WebFOCUS Designer Canvas

The canvas displays the current state of your content as you create it. You can select items in the canvas to edit them, drag resources such as fields or containers onto the canvas to add them to your content or page, and use on-chart filtering to create filters based on visual selections.
The canvas also contains, if enabled from the Properties panel, heading text for each component, as well as optional footers for charts and reports. You can double-click this text to edit it, and then type new text, make styling changes to header and footer text using the text toolbar that appears, and even drag a field into the header to create dynamic header text that displays the first available value for the field at run time.

Initially, if you choose to create a visualization with new content, the canvas allows you to create and edit a single chart or report.

The chart or report fills the entire canvas. Some options are only available when creating a single content item. For example, you can only enable Auto Drill or Auto Linking for stand-alone content items and only make a stand-alone item an Auto Linking target.

When creating a single content item, two canvas behaviors are available. The output format that you use determines which of these behaviors is used.

At design time, the AHTML and HTML5 output formats use the responsive canvas. Reports present In-Document Analytic paging controls at the bottom of the report that allow you to navigate through it. Some report styling properties are unavailable when using the responsive canvas. Charts in these output formats present informational tooltips and allow on-canvas filtering at design time.

The HTML, PDF, PPTX, and XLSX output formats, on the other hand, use a paginated canvas at design time. Some report styling properties are only available when using the paginated canvas. You can scroll through an entire report using a scrollbar, and charts do not present interactive options, such as tooltips.

At run time, the HTML5 and HTML output formats are functionally equivalent. The two options are available to allow you to use the two different canvas types. For more information about output formats for charts and reports, see Changing Output Formats in a Chart or Report on page 756.
You can create multiple new content items on a page. To transform a single item into a page without adding a second container, click **Convert to page**. Once you have converted a chart or report into a page, you can drag a container onto the page from the Resources panel when the **Container** tab is selected on the sidebar. Click and drag a container from the Resources panel, and drop it in the desired location. An empty container is created, to which you can add content. Alternatively, with the Fields tab selected on the sidebar, click and drag a field into an empty area of the page to create a basic panel container with a default content item that uses the selected field. The canvas with two containers is shown in the following image.

Once a container is placed on the page, you can click and drag the container toolbar to move it. A blue highlighted area shows where the container will be dropped. If necessary, other containers on the page will move to accommodate the placement of the container that you have moved.

If you point to a container, a set of sizing handles appears. If you click and drag one of these handles, you can resize a container on the page. The contents of the container automatically resize to fit the new container dimensions.

The same types of components are available in a page assembled from existing content. These pages are created by clicking the plus button on the WebFOCUS Hub or WebFOCUS Home Page and clicking **Assemble Visualizations**. When assembling content into a visualization, you cannot edit individual, external content items. However, additional options are available for certain components. For example, you can change styling and default values for filter controls, style and rearrange the filter grid, and unlock a container for run-time customization. When assembling a page from existing content, if you hold the Ctrl key, you can select multiple containers, controls, or sections to apply the same changes to each.
You can click and drag to select an area of a new chart created in a visualization to filter it. When you make a selection, a tooltip appears, giving you the option to filter for the values in the selected areas of the chart, or filter the visualization to exclude those values. A filter control is added to the Filter toolbar, and all content created in the visualization is affected, allowing you to filter your content quickly and intuitively. To clear the filter, remove the filter control from the toolbar. The filter is removed from all affected content.

The canvas shows a design view of your content. To see a full run-time view of your visualization, with run-time functionality such as drilldowns, In-Document Analytics, and more, click Run in new window on the Visualization toolbar. Your content runs in a new browser tab or window.

Filtering a Visualization From the Filter Toolbar

Filters in WebFOCUS Designer can utilize one of two behaviors. These are static filters and prompted filters. Static filters are always applied to your content whenever it is run, and allow you to apply consistent filter values without prompting the user to make filter selections. They are applied to a single content item at a time, and can only be added to new content. Prompted filters, on the other hand, allow users to select the filter values to use in your visualization at run time. When you create a prompted filter, a control appears on the Filter toolbar, allowing you to make filter selections. The user can see these controls and make selections from them at run time. Run-time controls are not displayed for static filters. Prompted filters can be created for new content, or added to a visualization from referenced content.

Prompted filters are created, accessed, and modified from the Filter toolbar. You can create a prompted filter in one of the following ways:

- Drag a field from the Resources panel to the Filter toolbar.
- Right-click a field from the Resources panel or a bucket in the Properties panel and click Add to filter toolbar.
- Use on-chart filtering to select areas of a chart on the canvas.
- Add external content that includes dynamic parameter filters to a page.
The Filter toolbar is displayed below the page heading in the following image.

When creating a prompted filter in a new chart or report, you can click a control on the Filter toolbar to change the filter selection, or right-click the it to access additional filtering options, such as making the filter required, changing the aggregation, changing the number of values that can be selected, or changing the filter operation from value selection to exclusion.

Right-click a prompted filter generated for external content to change the control type or merge controls for the same field. You can also use the options on the Settings and Format tabs to set default values for the filter, specify how the filter interacts with items in a page or portal, and style the filter.

Different types of filters provide different controls on the Filter toolbar. Filters on alphanumeric fields provide a list from which you can select values, measure fields provide a slider on which you can provide maximum and minimum values, and date fields provide a calendar from which you can select a range of dates or use a default range option.

**Changing Content Types**

You can use the Content picker, on the right-side of the WebFOCUS Designer interface, to change chart and report types in your visualization.

When a chart or report is selected, the Content picker allows you to select a chart type or report layout. This includes the ability to change your content from a chart to a report in addition to changing to different varieties of each content type.
By default, the Content picker is collapsed, allowing you to scroll through common options, as shown in the following image.
You can click the arrow at the bottom of the Content picker to expand it to display all content options, including additional report layouts, different map types, additional chart types, and chart extensions that you have enabled in your environment. The expanded Content picker is shown in the following image.

When you change the chart or report type, fields may need to be rearranged in, and in some cases removed from, their buckets to accommodate the new type. You can rearrange them as needed.
**Procedure: How to Create a Visualization With New Content in WebFOCUS Designer**

WebFOCUS Designer provides a wide variety of content creation options, allowing you to create new charts and reports in a page, or create a page with existing content. If you create a visualization with new content, you can also customize the data that you use in your content by joining additional tables to your original data source.

The following are a general set of steps that you can use to create new content in WebFOCUS Designer:

1. On the WebFOCUS Hub, click the plus button and then click *Create visualizations*.
   
   Or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. In WebFOCUS Designer, click the *Add data* button to select a data source.

3. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

4. Start by creating a new chart or report.

   a. From the Content picker, select a content type. You can choose from different chart types and report layouts.

   b. With the Fields tab selected on the sidebar, drag fields from the Resources panel into the buckets in the Properties panel to create content.

      You can also double-click a field or drag it onto the canvas to add it to the default bucket for that field type.

   c. Optionally, filter your content by dragging a field into the Filter toolbar or Filters bucket.

      Prompted filters in the Filter toolbar affect the entire page, while static filters in the Filters bucket affect only the item for which they were created.

   d. Use the options of the Format tab of the Properties panel to style your content.

   Once you've created content, you can save it as a single item or turn the visualization into a page.

5. If you want to create a page with multiple content items, click *Add container* on the Visualization toolbar to turn the visualization into a page.

   The first item you created is moved into a container, and a second container is created.

   To create a page that contains the single item that you have created, click *Convert to page* on the Visualization toolbar. The item is moved into a container, but a second container is not added.
6. Continue adding content to the page. You can create a new container by dragging one from the Container tab on the sidebar, or click Add container to create a new container. You can then create a new content item as outlined in step 4. You can also drag a field from the field list onto an empty area of the canvas to create a new container with content using that field.

7. Select different areas of the page and style and format them using the options on the Properties panel.

   The entire page, sections, containers, filter controls, and filter cells all have their own set of styling and formatting options.

8. Once you have finished creating your visualization, save it. You can also preview the visualization to see run-time behavior by clicking Run in new window.

You can now add your visualization to a portal and share it with others. If you created a single content item instead of turning the visualization into a page, the item can be added to new visualizations as external content.

**Procedure: How to Create a Visualization With Existing Content in WebFOCUS Designer**

WebFOCUS Designer provides a wide variety of content creation options, allowing you to create new charts and reports and create pages with new content, or create pages using existing content. If you have created charts and reports in WebFOCUS Designer, InfoAssist, or other content creation tools, or if you have external items such as images and URLs, you can add them to a page that uses external content.

The following are a general set of steps that you can use to create content with existing items in WebFOCUS Designer:

1. On the WebFOCUS Hub or the WebFOCUS Home Page, click the plus button and then click Assemble Visualizations.

   WebFOCUS Designer opens in a new browser tab.

2. In WebFOCUS Designer, select a template for the page. You can use a predefined template, or select Blank to build the page from scratch.

3. Add content to the page. Click Content on the sidebar and navigate to an item in the Resources panel, then drag onto the canvas. Alternatively, you can create a container for an item first by clicking Container on the sidebar and dragging a container on to the canvas, and then add content to the container.

4. Continue adding content to the page. You can create a new container by dragging one from the Container tab on the sidebar, or clicking Add visualization. You can then click Content on the sidebar to access items that you can add to containers on the page or drag directly onto the canvas.
5. If the content that you added to the page includes dynamic parameter filters, an indicator appears on the Filters tab on the sidebar. Select the Filters tab and then click **Add all filters to page** to create controls for all parameters in your content, or right-click a specific parameter in the list and click **Add to page** to create a control for it.

6. Select different areas of the page and style and format them using the options on the Properties panel.

   The entire page, sections, containers, filter controls, and filter cells all have their own set of styling and formatting options.

7. Once you have finished creating your visualization, save it. You can also preview the visualization to see run-time behavior by clicking **Run in new window**.

You can now add your visualization to a portal and share it with others. If you created a single content item instead of turning the visualization into a page, the item can be added to new visualizations as external content.

### Navigating TIBCO WebFOCUS Designer With Keyboard Controls

You can use keyboard commands to navigate through the WebFOCUS Designer interface to perform certain content creation tasks without a mouse.

Press the Tab key to navigate between adjacent sections of the user interface, or press Shift + Ctrl + F10 to open a menu of sections of the user interface to quickly jump from one section to another if they are not near each other. You can jump to one of the following areas of the interface:

- WebFOCUS Designer toolbar.
- Visualization toolbar.
- Sidebar.
- Properties panel.
- Canvas.
- Content picker.

Press the Enter key or Spacebar to select the item or area that is currently in focus. The arrow keys can be used to navigate through a section of the interface. For example, use the Up Arrow and Down Arrow keys to navigate through the field list, and the Right Arrow and Left Arrow keys to expand and collapse folders.

Context menu options can be accessed by pressing the Menu key or by pressing Shift + F10. For example, to add a field to a chart or report, navigate to the field, press the Menu key, focus on **Add to chart** or **Add to report** and press the Enter key or Spacebar.
When you select a container on the canvas, you can use the arrow keys to move the container and use the Shift key and an arrow key to resize it. Shift+Right Arrow expands the container to the right, while Shift + Left Arrow contracts the container from the right. Similarly, Shift + Down Arrow expands the container downward, while Shift+Up Arrow shrinks the container from the bottom. You can use the Delete key to delete the selected container.

You can also use keyboard commands in a page at run time. Use the Tab key to navigate between areas, buttons, and controls on the page, and press the Enter key or Spacebar to execute a button command or open a menu. When using filter controls, you can use the Tab key to navigate to different sections of the control, use the arrow keys to navigate to different values, use the Enter key to select values, and use the Esc key to close the control and apply the filter. At run time you can also press Ctrl + Shift + F10 to open a menu that allows you to jump to different areas and containers on the page, once you have started to navigate within it.

**Basic Guidelines for Building Accessible Pages in WebFOCUS Designer**

When building pages in WebFOCUS Designer that are intended to be accessible, there are some basic guidelines that you can follow.

Before creating your pages, you will need content with which to populate them. When creating authored pages that are converted from a single content item, you build this content directly within the page. When assembling pages from existing content, your content is saved as stand-alone charts and reports. Since many charts rely on visual cues in order to communicate information, such as data categories and values, it may be preferable to use reports where possible. If it is necessary to use a chart, adding data labels can be a compromise, as in some chart types, the screen reader reads out data labels as the user navigates through the content. When creating reports, it may be advisable to limit the number of fields that you use. This helps reduce the number of values in the report, making it easier to navigate. Simplification is always a best practice when creating accessible content.

Content items that you add to your page reside in containers. These can be basic panel containers, which each contain a single content item, or they can be a tab, accordion, or carousel container, which can hold multiple items on different tabs, accordion panels, or carousel slides, respectively. Although each of these container types is accessible, when building accessible pages, using basic panels without sub-panel sections can provide a more intuitive user experience.

When adding filters to a page, keep in mind that certain filter controls are easier to navigate than others. If possible, avoid using the calendar control to filter a date field. Instead, consider the option of using content items with separate filters for individual date components, such as years, quarters, months, or days. These component filters can use a drop-down control, which is easier to navigate.
You can improve the accessibility of your filter controls by adding a tooltip with information about the type of control and the values that the user can select. To add a tooltip to a control, select it and, on the Settings tab, in the General Settings area, type text for the Tooltip property that you want to display when you point to the control at run-time. You can also double-click the control label on the canvas to type a more descriptive title for the control. By default, the title of the field is used.

Procedure: How to Create New Content in WebFOCUS Designer

Use the following the following steps to create a new chart or report, which you can transform into a page, in WebFOCUS Designer.

1. On the WebFOCUS Home Page, press Ctrl + Shift + F10 to open the navigation menu.
2. Use the Down Arrow key to navigate to Toolbar and then press the Enter key.
3. Press the Tab key twice to navigate to the Visualize Data button, and then press the Enter key.

WebFOCUS Designer opens in a new tab, where you are prompted to select a data source.

4. In the Select Data Source dialog box, use the Tab key to navigate to the Workspace menu.
5. Use the Down Arrow key to expand the Workspace menu and navigate to a workspace in your environment from which you can access the data source that you want to use, then press the Enter key to select it.

The file explorer in the Select Data source dialog is populated by the application folders, Master Files, and Reporting Objects available from the selected workspace.

6. Use the Tab key to navigate to the Flat View button. Press the Enter key to switch to the flat view in the file explorer, making all data sources available for selection without having to navigate into subfolders.
7. Use the Tab key to navigate inside the file explorer. Use the Down Arrow and Up Arrow keys to navigate to the data source that you want to use, and then press the Enter key to select it.

The WebFOCUS Designer canvas loads, and you can begin creating your content.

8. To save your content, press Shift + Control + F10 to open the navigation menu. Navigate to Tool Menu and press the Enter key. Press the Enter key again to open the Application menu. Use the Down Arrow key to navigate to Save, and then press the Enter key. The Save dialog box opens. Use the Tab key to navigate to the Save button, and then press the Enter key.
**Procedure:** How to Navigate an Accessible Page Created in WebFOCUS Designer

When you run a page created in WebFOCUS Designer, you can use keyboard controls to navigate through different page components, including page and panel toolbars, filters, and sub-container sections. Components are labelled for screen reader use.

To quickly jump to a specific section of the page, press Ctrl + Shift + F10 to open the navigation menu. Otherwise, navigate from the top of the page using the following steps.

If you are using JAWS as your screen reader, press Insert + Z on your keyboard to enter Forms mode, allowing you to set values for controls more easily.

1. From the WebFOCUS Home Page, press Ctrl + Shift + F10 to open the navigation menu. Press the Space bar to open the **Header** submenu, then press the Down Arrow key three times to focus on the **Workspaces** option. Press the Enter key to navigate to the **Workspaces** option on the WebFOCUS Home Page toolbar, and press the Enter key again to open the Workspaces view.

2. In the Workspaces view, navigate to the page that you want to run. Press Shift + F10 or the Menu key to open the shortcut menu. Press the Down Arrow key to navigate to the collapsed **Run** menu. Press the Space bar or Enter key to expand the run menu. With focus on **Run in new window**, press the Enter key to run the page in a new browser tab or window.

3. Press the Tab key to start navigating the page. The first element should be the page title.

4. Press the Tab key again to move to the next element, which is the **Refresh** button, by default. Press the Enter key to refresh all items on the page.

5. Press the Tab key to navigate to the **Hide Filter** button. The filter bar displays by default if there are any filters added to it. Press the Enter key to hide the filter bar, and press the Enter key again to show the filter bar again.

6. Press the Tab key to navigate to the **Export to file** menu. By default, you can export a page as a PDF or a .png image. When creating the page, you can set options to export only one file type, in which case this menu becomes a button, or not allow export. Press the Enter key to expand the menu, use the Down Arrow key to navigate to an export file type, and press the Enter key again to export a snapshot of the page. To close this menu without selecting an option, press the Esc key.

7. Press the Tab key to navigate to the filter bar, if there are filters added to the page. Once you have placed focus on a filter control, you can set filter values using a different set of steps, depending on the control type.

   - To select values from a drop-down list, press the Space bar to open the drop-down menu. Use the Down Arrow and Up Arrow keys to navigate through the list of values, and use the Space bar or Enter key to select values. Press the Esc key to close the drop-down menu and apply your selections. If the filter is single-select, the menu closes as soon as you select a value.
To select values from a list of check boxes or radio buttons, use the Tab key to navigate through each item in the list. Press the Space bar or Enter key to select or clear a check box or select a radio button. Check box controls allow you to select multiple values, while radio button controls allow you to select a single value.

To select values from a button set, once you have placed focus on the control, press the Tab key again to enter the control, then use the Left Arrow and Right Arrow keys to navigate between values in the button set. Press the Enter key or Space bar to select a value. A button set may be single select or multiselect.

To select a date range from a calendar control, once you have placed focus on the control, press the Space bar to open the date picker menu. This menu provides the ability to clear the date range, select a range from a list of preset options, or set a custom date range.

To set a numeric range using a slider control, once you have placed focus on the control, use the Left Arrow and Right Arrow keys to set the lower end of the slider, then press the Tab key and use the Left Arrow and Right Arrow keys to set the high end of the slider. Once you are done setting the slider range, press the Tab key to advance to the next page component.

8. Once you have navigated through all filter controls, press the Tab key to navigate to the title bar of the first container. Press the Tab key again to navigate to the Maximize button on the container. Press the Enter key or Space bar to maximize the container, and press the same key again to collapse the container once it has been maximized.

9. Press the Tab key again to navigate to the run-time menu of the container. Press the Enter key or Space bar to open the menu and place focus on the Refresh button. Press the Enter key or Space bar to refresh the content in the container. Press the Esc key to close this menu without refreshing the container.

10. If the container includes multiple content items on separate tabs, accordion panels, or carousel slides, press the Tab key to navigate to the first sub-containers. You can navigate to each sub-container using different methods depending on the container type.

To navigate between tabs in a tab container, press the Tab key to navigate to the first tab, then use the Right Arrow and Left Arrow keys to focus on different tabs. Press the Enter key or Space bar to display the selected tab.

To navigate between panels in an accordion container, press the Tab key to navigate to the first panel, then use the Up Arrow and Down Arrow keys to focus on different panels. Press the Enter key or Space bar to expand a collapsed panel or collapse an expanded panel. When you expand an accordion panel, all other panels automatically collapse.
To navigate between slides in a carousel container, press the Tab key to place focus on the Previous Slide button. Press the Enter key or Space bar to display the previous slide in the carousel. The slides cycle continuously, so you can navigate through the first and last slides. Press the Tab key four more times to navigate to the Next Slide button. Press the Enter key or Space bar to display the next slide in the carousel.

11. From the run-time menu in a basic panel container, or from a tab, the last accordion panel header, or the Next Slide button in a carousel container, press the Tab key to place focus on the content item. Depending on the content type, some information about the item is read out. Use the arrow keys to navigate through text labels in a chart or values in a report.

Press the Tab key again to navigate to the next container.

**Procedure:** How to Assemble a Page From Existing Content in WebFOCUS Designer

Use the following steps to create a new page from existing charts, reports, images, and other content items.

1. On the WebFOCUS Home Page, press Ctrl + Shift + F10 to open the navigation menu.
2. Use the Down Arrow key to navigate to Toolbar and then press the Enter key.
3. While focused on the plus button, press the Enter key to open the What would you like to do menu.
4. Use the Tab key to navigate to the Assemble Visualizations button, and then press the Space bar.

WebFOCUS Designer opens in a new browser tab, and you are prompted to choose a template for your page.

5. To add a content item to the page, execute the following steps:
   a. Press Ctrl + Shift + F10 to open the navigation menu.
   b. Use the Down Arrow key to navigate to Resources, and press the Enter key.

Focus moves to the Outline tab, which is the first tab on the sidebar.

   c. Use the Down Arrow key to navigate to the Content tab on the sidebar. Press the Enter key or the Space bar to open it.
   d. Press the Tab key to navigate to the search bar, to search for an item by name, or to the resources tree. Use the Down Arrow and Up Arrow keys to navigate through items in a folder, and use the Right Arrow and Left Arrow keys to navigate into and out of folders in the repository file hierarchy.
   e. Press the Enter key or the Space bar to add the item to the page. Each item is placed in its own container. The new containers become available from the navigation menu, so you can easily select them.
6. To select a container on the page, press Ctrl + Shift + F10 to open the navigation menu, and then use the Down Arrow key to navigate to Resources. Press the Enter key to move focus to the Outline tab on the sidebar. Press the Tab key twice to enter the outline, then use the arrow keys to navigate to the container that you want to edit.

Note that the container may have the same name as the content item within it. The container and content item are separate components that allow a different set of configuration options.

7. To resize a container, use the Shift key and an arrow key. Shift + Right Arrow expands the container to the right, while Shift + Left Arrow contracts the container from the right. Similarly, Shift + Down Arrow expands the container downward, while Shift + Up Arrow shrinks the container from the bottom. You can use the Delete key to delete the selected container.

8. To configure or modify the container using the options on the Settings and Format tabs, select the container, and then press Ctrl + Shift + F10 to open the navigation menu. Use the Down Arrow key to navigate to Settings/Format. Press the Tab key once to focus on the tab label. You can use the Right Arrow and Left Arrow keys to navigate to the Settings or Format tab, and press the Enter key or Space bar to open it. Use the Tab key to navigate to different options. You can use the Enter key or Space bar to toggle options on or off, and type text into text boxes.

Procedure: How to Open an Existing Chart, Report, or Page in WebFOCUS Designer

You can access any content items saved in your repository from the Workspaces view. You can navigate to items in different workspaces, and open them from the file explorer.

On the WebFOCUS Home Page, press the Tab key to navigate to the Workspaces button, then press the Enter key.

Note: If you have already navigated within the page, you can return to the area that contains the Workspaces button by pressing Ctrl + Shift + F10 to open the navigation menu, using the Down Arrow key to navigate to the WebFOCUS Home option, and pressing the Enter key.

Procedure: How to Create a New Chart or Report in WebFOCUS Designer

Build new charts and reports by selecting a content type and then adding measure and dimension fields to the appropriate buckets.

1. Create a new visualization in WebFOCUS Designer and select a data source as described in How to Create New Content in WebFOCUS Designer on page 252.

2. The default content type is a stacked bar chart. Optionally, select a different chart type or report layout from the Content picker.

   a. Press Ctrl + Shift + F10 to open the navigation menu.
b. Use the Down Arrow key to navigate to Templates, and then press the Enter key to expand the list of available content types.

c. Press Shift + Tab and the Tab key to navigate through the list of chart types and report layouts.

d. With focus on the content type that you want to use, press the Enter key to select it.

3. Next, add fields to your content. Press Ctrl + Shift + F10 to open the navigation menu.

4. Use the Down Arrow key to navigate to Resources and then press the Enter key.

Focus jumps to the Outline tab, on the sidebar.

5. Press the Down Arrow key to navigate to the Fields tab on the sidebar, and press the Enter key to open it.

6. Press the Tab key multiple times until you have navigated to the top level folder in the Dimensions area of the field list, and then use the Down Arrow and Up Arrow keys to navigate through the list of dimension fields. You can expand a folder by using the Right Arrow key, or collapse it by using the Left Arrow key.

7. With focus on the dimension field that you want to use as the primary sort field in your content, press Shift + F10 or the Menu key to open the shortcut menu.

8. With focus on Add to chart or Add to report in the shortcut menu, press the Enter key. The field is automatically added to the default dimension bucket in your content.

9. Optionally, add more dimension fields to your content. They are placed in the default buckets for additional dimensions, based on the selected content type.

10. Once you have selected dimension fields, press the Tab key twice to enter the Measures area of the field list. Use the arrow keys to navigate to the measure field that you want to use.

11. With focus on the measure field that you want to add to your content, press Shift + F10 or the Menu key to open the shortcut menu.

12. With focus on Add to chart or Add to report in the shortcut menu, press the Enter key. The field is automatically added to the default measure bucket in your content.

13. Optionally, add more measure fields to your content. They are placed in the default buckets for additional measure fields, based on the selected content type.

**Procedure:** How to Style and Format Content in WebFOCUS Designer

The Format tab, on the Properties panel, provides options to style and format different areas of a chart or page. It also allows you to select a theme for your content, and change the output format of a chart or report.
When creating a single chart or report in WebFOCUS Designer, all options, in the Format tab and in other areas of the interface, apply to the item being created. When creating a page, the Format tab provides options to style the last selected page component, which may be the entire page, a page section, a container, the filter toolbar, a filter cell, or a content item. To select an item in a page, use the Tab key to move focus to it, then press the Enter key or Space bar.

1. In WebFOCUS Designer, press Ctrl + Shift + F10 to open the navigation menu.
2. Press the Down Arrow key to navigate to Settings/Format, and then press the Enter key.
3. Press the Tab key to focus on the Settings tab, then press the Right Arrow key to move focus to the Format tab, and press the Enter key to open it.
4. When creating a chart or report, press the Tab key to move focus to the quick access menu. The General options display by default. When creating a chart, press the Down Arrow key to open the quick access menu to access styling and formatting options for the Legend, Axis, Series, and more, depending on the chart type.

When creating a page, different options appear depending on the page component that you selected prior to navigating to the Format tab. Use the Tab key to navigate to these options, which include themes, styles, margins, text styles, and more.

5. Once you have navigated to an option that you want to set or enable, press the Enter key or use the arrow keys to open the control, depending on the control type. Some options may be set using a dialog box, which you can navigate using the Tab key or the arrow keys.

Procedure: How to Add Prompted Filters to Your Content in WebFOCUS Designer

Filters allow you to narrow down your data, providing a more focused and digestible sample. When creating charts and reports, or pages created from new charts and reports, in WebFOCUS Designer, you can create prompted filters and static filters. Prompted filters apply to all content items created within a page, and provide intuitive filter controls. When prompted filters are added to a page created with new content, they are available at run time, allowing anyone who accesses the page to control the data that displays.

1. In WebFOCUS Designer, when creating a new chart or report, or a page with new content, navigate to the field for which you want to create a prompted filter. If you select a dimension field, a drop-down list control is created. If you select a date field, a calendar control is created. If you select a measure field, a two-headed slider is created.

Press Ctrl + Shift + F10 to open the navigation menu, use the Down Arrow key to navigate to Resources, then press the Enter key.

2. Press the Down Arrow key to navigate to the Fields tab on the sidebar, and then press the Enter key.
3. Use the Tab key to navigate into the field list. If you want to filter for a dimension field, use the Down Arrow key once focus has been placed on the Dimensions folder to navigate through the list of dimension fields. To filter for a measure field, continue tabbing until focus is placed on the Measure Groups folder, then use the Down Arrow key to navigate through the list of measure fields. Press the Left Arrow key collapse folders and the Right Arrow key to expand folders, as needed.

4. When you have arrived at the field for which you want to create a filter, press Shift + F10 or the Menu key to access the shortcut menu.

5. Use the Down Arrow key to navigate to Add to filter toolbar, and then press the Enter key. A filter prompt for the field that you selected is added to the filter toolbar.

6. Next, set default values for the filter. Initially, the filter is set to display all values, so no data is filtered out.

   Press Ctrl + Shift + F10 to access the navigation menu.

7. Use the Down Arrow key to navigate to Filter Bar and press the Enter key. Use the Down Arrow key to navigate to Settings/Format and press the Enter key. Press the Tab key multiple times until you arrive at the first filter control in the filter toolbar carousel. Use the Right Arrow and Left Arrow keys to navigate to the filter for which you want to select values.

8. Optionally, press Shift + F10 or the Menu key to open the shortcut menu and change filter options.

   You can choose whether a dimensional filter includes or excludes the selected values, whether it is multi-select or single-select, and whether or not filter selections are required.

   For date filters, you can choose whether the range has a start and an end point or is open ended, and you can make filter selections required.

   For numeric filters, you can choose whether or not the range is open-ended, make selection required, and choose an aggregation to apply to the filter. By default, the sum aggregation is applied, but you can filter on Detail values to filter based on individual measure values from the data source, or use a different aggregation such as average or count.

9. Press the Enter key or Space bar to open the filter control.

   If you are filtering an alphanumeric dimension field, use the drop-down list to select filter values. Use the Tab key to navigate to the search bar, Select all button, Clear button, list of available values, and paging controls. Use the Space bar or Enter key to select a value.

   If you are filtering a date field

   If you are filtering a measure field, press the Enter key or Space bar to open the slider control. First, use the Right Arrow and Left Arrow keys to set lower end of the slider, then press the Tab key and use the Right Arrow and Left Arrow keys to set the upper end.
10. When you are done setting filter values, press the Esc key to close the filter control.

Procedure: **How to Apply Prompted Filters From Existing Content in WebFOCUS Designer Pages**

If external content used prompted filters or dynamic parameters, then when it is added to a page, you can instantly create filter controls for them.

1. Press Ctrl + Shift + F10 to open the navigation menu. Press the Down Arrow key to navigate to *Page Menu*, and then press the Enter key.

2. Press the Tab key to navigate to the *Add all filters to page* button.

3. Press the Space bar or Enter key to create controls for all prompted filters or dynamic parameters in content that was added to the page.

**Creating Content in TIBCO WebFOCUS Designer**

You can visually convey the information in your data source using a wide variety of chart types and tabular reports with different layouts and sort orders. You can save and share content items individually, create multiple content items as a page, or edit existing content should a scenario change. Because of its flexibility, WebFOCUS Designer provides you with the platform and tools you need to create charts that communicate overall trends quickly with eye-catching and intuitive graphics, enhanced with automatic tooltips and filtering capabilities, reports that allow you to organize even the most granular data into an easy-to-understand tabular format, and maps that make it easy to display geographic data to make it clear which areas are hotspots or may deserve more investigation. You can create multiple items together in pages for easy cross-comparison or use them as standalone components. You can then share them with others in your organization to facilitate collaboration, which is central to effective business practices.

Many charts, reports, and maps show contrasting intersections of data, giving you the opportunity to share useful information that conveys patterns in your data. WebFOCUS Designer provides you with access to different types of simple and complex charts in a suite of charting options. You can use simple charts to communicate important KPIs and other straightforward metrics to get communicate information clearly and memorably. More complex charts can be used to investigate numerous relationships between different aspects of your data, giving you a more overarching view.

You can focus in on precise data values in a report, where you can supply large quantities of information in a digestible format that makes it easy to identify and locate key values. A report thereby allows you to combine a broad overview of your enterprise data with exact values for every data point.
Maps take the effectiveness of chart based reporting and tailor it to display geographic data. You can communicate simple information with a basic bubble map or choropleth map, or create maps with multiple levels to show the interplay of different metrics in locations around the globe. You can create maps that are as precise as you need, from a regional level all the way down to postal codes.

All of these content types can be enhanced with run-time capabilities such as prompted filters and In-Document Analytics, which allows users to transform content and modify the display of data at run time. For single items, you can also enable Auto Drill, which makes it possible to navigate data hierarchies, Auto Linking which allows you to connect to and from other content with related parameters, and Insight, which allows you to modify and build content at run-time.

Creating a visualization with new content begins with the selection of a data source, which provides the underlying data that is used to create your content. You can select a Master file (.mas) or a Reporting Object (.ro) as your data source.

The following image shows the default WebFOCUS Designer interface when you create a visualization.
The default content type is a bar chart, but you can change it to another chart type, a report, or a map by using the Content picker, which is located to the right of your canvas. When you choose between the different chart types in the content picker, you can hover over each content type to display the name and the minimum data requirements to run it (for example, one measure and one dimension). You also have access to a number of chart extensions from the content picker, which are custom-made charts that can be installed by your administrator. You can view these by expanding the chart picker. Chart extensions display in the Custom section, as shown in the following image.
You select measures and dimensions from the Resources panel with the Fields tab selected on the sidebar. The Resources panel displays the fields that were populated from your data source. You can add fields to your content in the following ways: drag a field to the canvas, double-click a field, or drag a field into one of the buckets.

Once you have created some content, you can format it to enhance its appearance or style. For example, you might want to add a header and footer to identify your content and prepare it for distribution. Depending on the content type, you can access targeted formatting options that allow you to customize the Legend, Series, and Axis in a chart, the theme of a report, the background of a map, and more. Additional options display when working with certain content types. For example, there are special Matrix options to define the style of gridlines and labels for a matrix chart.

If you save your content as a single item, you can add it to visualizations that reference external content.

Alternatively, you can create multiple new content items within a single visualization. To add more content, click the Convert to page button on the Visualization toolbar. The visualization transforms from a stand-alone content item to a page. Select the content item with a container to edit it with the same set of options used to edit a stand-alone content item. Once a visualization is transformed into a multi-content page, you can add new content by clicking the Add container button, dragging a field from the Resources panel onto an empty area of the canvas, or by dragging a container onto the page.

If you have any multi-content containers in your visualizations, such as tabbed, accordion, or carousel containers, you can create content by dragging a field into the toolbar area of a container. The entire container is highlighted. When you drop the field, the Add Content dialog box appears, prompting you to replace the content in the container or create content with the field in a new tab, accordion panel, or carousel slide.

### Selecting a Data Source

To create a new visualization, such as a chart or report, you must first select a data source. This data source provides the fields and values that display in your content. It can be either a Master File, which is a data source description that allows you to structure the fields in a database or flat file into a more logical structure, or it can be a Reporting Object, which allows you to enhance a Master File with additional filters, default content items, and pre- and post-processing code. Both of these data source file types enable you to create content from data that you have uploaded or to which you have connected.
When you launch WebFOCUS Designer to create a new content item, you are prompted to select a data source, as shown in the following image.

The Select Data Source dialog box provides a file explorer that you can use to navigate to and select a Master File or Reporting Object to use as a data source. In the default folder view, the file explorer shows application folders containing Master Files, as well as repository folders containing Reporting Objects and Master File shortcuts. You can navigate through levels of folders to find the data source file that you want to use to create content.

The files shown are associated with the workspace that you select. Each workspace has an associated application path. The application path is a set of application folders on the server that are accessible from that workspace. Administrators can modify the application path for each workspace in order to provide different data sources to the users in each one. This is performed in the Properties panel on the WebFOCUS Hub. In the Workspaces area, right-click the workspace, click Properties, and click the Server tab. Select the Assign Application Path check box to specify the application folders that will be available from the selected workspace, then save your changes.
In the Select Data Source dialog box, the workspace from which you created your content is shown by default. You can change the workspace using the drop-down list on the toolbar at the top of the dialog box to access data sources from different application folders, as shown in the following image.

Options to filter and change your view of the folders and files in the file explorer are available on the toolbar, as shown in the following image.

Once you navigate to a folder containing available data sources, you can use the Filter by type menu to show only Master Files or only Reporting Objects instead of all items, so you can find the data source that you want to use more quickly.

You can also switch from the list view to a tile view, similar to the Workspaces area on the WebFOCUS Hub. When in list view, you can change the columns that display to see different information in the file explorer. You can sort these columns to find the data source you want to use more quickly based on different properties.
To see all data sources available from the selected workspace, switch from the folder view to the flat view. In the flat view, you can see all data sources from all folders and subfolders in the application path and workspace. The following image shows the items from My Workspace displayed in the file explorer when the folder view and flat view are selected.

Using the flat view may result in a very large number of data sources being shown, so if you know where the data source that you want to use is saved, it may be easier to find using the default folder view.

Finally, use the search bar to find a folder or data source that is currently displayed in the file explorer by name. The file explorer is filtered based on your search query. Clear the search bar to show all items in the file explorer again.

Once you have found the Master File or Reporting Object that you want to use as a data source, double-click it, or select it and then click Select, to begin creating your content.
Configuring Sample Data Settings

When you create charts, reports, and pages in WebFOCUS Designer, the canvas displays a design-time preview of your content. By default, the preview uses a subset of the data available in your selected data source, saving on the resource usage required in running a full data set, while still providing a representative and useful preview of your content.

By default, the data displayed when you design new content is a representative sample of the records in your data source, but you can change the sample data setting to display dummy test data or a live data selection the first records instead of a representative sample. By default, the data displayed when you design new content is limited to 1000 records, but you can change the sample data setting to display a representative sample from your data source or dummy test data instead of a set of the first aggregated records. You can also choose to display fewer or more records, and apply the record limit before or after aggregation when using live data.

To access the sample data settings, click the data settings button on the Visualization toolbar. The Canvas Data Limit dialog box opens, as shown in the following image.
The Canvas Data Limit dialog box includes the following options:

- **Preview data type:**
  - **Sample.** The data shown at design time is based on a representative sample of the records in your data source at a 99% confidence level. The sample is taken before aggregation and stored for use as you design your content.
  - **Live.** The data shown at design time is taken starting with the first records in your data source. You can specify the number of live data records to use, and whether this limit should be applied before or after aggregation.
  - **Test.** Values from the data source are not shown at design time. Instead, generic values are used to give a general sense of the structure and appearance of your content.

- **Also apply to runtime.** Applies the selected data limit when the content item or page is run. When this check box is not selected, the entire data set is used at run time.

- **Record limit.** When using a data sample or live data, set the number of records used to produce the design-time preview. You can select All, 500, 1000, 5000, 10000, or select Custom to type a value of your choice. The default for live data is 1000, limited to 1000 records, and the default for sample data is All, or the entire representative sample.

- **Enforce limit.** When using live data, determine when the record limit should be applied. If you select Post retrieval, the record limit is applied after aggregation, so, for example, if the record limit is 1000, the design-time view of your content can display up to 1000 values. If you select At the source, the record limit is applied to your data source before aggregation, so if the record limit is 1000, only the first 1000 records are read from the data source to display at design time.

### Creating Charts

Charts communicate overall trends quickly with eye-catching and intuitive graphics. Charts come in many different varieties that allow you to communicate information with varying degrees of complexity and specificity. You can use simple charts to effectively communicate simple metrics, and more complex charts to clearly display relationships between different aspects of your data, making it easy to identify less obvious trends.

Different chart types utilize different kinds of data and enable different styling options. You can easily change chart types by selecting a different option from the Content picker, making it easy to ensure that you choose the chart type that best represents your data.
When creating your visualization, you can use tooltips and on-chart filtering to get the necessary information from your chart, and you can also enhance the chart with run-time capabilities such as drill-downs and In-Document Analytics to make even more information available from a single chart.

**Procedure: How to Create a Chart Using WebFOCUS Designer**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Use the Content picker to change the chart type, or use the default vertical stacked bar chart. The Content picker is shown in the following image.

4. Add measures by dragging them onto the canvas.

   **Note:** You can also double-click a measure to add it to the default measure bucket or drag it into an appropriate bucket of your choice.

5. Add dimensions by dragging them onto the canvas.
**Note:** You can also double-click a dimension to add it to the default dimension bucket or drag it into an appropriate bucket of your choice.

The chart refreshes with your selections.

6. **You can format your chart in the following ways:**
   a. Edit the style, size, or format of your fonts.
   b. Modify the appearance or location of your legend.
   c. Modify axis options.
   d. Add a header and footer.
   e. Customize the series in your chart.

7. **On the WebFOCUS Designer toolbar, click Save to save your chart.**

    When you create a single chart and save it for the first time, it is saved as a stand-alone chart, which allows you to add it as external content to pages. If you click *Convert to page* on the Visualization toolbar, your content becomes a page to which you can add more content and containers. After this point, it is saved as a multi-content page.

    You can now continue editing your chart, or add more charts to the visualization to turn it into a page.

8. **To reopen your chart once you have exited WebFOCUS Designer, locate it on the Hub, right-click it, and click *Edit* from the shortcut menu.**

---

**Creating Vertical Stacked Bar Charts**

Use a vertical stacked bar chart when you want to view information for one dimension within another dimension. For example, when you want to see which product subcategories accounted for the most sales within each product category.
If you use one measure in the Vertical bucket and one dimension in the Horizontal bucket, a simple bar chart is created, with no stacked segments. Vertical stacked bar charts require at least one measure and one dimension. If you add a second measure to the Vertical bucket, a second series is created for the new measure and a new segment is placed on top of the first measure in each bar, as shown in the following image.

Additional measures increase the number of segments in a stack.
If you instead add a dimension field to the Color bucket, colored segments are created for each value in that dimension field, as shown in the following image.

Additional fields added to the color field create additional segments based on concatenated values.

The following display options are available for a vertical stacked bar chart:

- **Change chart orientation.** Switches the horizontal and vertical axes, making the bars horizontal.

- **Chart layout options:**
  - **Stacked.** When selected, creates a vertical stacked bar chart.
  - **Side-by-Side.** When selected, creates a vertical side-by-side bar chart, in which the series are placed side-by-side in groups.
  - **Absolute.** When selected, creates a vertical absolute bar chart, in which the series are layered in front of one another.
  - **Percent.** When selected, creates a vertical percent bar chart. Each series is stacked to show a proportion of each bar instead of their actual value.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
Details. Displays the value of each individual record.

Clear buckets content. Empties all buckets.

You can add fields to the following buckets for a vertical stacked bar chart:

- **Vertical.** The first field is added to the vertical axis to determine the height of each bar. Additional measures create additional segments in each bar. You can also choose to display multiple measures on different axes in a dual-axis chart by clicking the axis icon. Additional dimensions create matrix rows.

- **Horizontal.** The first field is added to the horizontal axis to create a bar for each unique value. You can click the icon in the bucket field label to toggle between using the field as a horizontal axis sort field or matrix column.

- **Size.** Controls the width of the bars based on a measure value.

- **Color.** If a dimension field is used, creates segments for each value. If a measure field is used, applies a color scale to the bars.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Vertical Stacked Bar Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click "Create Visualizations," or, on the WebFOCUS Home Page, click "Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.
Vertical stacked bar is the default chart type. If you have a different content type selected by default, select the vertical stacked bar chart option from the Content picker.

3. Add one or more measures and dimensions to the chart.

The vertical stacked bar chart refreshes with your selections.

4. You can perform the following tasks with your vertical stacked bar chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

5. Save your vertical stacked bar chart as a stand-alone chart, or as part of a page.

Creating Horizontal Bar Charts

Use a horizontal bar chart when you want to emphasize a ranking relationship in descending order. This chart type can also be used when the x-axis label is too long to fit legibly side-by-side.

If you add additional measure fields to the Horizontal bucket or add dimension fields to the Color bucket, additional bars are placed in groups for each vertical axis value. A horizontal bar chart with multiple dimension fields is shown in the following image.
**Note:** Horizontal bar charts require at least one measure and one dimension. Add measures as required to compare additional values.

To sort the bars from high to low, right-click a measure value in the Horizontal bucket and click *Sort descending*.

The following display options are available for a horizontal bar chart:

- **Change chart orientation.** Switches the horizontal and vertical axes, making the bars vertical.

- **Chart layout options:**
  - **Stacked.** When selected, creates a vertical stacked bar chart.
  - **Side-by-Side.** When selected, creates a vertical side-by-side bar chart, in which the series are placed side-by-side in groups.
  - **Absolute.** When selected, creates a vertical absolute bar chart, in which the series are layered in front of one another.
  - **Percent.** When selected, creates a vertical percent bar chart. Each series is stacked to show a proportion of each bar instead of their actual value.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

**Note:** When sorting a bar chart, each series is treated as a unique bar. As a result, groups of series such as stacked bar segments, side-by-side groups, or absolute overlapping bars may be separated.

You can add fields to the following buckets for a horizontal bar chart:

- **Vertical.** The first field is added to the vertical axis to create a bar for each unique value. You can click the icon in the bucket field label to toggle between using the field as a vertical axis sort field or matrix row.
Creating Charts

- **Horizontal.** The first field added to the vertical axis determines the height of each bar. Additional measures create additional series for each bar. You can also choose to display multiple measures on different axes in a dual-axis chart by clicking the axis icon 📊. Additional dimensions create matrix rows.

- **Size.** Controls the width of the bars based on a measure value.

- **Color.** If a dimension field is used, creates a new series for each value. If a measure field is used, applies a color scale to the bars.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Horizontal Bar Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart type to a horizontal bar chart.

4. Add a measure and a dimension to the chart.

5. You can perform the following tasks with your horizontal bar chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

6. Save your horizontal bar chart.
Creating Vertical Side-by-Side Bar Charts

Vertical side-by-side bar charts can be used to show additional measure or dimension values for each horizontal axis value using differing identifying colors. Side-by-side bar charts are useful to directly compare the values for different measures or categories within each horizontal axis sort value. The following image shows a vertical side-by-side bar chart with one dimension field and multiple measure fields.

Note: This chart requires at least one measure and one dimension. Add measures as required to compare additional values.

The following display options are available for a vertical side-by-side bar chart:

- **Change chart orientation.** Switches the horizontal and vertical axes, making the bars horizontal.

- **Chart layout options:**
  - **Stacked.** When selected, creates a vertical stacked bar chart.
  - **Side-by-Side.** When selected, creates a vertical side-by-side bar chart, in which the series are placed side-by-side in groups.
- **Absolute.** When selected, creates a vertical absolute bar chart, in which the series are layered in front of one another.

- **Percent.** When selected, creates a vertical percent bar chart. Each series is stacked to show a proportion of each bar instead of their actual value.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a vertical side-by-side bar chart:

- **Vertical.** The first field is added to the vertical axis to determine the height of each bar. Additional measures create additional bars for each horizontal axis value. You can also choose to display multiple measures on different axes in a dual-axis chart by clicking the axis icon. Additional dimensions create matrix rows.

- **Horizontal.** The first field is added to the horizontal axis to create a bar for each unique value. You can click the icon in the bucket field label to toggle between using the field as a horizontal axis sort field or matrix column.

- **Size.** Controls the width of the bars based on a measure value.

- **Color.** If a dimension field is used, creates new bars for each value, placed in groups for each horizontal axis sort value. If a measure field is used, applies a color scale to the bars.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.
**Procedure: How to Create a Vertical Side-by-Side Bar Chart**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add one or more measures and dimensions to the chart.

4. You can perform the following tasks with your vertical side-by-side bar chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

5. Save your vertical side-by-side bar chart.
Creating Ring Pie Charts

Use a ring pie chart when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure. The total value represented by all segments displays in the middle of the ring pie chart. The following image shows a ring pie chart.

![Ring Pie Chart Image]

**Note:** Ring pie charts require at least one measure (placed in the Measure bucket) and one dimension (placed in the Color bucket). Add additional measures as required to create a separate ring pie for each measure.

The following display options are available for a ring pie chart:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
Details. Displays the value of each individual record.

Clear buckets content. Empties all buckets.

You can add fields to the following buckets in a ring pie chart:

Vertical. Enables you to specify a field to display row data in a matrix chart. The use of measure fields is supported. Row data is displayed on the left side of the chart, along the y-axis.

Horizontal. Enables you to specify a field to display column data in a matrix chart. The use of measure fields is supported. Column data is displayed at the top of the chart, along the x-axis.

Measure. Use this bucket to specify a measure that will define the size of segments in a pie chart. The Measure metric is used with the Color bucket for pie charts to create sections based on your field selections. Each field in the Measure bucket results in a separate ring pie chart.

Size. When creating a matrix chart that contains ring pie charts, the size bucket controls the diameter of each chart based on a measure value.

Color. Add a dimension field to the Color bucket to create a segment in the ring pie chart for each value.

Tooltip. The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Ring Pie Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data. WebFOCUS Designer opens in a new browser tab.
2. Select a workspace and a data source available from that workspace. Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a ring pie chart.

4. Add one measure and a dimension to the chart.
   The ring pie chart refreshes with your selections.

5. You can perform the following tasks with your ring pie chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).
   d. Change the size of the hole in the ring pie chart. On the Format tab, select Series from the area menu, then adjust the value of the Hole Size % property. Setting this property to 0 removes the hole entirely, creating a standard pie chart.

6. Save your ring pie chart.

Creating Absolute Line Charts

Use absolute line charts when you want to show trend data over time. For example, monthly changes in employment figures, or yearly sales of an item in your inventory.
**Note:** Absolute line charts require at least one measure and one dimension. Adding multiple measures or adding fields to the Color bucket will create additional lines on the chart, as shown in the following image.

The following display options are available for a line chart:

- **Change chart orientation.** Switches the vertical and horizontal axes so that the lines draw from top to bottom.

- **Chart layout options:**
  - **Stacked.** Stacks each line on top of the previous line, similar to a stacked bar chart. As a result, the value for each point on a line is a sum of the value represented by that point and all points for the same horizontal axis value below it.
  - **Absolute.** Each point on each line represents an absolute value.
  - **Percent.** When selected, the points in each line are stacked and represent a proportion of the total for each horizontal axis value instead of their actual value.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
Counts. Provides a count of records in the selected measure field, for each sort value.

Details. Displays the value of each individual record.

Clear buckets content. Empties all buckets.

You can add fields to the following buckets for a line chart:

Vertical. The first field is added to the vertical axis to determine the height of points on the line. Additional measures create additional lines. You can also choose to display multiple measures on different axes in a dual-axis chart by clicking the axis icon. Additional dimensions create matrix rows.

Horizontal. The first field is added to the horizontal axis to create a point on each line for each unique value. Additional fields create matrix columns. You can click the icon in the bucket field label to toggle between using the field as a horizontal axis sort field or matrix column.

Size. Controls the thickness of the lines based on a measure value. The thickness changes at each point on the horizontal axis.

Color. If a dimension field is used, creates additional lines for each value. If a measure field is used, applies a color scale to the lines.

Tooltip. The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create an Absolute Line Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.
2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to an absolute line chart.

4. Add one or more measures and a dimension to the chart.

5. You can perform the following tasks with your absolute line chart:
   
a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

6. Save your absolute line chart.

Creating Vertical Stacked Area Charts

Use vertical stacked area charts when you want to distinguish your data more dramatically by highlighting volume with color. In a vertical stacked area chart, each area is stacked on top of the sections below it, as shown in the following image.

![Vertical Stacked Area Chart Example]

**Note:** Vertical stacked area charts require at least one measure and one dimension. Adding multiple measures will create additional shaded areas on the chart.
The following display options are available for an area chart:

- **Change chart orientation.** Switches the vertical and horizontal axes so that the lines draw from top to bottom.

- **Chart layout options:**
  - **Stacked.** Stacks each area on top of the previous area, similar to a stacked bar chart. As a result, the value for each point along the top of an area is a sum of the value represented by that point and all points for the same horizontal axis value in the areas below it.
  - **Absolute.** Each point in each area represents an absolute value. Areas are layered in front of each other.
  - **Percent.** When selected, the areas are stacked to fill the chart area and represent a proportion of the total for each horizontal axis value instead of their actual value.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for an area chart:

- **Vertical.** The first field is added to the vertical axis to determine the height of points in the area chart. Additional measures create additional areas. You can also choose to display multiple measures on different axes in a dual-axis chart by clicking the axis icon. Additional dimensions create matrix rows.

- **Horizontal.** The first field is added to the horizontal axis to create a point at the top of each area for each unique value in the field. You can click the icon in the bucket field label to toggle between using the field as a horizontal axis sort field or matrix column.

- **Color.** If a dimension field is used, creates additional areas for each value. If a measure field is used, applies a color scale to the areas.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.
Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Vertical Stacked Area Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
   WebFOCUS Designer opens in a new browser tab.
2. Select a workspace and a data source available from that workspace.
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.
3. On the Content picker, change the chart to a vertical stacked area chart.
4. Add one or more measures and a dimension to the chart.
   The vertical stacked area chart refreshes with your selections.
5. You can perform the following tasks with your vertical stacked area chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).
6. Save your vertical stacked area chart.

Creating Scatter/Bubble Charts

Scatter charts are used to show relationships between X and Y values. They compare two sets of numbers at once, which is useful for discovering patterns and trends.
A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data. A bubble chart can be used to effectively show the relationship between three measure fields, as shown in the following image.

Note: Scatter/bubble charts require at least two measures, and one dimension, which can be a color field or detail field. Optionally, add a dimension to the Size bucket using the count aggregation to view the concentration of data.

The following display options are available for a scatter plot or bubble chart:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.
You can add fields to the following buckets for a scatter plot or bubble chart:

- **Vertical.** Add a measure field to the vertical axis to determine the vertical position of points. Additional dimensions create matrix rows.

- **Horizontal.** Add a measure or dimension field to the horizontal axis to determine the horizontal position of points. Additional dimension fields create matrix columns.

- **Detail.** Use this bucket to add detail to your visualization by adding a data field to it. For example, if you add Sale,Quarter to the Detail bucket in your Scatter plot, the points on the plot are quadrupled, one for each quarter. In addition, the field that you specify in the Detail bucket also displays on the hover menu for each point in the plot.

- **Size.** Controls the size of each bubble based on a measure value.

- **Color.** If a dimension field is used, creates points or bubbles for each value and determines their color. If you also add a dimension to the Detail bucket, the values in the detail field are used to create points, and the values in the color field determine the color of the points. If a measure field is used, applies a color scale to the points.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure: How to Create a Scatter/Bubble Chart**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a scatter or bubble chart.
4. Add one measure and one dimension to the chart. Also, add fields in the Detail and Color buckets.

The scatter/bubble chart refreshes with your selections.

5. You can perform the following tasks with your scatter/bubble chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).
   d. Add trend lines. On the Format tab, select Series from the quick access menu and, with all series or a single series selected, click Show trend line. You can set the line style, trend line equation format, and, when using the polynomial equation, set the order or degree of the expression.

6. Save your scatter/bubble chart.

Creating Circle Plot Charts

Use circle plot charts to display differing values in rows, enabling you to draw inferences as to how the values overlap. An example of a circle plot is shown in the following image.
**Note:** Circle plot charts require at least one measure and one dimension, as well as one for the Detail and Color buckets. Optionally, add a dimension to the Size bucket with the count aggregation to view the concentration of data.

The following display options are available for a circle plot chart:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a circle plot chart:

- **Vertical.** Add a measure field to the vertical axis to determine the vertical position of points. Additional dimensions create matrix rows.

- **Horizontal.** Add a dimension field to the horizontal axis to determine the horizontal position of points. You can click the icon in the bucket field label to toggle between using the field as a horizontal axis field or matrix column.

- **Detail.** Use this bucket to add detail to your visualization by adding a data field to it. For example, if you add Sale,Quarter to the Detail bucket in your circle plot, the points on the plot are quadrupled, one for each quarter. In addition, the field that you specify in the Detail bucket also displays on the hover menu for each point in the plot.

- **Size.** Controls the size of each point based on a measure value.

- **Color.** If a dimension field is used, creates points for each value and determines their color. If you also add a dimension to the Detail bucket, the values in the detail field are used to create points, and the values in the color field determine the color of the points. If a measure field is used, applies a color scale to the points.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.
MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Circle Plot Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a circle plot.

4. Add one measure, one dimension to the chart. Also, add a field into the Detail and Color buckets.

The circle plot chart refreshes with your selections.

5. You can perform the following tasks with your circle plot chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

6. Save your circle plot chart.
Treemap charts can be used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree. A treemap is shown in the following image.

**Note:** Treemap charts require at least one measure and one dimension, to be placed in the Size and Color buckets. Groups are determined by those fields specified in the Grouping bucket.

The following content display options are available for a treemap:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.
  - **Clear buckets content.** Empties all buckets.
You can add fields to the following buckets for a treemap:

- **Group.** Enables you to specify dimension fields by which to present your data in nested categories or groups.

- **Size.** Use a measure field to determine the size of boxes in the treemap.

- **Color.** If a dimension field is used, creates boxes to contain values for the field in the Group bucket. If a measure field is used, applies a color scale to the boxes in the treemap.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Treemap Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a treemap chart.

4. Add one measure, one dimension to the chart. Also, add a field into the Size and Color buckets.

   The treemap chart refreshes with your selections.

5. You can perform the following tasks with your treemap chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).
6. Save your treemap chart.

Creating Matrix Marker Charts

Matrix marker charts can be used to analyze one or two measures against a crosstab of two categorical dimensions. The result is a color scaled matrix chart that shows categorized trends, as shown in the following image.

![Matrix Marker Chart Image]

**Note:** Matrix marker charts require at least two measures and two dimensions. It also requires a field in the Color and Size buckets, which allow you to see the concentration of data for that intersection of the chart.

The following display options are available for a matrix marker chart:

- **Change chart orientation.** Switches the vertical and horizontal axes.

- **Chart layout options:**
  - **Circle marker.** Uses circles as the markers. You can choose a different marker shape from the Format tab. On the Format tab, open the Quick Access menu and click *Series*. In the Shape section, select a shape from the drop-down menu.
Square marker. Uses squares as the markers. You can choose a different marker shape from the Format tab. On the Format tab, open the Quick Access menu and click Series. In the Shape section, select a shape from the drop-down menu.

Fill marker. The markers fill the grid, changing the chart into a heatmap. Instead of using the Size bucket, use the Color bucket to indicate measure values.

Calculation options:

Summaries. Sums measure values for each sort value. This is the default.

Counts. Provides a count of records in the selected measure field, for each sort value.

Details. Displays the value of each individual record.

Clear buckets content. Empties all buckets.

You can add fields to the following buckets for a matrix marker chart:

Vertical. Add a dimension field to the Vertical bucket to set the vertical axis values for the matrix marker chart. Additional dimension fields are nested.

Horizontal. Add a dimension field to the Horizontal bucket to set the horizontal axis values for the matrix marker chart. Additional dimension fields are nested.

Size. Controls the size of each marker based on a measure value. Is not applied to matrix marker charts using the fill marker, or heatmap, display.

Color. Use a measure field to apply a color scale to the markers.

Tooltip. The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Matrix Marker Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a matrix marker chart.

4. Add two measures and two dimensions to the chart. Also, add fields to the Color and Size buckets.
   The matrix marker chart refreshes with your selections.

5. You can perform the following tasks with your matrix marker chart:
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

6. Save your matrix marker chart.
Creating Statistical Box Plot Charts

A box plot, also known as a box-and-whisker plot, is a chart type that provides distribution information about your data. The box represents the range between the upper and lower quartiles, and the line inside the box represents the median. The whiskers represent the maximum and minimum with outliers excluded, and outliers are represented by individual points. An example of a box plot is shown in the following image.

Since box plots display the distribution of points in your data, you need to provide detail values. You can do this in one of two ways. One option is to add a dimension field to the Detail bucket. This field should have a large number of distinct values in order to generate a sufficient spread of data for the box plot. For example, in the image above, a separate box plot is created for each Product Category to show the distribution of values in the Model field, which has been placed in the Detail bucket.
Another option is to incorporate your entire data set into the box plot. You can do this by changing the calculation method from Summaries to Details. In this case, you do not need a field in the Detail bucket to generate the box plot. The following image shows a box plot chart in which separate box plots are still generated for each product category, but which uses the Details calculation option instead of using Model as the Detail field. Since more data values are used in this chart, there are more outliers.

The following display options are available for a box plot:

- **Change chart orientation.** Switches the vertical and horizontal axes.

- **Calculation options:**
  
  - **Summaries.** Sums measure values for each sort value. This is the default. Add a dimension field to the Detail bucket to create a box plot when using the Summaries option.

  - **Counts.** Provides a count of records in the selected measure field, for each sort value. Add a dimension field to the Detail bucket to create a box plot when using the Counts option.
Details. Displays the value of each individual record. You do not need to add a field to the Detail bucket when using the Details calculation option.

Clear buckets content. Empties all buckets.

You can add fields to the following buckets for a box plot chart:

Vertical. A measure field whose values constitute the set of data for the box plot. The outliers, maximum, minimum, median, and upper and lower quartile are calculated for these values.

Horizontal. Add a dimension field to the Horizontal bucket to generate a separate box plot for each value, allowing you to compare the distribution of each.

Detail. When using the Summaries or Counts calculation options, use the Detail bucket to provide individual values for the measure field in the Vertical bucket. The Detail bucket should provide multiple values for each value of the field in the Horizontal bucket.

Tooltip. The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Box Plot Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a statistical box plot.

4. Add a measure to the Vertical bucket and a dimension to the Horizontal bucket.
   A single measure value displays as a line in each column.
5. Use one of the following methods to generate a set of data for each column:

- Add a dimension field to the Detail bucket. This field should provide multiple records for Horizontal bucket value.

- Change the calculation option from Summaries to Details. If you have a very large data source, this may generate too many records to evaluate in the box plot.

A set of box plots appears on the canvas, showing indicators for outliers, maximum and minimum, median, and upper and lower quartiles.

6. You can perform the following tasks with your box plot chart:

a. Add additional measures or dimensions to the Tooltip, Animate, and MultiPage buckets, where applicable.

b. Change the fields to obtain different information.

c. Format the chart (for example, customize the header and footer, change the series colors, or set box plot-specific properties).

7. Save your box plot chart.

Creating Multi-Layer Maps in TIBCO WebFOCUS Designer

As an alternative to creating a map procedure in the text editor using WebFOCUS syntax, you can use the user interface in WebFOCUS Designer to create a multi-layer map from a single data source. You can then enhance your map with additional data and content layers, created directly within WebFOCUS Designer or referenced from existing map procedures or configured context layers.

To create a new map in WebFOCUS Designer, on the WebFOCUS start page, click the plus button and then click Create Visualizations. After WebFOCUS Designer opens and you select a data source, from the content picker, change the content type to a map. Once you have changed the content type to a map, you cannot change it back to another chart or report type.
To create a map, start by adding a data layer or content layer, from the Settings tab of the Properties panel. A data layer is created directly in WebFOCUS Designer, from fields in your selected data source. A content layer can be either a single layer map that was saved to your environment, or a context layer configured on the TIBCO WebFOCUS® Reporting Server. You can add multiple data and content layers to your map, and reorder them in the Layers bucket. The layers are drawn on the map in the layer in which they are listed, so the first layer in the list appears underneath the other layers, and the last layer in the list appears on top. The Layers bucket with two data layers and a content layer is shown in the following image.
When you add a new data layer, in the Add Data Layer dialog box, you first assign a name to the layer, that will appear in the legend and layers list, and select the type of map layer that you would like to create, as shown in the following image.

A data layer can be a choropleth or a bubble map. You can then populate the map layer by adding fields to the buckets on the Properties panel. Drag a field with a defined geographic role to the Location bucket, and populate the color, tooltip, and, depending on the layer type, size buckets to provide additional information in the map. You can style the selected layer using the options on the Map Properties panel.

To add more layers, click Add Data Layer or Add Content Layer. All layers appear in the Layers bucket, where they can be reordered, hidden, or deleted.
You can also style the run-time map interface from the Map Properties panel. The Map Properties panel provides options to change the basemap, interface style, viewing options, and available run-time tools and widgets. These run-time tools and widgets include the Search bar, Measurement tools, Directions widget, and Location widget. To open the Map Properties panel, click the Map Properties button on the Visualization toolbar. The Map Properties panel is shown in the following image.
From the Map Properties panel, you can set the following properties:

- **Basemap.** Change the basemap to contextualize the locations represented in the map.

- **Default View.**
  - 2D Mode
  - 3D Mode

- **Styling.**
  - **Viewer Theme.** Change the style of the buttons in the map interface at run-time.
  - **Initial Position.** Select *Automatic* to display all represented locations in the map when it loads, or select *Custom* to select a fixed center point and zoom level.

- **Widgets.** You can enable some widgets to have them available for selection in the run-time map toolbar, and select *Show on map* to display them by default when the map initially loads. Other widgets display directly on the map, and can only be permanently enabled or hidden.

  Each widget can be positioned based on the corner of the map in which it should be placed, and an index value that determines its position relative to other widgets in the same corner. The widget with the lowest index value is positioned closest to the specified corner.

- **Legend.** Displays color scales or keys for each layer currently visible on the map.

- **Scale Bar.** Displays a small scale bar that can be used to approximate the distances between locations visible on the map. You can change the units and appearance of the scale bar.

- **Zoom.** Adds buttons to zoom in and out of the map. If the Zoom widget is not added, you can zoom by using the scroll wheel on your mouse.

- **Interactive.** Interactive widgets use Esri tools to access more information about the map than may be available in your map layers alone. The Search widget allows you to jump to a location based on a search term. The Measure widget allows you to find the distance between points or the area of a polygon between multiple selected points. The Location widget displays the coordinates of locations on the map. The Direction widget generates navigable directions between selected locations. These items all occupy the same area of the map, and only one can be selected at a time from the toolbar when the map is run.
Locate Me. Click the Locate button to zoom to your current location. This button only works if the environment where the map is run is accessed via HTTPS or on localhost.

Creating Choropleth Maps in TIBCO WebFOCUS Designer

Choropleth maps can be used to create geographically-based heat maps. They are useful for visualizing location-based data, trends, and distributions across a geographic area, as shown in the following image.

Note: Choropleth maps require at least one measure and one Georole, which contains geographic location information. You can add a field to the Color bucket to color the map.

The Clear buckets content display option is available for a choropleth map. It removes the fields from all buckets.
You can add fields to the following buckets for a choropleth map:

- **Color.** Use a measure field to apply a color scale to the areas on the choropleth map. You can also use a dimension to color the areas on the map. Each area can show one color, so it is advisable to use overarching categories that apply to distinct sets of points. For example, you could use a country field in the Color bucket to categorize states shown on the map.

- **Location.** Enables you to specify a Geolocation field for use in a map. Each value from the field is plotted on the map if it is recognized. A choropleth can plot geographic areas, such as cities, states, or countries.

  **Note:** Geolocation fields must be configured in the data source to use a corresponding geographic role. Values from the field are matched to values from the geographic role to plot them in the correct location. For example, if your field contains country names, use the Country Name geographic role.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. This can be used to make additional information available without changing the appearance of the chart.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket.

**Procedure:** How to Create a Choropleth Map in WebFOCUS Designer

1. Open WebFOCUS Designer. On the default WebFOCUS Home Page, click **Visualize Data**.
   
   WebFOCUS Designer opens in a new browser tab.

2. In WebFOCUS Designer, click the **Add data** button to select a data source.

3. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

   **Note:** In order to create a map, the data source that you use must have fields with assigned geographic roles.

4. On the Content picker, change the chart to a map.

5. On the Settings tab, in the Layers bucket, click **Add Data Layer**.
   
   The Add Data Layer dialog box opens.

6. Provide an optional name for the layer, and select the **Choropleth** radio button.

7. Click **Add** to create a new choropleth map data layer.
8. Add a field with an assigned geographic role to the Location bucket. This field can contain place names corresponding to the assigned geographic role, or GIS polygon strings based on an array of coordinate values, created using the GIS_GEOMETRY function.

The choropleth map refreshes to show the area of each recognized location.

9. Optionally, enhance the information in the choropleth map in the following ways:

- Add a measure field to the Color bucket. Areas in the map will be colored based on a color scale, representing measure values for each location.

- Add a dimension field to the Color bucket. Areas in the map will be colored based on the series color of the associated dimension value.

Only one field can be added to the Color bucket at a time.

10. You can perform the following tasks with your choropleth map:

   a. Change the field in the Location bucket to analyze other trends.

   b. Zoom in or out to see different views of the data.

11. Save your choropleth map.
Creating Bubble Maps in TIBCO WebFOCUS Designer

Proportional symbol maps, or bubble maps, use symbols of different sizes to represent data associated with different areas or locations within the map, as shown in the following image.

![Bubble Map Example](image)

**Note:** Proportional symbol maps require at least one measure and one Georole, which contains geographic location information. You can add a field to the Color bucket to color the map.

The Clear buckets content display option is available for a proportional symbol map. It removes the fields from all buckets.

You can add fields to the following buckets for a proportional symbol map:

- **Size.** Use a measure field to determine the size of bubbles on the proportional symbol map.
- **Color.** Use a measure field to apply a color scale to the bubbles on the proportional symbol map. You can also use a dimension to color the points on the map. Each point can show one color, so it is advisable to use overarching categories that apply to distinct sets of points. For example, you could use a country field in the Color bucket to categorize points representing states.

- **Location.** Enables you to specify a Geolocation field for use in a map. Each value from the field is plotted on the map if it is recognized. A proportional symbol map can plot geographic areas, such as cities, states, or countries, as well as individual point locations such as street addresses and geographic coordinates.

  **Note:** Geolocation fields must be configured in the data source to use a corresponding geographic role. Values from the field are matched to values from the geographic role to plot them in the correct location. For example, if your field contains country names, use the Country Name geographic role.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket.

**Procedure: How to Create a Bubble Map in WebFOCUS Designer**

1. Open WebFOCUS Designer. On the default WebFOCUS Home Page, click **Visualize Data**.
   WebFOCUS Designer opens in a new browser tab.

2. In WebFOCUS Designer, click the **Add data** button to select a data source.

3. Select a workspace and a data source available from that workspace.
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

   **Note:** In order to create a map, the data source that you use must have fields with assigned geographic roles.

4. On the Content picker, change the chart to a map.

5. On the Settings tab, in the Layers bucket, click **Add Data Layer**.
   The Add Data Layer dialog box opens.

6. Provide an optional name for the layer, and select the **Proportional** radio button.

7. Click **Add** to create a new bubble map data layer.
8. Add a field with an assigned geographic role to the Location bucket. This field can contain place names corresponding to the assigned geographic role, or GIS point strings based on coordinate values.

The proportional symbol map refreshes to show a point at each recognized location.

9. Optionally, enhance the information in the proportional symbol map in the following ways:

- Add a measure field to the Size bucket. Markers in the map will be sized based on the measure values for each location.

- Add a measure field to the Color bucket. Markers in the map will be colored based on a color scale, representing measure values for each location.

- Add a dimension field to the Color bucket. Markers in the map will be colored based on the series color of the associated dimension value.

Only one field can be added to the Color bucket at a time.

10. You can perform the following tasks with your proportional symbol map:

a. Change the field in the Location bucket to analyze other trends.

b. Zoom in or out to see different views of the data.

11. Save your proportional symbol map.

Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map.

2. Click the Map Properties button.
3. In the Map Properties panel, open the Basemap menu and choose from the available options, as shown in the following image.

   ![Map Properties Panel]

4. Select one of the following options:

   - Basemap None
   - Dark Gray Canvas Map
Dark Gray Vector
Light Gray Canvas Map
Gray Vector
World Imagery with Labels
National Geographic World Map
Oceans Map
Open Street Map
World Imagery
World Street Map
Streets Navigation Vector
Streets Night Vector
Streets Relief Vector
Streets Vector
Terrain with Labels
World Topographic Map
Topographic Vector

Note: Custom configured basemaps also appear as options.

Vector basemaps can be more detailed than default raster tile basemaps, but may not be compatible with all environments or basemap styles. For some basemaps, both default raster tile and vector options are available.

Once you make a selection, the background of the map refreshes. You can continue to change your background until it displays the desired information.

Procedure: How to Add Demographic Layers to a Map

1. Create a new map or open an existing map.
2. Click Add Content Layer(s) to add a new content layer.
3. In the Add Content Layer(s) dialog box, on the Demographic tab, select from various population and lifestyle groups, as shown in the following image.

![Layer Selection](image)

**Note:** These are pre-defined demographic profiles, provided by Esri ArcGIS. Esri periodically retires older demographic layers.

You can select multiple options in either category to gain additional insight into your data. Specifically, each Demographic Layer has its own profile and provides a layering option, when comparing values across different layers or profiles.

4. Once you select the demographic layers in the list on the left that you want to use, click *Add >* to add them to the selected list on the right.

5. Click *Add* to add the select layers to the map.
The Demographic Layers that you select are rendered on the map. The legends for each layer, if they are available, display in the Layers list at run time. The Layer list with a configured demographic layer is shown in the following image.

![Layers List Example]

You can select and clear the check boxes to enable the display of one or more Demographic Layers to compare and contrast the different demographic scenarios.

**Note:** Layers that require a special layerTypeEx property in the addon_json when configured, are not supported in the com.esri.map extension. InfoAssist uses the com.esri.map extension.

**Procedure:** How to Add Reference Layers to a Map

1. Create a new map or open an existing map.
2. On the Format tab, in the Map options group, click the drop-down for Reference layer.
The list of Reference Layers displays, as shown in the following image.
3. Select one or more Reference Layers, such as World Countries, to add to your map, and then click OK.

Your map refreshes, and the definitions and borders of the References Layers display on the canvas. You can use the Table of Contents or Layers option, to toggle different Reference Layers in your map. These options are shown in the following image.

Reference:  **Query Buckets by Map Type**

This section presents the Query buckets that display, by map type.

<table>
<thead>
<tr>
<th>Query bucket</th>
<th>Choropleth Map</th>
<th>Proportional Symbol Map</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Geo</strong>. One data field, specifically a field containing location data (for example, State) with an assigned geographic role.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
Creating Charts

<table>
<thead>
<tr>
<th>Query bucket</th>
<th>Choropleth Map</th>
<th>Proportional Symbol Map</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color.</strong> One measure or dimension field.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Tooltip.</strong> One or more data fields (not required).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Multi-page.</strong> Up to one data field (not required).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Size.</strong> One measure field.</td>
<td>✗</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Reference: Geographic Roles**

Geographic roles have been unified to access 58 world administrative boundaries down to the postal code level, out of the box. You can access administrative boundaries for approximately 250 countries with a second level license, which is a paid service from Esri. Enter your second level license code by clicking the License button on the ribbon.

**Note:** Geographic roles are only available with Esri maps.

This section contains information on the geographic roles that are supported for Esri maps.

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTINENT</td>
<td>World Continents</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>World Countries</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>STATE</td>
<td>World Admin Divisions</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>CITY</td>
<td>World Cities</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
</tbody>
</table>
### Geographic Role

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTY</td>
<td>World Counties</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>POSTAL-CODE</td>
<td>Postal Code</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>GEOMETRY_POINT</td>
<td>Geographic Coordinates</td>
<td>Proportional Symbol</td>
</tr>
</tbody>
</table>

**Note:** This is a new, simplified list of geographic roles (dimensions) that you can utilize when creating a map chart. This unified list of roles provides worldwide mapping of administrative boundaries down to the postal code level. In WebFOCUS Designer, the new roles display, by default, when assigning a geographic role.

The following table illustrates the geographic roles and their dependencies. Level 1 indicates the highest level of hierarchy and level 5 is the lowest level of hierarchy.

<table>
<thead>
<tr>
<th>Region</th>
<th>Hierarchy Level</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>World</td>
<td>1</td>
<td>CONTINENT</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>STATE</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>
Creating Data Grids

A data grid is a kind of chart that can be used to present data in tabular form. For example, you can create a grid (table) that summarizes your data. Data grids include sorting and tooltip features by default, unlike tabular reports. An example of a data grid is shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Quantity Sold</td>
<td>Revenue</td>
<td>Quantity Sold</td>
<td>Revenue</td>
</tr>
<tr>
<td>Accessories</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2014</td>
<td>3,028</td>
<td>$744,930.82</td>
<td>3,103</td>
<td>$764,764.44</td>
</tr>
<tr>
<td>2015</td>
<td>4,603</td>
<td>$1,136,922.67</td>
<td>4,773</td>
<td>$1,191,083.87</td>
</tr>
<tr>
<td>2016</td>
<td>8,423</td>
<td>$2,120,543.62</td>
<td>7,473</td>
<td>$1,002,330.86</td>
</tr>
<tr>
<td>2017</td>
<td>11,617</td>
<td>$2,607,674.08</td>
<td>10,952</td>
<td>$2,793,195.45</td>
</tr>
<tr>
<td>2018</td>
<td>28,905</td>
<td>$7,320,410.95</td>
<td>26,644</td>
<td>$6,839,165.33</td>
</tr>
<tr>
<td>2019</td>
<td>44,159</td>
<td>$11,217,162.74</td>
<td>40,978</td>
<td>$10,417,806.74</td>
</tr>
<tr>
<td>Camera</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2014</td>
<td>2,077</td>
<td>$424,496.52</td>
<td>2,607</td>
<td>$507,550.35</td>
</tr>
<tr>
<td>2015</td>
<td>4,126</td>
<td>$1,654,323.51</td>
<td>4,224</td>
<td>$1,368,773.84</td>
</tr>
<tr>
<td>2016</td>
<td>7,245</td>
<td>$2,234,533.93</td>
<td>7,635</td>
<td>$2,362,787.86</td>
</tr>
<tr>
<td>2017</td>
<td>10,208</td>
<td>$3,591,263.52</td>
<td>9,606</td>
<td>$3,374,959.46</td>
</tr>
<tr>
<td>2018</td>
<td>25,511</td>
<td>$9,705,112.69</td>
<td>23,927</td>
<td>$6,238,442.56</td>
</tr>
<tr>
<td>2019</td>
<td>39,393</td>
<td>$13,112,665.74</td>
<td>36,666</td>
<td>$12,530,035.14</td>
</tr>
<tr>
<td>Computer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2014</td>
<td>988</td>
<td>$199,114.40</td>
<td>805</td>
<td>$158,662.11</td>
</tr>
<tr>
<td>2015</td>
<td>1,776</td>
<td>$355,634.16</td>
<td>1,767</td>
<td>$399,051.69</td>
</tr>
<tr>
<td>2016</td>
<td>3,228</td>
<td>$655,346.06</td>
<td>2,967</td>
<td>$607,756.72</td>
</tr>
<tr>
<td>2017</td>
<td>6,343</td>
<td>$1,441,510.34</td>
<td>5,998</td>
<td>$1,341,050.78</td>
</tr>
<tr>
<td>2018</td>
<td>15,034</td>
<td>$3,390,921.91</td>
<td>16,299</td>
<td>$4,123,075.67</td>
</tr>
<tr>
<td>2019</td>
<td>36,755</td>
<td>$11,652,553.66</td>
<td>41,675</td>
<td>$13,041,225.28</td>
</tr>
</tbody>
</table>

**Note:** Data grids require at least one measure and one dimension. Additional measures create unique columns. You can add multiple dimensions in the Row bucket to create customized rows based on the structure of your selection, and add dimensions to the Column bucket to create groups of measure columns based on dimension values.

The following display options are available for a data grid:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a data grid:

- **Measure.** Supplies the measure values to display in the cells of the data grid.

- **Row.** Use a dimension field to define the rows in the data grid, similar to the BY field in a report.
- **Column.** Use a dimension to provide an additional sort column for each value. Each measure column is nested within each column field value. The column bucket is similar to an ACROSS field in a report.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure: How to Create a Data Grid**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select *Data Grid (Chart)*.

4. Add one or more measures and dimensions to the chart.
   
   The data grid refreshes with your selections.

5. You can perform the following tasks with your data grid:
   
   a. Add additional measures or dimensions to the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or style the legend).

6. Save your data grid.
Creating Waterfall Charts

Waterfall charts allow you to see incremental positive and negative changes in your data, resulting in a rolling total. Positive and negative values are represented by different colored risers that start at the end point of the previous riser. Waterfall charts can be a good way to show change over time. An example of a waterfall chart is shown in the following image.

The following display options are available for a waterfall chart:

- **Change chart orientation.** Switches the vertical and horizontal axes so that the risers draw horizontally.

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.
You can add fields to the following buckets for a waterfall chart:

- **Vertical.** Specifies the measure field used in the chart to set the riser height. Negative values of this field display in red by default.

- **Horizontal.** A sort field whose values are represented by each riser.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Waterfall Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click **Create Visualizations**, or, on the WebFOCUS Home Page, click **Visualize Data**.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a waterfall chart.

4. Add one measure to the Vertical bucket, and one dimension to the Horizontal bucket.

The waterfall chart refreshes with your selections. Any positive values display in green, and any negative values display in red, by default. There is also a Total column, which displays in blue by default.

5. You can perform the following tasks with your waterfall chart:

   a. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.

   b. Change the fields to obtain different information.

   c. Format the chart (for example, customize the header and footer or add data labels).
6. Save your waterfall chart.
Creating Gauge Charts

A gauge is a simple visual that shows a measure value. These can be used to create straightforward KPI graphics, or use matrix rows and columns to compare data for different sort values. The following example shows a gauge chart with matrix rows.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>104.0M</td>
</tr>
<tr>
<td>Camcorder</td>
<td>124.2M</td>
</tr>
<tr>
<td>Computers</td>
<td>85.7M</td>
</tr>
<tr>
<td>Media Player</td>
<td>190.6M</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>234.0M</td>
</tr>
<tr>
<td>Televisions</td>
<td>62.5M</td>
</tr>
<tr>
<td>Video Production</td>
<td>46.6M</td>
</tr>
</tbody>
</table>
The following display options are available for a gauge chart:

- **Change chart orientation.** Switches the vertical and horizontal matrix axes.

- **Chart layout options:**

  - **Circular.** Shows the measure value using a pointer with values arranged in a semicircle starting at the bottom left, similar to a speedometer. A circular gauge is shown in the following image.

    ![Circular Gauge Example](image)

  - **Simple.** The default value, shows the measure value as a clockwise, colored fill on a circle starting at the top. The value is also displayed as text inside the circle. A simple gauge is shown in the following image.

    ![Simple Gauge Example](image)

  - **KPI.** Shows the measure value as text. A KPI gauge is shown in the following image.

    ![KPI Gauge Example](image)

- **Calculation options:**

  - **Summaries.** Sums measure values for each sort value. This is the default.
  
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  
  - **Details.** Displays the value of each individual record.

  - **Clear buckets content.** Empties all buckets.
You can add fields to the following buckets for a gauge chart:

- **Vertical.** A dimension field used to generate matrix rows.
- **Horizontal.** A dimension field used to generate matrix columns.
- **Measure.** The measure field whose value is represented by the gauge.
- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart. The KPI style gauge does not show a tooltip.
- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.
- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Gauge Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a gauge chart.

4. Choose a gauge type from the display options. Simple, Circular, and KPI gauge types are available.

5. Add one measure to the Measure bucket.
   
   The gauge loads to display the value of the measure field.

6. You can make the following additional customizations to your gauge chart:
   
   a. Create a matrix chart by adding dimension fields to the Vertical and Horizontal buckets.
   
   b. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.
c. Change the fields to obtain different information.

d. Format the chart (for example, customize the header and footer or change the series color).

7. Save your gauge chart.

Creating Funnel Charts

A funnel chart shows values of a dimension field as a proportion of the whole, similar to a bar in a stacked bar chart. The shape of the funnel makes it useful to show information about processes that involve cascading or narrowing down due to the hierarchy it implies. For example, the following image shows revenue by year in a funnel chart. The entire funnel can be taken to represent all sales, with the top segment representing the most recent year, the top two segments the two most recent years, and so on.
Conversely, you can use the pyramid option to show values in an implied hierarchy, as shown in the following image of a pyramid chart showing revenue by age range. The oldest range, 70-85 is at the top, and the youngest range, 13-17, is at the bottom.

The following display options are available for a funnel chart:

- **Chart layout options**:
  - **Funnel**: The default value, arranges the chart in a funnel shape, wide at the top and narrow at the bottom.
  - **Pyramid**: Arranges the chart in a triangle, wide at the bottom with a point at the top.

- **Calculation options**:
  - **Summaries**: Sums measure values for each sort value. This is the default.
  - **Counts**: Provides a count of records in the selected measure field, for each sort value.
  - **Details**: Displays the value of each individual record.

- **Clear buckets content**: Empties all buckets.
You can add fields to the following buckets for a funnel chart:

- **Measure.** The measure field whose values are represented by each layer of the funnel chart.

- **Color.** A dimension field that determines the layers of the funnel chart.

- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

- **Animate.** Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

- **MultiPage.** Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

**Procedure:** How to Create a Funnel Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations,* or, on the WebFOCUS Home Page, click *Visualize Data.*

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a funnel chart.

4. Add at least one measure to the Measure bucket and a dimension to the Color bucket.

   The funnel chart loads, showing each dimension field as a layer with height based on the value of the measure field.

5. You can make the following additional customizations to your funnel chart:
   a. Change the funnel chart to a pyramid chart.
   b. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.
   c. Change the fields to obtain different information.
   d. Format the chart (for example, customize the header and footer or change the series color).
6. Save your funnel chart.

Creating Mekko Charts

A Mekko chart allows you to see proportional values of a measure field for two dimension fields. The intersections of these dimension fields and their relative sizes make it possible to quickly identify the most significant combinations of values. An example of a Mekko chart is shown in the following image.

The following display options are available for a Mekko chart:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a Mekko chart:

- **Vertical.** The measure field whose values are represented by the proportional width of each column and height of each color segment.
Horizontal. A dimension field to break the Mekko chart into columns. The width of each column is based on the measure field in the Vertical bucket, and represents that column’s share of the total.

Color. A dimension field that determines the segments of the columns in the Mekko chart. The area of each segment represents its share of the total.

Tooltip. The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.

Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Mekko Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a Mekko chart.

4. Add one measure to the Vertical bucket and a dimension to the Horizontal and Color buckets.

The Mekko chart loads to display the proportional value of the measure field for each segment in each column.

5. You can make the following additional customizations to your Mekko chart:

   a. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.
   
   b. Change the fields to obtain different information.
   
   c. Format the chart (for example, customize the header and footer or change the series color).
6. Save your Mekko chart.

Creating Tag Clouds

A tag cloud allows you to see the most frequent or largest values in a dimension field based on the size and color of the text, making it easy to identify the most important values. An example of a tag cloud is shown in the following image.

The following display options are available for a tag cloud:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.

- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a tag cloud:

- **Detail.** The dimension field whose values are displayed as text in the tag cloud.
- **Size.** A measure value that determines the font size of each value.
- **Color.** A measure value to set a color scale for the tag cloud text.
- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.
Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Tag Cloud

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a tag cloud.

4. Add a dimension field to the Detail bucket and a measure field to the Size bucket. Optionally, add a measure field to the Color bucket.

The tag cloud loads, showing each value of the Detail field with a font size determined by the Size field.

5. You can make the following additional customizations to your tag cloud:
   a. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer).

6. Save your tag cloud.
Creating Streamgraphs

A streamgraph is a simplified area chart. It does not show labels for measure values, but makes it easy to identify trends for different dimension values over time. An example of a streamgraph is shown in the following image.

The following display options are available for a streamgraph:

- **Calculation options:**
  - **Summaries.** Sums measure values for each sort value. This is the default.
  - **Counts.** Provides a count of records in the selected measure field, for each sort value.
  - **Details.** Displays the value of each individual record.
- **Clear buckets content.** Empties all buckets.

You can add fields to the following buckets for a streamgraph:

- **Vertical.** The measure field that determines the height of each area.
- **Horizontal.** A dimension field to create a horizontal axis for the streamgraph. Typically, this is a date or date-time field.
- **Color.** A dimension field to generate different areas in the streamgraph.
- **Tooltip.** The data placed in this bucket displays in the tooltip at run time. Can be used to make additional information available without changing the appearance of the chart.
Animate. Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year.

MultiPage. Enables the creation of multiple graphs based on the field that you place in this bucket. The MultiPage bucket is available for stand-alone charts. If you convert the chart to a page created from new content, the MultiPage bucket disappears.

Procedure: How to Create a Streamgraph

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, change the chart to a streamgraph.

4. Add a measure field to the Vertical bucket, a dimension, such as a date field, to the Horizontal bucket, and another dimension to the Color bucket.

The streamgraph loads, showing comparative changes for each value in the Color bucket.

5. You can make the following additional customizations to your streamgraph:
   a. Add additional measures or dimensions to the Tooltip, Animate, or MultiPage buckets of the chart, where applicable.
   b. Change the fields to obtain different information.
   c. Format the chart (for example, customize the header and footer or change series colors).

6. Save your streamgraph.
Creating Charts Using a Chart Extension

WebFOCUS supports the ability to add new, custom chart types to its list of built-in charts. These custom chart types are called extensions or plug-ins. Once enabled on your WebFOCUS environment, any extensions that you have added are available when you expand the Content picker, in the Custom section, as shown in the following image.
Each chart extension uses a set of buckets and properties unique to that extension. The liquid gauge chart extension uses the Tooltip, Value Bucket, and MultiPage buckets, as shown in the following image.
The chord diagram, on the other hand, uses the Tooltip, Source Nodes, Target Nodes, Node Link Values, and MultiPage buckets. It also indicates the type of field that should be used in each bucket, as shown in the following image.

Each of these buckets is configured to allow a certain number of fields, and certain types of fields.

Chart extensions also have a unique set of properties that can be applied to them. To access chart extension properties, on the Format tab, with the General option selected from the Quick Access menu, in the Other section, click Extension properties. This opens the Extension properties panel. The Extension properties panel opens on top of the Resources and Properties panels, and can be resized and moved within the browser window. If you click outside of the Extension properties panel, it closes, and any changes that you made to the chart properties are applied.
The Extension properties panel for a liquid gauge chart is shown in the following image.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>waveAnimate</td>
<td>✓</td>
</tr>
<tr>
<td>circleFillGap</td>
<td>0</td>
</tr>
<tr>
<td>waveOffset</td>
<td>0</td>
</tr>
<tr>
<td>fontSize</td>
<td>1</td>
</tr>
<tr>
<td>maxValue</td>
<td>100</td>
</tr>
<tr>
<td>waveCount</td>
<td>1</td>
</tr>
<tr>
<td>valueCountUp</td>
<td>✓</td>
</tr>
<tr>
<td>textVertPosition</td>
<td>1</td>
</tr>
<tr>
<td>textColor</td>
<td>#045681</td>
</tr>
<tr>
<td>circleColor</td>
<td>#178bca</td>
</tr>
<tr>
<td>waveHeight</td>
<td>0</td>
</tr>
<tr>
<td>waveAnimateTime</td>
<td>8000</td>
</tr>
<tr>
<td>minValue</td>
<td>0</td>
</tr>
<tr>
<td>circleThickness</td>
<td>0</td>
</tr>
<tr>
<td>waveColor</td>
<td>#178bca</td>
</tr>
<tr>
<td>waveTextColor</td>
<td>#a4dbf8</td>
</tr>
<tr>
<td>waveRiseTime</td>
<td>800</td>
</tr>
<tr>
<td>displayPercent</td>
<td>✓</td>
</tr>
<tr>
<td>waveRise</td>
<td>✓</td>
</tr>
<tr>
<td>waveHeightScaling</td>
<td>✓</td>
</tr>
</tbody>
</table>
Some of the properties on the Extension properties panel apply to specific elements of the chart extension. For example, in the following image, the color of the wave in the liquid gauge chart has been changed to a darker shade of blue, and the number of waves has been increased from 1 to 3.

For more details about the buckets and properties used in specific chart extensions, see the page for each extension on the GitHub site.

**Procedure: How to Create a Chart Using a Chart Extension**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Expand the Content picker and, from the Custom section, select a chart extension with which to create your chart.

4. Add measure and dimension fields to the chart based on the available buckets.

5. Optionally, style the chart using the available extension-specific properties.
   a. On the Properties panel, select the *Format* tab.
   b. If it is not already selected, open the Quick Access menu and select *General*.
   c. In the Other section, click *Extension properties*. The extension properties panel opens.
d. Make changes to the desired properties, and then close the extension properties panel.

The chart updates to reflect your changes to extension properties.

6. Save your visualization.

Displaying Measure Values in Charts

In most chart types, measure values for different categories are communicated based on visual cues. For example, the height of a riser in a bar chart, the size of a slice in a pie chart, or the color or an area of a heatmap all communicate the measure value of the dimension value that they represent. By comparing different areas of the chart, and by using the legend and tooltips, you can quickly identify overall trends in your data.

To display measure values in a chart, you add them to a measure bucket. The names of these buckets differ, depending on the type of chart, and many chart types include multiple measure buckets, so you can evaluate the relationships between different metrics. For example, in a bar chart, you can display measure values using the Vertical, Size, and Color buckets. The Vertical bucket expresses values of the selected measure field using the height of each bar, the Size bucket expresses values using the width of each bar, and the Color bucket expresses values using the color of each bar, based on a color scale. The Color bucket can accept either a measure field or a dimension field. If you use a dimension instead of a measure, the color of each bar or bar segment is based on dimensional series values.

Each chart type has a default measure bucket. When you double-click a measure field or drag it onto the canvas, it is automatically added to that bucket. In the case of a bar chart, the default measure bucket is the Vertical bucket. For more information about the buckets available for each chart type, see the topics under Creating Charts.

By default, when a measure field is added to a measure bucket, the values are aggregated as a sum. The aggregation is performed for each dimensional sort value. To change the type of aggregation for a single field from sum to another option, such as count or average, right-click the measure field and point to Aggregate. A list of available aggregation options displays. For more information about aggregations, see Using Prefix Operator Aggregation Functions on page 686.

Alternatively, you can change the evaluation of all measure fields in your chart at once. From the Calculation Options menu, you can change the evaluation in all measure buckets from a summary aggregation to a count aggregation or to detail values, in which case measure values are not aggregated at all, instead displaying the value of each record in your data set. When you select one of these options, the icon displays above the chart buckets.
The count evaluation method displays the number of records within each sort value. This allows you to see the distribution of your data, such as in a histogram. To create a histogram, create a new bar chart and create a set of bins for the measure field distribution you want to evaluate. Add the newly created bins to the Horizontal bucket, then add the original, associated measure field to the Vertical bucket. Finally, change the evaluation method from Summaries to Counts. The chart now shows the number of records that fall into each bin range, as shown in the following image.

When using the Counts evaluation option, you can still change the aggregation option for each individual measure field, just like when you are using the Summaries option.
The Details evaluation option allows you to see the value of each individual record in your data set. Since every record is displayed, the Details option is best used for chart types that can display lots of values effectively. For example, the following image shows a scatter plot where each point represents a different record. The Revenue and Cost of Goods values represented by each axis are the non-aggregated revenue and cost of goods for each individual record.

If we had used the Summaries option, the chart would have displayed one point for each sort value, as shown in the following image. In this example, the sort value was the dimension in the Color bucket, Product Category.
Note: If you are using a very large data source, you may wish to filter your chart before displaying detail values in order to reduce the resources required to display all records.

Formatting Charts

Charts allow you to present information graphically, using such visual cues as color, size, and position to convey relationships between measures (numeric fields to be aggregated) and dimensions (categories) and to identify trends and outliers. You can create a wide variety of charts. For example, you can review your data (Gross Profit and Product Category) using different chart types (for example, bar chart, area chart, or line chart). The chart options give you an edge in deciding which chart to use to highlight certain information or trends.

Once you have created a chart, you can apply various styling and formatting changes to it. For example, bolding text in a legend or header, changing the color of a series, or changing the appearance of axis lines. The chart formatting options allow you to specify how components display, enabling you to format your chart to suit your needs.

The formatting capabilities of WebFOCUS Designer let you indicate which aspects will display, how fonts are utilized, and which additional options will enable you to create an effective, styled chart. This allows you to control the display of your chart information, giving you every opportunity to create a chart that you can share, distribute, and reuse on pages.

Customizing Charts

As you work with your chart, you can make modifications that improve the display of your chart, highlighting the layout and presentation of the chart components. Some of the formatting options include:

- Controlling font display
- Customizing headers and footers
- Changing the format of your legend
- Formatting the axes of your chart
- Formatting the series of your chart
- Customizing the format of your matrix chart
- Enhancing a box plot
- Enhancing your grid
- Enhancing a gauge
Adding a theme

Adding color to your chart

You can access the formatting options from the Format tab, as shown in the following image.
General options display, by default, but you can use the Quick Access menu to select a different aspect of your chart, for example, Legend, Axis, Series, or Matrix options, as shown in the following image.

![Menu options](image)

Different options are available, depending on the chart type.
Once you select an area of your chart to modify (for example, Axis), you can use the intuitive options and menus to make selections, as shown in the following image.

You can also access styling options by right-clicking an area of your chart, such as a riser or axis label, and clicking *Style*. 
**Note:** If you are working with a map, reference lines, or data grids, additional tabs will display, enabling you to make formatting changes to these components. These tabs do not display by default.

By streamlining formatting options in one place, you can quickly format charts to enhance the display of your data. Whether it be color-coding a series in a chart or changing the font size of your data labels, a customized, formatted chart is just a click away.

**Controlling Font Display in a Chart**

You can use the font formatter in WebFOCUS Designer to control how fonts are displayed in your chart. This is a quick way to apply styling, colors, or a specific font type for any text within your chart. The font formatter displays in different areas of the Format tab (for example, Legend, Axis, Series, and Matrix options). Depending on the chart type and what you want to format, you can use these options to enhance the fonts in your charts. The font formatter is shown in the following image.

You can also change the font of a header or footer in your chart. This allows you to control how a chart is labeled or highlighted, which is useful when the chart will be distributed. For headers and footers, you can:

- Change the font type and font size.
- Add bold, italic, and underline emphasis to your text.
- Set the justification of text in your header or footer. For example, left-aligned, centered, or right-aligned.
- Change the font color or background color.

The styling toolbar for header and footer text is available along the top of the canvas, as shown in the following image.
When reviewing text that displays in your chart, you might want to increase the font size of the header text to enhance its visibility. Editing the font types and styles in your chart gives you more control over how information is displayed and presented.

**Procedure:** How to Change the Font Type in Your Chart

Changing the type, size, and emphasis of a font improves the impact for the user that is analyzing this chart. To change the font of a chart header:

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add one or more measures and dimensions to your chart.

4. Double-click *Chart Heading* to enable it for formatting, and change this text to *Discount by Product Category*.
The styling toolbar displays along the top of the screen, as shown in the following image.

5. Ensure that the header *Discount by Product Category* is selected or highlighted.

6. From the styling toolbar, change the font type to Cambria, size 24, Bold.
The revised chart header displays and reflects the new font type and styling, as shown in the following image.

Note: You must select the text you want to modify in your header or footer before you apply any changes to the font.

**Adding Headings and Footings to a Chart**

You can use headers and footers to add key information, such as the purpose of the chart and the audience. For example, if you have gross profit for different product categories, you can add a header to highlight this information in your chart.

You can add multiple lines of information into the heading and footing areas in a chart. This accommodates thorough explanations and additional information while offering the most readable presentation.
You add a new line in the heading and footing by pressing the Enter key. The number of lines of heading and footing you can add to a chart is only limited by the available real estate on the chart. The chart body will adjust to fit within the available space with the heading/footing lines inserted. You can change the font size or other presentation aspects using the editing toolbar that displays. When you are finished editing the heading and footing and edit mode is closed, the chart canvas adjusts to ensure that all lines of the heading or footing are visible, as shown in the following image.

Headers and footers can contain the same type of information. Footers are not enabled, by default, but can be enabled from the Content area on the Settings tab, as shown in the following image.
You can make styling changes to the information in your headers and footers, which allows you to interactively style the text according to your preferences. Using a WYSIWYG canvas, it delivers formatting changes instantly, allowing you to see the results of your selections as you make them. When editing your header or footer, you can find the options at the top of the canvas, as shown in the following image.

You can change the font and font size using the drop-down lists. You can add bold, italic, and underline accents to your text. In addition, you can change the positioning of your text (left, center, and right). You can also customize the color of the text, as well as the background of the header or footer text area. When your formatting is complete, you can close the toolbar and continue working with your chart.

**Note:** You can double-click the heading or footing to resume modifications at any time.

**Procedure:**  How to Add Headings and Footings to a Chart

You can add and style headings and footings in a chart.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add one or more measures and dimensions.

4. On the Settings tab, expand the Content area and select *Enable footing.*
The headers and footers display, as shown in the following image.

5. Double-click the heading and change it to Sales by Category.

The styling options to edit the header and footer text are shown in the following image.

6. Change the font color to grey and change the font size to 20, as shown in the following image.
7. Change the footer to read October, 2019.
8. Change the font size to 8 and right-justify it, as shown in the following image.

Using headers and footers, you can add the finishing touches on your charts, identifying them with useful information for your audience. For example, when sharing and distributing your charts, headers and footers can help identify and streamline your communication.

**Formatting Legends in a Chart**

In a chart, the legend identifies values according to the color-coded data values that display. The legend typically displays on the right side of the chart, but you can change the location using the formatting options. You can format a legend in any of the following ways:

- Turn the Legend On, Off, or set it to Auto.
- Change the font features of the legend (for example, bold or a larger font size).
- Change the format of the title of the legend.
- Access options to change background options, including setting the background color and setting the border line width, size, and color.
- Set the display options for the legend.
To access the legend formatting options, click the Format tab. From the quick access list at the top of the tab, select *Legend*. The Legend formatting options display in the following image.

Use the On, Off, and Auto buttons to control how the Legend appears on your chart. You can optionally select On or Off, depending on whether you want to display the legend in your chart. The legend display setting is set to Auto, by default, which displays the legend only if there are multiple series in the chart.
**Note:** Occasionally, charts are large and require additional real estate. Hiding the legend, or turning it off, enables you to preserve additional room as required by the chart.

Under Labels, you can format the font used for the label text in your legend. These options include Font type, Style, Size, and Color.

Depending on the type of chart you use, adding data to a specific field automatically generates a title for the chart legend. For example, the following image displays a matrix marker chart that allows you to compare the differences between values by circle size. Since the measure Gross Profit has been added to the Size bucket, the legend title for this chart shows as Gross Profit, which is highlighted in the following image.

Under Titles on the Format tab, you can choose to show or hide the legend title with the **Show Titles** check box. You can also choose the font style and formatting of the legend title.

Under Other on the Format tab, you can perform tasks such as changing the position, setting the background color, and setting the border line width, size, and color. You also have options to display the legend options in reverse order and set it as collapsible.
Using Axis Options in a Chart

Depending on the chart type (for example, bar chart), you can format the axes to customize the display of the information. This includes items such as labels, titles, and font formatting. For example, you can choose to hide the labels in your chart or format the font to add clarity to your chart. You can easily customize the X and Y axis with options that suit your needs. To access these options, select Axis from the quick access menu on the Format tab. Other options, such as dual-axis, bi-polar axis, and split axis behavior, and a continuous time axis, are available by right-clicking a field once it has been added to your chart or using the menu next to the Vertical bucket.
You can rotate the labels in your axes as well as stagger them. This allows you to shift the display of information, which is particularly useful when your chart is very dense. You can modify the lines for individual axes, enhancing the frame of the axis on the chart. You can also show ticks, which allows you to view milestones in your data. You can also change the position of an axis, enabling you to dictate where your axis information will display (for example, right). The options on the Format tab for formatting an axis are shown in the following image.
In bar, line, and area charts, you can control x axis scrolling behavior from the Scroll menu. By default, the Scroll option is set to *On* and the scrollbar is enabled. When a large number of values are displayed on the x axis, a scrollbar generates so that they all have enough space to fit comfortably in the visible area of the chart. To disable the scrollbar, set the Scroll option to *Off*. When the scrollbar is not enabled, points and labels are compressed to fill the area occupied by the chart. As an alternative to the basic scrollbar, set the Scroll option to *MiniChart*. Instead of using a basic, default scrollbar setting, the minichart option provides a simplified image of the chart, with a transparent scrollbar, as shown in the following image.

You can point to the edge of the minichart scrollbar and use the double-headed arrow cursor to change the visible area of the chart by expanding or contracting the scrollbar. To set the default minichart scrollbar size, use the Count property that appears on the Format tab when you select the *MiniChart* option. The count represents the number of values initially visible on the x axis. For example, the default Count value of 10 means that a maximum of 10 values display in the chart at all times, regardless of the physical width of the chart area.
In bar, line, and area charts, you can also choose whether the y axis, or vertical axis, should be shared between all measures, or split so that each measure is separated and generates separate bars, lines, or areas. By default, the axis is blended, so all measures share the same y axis. To split the y axis, on the Settings tab, click the menu next to the Vertical bucket (or Horizontal bucket if the axes have been swapped), and click **Split axis**, as shown in the following image.

![Splitting y axis](image)

This option is especially useful if there are large disparities between the values of different measure fields. For example, the revenue values in a data source may be many times greater than the quantity sold values. To merge the axes back together, click the same menu, and then click **Blended axis**.

Alternatively, if you want to split the measure fields in a bar, line, or area chart into groups on separate axes, you can use the bi-polar axis option. The bi-polar axis option creates a second set of axes to which you can add some of your measure fields, instead of splitting each measure onto a separate axis. To enable this option, click the menu next to the Vertical bucket and then click **Bi-Polar axis**. To switch the y-axis that a measure field uses in bi-polar axis mode, click the axis icon next to the field in the measure bucket, or right-click a measure field and click **Top Axis (Y1)** or **Bottom Axis (Y2)**.
When creating a bi-polar axis chart, it may be useful to change the chart type of the risers for one of the measures on an axis to differentiate it. Right-click the measure field in the Vertical bucket (or the Horizontal bucket if the axes have been swapped), point to Shape, and choose whether the chart type for that measure should be bar, line, or area. The following image shows a bi-polar axis chart in which the Cost of Goods field is represented by a line chart.

Another way to show multiple measure fields on separate axes is to use dual axes. Instead of splitting the chart into horizontal sections, one or more measure field is plotted against the y1 axis on the left, and the other uses the y2 axis on the right. To specify which axis a measure field should use, when the Blended axis option is selected, click the axis icon next to the field in the measure bucket, or right-click the field and click Left Axis (Y1) or Right Axis (Y2). Each of these axes can be styled separately from the Axis options on the Format tab. When using dual axes, take note of which axis is used for each measure, as the values displayed in the chart may visually appear to be closer than they are in reality.

The same options are available for horizontal bar, area, and line charts, but affect the x axis, or horizontal axis, instead.
**Procedure: How to Format Axes**

You can format the axes of your chart to customize the display of information, including labels (rotated and staggered), titles, and axis-specific fonts.

1. Create a chart using WebFOCUS Designer, or open an existing WebFOCUS Designer chart. Axes are used in bar, line, area, scatter, bubble, and circle plot charts.

2. On the Format tab, click **General** to open the quick access menu, and then click **Axis**. The options for editing your axes display.

   You can select the Y-axis or edit the X-axis. The axis selection determines where changes are applied.

3. On the X-axis, perform the following formatting tasks:
   a. In the Labels section, change the font format of the labels to **bold**.
   b. Expand the Title section and change the size of the font for the axis title to 16. Change this to **bold** as well.

4. Select the Y-axis option and perform the following formatting tasks:
   a. Change the font format of the label to **italic**.
   b. Change the size of the font for the Title to 16. Change this to **bold** as well.

   When you preview the chart, you can see that styling on the axes has been modified, giving you a custom look and feel for your chart, as shown in the following image.

5. You can rotate the labels on the X-axis. In the Labels group, use the Rotation option to rotate the labels by 45 degrees, as shown in the following image.
6. You can also modify the line size of the axes. In the Lines group, use the Axis lines option to change the line size for both axes to 5. Making the axes lines bigger creates a more definitive frame, as shown in the following image.

![Chart Image]

With the axes of your chart formatted, you can continue making modifications or apply similar formatting to the axes in other chart types.

**Controlling the Display of Time-Based Axes**

By default, when you create a chart that has a dimension on an axis, missing values are not displayed on that axis. For example, if you create a bar chart showing revenue by product category, but there are no revenue values, including zero, for televisions, then televisions will not appear on the horizontal axis in the bar chart.

However, when you create a line or area chart using a date or date-time field as one of the axes, this is not the case. In these chart types, when a date or date-time field is used, the time axis option is enabled by default. This option allows you to show the entire, continuous range of time encompassed by your data, even if there are missing values in between. Missing values are extrapolated based on the nearest values. The time axis option allows you to see changes in your data over time on a continuous scale, displaying date values more intuitively and making it easier to recognize gaps in your data.
When the time axis option is enabled, the values in the chart are plotted along a continuous date axis, as shown in the following image.

![Revenue over time](image1)

Although there were no sales between December 6 and December 20 in the image shown above, those days occupy the same amount of space on the x-axis as the days in which there were sales, and the line is extrapolated for them. The same chart with the time axis option disabled is shown in the following image. Only dates with values in the data set of the chart display. Since not all dates appear in the chart, each existing date value is labeled on the axis.

![Revenue over time](image2)
To disable the time axis option and show only the date values in your data source, right-click the date or date-time field in the Horizontal or Vertical bucket of your chart and deselect *Time axis*, as shown in the following image.

To re-enable the time axis option, right-click the date or date-time field and click *Time axis* again.
Formatting Series in a Chart

A series represents a set of related values in a chart. These could be different measure fields in a chart, or different dimension field values in a chart. You can format all series together, or format each separately, including color, shape, display options for labels, and other options, including the ability to hide overlapping labels. You can select a specific series in a chart to which to apply changes, or you can select All Series, which applies changes to all series in the chart.

Having the ability to format by series gives you control over your content and allows you to customize display options at the series level. For example, you might want to color code a chart based on a range of values. You can also specify options for the data labels of the series. By default, these are enabled or hidden automatically depending on the chart type, but can be turned on or off. You also have the standard suite of font options, as shown in the following image.

![Chart settings and format options](image-url)
Different kinds of charts allow you to make different series-level style changes. For example, in a bar, area, or line chart you can set the width of all bars, or change a series to display as a line or area instead of a bar or bar segment. In a ring pie chart, you can change the size of the hole in the middle when viewing the options for all series, and on a scatter plot or bar, area, or line chart, you can add and style a trend line with different formulas for all series or an individual series. Other chart types allow different styling changes.

Additionally, some series styling options are only available when modifying all series in a chart, or only available when editing a single series. For example, when creating a bar chart, you can set the bar width for all series, but not for a single series. On the other hand, you can change the fill color for a single series, but not for all series in the chart.
When working with series in a chart, you can also set an option to control the display of data labels in your chart. The default is Auto. This gives you the ability to specify how your data will be presented (for example, by Value or Percentage), which is particularly useful in cases where you want to save real estate when using data labels in your chart, or show additional information. You can click the drop down to access a full list of content options, as shown in the following image.

You can use the following terms to decide the best way to display the content of your data labels.

- **Auto.** The chart engine decides what data label information to show. This is usually the value.

- **Label.** Shows the series label of the riser, marker, or slice (same as legend label)
- **Value.** Shows the value of the riser, marker, or slice, using the numeric format of the field. For example, if the field defined in the master file is US Currency with two decimal places of precision, then that is what the dataLabel will be ($123.45).

- **Percentage.** Shows the percentage of the riser/slice based on the group to which it belongs.

- **Value,Percentage.** Shows the value of the riser, marker, or slice, with numeric formatting and the percentage of the riser/slice based on the group to which it belongs.

- **Label,Value.** Shows the series label of the riser, marker, or slice (same as legend label) and the value of the riser, marker, or slice, with numeric formatting.

- **Label,Percentage.** Shows the series label of the riser, marker, or slice (same as legend label) and the percentage of the riser/slice based on the group to which it belongs.

- **Label,Value,Percentage.** Shows the series label of the riser, marker, or slice (same as legend label), as well as the value of the riser, marker, or slice, with numeric formatting. It also shows the percentage of the riser/slice based on the group to which it belongs.

When creating a stacked bar, stacked area, or stacked line chart, you can also select the *Show stacked totals* option to show the summed total of all series at the top of each bar or sort-value point.

You can also Wrap Data labels, which allows you to truncate available chart space or show your data on multiple lines. The following examples show how the wrapping option works.

Example of *WrapDataLabel=True*:

"France

$123.4

23.4%"

Example of *WrapDataLabel=False*:

"France, $123.4, 23.4%"
Specifically, the data label options allow you to determine what is shown when Show label is ON. For example, Label, Value, Percentage. If the option is set to Auto, the chart engine decides what it thinks is the best content to show. Typically, this is the value of the riser or slice. For example, on a basic pie chart, the Auto setting produces the following result.
You have additional content choices. For example, you can choose Label, which corresponds to the series label that is shown in the legend. When you select the Label option, you also have the option of turning the legend off, so as not to duplicate the information that is displaying in your chart. The Label option is shown in the following image.
You can also choose Percent, which shows the percentage of the whole for each riser or slice. This is very useful for a pie or stacked bar chart, as these are the charts that are best used to visualize the concept of percentage-related content, as shown in the following image.

![Pie Chart Example](image-url)
You can also display the Value, which is the riser/slice value. This is often the same thing you will get if you choose Auto.
There are also options for you to combine three choices, such as Value, Label, and Percent. This allows you to display all three items, as shown in the following image.

Click *Wrap Data labels* to display the content on three separate, unique lines, or clear the *Wrap Data labels* check box to display all label information on a single line.

**Procedure: How to Format a Series**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Create a Vertical Stacked Area chart.
4. Add a measure to the Vertical bucket, a dimension (for example, a time based dimension with month or year values) to the Horizontal bucket, and another dimension to the Color bucket, as shown in the following image.

5. On the Format tab, open the quick access menu and then click Series.

6. In the Data labels section, in the Show label group, turn data labels on by changing the setting from Automatic to On.

   Since All series is selected by default, labels are displayed for every series in your chart.

7. Format the labels with 10 point, red font using the font options.
The values in the chart reflect your custom formatting, giving you a better view of your data, as shown in the following image.

8. Change the color of one of the risers.
   a. From the series selection drop-down menu, on the Format tab, directly below the quick access menu, select a single series. Each series represents a value from the field in the Color bucket.

   If your chart contains multiple measure fields, then each series represents a measure field in addition to or instead of a dimension value.

   b. In the Shape section, change the color selected for the Fill option to a color of your choice.
The selected series riser updates to show the new color, as shown in the following image.
Formatting Matrix Charts

If you are working with a chart type that supports a matrix format (for example, Matrix Marker, or another chart type utilizing matrix rows and columns), WebFOCUS Designer provides a selection of formatting options that you can use to customize and enhance the styling of your chart. A matrix format is a grid that contains values based on the intersecting data points, which is useful for reviewing changes and trends over time. Available formatting options for matrix charts include Headers and labels, and Lines, as shown in the following image.

![Formatting options for matrix charts](image)

You can customize the row and column headers and their corresponding values in a matrix chart. Specifically, you can change the font type, font size, and color. You can also change the emphasis of the font using bold or italic styling. You can also change the alignment of row values text.

When working with lines in your matrix chart, you can change the line style (for example, solid or dotted) and the thickness. These formatting options allow you to make visible enhancements that will improve the appearance and presentation of your matrix charts.
Procedure: How to Format a Matrix Chart

To format a matrix chart:

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data. WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace. Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. From the Content picker, select the Matrix Marker chart type.

4. Add two dimensions and two measures to the chart. These data fields should be placed in the Vertical, Horizontal, Size, and Color buckets.

5. On the Format tab, click General and then click Matrix options from the drop-down list.

6. Apply formatting changes for the matrix chart, including:
   a. Headers and labels, which allow you to customize the font options for row and column headers and values. Font options include font type, bold, italic, font size, and font color.
   b. Line style, which allows you to adjust the type, size, and color of the lines for the matrix chart.

7. Change the font being used for row and column headers to bold, red, and size 16 font. The updated matrix chart now displays customized row and column headers, as shown in the following image.

![Matrix Chart Example](image-url)
8. Using the options in the Lines section, change the line style to blue, dashed lines.

   The resulting matrix marker chart resembles the one shown in the following image.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camcorder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Televisions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Production</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Formatting Box Plots

A box plot is a common chart type used to show key distribution information for a set of data points. A box plot displays outliers, the median, the upper and lower quartile, and the maximum and minimum with outliers excluded, by default. However, you can use the Box Plot options on the Format tab to show the mean, or average, as well. Additionally, you can change the display of the whiskers from lines to boxes, and change the style of the median and whisker lines.

To access the Box Plot properties when creating a box plot, click the Format tab and select **Box Plot options** from the Quick Access menu. The following options are available:

- **Show Mean.** Displays a marker at the mean point, which you can compare with the median to get an idea of the skewness of your data.
An example of a box plot with mean markers enabled is shown in the following image.

- **Show Hat as Box.** Changes the appearance of the whiskers in the box plot from lines to boxes.
An example of a box plot with the Show Hat as Box option enabled is shown in the following image.

- **Line style.** You can change the pattern of the median and whisker lines from a solid line to a dotted or dashed line, and change the width and color of the lines.

**Procedure:** How to Format a Box Plot

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.
2. Select a workspace and a data source available from that workspace.
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. From the Content picker, select the Statistical Boxplot chart type.

4. Add a measure to the Vertical bucket and a dimension to the Horizontal bucket.
   A single measure value displays as a line in each column.

5. Use one of the following methods to generate a set of data for each column:
   - Add a dimension field to the Detail bucket. This field should provide multiple records for Horizontal bucket value.
   - Change the calculation option from Summaries to Details. If you have a very large data source, this may generate too many records to evaluate in the box plot.
     A set of box plots appears on the canvas, showing indicators for outliers, maximum and minimum, median, and upper and lower quartiles.

6. On the Format tab, click General and select Box Plot options from the quick access menu.

7. Optionally, select the Show Mean check box to display a marker in each box plot indicating the location of the mean.

8. Optionally, select the Show Hat as Box check box to display the whiskers as narrow boxes on either side of the box showing the interquartile range.

9. Optionally, change the style of the median lines and whisker lines.
   Click the box showing an image of the line to change the line pattern to one of a variety of dashed and dotted lines. Use the spinner to change the width of the lines, in pixels. Click the color swatch to change the color of the lines.
   The box plot updates on the canvas as you make your changes.

10. Once you finish creating and formatting your box plot, save it, or convert it to a page to develop more content.

**Formatting Data Grid Charts**

A data grid is a type of chart that displays a tabular representation of your data, similar in structure to a tabular report. A data grid allows you to review data in a row and column format, similar to a printed report. Data grids are easy to create, and provide features such as a tooltip for each cell of the grid. WebFOCUS Designer provides numerous options to style and format a data grid.
Values in a data grid can be sorted, and data grids can be shared or saved for use on a page. A data grid is shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Cost of Goods</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$18,112,921.00</td>
<td>$10,995,633.29</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$81,396,149.00</td>
<td>$4,954,242.27</td>
</tr>
<tr>
<td></td>
<td>Home Theater Systems</td>
<td>$56,428,589.00</td>
<td>$3,943,920.23</td>
</tr>
<tr>
<td>Accessories</td>
<td>Headphones</td>
<td>$16,663,564.00</td>
<td>$3,516,513.33</td>
</tr>
<tr>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>$59,077,345.00</td>
<td>$3,475,828.52</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Standard</td>
<td>$49,071,633.00</td>
<td>$3,214,786.74</td>
</tr>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>$44,035,774.00</td>
<td>$2,790,775.51</td>
</tr>
<tr>
<td>Video Production</td>
<td>Video Editing</td>
<td>$40,105,857.00</td>
<td>$2,695,890.76</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Receivers</td>
<td>$40,329,068.00</td>
<td>$2,543,045.36</td>
</tr>
<tr>
<td>Accessories</td>
<td>Universal Remote Controls</td>
<td>$36,937,623.00</td>
<td>$2,310,446.31</td>
</tr>
<tr>
<td>Computers</td>
<td>Tablet</td>
<td>$29,771,059.00</td>
<td>$2,015,134.59</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>$20,576,918.00</td>
<td>$1,950,624.28</td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>$35,218,363.00</td>
<td>$1,933,997.25</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>iPod Docking Station</td>
<td>$20,119,093.00</td>
<td>$1,820,925.29</td>
</tr>
<tr>
<td>Media Player</td>
<td>Streaming</td>
<td>$5,004,732.00</td>
<td>$333,599.94</td>
</tr>
<tr>
<td></td>
<td>DVD Players</td>
<td>$3,756,254.00</td>
<td>$258,593.13</td>
</tr>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>$2,052,711.00</td>
<td>$187,486.05</td>
</tr>
<tr>
<td>Televisions</td>
<td>CRT TV</td>
<td>$1,928,418.00</td>
<td>$110,654.08</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Boom Box</td>
<td>$640,373.00</td>
<td>$62,739.39</td>
</tr>
<tr>
<td>Televisions</td>
<td>Portable TV</td>
<td>$545,343.00</td>
<td>$35,210.18</td>
</tr>
<tr>
<td>Media Player</td>
<td>DVD Players - Portable</td>
<td>$306,576.00</td>
<td>$26,356.05</td>
</tr>
</tbody>
</table>

You can format a data grid using the options on the Format tab. The Format tab contains two sets of options, General and Datagrid options, which you can access using the quick access menu, as shown in the following image.

The General section provides a set of options that are common to all chart types. These options are divided into three sections: Theme, Frame and background, and Other.

The Theme section provides a menu that allows you to select a StyleSheet to automatically format the data grid. You can select from a list of themes available with WebFOCUS, or click Custom to select a StyleSheet from the legacy templates or your repository.
The Frame and background section includes the following options:

- **Background.** Allows you to select a color for the background area behind the data grid.

- **Frame.** Allows you to select a color for the chart frame. This option allows you to change the data cell fill color in the data grid.

- **Frame Border.** The Frame Border settings are not applied to data grids. To style the borders in the data grid, use the Border style settings under Headers and values in Datagrid options.

The Other section includes the following options:

- **Fit to container.** This option does not apply to data grids. It is used for bar, line, area, and scatter plot chart types.

- **Hide null groups.** When selected, if any rows or columns in the grid do not contain any data, they are hidden at run time.

- **Show null as zeroes.** When selected, cells for which no data is returned show a value of zero (0). When not selected, cells with no data appear blank, which is the default.

You can also select styling options that are specific to data grids. These are listed when Datagrid options is selected from the quick access menu on the Format tab. You can also access these options by right-clicking an area of the data grid and clicking **Style**.

The Datagrid options are divided into three sections: Headers and values, Background and padding, and Other.

The Headers and values section allows you to define the styling properties of the item selected from the Headers and values menu. You can set these properties for the row headers, column headers, cell values, and column totals. The Headers and values section contains the following options for each area of the data grid.

- **Format.** Allows you to select the font, text formatting, font size and units, and text color.

- **Alignment.** Allows you to set the text alignment to the left, center, or right side of the cells.

- **Border style.** Allows you to select the line style (for example, solid, dashed, or dotted), thickness, and color of the cell borders.

The Background and padding section allows you to style the cells in the data grid by adding bands and increasing the cell padding. Options in this section include the following:

- **Row color.** Allows you to add bands to the data grid to make the rows easier to distinguish. Select the **Alternate row color** check box to add alternating bands to the data grid and select a color from the Color picker to style them.
- **Vertical padding.** Allows you to set the vertical padding, in pixels, between the text and borders of each cell.

- **Horizontal padding.** Allows you to set the horizontal padding, in pixels, between the text and borders of each cell.

The Other section allows you to add column totals to the data grid and freeze column and row headers. The options in this section are as follows:

- **Show column total.** When selected, adds a column total row to the data grid. This row can be styled by selecting *Totals* in the Headers and values section. Show column total is not selected, by default.

- **Freeze column headers.** When the data grid uses a vertical scrollbar, selecting *Freeze column headers* keeps the column headers in place while scrolling so that you can see which column each cell belongs to. When not selected, the column headers are not frozen when scrolling. Column headers are frozen, by default.

- **Freeze row headers.** When the data grid uses a horizontal scrollbar, selecting *Freeze row headers* keeps the row headers in place while scrolling so that you can see which row each cell belongs to. When deselected, the row headers are not frozen when scrolling. Row headers are frozen by default.

- **Fit to container width.** When this check box is selected, the grid spans the entire width of its container. When this check box is not selected, the grid width is only as wide as is needed to show each column header fully.

**Procedure: How to Format a Data Grid**

You use the options on the Format tab to customize a data grid. These options allow you to style the data grid to match your preferences while maintaining the simplicity and clarity of the data grid chart format.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. From the Content picker, select the data grid chart type.
4. Add fields to the data grid.
   a. In the Resources panel, with *Fields* selected from the sidebar, in the Dimensions area, expand *Product* and drag *Product,Category* to the Row bucket.
   b. In the Measures area, expand *Sales* and drag *Cost of Goods* and *Revenue* to the Measure bucket.
   c. In the Dimensions area, expand *Customer* and drag *Customer,Business,Region* to the Column bucket.

A basic data grid has been created, showing Cost of Goods and Revenue sorted by Product Category across Customer Business Region.

5. Add a header to the grid.
   a. Double-click the Chart Heading text.
      The text is highlighted and Rich Text Editor displays.
   b. Type *Regional Sales* into the chart heading area and click the X on the styling toolbar.
      The chart header is changed to *Regional Sales*.

6. Open the Format tab.
7. Change the background color of the cells to seafoam green.
   a. In the Frame and background section of the Format tab, click the color sample under Frame.
      The color picker opens.
   b. Click *More* to access the color wheel. Select seafoam green by clicking on the wheel in a location between cyan and green, and then using the brightness slider to select a light seafoam green color. Alternatively, type a hex code value into the text box. For example, #adebcc.
   c. Click *OK*.
      The data cells in the data grid now have a seafoam green fill.

8. Access additional styling options for the data grid. Open the quick access menu and select *Datagrid options*.
9. Make the across column headers bold.
   a. From the Headers and values drop-down menu, select *Column headers*.
   b. Click the *Bold* button to make the text bold.
10. Add pink bands to the grid.
    a. Expand the Background and padding section.
    b. Select the *Alternate row color* check box.
The rows now alternate between the seafoam green background and the default gray bands.

c. Click the color sample under the Alternate row color check box.
   The color picker opens.

d. Select the pink color from the palette.
   Now the data grid shows alternating seafoam green and pink rows.

11. Add column totals to the grid.
   a. Expand the Other section.
   b. Select the Show column total check box.
      The column total row appears on the data grid.

12. Style the column row total by changing the text and border color to purple.
   a. From the Headers and values drop-down menu, select Totals.
   b. In the Format subsection, click the color sample to change the text color for the column totals.
   c. Click More to access the color wheel, then select a shade of purple.
   d. Click OK.
      The column totals now show in purple text.
   e. Add a purple border to the columns total row.
      In the Border style subsection, click the color sample to open the color picker. From the Custom Colors palette, select the same purple color that you used for the text. This color was automatically saved and added to the Custom Colors palette.
   f. Click OK.
      The text and border for the column totals now use the same shade of purple.

An example of what the resulting grid may look like is shown in the following image.
Customizing a Gauge Chart

A gauge is a simple chart that allows you to display basic KPI values. You can choose to display these values with a standard or simplified dial graphic, or alone, as text only. The default, simple, gauge type is shown in the following image.

You can change the gauge type from the display options, above the buckets on the Settings tab. Use the default, Simple option to show a simple gauge dial, use the Circular option to show a gauge dial with a pointer and tick marks, or use the KPI option to show text only.

When you create a gauge, the Gauge Properties option becomes available on the Format tab. You can change the following properties of the gauge label and value text:

- **Label**
  - **Show label.** Select this check box to show the name of the measure field represented by the gauge. This text only displays when using the Circular or KPI display options. For example, the following image shows a KPI gauge with the label position set to *Top*.

    ![KPI gauge with label set to Top](image)

    The following image shows a KPI gauge with the label position set to *Bottom*.

    ![KPI gauge with label set to Bottom](image)

- **Position.** You can choose to place the measure label above or below a circular or KPI gauge.

- **Font.** Change the typeface, font style, size, and color of the label text as it displays in a circular or KPI gauge.

- **Value**
  - **Show value.** When creating a circular gauge, select this check box to show the gauge value as text, or clear it to hide the text and only show the value graphically. The simple and KPI gauge types always show the value text.
Font. Change the typeface, font style, size, and color of the value text as it displays in the gauge. When using the simple gauge type, you can also leave the Enable font autosize check box selected to have the value text automatically resize to fill the inside of the gauge, or clear the Enable font autosize check box to set a consistent font size for the value text.

Adding a Theme to a Chart

A theme is used to determine the coloring and hues that display in the charts you configure using WebFOCUS Designer. For example, the default border color and chart colors are determined by the theme.

When creating stand-alone content, the default theme is Designer 2018. When you turn the visualization into a page by adding a second new content item, the theme used for the chart is applied to the page. When you add items to the page, either by creating them or adding them as external content, the page theme is used as the default for all content items. You can then change the theme for each individual item.

You can use one of the themes included with WebFOCUS, or you can create your own theme. For example, you may want to apply a corporate standard theme to your chart. You can add and change themes to suit your requirements (for example, branding).
Available themes that are called by WebFOCUS Designer are located in the Themes folder in the Global Resources area, accessible from the Workspaces tab of the WebFOCUS Hub or Home Page, as shown in the following image. Custom themes can be added to folders within the Custom folder.

Supported formats for themes include .css and .sty. A .css theme file is used to style a page, while .sty file is used to style content such as charts and reports. When files called theme.css and theme.sty are placed into the same folder in the custom themes folder of the Global Resources area, they are available for selection in WebFOCUS when editing page components and content items. The two files are associated, so when the .css theme file is applied to a page, the associated .sty theme file is applied to new content in that page, by default. Similarly, if you select a theme for a chart, which uses the .sty file, then when you convert to a page, the associated .css file is used as the default page theme.

You can develop your own theme using the WebFOCUS text editor and then access it in WebFOCUS Designer. You can customize the .sty theme file used for charts and reports by specifying a set of default property values in it. For information on the properties that you can use in the theme to style a chart, see the Creating HTML5 Charts With WebFOCUS Language PDF.
**Tip:** You can use the code from an existing theme as a model when creating a new theme.

**Note:** Charts and reports created for use on pages can use a transparent background to allow the defined background color of the page containers to show through. Since the themes used for charts and reports (.sty files) can be associated with themes for pages (.css files), you can coordinate the background, text, and element colors used in both themes to create content with unified styling. At design time, the page theme associated with the chart or report theme is used for the canvas background. This is for visibility purposes only, and shows how the chart or report will appear when added to a page with the associated theme. The stand-alone chart or report does not include this background.

If a chart or report is run stand-alone instead of being added to a page, the run-time view displays a white background only. This means that if, in order to display on a dark colored page, the font color in the selected theme is defined as white and uses a transparent chart background, then the text will not be visible on the white preview background. An example of such a theme is the Midnight theme, provided as one of the default themes in the Global Resources. To view the white text, build your chart or report on the canvas, add it to a page container with a dark background, or change the chart background color from the Format tab. Note that a non-transparent chart background is layered in front of the panel background when the chart is part of a page.

**Procedure:** **How to Add a Theme to a Chart**

You can add a theme to a chart to color the background and components of your chart. If the chart is in a page, the default theme is the one used in the page. If the content is stand-alone, so that there is no page from which to inherit the theme, the default theme is called Designer 2018.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.
If you start creating content without changing the theme, the default theme is used, as shown in the following image.

3. On the Format tab, with the General option selected from the quick access menu, in the Theme and Format section, open the Theme drop-down menu.
A list of available themes is displayed. As shown in the following image, you can choose from the Designer 2018, Light, Midnight, and Vivid themes that are included with WebFOCUS, a custom theme added to the Global Resources area, such as the themes Alex's Theme, Custom Theme, or MyTheme shown in the image, or click Custom to select a legacy theme or a theme saved to a workspace folder.

4. Select another theme from the list (for example, Light) to change the theme.
The color of the background and chart components changes based on the selected theme, as shown in the following image.

5. Click **Convert to page** on the Visualization toolbar to transform the chart into a page and move it into a container.

The visualization transforms from a single content item into a page. Notice that the page adopts the theme that was used for the original content item. Additionally, the content item now has a theme of *Inherit Page Theme*, so that if you change the theme of the page, the theme of the content item changes along with it.

6. Add fields to the new chart to create a second content item. Notice that it also initially uses the same theme as the page.

7. Click the page toolbar or select the Visualization item from the outline to select the entire visualization.

8. Click the **Format** tab select a different theme from the Theme drop-down menu, for example, *Midnight*.

Notice that the theme of both content items have also changed to match the page, since they have a theme setting of *Inherit Page Theme*.

9. Select one of the items on the page and, on the **Format** tab, with the **General** area selected, change the theme.
The content item whose theme you explicitly set has changed, while the second item, for which a theme was not explicitly selected, still uses the theme used for the page, as shown in the following image.

![Page Heading](image)

**Adding Color to Charts**

By adding color to your chart components, you can change the way information is perceived and plays a large role in the effectiveness of your chart.

Color adds contrast to your charts, giving you an advantage in presenting unique, well-balanced content. You can use color to highlight a specific aspect or outcome on your chart. WebFOCUS Designer provides a color picker to add color and style your chart.

You can access the color picker in two primary ways: on the Format tab and at the top of the canvas when formatting headers and footers. Using these options, you can change the color of different components to style your chart. You can indicate color values and ranges to highlight data. You can color a chart component (for example, a header or axis), text, or even add colored lines to accentuate the background grid of your data. You can also change the theme, which changes the color palette and background of your chart.
The following image shows an example of color options that display on the Format tab (with the palette exposed), which you will also see in other areas where color formatting is supported:

The following image shows the options that display at the top of the canvas (with the palette exposed) when working with headers and footers.
**Note:** When specifying a theme, you can use the default or specify another one. The colors stored for the theme are part of the underlying .css or .sty file, which contains the color schemes.

In WebFOCUS Designer, the color picker supports a colorspace and a palette-based approach, as shown in the following image.

You can access the color picker from any of the sections on the Format tab. You can also access the color picker when working with headers and footers. When you access the color picker, the color picker displays the Palette tab, by default. From this tab, you can select from up to 20 pre-defined color options. You can also select the No Fill option, which displays the selected content as transparent. This is particularly useful in cases where you might want to prevent (or hide) the display of information.
The More tab allows you to choose a custom color by interacting with a hue wheel and the color value field, as shown in the following image.

![Color Selection Interface](image)

You can specify an exact color code (hexadecimal or HTML) by entering it in the color value field located at the top of this tab, and also specify transparency by using the transparency slider.

**Note:** When a custom color is selected and you click OK, the color is automatically added to the Custom Colors section in the Palette tab.

You can also set a color range for a measure in your chart. This allows you to specify hues or ranges of color for use in your chart. In cases where Theme is not selected, the color specification overrides what is available in the theme. The color that you select dictates the legend, which in turn displays the various chart components, based on the colors and measurements specified.
To change the color scale options, right-click a measure in the Color bucket and select Set color ranges, as shown in the following image.

This invokes a new dialog box, Set Color Ranges, where you can select a color range for your chart, as shown in the following image.
When you make a selection, you can override the color schemes that are available from the theme of your chart. Theme is selected, by default. You can select a different color range, such as Green or Red/Orange, from the list of options, which gives you more control over how color is used in your chart to create contrasts between various aspects. For example, if your chart displays different temperature values using a measure in the Color bucket, you may wish to use the Red/White/Blue option to intuitively show higher temperature values in red and lower ones in blue.

If you change the color range to something other than Theme, it is written as inline styling in the .fex file. Inline styling always overrides what is in the StyleSheet because it is listed after it in the .fex file. In this case, the last setting indicates which styling takes precedence. When the color range is set back to Theme, the inline styling is removed so the behavior returns to the theme’s settings.

This behavior does not affect your ability to change themes on the Format tab. However, if you change the theme with an inline setting in place, the settings of the Theme will still be overridden by the inline settings and the color scale in the legend will not be affected. The current procedure only respects the current theme’s settings if the color range setting is set to Theme.

In the Set Color Ranges dialog box, you can also select Continuous or Discrete to determine how the color scale is generated. When Continuous is selected, the color scale is a gradient, and each color in the color scale represents a different value. When Discrete is selected, the color scale is divided into segments. Each color in the color scale represents a range of values.
The following image shows a matrix marker chart that uses the Red/Yellow/Green color scale with the Continuous option selected.

The Continuous option creates a more granular color scale, allowing you to see slight differences between similarly colored chart components.
The following image shows the same chart, with the Discrete option selected.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camcorder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Televisions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Production</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Discrete option creates identifiable groups based on sections of the color scale.

When using the Theme color scale option, the default color scale type and number of segments in discrete mode are dependent on the values of the colorScale property in the theme that you are using. For example, if 5 colors are listed for the colorScale property in StyleSheet being used as your theme, then 5 colors display in the color scale when the discrete option is used.

**Procedure:** How to Add Color to Your Chart

To add color to your chart:

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add one or more measures and dimensions to your chart.
4. On the Format tab, expand the quick access menu and then click Axis from the drop-down list, as shown in the following image.

![Image of Axis settings](image)

5. In the Font section, click the color sample.
   The color picker displays, as shown in the following image.

![Image of color picker](image)
The text color you select is displayed for the values on the specified axis (for example, x-axis), as shown in the following image.

![Chart Heading](image)

**Procedure:** How to Change the Color Scale in a Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add one or more measures and dimensions to your chart.

4. Add a measure to the Color bucket.

   Many different chart types generate a color scale from the Color bucket. Exceptions include the ring pie and data grid chart types.

5. Right-click the measure field in the Color bucket and click *Set color ranges*. 
6. From the list of colors, select a color range, as shown in the following image.

7. Optionally, select **Continuous** or **Discrete** to determine how the color scale is generated.
   - When Continuous is selected, the color scale is a gradient, and each color in the color scale represents a different value.
   - When Discrete is selected, the color scale is divided into segments. Each color in the color scale represents a range of values.

8. Click **OK**.
   Note the change in the color and hues in your chart.
Changing the Size of Charts and Risers

By default, when you create a chart, it fills the frame in which it is run, and risers and other sections within the chart are sized accordingly. This makes the chart flexible, allowing it to run in large and small containers alike without sacrificing the appearance and legibility of the chart. This automatic sizing also means that you do not need to manually set any size properties for the chart.

However, you also have the option to set a consistent size for the chart, if you prefer. You can also determine the width of bars in a bar chart as a percentage of the riser area, and set the width of risers in a bar, area, or line chart, based on the font size of the ordinal axis, or on an exact value that you specify.

You can set a static height and width for a chart, so that it remains the same size no matter where it is loaded. This can be useful, for example, if you want to add the chart to a PowerPoint presentation or PDF, and want to leave room for other content on each slide or page. To set the size of your chart, on the Format tab, select General from the quick access menu. In the Other section, notice that the Fit to container option is set to Automatic, by default, so that the chart automatically resizes to fill its container. To specify a size for the chart, change this setting to Manual, and then provide a width and height for the chart, in pixels. As you set these dimensions, you can select the Lock Aspect Ratio check box so that as you change the width or height, the other dimension changes as well, to maintain the same aspect ratio.

In bar, area, and line charts, values are represented by the height of a bar, area, or line at different points along the ordinal axis, which displays different dimension value labels. These points are generically called risers. You can set the width of these risers to fill the width of the chart, resize them based on the font size of the ordinal axis labels, or resize them manually by specifying a number of pixels.
To access these options, on the Format tab, select Series, and leave All series selected. By default, the riser width automatically adjusts based on the width of the chart to fill it evenly. In the Shape section, change the Riser Width property to Tie to ordinal font size to have the riser width increase with the size of the dimension labels on the ordinal axis of the chart. This is most useful in charts that are oriented horizontally, so the risers and labels occupy roughly the same amount of vertical space. To change the font size, on the Format tab, select Axis from the quick access menu and then select X Axis from the axis drop-down menu. The Labels section includes the options to change the font size of the axis labels. In the following image, the font size was increased to 18, and, since the Riser Width property was set to Tie to ordinal font size, the width of each riser has also increased accordingly.

You can also set the width of each riser in pixels. Set the Riser Width property to Manual and then use the slider to set the riser width. If the riser width is too wide to fit all risers in the chart frame, a scrollbar is added.

In bar charts, you can also set the percentage of the riser area that each bar or set of side-by-side bars occupies, using the slider for the Riser Spacing property. Reducing this value increases the amount of space between bars.

Creating Maps to Illustrate Trends

You can create maps to identify patterns or trends in your data. By converting data into values that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and identify potential problem areas. For example, a law enforcement agency may use mapping functionality to identify areas of higher crime within the locations they cover. You can also use maps to determine how places are related, understand where things are located, and identify the best actions to take. By illustrating trends on a map, a decision maker can identify patterns easily, and reach conclusions sooner.
You can access Map options from the Format tab, as a special tab is activated when a map is initiated. This tab is shown in the following image:

You can format maps to display areas of emphasis through the use of demographic and reference layers.
A Brief History of Mapping

An early example of how maps can be used to illustrate trends is the case of Dr. John Snow, an epidemiologist who was one of the first to use data to map occurrences of cholera to find the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to visualize a trend that showed higher incidences of cholera closest to water pumps. This example is shown in the following image.

Maps also allow you to measure size, shape, and distribution to detect and quantify patterns, and even perform predictive analytics. An example of how maps can help detect and quantify patterns is the scenario in which a state agency used a mapping application to solve a problem with their food stamp system. Using this application, odd food stamp redemptions, such as rounded numbers transactions, were discovered. By plotting those transactions on a map, the agency discovered that the redemptions appeared in the same geographic location. Upon further investigation, the agency identified that individuals were selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as intended. This map example is shown in the following image.

<table>
<thead>
<tr>
<th>Citizen</th>
<th>Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jane Smith</td>
<td>01/03/2015</td>
<td>35.26</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>01/05/2015</td>
<td>44.12</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>01/10/2015</td>
<td>12.42</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/02/2015</td>
<td>100.00</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/08/2015</td>
<td>50.00</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/11/2015</td>
<td>75.00</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/03/2015</td>
<td>23.24</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/06/2015</td>
<td>14.32</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/11/2015</td>
<td>34.88</td>
</tr>
</tbody>
</table>
When working with maps, the concepts of location intelligence and business intelligence are important to understand. A Geographic Information System (GIS) captures, stores, analyzes, manages, and presents data linked to a location, while Business Intelligence (BI) relies on the conversion of raw data into meaningful information. Location intelligence is the process of analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow the recognition of patterns in your data, including the visualization and discovery of geospatial outliers, which would not be easily discovered if you use the technology independently and separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view symbol layers for data-bound to a geo-location, such as state, country, and ZIP code, in an integrated map viewer. Using metrics from your data, you can also visualize geographic roles or dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or assigned to a data field when you create a map.

**TIBCO WebFOCUS Designer and Esri Integration**

Using WebFOCUS Designer with the Esri integration, you can create maps that help you illustrate or identify trends so you can take action quickly. WebFOCUS architecture provides the framework in which this system operates. Using a JavaScript map viewer, you can navigate the interface easily, as shown in the following image.
In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS JavaScript API and content. Specifically, you can integrate data into maps with published content in ArcGIS Online platform. For more information, see [http://www.esri.com/software/arcgis/arcgisonline](http://www.esri.com/software/arcgis/arcgisonline). Additionally, by using this integration, you can include information about demographics, spending habits, crime, and lifestyle to maps that contain your data. These maps include layers with extensive demographic or reference detail and topography and allow you to view information about people, businesses, climate, and much more.

You can create the following maps in WebFOCUS Designer:

- **Choropleth.** A common thematic map that uses geographical measures (for example, states and countries), representing the values aerially while employing a varying intensity of colors. It is useful for visualizing location-based data, trends, and distributions across a geographic area. The color hues for Choropleth maps are dictated by the legend, based on the selected measure, enabling you to determine data concentration across your map.

- **Proportional Symbol (Bubble).** A map that represents coordinates, such as an address or intersection, using symbols of different sizes to represent any measure. These maps focus on specific areas, for which data concentrations may vary. When the data concentration is larger, the bubble will be bigger.

In addition, built-in zooming capabilities allow you to drill down to a specific geographic area of focus easily. This allows you to get a closer look at regional or local data, draw inferences, and make recommendations, without changing the initial view of your data.

Using the Esri integration in WebFOCUS Designer, you can also add the following layers to your map:

- **Base map.** Display a layer that positions data as it is located, in context to other geographical features, such as streets, terrain, and imagery. Some standard Background options may combine road, aerial, and topographic data using a variety of symbols. Hosted on ArcGIS, you can change your background at any time, to review your data in a different context.

  When you apply a Background to your map, its appearance changes. You can then adjust the view of your data, showing different terrain or geographical views. Base maps provide at least 17 levels of zoom. For more information, see [https://developers.arcgis.com/javascript/jsapi/esri.basemaps-amd.html](https://developers.arcgis.com/javascript/jsapi/esri.basemaps-amd.html).

  The basemap options include:

  - Light Gray Canvas Map
  - Dark Gray Canvas Map
Reference Layers. Display a layer of boundaries and locations that range from a continental scale to country, state, and even local neighborhood. For example, if you are viewing World data on electricity usage, you may want to add a Reference Layer that displays the borders and concentration of your data within each country.

Demographic Layers. Display a layer of information about people and businesses in a specific demographic area. This includes the United States and 120 other countries. Demographic Layers are thematic maps that provide additional information about the location, such as spending habits, population, and lifestyles. You can add Demographic Layers to a map about sales data, to identify new locations for stores, based on the spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the map. Layers is a menu that appears on the map and provides access to options that allow you to adjust the information that is being displayed.
The map example in the following image shows the use of layers.

![Map Example](image)

**Note:** Backgrounds, Demographic Layers, and Reference Layers can be accessed from the Format tab. These layers are static, standard options that Esri provides for use with WebFOCUS Designer, and do not change based on the data source that you select.

**TIBCO WebFOCUS Server Adapter for Esri ArcGIS Configuration for Demographic Layers**

In order for demographic layers to draw, you must configure the WebFOCUS Server to enable them. Some features, such as demographic and reference layers that require authentication and certain simplified geography functions, may additionally require a refresh token. You can acquire the refresh token using your Esri ArcGIS credentials.

**Procedure:**  **How to Configure the Adapter for Esri ArcGIS to Enable Demographic Layers to Draw**

1. From the plus menu of the WebFOCUS Hub, or from the WebFOCUS Home Page, click *Get Data*.

2. On the Get Data page, double-click *New Data Source*.

3. From the list of adapters, double-click *ESRI ArcGIS*.

   The Add Connection for Esri ArcGIS panel opens.

   **Note:** To find the Esri ArcGIS adapter option more easily, select GIS from the Available drop-down list, or use the search box.

4. Basic connection parameters for this adapter are supplied automatically. To access secured Esri ArcGIS features that require named authentication, configure the Adapter for Esri ArcGIS with a refresh token.
Click Get Refresh Token. The Esri ArcGIS Sign In page opens. Type your username and password and then click Sign In.

You are returned to the Add Connection panel.

5. In the Add Connection for Esri ArcGIS panel, click Configure, as shown in the following image.

Once this is configured, ESRI ArcGIS is added to the Get Data page.

**Configuring an Esri On Premise Environment**

The Esri On Premise functionality enables you to download and access mapping files through the use of a local Application Programming Interface (API). Once you download and configure the API, you do not need an internet connection to utilize the robust mapping features that Esri provides. For information on downloading and configuring the API that controls this feature, see *How to Download and Configure the ArcGIS JavaScript API* on page 419.
The Esri On Premise functionality provides you with local access to Esri mapping files. This is particularly useful if you are away from your office or without an internet connection. You may also be using a mobile device, such as an iPad or smartphone with a large screen, without an internet connection. The following mapping components are supported when using the Esri On Premise functionality:

- **Offline Basemaps.** Basemaps are an offering from ArcGIS. Standard basemaps are provided for your use offline. For example, there is an Oceans basemap and a Terrain with Labels basemap. These basemaps are also known as backgrounds. In an online setting, there are 10 basemaps available. In order to use offline basemaps you need to use a tiled mapservice published in the ArcGIS Server.

- **Offline Geographic Roles.** Geographic Roles are used to visualize measures with commonly known dimensions (for example, Country, State, Cities, and so on). These provide the location information often in the form of (x/y) needed to plot on a map. Geographic roles are pre-defined for online users through ArcGIS Online. A geographic role defines the geographic component that you can select when creating a map (for example, State or Continent). For an offline user, the options that display can be customized in the geoservices.xml file. For more information, see *Adding a Custom Geographic Role* on page 454.

**Note:** Demographic Layers are not supported in an Esri On Premise environment.

**Procedure:** **How to Download and Configure the ArcGIS JavaScript API**

You can use this procedure to download and configure the API that controls the Esri On Premise environment.

1. Sign in to Esri ArcGIS.
2. In your browser, navigate to the following URL to download the API: https://developers.arcgis.com/downloads/#javascript
3. Navigate to Version 3.28 of the ArcGIS API for JavaScript, as shown in the following image.
4. Click *arcgis_js_v328_api.zip* to download the API.
5. In *drive:\ibi\WebFOCUSnn\config\web_resource /qibm/userdata/qwebqry/base80/config/web_resource*, create a folder named *arcgis_api*.
6. Open the arcgis_js_v328_api.zip file downloaded in step 4 and navigate to arcgis_js_v328_api\arcgis_js_api\library\3.28\3.28.

7. Extract the files in that folder to the drive:\ibi\WebFOCUSnn\config\web_resource \arcgis_api folder /qibm/userdata/qwebqry/base80/config/web_resource/arcgis_api folder.

8. Next, verify the path to the API in the Administration Console, as shown in the following image.

**Note:** This is the path to which you extracted the API files. For example, /web_resource/arcgis_api.

This field identifies the path to the internal ArcGIS Javascript API Source that develops ESRI-based maps. This setting is blank, by default, indicating that the use of the internal API source to develop ESRI maps is not activated. The API that is referenced is https://js.arcgis.com/3.28/, by default. To direct WebFOCUS Designer to use the internal ArcGIS Javascript API to develop ESRI maps, enter the path to the local API files that you extracted into this setting. For more information, see the WebFOCUS Security and Administration manual.

**Note:** This path should be a relative path that is accessible within the local install.

9. Click Save.

10. Next, open the following two local API files in a text editor:

    - drive:\ibi\WebFOCUSnn\config\web_resource\arcgis_api\init.js
    - drive:\ibi\WebFOCUSnn\config\web_resource\arcgis_api\dojo\dojo.js
    - /qibm/userdata/qwebqry/base80/config/web_resource/arcgis_api\init.js
    - /qibm/userdata/qwebqry/base80/config/web_resource/arcgis_api\dojo\dojo.js
In both files, search for HOSTNAME_AND_PATH_TO_JSAPI to locate the baseUrl property. Replace the string [HOSTNAME_AND_PATH_TO_JSAPI] in baseUrl:"https://[HOSTNAME_AND_PATH_TO_JSAPI]dojo" with the path to your on-premise ArcGIS server. For example:

baseUrl:"https://localhost/arcgis/jsapi/jsapi/dojo"

11. In the Administration Console, click Clear Cache to clear the browser cache. Your configuration is complete.

Creating and Customizing Maps in TIBCO WebFOCUS Designer

The following procedures provide step-by-step instructions on how to create and customize maps.

As you create your maps, you can use the following built-in map viewer features:

- You can use the plus (+) and minus (-) symbols, +, within the map to zoom in and out of different areas of the map. You can also click your left mouse button to zoom in to a specific location.

- Like all HTML5 visualizations, the highlighted markers and regions on a map support drill, multi-drill, auto-linking, and informational tooltip features.

- You can use the Pan / Selection button to alternate between the Pan and Selection controls. This option is in the upper-right corner of the map.

- Creating a map chart using the US Zipcode 5 Georole with more than 2000 polygons will fail to draw.

Procedure: How to Create an Esri Choropleth Map

**Note:** The default option of creating a map utilizes the ArcGIS JavaScript API that Esri provides.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select the Choropleth map chart type.
A blank map displays and the Location bucket is enabled, as shown in the following image.

4. Add a Geolocation field to the Location bucket.

   This field, which already has a geographic role assigned, is denoted with a Location icon, 🌍, in the Resources panel.

   The canvas refreshes, and your map displays.

5. Before saving your map, to add insight, you can also do the following:

   - Click Run in new window, to see a run-time view of your map.
   - Add a measure or dimension to the Color bucket, to color your chart by that underlying data value. When you add a dimension field to the Color bucket, a legend displays for the values in that field. Note that each area in a choropleth map can only display one color at a time, so it may be preferable to use a dimension for which each geographic area will return a single value. If you specify a measure in the Color bucket, a color scale is generated.
   - Add a field to the Tooltip bucket, which will display tooltip information when you place your mouse over an area of the map.
   - Add a Base map, Demographic Layer, or Reference Layer from the Format tab, under Map options.
6. Click Save to save your map.

**Procedure:** How to Create an Esri Proportional Symbol (Bubble) Map

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select Proportional Symbol for the map type.

A blank map displays and the Location bucket is enabled.

4. Place a data field with a defined geographic role in the Location bucket.

This field, which already has a geographic role assigned, is denoted with a Location icon, in the Resource panel.

A basic bubble map displays, as shown in the following image.

5. Before saving your map, to add insight, you can also do the following:

- Click Run in new window, to see a run-time view of your map.
Add a measure or dimension to the Color bucket to color your chart by that underlying data value. Adding a dimension creates a legend with a different color assigned to each value. Adding a measure generates a color scale.

Add a measure to the Size bucket, to control the size of the bubbles on your map.

Add a field to the Tooltip bucket, to display tooltip information when you place your mouse over an area of the map at run time.

Add a Resources Panel, Demographic Layer, or Reference Layer from the Format tab, under Map options.

6. Click Save to save your map.

Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map.
2. On the Format tab, on the Map options tab, select Base map and choose from the available options, as shown in the following image.

3. Select one of the following options:
   - World Street Map
   - Terrain with Labels
   - Oceans Basemap
Creating Charts

- OpenStreetMap
- World Imagery
- World Imagery with Labels
- Light Gray Canvas
- National Geographic World Map
- Dark Gray Canvas
- None

**Note:** The Imagery with Labels Background provides the terrain for your map, ranging from land contours to city streets.

Once you make a selection, the background of the map refreshes. You can continue to change your background until it displays the desired information.

**Procedure:** How to Add Demographic Layers to a Map

1. Create a new map or open an existing map.
2. On the Format tab, in the Map options group, click the Demographic layer drop-down and click Demographic Layers.
3. Select from various population and lifestyle groups, as shown in the following image.

Note: These are pre-defined demographic profiles, provided by Esri ArcGIS. Esri periodically retires older demographic layers.

You can select multiple options in either category to gain additional insight into your data. Specifically, each Demographic Layer has its own profile and provides a layering option, when comparing values across different layers or profiles.

4. Click OK.
The Demographic Layers that you select are applied to your map. The map engine displays the different groups with unique hues and coloring. You can use the Table of Contents or Layers option, to toggle between the different layers that you have specified. The Layers option is shown in the following image.

![Layers](image)

**Note:** You can select and clear the check boxes to enable the display of one or more Demographic Layers to compare and contrast the different demographic scenarios.

**Procedure:** How to Add Reference Layers to a Map

1. Create a new map or open an existing map.
2. On the Format tab, in the Map options group, click the drop-down for Reference layer.
The list of Reference Layers displays, as shown in the following image.
3. Select one or more Reference Layers, such as World Countries, to add to your map, and then click **OK**.

Your map refreshes, and the definitions and borders of the References Layers display on the canvas. You can use the Table of Contents or Layers option, to toggle different Reference Layers in your map. These options are shown in the following image.

![Reference Layers](image)

**Reference:** **Query Buckets by Map Type**

This section presents the Query buckets that display, by map type.

<table>
<thead>
<tr>
<th>Query bucket</th>
<th>Choropleth Map</th>
<th>Proportional Symbol Map</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Location.</strong> One data field, specifically a field containing location data (for example, State).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Color.</strong> One data field.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Geographic Roles

Geographic roles have been unified to access 58 world administrative boundaries down to the postal code level, out of the box. You can access administrative boundaries for approximately 250 countries with a second level license, which is a paid service from Esri. Enter your second level license code by clicking the License button on the ribbon.

**Note:** Geographic roles are only available with Esri maps.

This section contains information on the geographic roles that are supported for Esri maps.

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTINENT</td>
<td>World Continents</td>
<td>Choropleth, Proportional</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>World Countries</td>
<td>Choropleth, Proportional</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>STATE</td>
<td>World Admin Divisions</td>
<td>Choropleth, Proportional</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>CITY</td>
<td>World Cities</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>COUNTY</td>
<td>World Counties</td>
<td>Choropleth, Proportional</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>POSTAL-CODE</td>
<td>Postal Code</td>
<td>Choropleth, Proportional</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
</tbody>
</table>
**Note:** This is a new, simplified list of geographic roles (dimensions) that you can utilize when creating a map chart. This unified list of roles provides worldwide mapping of administrative boundaries down to the postal code level. In WebFOCUS Designer, the new roles display, by default, when assigning a geographic role.

The following table illustrates the geographic roles and their dependencies. Level 1 indicates the highest level of hierarchy and level 5 is the lowest level of hierarchy.

<table>
<thead>
<tr>
<th>Region</th>
<th>Hierarchy Level</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>World</td>
<td>1</td>
<td>CONTINENT</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>STATE</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

**Procedure:** How to Access Second Level Licensed Geographies for Esri Maps

1. Click **Workspace** on the Reporting Server Web Console sidebar.
2. Click **License** on the ribbon.
   
The License Management pane opens, as shown in the following image.

3. Enter your Esri second level license code in the `license_2nd_level_maps` field.
4. Click *Save and Restart Server*.

Once the second level license is enabled, you can use the standard administrative and postal geographic roles to access these additional geographic boundaries.

**Note:** The server must be configured for Unicode if Unicode characters exist in the data.

**Reference:** List of Geographic Locations

The WebFOCUS Server Console provides a list of first and second level map administrative regions. To open the list, select Server Workspaces from the Management Center on the start pageHub, click the *Settings* menu on the Workspace page ribbon, point to Geo Services, and select *General maps info*. This opens the list of administrative regions and postal levels, as shown in the following image.

### Data Services Agents — General maps info

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Maps License</th>
<th>Delegate Country Source</th>
<th>Delegate State Source</th>
<th>Delegate County Source</th>
<th>Delegate City Source</th>
<th>Delegate Postal Code Source</th>
<th>Country 0-2 ZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afghanistan</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Algeria</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>AP</td>
</tr>
<tr>
<td>Algeria</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Algeria</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>American Samoa</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Argentina</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Argentina</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Armenia</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Armenia</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Australia</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Australia</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Austria</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Austria</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Australia</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Australia</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Austria</td>
<td>Paid</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
<tr>
<td>Austria</td>
<td>Free</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>ESRI world map</td>
<td>None</td>
</tr>
</tbody>
</table>

The regions that say *Paid* in the Maps license column are the additional regions you can access with a second level license.

- The source for the country administrative level is provided by the Esri World map. Country is administrative level 0.

- The source for the State georole can be provided by the Esri World map or by shape files. When there is a second level license, the state administrative level can be level 1 or level 2.
The source for the County georole can be provided by the Esri World map or by shape files. When there is a second level license, the county administrative level can be level 3 or level 4.

The source for the City georole can be provided by the Esri World map or by shape files. When there is a second level license, the city administrative level is level 5.

The source for the Postal Code georole can be provided by the Esri World map or by shape files. When there is a second level license, the postal code administrative level can be 3, 4, or 5.

Some georoles may not be applicable to specific countries. You can see the details of each country and its administrative levels by right-clicking the country name and clicking *Drill to administrative levels* or *Drill to postal levels*, as shown in the following image.

<table>
<thead>
<tr>
<th>Country name</th>
<th>Maps license</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afghanistan</td>
<td>Free</td>
</tr>
<tr>
<td>Afghanistan</td>
<td>Paid</td>
</tr>
<tr>
<td>Albania</td>
<td>Free</td>
</tr>
<tr>
<td>Algeria</td>
<td>Drill to administrative levels</td>
</tr>
<tr>
<td>Algeria</td>
<td>Drill to postal levels</td>
</tr>
</tbody>
</table>
Clicking *Drill to administrative levels* opens the list of States for the country, as shown in the following image.

![List of states for country 'Albania'](image)

Clicking any link opens information about the next level georole.
Clicking Drill to postal levels opens the list of postal levels for the country, as shown in the following image.

<table>
<thead>
<tr>
<th>Data Services Agents</th>
<th>General maps info</th>
<th>Result</th>
</tr>
</thead>
</table>

List of postal codes for country 'Albania'
(Source: MB postal layer 3 Extended)

<table>
<thead>
<tr>
<th>POSTAL-CODE (POSTCODE3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>33</td>
</tr>
<tr>
<td>34</td>
</tr>
<tr>
<td>35</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>43</td>
</tr>
</tbody>
</table>

Right-clicking a link in any georole column other than the Country column opens a summary of the values for that georole, as shown in the following image.

<table>
<thead>
<tr>
<th>Statistics of states for country 'Albania'</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Source: MB admin layer 1 Extended)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of names</th>
<th>First name</th>
<th>Last name</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Berat</td>
<td>Vlorë</td>
</tr>
</tbody>
</table>
Administrative Boundaries for Level 1 Countries

Administrative boundaries for the United States are automatically included by Esri.

The following table lists the Level 1 countries and their Level 1 and Level 2 administrative levels for available world countries and territories. For some countries, no additional administrative levels are added with a second level license.

<table>
<thead>
<tr>
<th>Country</th>
<th>Postal Code</th>
<th>Level 1 Administrative Level (Number of Values)</th>
<th>Level 2 Administrative Level (Number of Values)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Albania</td>
<td>2 - digit</td>
<td>Qarke (12)</td>
<td>Bashkia (61)</td>
</tr>
<tr>
<td>Andorra</td>
<td>5 - digit</td>
<td>Parroquies (7)</td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td>5 - digit</td>
<td>Departamentos (525)</td>
<td></td>
</tr>
<tr>
<td>Australia</td>
<td>4 - digit</td>
<td>Local Government Areas (569)</td>
<td></td>
</tr>
<tr>
<td>Austria</td>
<td>4 - digit</td>
<td>Gemeinden (2120)</td>
<td></td>
</tr>
<tr>
<td>Belarus</td>
<td>6 - digit</td>
<td>Woblaszi (7)</td>
<td>Raioni (129)</td>
</tr>
<tr>
<td>Belgium</td>
<td>4 - digit</td>
<td>Gemeinden (2120)</td>
<td></td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>5 - digit</td>
<td>Kantone (18)</td>
<td>Opstine (142)</td>
</tr>
<tr>
<td>Brazil</td>
<td>5 - digit</td>
<td>Municipios (5565)</td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>3 - digit</td>
<td>Census Divisions (293)</td>
<td>Census Subdivisions (5243)</td>
</tr>
<tr>
<td>Chile</td>
<td>2 - digit</td>
<td>Provincias (54)</td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>2 - digit</td>
<td>Counties City Districts (2855)</td>
<td></td>
</tr>
<tr>
<td>Costa Rica</td>
<td>2 - digit</td>
<td>Cantones (81)</td>
<td>Distritos (473)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level (Number of Values)</td>
<td>Level 2 Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Croatia</td>
<td>2 - digit</td>
<td>Zupanije (21)</td>
<td>Opchine (556)</td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cyprus</td>
<td>2 - digit</td>
<td>Eparchia (6)</td>
<td>Dimoi (615)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Czech Republic</td>
<td>2 - digit</td>
<td>Orp (206)</td>
<td>Obce (6253)</td>
</tr>
<tr>
<td></td>
<td>6-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Denmark</td>
<td>4 - digit</td>
<td>Kommunen (99)</td>
<td></td>
</tr>
<tr>
<td>Estonia</td>
<td>5 - digit</td>
<td>Maakonnad (15)</td>
<td>Vallad (213)</td>
</tr>
<tr>
<td>Finland</td>
<td>5 - digit</td>
<td>Seutukunnat (70)</td>
<td>Kunnat (317)</td>
</tr>
<tr>
<td>France</td>
<td>5 - digit</td>
<td>Cantons (1972)</td>
<td>Communes (36571)</td>
</tr>
<tr>
<td>Germany</td>
<td>5 - digit</td>
<td>Municipalities</td>
<td></td>
</tr>
<tr>
<td>Gibraltar</td>
<td>3/4/5 - digit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Greece</td>
<td>5 - digit</td>
<td>Nomoi (75)</td>
<td>Dimoi (326)</td>
</tr>
<tr>
<td>Holy See (Vatican City State)</td>
<td>5 - digit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>6 - digit</td>
<td>Shih Zizhiu (18)</td>
<td></td>
</tr>
<tr>
<td>Hungary</td>
<td>2 - digit</td>
<td>Kistersegek (175)</td>
<td>Telepulesek (3177)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level (Number of Values)</td>
<td>Level 2 Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Iceland</td>
<td>2 - digit</td>
<td>Landsvaedi (8)</td>
<td>Sveitarfelog (74)</td>
</tr>
<tr>
<td></td>
<td>3-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India</td>
<td>6 - digit</td>
<td>Districts (640)</td>
<td>Subdistricts (5783)</td>
</tr>
<tr>
<td>Italy</td>
<td>5 - digit</td>
<td>Provincias (110)</td>
<td>Comuni (8047)</td>
</tr>
<tr>
<td>Japan</td>
<td>3 - digit</td>
<td>Prefectures (47)</td>
<td>Municipalities (1901)</td>
</tr>
<tr>
<td>Kenya</td>
<td>1 - digit</td>
<td>Wilaya (47)</td>
<td>Districts (158)</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>3 - digit</td>
<td>Si Gun (230)</td>
<td></td>
</tr>
<tr>
<td>Latvia</td>
<td>2 - digit</td>
<td>Rajons (33)</td>
<td>Novadi (119)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>4 - digit</td>
<td>Landschaften (2)</td>
<td>Gemeinden (11)</td>
</tr>
<tr>
<td>Lithuania</td>
<td>2 - digit</td>
<td>Apskritys (10)</td>
<td>Savivaldybes (60)</td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luxembourg</td>
<td>4 - digit</td>
<td>Cantons (12)</td>
<td>Communes (105)</td>
</tr>
<tr>
<td>Macedonia, the former Yugoslav Republic of</td>
<td>2 - digit</td>
<td>Statisticki Regioni (8)</td>
<td>Opstini (80)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malta</td>
<td>3 - digit</td>
<td>Districts (6)</td>
<td>Local Councils (68)</td>
</tr>
<tr>
<td>Mexico</td>
<td>3 - digit</td>
<td>Estados (32)</td>
<td></td>
</tr>
<tr>
<td>Monaco</td>
<td>5 - digit</td>
<td>Quartiers (9)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Level 1 Administrative Level (Number of Values)</td>
<td>Level 2 Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Montenegro</td>
<td>2 - digit</td>
<td>Opstina (21)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netherlands</td>
<td>4 - digit</td>
<td>Gemeenten (380)</td>
<td></td>
</tr>
<tr>
<td>New Zealand</td>
<td>4 - digit</td>
<td>Territorial Authorities (68)</td>
<td>Area Units (1911)</td>
</tr>
<tr>
<td>Norway</td>
<td>4 - digit</td>
<td>Okonomisk regioner (89)</td>
<td>Kommuner (428)</td>
</tr>
<tr>
<td>Poland</td>
<td>5 - digit</td>
<td>Gminy (2479)</td>
<td>Gminy Miasta (3119)</td>
</tr>
<tr>
<td>Portugal</td>
<td>4 - digit</td>
<td>Concelhos (308)</td>
<td>Freguesias (3092)</td>
</tr>
<tr>
<td>San Marino</td>
<td>5 - digit</td>
<td>Castelli (9)</td>
<td></td>
</tr>
<tr>
<td>Serbia</td>
<td>5 - digit</td>
<td>National (1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5-digit (1156) for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>2 - digit</td>
<td>Regions (5)</td>
<td>Planning Areas (55)</td>
</tr>
<tr>
<td>Slovakia</td>
<td>2 - digit</td>
<td>Okresy (79)</td>
<td>Obce (2927)</td>
</tr>
<tr>
<td></td>
<td>6-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slovenia</td>
<td>2 - digit</td>
<td>Statisticne Regije (12)</td>
<td>Obcina (212)</td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South Africa</td>
<td>2-digit</td>
<td>Municipalities (234)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-digit for 2nd level license</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Administrative Boundaries for Level 2 Countries

The following table lists countries that are accessible only with a second level license.

<table>
<thead>
<tr>
<th>Country</th>
<th>Postal Code</th>
<th>Level 1 Administrative Level</th>
<th>Level 2 Administrative Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(Number of Values)</td>
<td>(Number of Values)</td>
</tr>
<tr>
<td>Spain</td>
<td>5 - digit</td>
<td>Provincias (52)</td>
<td>Municipios (8122)</td>
</tr>
<tr>
<td>Sweden</td>
<td>5 - digit</td>
<td>Kommuner (290)</td>
<td></td>
</tr>
<tr>
<td>Switzerland</td>
<td>4 - digit</td>
<td>Gemeinden (2225)</td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>3 - digit</td>
<td>Township Districts (368)</td>
<td></td>
</tr>
<tr>
<td>Turkey</td>
<td>5 - digit</td>
<td>Iller (81)</td>
<td>Ilceler (970)</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>4 - digit</td>
<td>Districts (391)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Bahamas</td>
<td></td>
<td>Islands (19)</td>
<td>Districts (32)</td>
</tr>
<tr>
<td>Bahrain</td>
<td>2-digit</td>
<td>Muhafazat (5)</td>
<td></td>
</tr>
<tr>
<td>Bangladesh</td>
<td>2-digit</td>
<td>Zila (64)</td>
<td>Upazila (553)</td>
</tr>
<tr>
<td>Barbados</td>
<td></td>
<td>Parishes (11)</td>
<td></td>
</tr>
<tr>
<td>Belize</td>
<td></td>
<td>Districts (6)</td>
<td>Constituencies (31)</td>
</tr>
<tr>
<td>Benin</td>
<td></td>
<td>Departements (12)</td>
<td>Communes (77)</td>
</tr>
<tr>
<td>Bermuda</td>
<td>4-digit</td>
<td>Parishes (11)</td>
<td></td>
</tr>
<tr>
<td>Bhutan</td>
<td>2-digit</td>
<td>Dzongkhags (20)</td>
<td></td>
</tr>
<tr>
<td>Bolivia, Plurinational State of</td>
<td></td>
<td>Departamentos (9)</td>
<td>Provincias (112)</td>
</tr>
<tr>
<td>Botswana</td>
<td></td>
<td>Districts (9)</td>
<td>Sub-Districts (28)</td>
</tr>
<tr>
<td>British Virgin Islands</td>
<td></td>
<td>National (1)</td>
<td>Electoral Districts (9)</td>
</tr>
<tr>
<td>Brunei Darussalam</td>
<td>2-digit</td>
<td>Daerah (4)</td>
<td>Mukim (38)</td>
</tr>
<tr>
<td>Burkina Faso</td>
<td></td>
<td>Regions (13)</td>
<td>Provinces (45)</td>
</tr>
<tr>
<td>Burundi</td>
<td></td>
<td>Provinces (17)</td>
<td>Communes (129)</td>
</tr>
<tr>
<td>Cambodia</td>
<td></td>
<td>Khaet (25)</td>
<td></td>
</tr>
<tr>
<td>Cameroon</td>
<td></td>
<td>Regions (10)</td>
<td>Departements (58)</td>
</tr>
<tr>
<td>Cape Verde</td>
<td>2-digit</td>
<td>Concelhos (22)</td>
<td>Freguesias (32)</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>8-digit</td>
<td>Districts (6)</td>
<td></td>
</tr>
<tr>
<td>Central African Republic</td>
<td></td>
<td>Prefectures (17)</td>
<td>Sous-Prefectures (51)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Chad</td>
<td></td>
<td>National (1)</td>
<td></td>
</tr>
<tr>
<td>Colombia</td>
<td>2-digit</td>
<td>Departamentos (33)</td>
<td>Municipios (1122)</td>
</tr>
<tr>
<td>Comoros</td>
<td></td>
<td>Islands (3)</td>
<td></td>
</tr>
<tr>
<td>Congo</td>
<td></td>
<td>Departements (12)</td>
<td></td>
</tr>
<tr>
<td>Congo, the Democratic Republic of the</td>
<td></td>
<td>Districts (48)</td>
<td>Territoires (188)</td>
</tr>
<tr>
<td>Côte d'Ivoire</td>
<td></td>
<td>Regions (32)</td>
<td>Departements (95)</td>
</tr>
<tr>
<td>Cuba</td>
<td></td>
<td>Provincias (16)</td>
<td>Municipios (168)</td>
</tr>
<tr>
<td>Djibouti</td>
<td></td>
<td>Regions (6)</td>
<td></td>
</tr>
<tr>
<td>Dominica</td>
<td></td>
<td>Parishes (10)</td>
<td></td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>5-digit</td>
<td>Provincias (32)</td>
<td>Municipios (155)</td>
</tr>
<tr>
<td>Ecuador</td>
<td>6-digit</td>
<td>Cantones (224)</td>
<td>Parroquias (1040)</td>
</tr>
<tr>
<td>Egypt</td>
<td>2-digit</td>
<td>States (27)</td>
<td></td>
</tr>
<tr>
<td>El Salvador</td>
<td>7-digit</td>
<td>Departamentos (14)</td>
<td>Municipios (262)</td>
</tr>
<tr>
<td>Equatorial Guinea</td>
<td></td>
<td>Regions (2)</td>
<td>Provinces (7)</td>
</tr>
<tr>
<td>Eritrea</td>
<td></td>
<td>Zobas (6)</td>
<td>Subzobas (52)</td>
</tr>
<tr>
<td>Ethiopia</td>
<td></td>
<td>Kililoch (11)</td>
<td>Awrajja (85)</td>
</tr>
<tr>
<td>Faroe Islands</td>
<td>3-digit</td>
<td>Syslur (6)</td>
<td>Kommunun (30)</td>
</tr>
<tr>
<td>Fiji</td>
<td></td>
<td>Provinces (15)</td>
<td></td>
</tr>
<tr>
<td>French Guiana</td>
<td>5-digit</td>
<td>Cantons (14)</td>
<td>Communes (22)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level</td>
<td>Lowest Administrative Level</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>French Polynesia</td>
<td>5-digit</td>
<td>Iles (5)</td>
<td>Communes (48)</td>
</tr>
<tr>
<td>French Southern Territories</td>
<td></td>
<td>Districts (4)</td>
<td></td>
</tr>
<tr>
<td>Gabon</td>
<td></td>
<td>Provinces (9)</td>
<td></td>
</tr>
<tr>
<td>Gambia</td>
<td></td>
<td>Local Government Areas (8)</td>
<td></td>
</tr>
<tr>
<td>Georgia</td>
<td></td>
<td>Regions (12)</td>
<td>Rajone (77)</td>
</tr>
<tr>
<td>Ghana</td>
<td></td>
<td>Regions (10)</td>
<td>Districts (216)</td>
</tr>
<tr>
<td>Greenland</td>
<td>4-digit</td>
<td>Kommuner (6)</td>
<td></td>
</tr>
<tr>
<td>Grenada</td>
<td></td>
<td>Parishes (7)</td>
<td></td>
</tr>
<tr>
<td>Guadeloupe</td>
<td>5-digit</td>
<td>Cantons (28)</td>
<td>Communes (32)</td>
</tr>
<tr>
<td>Guam</td>
<td>5-digit</td>
<td>County Subdivisions (19)</td>
<td></td>
</tr>
<tr>
<td>Guatemala</td>
<td>5-digit</td>
<td>Departamentos (22)</td>
<td>Municipios (334)</td>
</tr>
<tr>
<td>Guernsey</td>
<td>5-digit</td>
<td>Parishes (15)</td>
<td></td>
</tr>
<tr>
<td>Guinea</td>
<td></td>
<td>Regions (8)</td>
<td>Prefectures (34)</td>
</tr>
<tr>
<td>Guinea-Bissau</td>
<td>4-digit</td>
<td>Regioes (9)</td>
<td>Sectores (38)</td>
</tr>
<tr>
<td>Guyana</td>
<td></td>
<td>Regions (10)</td>
<td></td>
</tr>
<tr>
<td>Haiti</td>
<td></td>
<td>Arrondissements (42)</td>
<td>Communes (140)</td>
</tr>
<tr>
<td>Honduras</td>
<td>2-digit</td>
<td>Departamentos (18)</td>
<td>Municipios (298)</td>
</tr>
<tr>
<td>Indonesia</td>
<td>3-digit</td>
<td>States (34)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Iran, Islamic Republic of</td>
<td>1-digit</td>
<td>Provinces (31)</td>
<td>Subprovinces (397)</td>
</tr>
<tr>
<td>Iraq</td>
<td></td>
<td>Muhafazat (18)</td>
<td>Kaza (109)</td>
</tr>
<tr>
<td>Ireland</td>
<td></td>
<td>Counties (34)</td>
<td>Electoral Divisions (3441)</td>
</tr>
<tr>
<td>Isle of Man</td>
<td>5-digit</td>
<td>Shedadings (6)</td>
<td>Districts (24)</td>
</tr>
<tr>
<td>Israel</td>
<td>2-digit</td>
<td>States (6)</td>
<td></td>
</tr>
<tr>
<td>Jamaica</td>
<td></td>
<td>Parishes (14)</td>
<td>Constituencies (62)</td>
</tr>
<tr>
<td>Jersey</td>
<td>5-digit</td>
<td>Parishes (12)</td>
<td></td>
</tr>
<tr>
<td>Jordan</td>
<td>5-digit</td>
<td>Muhafazat (12)</td>
<td>Nahia (51)</td>
</tr>
<tr>
<td>Kazakhstan</td>
<td>4-digit</td>
<td>Oblystar (16)</td>
<td>Audandar (209)</td>
</tr>
<tr>
<td>Korea, Democratic People's Republic of</td>
<td></td>
<td>Do (14)</td>
<td></td>
</tr>
<tr>
<td>Kosovo</td>
<td>2-digit</td>
<td>Obstina (38)</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td>2-digit</td>
<td>Muhafazat (6)</td>
<td>Localities (137)</td>
</tr>
<tr>
<td>Kyrgyzstan</td>
<td>4-digit</td>
<td>Oblasttar (9)</td>
<td>Rajondor (46)</td>
</tr>
<tr>
<td>Lao People's Democratic Republic</td>
<td></td>
<td>Khoueng (17)</td>
<td>Muang (142)</td>
</tr>
<tr>
<td>Lebanon</td>
<td></td>
<td>Muhafazat (6)</td>
<td>Caza (26)</td>
</tr>
<tr>
<td>Lesotho</td>
<td></td>
<td>Districts (10)</td>
<td></td>
</tr>
<tr>
<td>Liberia</td>
<td></td>
<td>Counties (15)</td>
<td></td>
</tr>
<tr>
<td>Libyan Arab Jamahiriya</td>
<td></td>
<td>Schabiyat (22)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Macao</td>
<td>6-digit</td>
<td>Parishes (8)</td>
<td></td>
</tr>
<tr>
<td>Madagascar</td>
<td>3-digit</td>
<td>Regions (22)</td>
<td>Districts (114)</td>
</tr>
<tr>
<td>Malawi</td>
<td></td>
<td>Regions (3)</td>
<td>Districts (30)</td>
</tr>
<tr>
<td>Malaysia</td>
<td>2-digit</td>
<td>Negeri (16)</td>
<td>Daerah (144)</td>
</tr>
<tr>
<td>Maldives</td>
<td>2-digit</td>
<td>Atolls (20)</td>
<td></td>
</tr>
<tr>
<td>Mali</td>
<td></td>
<td>Regions (9)</td>
<td>Cercles (50)</td>
</tr>
<tr>
<td>Marshall Islands</td>
<td>3-digit</td>
<td>Municipalities (34)</td>
<td></td>
</tr>
<tr>
<td>Martinique</td>
<td>5-digit</td>
<td>Arrondissements (4)</td>
<td>Communes (34)</td>
</tr>
<tr>
<td>Mauritania</td>
<td></td>
<td>Wilayas (13)</td>
<td>Moughataas (53)</td>
</tr>
<tr>
<td>Mauritius</td>
<td></td>
<td>Districts (10)</td>
<td></td>
</tr>
<tr>
<td>Mayotte</td>
<td></td>
<td>Commununes (17)</td>
<td></td>
</tr>
<tr>
<td>Micronesia, Federated States of</td>
<td>5-digit</td>
<td>States (4)</td>
<td></td>
</tr>
<tr>
<td>Moldova, Republic of</td>
<td>4-digit</td>
<td>Raioane (37)</td>
<td></td>
</tr>
<tr>
<td>Mongolia</td>
<td>4-digit</td>
<td>Aimag (22)</td>
<td>Sums (338)</td>
</tr>
<tr>
<td>Montserrat</td>
<td></td>
<td>Parishes (3)</td>
<td></td>
</tr>
<tr>
<td>Morocco</td>
<td>2-digit</td>
<td>Regions (16)</td>
<td>Provinces (75)</td>
</tr>
<tr>
<td>Mozambique</td>
<td>2-digit</td>
<td>Provincias (11)</td>
<td>Distritos (142)</td>
</tr>
<tr>
<td>Myanmar</td>
<td></td>
<td>States and Divisions (15)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Namibia</td>
<td></td>
<td>Regions (13)</td>
<td>Constituencies (119)</td>
</tr>
<tr>
<td>Nauru</td>
<td></td>
<td>Districts (14)</td>
<td></td>
</tr>
<tr>
<td>Nepal</td>
<td></td>
<td>Zones (14)</td>
<td>Districts (75)</td>
</tr>
<tr>
<td>New Caledonia</td>
<td>5-digit</td>
<td>Provinces (3)</td>
<td>Communes (34)</td>
</tr>
<tr>
<td>Nicaragua</td>
<td></td>
<td>Departamentos (17)</td>
<td>Municipios (153)</td>
</tr>
<tr>
<td>Niger</td>
<td></td>
<td>Regions (8)</td>
<td></td>
</tr>
<tr>
<td>Nigeria</td>
<td></td>
<td>States (37)</td>
<td>Local Government Areas (774)</td>
</tr>
<tr>
<td>Northern Mariana Islands</td>
<td>5-digit</td>
<td>Municipalities (4)</td>
<td></td>
</tr>
<tr>
<td>Oman</td>
<td>1-digit</td>
<td>Muhafazat (11)</td>
<td>Wilayat (61)</td>
</tr>
<tr>
<td>Pakistan</td>
<td>2-digit</td>
<td>Provinces (8)</td>
<td>Districts (146)</td>
</tr>
<tr>
<td>Palau</td>
<td>5-digit</td>
<td>States (16)</td>
<td></td>
</tr>
<tr>
<td>Palestinian Territory, Occupied</td>
<td></td>
<td>Territories (2)</td>
<td>Muhafazat (16)</td>
</tr>
<tr>
<td>Panama</td>
<td></td>
<td>Provincias (12)</td>
<td>Distritos (76)</td>
</tr>
<tr>
<td>Papua New Guinea</td>
<td></td>
<td>Provinces (22)</td>
<td>Districts (87)</td>
</tr>
<tr>
<td>Paraguay</td>
<td></td>
<td>Departamentos (18)</td>
<td>Distritos (251)</td>
</tr>
<tr>
<td>Peru</td>
<td>2-digit</td>
<td>Provincias (195)</td>
<td>Distritos (1834)</td>
</tr>
<tr>
<td>Philippines</td>
<td>4-digit</td>
<td>Provinces (87)</td>
<td>Municipalities and Cities (1634)</td>
</tr>
<tr>
<td>Pitcairn</td>
<td>8-digit</td>
<td>Islands (4)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>5-digit</td>
<td>Municipios (78)</td>
<td>County Subdivisions (902)</td>
</tr>
<tr>
<td>Qatar</td>
<td></td>
<td>Municipalities (7)</td>
<td>Zones (90)</td>
</tr>
<tr>
<td>Republic of South Sudan</td>
<td></td>
<td>States (10)</td>
<td></td>
</tr>
<tr>
<td>Réunion</td>
<td>5-digit</td>
<td>Arrondissements (4)</td>
<td>Communes (24)</td>
</tr>
<tr>
<td>Romania</td>
<td>6 - digit</td>
<td>Judete (42)</td>
<td>Comune (3181)</td>
</tr>
<tr>
<td>Russian Federation</td>
<td>4-digit</td>
<td>Federal Subjects (80)</td>
<td>Raioni (2345)</td>
</tr>
<tr>
<td>Rwanda</td>
<td></td>
<td>Provinces (5)</td>
<td>Districts (30)</td>
</tr>
<tr>
<td>Saint Kitts and Nevis</td>
<td></td>
<td>States (2)</td>
<td>Parishes (14)</td>
</tr>
<tr>
<td>Saint Lucia</td>
<td></td>
<td></td>
<td>Quarters (10)</td>
</tr>
<tr>
<td>Saint Vincent and the Grenadines</td>
<td>4-digit</td>
<td>Parishes (6)</td>
<td></td>
</tr>
<tr>
<td>Samoa</td>
<td>3-digit</td>
<td>Regions (4)</td>
<td>Districts (43)</td>
</tr>
<tr>
<td>Sao Tome and Principe</td>
<td></td>
<td>Province (2)</td>
<td>Distritos (7)</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>2-digit</td>
<td>States (13)</td>
<td></td>
</tr>
<tr>
<td>Senegal</td>
<td></td>
<td>Regions (14)</td>
<td></td>
</tr>
<tr>
<td>Seychelles</td>
<td></td>
<td>Districts (25)</td>
<td></td>
</tr>
<tr>
<td>Sierra Leone</td>
<td></td>
<td>Provinces (4)</td>
<td>Districts (14)</td>
</tr>
<tr>
<td>Solomon Islands</td>
<td></td>
<td>Provinces (10)</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>South Sudan</td>
<td>2-digit</td>
<td>States (10)</td>
<td></td>
</tr>
<tr>
<td>Sri Lanka</td>
<td>2-digit</td>
<td>Districts (25)</td>
<td>DS-Divisions (331)</td>
</tr>
<tr>
<td>Sudan</td>
<td>2-digit</td>
<td>States (15)</td>
<td></td>
</tr>
<tr>
<td>Suriname</td>
<td></td>
<td>Districten (10)</td>
<td>Ressorten (62)</td>
</tr>
<tr>
<td>Svalbard and Jan Mayen (IE)</td>
<td></td>
<td>Counties (34)</td>
<td>Electoral Divisions (3441)</td>
</tr>
<tr>
<td>Svalbard and Jan Mayen (SJ)</td>
<td>4-digit</td>
<td>National (1)</td>
<td>Kommuner (4)</td>
</tr>
<tr>
<td>Swaziland</td>
<td>1-digit</td>
<td>Districts (4)</td>
<td></td>
</tr>
<tr>
<td>Syrian Arab Republic</td>
<td></td>
<td>Muhafazat (14)</td>
<td>Manatiq (61)</td>
</tr>
<tr>
<td>Tajikistan</td>
<td></td>
<td>Regions (5)</td>
<td>Raioni (64)</td>
</tr>
<tr>
<td>Tanzania, United Republic of</td>
<td></td>
<td>Mkoa (30)</td>
<td>Wilayah (169)</td>
</tr>
<tr>
<td>Thailand</td>
<td>2-digit</td>
<td>Changwate (77)</td>
<td>Amphoe (928)</td>
</tr>
<tr>
<td>Timor-Leste</td>
<td></td>
<td>Districts (13)</td>
<td>Subdistricts (65)</td>
</tr>
<tr>
<td>Togo</td>
<td></td>
<td>Regions (5)</td>
<td></td>
</tr>
<tr>
<td>Tokelau</td>
<td></td>
<td>Atolls (3)</td>
<td></td>
</tr>
<tr>
<td>Tonga</td>
<td></td>
<td>Island Divisions (5)</td>
<td></td>
</tr>
<tr>
<td>Trinidad and Tobago</td>
<td></td>
<td>Municipalities (15)</td>
<td></td>
</tr>
<tr>
<td>Tunisia</td>
<td>4-digit</td>
<td>Wilayat (24)</td>
<td></td>
</tr>
<tr>
<td>Turkmenistan</td>
<td>3-digit</td>
<td>Welayat (6)</td>
<td>Etraplar (65)</td>
</tr>
<tr>
<td>Country</td>
<td>Postal Code</td>
<td>Highest Administrative Level (Number of Values)</td>
<td>Lowest Administrative Level (Number of Values)</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Turks and Caicos Islands</td>
<td>8-digit</td>
<td>Districts (6)</td>
<td>Localities (38)</td>
</tr>
<tr>
<td>Tuvalu</td>
<td></td>
<td>Islands (9)</td>
<td></td>
</tr>
<tr>
<td>Uganda</td>
<td></td>
<td>Consolidated Districts (75)</td>
<td>Counties (110)</td>
</tr>
<tr>
<td>Ukraine</td>
<td>3-digit</td>
<td>Obstina (38)</td>
<td></td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td></td>
<td>States (7)</td>
<td></td>
</tr>
<tr>
<td>United States Minor Outlying Islands</td>
<td></td>
<td>Islands (5)</td>
<td></td>
</tr>
<tr>
<td>United States Virgin Islands</td>
<td>5-digit</td>
<td>National (1)</td>
<td>Islands (3)</td>
</tr>
<tr>
<td>Uruguay</td>
<td>5-digit</td>
<td>Secciones (232)</td>
<td>Segmentos (4301)</td>
</tr>
<tr>
<td>Uzbekistan</td>
<td>4-digit</td>
<td>Viloyati (14)</td>
<td>Tuman (171)</td>
</tr>
<tr>
<td>Vanuatu</td>
<td></td>
<td>Provinces (6)</td>
<td></td>
</tr>
<tr>
<td>Venezuela, Bolivarian Republic of</td>
<td>2-digit</td>
<td>Estados (25)</td>
<td>Municipios (367)</td>
</tr>
<tr>
<td>Viet Nam</td>
<td>2-digit</td>
<td>Provinces (63)</td>
<td>Districts (698)</td>
</tr>
<tr>
<td>Wallis and Futuna</td>
<td>5-digit</td>
<td>Kingdoms (3)</td>
<td></td>
</tr>
<tr>
<td>Yemen</td>
<td></td>
<td>Muhafazat (21)</td>
<td>Muderiah (333)</td>
</tr>
<tr>
<td>Zambia</td>
<td>5-digit</td>
<td>Provinces (10)</td>
<td>Districts (103)</td>
</tr>
<tr>
<td>Zimbabwe</td>
<td></td>
<td>Provinces (10)</td>
<td>Districts (91)</td>
</tr>
</tbody>
</table>
**Example:** Using a Second Level License to Map French Postal Codes

The request used in this example references data about French state names, city names, and postal codes. This data is readily available online. The data in this example was downloaded from [https://www.aggdata.com/free/france-postal-codes](https://www.aggdata.com/free/france-postal-codes) which is available for free using a Creative Commons Attribution 4.0 license detailed at [https://creativecommons.org/licenses/by/4.0/](https://creativecommons.org/licenses/by/4.0/). Once you download the data, you can upload it to the server to create the data file and synonym for use in requests. This example assumes that the data and synonym are in the ibisamp application on the server.

**Note:** Information Builders takes no responsibility for the accuracy or continued existence of this data on this site. It is being used only as an example of the detailed administrative boundaries available with a second level license.

The Master File for the uploaded data follows. The Master File generated by the upload procedure was edited to change the first field name to COUNTRY and to remove the folder declarations.

```plaintext
FILENAME=FR_POSTAL_CODES, SUFFIX=DFIX    ,
DATASET=ibisamp/fr_postal_codes.ftm (LRECL 1140 RECFM V, BV_NAMESPACE=OFF, $
SEGMENT=FR_POSTAL_CODES, SEGTYPE=S0, $
  FIELDDNAME=COUNTRY, ALIAS=E01, USAGE=A50V, ACTUAL=A50V,
    TITLE='Country for State',
    GEOGRAPHIC_ROLE=COUNTRY, $
  FIELDDNAME=STATE, ALIAS=E02, USAGE=A21V, ACTUAL=A21V,
    MISSING=ON,
    TITLE='State',
    GEOGRAPHIC_ROLE=STATE, $
  FIELDDNAME=COUNTY, ALIAS=E03, USAGE=A25V, ACTUAL=A25V,
    MISSING=ON,
    TITLE='County',
    GEOGRAPHIC_ROLE=COUNTY, $
  FIELDDNAME=CITY, ALIAS=E04, USAGE=A48V, ACTUAL=A48V,
    MISSING=ON,
    TITLE='City',
    GEOGRAPHIC_ROLE=CITY, $
  FIELDDNAME=POSTAL_CODE, ALIAS=E05, USAGE=A16V, ACTUAL=A16V,
    MISSING=ON,
    TITLE='Postal Code',
    GEOGRAPHIC_ROLE=POSTAL-CODE, $
  FIELDDNAME=PLACE_NAME, ALIAS=E06, USAGE=A56V, ACTUAL=A56V,
    MISSING=ON,
    TITLE='Place Name', $
  FIELDDNAME=GEO_POINT, ALIAS=E07, USAGE=A150, ACTUAL=A150,
    TITLE='GIS Point',
    GEOGRAPHIC_ROLE=GEOMETRY_POINT, $
```
The Access File for the uploaded data follows.

```
SEGNAME=FR_POSTAL_CODES,
    DELIMITER=',',
    CDN=COMMAS_DOT,
    CONNECTION=<local>, $
```

The following WebFOCUS Procedure generates a choropleth map that shows the postal codes from the uploaded data source. The DEFINE field is used to assign different numeric values to each field. When used in the Color bucket, this DEFINE field makes it easier to differentiate the different postal code areas.
DEFINE FILE fr_postal_codes
FOURTH_CHAR/I1 ( TITLE = 'Fourth, Character' ) =
  SUBSTRING(FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE, 4, 1);
END

SET COMPONENT=TableChart_1
SET ARVERSION=2
-DEFAULT &WF_TITLE='WebFOCUS Report';

GRAPH FILE fr_postal_codes
SUM FOURTH_CHAR
BY FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET VZERO OFF
ON GRAPH SET GRWIDTH 1
ON GRAPH SET HAXIS 1008.0
ON GRAPH SET VAXIS 768.0
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET EMBEDHEADING ON
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/WFC/Global/Themes/Standard/Default/theme.sty,$
TYPE=REPORT, TITLETEXT='Chart1', ORIENTATION=LANDSCAPE,
ARREPORTSIZE=DIMENSION,
  ARFILTER_TARGET='*', CHART-LOOK=com.esri.map, ARGRAPHENGINE=JSCHART, $
TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_SCRIPT

*GRAPH_JS_FINAL
"extensions": {
  "com.esri.map": {
    "overlayLayers": [
      {
        "ibiDataLayer": {
          "map-metadata": {
            "map-by-field": "FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE"
          }
        }
      },
      {
        "ibiBaseLayer": "dark-gray"
      }
    ],
    "baseMapInfo": {
      "customBaseMaps": [
        {
          "ibiBaseLayer": "dark-gray"
        }
      ]
    }
  }
}
*END
ENDSTYLE
END
When you run this procedure, the map displays postal codes in France, as shown in the following image.

Adding a Custom Geographic Role

The GEO configuration editor in the WebFOCUS Reporting Server provides a tool for editing or adding properties for geographic roles.
On the WebFOCUS Hub, from the Management Center, click Server Workspaces to access the WebFOCUS Reporting Server Workspace area. Alternatively, from the WebFOCUS Home Page, click the Settings menu and click WebFOCUS Server. When the WebFOCUS Reporting Server browser interface opens, open the Tools menu and click Workspace. The Workspace area opens.

In the Reporting Server Workspace area click Settings, point to Geo Services, then click Edit Configuration. The GEO configuration editor opens displaying the configured geographic roles, as shown in the following image.

![GEO configuration editor](image)

Reference: **Editing the List of Geographic Roles**

The following standard unified geographic roles are configured by default and cannot be changed. These geographic roles create a hierarchy that can be used to drill down or up between levels of administration in maps, reports, or charts.

- CONTINENT.
- COUNTRY.
- STATE.
- COUNTY.
- CITY.
- POSTAL CODE.

To add a geographic role to the configuration, you can add a new Esri map or a shapefile hosted by the Server and associate a geographic role with the new map. You can also implement NUTS geographic roles support.
Note: Some users may not be able to run maps with custom geographic roles when the default reporting server security configuration is in place. To allow a user to run content with custom geographic roles, on the Access Control page of the Reporting Server browser interface, right-click the role that the user privileges are based on and click Directory/File Privileges, then enable both the Execute and List privileges for geo_services_user.xml.

Configuring Properties of Geographic Roles

The following describes columns for geographic roles in the configuration editor.

name

Is the unique name of the geographic role. It cannot have spaces, but it can have underscores (_).

Next to the name is an indicator of whether the role is a standard role or a customized role.

title

Is the description of the geographic role that is displayed in reports and in drop-down lists in the WebFOCUS tools.

returned_geometry

Is the type of geographic data returned from the map service for rendering on the map.

Valid values include:

- GEOMETRY_AREA
- GEOMETRY_POINT
- GEOMETRY_LINE

When you have configured the properties, click OK to return to the Geo Configuration Editor. The new role will display on the list of roles, click Save to save it in the geographic configuration.

Adding a New Role for an Esri Map

To add an Esri geographic role, click Add ESRI map on the Geographic Configuration Editor.
The *Create a new ESRI map role* dialog box opens, as shown in the following image.

Configure the following map service properties.

**name**

Is a name for the geographic role.

**title**

Is a title to display in the WebFOCUS tools.

**returned_geography**

Select the type of geometry that is returned from the map service for this role. Valid values are:

- **GEOMETRY_AREA.** Returns JSON polygon definitions.
- **GEOMETRY_LINE.** Returns JSON line definitions.
- **GEOMETRY_POINT.** Returns a JSON point.
**url**

Is the URL to the map service that provides the geographic data.

Click Verify after entering the URL to verify that the map service is available by going to the specified URL.

**Service Parameters**

Add as parameters any additional geographic roles needed to identify the exact location of the new role. For example, a city name needs state and country parameters.

**Example:** Adding the WebFOCUS Regions Geographic Role

The following properties add the WebFOCUS Regions role to the configuration.

![Edit geography role REGION](image)

**Note:** The parameter name corresponds to the field name in the FeatureLayer referenced in the following URL:

http://services7.arcgis.com/L95Ww9OjRQ0tjAs/ArcGIS/rest/services/wfretail_sub_regions/FeatureServer/0

Click OK when you have finished configuring the properties.
The new role is added to the configuration as a customized role, as shown in the following image.

Click Save to save this role to the configuration.
The following request uses the WebFOCUS Regions geographic role in a map request.

```
DEFINE FILE WF_RETAIL_LITE

REGION/A50 (GEOGRAPHIC_ROLE=REGION) = BUSINESS_SUB_REGION;

END

GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
BY REGION
WHERE COUNTRY_NAME EQ 'United States'
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET STYLE *
TYPE=REPORT, CHART-LOOK=com.esri.map, $ TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_JS_FINAL
"extensions": {
  "com.esri.map": {
    "overlayLayers": [
      {
        "ibiDataLayer": {
          "map-metadata": {
            "map_by_field": "REGION"}
        }
      }
    ]
  }
}
"baseMapInfo": {
  "customBaseMaps": [
    {
      "ibiBaseLayer": "gray"
    }
  ]
}
*END
ENDSTYLE
END
```
Adding a New Role for a Server-Hosted Map

A server-hosted map is based on a shapefile. You must upload the shapefile (.dbf) to an application folder accessible to the server. The server will transform it to ibijjson format.

An ESRI shape file is actually a collection of at least four files:

- **.dbf file.** The .dbf file is a standard database file used to store attribute data and object IDs. A .dbf file is mandatory for shape files.

- **.shp file.** The .shp file is a mandatory Esri file that gives features their geometry. Every shapefile has its own .shp file that represents spatial vector data.

- **.shx file.** The .shx file is a mandatory Esri shape index position file. This type of file is used to search forward and backwards.

- **.prj file.** The .prj file is an optional file that contains the metadata associated with the shapefiles coordinate and projection system.

All files must have exactly the same name and to be located in the same directory. If they are not, the shapefile conversion will fail.

When there are several possible keys associated with a geometry, a drop down list of detected key names will be displayed. Select any one of these fields. No selection required when there is a single geometry key.

The shapefile should only be in the GCS_WGS_1984 - World Geodetic System 1984 (decimal degrees) coordinate system.
To add a geographic role for a Server-hosted map, click *Add WFRS map* on the Geographic Configuration Editor.

The *Add WFRS hosted map* dialog box opens, as shown in the following image.

Configure the following properties.

**role name**

Is a name for the geographic role.

**Geometry type**

Select either POLYGON or POINT from the drop-down list.

**Esri shape**

Enter the name of the application directory where the shapefile resides, or click the ellipsis (...) to navigate to the application directory. Then select the .dbf file for the role.

**Load to app**

Enter the name of the application directory where you want to place the ibijson file, or click the ellipsis (...) to navigate to the application directory.

**Quantization type**

Quantization is the process of transforming a large set of input values to a smaller set of values. When transforming the shapefile, the server will quantize points that are too close together in order to optimize map rendering performance. Two methods are available for quantization, LINEAR or GRID. The default is LINEAR.

**Quantization_X**

Is the threshold value for the x-axis.
Quantization_Y

Is the threshold value for the y-axis.

If the map has multiple keys, a drop-down list displays so that you can select one.

Click OK when you have finished configuring the properties.

The new role is added to the configuration as a customized role, as shown in the following image.

Click Save to save this role to the configuration.

You can test the role by right-clicking the role in the configuration editor and clicking Test. A sample map will be generated, as shown in the following image.
Adding NUTS Support

Nomenclature of territorial units for statistics (NUTS) are geographic roles specific to the European Union.

To add NUTS geographic roles to the configuration, click Add NUTS support on the Geographic Configuration Editor.

The NUTS geographic roles are added, as shown in the following image.

Click Save to save these roles to the configuration.

Adding Support for Extended Postal Codes

Click Add extended postal codes to add support for Level 1 and Level 2 postal codes used in certain countries.

Customizing Vocabulary Rules

For each geographic role, a set of vocabulary rules define how to recognize when a field name should automatically be assigned to that role. If you right-click a role, you can click Customize vocabulary from the shortcut menu.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).
A word may be prefixed and/or suffixed with the percent character (%), which is a placeholder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that word must not be found in the column name.

For example, the following are the vocabulary rules for the role COUNTRY.

To add another rule, click *Add optional*.

When you are finished, click *OK*.

Click *Save* to save these rules to the configuration.

*Reference:* Customizing the List of Basemaps

You can edit an existing basemap definition or add a custom basemap.

**Using Standard Basemaps**

To add a new basemap or customize an existing basemap, select *Basemap* from the Object drop-down list.
Configuring Basemap Properties

The following is a description of the properties used for basemap configuration.

**name**

Is the name of the basemap.

Next to the name is an indicator of whether the basemap is a standard basemap or a customized basemap.

**icon**

Is the name of the thumbnail for the basemap (for a standard basemap) or the URL to the thumbnail (for a customized basemap) that will appear on the Basemap drop-down list in the WebFOCUS tools (for example, the Base map menu in WebFOCUS Designer) or the Change Basemap map widget.

**title**

Is a title to display on the Basemap drop-down list in the WebFOCUS tools or the Change Basemap map widget.

**url**

Is the URL to the map service that provides the basemap, for a customized basemap. The map service URL can be copied from the URL field on the page showing a custom basemap. For a standard basemap, the URL is already stored in the server geographic configuration file and is not displayed.

**type**

Valid values are tiled and vector.

**addon_json**

Specifies additional JSON properties for rendering the map.

Editing the Properties of a Basemap

To customize the properties of an existing basemap, right-click the basemap line and click *Customize BASEMAP*. 
The Customize Basemap dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URL, you can click Verify to make sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor Basemaps page.

**Adding a Custom Basemap**

To add a new basemap to the configuration, click Add.
The Create a BASEMAP dialog box opens, as shown in the following image.

Enter a name for the basemap, a URL to the thumbnail, a title to display, and the URL to the map service that provides the basemap, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO configuration editor Basemap page.

**Reference:** Customizing the List of Context Layers

To add a new context layer or customize an existing context layer, select ContextLayer from the Object drop-down list.
The following image shows the GEO configuration editor with the ContextLayer object selected.

### Configuring Context Layer Properties
Following is a description of the properties used for context layer configuration.

**name**

Is the name of the context layer.

Next to the name is an indicator of whether the context layer is a standard context layer or a customized context layer.

**authorization**

Is the type of authentication needed to access this context layer. Valid values are:

- **silent.** Credentials for your ArcGIS application are provided in the connection string of the Adapter for Esri ArcGIS.

  **Note:** For instructions for configuring the Adapter for Esri ArcGIS, see the Adapter Administration manual.

- **none.** No authorization is needed.

- **named.** User credentials are provided in the connection string of the Adapter for Esri.

- **on premises.** User credentials for a locally hosted ArcGIS server are provided in the connection string of the Adapter for Esri.
layer type

Is the type of context layer. For a cached layer, the layer type is tile. For a layer that is rendered dynamically, the layer type is featurelayer.

title

Is a title to display on the demographic layer drop-down list in the WebFOCUS tools.

addon_json

Specifies additional JSON properties needed for rendering the context layer. For example, smartMapping properties define the border styles within the context layer.

Depending on the type of context layer, the addon_json properties may resemble the following:

```
"layerObjectType" : "esri/layers/ArcGISDynamicMapServiceLayer",
  "smartMapping": { "webMapInfo": { 
    "queryString" : "id:id",
    "itemDataUrl" : "url",
    "layerTypeEx" : "layerType"
  } }
```

where:

- **esri/layers/ArcGISDynamicMapServiceLayer**
  
  Defines the context layer as a dynamic map service.

- **id**
  
  Is the ID of the context layer on Esri ArcGIS. This can be found in the URL for the layer on the Esri ArcGIS site, or as the value of the "serviceItemld" property in the JSON properties accessible from the service URL of the layer.

  If there is no layer ID, then this property can be omitted.

- **url**
  
  Is the map service URL for the layer. This should match the value that you provide for the uri field.

- **layerType**
  
  Is an optional value to specify the type of context layer. It can be one of the following values:

- **group.** Identifies the context layer as a group layer composed of multiple feature layers. For more information, see [https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-GroupLayer.html](https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-GroupLayer.html).
- **map-image.** Identifies the context layer as a map image layer, which can contain multiple sub-layers rendered as images rather than features. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-MapImageLayer.html.

- **feature.** Identifies the context layer as a feature layer, which is a single layer created from a map service or feature service. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-FeatureLayer.html.

- **imagery-tile.** Identifies the context layer as an imagery tile layer, created from a tiled image service. For more information see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-ImageryTileLayer.html.

- **imagery.** Identifies the context layer as an imagery layer, created from an image service. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-ImageryLayer.html.

- **elevation.** Identifies the context layer as an elevation layer used in a 3D SceneView. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-ElevationLayer.html.

- **tile.** Identifies the context layer as a tile layer, created from a cached map service. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-TileLayer.html.

- **web-map.** Identifies a complete, two-dimensional WebMap. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-WebMap.html.

- **web-scene.** Identifies a complete, 3D web scene. For more information, see https://developers.arcgis.com/javascript/latest/api-reference/esri-WebScene.html.

If your context layer is neither a group layer nor a map image layer, the layerTypeEx property is not needed.

For example, the add-on JSON for a map image layer may resemble the following:

```json
"layerObjectType" : "esri/layers/ArcGISTiledMapServiceLayer",
"smartMapping": { "webMapInfo": {  
"queryString" : "id:1234567890abcdefghij1234567890ab",
"itemDataUrl" : "https://services5.arcgis.com/1234567890abcdef/arcgis/rest/services/Layer_Name/FeatureServer",
"layerTypeEx" : "map-image"
} }
```
uri

Is the URL to the map service that provides the context layer.

Customizing the Properties of an Existing Context Layer

To customize the properties of an existing context layer, click the down arrow next to a context layer name or right-click the context layer line and click Customize context layer.

The Customize CONTEXTLAYER dialog box opens, as shown in the following image.

![Screenshot of Customize CONTEXTLAYER dialog box]

Edit the properties you want to change. If you change the URI, you can click Verify to make sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor Context Layers page.

Adding a New Context Layer

To add a new context layer to the configuration, click Add.
Enter a name for the context layer, the authorization type, a layer type, a title to display, any additional JSON needed for rendering the context layer, and the URI to the map service that provides the context layer, and click *Verify*.

When you have configured the properties, click *OK*, then click Save on the GEO configuration editor Context Layer page.
Using Your Extension in a TIBCO WebFOCUS Request

If you have installed and configured your extension as described, your extension will be available for use in the WebFOCUS tools as a chart type in the Other format category under HTML5 Extension, as shown in the following image.
When creating a chart using WebFOCUS, chart extensions are available in the Custom category when you expand the content picker, as shown in the following image.

The attribute categories you defined in the dataBuckets object of your extension are available in the Query pane in InfoAssist or Display panel in WebFOCUS.
Additionally, in WebFOCUS, the properties defined in the propertyAnnotations object are available on the Format tab, in the Other section, when General is selected in the Quick Access menu. Clicking Extension properties opens the Extension properties panel, where you can make changes to the available properties, as shown in the following image, which shows properties for the liquid gauge chart extension.

The following syntax is added in the FOCEXEC:

- The LOOKGRAPH value is EXTENSION.
- The actual extension to use is identified in the chartType property of the *GRAPH_JS block in the StyleSheet. For example, for a liquid gauge chart:
Each custom attribute category name is prepended with a greater-than character (>). For example, for a simple bar chart that has one label field and four value fields:

```plaintext
TYPE=DATA, COLUMN=N1, BUCKET= >labels, $
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
TYPE=DATA, COLUMN=N3, BUCKET= >value, $
TYPE=DATA, COLUMN=N4, BUCKET= >value, $
TYPE=DATA, COLUMN=N5, BUCKET= >value, $
```

Extension chart properties are listed under the extensions:`extension_name` object. For example, for a liquid gauge chart with the number of waves set to 3 and the wave color set to a shade of dark blue, the properties appear as follows:

```json
"extensions": {
    "com.ibi.liquid_gauge": {
        "waveCount": 3,
        "waveColor": "#083f9e"
    }
}
```

The following is a sample request using the liquid gauge extension.

```plaintext
GRAPH FILE wf_retail_lite
SUM PCT.WF_RETAIL_LITE.WF_RETAIL_SALES.QUANTITY_SOLD
BY WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.BUSINESS_REGION
WHERE_GROUPED WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.BUSINESS_REGION EQ ©North_America©
ON GRAPH PCHOLD FORMAT JSCART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
*GRAPH_JS_FINAL
"chartType": "com.ibi.liquid_gauge",
"extensions": {
    "com.ibi.liquid_gauge": {
        "waveCount": 3,
        "waveColor": "#083f9e"
    }
}
*END
ENDSTYLE
END
```
Configuring the Automatic Refresh Option for Charts

WebFOCUS Designer allows you to integrate real-time streaming data with your charts using the Automatic refresh option. For example, for IoT analytics applications, if you configured a connection to a streaming data source using the Kafka adapter, the Automatic refresh option can be enabled to update your chart dynamically at a specified interval (in seconds). Depending on your specific use case or requirements, you can configure multiple charts using the Automatic refresh option and add them to assembled pages. Each chart will refresh independently with updated data based on the specified refresh rate.

Considerations

As of WebFOCUS Designer 8207, the Automatic refresh option is supported for all chart types, except for maps (for example, Proportional Symbol and Choropleth maps). The Automatic refresh option is not available for reports in WebFOCUS Designer. In addition, this option is not included in InfoAssist. Automatic refresh is only supported for stand-alone charts. If you convert the chart to a page, a warning appears, alerting you that automatic refresh will not be carried over.

Procedure: How to Enable and Configure the Automatic Refresh Option for a Chart

1. Create a new chart in WebFOCUS Designer. To best utilize the automatic refresh feature, use a streaming data source, such as one using the Kafka adapter.
2. Choose a chart type from the content picker, as shown in the following image.

3. Add measures and dimensions according to your requirements by dragging them onto the canvas.

   **Note:** You can also double-click a measure or dimension to add it to the relevant bucket or drag it into the relevant bucket.

4. Apply any required formatting or styling to your chart (for example, adding a header or footer).
5. To turn on automatic refresh, on the Settings tab, expand the Content section. Select the *Enable auto-refresh* check box, as shown in the following image.

6. By default, the refresh interval is set to 120 seconds. Use the spinner or type a value to specify the refresh rate in seconds, which is the period of time to wait until the chart polls the corresponding data source to reflect any updated data.
   
   **Note:** You can specify a maximum value of 120 seconds (two minutes) as the refresh rate.

7. Click **OK**.
   
   You can continue to build and modify your chart as required.

8. When you are finished, click **Save** on the Visualization toolbar to save your chart.

9. To test and verify that your chart is being refreshed correctly, locate it on the Hub, right-click it and select **Run** from the context menu.

   Observe your chart while it is running and make a note of any adjustments that should be made. For example, if the chart is being refreshed too quickly, then you should consider increasing the number of seconds specified for the Automatic refresh option.

**Procedure:** **How to Disable the Automatic Refresh Option for a Chart**

To disable the Automatic refresh option:

1. Open a visualization that uses automatic refresh. On the WebFOCUS Hub, right-click a visualization and click **Edit**.

   The selected visualization opens in WebFOCUS Designer.

2. On the Settings tab, expand the Content section.

3. Clear the *Enable auto-refresh* check box.

4. Save your content. When it is run, your content no longer refreshes automatically.
Using Insight to Analyze Dynamic Charts

Insight is a visualization tool that allows for the interactive selection of measures and dimensions, so you can create dynamic charts that refresh as you make changes.

With Insight, you can review and analyze a chart that shows the data fields that you choose in real time. It even rebuilds as you select additional fields or specify filters.

You can make quick decisions regarding your data with Insight. Using logical menus and simple filtering, you can analyze charts interactively to suit your needs. As you select additional fields and create filters, your chart refreshes instantly, letting you see the results of your data choices as you use the tool.

Insight lets you build filters, as needed, to customize the data that displays. You can add and remove fields, at any time and in any pattern, to enhance your chart. You can take advantage of the customization options that are available to you right from the toolbar.

With Insight, the chart type determines the buckets that display. For example, if you are working with a pie chart, you can specify values for the following buckets: Measure, Rows, Columns, Color, Size, Tooltip, and Animate.

Available fields are organized into applicable Dimension and Measure categories. You can use the plus sign to add additional fields to your chart. For example, if you want to create a bar chart that plots Gross Profit, Revenue, and MSRP for each Product Category, click the plus sign to add fields using the drop-down field selector. Once you choose the fields that you want to include, you can rearrange them by dragging and dropping them into the order that you prefer.

The resulting bar chart displays, as shown in the following image.
**Note:** The Save icon only displays when running an existing Insight chart from the WebFOCUS Hub or Home Page.

You can use the navigational arrows in the interactive header to move between the available buckets in your chart. The following image highlights these arrows, which shift the focus of these buckets to the right or left.

All charts support a bucket for Color, which adds contrast to your chart. Some charts also support the Size bucket, which binds a measure to the size of the markers rendered on the chart.

Once you have added fields to the relevant buckets, you can use the Sort arrows adjacent to each field to sort the data in ascending or descending order. This helps identify trends and priorities within your data. You can only sort one field at a time. Ascending order sorts your data from the smallest value to the greatest value, while descending order sorts your data from the greatest value to the smallest value, as shown in the following image.

When you select a sort order for a field, the field arrow changes color, appearing bolder than the unsorted fields. In the image below, a sort order was selected for MSRP, so the field arrow appears black.
Specify measures and dimensions for your chart in WebFOCUS Designer before using Insight. This pre-loads the Insight user interface (UI) with those selections. Optionally, you can use Insight without selecting any fields. In this case, the field selection options are broad, meaning that all fields will be presented. An example of an empty canvas is shown in the following image.

Insight can be enabled for stand-alone charts, and you can access Insight functionality when these charts are run on their own or as part of an assembled visualization. When added to an assembled visualization, Insight-enabled charts display an icon that you can click to access Insight features. If you convert an Insight-enabled chart to a page with new content, a warning appears, alerting you that Insight functionality will not be carried over.

**Procedure:** How to Enable Insight From WebFOCUS Designer

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Optionally, change the chart type and add fields to the chart.

   Insight can be run with no fields applied, allowing you to create an entirely new chart in Insight.

   **Note:** Insight is not available for reports.

4. On the Settings tab of the Properties panel, expand the Content section and select *Run with Insight*.

5. On the toolbar, click *Run in new window*.

   The chart opens with the Insight toolbar available, and you can begin modifying and analyzing your chart.
Working With Charts in Insight

With Insight, you can choose individual fields for the buckets that you add. Whether you added fields into the buckets before running Insight or left them empty, creating a chart in Insight is streamlined to allow you to easily create a dynamic chart in real time. It also provides you with the flexibility of interactive comparison as you change your data selections rapidly and adjust the options for display.

You can use the default vertical bar chart or you can specify a different chart type using the Chart Picker in the Options toolbar.

In addition, you can reorder the display of fields in your chart. This allows you to change the placement of a particular field, giving you control over where the data for this component displays in your chart.

Procedure: How to Configure a Basic Bar Chart Using Insight

1. Click the plus icon under the Vertical Axis bucket.
2. Choose a measure field from the drop-down list.
3. Click the plus icon under the Horizontal Axis bucket.
4. Choose a dimension field from the drop-down list.

Your bar chart displays, as shown in the following image.

Procedure: How to Change the Chart Type in Insight

1. On the Options toolbar, click Chart Picker.
The table of chart selections opens, as shown in the following image.

**Options**

2. Select a chart type.

Your chart refreshes with the new chart type, and the Insight interface refreshes to display all of the buckets that are relevant to the current chart type.

**Procedure:**  **How to Delete a Field From a bucket**

1. Add one or more fields to your chart.
2. Hover over the field that you want to delete and click X, as shown in the following image.

The chart refreshes to reflect your selections.
**Procedure:** How to Reorder the Display of Fields in a Bucket

1. Add multiple fields to your chart, as shown in the following image.

2. In the Vertical Axis grouping, drag the second bucket into the first position. The placement of the field is shown by a dark blue vertical bar, as shown in the following image.
The following image shows the newly ordered fields.
**Searching for Fields**

You can locate fields for your buckets using the search option. On the toolbar, click the plus sign. In the search field, start typing the field that you want to locate. You can type in whole words or partial words. The search identifies all fields that contain any instance of the characters that you specify, as shown in the following image.

![Search Field Example](image)

**Changing Summary Operators for the Field**

When working with measure fields, you can change the summary operators for the field from Summary (default) to Average, Maximum, or Minimum. You can also change a Count field to Count Distinct, using a similar menu selection.
When you make a selection, the axis of the relevant measure updates in the chart, as shown in the following image.

Options for changing the Summary field are shown in the following image.
Filtering in Insight

To enable filtering, click the Show Filter icon, which is located in the Options section of the toolbar. This opens the filter shelf that renders above the bucket shelf, as shown in the following image.

![Filter shelf image]

Use the filter shelf to build your filter. The filter shelf must be visible in order to add or modify a filter. In addition, constant value filters that were created in a procedure (.fex) or in InfoAssist, as well as all filters created in WebFOCUS Designer, are applied and display on the filter toolbar in Insight. Parameter filters created in InfoAssist, on the other hand, do not display in Insight. When Insight is enabled, prompted filters created in WebFOCUS Designer are always multi-select and optional, because single-select filters and required filters are not available in Insight.
Additionally, query variables are available in Insight and functional on the Filter shelf. Typically, query variables display in the Data pane, above the measure fields. The filter values display as True or False, rather than one and zero. In addition, you can only select one value, as shown in the following image.

### Types of Filters

There are different types of filters in Insight. For example, if you are filtering with a date field, you can use a built-in calendar to select a date range, as shown in the following image.
If you are filtering on a numeric value, such as a measure value, you can filter on values that are specific to a field. In this scenario, when you define the filter, a slider control opens. You can adjust the range of values that you want to include, using the slider control options, as shown in the following image.

![Cost of Goods Filter](image)

You can also filter on dimension values. You can select one or more values by simply clicking on multiple values. A check mark appears, indicating the values selected, as shown in the following image.

![Product Subcategory Filter](image)
You can select all values for the dimension, select one or more, or clear all selected values, as shown in the following image.

![Product Subcategory Selection](image)
Adding a Filter

You add a filter when you want to limit the display of your data, or drill down to focus on specific data values. For example, you may want to just display data for Camcorder and Televisions, rather than all Product Categories. You can do this by adding a filter for the Camcorder and Televisions, as shown in the following image.

![Product Category: Camcorder, Televisions](image)

**Procedure:** How to Add a Filter in Insight

1. In the Options toolbar, click *Show Filter*.
   The filter shelf opens.
2. Click the Show Filter icon.
3. From the drop-down list that opens, select the field on which to filter.
4. Click the identified field in the filter shelf to specify a value for the filter.
   A list displays, showing the values that you can select.
5. Click on the filter shelf to save your filtered items.
   Your chart refreshes.
Removing a Filter

To remove a filter, hover over it and click on the X, as shown in the following image.

The chart refreshes and displays your data without any filter.

Using the Options Toolbar

The Options toolbar is located in the upper-right corner of the Insight interface. These options control your interactions with your data, including options such as pivoting and filtering. You can also change your chart type using the Chart Picker option.

Reference: Options Toolbar Icons

The following section describes the icons that display on the Options toolbar.

- **Reset**
  Returns the chart to its original state. Any filters, measures, dimensions that are added in the current Insight session are reverted. The chart type is reverted, as well.

- **Swap Axis**
  Swaps the x and y axis, placing the contents of the x-axis on the y-axis. You can click Swap Axis again to change the chart back to its original orientation.

- **Save**
  Available when running an Insight-enabled chart from the WebFOCUS Hub or WebFOCUS Home Page. Allows you to save the Insight chart as a new file.
Chart Picker
Provides options for selecting different chart types, including:

- **Horizontal Bar.** Offers the capability of ranking data in descending order. This chart type can also be used when x-axis labels are too long to fit legibly side-by-side. The following buckets are available for this chart type: Vertical Axis, Horizontal Axis, and Color.

- **Vertical Bar.** Shows different measures per dimension component using different identifying colors. The following buckets are available for this chart type: Vertical Axis, Horizontal Axis, and Color.

- **Vertical Stacked Bar.** Stacks values per dimension component using differentiating colors. The following buckets are available for this chart type: Vertical Axis, Horizontal Axis, and Color.

- **Pie.** Presents values as part of a whole using colors to separate the segments. Pie charts emphasize where your data fits in relation to the larger whole. The following buckets are available for this chart type: Rows, Columns, Measure, Color, and Size.

- **Vertical Line.** Creates a line chart which is representative of the data. Line charts are useful for showing trends in numerical data. The following buckets are available for this chart type: Vertical Axis, Horizontal Axis, and Color.

- **Area.** Creates an area chart which is similar to a line chart except the area between the data line and the zero line (or axis) is usually filled with color. The following buckets are available for this chart type: Vertical Axis, Horizontal Axis, and Color.

- **Scatter.** Plots data using variable scales on both axes. The following buckets are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.
Note: When working with Insight Scatter or Bubble Charts, the "Show Datalabels" ability is tied to the Size bucket. Therefore, you will only see datalabels if there is a measure in the Size bucket.

- **Circle.** Plots differing values in rows, enabling you to draw inferences as to how the values overlap. The following buckets are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.

- **Treemap.** Displays large amounts of hierarchically structured data. This chart type uses sections to represent an aspect of the selected measure. The following buckets are available for this chart type: Grouping, Size, and Color.

- **Histogram.** Analyzes the distribution of a measure while assigning it to buckets based on the values you specify for the bins that are created. The default bin count is 10. The following buckets are available for this chart type: Rows, Columns, and Measure.

- **Table.** Presents data in tabular form, allowing you to compare various intersections in your data. The following buckets are available for this chart type: Rows, Columns, and Measure.

- **Matrix.** Analyzes one or two measures against a crosstab of two categorical dimensions. The following buckets are available for this chart type: Rows, Columns, Size, and Color.

- **Point Map.** Uses symbols of different sizes to represent data associated with different areas or locations within the map. The following buckets are available for this chart type: Layer, Size, and Color.

- **Choropleth Map.** Visualizes location-based data, trends, and distributions across a geographic area. These maps are geographically-based heat maps. The following buckets are available for this chart type: Layer and Color.
**Note:** The orientation of this chart icon changes if you swap an axis. In addition, the image that displays for the chart type changes, based on your selection.

*Show Filter*
Defines filters for your data. Select this icon, and using the filter shelf that opens above the bucket shelf, click the Show Filter icon to define a filter.

**Note:** To select one or more non-consecutive values, select each field. The selected values will display with a check mark to indicate that they have been selected.

*More Options*
Opens the following additional options:

- **Export Data.** Exports the underlying data of the current chart to an Excel file in LOCAL file storage. You will be alerted when the file appears in the bottom left corner, similar to any other file that you download.

- **Export Image.** Generates an image of the current chart, which is saved in PNG format to LOCAL file storage using the current width and height of the browser window.

- **Series Layout.** The bar, line, and area charts in Insight support several different sub-graph types (aka *Layout*). The supported graph types include: horizontal bar, vertical bar, vertical stacked bar, line, and area charts. For bar, line, and area charts, the Series Layout Options are as follows:
  - Horizontal Bar: Stacked, Side-by-Side, Absolute, Percent
  - Vertical Bar: Stacked, Side-by-Side, Absolute, Percent
  - Vertical Stacked Bar: Stacked, Side-by-Side, Absolute, Percent
  - Line: Stacked, Side-by-Side, Absolute, Percent
  - Vertical Stacked Area: Stacked, Side-by-Side, Absolute, Percent

- **Y-Axis Log Scale.** Adjusts the log scale on the y-axis. This option is always unchecked, by default. The following chart types are supported:
  - Horizontal Bar
  - Vertical Bar
  - Vertical Stacked Bar
  - Line
Area charts
Scatter charts
Circle
Histogram

X-Axis Log Scale. Adjusts the log scale on the x-axis. This option is always not selected, by default. The following chart types are supported:

Scatter
Bubble

Change Bin Size. Changes the size of the bin (numeric value only). This option is only available for histograms. Clearing the text box switches it back to automatic bin size generation.

Show Data Label. Turns numeric Data labels on/off on all charts, except Grids. The default for this setting is always Off except for Treemaps.

Show Totals. Turns the Summary Row Total on Data Grid on or off. The default for this setting is always False.

Marker Shape. Changes the marker shape used in the matrix marker chart. Options include: Circle, Square, or Fill.

Using Insight in Phone Mode

Phone mode, which is available in Insight, allows you to take advantage of the features of Insight on your phone. The interactive heading that is available in Insight on a tablet or desktop is replaced by a static heading that displays the field names in the chart, in blue text. These become summary fields that allow you to see what fields are included in the chart.

Insight is mobile aware and mobile-friendly. Full functionality is available on tablet devices and other high-resolution touch displays. On smaller devices, such as an iPhone, Insight enters a special phone mode which has a useful, but more limited, set of options and features that are tuned for the small screen real-estate of the device. In this mode, you can add or modify filters to narrow your data as needed. You can also hover over data points to see the underlying data.
Measures are shown first. The first measure displays with a summation attribute (for example, Sum or Avg) and then displays of and then the name of the measure, as shown in the following image.

In the above image, area one is the static heading. Area two marks the filtering side option button. Lastly, area three shows the conbody of the chart.

Numeric measures are displayed after the measures in the order of Y-Axis and then X-axis. If you define fields in your Grouping bucket, they display after the collective measures and are preceded by the word by. If you have created a matrix marker chart, the relevant buckets for these display next. They also use the word by, as do any Detail buckets that are populated in the chart. If your chart specifies a field for color, Phone mode precedes the display of this item with color by. Lastly, if you have populated the Size bucket, this displays last and is introduced by size by.

**User Options in Phone Mode**

You have a number of options in Phone mode, including robust filtering and hover capabilities.
**Filtering**

In Phone mode, you can filter just like in regular desktop mode. The primary difference is that the filter shelf stacks the available filters in a vertical row, as shown in the following image.

You click the filter icon to bring up the filter shelf and then you click the X to close it. If you have defined filters, closing the filter shelf merely collapses it. The filters that you defined remain intact. To remove a filter, hover over it and click the X in the upper-right corner.

**General Usability**

Phone mode allows you to view your chart and filter it to refine it based on your own unique scenario.

You can hover over a data bar a segment of a chart to obtain additional, detailed information from the underlying data. The tooltips that display are based on your data selections.

You can also show and hide the legend using the right arrow above the legend. When you collapse the legend, you can see more of your chart.
The opportunities for dynamic charting are vast with Insight. Using dynamic menus, filtering options, and search features, you can quickly and effectively create charts that communicate your data.

Creating Reports

You can create reports in a visualization in WebFOCUS Designer similar to the way in which you create charts. Reports allow you to communicate information at a high level of detail using a familiar tabular format. You can create a stand-alone report in a visualization, or combine multiple reports in a page.

You can create a report by creating new content in a visualization and changing the content type to a report using the Content picker. The report options in the Content picker are shown in the following image.

Three report layout options are available: a standard, tabbed report in which repeating sort values are only displayed once, a grid in which sort values repeat so that all cells of the report are filled. The third option creates a data grid, which is a type of chart that resembles a tabbed report.
The following image shows a report using the standard report layout.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Sale Year</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>2014</td>
<td>20,152</td>
<td>$5,039,297.57</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>31,396</td>
<td>$7,860,068.93</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>46,735</td>
<td>$11,820,675.96</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>63,836</td>
<td>$16,060,415.69</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>139,977</td>
<td>$35,619,872.81</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>209,571</td>
<td>$53,208,007.57</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2014</td>
<td>17,722</td>
<td>$5,878,431.53</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>28,485</td>
<td>$9,673,248.16</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>41,250</td>
<td>$13,971,708.11</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>56,782</td>
<td>$19,438,607.89</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>123,972</td>
<td>$42,396,539.60</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>187,033</td>
<td>$63,107,166.95</td>
</tr>
</tbody>
</table>

The following image shows a report using the grid layout.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Sale Year</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>2014</td>
<td>20,152</td>
<td>$5,039,297.57</td>
</tr>
<tr>
<td>Accessories</td>
<td>2015</td>
<td>31,396</td>
<td>$7,860,068.93</td>
</tr>
<tr>
<td>Accessories</td>
<td>2016</td>
<td>46,735</td>
<td>$11,820,675.96</td>
</tr>
<tr>
<td>Accessories</td>
<td>2017</td>
<td>63,836</td>
<td>$16,060,415.69</td>
</tr>
<tr>
<td>Accessories</td>
<td>2018</td>
<td>139,977</td>
<td>$35,619,872.81</td>
</tr>
<tr>
<td>Accessories</td>
<td>2019</td>
<td>209,571</td>
<td>$53,208,007.57</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2014</td>
<td>17,722</td>
<td>$5,878,431.53</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2015</td>
<td>28,485</td>
<td>$9,673,248.16</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2016</td>
<td>41,250</td>
<td>$13,971,708.11</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2017</td>
<td>56,782</td>
<td>$19,438,607.89</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2018</td>
<td>123,972</td>
<td>$42,396,539.60</td>
</tr>
<tr>
<td>Camcorder</td>
<td>2019</td>
<td>187,033</td>
<td>$63,107,166.95</td>
</tr>
</tbody>
</table>

To populate the report, select measures and dimensions from the Resources panel with the Fields tab selected from the sidebar. The Resources panel displays the fields that were populated from your data source. You can add fields to your report in the following ways:

- Drag a field from the Fields tab into your content.
- Double-click a field in the Fields tab.
- Drag a field from the Fields tab into a bucket.
- Right-click a field on the Fields tab and click Add to report.

When you add a field to your report, the canvas updates to display the values in it.

You can define the rows and columns in a report by adding fields to the Rows and Column Groups buckets, respectively. Typically, these are dimension fields. The values in these fields are used to sort the report.

You can display aggregated values in a report by adding fields to the Summaries bucket. This bucket is usually used to display values for measure fields. The Summaries bucket displays by default, but you can change the bucket by selecting a different display option. The available display options are shown in the following image.

The Summaries and Counts options provide aggregated measure values for each sort value, that is, each row or column, in the report. The Details and Details with counter display options, on the other hand, provide a complete list of every value for the selected field or fields.
Once you have added fields to the report, you can format it to enhance its appearance or style. For example, you might want to add a header and footer to identify the information on each page of the report, or use a report template to modify the layout. You can also click the Format tab to apply a theme or change the output format of the report and style different areas of the report.

On the Format tab, select an option from the quick access menu on the Format tab to select the area that you want to style. By default, General is selected. Styling changes made here affect the entire report. Other areas that you can style include different columns, totals, and headers and footers. You can select different options to style only the titles or data values in a report, or both, and for certain areas you can select which fields your styling is applied to. You can change the typeface, size, style, alignment, and color of the text in different areas of a report, and the background color and margins of cells.

You can filter a report using prompted or static filters. To create a prompted filter, drag a field from the Fields tab to the Filter toolbar. A menu appears, allowing you to select default filter values. When a report with prompted filters is added to a visualization assembled from existing content, you can create filter controls to allow users to select their own filter values at run time. When creating a report, you can also require user selection for a prompted filter, so that the report does not run until the user makes a filter selection, by right-clicking the filter in the toolbar and clicking Require selection, as shown in the following image.

![Prompted Filter](image)

Static filters, on the other hand, do not allow user selection at run-time. They allow you to apply consistent filters to the report that cannot be modified at run time. To create a static filter, drag a field from the Fields tab to the Filters bucket, then specify filter values in the Add Filter dialog box.
Procedure: How to Create a Report Using WebFOCUS Designer

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select a report layout.

4. Add sort fields to the report by dragging dimension fields from the Fields pane into the Rows and Column Groups buckets.

   Note: You can also double-click a dimension field or drag it onto the canvas to add it to the Rows bucket.

5. Add aggregated data values to the report by dragging measure fields from the Fields pane into the Summaries bucket.

   Note: You can also double-click a measure field or drag it onto the canvas to add it to the Summaries bucket, or other measure bucket if you have changed the display option.

   The report displays the selected fields, based on the bucket they were placed in.

6. The following are some of the options you have to customize the report:

   - Select a theme and apply custom styling options from the Format tab.
   - Change the layout of the report by changing the report template from the Content picker.
   - Filter the report by dragging fields into the Filter toolbar or Filters bucket.
   - Add subtotals, page breaks, or row breaks to the report each time the value in a field changes by right-clicking a field in the Properties panel, pointing to Insert breaks, and selecting an option for each category.
   - Add a header or footer by selecting the header or footer area of the report and typing header or footer text.
   - Enable Auto Drill or Auto Linking, or make the report an Auto Link target, from the Content section of the Settings tab on the Settings/Format panel.
   - Add column or row totals to the report from the Content Settings section under the Setting tab of the Settings/Format panel.
7. To see a run-time view of the report, including behaviors such as Auto Drill or dynamic filtering that are not available in the canvas, click **Run in new window** on the Visualization toolbar.

8. On the WebFOCUS Designer toolbar, click **Save** to save your report to a selected location. Once saved, you can share the report and add it to a page.

   To open the report to edit it again at a later time, locate it on the Hub or Home Page, right-click it, and click **Edit** from the shortcut menu.

**Displaying Measure Values in Reports**

When you add a measure field to a report using the Summaries bucket, the values in that field are aggregated, by default. This means that measure values are evaluated for each sort value in the report. This option is used when the Summaries display option is selected.

By default, the values of fields in the Summaries bucket are aggregated by summing them. You can also aggregate them by average, count, count distinct, percent, percent of count, minimum, maximum, median, and mode values. To use one of these aggregation options, right-click a field in the Summaries bucket, point to **Aggregate**, and select an aggregation.
You can change the display method for measure values from Summaries to Counts, Details, or Details with counter to change how the fields in this bucket are evaluated. These display methods are available from the Calculation Options menu above the buckets on the Display tab, and in the menu next to the measure bucket – the Summaries bucket, by default – as shown in the following image.

Changing the display method also changes the name of the Summaries bucket.

You can use the Counts display option as an alternative to the Count prefix operator aggregation option to provide a count of data records for all fields in the Counts bucket. A count allows you to see the distribution of your data by displaying the number of records in the selected count fields, for each sort value.
You can select the Details display option to individually display all record values for the fields in the Details bucket instead of aggregating them.

For example, the following image shows two reports. The one on the left uses the default Summaries display option, while the one on the right uses the Details display option.
Records in a Details field are separated into groups based on the fields in the Row and Column Groups buckets, but are not individually sorted. The order in which they appear reflects the order in which they are accessed from the data source.

To see a list of the records in your data source without grouping them, for example as a data extract, you can add all desired dimension and measure fields to the Details bucket, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Model</th>
<th>Cost of Goods</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Production</td>
<td>BOSE V-52-P</td>
<td>$234.00</td>
<td>$399.00</td>
</tr>
<tr>
<td>Media Player</td>
<td>N1000</td>
<td>$46.00</td>
<td>$59.99</td>
</tr>
<tr>
<td>Media Player</td>
<td>SAMSUNG BD-C0500</td>
<td>$300.00</td>
<td>$446.99</td>
</tr>
<tr>
<td>Media Player</td>
<td>JVC DR-MV150B</td>
<td>$374.00</td>
<td>$696.08</td>
</tr>
<tr>
<td>Media Player</td>
<td>Panasonic DMP-BD30</td>
<td>$310.00</td>
<td>$389.99</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>DC390/37</td>
<td>$83.00</td>
<td>$127.59</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Yamaha RXV455</td>
<td>$312.00</td>
<td>$406.30</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Onkyo TXSR376B</td>
<td>$548.00</td>
<td>$786.50</td>
</tr>
<tr>
<td>Media Player</td>
<td>Panasonic DMP-BD70V</td>
<td>$400.00</td>
<td>$599.99</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>LG XD63</td>
<td>$131.00</td>
<td>$199.99</td>
</tr>
<tr>
<td>Computers</td>
<td>i897B</td>
<td>$243.00</td>
<td>$306.50</td>
</tr>
<tr>
<td>Media Player</td>
<td>Pioneer BDP-330</td>
<td>$370.00</td>
<td>$499.99</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Panasonic</td>
<td>$135.00</td>
<td>$172.49</td>
</tr>
<tr>
<td>Media Player</td>
<td>JVC DR-MV150B</td>
<td>$374.00</td>
<td>$448.99</td>
</tr>
<tr>
<td>Accessories</td>
<td>BCG3HRE54KN</td>
<td>$16.00</td>
<td>$29.99</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Sony STRDH010</td>
<td>$240.00</td>
<td>$359.00</td>
</tr>
<tr>
<td>Media Player</td>
<td>SHARP BD-HP70U</td>
<td>$390.00</td>
<td>$359.99</td>
</tr>
<tr>
<td>Video Production</td>
<td>Thomson Grass Valley ADVC110</td>
<td>$165.00</td>
<td>$219.99</td>
</tr>
<tr>
<td>Media Player</td>
<td>Pioneer BDP-120</td>
<td>$410.00</td>
<td>$599.98</td>
</tr>
</tbody>
</table>
You can also use the Details with counter display option to display individual values in the report and number them. This can be useful if you want to display records from your data source and provide a key value, such as a record ID number, for each one, as shown in the following image.
When there are fields in the Rows bucket, the Details with counter display option generates a numbered list based on the primary sort field, but places it before the measure columns in the report. Notice that in the following image, the report is sorted by Product Category and Model, so the record list column appears to the right of the Model column, but the counter resets only on each Product Category value.

Since the Details and Details with counter display options create a row in the report for every record in the data source, be careful when using them with larger data sources.

Adding Column and Row Totals to a Report

You can summarize the measure data in a report by adding column and row totals. Column totals provide a grand total of each measure column in a report, while row totals provide a grand total of each row in a report, summing multiple measure values.

To add column totals to a report, on the Content section of the Settings tab of the Properties panel, click *Enable column totals* or *Recalculate totals*.
The Enable column totals option provides a sum total for each column. As shown in the following image, the values in each measure column are summed into total values. Columns created by dimension fields in the Column Groups bucket are treated as separate columns for this purpose.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Sale, Year, Quarter</th>
<th>2014 Quantity Sold</th>
<th>2014 Revenue</th>
<th>2015 Quantity Sold</th>
<th>2015 Revenue</th>
<th>2016 Quantity Sold</th>
<th>2016 Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>1</td>
<td>4,580</td>
<td>$1,125,123.02</td>
<td>7,121</td>
<td>$1,800,068.41</td>
<td>11,954</td>
<td>$3,048,787.53</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td>1</td>
<td>1,343</td>
<td>$302,839.60</td>
<td>2,723</td>
<td>$545,285.69</td>
<td>4,622</td>
<td>$935,868.89</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td>1</td>
<td>11,717</td>
<td>$3,427,197.08</td>
<td>12,067</td>
<td>$3,851,602.64</td>
<td>16,372</td>
<td>$5,239,161.93</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Televisions</td>
<td>1</td>
<td>3,925</td>
<td>$1,566,904.80</td>
<td>1,437</td>
<td>$1,096,511.50</td>
<td>2,070</td>
<td>$1,686,377.91</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Alternatively, you can use a recomputed total to provide summed totals for measure fields from the data source but recalculate the total values for computed fields created in a report. To add a recomputed total to a report, on the Content Settings section of the Settings tab of the Settings/Format panel, click Recalculate totals. Values for each measure field are recomputed after each value in the selected field.
For example, perhaps you have created a report that includes a calculated field, Revenue Per Item, that is evaluated after aggregation from Revenue divided by Quantity Sold. The following image shows a report containing that field, with summed totals added using the Enable column totals option.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>2014 Revenue</th>
<th>2014 Revenue Per Item</th>
<th>2015 Revenue</th>
<th>2015 Revenue Per Item</th>
<th>2016 Revenue</th>
<th>2016 Revenue Per Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$1,125,123.02</td>
<td>$245.66</td>
<td>$1,800,068.41</td>
<td>$252.78</td>
<td>$3,648,787.53</td>
<td>$254.83</td>
</tr>
<tr>
<td></td>
<td>$1,165,106.04</td>
<td>$249.92</td>
<td>$1,827,354.16</td>
<td>$249.54</td>
<td>$2,695,673.25</td>
<td>$251.63</td>
</tr>
<tr>
<td></td>
<td>$1,270,872.45</td>
<td>$265.71</td>
<td>$1,954,121.52</td>
<td>$248.84</td>
<td>$2,760,894.18</td>
<td>$249.88</td>
</tr>
<tr>
<td></td>
<td>$1,478,106.06</td>
<td>$241.26</td>
<td>$2,268,524.84</td>
<td>$250.42</td>
<td>$3,315,315.00</td>
<td>$254.85</td>
</tr>
<tr>
<td>Camcorder</td>
<td>$1,225,199.72</td>
<td>$316.34</td>
<td>$2,304,019.65</td>
<td>$356.16</td>
<td>$3,452,156.37</td>
<td>$338.48</td>
</tr>
<tr>
<td></td>
<td>$1,244,408.92</td>
<td>$326.45</td>
<td>$2,073,199.24</td>
<td>$320.18</td>
<td>$3,339,495.11</td>
<td>$334.08</td>
</tr>
<tr>
<td></td>
<td>$1,536,974.19</td>
<td>$353.65</td>
<td>$2,529,194.52</td>
<td>$350.84</td>
<td>$3,385,661.95</td>
<td>$344.25</td>
</tr>
<tr>
<td></td>
<td>$1,871,848.70</td>
<td>$326.91</td>
<td>$2,756,844.75</td>
<td>$332.07</td>
<td>$3,794,394.68</td>
<td>$338.18</td>
</tr>
<tr>
<td>Media Player</td>
<td>$3,427,107.08</td>
<td>$202.50</td>
<td>$3,851,602.64</td>
<td>$319.18</td>
<td>$5,230,161.93</td>
<td>$320.01</td>
</tr>
<tr>
<td></td>
<td>$3,268,394.60</td>
<td>$281.32</td>
<td>$3,313,925.34</td>
<td>$322.87</td>
<td>$4,681,985.38</td>
<td>$325.53</td>
</tr>
<tr>
<td></td>
<td>$3,585,013.72</td>
<td>$282.60</td>
<td>$3,727,532.88</td>
<td>$326.35</td>
<td>$5,698,038.72</td>
<td>$320.01</td>
</tr>
<tr>
<td></td>
<td>$4,699,372.86</td>
<td>$314.49</td>
<td>$4,239,470.35</td>
<td>$316.87</td>
<td>$6,084,901.35</td>
<td>$325.40</td>
</tr>
<tr>
<td>Televisions</td>
<td>$1,566,904.80</td>
<td>$399.21</td>
<td>$1,095,511.50</td>
<td>$763.06</td>
<td>$1,688,377.91</td>
<td>$814.68</td>
</tr>
<tr>
<td></td>
<td>$1,577,021.42</td>
<td>$420.76</td>
<td>$1,074,107.17</td>
<td>$806.99</td>
<td>$1,481,373.79</td>
<td>$883.11</td>
</tr>
<tr>
<td></td>
<td>$1,796,316.25</td>
<td>$417.55</td>
<td>$1,181,874.36</td>
<td>$851.21</td>
<td>$1,654,188.98</td>
<td>$854.44</td>
</tr>
<tr>
<td></td>
<td>$1,540,975.20</td>
<td>$347.77</td>
<td>$1,385,046.13</td>
<td>$330.72</td>
<td>$2,036,387.03</td>
<td>$808.09</td>
</tr>
</tbody>
</table>

The total row contains summed values for the Revenue and Revenue Per Item fields.
By contrast, the following image shows the same report, but with recomputed totals, using the Recalculate totals option, instead.

In this report, the total values in the Revenue Per Item columns are recomputed for the entire report, since Revenue Per Item is a calculated field. On the other hand, the Revenue columns are still summed, since they come from the data source.

Note that the Recalculate totals option does not reapply prefix operators. Fields with prefix operators are summed just as they would be when applying a regular subtotal. Only COMPUTE fields, which are calculated fields evaluated after data aggregation, are recalculated.

When column totals are enabled, they display below the data in the report by default. Select the Show totals above detail check box to show the column totals above the data values.

**Note:** The Show totals above detail option is reflected only at run-time.

You can also add row totals to a report to generate summed grand totals for each row of the report. To add row totals, on the Content Settings section of the Settings tab of the Settings/Format panel, click Enable row totals.
Row totals behave differently depending on whether or not fields have been placed into the Column Groups bucket. If there are no fields in the Column Groups bucket, then all measure columns in the report are summed in a single Total column, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Sale Quarter</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>1</td>
<td>$4,147,248.00</td>
<td>$280,171.28</td>
<td>$1,826,730.96</td>
<td>$6,254,150.24</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$3,925,748.00</td>
<td>$269,670.58</td>
<td>$1,762,391.45</td>
<td>$5,957,810.03</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$4,166,868.00</td>
<td>$297,293.76</td>
<td>$1,829,020.15</td>
<td>$6,293,181.91</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$4,887,672.00</td>
<td>$334,687.80</td>
<td>$2,174,363.90</td>
<td>$7,396,723.70</td>
</tr>
<tr>
<td>Camcorder</td>
<td>1</td>
<td>$4,754,152.00</td>
<td>$331,388.92</td>
<td>$2,227,223.74</td>
<td>$7,312,764.66</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$4,479,378.00</td>
<td>$291,023.13</td>
<td>$2,177,715.27</td>
<td>$6,948,116.40</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$5,086,129.00</td>
<td>$341,115.23</td>
<td>$2,365,701.66</td>
<td>$7,792,945.89</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$5,702,159.00</td>
<td>$380,644.79</td>
<td>$2,730,929.13</td>
<td>$8,813,732.92</td>
</tr>
<tr>
<td>Media Player</td>
<td>1</td>
<td>$9,475,832.00</td>
<td>$577,328.70</td>
<td>$3,042,129.65</td>
<td>$13,095,290.35</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$8,796,078.00</td>
<td>$548,854.63</td>
<td>$2,768,227.41</td>
<td>$12,113,160.04</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$9,441,755.00</td>
<td>$577,436.23</td>
<td>$2,969,430.32</td>
<td>$12,988,621.55</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$11,419,820.00</td>
<td>$670,837.94</td>
<td>$3,603,924.56</td>
<td>$15,694,582.50</td>
</tr>
<tr>
<td>Televisions</td>
<td>1</td>
<td>$3,376,862.00</td>
<td>$212,974.63</td>
<td>$972,932.21</td>
<td>$4,562,768.84</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$3,199,280.00</td>
<td>$177,866.59</td>
<td>$933,588.38</td>
<td>$4,310,734.97</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>$3,597,757.00</td>
<td>$218,950.77</td>
<td>$1,034,422.59</td>
<td>$4,851,130.36</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>$3,861,098.00</td>
<td>$240,878.10</td>
<td>$1,101,910.36</td>
<td>$5,203,886.46</td>
</tr>
</tbody>
</table>

In this case, ensure that it makes sense to sum all of the measure fields in your report before adding row totals. Since these fields may have different formats, you can edit the field format used for the row totals by clicking Edit Data Format under the Enable row totals check box.
If there is a field in the Column Groups bucket, then instead of summing all columns, the row totals are evaluated for each measure field in the report, as shown in the following image.

Note that row totals provide sum values for the measures in each row, including instances when the report includes calculated fields.

If your report includes both column totals and row totals, then column totals are evaluated for any row total columns, as shown in the following image.
Using Breaks and Subtotals in a Report

Breaks and subtotals allow you to divide a report into smaller sections for more granular analysis and a more digestible view of your data. These sections are generated for each value in a selected Row field or after the last value of a selected Column Group field.

To apply a break or subtotal, right-click a field in the Rows or Column Groups bucket, point to Insert breaks, and select an option. Three categories of options are available for row fields: Subtotals, Page breaks, and Row breaks. You can select an option for each of these categories in each row field of a report. For columnar sort fields, only the Subtotal options are available.

Note: The responsive canvas, used for the AHTML and HTML5 output formats, uses AHTML In-Document Analytic capabilities to enable interactive options at design time. When creating a report, page and row break settings are not supported on this canvas, or at runtime when using the AHTML output format. If you select an output format that uses the paginated canvas, such as HTML, PDF, PPTX, or XLSX, you will see these breaks at design time and at runtime.

Using Breaks and Subtotals on Rows in a Report

The Subtotal options allow you to add a subtotal or recompute row after each value in the selected field. Subtotals and recomputes do not add page breaks to a report.

To add a subtotal, right-click a field in the Rows bucket, point to Insert breaks, and click Aggregate columns. A subtotal row is added for each value in the selected field and evaluated for each measure field in the report.
The selected field does not need to be the primary sort field. For example, the following image shows a report with subtotals for Product Subcategory, the secondary sort field, but not Product Category, the primary sort field. You can add subtotals for each sort field separately.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Subtotal Charger</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Headphones</td>
<td>2014</td>
<td>$2,914,047.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,612,931.48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,899,210.86</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$9,332,629.55</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$21,114,466.12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$31,313,302.59</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charger</td>
<td>2014</td>
<td>$158,015.56</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>$248,167.29</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>$374,562.24</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>$493,220.38</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>$1,101,388.29</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>$1,647,481.15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subtotal Headphones</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Remote Controls</td>
<td>2014</td>
<td>$1,967,234.64</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>$2,998,970.16</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>$4,546,902.86</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>$6,234,565.76</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>$13,404,018.40</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>$20,247,223.83</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subtotal Universal Remote Controls</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2014</td>
<td>$49,398,915.65</td>
</tr>
</tbody>
</table>

Alternatively, you can use the recompute option to provide summed totals for fields from the data source but recalculate the total values for computed fields created in a report. To add recompute rows to a report, right-click a field in the Rows bucket, point to Insert breaks, and click Recalculate totals. Values for each measure field are recomputed after each value in the selected field.
For example, perhaps you have created a report that includes a calculated field, Revenue Per Item, that is evaluated after aggregation from Revenue divided by Quantity Sold. The following image shows a report containing that field, with subtotals added using the Aggregate columns option.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
<th>Revenue Per Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>2014</td>
<td>$158,015.56</td>
<td>$38.74</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$248,167.29</td>
<td>$38.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$374,562.24</td>
<td>$38.23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$493,220.38</td>
<td>$38.02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$1,101,388.29</td>
<td>$38.31</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$1,647,481.15</td>
<td>$38.15</td>
</tr>
<tr>
<td><strong>Subtotal Charger</strong></td>
<td></td>
<td></td>
<td><strong>$4,022,834.91</strong></td>
<td><strong>$229.77</strong></td>
</tr>
<tr>
<td>Headphones</td>
<td></td>
<td>2014</td>
<td>$2,914,047.37</td>
<td>$323.68</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,612,931.48</td>
<td>$328.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,899,210.86</td>
<td>$335.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$9,332,629.55</td>
<td>$328.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$21,114,466.12</td>
<td>$335.68</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$31,313,302.59</td>
<td>$335.25</td>
</tr>
<tr>
<td><strong>Subtotal Headphones</strong></td>
<td></td>
<td></td>
<td><strong>$76,186,587.97</strong></td>
<td><strong>$1,986.84</strong></td>
</tr>
<tr>
<td>Universal Remote Controls</td>
<td></td>
<td>2014</td>
<td>$1,967,234.64</td>
<td>$278.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,998,970.16</td>
<td>$275.67</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,546,902.86</td>
<td>$277.62</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$6,234,565.76</td>
<td>$273.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$13,404,018.40</td>
<td>$277.34</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$20,247,223.83</td>
<td>$277.42</td>
</tr>
<tr>
<td><strong>Subtotal Universal Remote Controls</strong></td>
<td></td>
<td></td>
<td><strong>$49,398,915.65</strong></td>
<td><strong>$1,664.40</strong></td>
</tr>
</tbody>
</table>

The subtotal rows each contain summed values for the Revenue and Revenue Per Item fields.
By contrast, the following image shows the same report, but with recomputes, using the Recalculate totals option, instead.

Now the subtotal rows provide reaggregated values. They provide a sum total value for the Revenue field, just like with a subtotal, and a recalculated value for the Revenue Per Item field.

Note that the Recalculate totals option does not reapply prefix operators. Fields with prefix operators are summed just as they would be when applying a regular subtotal. Only COMPUTE fields, which are calculated fields evaluated after data aggregation, are recalculated.
You can create subtotals and recomputes with more advanced options, such as different aggregations and cascading to all higher level sort fields, by right-clicking a field in the Rows bucket, pointing to *Insert breaks*, and clicking *More options*. The Configure Subtotals dialog box opens, as shown in the following image.

![Configure Subtotals dialog box](image)

Select the *Aggregate columns* radio button to create subtotals, or the *Recalculate totals* radio button to create recomputes. You can then choose to create subtotals or recomputes at the current levels, that is, the selected field, or for current and higher level sort fields. If you select *Current and higher level groups*, then the same subtotal settings are applied to all higher level fields in the report. Pre-existing subtotals or recomputes are not replaced. Note that the specified subtotal label text is not used for the higher level sort fields.

A grid in the Configure Subtotals dialog box shows a list of measures fields in the report. Select any or all check boxes to indicate which fields should be subtotaled or recomputed. You can also change the prefix aggregation for each one. For example, instead of a summed total, you can show a total average or total count for a selected measure column.
You can also change the text that appears in the subtotal rows of the report, and choose whether break groups with only one row should also be subtotaled. The subtotals for these groups would be the same as the measure values displayed in the group itself, so you may prefer not to subtotal them. For example, the following image shows a report with subtotals on the Store Business Region field. Since the Oceania business region occupies only one row, and the Only show subtotals when the group has more than one row option is selected, it is not subtotaled.

<table>
<thead>
<tr>
<th>Store Business Region</th>
<th>Store Business Sub Region</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Africa</td>
<td>195</td>
<td>$61,881.01</td>
<td>$17,054.01</td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td>87,192</td>
<td>$26,475,042.07</td>
<td>$7,450,955.07</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td>1,317,153</td>
<td>$396,208,754.84</td>
<td>$112,230,885.84</td>
</tr>
<tr>
<td>Subtotal: EMEA</td>
<td></td>
<td>1,404,540</td>
<td>$422,745,677.92</td>
<td>$119,698,894.92</td>
</tr>
<tr>
<td>North America</td>
<td>Canada</td>
<td>171,492</td>
<td>$51,147,788.36</td>
<td>$14,541,675.36</td>
</tr>
<tr>
<td></td>
<td>East</td>
<td>129,277</td>
<td>$39,052,672.79</td>
<td>$11,063,697.79</td>
</tr>
<tr>
<td></td>
<td>Mexico</td>
<td>42,921</td>
<td>$12,976,898.90</td>
<td>$3,680,274.90</td>
</tr>
<tr>
<td></td>
<td>Midwest</td>
<td>201,153</td>
<td>$60,946,396.65</td>
<td>$17,171,198.65</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>5,189</td>
<td>$1,526,577.09</td>
<td>$428,166.09</td>
</tr>
<tr>
<td></td>
<td>South</td>
<td>255,640</td>
<td>$77,468,535.43</td>
<td>$21,824,155.43</td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td>14,704</td>
<td>$4,488,702.58</td>
<td>$1,268,099.58</td>
</tr>
<tr>
<td></td>
<td>West</td>
<td>1,189,804</td>
<td>$362,309,281.86</td>
<td>$101,987,950.86</td>
</tr>
<tr>
<td>Subtotal: North America</td>
<td></td>
<td>2,010,180</td>
<td>$609,916,853.66</td>
<td>$171,965,218.66</td>
</tr>
<tr>
<td>Oceania</td>
<td>Australia-New Zealand</td>
<td>4,242</td>
<td>$1,260,307.29</td>
<td>$361,558.29</td>
</tr>
<tr>
<td>South America</td>
<td>SA-Port</td>
<td>86,606</td>
<td>$25,974,011.78</td>
<td>$7,359,004.78</td>
</tr>
<tr>
<td></td>
<td>SA-Span</td>
<td>4,323</td>
<td>$1,296,074.55</td>
<td>$388,719.55</td>
</tr>
<tr>
<td>Subtotal: South America</td>
<td></td>
<td>90,929</td>
<td>$27,270,086.33</td>
<td>$7,727,724.33</td>
</tr>
</tbody>
</table>

Click Apply to create the subtotals or recomputes as you configured them.

If you create subtotals and apply them to all higher fields, and then right-click a higher level sort field and point to Insert breaks, only the More options option is available for subtotals. If you click More options, the Configure Subtotals dialog box opens with options to edit the cascaded group of subtotals from the lower level sort field. If you change the Apply Subtotals At option from Current and higher level groups to Current level, then the cascaded group of subtotals are removed except for the field that you right-clicked.
You can also add page breaks to a report using two different options. Right-click a field in the Rows bucket, point to Insert breaks, and click Continuous numbering or Restart at 1 to split the report into separate pages for each value in the selected field.

Page headers and footers appear at each page break. Page headers and footers can use dynamic text to indicate the values on the page. Dynamic text is added by typing a less-than sign (<) markup tag followed by the name of the field, with no spaces between them.
For example, the following image shows a report with page breaks added for the Product Category field, and page headers added by typing Sales for \texttt{PRODUCT\_CATEGORY} in the page header area of the report.

<table>
<thead>
<tr>
<th>Sales for Accessories</th>
<th>Sales for Camcorder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Category</strong></td>
<td><strong>Product Subcategory</strong></td>
</tr>
<tr>
<td>Accessories</td>
<td>Charger</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Charger</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Headphones</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Universal Remote Controls</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Universal Remote Controls</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sales for Accessories</strong></td>
<td><strong>Sales for Camcorder</strong></td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Handheld</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Professional</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Professional</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal Standard</strong></td>
<td></td>
</tr>
</tbody>
</table>
There is no difference between the Continuous numbering and Restart at 1 page break options unless there are page numbers added to the report. If there are page numbers, then using the Continuous numbering option counts page breaks for all values in the field toward page numbering, while the Restart at 1 option resets the page count for each value in the selected field. You can display page numbers by adding the dynamic text <TABPAGENO to a page header or footer.

The Restart at 1 option can be used on a higher level sort field to control the displayed page number for lower-level sort field page breaks using the Continuous paging option. For example, the report shown in the image below uses the Restart at 1 page break option on Product Category, the primary sort field, and the Continuous numbering option on Product Subcategory, the secondary sort field. It also contains the following page footer text:

Page <TABPAGENO of <BYLASTPAGE

At run time, <TABPAGENO provides the current page, and <BYLASTPAGE provides the page count for the sort field using the Restart at 1 option. Using <TABLASTPAGE instead of <BYLASTPAGE would instead provide the total page count.
The following image shows that the page for each Product Subcategory is numbered, while different values for Product Category cause the page numbers to reset.

### Page for Charger under Accessories

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>2014</td>
<td>$158,015.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$248,167.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$374,562.24</td>
</tr>
</tbody>
</table>

Subtotal Charger: $780,745.09

### Page for Headphones under Accessories

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Headphones</td>
<td>2014</td>
<td>$2,914,047.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,512,931.48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,899,210.80</td>
</tr>
</tbody>
</table>

Subtotal Headphones: $14,426,189.71

### Page for Universal Remote Controls under Accessories

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Universal Remote Controls</td>
<td>2014</td>
<td>$1,967,234.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,998,970.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,546,902.85</td>
</tr>
</tbody>
</table>

Subtotal Universal Remote Controls: $9,513,107.66

### Page for Handheld under Camcorder

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>2014</td>
<td>$1,632,425.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,589,025.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$3,837,933.41</td>
</tr>
</tbody>
</table>

Subtotal Handheld: $8,069,384.06
By contrast, if Product Category used either the Continuous numbering option or no page breaks at all (since breaks have already been added on a lower level sort field, Product Category values will display on separate pages anyway), <BYLASTPAGE would display the total number of all pages in the report, as shown in the following image, and <TABPAGENO would not reset.

**Page for Charger under Accessories**

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sales Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>2014</td>
<td>$158,015.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$248,167.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$374,562.24</td>
</tr>
<tr>
<td><strong>Subtotal Charger</strong></td>
<td></td>
<td></td>
<td><strong>$780,745.09</strong></td>
</tr>
</tbody>
</table>

Page 1 of 21

**Page for Headphones under Accessories**

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sales Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Headphones</td>
<td>2014</td>
<td>$2,914,047.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,612,931.48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,899,210.88</td>
</tr>
<tr>
<td><strong>Subtotal Headphones</strong></td>
<td></td>
<td></td>
<td><strong>$14,426,189.71</strong></td>
</tr>
</tbody>
</table>

Page 2 of 21

**Page for Universal Remote Controls under Accessories**

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sales Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Universal Remote Controls</td>
<td>2014</td>
<td>$1,967,234.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,998,970.16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,546,902.88</td>
</tr>
<tr>
<td><strong>Subtotal Universal Remote Controls</strong></td>
<td></td>
<td></td>
<td><strong>$9,513,107.66</strong></td>
</tr>
</tbody>
</table>

Page 3 of 21

**Page for Handheld under Camcorder**

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sales Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>2014</td>
<td>$1,632,425.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,599,025.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$3,837,933.41</td>
</tr>
<tr>
<td><strong>Subtotal Handheld</strong></td>
<td></td>
<td></td>
<td><strong>$8,069,384.06</strong></td>
</tr>
</tbody>
</table>

Page 4 of 21
To visually break up a report without adding page breaks, you can add a row break in the form of a blank row or line. To add a row break, right-click a field in the Rows bucket, point to Insert breaks, and click Blank row or Solid line.
Row breaks do not create page breaks, so page headers and footers are not repeated on the field to which the row break is added, and they are not counted for page numbering. This technique can be a good way to space out the values and information in a report without adding unnecessary functionality. In the following image, blank row breaks on Product Subcategory make it easier to locate and isolate the values for each product subcategory.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>2014</td>
<td>$158,015.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$248,167.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$374,562.24</td>
</tr>
<tr>
<td>Headphones</td>
<td></td>
<td>2014</td>
<td>$2,914,047.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,612,931.48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,899,210.86</td>
</tr>
<tr>
<td>Universal Remote Controls</td>
<td></td>
<td>2014</td>
<td>$1,967,234.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,998,970.16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,546,902.86</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>2014</td>
<td>$1,632,425.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,599,025.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$3,837,933.41</td>
</tr>
<tr>
<td>Professional</td>
<td></td>
<td>2014</td>
<td>$1,590,967.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$2,732,875.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,036,890.50</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td>2014</td>
<td>$2,655,039.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$4,341,347.67</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$6,096,884.20</td>
</tr>
</tbody>
</table>
Using Subtotals on Sort Columns in a Report

Page and row breaks are not available for fields in the Column Groups bucket, but you can use the subtotal and recompute options on columnar sort fields similarly to row sort fields. To add columnar subtotal columns, right-click a field in the Column Groups bucket, point to Insert breaks, and click Aggregate rows. To add columnar recompute columns, right-click a field in the Column Groups bucket, point to Insert breaks, and click Recalculate totals.

Columnar subtotals work differently than row subtotals. While a subtotal or recompute row is added for each value in the selected Row field, subtotal or recompute columns are added after the last value of the selected field in each column group. For example, in the following image, subtotals have been added to the Sale Quarter field, so the subtotal column sums the revenue values for all of the quarters within each value for Sale Year, which is a higher level columnar sort field. Effectively, the subtotals applied to the Sale Quarter field provide a total for each Sale Year value.

As a result, subtotals and recomputes added to the highest level field in the Column Groups bucket serve as a grand total for all of the columns in the report.

Sorting Data in a Report

You can modify the order and arrangement of values in a report by using different sort orders. Reports are sorted into rows based on the values of fields in the Rows bucket, and into columns based on the values of fields in the Column Groups bucket.
Sorting is hierarchical, so values are first sorted by the first field in the Row or Column bucket, then by the second field, and so on. For example, in the following image, the report is sorted by the Product Category field, then for product subcategories under each product category, then by sale year values for each product subcategory. Product Category, Product Subcategory, and Sale Year have all been placed into the Rows bucket. Gross Profit was placed in the Summaries bucket, so it is not used to sort the report. Instead, gross profit values are sorted by the other three fields.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Sale Year</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>2014</td>
<td>$560,961.19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$968,864.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$1,451,039.85</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$1,980,595.07</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$5,153,998.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$5,719,242.85</td>
</tr>
<tr>
<td>Tablet</td>
<td></td>
<td>2016</td>
<td>$196,009.74</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$1,395,785.48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$3,123,898.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$12,958,422.03</td>
</tr>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>2014</td>
<td>$2,018,067.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$3,237,933.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$4,701,470.35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$6,554,474.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$14,110,114.35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$21,149,135.32</td>
</tr>
<tr>
<td>DVD Players</td>
<td></td>
<td>2014</td>
<td>$1,717,087.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$142,558.37</td>
</tr>
<tr>
<td>DVD Players - Portable</td>
<td></td>
<td>2014</td>
<td>$265,150.77</td>
</tr>
<tr>
<td>Streaming</td>
<td></td>
<td>2014</td>
<td>$46,646.99</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2015</td>
<td>$107,489.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016</td>
<td>$147,308.03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2017</td>
<td>$176,395.88</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2018</td>
<td>$370,256.62</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2019</td>
<td>$1,088,490.08</td>
</tr>
</tbody>
</table>
By default, field values are sorted into ascending order based on the numeric and alphabetical order defined in the code page that you are using. To reverse the sort order, right-click a field and click *Sort descending*. To return to the original sort order, right-click a field and click *Sort ascending*. You can also click the sort arrows on the fields in a bucket, as shown in the following image.
You can rearrange the fields within a bucket by dragging them, which allows you to prioritize certain information in the report. The previous example showed a report sorted by Product Category, then Product Subcategory, then Sale Year. If we move Sale Year to the top of the Rows bucket so that it is the primary sort field, the report becomes a breakdown of yearly sales, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Accessories</td>
<td>Charger</td>
<td>$77,918.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Headphones</td>
<td>$943,893.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Universal Remote Controls</td>
<td>$536,815.64</td>
</tr>
<tr>
<td>Camcorder</td>
<td></td>
<td>Handheld</td>
<td>$832,239.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Professional</td>
<td>$326,739.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Standard</td>
<td>$749,341.17</td>
</tr>
<tr>
<td>Computers</td>
<td></td>
<td>Smartphone</td>
<td>$560,961.19</td>
</tr>
<tr>
<td>Media Player</td>
<td></td>
<td>Blu Ray</td>
<td>$2,018,067.15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DVD Players</td>
<td>$1,717,087.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DVD Players - Portable</td>
<td>$265,150.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Streaming</td>
<td>$46,646.99</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td></td>
<td>Boom Box</td>
<td>$546,423.99</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Home Theater Systems</td>
<td>$1,116,533.39</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Receivers</td>
<td>$673,700.84</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Speaker Kits</td>
<td>$1,010,824.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>iPod Docking Station</td>
<td>$615,492.06</td>
</tr>
<tr>
<td>Televisions</td>
<td></td>
<td>CRT TV</td>
<td>$602,419.65</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flat Panel TV</td>
<td>$645,916.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Portable TV</td>
<td>$341,221.62</td>
</tr>
<tr>
<td>Video Production</td>
<td></td>
<td>Video Editing</td>
<td>$706,553.17</td>
</tr>
</tbody>
</table>
You can sort by measure fields as well when they use the Summaries, Details, or Details with counter display options. To sort by aggregated measure values, right-click a field in the measure bucket and click Sort ascending or Sort descending. A hidden instance of the measure field is added to the top of the Rows bucket, as shown in the following image.
The result is a report that is sorted into rows based on the selected measure value, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$21,149,135.32</td>
</tr>
<tr>
<td>2018</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$14,110,114.35</td>
</tr>
<tr>
<td>2019</td>
<td>Computers</td>
<td>Tablet</td>
<td>$12,958,422.03</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$11,437,009.44</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$10,556,588.15</td>
</tr>
<tr>
<td>2019</td>
<td>Accessories</td>
<td>Headphones</td>
<td>$10,077,097.59</td>
</tr>
<tr>
<td>2019</td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$8,758,717.23</td>
</tr>
<tr>
<td>2019</td>
<td>Camcorder</td>
<td>Standard</td>
<td>$8,021,561.37</td>
</tr>
<tr>
<td>2018</td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$7,662,268.78</td>
</tr>
<tr>
<td>2019</td>
<td>Video Production</td>
<td>Video Editing</td>
<td>$7,330,486.17</td>
</tr>
<tr>
<td>2018</td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$7,072,283.83</td>
</tr>
<tr>
<td>2018</td>
<td>Accessories</td>
<td>Headphones</td>
<td>$6,795,787.12</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Receivers</td>
<td>$6,759,172.56</td>
</tr>
<tr>
<td>2019</td>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>$6,560,087.29</td>
</tr>
<tr>
<td>2017</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$6,554,474.17</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>iPod Docking Station</td>
<td>$6,244,914.54</td>
</tr>
<tr>
<td>2018</td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$5,839,787.45</td>
</tr>
<tr>
<td>2019</td>
<td>Computers</td>
<td>Smartphone</td>
<td>$5,719,242.85</td>
</tr>
</tbody>
</table>

In this example, sorting by the Gross Profit field from the Summaries bucket has allowed us to see at a glance that larger profits have been made in more recent years. You could change the sort order to see lowest profits first by clicking the sort arrow for the hidden Gross Profit field in the Rows bucket, just as you could for a visible field.
You can move this hidden field in relation to the other sort fields to change the sorting priority. In the following image, the hidden Gross Profit field has been moved to after Sale Year, allowing us to see the most profitable products in each year.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$2,018,067.15</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>DVD Players</td>
<td>$1,717,087.44</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$1,116,533.39</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$1,010,824.45</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Headphones</td>
<td>$943,893.37</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$832,239.21</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Standard</td>
<td>$749,341.17</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>Video Editing</td>
<td>$706,553.17</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Receivers</td>
<td>$673,700.84</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>$645,916.40</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>iPod Docking Station</td>
<td>$615,492.06</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>CRT TV</td>
<td>$602,419.65</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>Smartphone</td>
<td>$560,961.19</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Boom Box</td>
<td>$546,423.99</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Universal Remote Controls</td>
<td>$536,815.64</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>Portable TV</td>
<td>$341,221.62</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Professional</td>
<td>$326,739.15</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>DVD Players - Portable</td>
<td>$265,150.77</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Charger</td>
<td>$77,918.56</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>Streaming</td>
<td>$46,646.99</td>
</tr>
</tbody>
</table>

| 2015      | Media Player     | Blu Ray             | $3,237,933.79  |
|           | Stereo Systems   | Home Theater Systems| $1,706,265.20  |
|           | Stereo Systems   | Speaker Kits        | $1,580,534.80  |
|           | Accessories      | Headphones          | $1,482,596.48  |
|           | Camcorder        | Handheld            | $1,325,634.44  |
|           | Camcorder        | Standard            | $1,235,711.67  |

You can sort by multiple measures to have more granular control over how the report is sorted. If there are some matching values of the first sorting measure, the second sorting measure will sort those matching values.
When using the Details or Details with counter display option instead of the Summaries option, you can sort fields in the Details bucket in the same way. This can be helpful if you want to view a sorted list of all records for a field. Right-click a field in the Details or Details with counter bucket and click Sort ascending or Sort descending to sort the report using the values from that field.

You can remove the sorting effect of a field in the Summaries, Details, or Details with counter bucket by pointing to the invisible measure field in the Rows bucket and clicking the X, or by right-clicking the original field in the measure bucket and clicking No sort. The hidden field is removed from the Rows bucket, but the original field remains in the measure bucket. When you remove the original field from the measure bucket, the invisible field in the Rows bucket is automatically removed as well.

You can also sort by hidden dimension fields, if you do not want them to display in the chart. To hide a dimension field in your report, right-click the field in the Rows or Column Groups bucket and click Hide.
The following image shows a report sorted by Sale Day Name and Sale Date. We want to see sales information based on the day of the week. Notice, however, that Sale Day Name is sorted alphabetically, by default.
We can add the Sale Day of Week field, which assigns a number to each day, to the report as the primary sort field, and then hide it, so the days are listed in weekday order, as shown in the following image.
Using Hidden Fields in Reports

When creating a report in WebFOCUS Designer, you can hide a field so that it exists in the report but is not shown as a column. The main advantage of doing this is that hidden fields are still used for sorting, which gives you more control over how the values in a report are displayed and organized. To hide a field in your report, right-click a field and click *Hide*. The hidden field appears slightly faded in its bucket, as shown in the following image.

![Diagram showing rows and columns with hidden fields]

You can display the field again by right-clicking it and de-selecting the *Hide* option.

You can sort by hidden dimension fields if you do not want them to display in the chart, but still want to use the values in those fields to sort the values in the fields that do display.
The following image shows a report sorted by Sale Day Name and Sale Date. We want to see sales information based on the day of the week. Notice, however, that Sale Day Name is sorted alphabetically, by default.

<table>
<thead>
<tr>
<th>Sale Day Name</th>
<th>Sale Date</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRI</td>
<td>2020/12/03</td>
<td>$404,923.67</td>
</tr>
<tr>
<td></td>
<td>2020/12/10</td>
<td>$435,615.04</td>
</tr>
<tr>
<td></td>
<td>2020/12/17</td>
<td>$419,272.25</td>
</tr>
<tr>
<td></td>
<td>2020/12/24</td>
<td>$418,694.42</td>
</tr>
<tr>
<td></td>
<td>2020/12/31</td>
<td>$449,438.54</td>
</tr>
<tr>
<td>MON</td>
<td>2020/12/06</td>
<td>$422,459.31</td>
</tr>
<tr>
<td></td>
<td>2020/12/13</td>
<td>$412,501.41</td>
</tr>
<tr>
<td></td>
<td>2020/12/20</td>
<td>$402,688.19</td>
</tr>
<tr>
<td></td>
<td>2020/12/27</td>
<td>$441,724.59</td>
</tr>
<tr>
<td>SAT</td>
<td>2020/12/04</td>
<td>$432,559.97</td>
</tr>
<tr>
<td></td>
<td>2020/12/11</td>
<td>$406,710.17</td>
</tr>
<tr>
<td></td>
<td>2020/12/18</td>
<td>$417,049.59</td>
</tr>
<tr>
<td></td>
<td>2020/12/25</td>
<td>$437,732.62</td>
</tr>
<tr>
<td>SUN</td>
<td>2020/12/05</td>
<td>$405,621.47</td>
</tr>
<tr>
<td></td>
<td>2020/12/12</td>
<td>$426,540.58</td>
</tr>
<tr>
<td></td>
<td>2020/12/19</td>
<td>$404,776.48</td>
</tr>
<tr>
<td></td>
<td>2020/12/26</td>
<td>$442,294.65</td>
</tr>
<tr>
<td>THU</td>
<td>2020/12/02</td>
<td>$408,346.28</td>
</tr>
<tr>
<td></td>
<td>2020/12/09</td>
<td>$405,389.56</td>
</tr>
<tr>
<td></td>
<td>2020/12/16</td>
<td>$409,753.83</td>
</tr>
<tr>
<td></td>
<td>2020/12/23</td>
<td>$423,699.77</td>
</tr>
<tr>
<td></td>
<td>2020/12/30</td>
<td>$434,336.89</td>
</tr>
</tbody>
</table>
We can add the Sale Day of Week field, which assigns a number to each day, to the report as the primary sort field, and then hide it so that the days are listed in order, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Day Name</th>
<th>Sale Date</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>MON</td>
<td>2020/12/06</td>
<td>$422,459.31</td>
</tr>
<tr>
<td></td>
<td>2020/12/13</td>
<td>$412,501.41</td>
</tr>
<tr>
<td></td>
<td>2020/12/20</td>
<td>$402,688.19</td>
</tr>
<tr>
<td></td>
<td>2020/12/27</td>
<td>$441,724.59</td>
</tr>
<tr>
<td>TUE</td>
<td>2020/12/07</td>
<td>$432,028.69</td>
</tr>
<tr>
<td></td>
<td>2020/12/14</td>
<td>$417,251.38</td>
</tr>
<tr>
<td></td>
<td>2020/12/21</td>
<td>$416,046.26</td>
</tr>
<tr>
<td></td>
<td>2020/12/28</td>
<td>$439,444.78</td>
</tr>
<tr>
<td>WED</td>
<td>2020/12/01</td>
<td>$412,366.08</td>
</tr>
<tr>
<td></td>
<td>2020/12/08</td>
<td>$411,867.51</td>
</tr>
<tr>
<td></td>
<td>2020/12/15</td>
<td>$399,701.53</td>
</tr>
<tr>
<td></td>
<td>2020/12/22</td>
<td>$409,314.78</td>
</tr>
<tr>
<td></td>
<td>2020/12/29</td>
<td>$439,271.60</td>
</tr>
<tr>
<td>THU</td>
<td>2020/12/02</td>
<td>$408,345.28</td>
</tr>
<tr>
<td></td>
<td>2020/12/09</td>
<td>$405,389.56</td>
</tr>
<tr>
<td></td>
<td>2020/12/16</td>
<td>$409,753.83</td>
</tr>
<tr>
<td></td>
<td>2020/12/23</td>
<td>$423,869.77</td>
</tr>
<tr>
<td></td>
<td>2020/12/30</td>
<td>$434,336.69</td>
</tr>
<tr>
<td>FRI</td>
<td>2020/12/03</td>
<td>$404,923.67</td>
</tr>
<tr>
<td></td>
<td>2020/12/10</td>
<td>$435,615.04</td>
</tr>
<tr>
<td></td>
<td>2020/12/17</td>
<td>$419,272.25</td>
</tr>
<tr>
<td></td>
<td>2020/12/24</td>
<td>$418,694.42</td>
</tr>
<tr>
<td></td>
<td>2020/12/31</td>
<td>$449,438.54</td>
</tr>
</tbody>
</table>
A hidden field is also created automatically when you sort by a measure field. To sort by aggregated measure values, right-click a measure field in the Summaries bucket and click Sort ascending or Sort descending. A hidden instance of the measure field is added to the top of the Rows bucket, as shown in the following image.
The result is a report that is sorted into rows based on the selected measure value, as shown in the following image.

<table>
<thead>
<tr>
<th>Year</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2019</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$21,149,135.32</td>
</tr>
<tr>
<td>2018</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$14,110,114.35</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>Tablet</td>
<td>$12,958,422.03</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$11,437,009.44</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$10,556,588.15</td>
</tr>
<tr>
<td>2019</td>
<td>Accessories</td>
<td>Headphones</td>
<td>$10,077,097.59</td>
</tr>
<tr>
<td>2019</td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$8,758,717.23</td>
</tr>
<tr>
<td>2019</td>
<td>Camcorder</td>
<td>Standard</td>
<td>$8,021,561.37</td>
</tr>
<tr>
<td>2018</td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$7,662,268.78</td>
</tr>
<tr>
<td>2019</td>
<td>Video Production</td>
<td>Video Editing</td>
<td>$7,330,486.17</td>
</tr>
<tr>
<td>2018</td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$7,072,283.83</td>
</tr>
<tr>
<td>2018</td>
<td>Accessories</td>
<td>Headphones</td>
<td>$6,795,787.12</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>Receivers</td>
<td>$6,759,172.56</td>
</tr>
<tr>
<td>2019</td>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>$6,560,087.29</td>
</tr>
<tr>
<td>2017</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$6,554,474.17</td>
</tr>
<tr>
<td>2019</td>
<td>Stereo Systems</td>
<td>iPod Docking Station</td>
<td>$6,244,914.54</td>
</tr>
<tr>
<td>2018</td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$5,839,787.45</td>
</tr>
<tr>
<td>2019</td>
<td>Computers</td>
<td>Smartphone</td>
<td>$5,719,242.85</td>
</tr>
</tbody>
</table>

In this example, sorting by Gross Profit has allowed us to see at a glance that larger profits have been made in more recent years. You could change the sort order to see lowest profits first by clicking the sort arrow for the hidden Gross Profit field in the Rows bucket, just as you could for a visible field.
You can move this hidden field in relation to the other sort fields to change the sorting priority. In the following image, the hidden Gross Profit field has been moved to after Sale Year, allowing us to see the most profitable products in each year, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$2,018,067.15</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>DVD Players</td>
<td>$1,717,087.44</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$1,116,533.39</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$1,010,824.45</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Headphones</td>
<td>$943,893.37</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$832,239.21</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Standard</td>
<td>$749,341.17</td>
</tr>
<tr>
<td></td>
<td>Video Production</td>
<td>Video Editing</td>
<td>$706,553.17</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Receivers</td>
<td>$673,700.84</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>$645,916.40</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>iPod Docking Station</td>
<td>$615,492.06</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>CRT TV</td>
<td>$602,419.65</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>Smartphone</td>
<td>$560,961.19</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Boom Box</td>
<td>$546,423.99</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Universal Remote Controls</td>
<td>$536,815.64</td>
</tr>
<tr>
<td></td>
<td>Televisions</td>
<td>Portable TV</td>
<td>$341,221.62</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Professional</td>
<td>$326,739.15</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>DVD Players - Portable</td>
<td>$265,150.77</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Charger</td>
<td>$77,918.56</td>
</tr>
<tr>
<td></td>
<td>Media Player</td>
<td>Streaming</td>
<td>$46,646.99</td>
</tr>
<tr>
<td>2015</td>
<td>Media Player</td>
<td>Blu Ray</td>
<td>$3,237,933.79</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>$1,706,265.20</td>
</tr>
<tr>
<td></td>
<td>Stereo Systems</td>
<td>Speaker Kits</td>
<td>$1,580,534.80</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>Headphones</td>
<td>$1,482,596.48</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Handheld</td>
<td>$1,325,634.44</td>
</tr>
<tr>
<td></td>
<td>Camcorder</td>
<td>Standard</td>
<td>$1,235,711.67</td>
</tr>
</tbody>
</table>
You can sort by multiple measures to have more granular control over how the report is sorted. If there are some matching values of the first sorting measure, then the second sorting measure will be used as a secondary means of determining sort order.

When using the Details display option instead of the Summaries option, you can sort fields in the Details bucket in the same way. This can be helpful if you want to view a sorted list of all records for a field. Right-click a field in the Details bucket and click Sort ascending or Sort descending to sort the report using the values from that field.

You can remove the sorting effect of a field in the Summaries or Details bucket by pointing to the invisible measure field in the Rows bucket and clicking the X, or by right-clicking the original field in the Summaries or Details bucket and clicking No sort. The hidden field is removed from the Rows bucket, but the original field remains in the Summaries or Details bucket. When you remove the original field from the Summaries or Details bucket, the invisible field in the Rows bucket is automatically removed as well.

**Using Sort Limits**

You can use sort limits to control how many values to display in your content. While a filter allows you to limit your content by specifying which values should display, a sort limit allows you to limit it by specifying how many values should display, depending on the amount of information that you want to see.

To add a sort limit, right-click a field in a bucket, point to Sort limit, and select a value. Only fields in certain buckets, generally the default dimension and measure buckets, can have sort limits applied. When you add a sort limit to a measure field, that field is used to sort your content automatically.

When setting a sort limit, the values 5, 10, and 25 are provided for quick selection, but you can select Custom to specify a different number as the sort limit. You can remove the sort limit from a field by right-clicking the field, pointing to Sort limit, and clicking No limit.
When a sort limit is applied to a sort field, only the specified number of values is displayed for that field within each sort group. If a sort limit of 5 is applied to the primary sort field, then only the first five sort values display in the chart or report. If a sort limit of 5 is applied to a secondary sort field, then five values for that field display within each higher level sort value. In the following image, both the Customer Business Sub Region and Customer City fields have a sort limit of 5, so the report shows the first five Customer Business Sub Region values and the first five Customer City values within each subregion.

The values that display are based on the sort order of the field that has the sort limit applied. If an alphanumeric dimension field has a sort limit of 5 and is sorted ascending, then the first five alphabetic values for that field display. If the same field is sorted descending, then the last five alphabetic values display.

As a result, one of the most effective ways to use sort limits is to apply them to a sorting measure field, which allows you to limit the report to the highest or lowest aggregated values in each sort category. To do this, right-click a field in the measure bucket, point to Sort limit, and select a value. In a report, a hidden instance of the selected measure field is automatically added to the top of the Rows bucket, with the sort limit applied. You can click the arrow icon on the hidden field in the Rows bucket to change the sort order, and you can drag the hidden field into a different order in the Rows bucket to change the level at which the sort limit is applied. In a chart, you can right-click the measure field for which you created a sort limit and change the sort order from the shortcut menu.
In the following image, a sort limit of 5 has been applied to the Revenue field from the Summaries bucket of a report. The resulting Revenue sort field has been changed to descending order and moved to apply the sort limit after the Customer Business Sub Region field. As a result, the report shows the cities with the five highest Revenue values in each business subregion.

<table>
<thead>
<tr>
<th>Customer Business Sub Region</th>
<th>Customer City</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Africa</td>
<td>Johannesburg</td>
<td>$41,415.70</td>
<td>$10,333.70</td>
</tr>
<tr>
<td></td>
<td>Maleking</td>
<td>$25,034.25</td>
<td>$7,553.25</td>
</tr>
<tr>
<td></td>
<td>Cape Town</td>
<td>$24,104.82</td>
<td>$5,771.92</td>
</tr>
<tr>
<td></td>
<td>Colesberg</td>
<td>$21,376.84</td>
<td>$5,889.84</td>
</tr>
<tr>
<td></td>
<td>Cairo</td>
<td>$21,197.13</td>
<td>$6,653.13</td>
</tr>
<tr>
<td>Asia</td>
<td>Singapore</td>
<td>$25,762.37</td>
<td>$7,230,319.97</td>
</tr>
<tr>
<td></td>
<td>Ashdod</td>
<td>$8,128,340.40</td>
<td>$2,259,953.40</td>
</tr>
<tr>
<td></td>
<td>Tel Aviv</td>
<td>$150,566.58</td>
<td>$49,920.58</td>
</tr>
<tr>
<td></td>
<td>Chennai</td>
<td>$152,121.33</td>
<td>$42,121.33</td>
</tr>
<tr>
<td></td>
<td>Bangalore</td>
<td>$149,988.09</td>
<td>$38,216.09</td>
</tr>
<tr>
<td>Australia-New Zealand</td>
<td>Melbourne</td>
<td>$159,733.94</td>
<td>$55,975.94</td>
</tr>
<tr>
<td></td>
<td>Sydney</td>
<td>$158,734.72</td>
<td>$53,466.72</td>
</tr>
<tr>
<td></td>
<td>Perth</td>
<td>$42,504.01</td>
<td>$10,363.01</td>
</tr>
<tr>
<td></td>
<td>Port Lincoln</td>
<td>$31,156.87</td>
<td>$7,924.87</td>
</tr>
<tr>
<td></td>
<td>Sidney</td>
<td>$26,763.47</td>
<td>$7,345.47</td>
</tr>
<tr>
<td>Canada</td>
<td>Vancouver</td>
<td>$11,787,731.16</td>
<td>$3,338,880.18</td>
</tr>
<tr>
<td></td>
<td>Toronto</td>
<td>$8,666,496.70</td>
<td>$2,454,965.70</td>
</tr>
<tr>
<td></td>
<td>Calgary</td>
<td>$4,613,906.53</td>
<td>$1,301,867.53</td>
</tr>
<tr>
<td></td>
<td>North York</td>
<td>$3,804,215.87</td>
<td>$1,075,787.87</td>
</tr>
<tr>
<td></td>
<td>Mississauga</td>
<td>$3,476,351.49</td>
<td>$960,260.49</td>
</tr>
</tbody>
</table>
If you are sorting by a measure field with a sort limit, and multiple rows within a sort group have the same value for that measure field, then they are all displayed. This may result in a number of rows higher than the sort limit. For example, the following image shows a report in which the Quantity Sold field has a sort limit of 5. Since multiple Customer City values in the Africa subregion have the same Quantity Sold value, seven values display, representing the cities with the five highest distinct Quantity Sold values in that subregion.

### Styling Reports in TIBCO WebFOCUS Designer

You can apply styling changes to a report to help it visually match the styling of your other content, and make it easier to read and more visually appealing. You can style a report from the Format tab on the Properties panel.
On the Format tab, you can use the quick access menu to select the section or component of the report whose styling properties you want to change, as shown in the following image.

You can style the following sections or components of a report:

- **General.** Set properties, such as a theme, font, or background color, that affect the entire report.
- **Headings.** Set text, border, background, and cell margin properties for report level and page level headings.
- **Columns.** Format the text and cells for column titles and data values.
- **Column Groups.** Format the text and cells for column group, also known as across column, field titles and data values. You can create column groups by adding dimensions to the Column Groups bucket in a report.
- **Totals.** Set text and cell properties for column totals and subtotals.
- **Row Totals.** Set text and cell properties for row totals.
- **Footings.** Set text, border, background, and cell margin properties for report level and page level footings.

If you are styling Columns, Column Groups, or Row Totals in a report, you can select a specific field whose title or values you want to style. You can revert the changes you made in any area by clicking *Reset styling* on the Format tab. Only the settings in the selected area are reset.
Setting General and Columnar Report Properties

When you select General from the quick access menu on the Format tab, you are presented with options to style and format the entire report. These options include the ability to set a theme, change the output format, change the font style and size, style cells and cell borders, set cell margins, and configure how column widths are set. Font and cell styling options can be set for the entire report, or for specific columns within it.

Applying Themes to Reports

On the Format tab, in the General settings, in the General Options section, you can select a theme (.sty file, or StyleSheet), to apply to your report from the Theme menu. Themes style multiple components of a report, such as headers, column titles, and data text, all at once. Themes include associated cascading style sheet files along with a StyleSheet to help coordinate styling between an individual report and the entire visualization.

When creating a stand-alone report, the default theme is Designer 2018. When you change a visualization into a page by adding a second new content item, the theme used for the report is applied to the page. When you add items to the page, either by creating them or adding them as external content, the page theme is used as the default for all content items. You then can change the theme for each individual item.

If you prefer, you can specify one of the themes included with WebFOCUS, such as the Designer 2018, Light, Midnight, or Vivid theme, select a custom theme saved to the Global Resources area in the repository, or you can click Custom to select a legacy template or a StyleSheet saved to a workspace in your repository. When you select a StyleSheet using the Custom option, it is applied to the report and added to the Theme list.

To make a custom theme available directly from the Theme menu, create a folder for it in the Global Resources area, in the Custom folder within the Themes folder. In the new folder that you create inside the Custom folder, you can add a custom StyleSheet to use with charts and reports, and a custom CSS file to use for pages. The .sty file and .css file must both be named theme. An .sty file and .css file that share the same theme folder are associated. If you select a theme for a report, which uses the .sty file, then when you convert it to a page, the associated .css file is used as the page theme by default.

Tip: When creating a custom theme, you can copy the CSS and StyleSheet syntax from existing themes to use as a model.
Note: Charts and reports created for use on pages can use a transparent background to allow the defined background color of the page containers to show through. Since the themes used for charts and reports (.sty files) can be associated with themes for pages (.css files), you can coordinate the background, text, and element colors used in both themes to create content with unified styling. At design time, the page theme associated with the chart or report theme is used for the canvas background. This is for visibility purposes only, and shows how the chart or report will appear when added to a page with the associated theme. The stand-alone chart or report does not include this background.

If a chart or report is run stand-alone instead of being added to a page, the run-time view displays a white background only. This means that if, in order to display on a dark colored page, the font color in the selected theme is defined as white and uses a transparent chart background, then the text will not be visible on the white preview background. An example of such a theme is the Midnight theme, provided as one of the default themes in the Global Resources folder. To view the white text, build your chart or report on the canvas, or add it to a page container with a dark background.

Formatting Text in a Report

You can use text formatting options to change the font, font style, alignment, size, and color of the text in your report. On the Format tab, in the General options, you can set these options for the entire report.

To set the same properties but only apply them to a specific area of your report, select a different option from the quick access menu. For example, select Columns to change the font in the body of the report. In the Select Elements and Columns area, you can specify whether your formatting should apply to the column titles, data values, or both, and which column should be affected. This allows you to set styling options that affect specific columns of the report, highlighting or distinguishing certain fields.

The text formatting options are shown in the following image.
A list of default fonts is provided. To add a font to this list, specify the font files for each font style, such as regular, bold, and italic, in the fontuser.xml file, in your server installation. This file is located in the etc subdirectory of the server configuration directory, for example, drive: \ibi\srv82\wfs\etc. For more information, see the WebFOCUS Font Support topic in Creating Reports With WebFOCUS Language. If you are configuring a TrueType font, you do not need to specify the AFM font metrics file.

Formatting Cells in a Report

You can style the body of your report by applying cell border lines, specifying cell background colors, and setting cell margins. These options can help to make your report more legible by separating and spacing out the text, and by delineating different rows of data. On the Format tab, select General from the quick access menu to apply this formatting to the entire report. Select Columns and then make selections from the Select Elements and Column menus to apply cell formatting to the data values, column headers, or both areas of the selected column or columns.

You can add borders to the report to visually separate each value in the report. Borders are applied around each cell. Select the Show Border check box to enable cell borders. You can then set the border style, thickness, and color. The following border styles are available:

- **Solid.** Applies a solid line border.
- **Dot.** Applies a dotted-line border.
- **Dash.** Applies a dashed-line border.
- **Double.** Applies a two-line border.
- **Groove.** Applies a three-dimensional grooved border. Half of the border is shaded to make it appear three-dimensional.
- **Ridge.** Applies a three-dimensional ridged border. The shaded half of the ridged border is opposite to that of the grooved border.
- **Inset.** Applies a three-dimensional inset border. The inset border is shaded similarly to the ridged border.
- **Outset.** Applies a three-dimensional outset border. The outset border is shaded similarly to the grooved border.

Note that since these border options are applied around the entire cell, they are considered more general than side-specific borders that can be set in a theme or StyleSheet. If your theme or StyleSheet uses these side-specific borders, they will override the borders applied in Designer.
You can also change the background color that appears behind the entire report, only the column titles, or only the data values in one or more columns of a report. Click the color swatch next to Report, Title Row, or Data Row to change the background color for the associated area. If you change the color for Report, the background color of the entire report, including the column title area and data values, is changed. Alternatively, you can set the background color for just the column titles using just the Title Row color option, or for just the data values using the Data Row color option. If you select *Columns* from the quick access menu and then select a specific column from the Select Elements and Columns menus, the background color is only applied to a single column.

When setting the background color for the data values in the report, you can apply different colored bands to make it easier to differentiate different rows or sort groups. You can set alternating bands in a repeating pattern of up to 4 rows. To add bands, click the plus icon to the right of the Data Row option, then set a second color. To add another color to the band pattern, click the plus sign again. To remove a band color, click the minus sign. The following image shows a report with 4 Data Row colors set in a pattern of yellow, white, blue, and white.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Sale Quarter</th>
<th>Product Category</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2015</td>
<td>1</td>
<td>Accessories</td>
<td>4,530</td>
<td>$1,125,123.02</td>
<td>$347,685.02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>3,873</td>
<td>$1,225,199.72</td>
<td>$406,657.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>1,343</td>
<td>$302,839.60</td>
<td>$117,086.60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,717</td>
<td>$3,427,197.08</td>
<td>$925,302.08</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>15,000</td>
<td>$3,320,151.66</td>
<td>$1,072,105.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>3,925</td>
<td>$1,566,904.80</td>
<td>$385,015.80</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,720</td>
<td>$477,391.46</td>
<td>$154,764.46</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Accessories</td>
<td>4,562</td>
<td>$1,165,106.04</td>
<td>$362,612.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>3,312</td>
<td>$1,244,408.92</td>
<td>$409,405.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>1,235</td>
<td>$285,453.66</td>
<td>$110,264.65</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,518</td>
<td>$3,286,394.69</td>
<td>$994,116.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>13,259</td>
<td>$3,026,455.46</td>
<td>$948,934.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>3,749</td>
<td>$1,577,021.42</td>
<td>$387,599.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,731</td>
<td>$480,282.56</td>
<td>$149,265.56</td>
</tr>
</tbody>
</table>
By default, each band spans a single row of the report. As an alternative, you can set each band to span a sort group, visually distinguishing values for different sort fields. To change the scope of each band, open the Alternate On menu and select a sort field in your report. The following image shows a report with 4 Data Row colors set in a pattern of yellow, white, blue, and white, alternating on each value of the Sale Quarter field.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Sale Quarter</th>
<th>Product Category</th>
<th>Quantity Sold</th>
<th>Revenue</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2015</td>
<td>1</td>
<td>Accessories</td>
<td>4,580</td>
<td>$1,125,123.02</td>
<td>$347,805.02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>3,873</td>
<td>$1,225,199.72</td>
<td>$406,657.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>1,343</td>
<td>$302,639.90</td>
<td>$117,066.60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,717</td>
<td>$3,477,197.08</td>
<td>$925,302.08</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>15,000</td>
<td>$3,320,151.86</td>
<td>$1,072,105.66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>3,925</td>
<td>$1,566,904.80</td>
<td>$385,015.80</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,720</td>
<td>$477,301.46</td>
<td>$154,764.46</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Accessories</td>
<td>4,082</td>
<td>$1,105,100.04</td>
<td>$362,012.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>3,812</td>
<td>$1,244,408.92</td>
<td>$409,405.92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>1,235</td>
<td>$285,463.96</td>
<td>$110,264.66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>11,518</td>
<td>$3,268,394.69</td>
<td>$894,116.69</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>13,259</td>
<td>$3,026,456.46</td>
<td>$948,934.46</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>3,748</td>
<td>$1,577,021.42</td>
<td>$387,599.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,731</td>
<td>$480,282.56</td>
<td>$149,265.56</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Accessories</td>
<td>4,783</td>
<td>$1,270,872.45</td>
<td>$390,073.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>4,345</td>
<td>$1,536,974.19</td>
<td>$484,041.19</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>1,659</td>
<td>$349,908.27</td>
<td>$137,684.27</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>12,588</td>
<td>$3,585,613.72</td>
<td>$976,931.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>10,607</td>
<td>$2,730,062.03</td>
<td>$817,195.03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>4,301</td>
<td>$1,796,316.25</td>
<td>$443,139.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>1,000</td>
<td>$557,302.58</td>
<td>$170,352.58</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Accessories</td>
<td>6,127</td>
<td>$1,478,190.06</td>
<td>$458,077.06</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Camcorder</td>
<td>5,691</td>
<td>$1,871,848.70</td>
<td>$608,214.70</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computers</td>
<td>2,493</td>
<td>$503,542.66</td>
<td>$195,915.66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Media Player</td>
<td>14,943</td>
<td>$4,699,372.86</td>
<td>$1,250,601.86</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stereo Systems</td>
<td>14,541</td>
<td>$3,790,147.58</td>
<td>$1,124,739.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Televisions</td>
<td>4,431</td>
<td>$1,540,975.20</td>
<td>$373,803.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Video Production</td>
<td>2,675</td>
<td>$753,824.57</td>
<td>$232,170.57</td>
</tr>
</tbody>
</table>
To better space out the values in your report, when using a paginated output format such as HTML, PDF, PowerPoint, or XLSX, you can change the cell margins. You can select preset small, medium, and large margin options, or click the ellipsis button to set custom cell margins. When setting custom margins, you can set different margin sizes for each side of the cells in your report. You can clear the check boxes for different sides of the cells to use default values for them. For example, if you clear the check box for the Top margin, the default margins are used for the top of each cell. Custom margin sizes are set inches. You can use the Cell Margins settings in the General options to set margins for the entire report, or set margins for each area of the report individually by selecting a different option from the quick access menu. When setting margins using the Columns-level options, it may be preferable to set them separately for the column titles and data values. Since each line of text in the column titles is treated as a separate cell, you may prefer to use smaller top and bottom margins for them than for the cells containing data values.

To undo all custom styling changes made in the General options or Columns options, click Reset styling. All options revert to their default values, which are dependent on the theme used in the report.

**Controlling Column Width**

When you create a report, the width of each column depends upon the values in the column, and the width of the page in which the report is displayed. Three options are available to set column width behavior. They are available in the Column Width menu, in the Other Options section of the General options on the Format tab.

The default Column Width option is *autofit*. When the autofit option is used, the width of each column is set to fit the column title or row with the most characters, minimizing the amount of space that each column uses while still displaying each value in its entirety.

If you change the Column Width option to *based on value*, the maximum width of each column is based on the format of each field used in the report. If the report is filtered so that the longest values are not included, the column width is still wide enough to include those values.

Select *fixed value* to create a report that always fills the width of the container into which it is placed, no matter how wide the container is.

Note that if your theme specifies values for the SQUEEZE or AUTOFIT options, that this may override the Column Width setting in WebFOCUS Designer.
Adding Margins to Report Headings and Footings

When you edit the text in the heading or footing of a chart or report, a set of basic text styling options appears in the styling toolbar at the top of the canvas. This toolbar provides options to change the font, text size, font style, alignment, text color, and background color of the heading or footing text. For more information about these options, see Adding Headers and Footers to Content on page 654.

You can set margins for the headings and footings in a report from the Format tab. Open the Format tab and then select Headings or Footings from the quick access menu. In the Heading Options and Footing Options areas, you can apply a preset margin by selecting the preset Small, Medium, or Large options, or you can select the custom margin option and use a spinner control to set your own top and bottom margins separately. These can be set in intervals of 0.001 inches.

Formatting Column Group Labels in a Report

When you add a field to the Column Groups bucket in a report, measure columns are repeated for each value in that field. The column group, or across column, field values are shown above the column titles for each measure field, identifying the dimension values by which they are aggregated.

When creating a report with column group fields, such as a crosstab report, you can select Column Groups from the quick access menu on the Format tab to style the field names and values for each one. As when styling columns in a report, from the Select Elements and Columns menus, you can choose whether to style the field titles and values, or just one or the other. You can also choose whether to style the field titles and values for all column group fields, or a single column group field. Note that while the default field selection is All Columns, column group field names and values display in a row. All Columns in this case refers to all columns from your data source, and allows you to style column group field titles and values for all fields in the Column Groups bucket.

You can style column group field titles and values by changing the font, style, alignment, size, and color of the text; changing the background color of the title and values; and adjusting margins. When adjusting margins for column group labels, you can only set the top and bottom margins, since the left and right margins are based on the widths of the columns in the body of the report.
In the Other Options area, you can select *Show title on the side* to display the column group field titles and value in the same row of text. This is especially useful in Excel output, where placing the column group field title on a separate row from the values would result in empty cells. Select *Hide null columns* to hide column group values that only have null values on a page of a report, so that columns without values are not shown. For example, the following image shows a report with the *Hide null columns* option enabled and page breaks on the Customer Business Sub Region field. Since there are no values in the SA-Span subregion for the Sale Year value of 2015, the columns for that year are removed. Since there were sales in 2015 in the SA-Port region, the columns are still included on that page of the report.

You can also select *Repeat across values* to show the column group value above every measure column in the report instead of only once for each group.

**Styling Column and Row Totals in a Report**

As with the data values in a report, you can apply styling to the row and column totals and subtotals in a report to visually separate them from the rest of the values in your report and to draw attention to them. To add row and column totals to a report, on the Settings tab, in the Content Settings area, select *Enable column totals* and *Enable row totals*. To add subtotals, right-click a field in the Rows bucket of a report, point to *Insert breaks*, and select an option from the Subtotals section of the Insert breaks menu. To style your totals, on the Format tab, select *Totals* or *Row Totals* to display column or row total styling options. These options include text styling options, such as the font, style, alignment, size, and color; background color options; and cell margin sizing. Similar to when setting margins for column group labels, you can only set the top and bottom margins for column totals and left and right margins for row totals, since the other margins are based on the margins of the cells in the body of the report.
When styling row totals, from the Select Elements and Columns menu, you can choose whether the styling changes should affect the total label, values, or both. You can also choose which columns are affected if there are across columns in the report. When row totals are added to a report with column groups, a separate row total column is generated for each measure field in the report. Each of these row total columns can be styled separately by changing the text and cell styling. When there are no column group fields, all measure fields are summed into a single row total column to which your styling is applied.

Column totals, on the other hand, are arranged into a single row to which you can apply styling. You can style the grand totals or all subtotals, or you can select a specific sort field whose subtotals you want to style if you have multiple levels of subtotals for different sort fields. The following image shows different styling applied to the grand totals and subtotals in a report so that they can be easily distinguished.

![Image of a report with styled row and column totals]

For column totals and subtotals, you style the total label and values separately using the Total Tag Options and Column Options areas. This allows you to differentiate between labels and values in your totals and subtotals. If you select a column in the Column Options area, you can apply different styling to the grand total or subtotal values for different measure fields. You can also change the background color for the grand total or subtotal rows and adjust the margins used for the grand total or subtotal cells.

**Setting Page Layout Options**

When creating reports for different types of output, you may want to change the page layout, depending on the type of file that will be generated. For example, PowerPoint slides are typically landscape oriented, and a smaller size than PDF pages, which tend to be vertically oriented. You can set options such as page orientation, page size, and margins, separately for each output format, by selecting *Output Settings* from the quick access menu on the Format tab.
The settings specified in the Output Settings options are specific to each output format. If you change the output format of your report, then a separate set of page settings appears. This allows you to ensure that the report displays properly in all output formats, even when user output format selection is enabled.

The following page layout options are available for each output format:

- **Page Size.** You can set the size of the page on which the report displays to the following common standards:
  - **A3.** Sets the size of each page containing the report to 297 by 420 millimeters, or 11.7 by 16.5 inches.
  - **A4.** Sets the size of each page to 210 by 297 millimeters, or 8.25 by 11.7 inches.
  - **A5.** Sets the size of each page to 148 by 210 millimeters, or 5.8 by 8.25 inches.
  - **Letter.** The default. Sets the size of each page to 8.5 by 11 inches, or 216 by 279 millimeters.
  - **Tabloid.** Sets the size of each page to 11 by 17 inches, or 279 by 432 millimeters.
  - **Legal.** Sets the size of each page to 8.5 by 14 inches, or 216 by 356 millimeters.
  - **PowerPoint Slide.** Sets the size of each page to that of a standard PowerPoint slide, which is 7.5 by 10 inches, or 191 by 254 millimeters. This page size, like all other report page size settings, is portrait oriented by default. Change the page orientation of your report to *Landscape* to match the default page orientation used in Microsoft PowerPoint.
  - **Large Size.** Sets the size of each page to the ANSI E architectural paper size, which is 34 by 44 inches, or 864 by 1118 millimeters.

- **Orientation.** The direction in which the page is oriented. Select *Portrait* to align the longer sides of the page vertically, or *Landscape* to align them horizontally.

- **Page Margins.** The amount of blank space between the report and the top, bottom, and sides of the page. Page margins can be set on each side in increments of 0.001 inches. The report is aligned to the top left corner of the page by default, meaning that the right and bottom margins are only used if the report is wide or long enough to occupy more than one page.

  **Note:** When a page margin is set to 0, the default margin size of 0.25 inches is used.
Cell Margins. The amount of blank space between the top, bottom, left, and right sides and the text of each cell in the report. These margins affect the entire report when the selected output format is used, unless overridden by more granular cell margin settings, such as those set at the column or total level. [see spec for reason why this is here ** doesn’t say; I guess you might just want to style different outputs differently? Seems reasonable enough to me. I assume these are page level (instead of, say, column level or something more granular)]

To revert the page layout settings for the selected output format to the default, click Reset styling. The default page layout settings are letter page size, portrait orientation, and 0.25 inch margins.

Converting Reports to Excel Tables

You can use the Excel Tables feature to utilize the Excel functionality and apply it to the reports created in WebFOCUS Designer. You do that by enabling the XLSX format and configuring your output settings.

Procedure: How to Convert a Report to an Excel Table

1. Create a report as described in Creating Reports on page 502.
2. In the Output Format menu above the canvas, select XLSX.
3. In the Settings/Format pane, click Format, and select Output Settings from the drop-down menu.
4. In the XLSX Features section, select the Enable Excel Tables checkbox and, optionally, edit the name field below to give your Excel table a unique identifier.
An example of the fully configured Format pane for an Excel-optimized report is shown in the following image.

5. Save your report and exit WebFOCUS Designer.

Adding Filters to a Visualization

As you create charts and styled tabular content in WebFOCUS Designer, you may want to narrow the display of information that is shown. You can do this by creating filters for fields in your data source. You can also use filters as a way to create custom displays of the data that you show in your content. For example, you may only want to show revenue information for specific product categories and models in a given year, or for product categories that exceed a certain revenue value.
Filters in WebFOCUS Designer can utilize one of two behaviors: static and prompted filtering. Static filters are applied to individual content items at design time, and allow you to apply consistent filter values to a chart or report. Prompted filters, on the other hand, allow users to select the filter values to use in your content at run time. When you create a new prompted filter, it affects all new content on the page. In addition to adding prompted filters to new content, when existing content using a prompted filter is added to a page, you can create automatic filter controls that can be used at run time. Any content that uses the same parameters can be filtered using the same control. These controls are not generated for static filters.

To create a static filter for a selected field, drag it from the Fields tree on the Resources panel to the Filter bucket, which is located below the field container buckets on the Properties panel when you select a content item. When you create a static filter, the Add Filter dialog box appears, as shown in the following image.

You can select filter values and the relationships those values have to the data that you want to display in your chart or report. Static filters can only be created for new content.
You can add prompted filters to a visualization using new or existing content in one of the following ways:

- When creating new content, drag a data field to the Filter toolbar below the page toolbar.
- When creating new content, right-click a data field and click Add to filter toolbar.
- When creating or interacting with new content, select one or more sections of a chart by clicking or lassoing them, then click Keep.
- When creating or interacting with new content, use the filter options in the In-Document Analytics menu on the column of a report.
- When creating a visualization from existing content, add an item that uses dynamic parameter filters to the visualization.

Click the resulting label on the Filter toolbar to open a control, from which you can select default filter values. Users will be able to change the selected value at run-time.

Adding Static Filters to Content

Filters allow you to limit the data that displays in your content, making it easier to find useful information by removing extraneous data values. You can create prompted filters, which allow users to select the filter values to use in your content at run time, or you can create static filters, which are always applied to your content whenever it is run. Prompted filters allow you to create controls when the content that uses them is added to an assembled page, while static filters do not. Additionally, prompted filters affect all new content on the page, or any referenced content that uses the filter. Static filters, on the other hand, affect only the item for which the filter was created.

Static filters are a good choice when you want the same filter values to be applied to your content at all times, or want to create a filter that only affects a single content item.

To create a static filter, when creating a new chart or report, drag a field into the Filters bucket on the on the Settings tab of the Properties panel. The Add Filter dialog box opens, and presents options relevant to the type of field that you are filtering.

These options also differ depending on whether you are filtering compared to selected values or to another field. You can change this option by setting the Compare to option to Value or Field.
When you set the Compare to option to Value you can filter alphanumeric fields using the following options:

- **Select values.** When using the Value comparison type, select the values that will be used to define the filter.

- **Select from data.** Search for and select values from the data source used in your content.
  
  Click *Load values from data* to display all available values from the selected field in the left list. Select one or more values and click *Add* to add them to the list of selected filter values on the right. To remove a value from the list of selected filter values, select one or more values and click *Remove*. You can also click *Clear List* to remove all selected values.

- **Select from file.** Allows you to pull data values from a file on your system. You can select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to import values for selection. These values are taken from the first column of the file. This option can be an easy way to select a large number of values that are found in another data source.
  
  Click *Load values from file* to select a data file and display all available values from it in the left list. Select one or more values and click *Add* to move them to the list of selected filter values on the right. To remove values from the list of selected filter values, select one or more values and click *Remove*, or click *Clear List* to remove all values.

- **Enter manually.** Type a value and click *Add* or press the Enter key to move it to the list of selected filter values on the right. Multiple values must be typed separately. You can also choose whether or not to include missing or blank values in the filter. To remove a value from the list of selected filter values, select one or more values and click *Remove*, or click *Clear List* to remove all selected values.

- **Wildcard.** Manually type a single string that you can use to select multiple filter values. You can specify that the values in your content should start with the string, end with the string, or contain the string at any point. Wildcard value filtering is case-sensitive. You cannot use a wildcard filter value at the same time as specified values.

- **Exclude.** Available when using the Value comparison type. When the *Exclude* check box is selected, the values selected for the filter are excluded from the request. When cleared, which is the default state, the selected values are included.
The Add Filter dialog box when filtering an alphanumeric field is shown in the following image.

When you set the Compare to option to *Value*, you can filter numeric fields using the following options:

- **Select values.** Select the values or field that will be used to define the filter.

- **Select ranges.** Provides options to specify a range of values for your filter. When selecting data ranges, you can apply an aggregation option to use when filtering the selected field. Use None to filter on data values before aggregation, or use a different aggregation to filter on sorted values, aggregated by the selected operation. For example, use Summary to filter by measure values summed for each sort value. For more information, see *Summarizing Numeric Data Using Filters* on page 598.

- **Single value.** Select a filter operator, then filter for all values before or after a selected start or end point. You can select a value using the slider or type a value into the text box.
- **Range of values.** Set a static range of values to use for the filter. Select a start and end point using the slider or text boxes, and set filter operators for each.

You can type a value that is outside the range of values in your data. In this case, the text box displaying the value is outlined in purple and a message indicates that the value is out of range.

- **Select from data.** Search for and select values from the data source containing the filter field.

Click *Load values from data* to display all available values from the selected field in the left list. Select one or more values and click *Add* to add them to the list of selected filter values on the right. To remove a value from the list of selected filter values, select one or more values and click *Remove*. You can also click *Clear List* to remove all selected values.

- **Select from file.** Allows you to pull data values from a file on your system. You can select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to import values for selection. These values are taken from the first column of the file. This option can be an easy way to select a large number of values that are found in another data source.

Click *Load values from file* to select a data file and display all available values from it in the left list. Select one or more values and click *Add* to move them to the list of selected filter values on the right. To remove values from the list of selected filter values, select one or more values and click *Remove*, or click *Clear List* to remove all values.

- **Enter manually.** Type a value and click *Add* or press the Enter key to move it to the list of selected filter values on the right. Multiple values must be typed separately. You can also choose whether or not to include missing or blank values in the filter. To remove a value from the list of selected filter values, select one or more values and click *Remove*, or click *Clear List* to remove all selected values.

- **Exclude.** Available when using the Value comparison type. When the *Exclude* check box is selected, the values selected for the filter are excluded from the request. When cleared, which is the default state, the selected values are included.
The Add Filter dialog box when filtering a measure field is shown in the following image.

When you set the Compare to option to Value, you can filter date fields using the following options:

- **Select values.** Select the values or field that will be used to define the filter.

- **Select ranges.** Provides options to specify a range of dates for your filter.
  - **Single date.** Filter for all dates before or after a selected start date or end date, by selecting a filter operation and a date value.
  
  - **Range of dates.** Set a static range of dates to use for the filter by selecting a start and end date and setting filter operators for each.

- **Select from data.** Search for and select values from the data source containing the filter field.
Click **Load values from data** to display all available values from the selected field in the left list. Select one or more values and click **Add** to add them to the list of selected filter values on the right. To remove a value from the list of selected filter values, select one or more values and click **Remove**. You can also click **Clear List** to remove all selected values.

- **Select from file.** Allows you to pull data values from a file on your system. You can select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to import values for selection. These values are taken from the first column of the file. This option can be an easy way to select a large number of values that are found in another data source.

  Click **Load values from file** to select a data file and display all available values from it in the left list. Select one or more values and click **Add** to move them to the list of selected filter values on the right. To remove values from the list of selected filter values, select one or more values and click **Remove**, or click **Clear List** to remove all values.

- **Enter manually.** Type a value and click **Add** or press the Enter key to move it to the list of selected filter values on the right. Multiple values must be typed separately. You can also choose whether or not to include missing or blank values in the filter. To remove a value from the list of selected filter values, select one or more values and click **Remove**, or click **Clear List** to remove all selected values.

- **Exclude.** Available when using the Value comparison type. When the **Exclude** check box is selected, the values selected for the filter are excluded from the request. When cleared, which is the default state, the selected values are included.
The Add Filter dialog box when filtering a date field is shown in the following image.

Set the Compare to value to Field to filter the selected field in relation to another field in the request. For example, you could use this filter to identify values for which the revenue was less than the cost of goods sold. When filtering by compared field values, the following options are available:

- **Source aggregation.** Available only for numeric fields. Select an aggregation option to use for filtering the selected field. Use None to filter on data values before aggregation, or use a different aggregation to filter on sorted values, aggregated by the selected operation. For example, use Summary to filter by measure values summed for each sort value.

- **Operator.** Set the relationship that will define how the filter is applied. Options are:
  - **Equal to.** Values display in your content if they match the specified filter values.
  - **Not equal to.** Values display in your content if they do not match the filter values.
  - **Greater than or equal to.** Values display in your content if they match the selected filter values, come after them alphabetically, or have a higher numeric value.
- **Greater than.** Values display in your content if they come after the selected filter value alphabetically or have a higher numeric value.

- **Less than or equal to.** Values display in your content if they match the selected filter value, come before it alphabetically, or have a lower numeric value.

- **Less than.** Values display in your content if they come before the selected filter value alphabetically or have a lower numeric value.

- **Compare aggregation.** Select an aggregation to apply to the field that the selected field is being compared to. Use None to compare to data values before aggregation, or use a different aggregation to compare to sorted values, aggregated by the selected operation. For example, use Summary to compare values from the selected field to values in the comparison field summed for each sort value.

- **Compare field.** When using the Field comparison type, provides a list of fields in your data source. Values from the field for which you are creating the filter are compared to those in the comparison field and filtered out based on the selected operator.

The Add Filter dialog box when filtering a numeric field by comparison to another field is shown in the following image.
Adding Promoted Filters to a Visualization

As you create charts or styled tabular content in WebFOCUS Designer, you may want to narrow the display of information that is shown. You can do this by creating filters for data fields in your content. You can also use filters as a way to create custom displays of the data that you show in your content. For example, you may only want to show revenue information for specific product categories and models in a given year.

Prompted filters can be created for external content added to a page, in which case any parameters in that content can be added as filter prompts, or for new content, in which case the filter affects all new content on the page.

When you add filtered content to a page, you can open the Filters tab on the sidebar and click Add all filters to page to add the filters to the page automatically, providing interactive controls that your users can choose from to change the view of data available to them. Filtered content can also be kept stand-alone, and you can choose to enable parameter prompting, which requires a user to make a selection before the content displays. There is no limit to the number of filters that you add, however, as you add more than five filters, all filters may not fit on your screen. If you are using a carousel filter layout, used for prompted filters added to new content, you can use the arrow control to scroll over to see any filters that are not visible in the Filter toolbar, as shown in the following image.

If you are using a columnar layout, which is used for a visualization assembled from existing content, then filters are split into additional rows as they exceed the number of columns on the page, as shown in the following image.

You can add prompted filters to a chart or styled tabular content in one of the following ways:

- When creating new content, drag a data field to the Filter toolbar below the page toolbar.
When creating new content, right-click a data field and click Add to filter toolbar.

When creating or interacting with new content, select one or more sections of a chart by clicking or lassoing them, then click Keep.

When creating or interacting with new content, use the filter options in the In-Document Analytics menu on the column of a report.

When creating a visualization from existing content, add an item that uses dynamic parameter filters to the visualization.

**Note:** You can add data fields to the filter toolbar even if you do not have it displayed in your view.

You can remove filters from the filter toolbar by clicking the X in the upper-right corner of the filter, or by right-clicking the filter and then clicking Delete.

You can create a maximum of one filter per measure field, and a maximum of two filters per dimension field, for individual dimension field values and for an aggregation of the dimension field. The aggregation of a dimension field can be a count, count of distinct values, or a percent of count. You can create an aggregated dimension filter by adding the dimension to your content as a measure, right-clicking the aggregated field in a measure bucket, and then clicking Add to filter toolbar. If you right-click a field that already has a filter and click Add to filter toolbar, or drag it into the filter toolbar, the existing filter control expands for you to select filter values.
Once you have created filters, you can click them to select default data values and set selection options for each filter. For example, when you create a filter using a dimension, it lists the available data values. You can then select the default filter values, as shown in the following image.

![Filter UI Example](image)

By default, no values are initially selected in the list control, which means that all values are displayed by default. To select default values, you click the filter control, and begin clicking the data values that you want to use as the default, then click outside the filter control area to apply the selection.

If you select one or two values, each selected value is listed by name in the filter control. If you select three or more values, the filter control shows the number of values selected out of the total number of available values. If no values are selected, the filter control says All. All available filter values are reflected in your content. If you select all listed values or click Select all, then the filter indicates that \( n \) of \( n \) values are selected. If the values in the field change in the data source, then the filter does not dynamically update to include them like it would if no values had been explicitly selected.

The selected values are displayed in the chart at run time by default, and users can select other values to display them.
Note: In charts, reports, and visualizations with new content, drop-down list controls and slider controls have a default record limit of 5000 values. Values beyond this limit are not available for selection in the filter control. There is no record limit for filters in visualizations assembled from existing content, or in calendar controls.

You can change this record limit from the Administration Console, on the Other page of the Configuration tab, using the Designer/InfoAssist record limit setting. You can increase or decrease the record limit, or set it to 0 to display all values in filter controls. Displaying all values may result in performance issues, however.

When multiple prompted filters for alphanumeric dimension fields are created in a visualization created with new content, they are chained in all directions, by default. This means that the selection from one prompted filter control automatically filters and updates the available values in the other controls, so they only display relevant values. This ensures that you cannot select filter values that result in no data displayed in the visualization. You can change the chaining setting from multidirectional chaining to hierarchical chaining, or turn chaining off, from the Filter options menu.

In pages assembled from existing content, chaining is unidirectional, applied only to filters lower in the chaining hierarchy than the filter for which you selected values. Filters for fields in the same hierarchy are chained automatically, and you can drag a field onto another field in the filter list in the Filters tab to manually make it a child of that filter for chaining purposes. For more information about filter chaining in new content and pages assembled from existing content, see Chaining Filter Control Selections on page 583.

When creating prompted filters for new content, you can choose to exclude data values from the list. To do this, right-click the filter and select Exclude. You can then click the filter control again, and begin clicking the data values that you want to exclude from the list. Once you have selected the data values that you want to exclude, your chart refreshes.

At run time, instead of choosing which values to display in the chart, users select values to exclude from the chart.

You can also set a prompted filter for new content to use a single value instead of multiple values. If you right-click a prompted filter for new content and click Single, when you click the filter control again, you are only able to select a single value. In filters for existing content, you will have already defined whether or not the filter is multiselect or single-select.
If you add a filter using a numeric field, such as a measure, (for example, Cost of Goods), you can use a slider to adjust the range of data values that display, as shown in the following image.

![Cost of Goods Filter](image)

Click the filter, and use the slider options on either side to modify the range of data values. You can set a range using both ends of the slider. To select a single value, set both ends of the slider to the same value.

The filter for a numeric field is applied after aggregation by default. That means that the filter is applied based on summed values for all sort values in the chart instead of filtering each row of the data source before aggregation. You can right-click a new prompted filter and point to Aggregation to select a different aggregation operation, or select Detail to apply the filter to each row before aggregation. For more information, see Summarizing Numeric Data Using Filters on page 598.

If you right-click a new numeric filter and select Greater than or equal or Greater than, you can select a minimum value for the filter range. The upper limit on the slider is fixed and cannot be moved. Selecting Greater than or equal includes the value indicated by the slider in the filter, while selecting Greater than excludes this value. Similarly, if you right-click a numeric filter and select Less than or equal or Less than, you can select a maximum value to display. The lower limit on the slider is fixed and cannot be moved. Selecting Less than or equal includes the value indicated by the slider in the filter, while selecting Less than excludes this value. The slider displays the greater than (>), less than (<), greater than or equal to (≥), and less than or equal to (≤) symbols to differentiate your choices.

**Note:** Selecting the full range of values in the slider includes all values in the filter. The value indicated by the slider head is not excluded in this case, even if the Greater than or Less than filter options are used.
If you add a date field, you can use the date picker window to select a start or end date, range of dates, and more, as shown in the following image.

![Date Picker Image]

You can use a default range available in the list on the left, or select your own range of dates from the calendar. Click the same date twice to select a single day.

If you right-click a new date filter and select After or Before, you are unable to select a range using either the preset or custom range options. Instead, use the calendar to select a start or end date for the filter.

Similar to filtering a numeric field, you can right-click a date filter control and click On or after or On or before, as an alternative to After or Before, to include the start or end date selected in the calendar. The After and Before options do not include the selected date in the date range of the filter.

In addition to the options specific to each type of filter, you can make the filter required. When a filter is required, filtered content will not load until the user makes a selection for that filter. To make a prompted filter for new content required, right-click the filter and click Require selection. To make a prompted filter for existing content required, select the filter control and, on the Settings tab of the Properties panel, clear the Optional check box.
You can right-click a filter control for existing content on a page to access formatting options. For example, you can convert a list control to radio buttons, check boxes, or a button pane, merge two related controls, and access configuration and format options on the Properties panel. For more information, see *Styling Filter Controls in a Visualization* on page 631.

**Filtering a Chart with Visual Selections**

You can visually create prompted filters by selecting areas of a chart directly from the canvas as you create it, as well as at run-time. This is called on-chart filtering. Since on-chart filtering is performed based on visual selections on a chart, they are quick and intuitive to create. On-chart filters created from one item immediately affect all other content created on the page, allowing you to see the impact of your filter immediately. On-chart filtering is available from pages containing one or more new content items, and from stand-alone charts created using the AHTML output format.

On-chart filtering is enabled in applicable content types by default. To disable on-chart filtering, open the *Filter options* menu and deselect *Use content as filters*. 
To use on-chart filtering, select one or more areas of a chart by clicking a single section or by clicking and dragging, or lassoing, an area of the chart. The selected sections of the chart are highlighted, and a tooltip appears with information about the selected area, as shown in the following image.

<table>
<thead>
<tr>
<th>Container 1</th>
</tr>
</thead>
</table>

From the tooltip, you can filter the entire visualization for the data that you selected in the chart. Click *Keep* to create a prompted filter for the selected values, or click *Exclude* to create a filter that excludes the selected values.
You can create several filters using on-chart filtering to further refine the data that you display in the visualization. Each of these filters affects every item on the page. When a filter is created, it is added to the Filter toolbar. If the filter applies to a single dimension, you can click the filter label in the toolbar to edit it. If the filter is applied to multiple dimensions, such as a bar chart with one dimension in the Horizontal bucket and another dimension in the Color bucket, then the filter is not editable from the Filter toolbar. However, you can point to it to see a tooltip listing the filter selections, as shown in the following image.

You can right-click the filter label at design time to delete the on-chart filter or swap between keeping and excluding the selected values. You can also delete a filter created with on chart filtering by selecting an area of the chart and clicking Remove Filter on the tooltip, or by clicking the X on the filter control in the Filter toolbar. The visualization restores the values previously hidden by the on-chart filter.

On-chart filtering works similarly at run time. When you run a page created with new content, you can click or lasso different areas of a chart to dynamically filter the entire page.
Chaining Filter Control Selections

When a content item or page includes multiple filters, chaining ensures that those filters always return valid values to your content. When you select a value from one of the filter controls, the other controls can be filtered and updated based on the value that you select, if chaining is applied. For example, if you have a filter for Sale Quarter chained to a filter for Sale Month, then when you select Q1 from the Sale Quarter filter, the Sale Month filter updates to show only the months of January, February, and March, and automatically excludes any month values that were not in Q1.

Two different chaining behaviors are available: multidirectional and hierarchical. When multiple prompted filters for alphanumeric dimension fields are created in a visualization created with new content, they are chained multidirectionally, by default. This means that the selection from one prompted filter control automatically filters and updates the available values in all other controls for alphanumeric fields, so they only display relevant values. This ensures that users cannot select filter values that result in no data displayed in the visualization, regardless of the order and arrangement of the filter controls. To select a value that has been hidden because of chaining, clear any other filters that may have resulted in the value being unavailable. Note that on-chart filtering also affects the available filter values when multidirectional chaining is enabled.
For example, the following image shows a chart with multidirectional filter chaining enabled. Notice that, since the filter for Sale Day was set to 31, only months with 31 days are shown in the drop-down list for Sale Month.

If you make selections in one filter control, and then make selections in another chained filter control that make some of the original values unavailable, those originally selected values are restored when the other filters are cleared. For example, if you set the Sale Month filter to September and December, and then set the Sale Day to 31, September is no longer visible in the Sale Month control, since it only has 30 days. Only December is selected. When you clear the Sale Day control, both September and December are selected once again in the Sale Month control.

Full multidirectional chaining is only applied to list controls. Calendar and slider controls are not chained. While slider controls and preset ranges in calendar controls update to reflect the current range of data, similar to chaining, the values selected using a slider or calendar do not affect the other controls.
You can change the chaining setting for filters in the page to hierarchical chaining or no chaining by clicking the Filter options menu and selecting Link hierarchies or Do not link filters, respectively. The option to change chaining behavior is only applicable to stand-alone content or content created within a visualization.

Hierarchical chaining is based on drill levels in your metadata. When you select a filter value, chaining is applied to fields that are lower in the same filter hierarchy. Filter controls for fields that are higher in the same hierarchy are not affected by filter selections when using hierarchical chaining, nor are filter controls for fields that are not in the same hierarchy.

Hierarchical chaining is the default behavior for filter controls that are added to a page from external content. When external content is added to a visualization, hierarchical chaining is applied automatically to any content with WHERE filters using a WITHIN phrase. WebFOCUS Designer automatically adds the WITHIN phrase to filters from the same metadata hierarchy, so hierarchical chaining is enabled for content items created in WebFOCUS Designer by default when they are added to a page as external content.
When assembling a page from existing content, you can manually apply hierarchical chaining relationships to filter controls from the Filters tab on the sidebar, even if those fields are not part of the same metadata hierarchy. The Filters tab shows a list of all parameters in your assembled page. The order of this list does not impact filtering behavior, but the parameter list does indicate chaining hierarchies, which display as values indented below their parent value. Drag a parameter in the list on the Filters tab onto another parameter to make it a child of that filter control. You can create a multi-level chaining hierarchy so that selections from one filter apply chaining to a second filter, and selections from the second filter apply chaining to a third filter. The following image shows the parameter list with a selection of filters that have been added to a page assembled from existing content.

In this example, the filter selections in the Customer Business Region filter are chained to the Customer Country and Customer State Province fields, so if you select North America as the business region, then only countries and provinces in North America will be available from the other respective filter controls. Since hierarchical chaining is unidirectional, if you select a country for the Customer Country filter, the Customer Business Region is not affected, so you could still select a business region other than the one that contains the previously selected country.
Filters from multiple data sources used for content in an assembled page can be chained together, although if the field name and values of parent filters do not exist in the data source used for the child filter, chaining will not work properly. To unchain a parameter, drag it into the empty space between the Add all filters to page button and the top parameter in the list. The parameter is removed from the chaining hierarchy and moved to the bottom of the list.

**Applying Prompted Filters From External Content**

Importing a filter from external content in WebFOCUS Designer is a quick and intuitive process. Additionally, parameter filters added to a page from existing content can be rearranged and styled with options unavailable to filters created for new content in a page.

Whenever you add a parameterized content item to the canvas, such as a chart or report that uses a prompted filter or dynamic parameter, the parameters are recognized and you can create filters for them automatically. A badge count is overlaid on the Filters tab on the sidebar, as shown in the following image.

The Filters tab provides options to add filters to your page and apply chaining to them. Open the Filters tab and then click Add all filters to page to create filters for all identified parameters. Alternatively, right-click a parameter in the list to create a single filter control. Each filter in the list on the Filters tab displays the filter name and, under Bindings, the data source and target items associated with the filter. Available filter values are pulled from the data source, and the selected values are passed to the target items. Chaining is indicated by tabbed hierarchies on the Filters tab, and can be applied manually by dragging one filter onto another in the list.

After you add filters from external content to a page, you can right-click a filter control to access formatting options. For example, you can convert a list control to radio buttons, check boxes, or a button pane, merge two related controls, and access configuration and format options on the Properties panel.

As an alternative to using the Filter toolbar, or in addition to it, you can also add a grid container to a page assembled from existing content by dragging it from the Resources panel when you select the Container tab on the sidebar. A grid container includes multiple cells into which filter controls can be placed. You can also move the original filter toolbar or have it display in a modal window by selecting the entire page and then clicking one of the filter location options on the Settings tab of the Properties panel.
You can interact with the filter controls in an assembled page at design time to see how different filter selections affect your content. However, these filter selections are not retained at runtime. To change the default value for a filter in an assembled page, select the filter and, on the Settings tab, in the Data Settings section, type a value into the Default value text box.

You can also change the values that are available from the filter control. As an alternative to the values that are automatically brought in from the field that the filter is associated with, you can manually add values to the control as a static list, or import all values from an external data source as a dynamic list. Once you add controls to the page, select a control and, on the Settings tab of the Properties panel, in the Bindings section, click the pencil icon next to the Source box. The Edit Source dialog box opens.

In the Edit Source dialog box, leave Default selected to automatically pull all relevant values from the data source. Select Static and then click Add Row to add a new value. You can type the literal value that is passed to the filtered content in the Value column, and the text that displays in the filter control to represent that value in the Display column. You can add multiple items, reorder them, and delete them as needed. The static list options in the Edit Source dialog box are shown in the following image.
If you select *Dynamic*, you are presented with the choice of two options: From Data and From Procedure. If you select the *From Data* option, you can choose a synonym available in your environment, and then select the fields from that synonym that should provide the actual and display values for the filter. Optionally, you can enable sorting for your filter either by the actual or display value as well as configure the sorting order. The options to populate a filter with values from fields in a data source are shown in the following image.

If you select the *From Procedure* option, you can bind your filter to an existing content item in your repository. Keep in mind that this item must be converted to an XML format in Text Editor, as shown in the highlighted section of the following image.
Select your previously created and modified item in the Procedure field, then select fields from this item that should provide the actual and display values for the filter. The sorting options are disabled here to preserve the sort order defined by the selected procedure. An example of the options to populate a filter with values from fields in a procedure is shown in the following image.

![Edit Source](image)

**Note:** You can leave the Display from field empty, if the display value is the same as the actual value. If left empty, the Display from field automatically reflects the Value from field setting.
To see which filters apply to which external content items, in addition to the binding information on the Filters tab, click Info on the Visualization toolbar. Each content item on the page lists the parameters by which it is filtered. The chart displayed in the following image is affected by filters for six fields, listed under Parameters/Filters.

![Chart showing filter parameters](image)

**Procedure:** How to Add Filters From Existing Content to a Page

When you bring existing, parameterized content into a page, you are prompted to create filter controls for each parameter. Once created, these controls can be modified with a set of additional options that are not available when creating new content items.

1. Open WebFOCUS Designer. On the WebFOCUS Hub or the WebFOCUS Home Page, click the plus button and then click Assemble Visualizations.

   WebFOCUS Designer opens in a new browser tab.

2. In WebFOCUS Designer, select a template for the page. You can use a predefined template, or select Blank to build the page from scratch.

3. With the Content tab selected on the sidebar, drag a parameterized item of your choice from the Resources tree to the canvas.

   A badge appears on the Filters tab icon on the sidebar, indicating that there are unbound filters.

4. Optionally, add more content.
Note: The quickest way to create stand-alone content featuring the same set of parameters is to start by creating a Reporting Object with desired parameters, and then using the Reporting Object to create content. To do so, on the WebFOCUS Hub, click the plus menu and click Create Visualizations, or on the WebFOCUS Home Page, click Visualize Data. When WebFOCUS Designer opens, select a Reporting Object as your data source.

5. Click the Filters tab on the sidebar. Click Add all filters to page to create controls for all listed parameters, or right-click each parameter for which you want to create a filter control, and click Add to page.

The filter bar appears above your content with the controls that you chose to create.

6. Optionally, customize your filter bar as described below.

- Change the location of the filter bar from below the page toolbar to above it, to the left side of the page, or into a modal window. Select the entire page and, in the Properties panel, on the Settings tab, select Below Header, Above Header, Left Position, or Modal.

- Move filter controls to a filter grid. When assembling a page from existing content, you can create a filter grid by dragging a grid container from the Resources panel with the Container tab selected. You can then resize and reposition the filter grid to customize where the filter controls should display on your page.

- Right-click a cell to access shortcut menu options, as shown in the following image.

To right-click a cell, right-click the margin above or to the left of a filter control.

The available options are:

- Insert row above. Inserts an empty row above the current row in the filter grid.

- Insert row below. Inserts an empty row below the current row in the filter grid.

- Format. Opens the Properties panel to the Format tab, where you can customize the grid style and cell alignment.
❑ **Delete cell.** Deletes the current cell.

❑ **Delete grid.** Deletes the entire filter bar.

❑ Right-click a control to access shortcut menu options, as shown in the following image.

![Shortcut Menu Options](image)

The available options are:

❑ **Edit title.** Selects the label text for editing.

  Note: Another way to edit a control label is to double-click the filter label, type the new text, and press the Enter key.

❑ **Convert.** Opens the Convert Control To dialog box, where you can choose between various control types.

  You can convert a list control, created for alphanumeric fields, to radio buttons if single-select, check boxes if multiselect, or a button panel. You can convert a single-headed slider, created for single-select numeric fields, to an input box.

❑ **Settings.** Opens the Settings tab of the Properties panel, where you can customize control configuration options.

❑ **Format.** Opens the Format tab of the Properties panel, where you can customize control styling options.

❑ **Delete control.** Removes the filter control from the visualization.

❑ Drag any filter cell to a new location in the grid to reposition or reorder the filter controls.
Multi-select two related controls, right-click one of them, and then click **Combine** to combine the two controls into one. An example of two combined controls is shown in the following image.

The Combine option only applies to single-select date and numeric slider controls. They can be combined into a single control with a start and end point.

Drag a control into a cell with other controls. This action puts two separate controls into one cell. The drag marker is shown allowing you to position one controls in front or behind another control. You can separate the controls again by dragging one control out of the cell.

7. Save your changes.

Filtering Large and Streaming Data Sources

By default, the filter controls that you create in WebFOCUS Designer include, or are bounded based on, a list of values from your data source, which allows you to more easily select valid values from these controls. However, when working with large or streaming data sources, it may not be prudent to query the data source to retrieve this list, as a large number of values may exceed the maximum that can display in the filter control, or cause performance issues, while values from streaming data sources may change rapidly.

As an alternative, when creating a single chart or report, or a page with new content, you can provide dataless filters for specified segments in a data source, in order to conserve the resources needed to perform data retrieval. This filtering behavior is also applied at run time in pages created with new content. Filtering behavior in autoprompt and in pages assembled from existing content is not affected.

Once dataless filter controls are enabled for a segment in a data source, when you create a filter using a field from that segment, a predefined list or range of values is no longer provided in the filter control. For alphanumeric and numeric fields, the filter control is an edit box into which you can type your own values. In the case of alphanumeric fields, you can type multiple values, while for numeric fields, you type the start and end point for a range of values. For date fields, the filter is a calendar control in which only the previous week is selected by default. You should therefore be familiar enough with the data source to provide valid filter values.
The dataless edit box filter control used for alphanumeric fields is shown in the following image.

![Customer City Filter]

The dataless edit box filter control used set a range of values for a numeric field is shown in the following image.

![Book Pagecount Filter]
The dataless calendar control is shown in the following image. Notice that the same preset date options and calendar selection options are available as when data retrieval is performed. Only the default custom date range is affected.

![Calendar control example](image)

Dataless filter controls are activated for a segment in a data source by adding a property to the Access File of the synonym. Add the setting DATASIZE=INFINITE to turn on dataless filtering for a segment. This segment can represent an entire data source or a single table within a larger data structure, meaning that you can turn on dataless filtering for fields in individual segments that you want to filter without retrieving data values. Set the DATASIZE property to INFINITE in the Access File, as shown in the following syntax example.

```
SEGNAME=segment,
DATASIZE=INFINITE,
TABLENAME=table, $
```

where:

*segment*

Is the name of a segment whose fields you want to filter without data retrieval. The segment must be defined in the Master File with which the Access File is associated in the synonym. This allows you to configure dataless filtering for a selected set of fields.
**table**

Is the name of the original data source that the synonym whose Access File you are editing represents. This may be a flat file, a table in a database, or another collection of data records.

For more information about setting properties for metadata, see the *Describing Data With WebFOCUS Language* technical content.

Once enabled, filters created for fields from the specified segment are set by manually supplying filter values. Prompted filters for alphanumeric fields can be applied by typing the filter values into a text box. You can enter multiple values, and deselect previously entered values that you no longer want to use by clearing the check boxes in the list of values. Filter values that are deselected at design time do not appear at run time. You can determine whether selected filter values should be applied or excluded by right-clicking the control and selecting *Include* or *Exclude*.

Prompted filters for numeric fields also allow you to type in filter values. By default, numeric filters are applied as a range, bounded by a maximum and minimum. Therefore, two edit boxes are provided into which you can type a minimum and maximum value. If you change the filter to use an open-ended range that is greater than or less than a specified value, only a single edit box is provided in the filter control.

Prompted filters for date fields allow you to select a preset date range relative to the current date, or set a custom date range. The custom date range defaults to the past week, but can be set to any range of dates. By default, you set date filters to using a range with a fixed start and end point, but you can change it to an open-ended range that begins or ends on the selected date, by right-clicking the filter control and selecting a new filter relationship.

Static filters include a similar set of options when creating filters without referencing the data source. For all field types, the Select from data option is unavailable. For alphanumeric fields, this leaves the Select from file, Enter manually, and Wild card options, which allow the user to provide their own values. For date fields, this leaves the Select ranges, Select from file, and Enter manually options. The default date range for the Select ranges option is initially set to the current date, but you can set the start and end of the date range to any date, as needed. For numeric fields, this leaves the Select ranges, Select from file, and Enter manually options. When providing a range of values, the slider is removed, and you can provide start and end points for the range by typing a value into an edit box. The ability to create a filter by comparing two fields is unaffected.
Summarizing Numeric Data Using Filters

When you create a filter for a measure field in new content, you can choose to filter by aggregated values, using a Summary filter, or by individual records, using a Detail filter. This enables you to review data from a high level or based on a more granular view.
To specify one of these options in a new prompted filter, when you place a measure on the Filter toolbar, right-click it and point to Filter on to access the Detail and aggregated filter options, which are shown in the following image.
To choose between detail and aggregated filter options when creating a static filter, drag a measure to the Filter bucket and select an option from the Apply aggregation drop-down menu.

Summary filters are indicated by an aggregation prefix operator on the filter control label.

The Summary option, which is the default for measure fields, allows you to select records based on the summed, aggregated value of a field. All values for the chart, report, or page are calculated, and then the aggregated values are filtered based on whether they meet the filter requirements. For example, if you create a chart that shows Revenue sorted into Product Categories, you can use a summary filter to display only the Product Categories that meet the selected filter requirements.

If you create a new summary filter in a visualization with multiple content items, the minimum and maximum values available in the filter control are the minimum and maximum values across all combined sort fields in the entire visualization. For example, if you created a chart that was sorted by Product Category, and then added a second chart that was sorted by Sale Year and colored by Sale Quarter, then the values in the summary filter would reflect the range of values for each product category and each combined sale year and sale quarter. In the following image, the minimum available value for the summary filter on the Revenue field is 11,047,133, which is the revenue from Q1 2014 in the bar chart on the right. This is the smallest value on the page. The maximum available value, 291,294,934, is the revenue for stereo systems in the pie chart on the left. This is the largest value on the page.
All of the other values in the pie chart and the bar chart on the page fall between these two points. As a result, certain summary filter selections may exclude all values from one chart, but not another.

You can also filter using Detail values, which represent each record of your data source. In this case, filtering occurs before the values are calculated for each sort value. If you create a chart that shows Quantity Sold sorted by Product Category and add a Detail filter, the individual record values from the data source are filtered based on whether they meet the filter requirements, and then sorted into product categories and aggregated to display the quantity sold for each.

Consider the following two charts, each of which uses a filter for Revenue greater than $10,000. The first chart uses a Summary filter, so it is filtered after aggregation. It displays Revenue values for every product category that had over $10,000 in total revenue. Each of the seven product categories met this criterion, and are therefore displayed in the chart, as shown in the following image.
In the second chart, the Summary filter has been changed to a Detail filter where Revenue is greater than $10,000. This filter is applied before data aggregation. Since each record in the data source represents a single sale, the data is filtered for individual sales that earned revenue of over $10,000. Those values are then grouped by Product Category into the chart shown in the following image.

In this case, the only individual sales for more than $10,000 were for camcorders and televisions.
In addition, when working with numeric filters, you can select the type of aggregation to be used in a Summary filter. By default, a Summary filter, created using the Summary option, uses the sum aggregation. You can also apply standard aggregation methods including average, count, count distinct, minimum, and maximum to a Summary filter. Selecting one of these options filters your content for aggregated values matching the specified criteria, indicated by the label on the filter control, as shown in the following image of a filter control using the average aggregation method.

If you create a filter for a field in your chart or report that already uses a prefix operator aggregation, by dragging the field from a bucket to the filter toolbar or by right-clicking it in a bucket and clicking Add to filter toolbar, a Summary filter is created with the prefix operator aggregation applied.

If the field with the prefix operator is a dimension field, which can use the count, count distinct, or percent of count prefix operator aggregations, then you can create two filters for the field, one for the non-aggregated dimension field and one for the aggregated version of the field.

If your request produces a single aggregated value before applying a Summary filter, such as when there are no sort values, the filter control shows a single Summary value instead of providing a range. If you point to the filter value on the Filter toolbar, a tooltip appears that says, Summary filter irrelevant. Change to Filter on Detail or add a sort field to your request.

If you create a Summary filter and then changes are made to the request such that the minimum or maximum value on the Summary filter range falls outside the range of values in your data, then that filter value appears in red in the control. If you point to it, a tooltip indicates that it is outside the range of your data. The filter is still valid, but may not be applicable to the current state of your content. Similarly, when creating a static filter, you can type a value that is outside the range of values in your data. In this case, the text box displaying the value is outlined in purple and a message indicates that the value is out of range.
If you create a numeric range in a static filter where the minimum value is greater than the maximum value, the filter is not valid, and you cannot save it. A warning appears alerting you that the start and end points are invalid.

**Working With Required Parameters**

By default, when you create a prompted filter in WebFOCUS Designer, the filter is optional. You can right-click a new prompted filter and select *Require selection*, or select a prompted filter for existing content and clear the *Optional* check box on the Settings tab to make it required. This means that users must select a value at run-time before affected content on the page loads. Required controls from external content are marked in red, prompting you to make a selection for the request to be processed. The image below shows an example of a required filter control.

![Required Filter Control Example](image_url)

**Procedure:** How to Convert an Optional Filter Control in an Assembled Page to a Required One

1. In WebFOCUS Designer, add filters to a page, as described in *Applying Prompted Filters From External Content* on page 587.

2. Select an optional filter control and open the Settings tab on the Properties panel. Be sure to select the filter control itself. If you click just outside the filter control, you will select the cell containing the control, which can also be styled and formatted.

3. In the Control Settings area, clear the *Optional* check box to make the control required.
The filter control is marked in red and the *Make a selection* text displays inside the control field.

4. Optionally, to change the default text from *Make a selection* to a prompt of your choice, change the value of the Placeholder text setting on the Properties panel. The default text in the required control changes.

5. If the filter was created for an alphanumeric field, on the Settings tab, in the Data Settings area, disable the *Show All option* setting.

6. Click the *Run in new window* button.

   Your content opens in a new browser tab or window. The content affected by the filter does not initially load. You must select a filter value first.

7. Select a value for the required filter control.

   The content refreshes to reflect your selection.

8. Return to WebFOCUS Designer and save your changes.

**Working With Single and Multiple Select Lists**

In WebFOCUS Designer, list controls are created for alphanumeric fields and numeric dimension fields. There are two types of list controls in WebFOCUS Designer:

- **Single Select List.** Allows you to pick a single value at run time.

- **Multiple Select List.** Allows you to pick multiple values at run time.
An example of a single select list control is shown in the following image.

Once you have made a selection in a single select list, your content instantly refreshes to reflect that selection.
An example of a multiple select list control is shown in the following image.

Once you have made all your selections in the multiple select list, you must click outside of the control for the content to refresh.

If the prompted filter was created in a visualization with new content, you can switch between a single and multiple list control by right-clicking the control and selecting Single or Multiple. If the prompted filter was created for external content, the parameter on which it is based is already defined as single- or multiselect.

List controls for new content include a search feature to make it easy to select the filter values you want to use. To add or remove the search box for a filter for external content in an assembled page, select or clear the Search check box on the Settings tab of the Properties panel. Once search is enabled in the control, simply start typing any word or syllable and all values that contain it will display.
If a list contains 200 or more values, the paging feature is added to the bottom of the control. When paging is active, 10 values display per page. An example of a long list with the paging feature enabled is shown in the following image.

List controls for new content also include the Select all and Clear buttons. These are especially useful when you need to eliminate just a few values from your results. You can click Select All, clear the values that you need to eliminate, and click outside of the control to refresh your content. These can also be added to multiselect list controls for existing content by selecting the Selection controls option on the Settings tab.

Once you've typed a search term, you can use the Select all button to select all search results, as shown in the following image.
Note that the Select All option selects all values in the control. If the control does not contain all field values, then those values won’t be included in the filter. Additionally, the filter selection will not update to include new values added to the data source. To ensure that all values for the selected field are included in the filter, clear the filter selection. All displays on the filter control, indicating that all values are used in the filter.

Dropdown list controls in pages assembled from existing content can be converted into different types of controls that offer similar functionality. You can convert a multiselect list to a checkbox control, double list control, or a button set, and you can convert a single-select list to a radio button control, toggle control, or a button set.

**Note:** In charts, reports, and visualizations with new content, drop-down list controls and slider controls using the Detail option have a record limit of 5000 values. Values beyond this limit are not available for selection in the filter control. There is no record limit for filters in visualizations assembled from existing content, calendar controls, or slider controls using a summary aggregation.

**Working With Double List Controls**

Another common type of control for alphanumeric fields is a double list control. You can select items in the full list of values on the left, and add them to the list of selected values on the right. The double list control also includes the option to reorder the selected values. This can be especially useful when using multi-select field list parameters in an InfoApp, allowing you to change the order of sort and measure fields in the parameterized content. The only other type of control that includes this reordering behavior is the check box control when you select the Allow reordering option. The double list control is available only for alphanumeric, multi-select parameter filters.
Double list controls can be added to pages assembled from existing content. To add a double list control to your page, add an external chart or report that is filtered by an alphanumeric, multi-select parameter, and add the default drop-down list control to the Filter toolbar or a grid container. Right-click the control, click Convert, and then select Double List. A text box that displays the default filter value or values appears in the filter grid. Click the text box to open the double list control, as shown in the following image.

![Double List Control Example](image-url)

**Customer Country**

Austria, Australia

- France
- Germany
- Greece
- Hungary
- India
- Ireland
- Isle of Man
- Israel
- Austria
- Australia
- Greece
- Hungary
- Ireland
To apply filter values, first select the values in the list on the left that you want to use by selecting the check box for each one. Selected values in the list are shown as checked. Select the check box for a selected value again to deselect it. You can select multiple consecutive values by holding the Shift key and clicking the check box for two values. You can select all available values by clicking the check box in the list header, and deselect all values by clicking it again. When more than 50 values are present in the list, it is divided into multiple pages of 25 values each. To navigate to a specific value, filter the list by typing a text string into the search bar. When you have selected the values that you want to use in the filter, click the right arrow button to move them to the list of applied filter values on the right. You can also double-click a single value to move it from one list to the other. Click outside of the double list control to apply the filter selection.

You can reorder the applied values by using the up and down arrow buttons in the control, or by dragging an item up or down within the list on the right. When the double list filter control is used in a multi-select field list parameter, this allows you to change the order in which user selected fields appear in dynamic content. For example, you can use the double list control with a multi-select field list parameter to swap the primary and secondary sort fields in a report, placing focus on different values. To create a multi-select field list parameter, click Add Parameter Field List in the Filters area of the Settings tab, and then, in the Add Parameter Field List dialog box, set the Control type to Single select. For more information, see Enabling Field Selection at Run Time With Field List Parameters on page 711.

To remove one of the applied filter values, open the double list control and double-click a value in the list on the right, or select the values in the list on the right and click the left arrow button. You can also click Clear List to immediately remove all applied filter values.
Working With Toggle Controls

In some cases, instead of having a list of several possible filter values, you may want to create a filter in which only two values are available. Sometimes, this will be a Boolean expression, in which a pre-defined flag can be set to true or false. At other times, you may have a field that has only two available values, and you may want only one or the other to be available at a given time. In each of these cases, a toggle control can be a straightforward way to present these filters. The toggle control is available in pages assembled from existing content items. A toggle control is shown in the following image.

![Store Type: Store Front Web](image)

To create a toggle control, either drag it directly from the Control tab on the sidebar and populate it with a parameter [by however you will be able to do this], or add a parameterized chart or report to an assembled page, generate filter controls for it, and convert one of those controls from a drop-down list to a toggle control by right-clicking the control and clicking Convert. The first two highest-sorted, unique values in the filtered field are added to the toggle control automatically. Only filter controls for alphanumeric fields can be converted into toggle controls.

Toggle controls are most useful for single-select parameters with only two available values, such as filters for flag columns that indicate whether a condition is true or false. However, toggle controls can be created for fields with more than two values, as well. In this case, the first two unique values in the data source are used, by default. If only one unique value is present in the field, then that value and an All value are available for selection using the toggle control, by default. If there are no available values in the selected field, then an All value is used for both sides of the toggle control. The first value in the toggle control is selected when the page loads. At run-time, click the toggle slider to select the second value, and click it again to switch back to the first value.
You can set the two values that are available from the toggle control by selecting it and then using the options in the Control Settings area of the Settings tab. You can set whether the toggle control displays one or two values, and you can set the display and actual values available in the toggle control. The Data Settings area when a toggle control is selected is shown in the following image.

The display value is the value that appears in the control itself, while the actual value is the value that is actually applied when a filter value is selected. To change the display values, change the text in the Label One and Label Two fields. To change the actual values, change the text in the Value One and Value Two fields. If you change the actual values, make sure that they match the values in the filtered data source exactly. Otherwise, the filtered content may not return any values when the filter is applied.
To display only the first value, which reduces the amount of horizontal space needed by the toggle control, clear the Display label two check box. In this case, when the toggle slider is switched off of the first value, the non-displayed second value is selected. Therefore, it may be best to show the label for the second value, unless the two available values are commonly juxtaposed opposites, so users can be expected to understand what the second value should be. A toggle control with only the first value displayed is shown in the following image.

Store Type:

Store Front

You can style a toggle control using cascading style sheet properties. For example, you can use the background-color CSS property to change the color of all toggle sliders on a page based on the selected value. To set the color of the toggle sliders when the first value is selected, use the CSS selector `.ibx-switch-slider.round`, and to set the color of the toggle sliders when the second value is selected, use the CSS selector `.ibx-switch.checked .ibx-switch-slider.round`. For example, to set the slider color to green when the first value is selected and red when the second value is selected, you can add the following code to the CSS text editor for a page in WebFOCUS Designer, which you can access from the Outline.

```css
.ibx-switch-slider.round {
    background-color: #77cc77;
}

.ibx-switch.checked .ibx-switch-slider.round {
    background-color: #ff2323;
}
```

When the page is run and the first value is selected, the toggle slider displays a green background, as shown in the following image.
When the second value is selected, the toggle slider displays a red background, as shown in the following image.

![Store Type: Store Front](image)

**Procedure: How to Add a Toggle Control to a Page**

In pages assembled from existing content, you can use the toggle control to quickly switch between two filter values. These are especially useful for dimension fields with Boolean values, or that have two available values that represent all of your data.

1. Create a new page assembled from existing content. On the WebFOCUS Home Page, click the plus button and then click *Assemble Visualizations*.

   WebFOCUS Designer opens and prompts you select a page template.

2. Select a page template.

   The WebFOCUS Designer canvas opens.

3. Add a content item with a parameter filter for a dimension field to the page.

   A count of available filter controls appears on the Filters tab on the sidebar.

4. Open the Filters tab and then click the *Add all filters to page* button to add all available filter controls, or right-click a single filter parameter in the list and click *Add to page* to select one or more specific filter controls.

   The default filter control, a drop-down menu for dimension fields, appears for the selected alphanumeric filters.

5. Select and then right-click a drop-down menu filter control and click *Convert*.

   The Convert Control To dialog box opens.

6. Click *Toggle* to transform the control into a toggle control.

7. Optionally, on the Settings tab, in the Data Settings section, clear the *Display label two* check box to show only the first value in the toggle control.

8. Optionally, on the Settings tab, in the Data Settings section, change the display values that appear in the toggle control, and the actual values that are passed from the control. If you change the actual values, make sure that they match the values in the filtered data source exactly. Otherwise, the filtered content may not return any values when the filter is applied.
9. Save and run the page. When you click the toggle slider, the filter selection switches from the first value to the second value.

**Working With**

**Slider Controls on a Page**

A slider control is a horizontal track with a marker or markers that you can slide between a minimum and maximum value. This versatile control is often used to choose a numeric value within a fixed range. An example of a slider control is shown in following image.

![](image)

**Procedure:**  **How to Create a New Slider Control Using WebFOCUS Designer**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Add a dimension field and, optionally, a measure field to your chart.

   If there are no dimension values in the chart by which to aggregate the numeric values on the slider, a tooltip indicates that slider selections are not relevant.

4. Drag a measure field into the Filter toolbar.
A slider control appears, allowing you to select default values for the filter parameter, as shown in the following image.

![Image of a slider control]

5. Set the default range of values for the filter.

6. Optionally, right-click the control on the Filter toolbar and click Greater than, Greater than or equal, Less than, or Less than or equal to select only the minimum or maximum value for the filter.

When a parameter using one of these options is added to a page in WebFOCUS Designer, the control is a slider with a fixed start or end point.

**Procedure: How to Create a Slider Control From Content Created in InfoAssist**

1. On the WebFOCUS Hub or WebFOCUS Home Page, in the Workspaces area, in the +Content menu, point to InfoAssist, and click Report or Chart.

   The Open dialog box opens.

2. Select a data source in the Open dialog box and click Open.

   InfoAssist opens.

3. Create a report or chart.

   To learn more about creating content in InfoAssist, see the WebFOCUS InfoAssist User's Manual.

4. On the Data tab, click Filter.

   The Create a filleting condition dialog box opens.

5. Create two optional simple parameters representing minimum and maximum values and make them optional.
In this example we create the minimum and maximum parameters for the MPG field in the car report. An example of the completed filtering condition is shown in the following image.

6. Save your changes and exit InfoAssist.

7. On the Hub or Home Page, right-click your new content item, and then click *Edit with text editor*.
   
   The Text Editor window opens.

8. Edit the syntax by providing the data range values.
An example of the modified syntax is shown in the following image.

```plaintext
ENGINE INT CACHE SET ON
SET PAGE RUN NOLOAD
SET SQUEEZE-ON
-DEFAULT AMP_HTML ENCODE=ON;
SET HTML ENCODE=AMP_HTML ENCODE
SET HTMLCSS-ON
-DEFAULT AMP_EMPTYREPORT=ON;
SET EMPTYREPORT=AMP_EMPTYREPORT
-DEFAULT AMP_ARVERSION-2;
SET ARVERSION=AMP_ARVERSION
-DEFAULT AMP_SUMMARY='Summary';
-DEFAULT AMP_TITLE='WebFOCUS Report';
-DEFAULT AMP_MPI=10;
-DEFAULT AMP_MAX_MPI=38;
TABLE FILE idisamp/car
PRINT CAR_SPECS.MPG
BY CAR,COMP,CAR
BY CAR,COMP,CAR
BY CAR,COMP,CAR
BY CAR,COMP,CAR
WHERE CAR_SPECS.MPG GE MIN_MPI,(FROM 1 TO 30 FORMAT=DS).Minimum MPG.;
WHERE CAR_SPECS.MPG LE MAX_MPI,(FROM 3 TO 46 FORMAT=DS).Maximum MPG.;
ON TABLE FCHOLD FORMAT HTML
ON TABLE NOTOTAL
ON TABLE SET CACHELINES 100
ON TABLE SET GROWTH 1
-ON TABLE SET STYLE =
INCLUDE=IBSFS/FILE/IBI_HTML_DIR/ibi_themes/hornsty.$
TYPE=REPORT, TITLETEXT=AMP_TITLE.QUOTEDSTRING, SUMMARY=AMP_SUMMARY.QUOTEDSTRING, ORIENTATION=LANDSCAPE, $
ENDSTYLE
END
-RUN
```

9. Save your changes and exit the Text Editor.

10. Create a new visualization using existing content. On the plus menu, click **Assemble Visualizations**.

    WebFOCUS Designer opens in a new tab.

11. Select a template for your visualization.

12. In WebFOCUS Designer, in the Resources panel with the Content tab selected on the sidebar, drag your new content item to the canvas.

    A badge appears on the Filters tab of the sidebar, indicating that filters are available to add to the page.

13. Click the Filters tab on the sidebar, and then click **Add all filters to page**.
The slider controls display in the filter grid, as shown in the following image.

14. Optionally, combine two controls together. Multi-select both controls, right-click one of them, and then click **Combine**.

Your controls are combined. You can double-click the label to edit it to reflect your new combined control. An example of the combined slider control is shown in the following image.

15. Save your changes.
Working With Date Controls

Parameters that contain dates are recognized by WebFOCUS Designer as date controls. You can filter date fields by setting start and end points to create a date range. When setting a date range, you can choose from a number of relative pre-defined date ranges, or set a fixed custom date range using a calendar control. Click the same date twice to set the date range to a single day. The calendar control and pre-set date range options are shown in the following image.

Once you have set the date range, click OK to apply the filter, or click Reset filter to clear the filter and include all available dates in your content. Click Cancel to close the date control without making any changes to your filters.
Date ranges set in WebFOCUS Designer are actually based on two parameters, one for the start date and one for the end date. As a result, when you add content created in Designer with a prompted date filter to an assembled page, each of the controls is associated with a distinct parameter. One parameter uses the Greater Than WHERE condition, the other parameter uses the Less Than WHERE condition. If you add each date filter parameter to the page separately, the start and end date each use separate filter controls. If you add all filters to the page at once, they are combined automatically. An example of separate start and end date controls for external content on the page is shown in the following image.
When assembling a page from existing content and add the date filters separately, you can still manually combine the two date controls into a single date range control. To do so, multi-select two date controls, right-click one of them, and then click Combine. An example of a combined date range control is shown in the following image.

When creating new content with a date filter, the date control is automatically a combined control that allows you to select a date range.

The calendar feature inside a date control allows you to select a specific date value. Once you pick a specific date, it is always spelled out, so that it can be supported by all internationalized applications.
Setting Time Rangesa Time Zone in Date-Time Controls

Fields that include both the date and a timestamp, as opposed to just the date, are considered to have a date-time format. Date-time fields are considered a separate field type from regular date fields. You can filter a date-time field to the millisecond, depending on the precision of the field format used for the field, allowing granular start and end points for date-time ranges.

When you filter a date-time field in a chart, report, or authored page in WebFOCUS Designer, you are presented with the ability to change the time zone in addition to the regular date filtering options, allowing you to filter content based on your local time zone. When you set a time zone as part of a date-time filter, content is filtered to show data, which may have recorded in a different time zone, based on whether it would fall within the defined date range in your current time zone. For example, if the data was recorded in Greenwich Mean Time, which is UTC±0 during standard time, and you set the time zone for your date range to a location that uses Eastern Standard Time, which is UTC-5, then the filtered data begins at 5:00 AM on the first day of the range. This is because 5:00 AM in UTC±0, which is used as the time zone where your data originated, is the same time as midnight in Eastern Standard Time, the time zone that you selected for the filter. The start time for the filtered date range is shifted based on the difference between the two time zones. The data values displayed in your content do not change when you change the time zone used in your filter, and are assumed to have been written from a time zone with an offset of UTC±0.
When you create a prompted or static filter for a date-time field in a chart, report, or page in WebFOCUS Designer, you are presented with the ability to set a time range and change the time zone in addition to the regular date filtering options. When you select ranges for a static filter or use the Custom range option for a prompted filter, you can set a time range to provide more granular start and end points for the selected date range when using a date-time field. The start time is applied to the start date, and the end time is applied to the end date. You can set start and end times precise to the millisecond level, or choose not to set a time range by clearing the Apply time range check box. To set a time range using the filter control for a date-time field, when creating new content or running an assembled page, open the control and click Custom. Spinners to set the hour, minute, second, millisecond, and half of the day using a 12-hour system appear below the calendar, as shown in the following image, and you can also type numeric values into them.
The available time components depend on the format of the date-time field being filtered. The following image shows the date-time filter control for a field with a format of HYYMDI, which is precise to the minute level. As a result, only hour and minute time components are available to set.

Once you have set the start and end date and time for your filter, click OK on the filter menu to apply it. To reset the filter to include all available values, open the filter menu, click Reset filter, and then click OK.

In some cases, however, the time values in your data may have been recorded in a different time zone than the one in which you are currently located. You can change the time zone that is applied to the filter to adjust the filtered data based on the time difference between your location and the location from which the data was recorded. When you set a time zone as part of a date-time filter, content is filtered to show data, which may have recorded in a different time zone, based on whether it would fall within the defined time and date range in your current time zone.
For example, if the data was recorded in Greenwich Mean Time, which is UTC±0 during standard time, and you set the time zone for your date range to a location that uses Eastern Standard Time, which is UTC-5, then the filter that would start at 12:00 AM if the time zone were not changed instead begins at 5:00 AM when the time zone is set. This is because 5:00 AM in UTC±0, which is used as the time zone where your data originated, is the same time as 12:00 AM in Eastern Standard Time, the time zone that you selected for the filter. The start time for the filtered date range is shifted based on the difference between the two time zones. The data values displayed in your content do not change when you change the time zone used in your filter, and are assumed to have been written from a time zone with an offset of UTC±0.
To apply a time zone to a your filter, drag a date-time field into the Filter toolbar or Filters bucket. In addition to the range options that are also available for date fields, a Time Zone option appears, with the default time zone selected, if one has been set on the Reporting Server. To set the time zone for a prompted filter, click the Time Zone menu, as shown in the following image.

Time Zone

Choose option

Time Period

Custom

Previous month and current
Previous quarter and current
Previous year and current
YTD
Last 5 quarters
Last 13 months
Last 9 quarters
Last 25 months
Prior YTD
Last 7 days
Last 30 days

Cancel  OK

Reset filter
To set the time zone for a static filter, click the *Time Zone* option, as shown in the following image.

![Time Zone panel](image)

Click the Time Zone menu or Time Zone option to open the Time Zone panel, shown in the following image.

- **Apply a time zone**

  - **Time zones**
    - **Country**
      - **Select Country**

  - **Time Offsets (UTC)**

If no default time zone has been set, select the *Apply a time zone* check box to enable time zone selection. You can select time zones for locations sorted by country or territory, on the Time zones tab, or based on the UTC offset, on the Time Offsets (UTC) tab.
To select a time zone based on a location, on the Time zones tab of the Time Zone dialog box, first select a country or territory from the Country drop-down list. You can start typing the name of a country or territory to navigate to it more quickly. Once you select a country or territory, a list of available location-based time zones in that country appears, as shown in the following image.

Select a location and then click OK on the filter menu to apply it.

Time zones based on locations automatically apply daylight savings, depending on the time of year. For example, the North American Eastern Time zone has a UTC offset of UTC-5 during standard time, and a UTC offset of UTC-4 during daylight time.

When applying a time zone to a date range filter for a date-time field, your data is interpreted as having been written from a time zone with an offset of UTC±0. This is the offset during standard time for the Western European Time time zone, during daylight savings time for the Azores and part of Greenland, and year-round for Iceland and most of West Africa. Therefore, if your data comes from a different original time zone, it is recommended to use a UTC offset equivalent to the time difference between the time zone where the data originated and your current time zone. For example, if your data originated in Los Angeles, and you are currently located in New York, then you can select an offset of UTC+3 to see content with date-time data from Los Angeles, filtered based on a start time of midnight in the New York since the time zone for New York is three hours ahead of the time zone for Los Angeles.
To select a UTC offset instead of a location-based time zone, click the *Time Offsets (UTC)* tab and select an option. Click *OK* on the filter menu to apply the new time zone.

Once you set your time zone, select a date range for your filter and apply it. Your content refreshes, and the hour at which your date range starts and ends is adjusted based on the selected time zone.

If you create a page with multiple date-time parameter filters, the same time zone is applied to all of them. When you select a time zone for one filter, an alert appears to inform you that it will also be applied to other date-time filter controls on the page.

If you set a time zone and then want to revert to the default, open the Time Zone dialog box and click *Reset filter*, then set the start and end date and time again. If you decide you do not want to apply time zone adjustments at all, open the Time Zone dialog box, clear the *Apply a time zone* check box, and then click *OK*.

You can set the default time zone in the locale settings of your reporting server. On the WebFOCUS Hub, click *Management Center* and select *Server Workspaces*. Alternatively, In the Server Console, click the *Tools* menu and click *Workspace*. Click the *Settings* menu, point to *LOCALE*, and then click *LOCALE (Language, Numbers, Currency, Dates)*. Type the default time zone name into the *TIMEZONE* field. The time zone should use the IANA tz database name, which typically use a format similar to *Region/City_Name*. For more information, see the *List of tz database time zones* on Wikipedia.

**Styling Filter Controls in a Visualization**

When creating a page from external content, you can configure the properties of the filter toolbar, a filter grid panel, or single filter control by using the Properties panel, which is context-sensitive. For example, when you click a filter cell on the toolbar or in a filter grid, the cell style properties open in the Properties panel. When you click a filter control within a cell, the configuration and style properties for this control open in the Properties panel. You can access properties for the entire Filter toolbar or a filter grid by selecting it from the outline. When creating a page from new content, a smaller set of options are available for a filter control or for the filter toolbar.
The Properties panel consists of the Settings tab and the Format tab. The Settings tab includes options to configure the behavior of the Filter toolbar, a filter cell, or a filter control. The Settings tab on the Properties panel for a filter control created for external content is shown in the following image.
When you select the entire page, if it was assembled from existing content, you can change the position of the filter toolbar using the following options:

- **Include Page Filters.** Select this check box to add a filter toolbar to the page, even if no filters have been added yet. Clear this check box to remove the filter toolbar.

  If **Include Page Filters** is selected, you can select one of the following options to change the position of the filter toolbar:

  - **Below Header.** The filter toolbar is placed below the page toolbar and header. This is the default.
  - **Above Header.** The filter toolbar is placed above the page toolbar and header.
  - **Left Position.** The filter toolbar is aligned vertically along the left side of the page, below the page header.
  - **Modal.** The filter toolbar is accessible in a modal window overlaid onto the page. Click the **Show filters** button on the page toolbar to open the modal window and make filter selections.

When the Filter toolbar or a filter cell is selected, the Settings tab includes two properties:

- **ID.** Contains a read-only unique CSS identifier.
- **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code.

Filter controls created within a page have different configuration and styling options than filter controls added to the page from referenced, external content. When you select a filter control that you created directly within the page, the Settings tab contains the following properties:

- **General Settings.** This section includes the following options:

  - **Type.** Displays the type of the control.
  - **ID.** Contains a read-only unique CSS identifier.
  - **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code.
  - **Tooltip.** Displays a tooltip when you hover over the filter control.
When you select a filter control that was generated from external content using the Filters tab on the sidebar, the Settings tab contains the following additional property:

- **Global name.** Designates a global name to the control, allowing you to synchronize control values on different pages in a portal. For more information, see *Using Global Name to Synchronize Filter Controls* on page 642.

- **Control Settings.** This section includes the following options:
  - **Optional.** Toggles between optional and required control.
  - **Allow reordering.** If selected, allows you to reorder values inside the control at run time. The default order is alphabetical. This property is only available for check box controls.
  - **Placeholder text.** Enables a configurable placeholder text that you can show users inside a required control when it has no value. The default text is *Make a selection*. This property is only available for drop-down list controls.

  **Note:** The Placeholder text property is only used for required controls. The placeholder text appears before a selection has been made. To change the default text for an optional control, if the Default value for the control is _FOC_NULL, meaning all values, enable the *Show All option* property and type a value for the Display text property. The Display text option in the control represents the _FOC_NULL, or all values, filter value.

  - **Search.** Adds a search field to the filter drop-down menu. This option is available for drop-down list, check box, and radio button controls.

    **Note:** If the select list contains 50 or more values the Search option is enabled automatically.

  - **Selection controls.** Adds *Select all* and *Clear* buttons to the filter drop-down menu. This property is only available for multiple select lists and check box controls.

    **Note:** The Selection controls and Show All options cannot be selected at the same time.

- **Data Settings.** This section includes the following options:
  - **Show All option.** Adds an All option to the control that the user can select.

    **Note:** Choosing this option results in the parameter receiving a _FOC_NULL value. If this parameter is used in a WHERE condition, it results in the WHERE condition being removed from the request and all data values for this field displaying the page.

  - **Display text.** Allows you to specify a custom value for the Show All option in the control. The default text is *All.*
Note: The Display text property is available when Show All option is selected. The display text option in the control represents all values. To supply a placeholder value for required controls that appears before a selection is made, use the Placeholder text property.

- Default value. Displays the default value of the control. For optional parameters you can edit this field and override the control value.

The following options are available for toggle controls only:

- Label One. Is the label that displays on the left side of the toggle control.

- Value One. Is the actual filter value represented by the label on the left side of the toggle control. This is the default value of the toggle control.

- Value Two. Is the actual filter value represented by the label on the right side of the toggle control.

- Display label two. Allows you to hide or show the label on the right side of the toggle control. Hiding the label saves horizontal space, but provides less information to users.

- Label Two. Is the label that displays on the right side of the control. This label only appears if the Display label two check box is selected.

- Parameters. Shows the name of the parameters that are associated with this control.

When creating a visualization using external content, the Format tab of the Properties panel provides layout and styling options for the Filter toolbar, a filter cell, or a filter control. These options differ depending on the origin of the filter and the item selected. Format options are not available for new prompted filters created in a visualization.
The Format tab of the Properties panel, for the filter bar on the Filter toolbar or in a grid container, is shown in the following image. You can use these options to change the layout of the cells in the Filter toolbar or grid container, and change the theme style it uses.

The Format properties for a bar are:

- **Grid Type.** Controls the grid layout of the filter bar. The options include 1-Column, 2-Column, 3-Column, 4-Column, and 6-Column.

  When you are using a columnar layout and the number of filters exceeds the number of columns, the extra filter controls are added to new rows in the Filter toolbar. In the carousel layout, you can use the arrows on either side of the Filter toolbar to scroll to additional filter controls.
❑ **Grid Style.** Controls the style of the filter grid. The available styles are defined in the theme used for the page. When you select a style for a cell, the entire Filter toolbar is affected.

The Format tab for a cell is shown in the following image.

![Format tab for a cell](image)

When you configure these properties, you modify the alignment of a control or other object within a cell. Cell format properties are only available for cells in the columnar grid or toolbar layout used in a visualization with external content. The cell and filter control in the carousel style layout used in a visualization with new content are not separate components, so the cell cannot be selected for formatting.

The properties for a filter cell are:

❑ **Cell Content Alignment.** Controls the alignment of the label and control inside the cell. The options include top, middle, bottom, left, center, and right. These options are available when using a columnar filter grid layout.
The Format tab for a filter control created for external content is displayed in the following image. You can modify the positions of labels in a control, define the alignment, and set the object width.

The style properties for filter controls in a page with external content are:

- **Label Position.** Controls the position of the filter label in the relation to the control. The options are above, right, left, and no label.

- **Label Alignment.** Controls the alignment of the filter label. The options are left, right, and center.

- **Direction.** Controls the alignment of the elements inside the control. This property is available for radio button, check box, and button set controls. The options are horizontal and vertical. The vertical option is enabled, by default, when the control has five or more values.

- **Label/Control Split.** Controls the space ratio between the label and control inside the cell. This option is only available when the label position is set to right or left.

- **Control Object Width.** Sets the width of the control in relation to the filter cell. The options are:
  - **Auto.** Adjusts the width of the control automatically to accommodate the name of each value.
- **Max.** Fills the entire filter cell. This is the default value.

- **Percentages.** Set the control width to various percentages, as they relate to the filter cell.

- **Control Object Height.** Sets the maximum height of the control. If the list of elements exceeds the maximum height of the control, a scrollbar is added to this control. This property is available for radio button, checkbox, and button set controls when their Direction property is set to vertical. The default value is 150px. You can change this value as necessary.

Prompted filter controls created in a visualization with new content always use a predefined, simple filter style. No format options are available for these controls.

### Choosing an Event Model for Your Page Filter

When assembling a visualization from existing content, WebFOCUS Designer supports two event models for passing parameters to your page content:

- **On-selection Change.** Whenever you change a value of any filter control on the page, parameterized content refreshes to reflect your selection. This model is enabled, by default.

- **Submit Button.** After you make all desired changes to filter controls on the page and click the Submit button, parameterized content refreshes to reflect all your selections. This event model also allows you to use a Reset button to revert all filters to their default values. This model can be enabled by dragging a Submit button from the Control tab on the sidebar into the filter grid. Submit and Reset buttons appear, as shown in the following image.

![Filter Grid with Submit and Reset Buttons](image)

You can delete the Submit button to use the on-selection change event model for your filters, but still retain the Reset button, and you can also delete the Reset button to keep only the Submit button on the page.
Procedure: How to Use On-selection Change Filters

1. Add filters to a page as described in Applying Prompted Filters From External Content on page 587.

2. Click the Run in new window button.

Your content opens in a new browser tab or window, allowing you to interact with content and filters. If your page content contains default values, page filters and page content run in parallel, which results in a faster loading time.

3. Make filter selections.

Each time you make a selection, the content refreshes to reflect it.

Note: Notice that, if you have parameters that come from the same field hierarchy in your data source, the filter controls are chained in such a way that each selection automatically reflects the available choices in other filters. In our example, we set Category to Televisions. Now, the Product Model filter only shows models of televisions, as shown in the following image. WebFOCUS Designer chains controls automatically, if the parameters are defined in the metadata layer with the WITHIN keyword to relate them.

4. Return to WebFOCUS Designer and save your changes.

Procedure: How to Use Filters With a Submit Button

1. Add filters to a page assembled from existing content, as described in Applying Prompted Filters From External Content on page 587.
2. From the Resource selector, click the Controls tab, and then drag the Submit button onto the filter grid. This can be the filter grid in the Filter toolbar, or in a grid container.

The Submit and Reset buttons display in the filter grid.

3. Optionally, customize the Submit and Reset buttons in any of the following ways:

- Align the Submit and Reset buttons by selecting the cell in which the buttons reside and customize the Cell Content Alignment option on the Format tab of the Properties panel. In this example, we selected Align control bottom and Align control center.

- Add a tooltip to the buttons by selecting each one and populating our the Tooltip field on the Settings tab of the Properties panel.

- Customize the width of the buttons in relation to the filter cell by selecting one of the options under the Control Object Width property. In this example, we selected 50%.

**Note:** You can delete one or both buttons by right-clicking them and clicking Delete.

4. Click the Run in new window button.

The content runs in a new browser tab or window, allowing you to interact with content and filters.

5. Make filter selections. Your parameterized content does not update immediately.

6. Click Submit.

The content refreshes to reflect all your selections upon clicking the Submit button, as shown in the following image.
7. Click Reset.
   The filters return to their default values.

8. Optionally, click Submit again to refresh the content with the default values.
   **Note:** If you deleted the Reset button, you must select default values manually, and then click Submit to return to the default state. Alternatively, you can click the refresh button on the page toolbar to refresh all content and filter controls on the page.

9. Return to WebFOCUS Designer and save your changes.

**Using Global Name to Synchronize Filter Controls**

The Global Name property is a powerful tool that allows you to quickly synchronize filter control values between different pages. The Global Name property is configured on the Settings tab of the Properties panel for a filter control in an assembled page. Once enabled, it allows you to match your filter selections across multiple pages at run time within the same browser session. This option is especially useful in a portal. The global name can be used to synchronize filter control selections across multiple pages in the same portal.

**Procedure: How to Configure Global Name Filter Control Property**

1. In WebFOCUS Designer, add filters to a page using existing content, as described in *Applying Prompted Filters From External Content* on page 587.

2. Click a filter control that you want to synchronize.

642
3. On the Properties panel, in the Settings tab, populate the *Global Name* field, as shown in the following image.

![Image of WebFOCUS Designer showing the Properties panel with the Global Name field populated.]

**Note:** You can choose any text as a global name for your control. Combined controls, such as date ranges and slider controls, have a single global name property.

4. Optionally, repeat step 3 for all the filter controls that you want to synchronize.

5. Save the page.

6. Create a second page, populate it with parameterized content, and add the same set of filter controls as you did in step 1.

   **Note:** To streamline this process, you can use the Save As option to create a new version of the existing page, leave the configured filters intact, and replace the content on the canvas. Make sure the Global Name values are identical between the filter controls on both pages.

7. Save the second page and exit WebFOCUS Designer.

8. Run one of your newly created pages.

9. Select filter control values.
An example of the filter control selections is shown in the following image.

10. Run the second page.

The page runs with the same filter control values as the ones you have selected on the previous page, as shown in the following image.

Note: If your page was created prior to the WebFOCUS Release 8205 and it uses the Global Name feature and contains default content, you must save it again using WebFOCUS Designer to ensure optimal performance.
11. Optionally, change the filter control values on the second page and see how they synchronize with the ones on the first page.

**Bookmarking**

**Control Selections in a Page**

Bookmarking allows users to save filter control selections and other run-time content customizations that they make in a page so that they can easily reapply them when they run the page again later. This is especially useful when there are many filter controls on a page that a user may want to apply each time they access it. Bookmarks are personal to each user and can easily be created and deleted as needed.
Bookmarking is enabled automatically once the page has been saved, and is available in authored pages created with new content and in assembled pages built from existing content. To add a bookmark, make some filter selections when running a page, and then click the **Bookmarks** button, which appears on the page toolbar at run time. You are prompted to type a name for the bookmark. Click **OK** to apply it. A maximum of 46 characters display for each bookmark name. Once applied, the bookmark is added to the list, which you can open by clicking the drop-down menu arrow next to the Bookmarks button. Select a bookmark from the list to refresh the page and apply the associated set of filter values. The bookmark list also includes the **Original page** option, which reloads the page with the default filter values selected. From the bookmark list, you can also use the menu for each existing bookmark to rename or delete the bookmark, or make it your personal default set of filter values when you load the page, as shown in the following image.

Each user can create a maximum of ten personal bookmarks for a page. If you reach this limit on a page, delete an existing bookmark to add a new one. The Original page bookmark is always available and cannot be deleted.
Bookmarks also save certain user customizations made in the page. For example, if you use on-chart filtering in an authored page at run-time to create a new filter, you can create a bookmark to save it. In authored pages, you can also change the filter condition from included values to excluded values and change the aggregation operation, and in assembled pages, you can change the content that displays in unlocked containers. All of these changes are saved when you create a new bookmark.

**Setting Dynamic Default Values for Filter Controls**

When assembling pages from external content, you can personalize default values for filters in a page based on users or conditions. This feature uses an amper-amper (&&) global variable to specify the default option for a filter control. You can then use variables, functions, and conditions to set the values of these global variables. For example, you can set the Region value for a user, using the && global variable, and link it to the filter control to show their region as the selected value, or you can base the default values for a calendar control on the current date so that they always show a relevant, relative date range.

**Procedure: How to Personalize Default Values for Filter Controls**

You can use global variables to dynamically set the default values of filter controls based on the user who is running the page.

1. Start by creating a FOCEXEC which specifies the global variable and the default values. In this example, we are setting default values for different users for the Region control.
   a. On the default WebFOCUS Hub or Home Page, in the Workspaces area, click the +Content button, point to Other, and then click Text Editor.
      The New Text Resource dialog box opens
   b. In the New Text Resource dialog box, click FOCEXEC (fex).
      The WebFOCUS Editor opens.
   c. Add the following FOCEXEC code to set the global variable:
      ```
      - &&DEFREGION
      -SET &&DEFREGION= IF &FOCSECUSER EQ user1 THEN 'North America' ELSE
      -IF &FOCSECUSER EQ user2 THEN 'EMEA' ELSE 'South America'
      ```
   d. Save your changes and close the Text Editor.
   e. Publish the FOCEXEC.
2. Bring the global variable in effect by either running the FOCEXEC or mapping its path in the Administration Console for it to be run when the user signs in.
To map the FOCEXEC you just created in the Administration console, add the FOCEXEC path to the Paths to be executed on user Sign-in field in the Other section under Application Settings. The FOCEXEC path name can be copied from the Properties panel in the Hub or Home Page.

**Note:** If you are setting the FOCEXEC to be executed on sign in, make sure that the WebFOCUS user credentials are passed to the server. One way to do that is to set the server connection to Trusted and select the Pass WebFOCUS User ID and other Groups radio button. For more information on how to use Administration Console, see the WebFOCUS Security and Administration technical content.

3. Assemble a page from existing content, as described in *How to Create a Visualization With Existing Content in WebFOCUS Designer* on page 249.

4. Populate your new page with the content that features the Region parameter and add the Region filter to the canvas using the Filters tab on the sidebar, as described in *Applying Prompted Filters From External Content* on page 587.

5. Click the Region filter, open the Properties panel and, in the Settings tab, under Data Settings, type the default value variable that you created in the FOCEXEC (in this case, \&DEFREGION).

The following image shows an example of the Default value property populated with the variable.
6. Save, publish, and run your page.

The default value for the Region filter control is North America, as shown in the following image.

7. Sign in to WebFOCUS as one of the users mentioned in the FOCEXEC.
8. Run the same page.
The following image shows an example of the user with the username *user2* running the page. The default Region value now is EMEA.

![Sales Dashboard](image)

**Procedure:** How to Set a Dynamic Default Range for a Calendar Control

A calendar control in a page assembled from existing content is a combined control that allows you to filter for a date range by selecting a start date and an end date. You can use date functions to set global variables for the start and end date to a fixed length of time from the current date, then use those global variables as the default start and end date values for a calendar control.

The calendar control default dates must be entered using the full month name, for example, *December 31 2019*.

1. Start by creating a FOCEXEC procedure that specifies global variables for the default start and end dates. In this example, we will make the default start date a week before today, and the end date today.
   a. On the WebFOCUS Hub or the WebFOCUS Home Page, in the Workspaces area, in the +Content menu, point to *Other*, and click *Text Editor*.

b. In the New Text Resource dialog box, click FOCEXC (fex).

The WebFOCUS Editor opens.

c. Add the following FOCEXC code to set the global variable:

-SET &LASTWEEK = AYMD(&YYMD, -7, 'YYMD');
-SET &&FROM_DATE = CHGDAT('YYMD', 'MDYYX', &LASTWEEK, 'A17');
-SET &&TO_DATE = CHGDAT('YYMD', 'MDYYX', &YYMD, 'A17');
-DONE

Three variables are defined in this FOCEXC: &LASTWEEK, &&FROM_DATE, and &&TO_DATE. &LASTWEEK is a variable that provides the date from one week ago. It does not need to be used directly in the calendar control, so it is not created as a global variable. &&FROM_DATE and &&TO_DATE need to be saved for use as default values in the calendar control in our page, so they are created as global variables.

&LASTWEEK is created using the AYMD function, which takes a date, a number of days to add to that date, and a date format. In this case, we are using &YYMD, which is a system variable that provides the current date in YYMD (year-month-day) format. We are subtracting one week (seven days) from the current date. The date format is YYMD.

The date format needs to use the full month name, and must be in month-day-year order. We will use the CHGDAT function to convert the date to the proper format for both the &&FROM_DATE and the &&TO_DATE global variables. The CHGDAT function uses four parameters: the format of the input date, the order of the output date, the input date value, and the output date string format as an alphanumeric field.

The format of our two input dates, the date of one week ago set by the AYMD function and the current date, are both in YYMD format, so that is the first argument of both CHGDAT functions. Similarly, the output of both functions is MDYYX, which generates a date with the full month name in month-day-year order. Typically, the format for such a date would be MtrDYY, but since the CHGDAT function uses date character strings instead of actual date values, it has its own date format designations. MDYYX sets the date order as month-day-year, with the year written in four digits, and the X indicates that the full month name should be displayed.

The third argument of the CHGDAT function is the date to be converted. For the &&FROM_DATE variable, it is &LASTWEEK, which was previously defined in this FOCEXC using the AYMD function. For the &&TO_DATE variable, it is &YYMD, a system variable representing the current date in YYMD format.

Finally, A17 defines the string length of the converted date. 17 characters is long enough to fit any date string.
For more information about the AYMD and CHGDAT functions, see the *Using Functions* technical content.

d. Save your changes and close the Text Editor.

The FOCEXEC must be available to any users for whom you want to set default values in the page. Save it in a location where it will be accessible and then publish the FOCEXEC, or share it with any users after saving.

2. Bring the global variable into effect by either running the FOCEXEC or mapping its path in the Administration Console for it to be run when the user signs in.

   To map the FOCEXEC you just created in the Administration console, add the focexec path to the *Paths to be executed on user Sign-in* field in the *Other* section under Application Settings. The FOCEXEC path name can be copied from the Properties panel on the Hub or Home Page.

3. Assemble a page from existing content, as described in *How to Create a Visualization With Existing Content in WebFOCUS Designer* on page 249.

4. Populate your new page with the content that is filtered for a date range, and add the calendar control to the page using the Filters tab on the sidebar, as described in *Applying Prompted Filters From External Content* on page 587.

5. Select the calendar control, open the *Properties* panel and, in the Settings tab, under Data Settings, type the default value variables that you created in the FOCEXEC (in this case, `&&FROM_DATE` for the first value and `&&TO_DATE` for the second value).
The following image shows an example of the Default value property populated with the variable.

![Data Settings](image)

6. Save and run your page.
The default date range in the calendar control is automatically set to the past week. The dates will update every day to always represent a period of one week.

Adding Headers and Footers to Content

You can use headers and footers to add key information, such as the purpose of your chart or report and the audience for whom it is intended.

You can add multiple lines of information into the heading and footing areas, and apply different styling options to different sections of the heading or footing. This accommodates thorough explanations and additional information, while offering the most readable presentation.

When you create a chart or report, the heading area is available above your content, and the report footer is available below your content. You can click within these areas to edit them. To show or hide these areas, on the Settings tab, expand the Content section, then select the Enable heading or Enable footing check boxes.
When you double-click the Page Heading or Page Footing placeholder text in the canvas, the heading or footing is selected for editing and the styling toolbar appears.

You can make styling changes to the text in your headers and footers, according to your preferences. Using a WYSIWYG canvas, formatting changes are applied instantly, allowing you to see the results of your styling selections as you make them. When editing your header or footer, you can find the options at the top of the canvas, as shown in the following image.

You can change the font and font size using the drop-down lists. You can add bold, italic, and underline accents to your text. In addition, you can change the positioning of your text (left, center, and right). You can also customize the color of the text, as well as the background of the header or footer text area. When your formatting is complete, you can close the toolbar and continue working with your report. The canvas adjusts to ensure that all lines of the heading or footing are visible.
You can add a new line in the heading and footing by pressing the Enter key. The number of lines of heading and footing you can add to a report is only limited by the available space on your screen. A scrollbar is added to a report if all of the data cannot fit on the canvas or in the container.

When you are done editing the heading or footing, click the X button on the styling toolbar to close it. Once you have edited the header or footer, the updated text will appear when the report is run.

If you delete the header or footer text and then close the styling toolbar, the header or footer is removed from the report. You can select the header or footer area and enter text to add them to the report again.

Heading and footing text in WebFOCUS Designer is created at the page level, so the heading or footing is displayed for each separate page of a chart or report. You can create separate pages in a chart by adding a field to the Multipage bucket, or in a report by right-clicking a field in the Rows bucket, pointing to Insert breaks, and selecting Continuous numbering or Restart at 1.

You can add dynamic heading or footing text by dragging a field from the Fields tab into the heading or footing text area, or by typing a less-than sign (<) followed by the field name. At run time, the first value for the selected field is displayed in place of the field name in the header or footer. You can combine dynamic page heading or page footing text with filters or page breaks to provide more relevant information at run time.

**Procedure:** How to Add a Dynamic Page Heading to a Report

You can add a dynamic page heading to a report that changes depending on filter selections and sort values for each page.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select a report format, such as the standard report or grid report layout.

4. With the Fields tab selected on the sidebar, In the Dimensions area of the Resources panel, expand Product, and add the Product Category and Product Subcategory fields to the Rows bucket, in that order.

5. In the Measures area of the Resources panel, expand Sales, and drag Quantity Sold and Revenue to the Summaries bucket.
   In the Dimensions pane, expand Customer and drag Customer Country into the Filter toolbar.

7. Select Argentina, and click outside of the filter control to apply the filter.

8. Create a page break after each Product Category value.
   Right-click the Product Category field in the Rows bucket, point to Insert Breaks, and click Continuous numbering.

9. Double-click the Page Heading text above the report to select it for editing.

10. Delete the placeholder text in the heading area, and type Sales for.

11. From the Dimensions pane, drag the Product Category field into the heading area after where you typed Sales for.
   The heading should resemble the following image. Dynamic values for the Product Category field will be substituted for the text string starting with the less-than sign (<) at run time.

   Sales for <WF_RETAIL_LITE.WF_RETAIL_PRODUCT.PRODUCT_CATEGORY>

12. Click the close button on the styling toolbar to finish editing.

13. On the Properties panel, on the Settings tab, expand the Settings area and select Enable footing.
   The page footing placeholder text appears at the bottom of the page.

14. Double-click the page footing area to select it for editing.

15. Type, This report shows figures for sales in.

16. From the Dimensions pane, drag the Customer Country field into the footing area after the text that you just typed.
   The name of the field, with a less-than sign in front of it, appears in the page footing area.

17. With the entire page footing text selected, click the Italic button on the styling toolbar.

18. Click Run in new window to see a run-time view of the report.
   Notice that the page header appears and displays a different value for each Product Category value. The Page footer appears below each section of the report, and indicates that values are for Argentina, since this was the value selected for the Customer Country filter. If you were to select a different value for Customer Country, the footing text would automatically change.
The following image shows an example of what a section of the report may look like.

### Sales for Accessories

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>509</td>
<td>$19,101.40</td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
<td>1,095</td>
<td>$376,563.98</td>
</tr>
<tr>
<td></td>
<td>Universal Remote Controls</td>
<td>869</td>
<td>$245,119.09</td>
</tr>
</tbody>
</table>

*This report shows figures for sales in Argentina*

### Sales for Camcorder

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>1,232</td>
<td>$206,880.45</td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>77</td>
<td>$270,196.10</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>919</td>
<td>$331,031.88</td>
</tr>
</tbody>
</table>

*This report shows figures for sales in Argentina*
Setting Conditional Styling Based on Data Values

Conditional styling is a feature that applies unique styling to cells in a chart or report when their values meet specified criteria. This allows you to highlight values that are especially high or low, or are higher and lower than those in another field, making it easy to spot important information in your content. You can even use conditional styling to add drill down links to values that match your set criteria, allowing users who run the chart or report to access additional context and information pertaining to those records. The following image shows a report to which conditional styling has been applied. Revenue values higher than 5,000,000 have a bright green background, while revenue values lower than 500,000 have a bright pink background.

<table>
<thead>
<tr>
<th>Store Name</th>
<th>Sale Quarter</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amsterdam</td>
<td>1</td>
<td>21,262</td>
<td>$6,341,648.06</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>20,016</td>
<td>$6,975,387.79</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>21,254</td>
<td>$6,422,633.53</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>28,757</td>
<td>$8,125,623.97</td>
</tr>
<tr>
<td>Anchorage</td>
<td>1</td>
<td>4,101</td>
<td>$1,209,002.68</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>3,919</td>
<td>$1,180,688.39</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>4,780</td>
<td>$1,404,526.00</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>6,105</td>
<td>$1,832,456.65</td>
</tr>
<tr>
<td>Arlington</td>
<td>1</td>
<td>3,452</td>
<td>$1,079,601.63</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>3,390</td>
<td>$1,040,887.99</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>3,328</td>
<td>$971,228.37</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>4,194</td>
<td>$1,333,370.47</td>
</tr>
<tr>
<td>Athens</td>
<td>4</td>
<td>1,191</td>
<td>$373,337.59</td>
</tr>
<tr>
<td>Atlanta</td>
<td>1</td>
<td>6,564</td>
<td>$1,960,785.12</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>6,577</td>
<td>$1,974,945.67</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>6,297</td>
<td>$1,937,744.32</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>7,723</td>
<td>$2,358,300.10</td>
</tr>
<tr>
<td>Bangalore</td>
<td>3</td>
<td>300</td>
<td>$99,173.60</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2,479</td>
<td>$555,082.32</td>
</tr>
<tr>
<td>Bangkok</td>
<td>4</td>
<td>115</td>
<td>$42,720.78</td>
</tr>
<tr>
<td>Barcelona</td>
<td>3</td>
<td>620</td>
<td>$190,613.70</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2,449</td>
<td>$803,790.09</td>
</tr>
<tr>
<td>Beijing</td>
<td>4</td>
<td>120</td>
<td>$325,629.95</td>
</tr>
<tr>
<td>Belfast</td>
<td>4</td>
<td>81</td>
<td>$222,207.90</td>
</tr>
<tr>
<td>Berlin</td>
<td>1</td>
<td>21,012</td>
<td>$6,294,658.12</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>20,207</td>
<td>$6,989,913.09</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>20,221</td>
<td>$6,087,656.34</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>23,825</td>
<td>$7,140,666.71</td>
</tr>
<tr>
<td>Boba</td>
<td>1</td>
<td>647</td>
<td>$291,905.43</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>971</td>
<td>$282,355.56</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>650</td>
<td>$297,577.23</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1,213</td>
<td>$375,700.38</td>
</tr>
</tbody>
</table>
Conditional styling is set on the field level. To enable conditional styling for a field, right-click the field that you want to style in its bucket, and then click **Conditional Styling**. The Conditional Styling panel opens, where you can set the criteria that, when met, will trigger conditional styling. By default, the field to which the conditional styling will be applied is the field whose values the conditional styling criteria are evaluated against. You can change the field used in the criteria, however, allowing you, for example, to style values in a sort field based on the measure values associated with them.

You can set the operator and the field or static value to which the values of the selected field will be compared. For example, you can choose to apply conditional styling to values in a field that exceed a specified value, or that are greater than the value in the same row of another specified field. For example, you may wish to highlight sales where the cost of goods was greater than the revenue, indicating a net loss. If you choose to compare field values to another field, you can select one from a list of measure or dimension fields in the chart or report. The list of fields is filtered based on the type of field to which the comparison is being made. To compare field values to a static value, type that value into the text box.

You can create a conditional styling criterion using the following comparative operators:

- Equal to
- Not equal to
- Greater than
- Less than
- Greater than or equal to
- Less than or equal to
Once you have set your criteria for conditional styling, you can apply a variety of styling properties to be used when the criteria are met. For a chart, you can set the color of risers that meet the conditional styling criteria. For a report, you can set the font, text size, text color, font style, justification, and background color of conditionally styled cells. The styling options for a report are shown in the following image.

In addition to standard report cell styling options, you can also create drilldowns as part of your conditional styling, which allow users who run the report to drill from values that match the conditional styling criteria to content or external resources with additional information. Values that do not meet the criteria do not have drilldowns applied. For more information about drilldowns, see *Adding Drill-Down Links to Content* on page 734.
Multiple conditional styling criteria can be added to each field. They are listed as separate conditions above the conditional styling options. If multiple conditions are available, you can click the name of the condition to edit it. Click the trash can icon next to a condition name to delete it. You can also use the handles next to the name of the condition to reorder your styling conditions, allowing you to specify the order in which the conditions should be tested against each record in the selected column. This can be especially useful if you have conditions that overlap. For example, if you have a condition to set the background of cells with values greater than 250 to yellow, and a second condition to set the background of cells with values greater than 500 to bright green, then as a best practice, place the condition with the higher threshold first, so that only values above 500 are initially styled, before the remaining values are styled based on subsequent criteria, as shown in the following image.
Once you have set the conditions and the styling that you want to apply when those conditions are met, click Apply. You can then close the Conditional Styling panel. When you run the report, the values in the styled field that match your specified conditions have special styling applied, making them easy to identify at a glance.

**Changing a Field Format**

Changing the display or output format of fields that have been placed on the canvas or in buckets allows you to control how values in a field are interpreted and the styling that they use when displayed. This feature allows for field display formatting, which is essential for any data-based content design tool.

In a report, the field format is reflected in the format of data values. In a chart, the field format may be reflected in data values in the chart, if they are displayed, or in the tooltip. Note that series based data labels in a chart are formatted independently from the field itself.

**Note:** These formatting options are applied when the WebFOCUS Reporting Server retrieves data from the data source. When that data is passed to the JavaScript chart engine to generate a chart, some formatting information may not be included and replaced with default settings. For reports, the selected field formatting options are passed directly.

When you change the field format, a new calculated field is created with the new format, replacing the original field. The calculated field is also added to the field list. The new field is identified by the number 1 appended to the field name and title. Additional format changes can be applied directly to the new, reformatted field, without creating additional calculated fields. The original field is still available in the field list if you want to restore the original format without using the field format options.
To change the format of a field in a bucket on the Properties panel, right-click the field and point to *Format data*, as shown in the following image.

**Note:** When editing the format of a field, the only options available are those that are relevant to the selected field.
When creating or editing a calculated field, you can access Data Format options by clicking the Edit Format button, which appears with a different icon depending on whether the field is a number, character, or date field, and which is located above the Operator Selection pane next to the field name, as shown in the following image.
To edit the format of a field, first select the data type, then set details specific to that data type. In the following image, the numeric data type is selected, providing options for numeric fields.

You can select one of the following data types:

- **Character format**, for fields containing letters and numbers.
- **Number format**, for fields containing numbers that you want to sum or aggregate.
- **Date format**, for fields containing dates.
- **Other format**, for fields that have values that do not match one of the other formats, such as date-time fields or string fields, or are a variety of another type of field, such as packed decimal fields or Julian date fields.
When you select the character data type, you can specify character-specific formatting, as shown in the following image.

You can use the Length option to select the number of characters to display in the field, and enable variable length. Variable length indicates that the number of characters can vary depending on the data that is stored in the field.

When you select the numeric data type, you can specify number-specific formatting, as shown in the following image.
You can choose whether or not to display decimals, and set the maximum number of digits to show before and after the decimal point. You can also choose how to format negative numbers, whether to show thousands separators, and whether to show a zero before the decimal point when the value is less than one.

You can also specify currency and percent variations, such as a different currency symbol or a change in the use of a percentage value. When you select the currency option under Type, the Currency symbol and Symbol position options appear, allowing you to select the currency symbol and how it displays. When changing the format of a numeric field, a preview shows an example of what data values may look like based on the current field format settings.

**Note:** The Percent data format option automatically multiplies the field value by 100 so that decimal values are accurately converted to percentages. If your data values do not need to be multiplied by 100 and only need the percent symbol (%) added, select the custom format data type and manually enter a field format followed by %. For example, \( D12.2\% \).

When your data type is a date field, you can make a selection from the supported date formats that are available for selection. The options for a date field are shown in the following image.

![Date format menu](image)

The Date format menu shows a list of date formats as applied to December 31 of the current year. You can select date formats that use separators or month names, or show a single date component.

When you select a date format that uses a separator, the Date separator menu is available. You can choose to use a slash (/), dash (-), dot (.), or space.
If you want to use a format not available in the character, number, or date sections, you can select the Other data type. Type a valid WebFOCUS field format into the Format text box. For example, the following image shows a field using the format HMDYYS, which is a date-time format.

The Other data type, like all of the other data types, does not allow field transformations, which prevents invalid formats. If the field was originally alphanumeric, you can enter a custom alphanumeric format. If the field was originally numeric, you can enter a custom numeric format. If the field was a originally a date field, you can enter a custom date format.

**Procedure:** How to Change the Number of Decimal Places in a Field

You can change the number of decimal places that display for a numeric field to show fewer or more decimal values. Showing more decimal values allows you to analyze your data with greater precision, while showing fewer decimal values may help make information more immediately digestible.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select *wf_retail_lite.mas* as the data source.

   WebFOCUS Designer loads with options to create a single content item.

3. Change the content type to a report. In the Content picker, select one of the report layouts.

   Using a report makes it easy to see all data values directly on the canvas. If you are creating a chart, you can see exact data values when you point to a section of the chart to display a tooltip.
4. Add a sort field, for example, Product Category, to the Row bucket and a measure field, for example, Revenue Per Sq. Ft., to the Measure bucket.

5. Change the format of the measure field to show four digits after the decimal point, by doing the following:
   a. In the Measure bucket, right-click a field and point to Format data, as shown in the following image.
b. If the field is not already in a numeric format, change the data type to numeric by clicking the number button in the Data type section, as shown in the following image.

c. To display decimals, ensure that the integer option is not selected in the Type section. You can select the decimal, currency, or percent option depending on how you want the field to display.

d. To change the number of digits after the decimal, use the arrow control to increase or decrease the Decimal place value, or type a number in the text box.

e. Check the data preview in the Sample data text box. If it shows the symbols and the number of values that you want to display in your content, click OK to accept your format changes.

The field whose format you modified is replaced with a new version that shows the specified number of decimal points, as shown in the following image.
The field whose format you modified now shows the specified number of decimal points, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Revenue Per Sq. Ft.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>24,903.9186</td>
</tr>
<tr>
<td>Camcorder</td>
<td>29,664.6065</td>
</tr>
<tr>
<td>Computers</td>
<td>18,510.8106</td>
</tr>
<tr>
<td>Media Player</td>
<td>47,720.1179</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>55,985.4263</td>
</tr>
<tr>
<td>Televisions</td>
<td>15,276.0628</td>
</tr>
<tr>
<td>Video Production</td>
<td>11,110.4634</td>
</tr>
</tbody>
</table>

Creating Calculations

When you create content, you are not restricted to the fields that exist directly in your data source. You can add calculations to automate summations and other mathematical tasks related to your data fields. You can specify operators, fields, variables, and functions when creating a calculation. If you can generate the information you want from the existing data, you can create a temporary field to evaluate and display it. A temporary field is a field whose value is not stored in the data source, but can be calculated from the data that is there. A temporary field takes up no storage space in the data source, and is created only when needed.
You can create two types of temporary fields, which differ in how they are evaluated:

- A pre-aggregation calculated field, or DEFINE, is evaluated as each record that meets the selection criteria is retrieved from the data source. The result of the expression is treated as though it were a real field stored in the data source.

- A post-aggregation calculated field, or COMPUTE, is evaluated after all the data that meets the selection criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the aggregated values of the fields.

**Performing Basic Calculations**

You can use the calculator to perform basic calculations on fields in your data hierarchy. When you create a calculated field, a new, unique field is created. It incorporates all of the data fields and expressions that you added to the calculation.

Once the calculation is complete, a new data field is created which can subsequently be used in your content. This field is placed on the Data pane, using the label of the originating field on which you created the initial calculation. For example, you can perform an addition operation on two fields. This action sums the values of the fields, displaying the total of the two when the field is used in a chart. You can also perform more advanced calculations that can result in different outcomes.

Calculated fields include DEFINEs, COMPUTEs, quick transforms, and more. You also have access to WebFOCUS functions that can be used in a calculation to perform specific operations on character and numeric fields. These display in a list of available functions. They are separated into categories, listed in alphabetical order, and are case-insensitive.

A DEFINE field is evaluated before data aggregation, while a COMPUTE field is evaluated after data aggregation. This means that DEFINE fields are especially useful to sort the data in a chart or report, while a COMPUTE field is especially useful as a measure field.

You can determine whether a calculation will be created as a DEFINE or COMPUTE by selecting Calculate at the source or Calculate after aggregation in the calculator. When you select Calculate at the source, a DEFINE field is created, and when you select Calculate after aggregation, a COMPUTE field is created. When you create a DEFINE field, it is added to the field list, from where you can add it to your content. When you create a COMPUTE field, it is added to your content automatically, in the default measure bucket if it was created from the field list, or in the bucket from where you created the COMPUTE.
Access the calculation feature in one of the following ways:

- Right-click a field in the Resources panel and click *Add calculation*. This creates a DEFINE, by default, with the selected field added automatically to the calculation. If you create a DEFINE, it is added to the Resources panel, from where you can add it to your content. If you create a COMPUTE, it is added to the default measure bucket.

- Right-click a measure field in a bucket and click *Add calculation*. This creates a COMPUTE, with the selected field automatically added to the calculation. The calculated field is added to the bucket from where you accessed the calculator.

- Click the menu in the Dimensions area or Measures area of the Resources panel, and click *Add calculation*. This creates a DEFINE, by default. If you create a DEFINE, it is added to the Resources panel, from where you can add it to your content. If you create a COMPUTE, it is added to the default measure bucket.

- When creating a report, click the menu for the Rows bucket or the Summaries, Counts, Details, or Details with counter bucket, and click *Add calculation*. This creates a COMPUTE. The calculated field is added to the bucket from where you accessed the calculator.

- Right-click a calculated field that you created previously and click *Edit calculation*. This allows you to modify an existing calculated field. This option is available from the field list for DEFINE fields, and from a bucket in the Properties panel to which a calculated field has been added.
When you perform one of these actions, the calculator opens, as shown in the following image.
The numbering in this image points out the different areas of the interface, as a guide.

1. **Title bar.** Shows context information about the current calculation. For example, New Calculation or Edit Calculation, along with the field name.

2. **Evaluation options.** Determines the type of calculation. Select *Calculate at the source* to create a pre-aggregation, DEFINE field, or select *Calculate after aggregation* to create a post-aggregation, COMPUTE field.

3. **Close button.** Closes the Calculator. Clicking this button performs the same function as the Cancel button.

4. **List chooser.** Allows you to select which list should be displayed in the Calculator. For example, functions.

5. **Search box.** Allows you to search for components across all subjects (Fields, Functions, and Variables). The search will find matches on contiguous text and performs a case-insensitive search. A flat list of matches is returned.
   - For Fields, matches are performed on Name, Title, and Positional (folder or segment) information in the hierarchy.
   - For Functions, matches are performed on Name, Category, Parameters, and Help text.
   - For Variables, matches are performed on Name.

6. **Field/Function/Variable list.** Lists the fields, functions, or variables that are available for selection and on which you can perform a calculation.

   The following considerations apply to Field/Function/Variable lists.
   - A Field list will always present with Single-list mode. It operates the same way as the Field List tab in the Field Tree.
   - The Function list displays a categorized list of WebFOCUS functions, sorted case-insensitive in alpha order (ascending or descending). You can use the drop-down menu to select the category of the function that you want to use, or you can search for a function. Double-click or drag and drop a function into the Canvas and then supply parameter values to use it.

   You can still use a function, even if it is not listed, by typing it into the calculator canvas. See the *Using Functions* technical content for a complete list of available functions, including legacy functions.
A Variable list displays a list of system variables in WebFOCUS. The Variable list tab operates the same way as the Variable list tab in the Field Tree.

7. **Calculated field definition area.** Displays the field name for which an expression is being created. It displays an icon (separate) to allow its format to be set with the Data Format Selector.

- **Format icon.** You can use the Format icon to change the target field format for the calculation.

- **Properties icon.** Enables you to change the target field properties for the calculation, such as the field name and title, and whether to allow missing values.

8. **Operator Selection pane.** This pane displays a full, contextualized list of operators that are available in calculations. It also displays mathematical and logical operators. Additional statements (IF, THEN, ELSE) are also included.

9. **Canvas/typing surface.** This is where you build your calculation. It shows fields, aggregations, and other items related to the calculation you are creating. It also supports functions, variables, operators, values, and placeholders.

10. **Function Help.** When working with Functions, you may receive help messages, such as a description of the selected function and the values that you must supply.

11. **Actions.** Includes a Validate button that allows you to check whether the syntax that you have provided for the DEFINE or COMPUTE is structured correctly, and options to cancel or commit the calculated field.

**Procedure:** How to Create a DEFINE Field Using a WebFOCUS Function

A DEFINE is a virtual field that is evaluated as each record that meets the selection criteria is retrieved from the data source. The result of the expression is treated as though it were a real field stored in the data source. It is added to the field list in the Resources panel, from which you can add it to multiple content items.

You can use a WebFOCUS function in a DEFINE or in a COMPUTE to transform data from an existing field to create a new field. Each function accepts a different set of arguments that are added in parentheses after the function name.

DEFINEs are built from the field list in the Resources panel.

DEFINEs can be created in the following ways:

- **In a Master File.** These virtual fields are available whenever the data source is used.

- **In a procedure.** A virtual field that is created in a procedure lasts only for that procedure.
In this example, a new DEFINE field will be created that uses the DTRUNC function to supply the first day of the week for each sale date.

1. Create a new visualization in WebFOCUS Designer, using wf_retail_lite.mas as the data source.

2. With the Fields tab selected from the sidebar, in the Resources panel, right-click a field or click the menu next to the Dimensions area or Measures area, and then click Add calculation.

   The calculator opens to create a new DEFINE field, by default. Notice that the Create at the source radio button is selected.

3. In the Calculator dialog box, click the Functions tab.

   The Function list appears, and displays the first available function category.

   Note: If you create the new calculation by right-clicking a field, that field is automatically added to the calculator text area. For the present example, delete this text before continuing.

4. Navigate to the DTRUNC function using one of the following methods:
   - In the search box, type DTRUNC.
   - Expand the function category drop-down menu, and select Date/Date-Time.

   Double-click the DTRUNC function, or drag it into the Calculator text area.

   The text area displays the function and identifies the required arguments, in this case, date and period. Notice that an example is provided in the space below the calculator text area.

5. In the text area, inside the parentheses after DTRUNC, select the word date.

6. In this space, specify the input date that will be used to provide the first day of the week. In this case, instead of a single date, provide an entire date field, so that the DEFINE field will generate a value for each input date value.

   Click the Fields tab to access the Field list. Under Dimensions, expand Sales_Related, Transaction Date, Simple, Sale,Day, and Sale Date Details, then double-click Sale,Date.

   The Sale Date field is added as the first argument in the DTRUNC function, as shown in the following image.

   \[ \text{DTRUNC( "Sale,Date", period) \} }\]
7. Replace the word *period* with the date component that you want the field to use as increments. In this case, it is the first day of each week. Type *WEEK* as the second argument in the DTRUNC function, in place of the *period* placeholder text. The completed function should resemble the following:

```
DTRUNC("Sale,Date", WEEK)
```

8. Since the output of the DTRUNC function is a date field, the DEFINE field should use a date format.

   Click the *Edit format* button, change the Data type to a date format, and select an option of your choice from the Date format drop-down menu.

   Click *OK*.

9. Optionally, double-click the name of the DEFINE field to change it.

10. Click *Validate* to confirm that the DEFINE is set up correctly.

11. Click *OK* to return to the calculator.

   If the validation indicated that there was an error, determine the cause of the issue and fix it.

12. Click *OK* to finish creating the DEFINE field.

   If you created the DEFINE by right-clicking a field in the Field panel, it displays at the bottom of the measure or dimension group where it was created from. If you have trouble locating your calculated field, type the name into the search box to find it.

13. Add the DEFINE to your content as a sort field.
You can use the calculated field from this example to create a chart or report that shows sales information for each week, as shown in the following image.

![Revenue Chart](image)

**Procedure: How to Create a COMPUTE Field**

COMPUTEs are calculated fields whose values are evaluated after all of the data that meets the selection criteria is retrieved, sorted, and summed. The calculation uses the aggregated (total) values of the fields. For example, based on the values of Revenue and MSRP fields in your data source, you could calculate the discount percentage.

Create a COMPUTE field by selecting *Calculate after aggregation* in the calculator.

1. Create a new visualization in WebFOCUS Designer, using `wf_retail_lite.mas` as the data source.
2. With the Fields tab selected on the sidebar, on the Resources panel, in the Measures area, expand the Sales folder, and double-click the Revenue field to add it to a measure bucket.
3. From the measure bucket, right-click the Revenue field and click *Add calculation*.
4. In the Calculator dialog box, build the COMPUTE.
**Note:** The field that you right-click to create the COMPUTE field is automatically added to the text area, as shown in the following image.

You can select another field, or add fields from the data source tree that display.

**Note:** For COMPUTEs, the Calculate after aggregation check box is selected, indicating that the field values are evaluated after the chart or report has been sorted.

5. Type the mathematical expression to create a COMPUTE field to evaluate the discount percentage using the Revenue and MSRP fields:
   a. Click to place your cursor before the Revenue field in the text area, and type `1 - (`. 
   b. Click to place your cursor after the Revenue field, and type `/`. 
   c. From the data tree, under Measure Groups, expand the Sales folder and double-click the MSRP field to add it to the expression. 
   d. Type `)` to close the expression. The completed expression for the COMPUTE field should resemble the following:

```
1 - ("Revenue"/"MSRP")
```
The following image shows this expression in the Calculator.

Note: You can use the buttons in the Operator Selection area instead of typing some mathematical operators.

6. To show the discount percentage as percentage values instead of as a decimal, change the format of the calculation.
Click the Format icon to open the Format dialog box. Click the Percent Type option to change the field format to a percentage, as shown in the following image.

![Format dialog box]

The percentage option automatically multiplies the values in the field by 100 to produce a percentage, so we do not need to perform this operation in the COMPUTE expression.

7. Click OK to accept the field format change.

8. Optionally, change the name of the COMPUTE field. It is assigned a default name based on where the COMPUTE field was created from. Unless you specify a different column title, this name appears in the bucket where the COMPUTE is used and in your content.

   Double-click the field name next to the Format icon, and type a new name for the field.

9. Optionally, change the column title that displays for the COMPUTE field when it appears in your content.
Click the Field Properties menu, and type a column title for the field, as shown in the following image.

10. Click OK to accept the new column title for the COMPUTE.
11. Click Validate to confirm that the COMPUTE is set up correctly.
12. Click OK to return to the calculator.

   If the validation indicated that there was an error, determine the cause of the issue and fix it.
13. Click OK to finish creating the new COMPUTE field.

   The field is added to the same bucket from which you created it. You can move it to a different bucket or delete the original field, Revenue, in this example, from which it was created.
The following image shows a data grid that displays the Revenue and the calculated Discount Percentage for different product models.

<table>
<thead>
<tr>
<th>Model</th>
<th>Revenue</th>
<th>Discount Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2100</td>
<td>$4,434,062.45</td>
<td>4.56%</td>
</tr>
<tr>
<td>4200</td>
<td>$1,957,114.64</td>
<td>4.75%</td>
</tr>
<tr>
<td>Audio Technica ATHW5000</td>
<td>$9,341,397.65</td>
<td>4.50%</td>
</tr>
<tr>
<td>AudioVox D1788PN</td>
<td>$148,343.05</td>
<td>4.21%</td>
</tr>
<tr>
<td>Audiovox VE727</td>
<td>$274,014.46</td>
<td>3.91%</td>
</tr>
<tr>
<td>B00D7MOHDO</td>
<td>$2,514,622.50</td>
<td>4.49%</td>
</tr>
<tr>
<td>BCG34HRE4KN</td>
<td>$1,508,212.41</td>
<td>4.39%</td>
</tr>
<tr>
<td>BOSE AM10IV</td>
<td>$15,009,325.65</td>
<td>4.50%</td>
</tr>
<tr>
<td>BOSE AM16II</td>
<td>$9,749,839.35</td>
<td>4.41%</td>
</tr>
<tr>
<td>BOSE V-S2</td>
<td>$14,194,157.90</td>
<td>4.47%</td>
</tr>
<tr>
<td>BOSE V-S2-P</td>
<td>$10,898,704.95</td>
<td>4.38%</td>
</tr>
<tr>
<td>C6506B</td>
<td>$8,159,907.03</td>
<td>4.41%</td>
</tr>
<tr>
<td>C6506S</td>
<td>$8,072,776.93</td>
<td>4.45%</td>
</tr>
<tr>
<td>C6506W</td>
<td>$8,095,460.35</td>
<td>4.47%</td>
</tr>
<tr>
<td>Canon FS300</td>
<td>$14,280,110.10</td>
<td>4.50%</td>
</tr>
<tr>
<td>Canon HFR11</td>
<td>$9,462,118.35</td>
<td>4.39%</td>
</tr>
<tr>
<td>Canon XHA1S</td>
<td>$10,676,938.80</td>
<td>4.52%</td>
</tr>
<tr>
<td>DC390/37</td>
<td>$6,091,014.89</td>
<td>4.45%</td>
</tr>
</tbody>
</table>

If you remove the COMPUTE field from your content, it is deleted permanently. COMPUTE fields are not stored in the Resources panel.

**Procedure: How to Edit an Existing Calculation**

Once you have created a calculated field (DEFINE or COMPUTE), you can edit it. This allows you to revise the calculation and in the field so that you can achieve the results you expect.
**Note:** You cannot edit a calculated field that is already being used in a static or prompted filter. You may, however, delete the filter, edit the calculated field, then recreate the filter using the edited field.

1. On the WebFOCUS Hub or WebFOCUS Home Page, locate a visualization with new content that uses a calculated field. Right-click it and click *Edit*.

   WebFOCUS Designer opens.

2. If you created a DEFINE field, the calculated field was added to the Field panel. Right-click the calculated field and click *Edit calculation*. If you created a COMPUTE field, or already added the DEFINE field to your content, you can also edit it from the bucket to which it was added.

3. Modify the calculated field using the calculator.

4. Click *Validate* to confirm that the calculated field is set up correctly.

5. If the validation indicated that there was an error, determine the cause of the issue and fix it.

6. Click *OK*.

   The revised field displays in the location from which you edited it.

---

**Using Prefix Operator Aggregation Functions**

You can use prefix operator aggregation functions to instantly apply a number of different aggregation operations to fields, unlocking significant insight into your data without writing your own calculations.

To apply a prefix operator, right-click a field in a measure bucket in a chart or report, point to *Aggregate*, and select one of the following options:

- **None.** Does not explicitly apply a prefix operator. When the Summaries display option is selected, the Sum aggregation is used. When the Counts display option is selected, the Count aggregation is used. When the Details or Details with counter display options are used, no aggregation is applied.

- **Sum.** Adds record values together for the selected field within each sort value.

- **Average.** Calculates the average of record values for the selected field within each sort value.

- **Count.** Provides the number of record values for the selected field within each sort value. If there are no missing values in the data source, the count aggregation returns the same value for every field.
- **Count distinct.** Provides the number of distinct record values for the selected field within each sort value.

- **Percent.** Calculates a percentage for each sort value based on the summed total value for the selected field.

- **Percent of count.** Calculates a percentage for each sort value based on total record count for the selected field.

- **Minimum.** Provides the minimum value for the field within each sort value.

- **Maximum.** Provides the maximum value for the field within each sort value.

- **Median.** Provides the median field value with each sort value.

- **Mode.** Provides the most common value of the field within each sort value.

- **Standard Deviation, Sample.** Provides the standard deviation of the field, within each sort value. Sample standard deviation uses Bessel’s correction of \( n-1 \) to calculate the standard deviation.

- **Standard Deviation, Population.** Provides the standard deviation of the field, within each sort value. Population standard deviation is calculated using \( n \) to represent the number of records in the request.

- **First value.** Available only when a dimension field is added to the measure bucket of a report. Retrieves the first value in the field from the data source.

- **Last value.** Available only when a dimension field is added to the measure bucket of a report. Retrieves the last value in the field from the data source.

- **Distinct.** Available only when creating reports with the Details and Details with counter display options. Displays only distinct values.

- **Total.** Available only when creating reports with the Details and Details with counter display options. Provides a grand total for the field. The Total operator (TOT.) can also be applied to a measure field in a header or footer to show the total value.

The operation is instantly applied to the field, indicated by a prefix in the measure bucket.

When you add a dimension field to a measure bucket in a chart, the only available aggregations are Count, Count distinct, and Percent of count. These options allow you to understand the distribution of values in dimension fields. When you add a dimension field to a chart as a measure, the Count aggregation is applied automatically in order to generate aggregated values for the chart.
In reports, numeric dimension fields are aggregated by default when added to the Summaries bucket, while alphanumeric dimension fields have the maximum aggregation prefix applied. When a dimension field is added to the Counts bucket, the count aggregation is applied. When a dimension field is added to the measure bucket of a report, the following aggregation options are available:

- Count
- Count distinct
- Percent of count
- Minimum
- Maximum
- First value
- Last value

When using Counts display option, the Count prefix operator is used by default, but other operators, including Sum, can also be applied. These operators behave the same as when using the Summaries display option. When using the Details and Details with counter display options, measure values are not aggregated. As a result, measure fields in the Details and Details with counter buckets can only use the Distinct, Total, and Percent prefix operators.

You can use the same field multiple times in a chart or report with different prefix operators to enhance your understanding of your data set. For example, the report in the following image shows columns for average revenue and median revenue, which helps to understand the skewness of the data.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>AVE Revenue</th>
<th>MEDIAN Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$231.90</td>
<td>$169.00</td>
</tr>
<tr>
<td>Camcorder</td>
<td>$415.82</td>
<td>$299.99</td>
</tr>
<tr>
<td>Computers</td>
<td>$301.13</td>
<td>$280.00</td>
</tr>
<tr>
<td>Media Player</td>
<td>$454.12</td>
<td>$382.49</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>$345.64</td>
<td>$251.99</td>
</tr>
<tr>
<td>Televisions</td>
<td>$1,227.71</td>
<td>$799.99</td>
</tr>
<tr>
<td>Video Production</td>
<td>$376.91</td>
<td>$299.00</td>
</tr>
</tbody>
</table>
Since the average revenue values for each product category are all greater than the median revenue values, we can see that the data is skewed to the right. This means there are a higher proportion of records with lower than average revenue, and that the average revenue is brought up by some outlying high revenue values.

Similarly, you can use the Count prefix operator in combination with the binning feature to see the distribution of your data, such as in a histogram. To create a histogram, create a new chart, right-click a measure field in the Resources panel, point to Bin values, set a bin size and labeling option, and click OK. The bins appear as a field in the Dimensions area of the Resources panel. Drag the bin field into the sort bucket of your chart, such as the Horizontal bucket in a bar chart. Next, drag the same field for which you created your bins from the Measures area into the bucket used to aggregate measure data in the chart, such as the Vertical bucket in a bar chart. Finally, right-click that measure field, point to Aggregate, and click Count. The result is a histogram showing the distribution of values for the selected field, as shown in the following image.

Using Quick Transforms to Apply Analytical Functions to Data Fields

With quick transforms, you can easily apply the most commonly used analytical functions to measure fields in your content. This allows you to quickly apply a function to a field as you create content, expanding your options for incorporating aggregated data.
Quick transforms are robust and support a variety of functions. For example, you can perform a rolling or moving aggregation or correlation (both COMPUTEs) on a measure field. This makes it easy to perform the calculations you need to understand the distribution and patterns in your data with just a few clicks. To access these options, right-click a measure field in your chart or report, point to Quick transform, and then point to one of the quick transform options. Each quick transform allows you to configure how the calculation is performed. The following options are available:

- **Rolling aggregate.** Reaggregates the total values in the request at each sort value.
- **Moving aggregate.** Reaggregates subtotal values in the request, for a fixed number of previous sort values, at each sort value.
- **Correlation.** Calculates the correlation coefficient between two numeric fields.
- **Cluster.** Partitions values into a specified number of clusters, based on the nearest mean value.

You can do this from the shortcut menu for a measure field added to a non-sorting bucket in a chart or report, such as the Vertical bucket in a bar chart. Placing a measure in the Horizontal bucket, which is used to sort a bar chart, creates entries for each underlying value. In this case, you do not have access to the Quick transform option.

Other examples include the use of the correlation function, which calculates the correlation between two numeric fields. This is often used to display how strongly two variables are related to each other. In addition, the cluster (KMEANS) function partitions observations into a specified number of clusters based on the nearest mean value. The goal of cluster analysis is to group, or cluster, observations into subsets based on their similarity of responses on multiple variables.

Quick transforms create post-aggregation (COMPUTE) virtual fields. A calculated value (COMPUTE) is evaluated after all of the data that meets the selection criteria is retrieved, sorted, and summed. This means that the quick transform calculation is performed using the aggregated values of the fields.
Performing a basic aggregation with a quick transform allows you to convert a field value from its raw state into a calculated field. With the Discount field, you can create a rolling sum that shows the cumulative sum of the field as it changes for each value in the chart. The Quick transform options are shown in the following image.

![Quick Transform Options](image)

**Note:** You can perform multiple quick transforms using the same originating field.

Here, you can specify the type of aggregation (for example, Sum, Average, Count, and others) and indicate whether you want to keep the original field. The Keep original field option is selected, by default, if the bucket supports multiple measure fields, and serves the purpose of preserving the original field for other use in your chart. You can also choose to replace the field in favor of the transformed field, by deselecting this check box.

When you perform a quick transform on a field, a new, unique field is created and placed in the same bucket as the originating field, as shown in the following image.

![Transformed Field](image)
The transformed field is now a COMPUTE, which is a post-aggregation calculated field. It is a separate field, labeled with the transformation that was applied. You can move the transformed field into a different measure bucket to make it easier to analyze your data. For example, the following image shows a scatter chart with Model values plotted based on Quantity Sold and MSRP values. The Cluster quick transform was performed on the MSRP field using the Average aggregation, creating four groups of models with similar average MSRP values. The cluster field has been moved into the Color bucket, making it easy to identify which cluster each model falls into.

---

**Procedure: How to Apply a Rolling Aggregation to a Report Using Quick Transforms**

A rolling aggregate, or cumulative moving aggregate, is a cumulative aggregation of values. The aggregation is recalculated for each data record, allowing you to see totaled or recomputed values at various points in a chart or report.

You can add a rolling sum to a report that is sorted by year, quarter, and month values, allowing you to see the total sales data for different points in time. You can also break the rolling sum on a lower-level sort field, allowing you to view a separate rolling sum for different categories.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select wf_retail_lite.mas as the data source.
WebFOCUS Designer loads with options to create a single content item.

3. On the Content picker, select one of the report layouts as the content type.

4. With the Fields tab selected on the sidebar, on the Resources panel, in the Dimensions section, expand Sales_Related and Transaction Date, Simple, and double-click Sale,Year, Sale,Quarter, and Sale,Month, in order, to add them to the report in the Rows bucket.

5. On the Resources panel, in the Measures section, expand Sales and double-click Revenue to add it to the Summaries bucket.

The report now shows Revenue by Sale Year, Sale Quarter, and Sale Month.

6. To see how the total revenue increased over time, add a rolling sum quick transform on the Revenue field.

   a. In the Summaries bucket, right-click the Revenue field, point to Quick transform, and then to Rolling aggregate.

   b. Leave the selected Aggregation option as Sum.

      You can select a different aggregation option to recalculate that aggregation at each row of the report.

   c. Leave the Break on option set to None. The rolling sum will continue accruing throughout the entire report, without resetting.

   d. Leave the Keep original field check box selected, so that you will still be able to see the Revenue values for each month.

   e. Click OK.
The quick transform field, called Revenue rolling sum, by default, is added to the report. It displays the total revenue that has been accrued up to each month, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Sale Quarter</th>
<th>Sale Month</th>
<th>Revenue</th>
<th>Revenue rolling sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>1</td>
<td>1</td>
<td>$3,874,651.96</td>
<td>$3,874,651.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>$3,592,608.63</td>
<td>$7,467,260.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>$3,977,546.75</td>
<td>$11,444,807.34</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>1</td>
<td>$3,648,111.77</td>
<td>$15,092,919.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>$3,704,586.77</td>
<td>$18,797,505.88</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>$3,694,435.21</td>
<td>$22,491,941.09</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>1</td>
<td>$4,020,855.35</td>
<td>$26,512,796.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>$4,126,310.80</td>
<td>$30,639,107.24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>$3,688,054.34</td>
<td>$34,327,161.58</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>1</td>
<td>$4,794,720.40</td>
<td>$39,121,881.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>$4,574,636.32</td>
<td>$43,696,518.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11</td>
<td>$5,268,550.91</td>
<td>$48,965,069.21</td>
</tr>
<tr>
<td>2015</td>
<td>1</td>
<td>1</td>
<td>$4,857,824.42</td>
<td>$53,822,893.63</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>4</td>
<td>$4,422,610.34</td>
<td>$67,764,106.86</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>$4,586,992.98</td>
<td>$72,351,099.84</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>$4,856,111.47</td>
<td>$77,207,211.31</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>7</td>
<td>$5,075,337.19</td>
<td>$82,282,548.50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>$5,133,075.08</td>
<td>$87,415,623.58</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>$5,031,634.54</td>
<td>$92,447,258.12</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>11</td>
<td>$5,788,867.16</td>
<td>$104,062,870.73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12</td>
<td>$6,043,161.45</td>
<td>$110,106,032.18</td>
</tr>
</tbody>
</table>

7. Add a new rolling sum quick transform field that breaks on the Sale Year field, thereby showing the accrued revenue at different points within each year.
   a. In the Summaries bucket, right-click the Revenue field, point to Quick transform, and then to Rolling aggregate.
   b. Open the Break on drop-down menu and select Sale, Year.
   c. Click OK.
A new quick transform field, called *Revenue rolling sum Sale Year*, by default, is added to the report. Notice that the values continue increasing until the end of each year, at which point they reset and start accruing again, as shown in the following image.

<table>
<thead>
<tr>
<th>Sale Year</th>
<th>Sale Quarter</th>
<th>Sale Month</th>
<th>Revenue</th>
<th>Revenue rolling sum</th>
<th>Revenue rolling sum Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>1</td>
<td>1</td>
<td>$3,874,651.96</td>
<td>$3,874,651.96</td>
<td>$3,874,651.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>$3,592,608.63</td>
<td>$7,467,260.59</td>
<td>$7,467,260.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>$3,977,546.75</td>
<td>$11,444,007.34</td>
<td>$11,444,007.34</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>4</td>
<td>$3,648,111.77</td>
<td>$15,092,919.11</td>
<td>$15,092,919.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>$3,704,686.77</td>
<td>$18,707,505.88</td>
<td>$18,707,505.88</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>$3,694,435.21</td>
<td>$22,491,941.09</td>
<td>$22,491,941.09</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>7</td>
<td>$4,020,855.35</td>
<td>$26,512,796.44</td>
<td>$26,512,796.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>$4,126,310.80</td>
<td>$30,639,107.24</td>
<td>$30,639,107.24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>$3,686,054.34</td>
<td>$34,327,161.58</td>
<td>$34,327,161.58</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>10</td>
<td>$4,794,720.40</td>
<td>$39,121,881.98</td>
<td>$39,121,881.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11</td>
<td>$4,574,636.32</td>
<td>$43,695,518.30</td>
<td>$43,695,518.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12</td>
<td>$5,238,550.91</td>
<td>$48,905,069.21</td>
<td>$48,905,069.21</td>
</tr>
<tr>
<td>2015</td>
<td>1</td>
<td>1</td>
<td>$4,857,824.42</td>
<td>$53,822,893.63</td>
<td>$4,857,824.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>$4,595,104.63</td>
<td>$58,419,088.26</td>
<td>$9,453,019.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>$4,923,403.20</td>
<td>$63,341,496.52</td>
<td>$14,370,427.31</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>4</td>
<td>$4,422,610.34</td>
<td>$67,764,106.86</td>
<td>$18,799,037.55</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>$4,536,092.98</td>
<td>$72,351,099.84</td>
<td>$23,386,030.63</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>$4,850,111.47</td>
<td>$77,207,211.31</td>
<td>$28,242,142.10</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>7</td>
<td>$5,075,337.19</td>
<td>$82,282,548.50</td>
<td>$33,317,479.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8</td>
<td>$5,133,076.08</td>
<td>$87,415,623.58</td>
<td>$38,450,564.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>$5,031,634.54</td>
<td>$92,447,256.12</td>
<td>$43,482,188.91</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>10</td>
<td>$5,826,745.45</td>
<td>$98,274,003.57</td>
<td>$49,308,934.36</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11</td>
<td>$5,788,867.16</td>
<td>$104,062,870.73</td>
<td>$55,007,801.52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12</td>
<td>$6,043,161.45</td>
<td>$110,106,032.18</td>
<td>$61,140,962.97</td>
</tr>
<tr>
<td>2016</td>
<td>1</td>
<td>1</td>
<td>$7,528,276.32</td>
<td>$117,634,308.50</td>
<td>$7,528,276.32</td>
</tr>
</tbody>
</table>

Using this report, you can see when certain revenue goals and thresholds were met.

**Procedure:**  How to Apply a Moving Average to a Chart Using Quick Transforms

You can use a rolling or moving average to smooth out the data in your chart or report, making it easier to identify trends and patterns.
While a rolling aggregate is a cumulative aggregation of all of the values in a chart or report, a moving aggregate is a cumulative aggregation that is performed on a limited selection of the most recent values. As the moving aggregate proceeds through the sequence of values in your chart or report, earlier values are gradually discarded from the calculation as they fall outside the scope of the moving aggregation. A moving average, therefore, is an average that is recalculated at each value for that value and a specified number of prior values.

To create a moving average based on a measure field in your content:

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select *wf_retail_lite.mas* as the data source.

   WebFOCUS Designer loads with options to create a single content item.

3. Use the Content picker to change the chart type to a vertical side-by-side bar chart. The moving average will be added to the chart as a second measure, and since we want to compare it directly to the non-transformed field, the bars should be aligned side-by-side instead of stacked.

4. On the Resources panel, in the Dimensions section, expand *Sales_Related* and *Transaction Date, Components*, and double-click *Sale,Year/Quarter* to add the Sale Year/Quarter field to the chart in the Horizontal bucket.

5. On the Resources panel, in the Measures section, expand *Sales* and then double-click *Revenue* to add the Revenue field to the Vertical bucket.
The result is a bar chart showing revenue for each quarter of each year, as shown in the following image.
6. Right-click the measure field in the Vertical bucket, in this case, Revenue, and point to Quick transform, as shown in the following image.

7. To add a moving average to the chart, point to Moving aggregate and:
   a. From the Aggregation menu, select Average, which is the default. You can alternatively create a moving sum, moving count, and more.
   b. Since there is only one sort field in the chart, the Break on option is not available. If we had added a second field to the Horizontal bucket, you would be able to select a field on which to break the moving average.
The default selection is None. When None is selected, the moving aggregation continues for every value, and never resets. If you have multiple sort fields in the chart, and you select a field to break on, the aggregation starts over for each new value of that field. You cannot break on the lowest sort field or the only sort field, since this would cause the rolling aggregation to reset on each value.

c. Set the Look back value to 8. The Look back value determines the number of past values to include when evaluating the moving aggregation. In this case, we will use the last two years of data to calculate the moving average.

Use a higher Look back value to make a smoother moving average. Using a lower value results in a less smooth moving average, but makes the moving average more responsive to changes to the data.

d. Leave the Keep original field check box selected. This check box controls if the original field on which you are basing the quick transform is retained in the bucket. This check box is selected, by default.

If you leave it checked, both the original field and the new calculated field will share the bucket from which the quick transform was created, if possible. If you do not want to keep the original field, you can replace the field with the quick transform field by deselecting the box. Single-field buckets, such as Size or Color, always replace the original field, and do not provide this option.

8. Click OK.

The field is placed in the measure bucket and displays in your content, by default. The legend is also updated to reflect this new field, as shown in the following image.
Notice that since we used a fairly high Look back value of 8, the moving average bars have a smooth growth that allows us easily identify a general pattern in the data, but do not increase quite as quickly as the actual revenue values.

9. Optionally, you can change the moving average fields to display as a line instead of bars, more clearly differentiating the moving average from the actual revenue values.

In the Vertical bucket, right-click the moving average field, point to Shape, and click Line.

The moving average now displays as a line, as shown in the following image.

**Note:** For information on the PARTITION_AGGR functions, see the *Developing Reporting Applications* technical content.
Using Dynamic Grouping for Dimension Field Values

Dynamic grouping allows you to create groups of elements based on the field data type that you select. For example, you may have a field with US state names, but no field for US regions. Using the dynamic grouping functionality, you can create groups for different regions for use in a content item without editing the data source. You create one group that combines state name values like Maine, New Hampshire, and Massachusetts into a New England group, states such as New York, New Jersey, and Pennsylvania into a Mid-Atlantic group, and so on. You can even add the extraneous, remaining values into an Other group automatically, if you do not think they fit into another defined group.

**Note:** The Create Group option is only available for dimension fields of non-numeric format or attribute.

You can also specify multiple, unique groupings in the same session. For example, you might want to group the data to indicate groups or products, or specific regions.

**Note:** If you want to exclude a specific data element from your analysis, you can use the filter functionality.

The grouping that you specify is applied and this new group then replaces the original field that you selected in the Query pane. The name that you specify when creating the group is reflected in the Query pane.

The process of dynamic grouping creates a Define field, which can then be used in other reports or charts in the same visualization. When creating a single content item, dynamic grouping also supports Auto Drill, enabling you to drill through the hierarchy of your data just like any other data field.

**Note:** When working with Reporting Objects, Dynamic Grouping is not supported.

**Procedure:** How to Create a Dynamic Group

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Resources pane, with Fields selected on the sidebar, right-click the data field for which you want to apply dynamic grouping.

   **Note:** You can use the dynamic grouping functionality on non-numeric dimension fields only.
4. Click *Group values*.

   The Create Groups dialog box displays.

5. In the **Field** text box, optionally type a name for the new group field.

   **Note:** The fully qualified field name is displayed as the Origin Field at the bottom of the Create Groups dialog box. The display of the fully qualified field name is particularly useful when renaming or editing a group, as it identifies the data source followed by the hierarchical location of the field within a data set. For example, `WF_RETAIL_LITE.WF_RETAIL_PRODUCT.BRAND`.

6. Create a group of values in one of the following ways:
   - Use Ctrl + click to select more than one value, as shown in the following image, then click *Group*.
   - Drag one value onto another value. The two values are grouped.

7. Optionally, double-click the group title or select a group and click *Rename*, and then type a new name for the group.
8. Optionally, add more values to the group that you just created using one of the following methods:

- Select one or more values, open the Add to menu, and select a group to add the values to.
- Select one or more values and drag them into a group.
- Drag the group onto a single, ungrouped value. The value is added to the group.
- If you have multiple groups, drag one group into another group to merge them. The name of the target group is retained for the merged group.

These methods can also be used to move a value from one group to another group.

9. Optionally, create additional groups using the methods in step 7, as shown in the following image.

10. Optionally, to ungroup values, click a group and then click Ungroup. Click Ungroup all to disband all groups.

11. Optionally, click Show other to add all remaining non-grouped values to an Other group.

**Note:** If you add all values to the Other group, all groups, including the Other group, are disbanded. You must have at least one group for the Other group to be available.
12. Click OK.

Your grouped data will display as a new field in the Resources panel. If it is not immediately visible, you can use the search feature on the field list to find it. From there, you can add the grouped field to your content, as shown in the following image.

To edit the grouped field, right-click it in the Resource panel and click Edit group values.

Creating Numeric Ranges With Binning

In WebFOCUS Designer, bins are used to group numeric values by the increment you specify. This allows you to view large amounts of data across measures or calculated measures, enabling you to analyze trends and identify outliers. Data binning also allows you view your data as part of a larger group, displaying ranges of that data in manageable, visible bins.
For example, you might want to analyze Cost of Goods Sold against Discount to understand how discounts impact the cost of goods. First, you add the Discount measure to the Vertical field container. These values will be used as a guide for the comparative, grouped content in the bin. If you apply a bin width value of 250 to the Cost of Goods measure, your data values will be grouped into ranges of 250 (for example, 0 - 250, 250 - 500, 500 - 750). Finally, you add the new binned dimension field (generated by the bin process) to your chart. Your chart now displays the binned values against the Discount measure, as shown in the following image.

As you can see in this example, there is a direct correlation between Cost of Goods and Discount, with the smaller cost records values (0 - 250) constituting more of the discount amount. From this example, it is evident that a large portion of total discounts are given for lower cost items. In this case, binning has given you insight into the frequency distribution of values in your data.
Bins are created on a numeric measure field (for example, Gross Profit), as shown in the following image.

Examples of numeric measure fields include Gross Profit or Discount. Once you create a bin, a new dimension field is automatically created, allowing you to plot values based on your bin specifications.

You can create or edit bins using the same options. On the Resources panel, right-click a field and click *Bin values*, or right-click a binned field and click *Edit bin values*. This opens a shortcut menu with the following options:

- **Bin width.** A standard text box that accepts any number greater than 0.
- **Show as.** Identifies the bin label type.
  - **Value.** Displays the alphanumeric representation of the numeric value containing the minimum value (FLOOR) of each bin. The format should be set to the data format of the source field.
  - **Range.** Displays the alphanumeric string representing the minimum and maximum range for each bin. The format should be set to the data format of the source field.
- **OK.** Creates a new dimension field based on the bin options that you selected. This dimension field is automatically added under your dimensions in the Fields tab.
- **Cancel.** Closes the shortcut menu and cancels the changes.
The following image displays bin values and bin ranges for the DEALER_COST field, using a bin width of 1000. It also shows how the data falls into the value and range properties.

<table>
<thead>
<tr>
<th>DEALER_COST</th>
<th>BINVALUE</th>
<th>BINRANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2,626</td>
<td>2,000</td>
<td>2,000 - 2,999</td>
</tr>
<tr>
<td>2,886</td>
<td>2,000</td>
<td>2,000 - 2,999</td>
</tr>
<tr>
<td>4,292</td>
<td>4,000</td>
<td>4,000 - 4,999</td>
</tr>
<tr>
<td>4,631</td>
<td>4,000</td>
<td>4,000 - 4,999</td>
</tr>
<tr>
<td>4,915</td>
<td>4,000</td>
<td>4,000 - 4,999</td>
</tr>
<tr>
<td>5,063</td>
<td>5,000</td>
<td>5,000 - 5,999</td>
</tr>
<tr>
<td>5,660</td>
<td>5,000</td>
<td>5,000 - 5,999</td>
</tr>
<tr>
<td>5,800</td>
<td>5,000</td>
<td>5,000 - 5,999</td>
</tr>
<tr>
<td>6,000</td>
<td>6,000</td>
<td>6,000 - 6,999</td>
</tr>
<tr>
<td>7,427</td>
<td>7,000</td>
<td>7,000 - 7,999</td>
</tr>
<tr>
<td>8,300</td>
<td>8,000</td>
<td>8,000 - 8,999</td>
</tr>
<tr>
<td>8,400</td>
<td>8,000</td>
<td>8,000 - 8,999</td>
</tr>
<tr>
<td>10,000</td>
<td>10,000</td>
<td>10,000 - 10,999</td>
</tr>
<tr>
<td>11,000</td>
<td>11,000</td>
<td>11,000 - 11,999</td>
</tr>
<tr>
<td>11,194</td>
<td>11,000</td>
<td>11,000 - 11,999</td>
</tr>
<tr>
<td>14,940</td>
<td>14,000</td>
<td>14,000 - 14,999</td>
</tr>
<tr>
<td>25,000</td>
<td>25,000</td>
<td>25,000 - 25,999</td>
</tr>
</tbody>
</table>

**Note:** Bin fields that display ranges, using the Show as Range option, use a character field format, while bin fields that display floor values, using the Show as Value option, use a numeric field format. As a result, when displaying ranges, bins with negative numbers display after bins with positive values. This is due to the sort sequence used for character fields. On the other hand, when displaying floor values, bins are sorted into numeric order, so negative value bins display before bins with positive values.
Therefore, if the measure field that you are binning includes negative values, it is recommended to select Value as the Show as option. Alternatively, you can display ranges in numeric order by using a bin with values as a hidden, higher-level sort field and adding the bin with ranges below it on the same axis. For example, if creating a vertical bar chart, create a value bin field and a range bin field, both with the same width. Add the value bin field and then the range bin field to the Horizontal bucket, then hide the value bin field. The ranges are now in the correct order, as shown in the following image.

Editing an Existing Bin

Once you have created a bin, you can edit it. This gives you the flexibility of changing the size of the bin or other related parameters. Changes to the bin values appear in real time.

You can edit an existing bin from the Data panel or if you have placed the bin in a bucket, by right-clicking the bin and selecting Edit bin values.

Note: If a bin field is being used in a calculated field or in a filter, you cannot change the bin label type.
Procedure: How to Create a Histogram Using Bins

A histogram is a chart, usually in a bar chart format, that displays the frequency distribution of values in your data by displaying the count of values in different ranges. The count aggregation and bins should be applied to the same field to show the frequency distribution effectively.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. If the default content type is not a bar chart, select a vertical bar chart option from the Content picker.

4. With the Fields tab selected on the sidebar, on the Resources panel, under Measures, select a numeric measure field and place it in the Vertical bucket. You can also double-click the field, or right-click it and select Add to chart.

5. Right-click the measure field in the Vertical bucket, point to Aggregate, and click Count.

   The prefix CNT. is added to the front of the field name. The vertical axis now represents the frequency of values of the selected measure field, rather than summed values.

6. On the Resources panel, under Measures, right-click the same measure field and point to Bin values.

7. Specify a numeric value in the Bin width field. For example, using the numeric value 500 creates bins that group values of 500 together.

   Keep in mind the overall range of values in the field that you are binning. Fields with smaller variance work best with smaller bins, while fields with large variance work best with larger bins.

8. Optionally, select a Show as option. Range, which is the default, shows the minimum and maximum value for each range, while Value shows only the minimum value.

9. Click OK to generate the bins for the selected measure field.

   Note: The binned measure is added to the Resources panel as a new dimension field that you can use in your chart.

10. From the list of dimension fields, locate the field that is suffixed by _BIN_1 (for example, REVENUE_US_BIN_1).
**Note:** The binned field is placed under Dimensions on the Resources panel. If you are viewing these fields using the Folder view, it will be available under a folder with the same name used under Measures. You can also use the search feature to locate the new dimension field if needed.

11. Add this new dimension field to the Horizontal field container.

The bins display in your chart. Each bar represents a range of values, and the height of each bar represents the number of records that fall into each range, as shown in the following image.

From the image above, we can see that sales falling into the first two bins, up to $500 in revenue, were the most frequent.
12. Optionally, to edit the bin width to produce more or fewer bins, or to toggle the bin label type between ranges and values, right-click the bin field in the Horizontal bucket and point to Edit bin values. You can then change the bin settings and click OK to apply them.

Enabling Field Selection at Run Time With Field List Parameters

Field list parameters are a powerful tool that allows you to provide users with a selection of fields that they can use at run-time to build charts and reports within a framework that you provide. Field list parameters can be added to buckets in place of fields in a chart or report. At run time, users select the fields that they want to display, giving them the power to choose the data that is represented by and displayed in your content. You can complement these field list parameters with fields that always appear in your content, providing a mix of customizable and static content. Field list parameters can be single select or, if the bucket allows multiple fields, multi-select, providing even more flexibility. Field list parameters are a key component of InfoApps, which are pages in which users can select the fields that display.

When you add a field list parameter, it becomes a field container into which you can add one or more measure and dimension fields. Create a new parameter by clicking Add Parameter Field List on the Settings tab. The Add Parameter Field List dialog box opens, as shown in the following image.
Here, you can supply a prompt name, used as a label for the field list control and bucket, choose which bucket the field list selections should populate, and determine whether the field list parameter is single select or multi-select. Multi-select field list parameters are not available for charts, so when creating a chart, the Control type option is locked to *Single select*. When you click *Save* to create the parameter, a field list parameter placeholder appears in the location selected from the Bucket Type menu, and a new field list parameter bucket appears below the Filters bucket. The placeholder is a purple color to distinguish it from regular measure and dimension fields.
To add fields to the field list parameter, drag them into the new field list parameter bucket. Field list parameter buckets only accept the types of fields that can be added to the bucket that the field list parameter has been added to. For example, if the field list parameter was created for the Location bucket, only fields with an assigned geographic role can be added to it. The following image shows the buckets for a report, in which the Product Category, Sale Year, Sale Quarter, and Customer Business Region fields have been added to a field list parameter, and the parameter itself has been added to the Rows bucket.
The order of the fields in each field list parameter bucket is the order in which they will appear in the field list filter prompt when you run your content. Click the check box icon next to the field name in the field list parameter bucket to set default values for each field list control. For field list parameters with a Control type of Multi-select, you can choose to have multiple fields selected by default. If parameter prompting is set in your environment to run content with default values without showing autoprompt, then when you run content in which default values have been set for all field list parameters, you will not be prompted to select fields for your content.

You can right-click a field in a field list parameter bucket to make some simple modifications to it. You can rename a measure or dimension field to change the name that it uses in the field list control when the content is run. The original field name is still used in the content itself when the field is added to it. You can also right-click a measure field in a field list parameter bucket and point to Aggregate to change the aggregation of the field. This allows you, for example, to make both summed revenue and average revenue fields available in the field list.

To edit or delete a field list parameter, click the ellipsis menu on the field list parameter bucket, and click Edit or Delete. You can also delete a field list parameter by pointing to it in the standard chart or report bucket to which it was added, and clicking the X that appears when you point to it. To remove a field from a field list, point to the field in the field list parameter and click the X, or right-click it and click Remove. To remove all fields from the field list, click the ellipsis menu for the field list parameter bucket and click Clear.

You can create multiple field list parameters, and add them to buckets together with regular fields that will always appear in your content, allowing you to have a mix of permanent and user-selected fields in your charts and reports. Just like regular fields, field list parameters can be reordered relative to other fields and field list parameters in a bucket, giving you some control over the sort order of your content, even when user-selected fields are used. Parameters can be added to any bucket in a report, and in any chart bucket, with the exception of the Multi-graph bucket.
When you run a chart or report with field list parameters, you can select the fields with which each one should be populated using standard filter controls for alphanumeric values. If the chart or report is run stand-alone, these controls are presented in the autoprompt interface. If the chart or report is added to an assembled page, you can create filter controls for each field list parameter to allow users to select fields for each one. The following image shows a page with controls for multiple field list parameters.

When adding content with multi-select field list parameters to an assembled page, changing the filter control type to a double list control, or to a check box control with the Allow reordering option enabled, makes it possible to reorder the selected fields at run time. This provides even more control over the display of your content when run in a page.

**Note:** Field list parameters are unavailable in pages created with new content. Charts and reports with field list parameters cannot be converted into a page. To add content with field list parameters to a page, create an assembled page using the Assemble Visualizations option on the plus menu of the WebFOCUS Home Page.
Enabling Hierarchical Drilling in TIBCO WebFOCUS Designer With Auto Drill

Auto Drill enables you to navigate through different levels within the dimension hierarchy of your data source. This allows you to review underlying data for a particular area, and move through the structure of your data source, based on your informational needs.

Auto Drill can be enabled for stand-alone content items. If you convert a chart or report with Auto Drill to a page with new content, a warning appears, alerting you that Auto Drill functionality will not be carried over. Auto Drill is functional in content added externally to an assembled page. To enable Auto Drill, in the Content section of the Settings tab, on the Properties panel, select AutoDrill. Auto Drill is not available if your chart or report does not contain fields that are part of a hierarchy.

Once you have enabled Auto Drill, you can develop your report or chart and run it to activate the hyperlinks that Auto Drill creates. This enables you to navigate up or down through the related hierarchy of your data source by clicking the links that display.

In a chart, Auto Drill links are available from the tooltip that appears when you point to a section of a chart, as shown in the following image.
In a report, Auto Drill links are available when you click a data value hyperlink. The values are styled as hyperlinks to indicate that you can drill into them, as shown in the following image.

![Drill down to Product Subcategory](image)

When you click a hyperlink, the option to drill up or drill down displays, depending on where you are in the hierarchy of your data. You can then select one of these options to begin navigating your data. For example, if you have Product,Category in your hierarchy, you would be able to drill down to Product,Subcategory. When you drill down, you can subsequently drill back up to the originating dimension sort field. If you have selected a data source that has multiple levels and your report or chart uses a component in the middle of the hierarchy, both the Drill up and Drill down options will display. Once you have started navigating your data using the Drill up and Drill down options, the Restore Original option displays, enabling you to start your data analysis over by re-executing the original Auto Drill request.

The drill up and drill down options are shown in the following image.
At run-time, the Auto Drill functionality displays a breadcrumb header. This defines your current location in the hierarchy of your data source and enables you to navigate back and forth between different levels in your data.

When you drill into a report, the result is filtered based on the selected value, and on the related values of any higher level sort fields. All applicable values for lower level fields are shown. Since charts do not have explicit field hierarchies, you can determine how filtering is applied when using Auto Drill in a chart with multiple dimensions, by selecting different options from the run-time menu.

When Auto Drill is enabled for a chart with multiple dimension fields, such as if there is one dimension field in the Horizontal bucket and another in the Color bucket, you can choose whether to apply filters as part of the Auto Drill navigation, based on the run-time option that you select. If you choose to apply filters, then when you drill down into a field hierarchy using Auto Drill, the result drills into the area of the chart that you clicked, and is filtered based on all dimension field values pertinent to that area. If you choose not to apply filters, the dimension that you drill into is replaced with the next field in the hierarchy, filtered for the value of the selected Auto Drill link, and other fields are not filtered. The chart continues to show all applicable values for other dimension fields.
For example, the following image shows a stacked bar chart with the Product Category field in the Horizontal bucket, and the Customer Business Region field in the Color bucket.

When you run the chart and point to a segment of it, the tooltip shows options to use Auto Drill with or without filters, as shown in the following image.
When you use Auto Drill to drill into the Product Category field from a segment in the Accessories riser, and choose not to apply filters, the resulting chart shows subcategories within Accessories, for all Business Regions, as shown in the following image.
If you drill into Product Category from a segment in the Accessories riser and do apply filters, then the resulting chart only shows the Business Region of the segment that you drilled into, as shown in the following image.

**Note:**

- The Auto Drill functionality is only available for data sources that have a dimension hierarchy. Dimension hierarchies are a capability of Business View Plus, and also of legacy Dimension View and Real Cube metadata.

- If you have Auto Drill enabled and you attempt to run your chart in deferred mode, the hyperlinks will not display. This is also true for Auto Drill enabled reports that are distributed through ReportCaster.

- Auto Drill is not supported for all HTML output format charts, or for HTML5 output format charts that do not support the new chart attributes syntax.

- You must use dimension fields as a sorting field, either BY or ACROSS.
If you are creating a chart that has multiple dimension sort fields in the request and some of these belong to the same dimension hierarchy, you may encounter multiple links with the same label in the drill menu.

Auto Drill functionality is not available in reports distributed by ReportCaster, because Auto Drill uses live data, in an interactive session, for data drilling. Data values and totals may not be the same if the data has changed since the last distribution. Mixing past data with current data could impact data analysis.

When Auto Drill is enabled, Accessibility is disabled. When Accessibility is enabled, Auto Drill is disabled. In Chart mode, Accessibility is disabled, by default.

**Procedure: How to Use Auto Drill to Navigate the Hierarchy of Your Data Source**

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Create content with one or more hierarchical fields (for example, Product, Category).

4. On the Properties panel, on the Settings tab, expand Content, and then select AutoDrill.

5. Click Run in new window.
   
   Your content displays.

6. If you created a chart, hover over an area of the chart (for example, a bar).
A menu appears, as shown in the following image.
If you created a report, click a drill-down link. A menu appears, from which you can choose to drill up or down depending on your position in the data source, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Year</th>
<th>Sales (in thousands)</th>
<th>Quantity Sold</th>
<th>Revenue (in thousands)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>2015</td>
<td>31,396</td>
<td>$7,089,068.93</td>
<td>$97.57</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>46,735</td>
<td>$11,820,675.06</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>63,836</td>
<td>$18,060,415.60</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>139,977</td>
<td>$35,619,872.81</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>209,571</td>
<td>$53,208,007.57</td>
<td></td>
</tr>
<tr>
<td>Camcorder</td>
<td>2014</td>
<td>17,722</td>
<td>$5,878,431.53</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>28,485</td>
<td>$9,673,248.16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>41,250</td>
<td>$13,971,708.11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>56,782</td>
<td>$19,438,607.89</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>123,972</td>
<td>$42,396,539.60</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>187,033</td>
<td>$63,107,166.95</td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td>2014</td>
<td>6,730</td>
<td>$1,441,835.19</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>12,239</td>
<td>$2,479,491.58</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>19,820</td>
<td>$4,170,749.59</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>34,626</td>
<td>$7,857,928.55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>89,626</td>
<td>$24,176,475.33</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>188,736</td>
<td>$63,190,001.68</td>
<td></td>
</tr>
</tbody>
</table>

7. Select a hierarchical value to which to drill down to.

Once you have drilled down on a field, you can subsequently drill up.
8. To return to the default state of the report or chart, click the Home link in the breadcrumb trail, or click a hyperlink or hover over a chart aspect and click Restore Original, as shown in the following image.

---

**Enabling Drill Anywhere to Analyze Field Relationships**

Auto Drill is a feature that allows you to drill into values from fields that are part of a data hierarchy, to see which subcategories within that hierarchy contribute to the values that you drill into, and to what extent. Drill Anywhere, meanwhile, resembles an enhanced version of Auto Drill. It does not require the fields in your initial content to be part of a data hierarchy, and it allows you to drill to any field in your data source, providing a powerful tool to explore relationships between values in different fields. Instead of drilling from a dimension field to its children within a pre-defined data hierarchy, with Drill Anywhere, you drill into a sort value to see which dimension values from the field that you select constitute subsets of that value. The resulting content is filtered by the value that you drilled into.
For example, the following image shows a simple bar chart with revenue aggregated by product category. Drill Anywhere is enabled for the chart, so target fields appear in the tooltip, in the Drill to menu.

With Drill Anywhere, you can investigate the dimension values that contribute to the value of the selected riser in a chart, or row of a report. If you point to the riser for the product category of Computers and click Drill to Customer Country in the tooltip, then the resulting chart shows information about how much revenue was generated by computer sales in each country, as shown in the following image.
To enable Drill Anywhere in your content, on the Settings tab, in the Content Settings area, click Drill Anywhere. When you run your content, the fields available as drill targets appear in the tooltips, in the Drill to menu. In reports, you can access these tooltips by clicking a hyperlink. Hyperlinks for Drill Anywhere in reports are available for all sort fields, allowing you to substitute a field of your choice for row or column group fields. In charts, you can access tooltips by pointing to a riser, allowing you to replace the sort field value that it represents.

**Note:** When using Drill Anywhere in a report using the In-Document Analytic (AHTML) output format, a limited number of fields are available for selection.

Drill Anywhere is only available for stand-alone content items, when they are run on their own or when added to a page assembled from external content.

When you use Drill Anywhere to drill to a field from the tooltip, the content refreshes and is sorted by the selected field. The data in the new content is filtered based on the value from which you accessed the tooltip. If you continue using Drill Anywhere to drill to other fields, new filters are applied to the content on top of any filters applied by previous executions of Drill Anywhere. The applied filter values are indicated by the breadcrumbs that appear above the chart or report once you have used Drill Anywhere. You can return to a previous drill level or to the original content using the breadcrumb links. You can also return to the original state of the content item by selecting Reset from the tooltip in the chart or report.

If your content uses multiple sort fields, you can use Drill Anywhere to drill into each of them. In a report, you can do this by accessing the tooltip from the sort field that you want to drill into. In a chart, these fields are listed separately in the tooltip. If you drill into multiple fields, a separate set of breadcrumbs displays for each, and filters for all values that you drill into, for all fields, are applied to the Drill Anywhere content. If you drill into a secondary sort field, then the resulting content is filtered by both the secondary sort value that you drilled into, and the primary sort value by which it was previously sorted.

**Enabling Automatic Content Linking in TIBCO WebFOCUS Designer With Auto Linking**

Auto Linking makes it easy to connect reports and charts in your development environment, expanding the reporting capabilities of your organization. Using Auto Linking, you can dynamically link multiple charts and reports with a single report or chart of any format, based on their common sort (BY) fields and parameters referenced in any filters. It is this commonality that dynamically links content in your WebFOCUS repository, allowing you to discover new possibilities in your data, and explore new relationships within your reporting enterprise. In addition, Auto Linking saves development time and effort, because drilldowns do not need to be manually created and maintained.
To use Auto Linking, you must use the AutoLink option in WebFOCUS Designer to set the reports or charts that provide Auto Linking drilldowns. In addition, you must also set reports or charts to be Auto Link targets. The options to enable and disable Auto Linking and Auto Link target functionality are available in the Content area, located beneath the buckets on the WebFOCUS Designer Properties panel.

Auto Linking and Auto Linking target status can only be enabled for stand-alone content items. If you convert a chart or report with Auto Linking to a page, a warning appears, alerting you that Auto Linking functionality will not be carried over.

**Note:** You can open an existing chart and enable Auto Linking or set the item as an Auto Link target.

When Auto Link functionality is activated, tooltips in your charts can display links in the tooltip for each sort (BY) field with qualifying target reports or charts at run time. In Auto Link enabled charts, you can add sort (BY) fields to the Vertical Axis, Horizontal Axis, or Color field containers. In Auto Link enabled reports, Auto Linking drill-down links are added to each sort value for which there are Auto Link targets available.

To qualify a chart as an Auto Link target, you must include filters that contain the parameters that you selected as the sort field or fields in Auto Linking enabled content. The parameter names defined in these filters must be the same as the sort (BY) field names in the Auto Link enabled chart. For example, if you Auto Linking enabled content uses Product Category as a sort field, then the Auto Linking targets that are available will be those that have parameters for the Product Category field. When you select a chart as the Auto Link target, it specifies that the parameter information should be cataloged, and will be evaluated when an Auto Link enabled chart is run.

For an Auto Link enabled chart or report at run time, the target reports and charts are those that have filters with parameters for all sort fields. For run time for charts, the linked sort field values in the Auto Link enabled content is passed to the Auto Link target report or chart and used as a filter value.

For example, you may have an Auto Link enabled chart that contains sort (BY) fields, Product Category and Model, with a measure (Sum) field, Revenue. To qualify as an Auto Link target, other charts in your repository can contain a single filter with a parameter for Product Category, or two filters with parameters for both Product Category and Model. When you run the Auto Link enabled chart, the Product Category field will link to target reports or charts that have a filter with a parameter for Product Category, and the Model field will link to target reports or charts that have filters for both Product Category and Model.
You can access the target reports or charts from a tooltip option that displays when you point your mouse over an area of the chart, such as a bar that represents Revenue by Product Category and by Model.

**Using Optional Parameters With Auto Linking to Enhance Drill-Down Results**

In addition to the basic Auto Linking functionality that is available in WebFOCUS Designer, you can also add optional parameters to your Auto Link charts, extending the capability of this feature. An Auto Link enabled chart can link to any target content that you are authorized to access that satisfies the sort (BY) field to the Auto Link target report filter parameter requirement. Auto Link target reports that satisfy this requirement and also have optional filter parameters for other fields are included in the Auto Link target report evaluation, so that all possible combinations of run-time parameters are evaluated and available as links as you run the request. This may produce additional reports or charts in your list of available Auto Link targets, offering you access to an expanded network of related content.

Setting a parameter to optional is not required because the Auto Link enabled content will pass the value for the fields being filtered to the Auto Link target report or chart. When a sort (BY) field value in an Auto Link enabled chart is selected, that value and the value of its parent sort fields are passed to the Auto Link target. When a measure value in a chart is selected, all sort (BY) field values for that measure are passed to the Auto Link target. If you select the Optional option, the Auto Link target report or chart can run on its own (from the Resources Tree or within InfoAssist) without being prompted by Autoprompt for a value for the parameter. This is because optional parameters are assigned a default value.

With Auto Linking, there is no limit to the number of charts and reports that are available from an Auto Linking drilldown, and Auto Linking enabled charts can also be an Auto Linking target, which contributes to the development of a cascading linkage of charts and allows you to drill through continuously through multiple charts and reports.

**Note:**

- The linked reports and charts displayed are limited to those that you are authorized to run or run deferred.

- The Auto Link enabled and Auto Link target options can be set individually, or both can be set on the same chart if that item meets the Auto Linking requirements.

- Consideration should be given to how many reports or charts are indicated as Auto Link targets, as the run-time Multi-drill menu for the qualifying target reports or charts may become long in length. In these cases, some browsers may display a script processing warning message.
Auto Linking utilizes the Multi-drill feature with cascading menus, except when running an HTML report with On-demand Paging enabled or a chart request that is a legacy graph format (PFJ-based formats, such as PNG and non-bucket HTML5), which will display a single-level list in the order the drilldowns are specified in the request.

The Multi-drill cascading menu displays:

- Horizontal lines to separate user-specified drilldowns and Auto Link navigation options.
- Auto Link target reports in a single-level list that is sorted alphabetically, first by folder, and then the Auto Link target reports and charts within the folder. This may differ from the sort order of the resource tree that also applies the Properties Sort order option when sorting folders and items within folders.

When drilling down through a list of Auto Link target reports and charts, a previously selected Auto Link target report or chart will be excluded so that the available Auto Link targets are reports and charts that you have not yet viewed.

**Procedure:** How to Set an Existing Report or Chart as Auto Link Enabled

1. On the WebFOCUS Hub or the WebFOCUS Home Page, click the Workspaces tab, and navigate to a chart or report for which you want to enable Auto Linking.
2. In the content area, right-click the chart that you want to set as Auto Link enabled, and then click **Edit**.
   
   WebFOCUS Designer opens in the relevant mode.
3. Verify that there is a sort (BY) field in the report or chart.

   - For charts, sort fields are added to the Vertical, Horizontal, or Color buckets.
   - In a report, sort fields are added to the Rows bucket.
4. On the Properties panel, on the Settings tab, expand **Content**, and then select **AutoLink**.
5. Save the report or chart.

   Your existing chart or report is now Auto Link enabled.

**Procedure:** How to Set an Existing Chart as an Auto Link Target

1. On the WebFOCUS Hub or the WebFOCUS Home Page, click the Workspaces tab, and navigate to a chart that you want to link to as an Auto Link target.
2. In the content area, right-click the chart that you want to set as an Auto Link target, and then click **Edit**.

   WebFOCUS Designer opens in the relevant mode.
3. On the Properties panel, on the Settings tab, expand Content, and then select AutoLink target.

**Note:** Selecting AutoLink target specifies that the parameter information for this chart will be stored, adding it to the repository of reports and charts that will be evaluated when an Auto Link enabled chart is run.

4. Verify if the report or chart has an existing filter, as qualifying target reports are those that have filters with parameters for the sort (BY) fields in Auto Link enabled reports or charts. If a filter does not exist, add a filter prompted filter to the target report or chart.
   a. From the Data pane, drag a sort (BY) field onto the Filter toolbar. You do not need to select a value.
      
      **Note:** When creating a parameter for a field, the parameter name defaults to the name of the field that you select. For example, if you create a filter for the Product Category field by dragging it to the Filter toolbar, the name of the resulting parameter is &PRODUCT_CATEGORY, reflecting the field name PRODUCTCATEGORY. You can see the field name in the tooltip when you point to a field on the Fields pane.

5. Save the chart.

Your existing chart is now set as an Auto Link target.

**Procedure:** How to Create a New Auto Link Enabled Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.
   
   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.
   
   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Settings tab of the Properties panel, expand the Content area, and then select AutoLink.

4. Add fields to the report or chart, ensuring that one is a sort (BY) field.
   
   - For charts, sort fields are added to the Vertical, Horizontal, or Color field containers depending on the chart type.
   - For reports, sort fields are added to the Rows bucket.

5. Save the chart.

Your chart is now set as Auto Link enabled.
Procedure: How to Create a New Auto Link Target Chart

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. On the Settings tab of the Properties panel, expand the Content area, and then select AutoLink target.

   **Note:** Selecting AutoLink target specifies that the parameter information for this chart will be stored, adding it to the repository of reports and charts that will be evaluated when an Auto Link enabled chart is run.

4. Add fields to the chart or report.

5. Add a prompted filter.

   From the Data pane, drag a sort (BY) field onto the Filter toolbar.

   **Note:** When creating a parameter for a field, the parameter name defaults to the name of the field that you select. For example, if you create a filter for the Product Category field by dragging it to the Filter toolbar, the name of the resulting parameter is &PRODUCT_CATEGORY, reflecting the field name PRODUCT_CATEGORY. You can see the field name in the tooltip when you point to a field on the Fields pane.

6. Save the chart or report.

   Your content is now available as an Auto Link target.

Running an Auto Link Enabled Chart

Auto Linking is supported from any WebFOCUS repository content, wherever it is run online.

Example: Launching an Auto Link Enabled Report

From the WebFOCUS Hub or the WebFOCUS Home Page, right-click a report that is Auto Link enabled, and then click Run.
Example: Using Hyperlinks to Link to Other Reports or Charts

Use the hyperlinks to link to other reports and charts, based on the following information:

- **Charts.** Displays with aspects over which you can hover (for example, a bar) in the chart. A tooltip displays with the Auto Link target reports and charts, as shown in the following image.
Reports. Values pointing to Auto Link targets display as clickable links. When you click a link, a menu appears, allowing you to select a target to open, as shown in the following image.

Adding Drill-Down Links to Content

Drilldowns are a powerful feature that allows users to navigate from one content item to another, providing access to additional, related information at run-time. Drill-down links can also be used to pass parameters, so that the target content is automatically filtered for the value that a user selects, allowing you to maintain context between items. By linking content with drilldowns, you can vastly expand the amount of information that is available from a single chart or report.

In a report, drill-down links are provided as hyperlinked values. In a chart, drill-down links are executed when you click a section of the chart. When you add multiple drill-down links to a single field, you can select one from the tooltip menu that results when you click a report hyperlink or point to an area of a chart.

You can create different types of drill-down links to connect to different types of target items. You can use the link to open a selected content item or page, connect to a URL, or execute a JavaScript function.
To create drill-down links for a field, right-click a field in any bucket of a report, or in the default measure bucket of most chart types, and click **Configure drill downs**. The Configure Drill Downs dialog box opens, as shown in the following image.

To create a drilldown, click the plus icon. Next, determine the type of content that you want to link to. The information that you provide to create the drilldown differs depending on the target type.

Select **Content/Page** to link to another procedure, such as a chart or report, or to a page. Select the item from your WebFOCUS repository, and choose where it should load. You can load the target content in a new window or browser tab, the same window as the current item, or you can specify a window or frame by name.

**Note:** Drill-down links are functional at design time. When the drill-down target location is Current Window, clicking a drill-down link in the canvas opens the target in a new browser tab or window so that WebFOCUS Designer can stay open. When you run your content, drilldowns with a target location of Current Window load in the window where the drilldown was accessed.

You can also configure the drilldown to pass parameter values to the target item. If the target uses dynamic parameters, such as prompted filters, matching parameters with the same name are automatically created to pass the value that a user clicks. The selected value will be applied to the target content when it loads.
To manually add parameters to pass through the drilldown, click the plus sign in the Parameters section of the Configure Drill Downs dialog box. First, provide a parameter name, which should match the names of amper variables in the target content. Using the menu in the Type column, set whether the parameter should pass field values, a static value that you set, or the value set for a global variable in your environment. Finally, select a field, enter a value, or select a global variable to pass. You can automatically create all parameters in the target content by clicking Add all target filters, or create parameters for all sort fields in your parent content – that is, the chart or report that you are currently editing – by clicking Add all group fields. You can then delete individual parameters if you want, or delete all parameters by clicking Clear List. Drill-down parameter options are shown in the following image.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Type</th>
<th>Field/Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTRY_NAME</td>
<td>Field</td>
<td>WF_RETAIL_LITE.WF_RETAIL_GEOX</td>
</tr>
<tr>
<td>TIME_DATE_FROM</td>
<td>Global variable</td>
<td>CURRDATE</td>
</tr>
<tr>
<td>TIME_DATE_TO</td>
<td>Global variable</td>
<td>CURRDATE</td>
</tr>
<tr>
<td>PRODUCT_CATEGORY</td>
<td>Value</td>
<td>Accessories</td>
</tr>
</tbody>
</table>

To link to a web page through a URL, select the URL radio button. The URL must include the protocol, for example, http or https, if it is an external link. Otherwise, the URL will be interpreted as a partial URL within your WebFOCUS environment.

Next choose where the target URL should load, whether in a new window, the same window, or elsewhere. Finally, add any parameters. If you add parameters, they are appended sequentially to the end of the URL as key-value pairs using a GET request in the following format:

```
?parameter_name1=value1[&parameter_name2=value2 ... &parameter_namen=valuen]
```

where:

- `parameter_name1, parameter_name2, parameter_namen`
  - Are parameter name values, specified in the Parameter Name column of the Configure Drill Downs dialog box.
- `value1, value2, valuen`
  - Are parameter values. They can be field values passed from the report, or static values. The field or static value is specified in the Field/Value column of the Configure Drill Downs dialog box.
The question mark (?), ampersands (&), and equals signs (=) are added to the URL automatically, so you do not need to include them when setting up the drilldown.

To execute a JavaScript function from the drill-down link, select the JavaScript radio button. In the JavaScript Function text box, supply the name of the JavaScript function. The function and the arguments that it accepts must already be defined for the function to work. You can define custom JavaScript functions in a .js file on your environment, which you can create using the text editor or upload from your machine, then reference that file using the SET JSURLS command. This command can be applied globally by adding it to edasprof.prf on the WebFOCUS Reporting Server, so the functions in the file are always available to whoever has access. Alternatively, you can add the SET JSURLS command to the Preprocessing Other component of a Reporting Object, then use it as the data source for your content.

In the Request Parameters area, add each argument, in order, as a separate row. These arguments can be static values, by setting the Type column to Value, or dynamic field values, by setting the Type column to Field. Once the type is set, enter the value or select the field whose value should be used as the argument.

You can manage your drilldowns from the pane at the left side of the Configure Drill Downs dialog box. You can create multiple drilldowns that you can access from the same hyperlink in a report or the same area of a chart. To create more drill-down links that you can select from the same location, click the plus sign above the list of drilldowns in the Configure Drill Downs dialog box, as shown in the following image.

When you click a link in a report or an area of a chart that includes multiple drilldowns, a menu appears, listing them all.

Note: The menu for multiple drilldown links on a single field does not display if a report is created as part of a page. They display properly for charts, stand-alone reports, and reports added to a page as external content.

To rename a drilldown link, double-click the title in the drilldown list, and type a new title. These titles appear in the tooltip in your content when selecting a drilldown to execute. Drag a drilldown using the handles to the left of the drill-down title to change the order in which your drilldowns appear.
If you want to remove a drilldown, click the X next to its name. To remove all drilldowns, click Remove All Drill Items.

**Procedure:** How to Pass Parameter Values to a Page

You can drill down from a chart or report to a page created in WebFOCUS Designer. Drill-down parameters can be passed to the page to apply their values to any page filters.

1. Create and save a page that includes prompted filters. These filters can be created by adding parameterized external content to an assembled page and clicking Add all filters to page on the Filters tab of the sidebar, or can be created in a page with new content by dragging a field to the Filter toolbar.

   The filters in this page will be populated with values passed from a drill-down report.

   For information on creating a page, see Creating Pages on page 784.

2. Create a new report.

   On the WebFOCUS Hub or the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens.

3. Select the same data source that was used to filter the page, and click Select.

   The WebFOCUS Designer canvas appears.

4. Create a chart or report that is sorted by the same fields that are used as filters in the page. For example, if the page is filtered by Customer Business Region and Sale Year, create a report with those fields in the row bucket. Add other measures and dimensions to your content based on your needs and preferences.

5. Determine the measure field in a chart, or any field in a report, to which to add drill-down links.

   If you are passing multiple parameter values through the drilldown, selecting a field in the chart or report with additional sort values under it may help clarify to the user which values will be passed.
For example, in the report shown in the following image, the Sale Year field is the secondary sort field while Customer Business Region is the primary sort field, so each row in the Sale Year column represents a sale year and a business region.

<table>
<thead>
<tr>
<th>Customer Business Region</th>
<th>Sale Year</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>2014</td>
<td>115,367</td>
<td>$32,608,030.34</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>132,574</td>
<td>$39,630,841.14</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>193,158</td>
<td>$57,591,488.69</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>255,468</td>
<td>$76,647,406.85</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>464,797</td>
<td>$140,440,022.62</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>699,498</td>
<td>$215,398,344.26</td>
</tr>
<tr>
<td>North America</td>
<td>2014</td>
<td>46,386</td>
<td>$13,060,621.95</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>61,246</td>
<td>$18,287,269.34</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>92,483</td>
<td>$27,473,407.52</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>147,038</td>
<td>$43,907,888.55</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>426,176</td>
<td>$128,662,736.78</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>694,386</td>
<td>$212,755,358.69</td>
</tr>
<tr>
<td>Oceania</td>
<td>2015</td>
<td>56</td>
<td>$14,736.30</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>165</td>
<td>$48,743.31</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>374</td>
<td>$104,323.54</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>1,321</td>
<td>$424,709.91</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>6,481</td>
<td>$1,970,040.66</td>
</tr>
</tbody>
</table>

In this case, adding the drill-down links to the Sale Year column would allow you to choose from all of the available Customer Business Region and Sale Year values, whereas adding the links to the Customer Business Region column would only allow you to pass parameter values for the first sale year in each business region group. As an alternative to creating drilldowns on the lower level sort field, you could ensure that all parameter values are passed from a report by using repeating sort values. On the Content picker, select the Grid report layout option.

6. Right-click the field to which you want to add drill-down links and click Configure drill downs.

The Configure Drill Downs dialog box opens.
7. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

The Content/Page drilldown type, which we are using to drill to a page, is selected by default.

8. In the Content/Page Path text box, click the file icon to select the page that you want to drill to.

Notice that the Parameters grid is automatically filled based on the filters in the selected page.

9. In the Load In area, select the location where the target page should run. It can be the same window where the report was run, in a new browser tab, or a user-specified location.

10. In the Parameters section, check whether the parameters that you want to pass have already been added. To add a new parameter, click the plus icon, and proceed with the following steps.

   a. In the Parameter Name column, type the name of the parameter. Typically, this matches the field name. You can check the parameter names used in an assembled page by clicking the Info button.

   b. From the Type menu, choose whether the value to pass should be a field value, associated with the link that a user selects, the value of a global variable defined in your environment, or a constant value.

   c. If you selected Field, use the Value menu to select a field from your content. If you selected Constant, type a constant value to pass to the page.

11. Repeat step 11 for all parameters whose values you want to pass to the target page, or click the X in the right-most column of the Parameters grid to remove unneeded parameters.

12. Double-click the default drill-down name, for example, Drill Item 1, to change the name of the drilldown. This name appears in the tooltip when you point to a drill-down link, or click a link that includes multiple drilldowns.

13. Click Apply to create the drilldowns.

   In a report, drill-down links are added for each value of the field where the drilldown was created. In a chart, drilldowns are added to each section.

14. Run the chart or report.

15. At run-time, drill down to the target page.

   - If you created a chart, click a section of the chart. If there are multiple drilldowns, select the drilldown that you just created.

   - If you created a report, click a drill-down link. If that field of the report has multiple drilldowns associated with it, select the drilldown that you just created.
The page opens in a new browser tab or window. Notice that the value or values represented by your selection in the parent content item are applied as filter values in the page.

**Procedure:** How to Pass a Global Variable Value Through a Drilldown

A global variable is a variable that maintains its value for the duration of a WebFOCUS session or until a different value is assigned. Global variables are identified by double ampersands. As opposed to local amper variables, which you can pass different values through a drilldown to filter target content based on the value that you select, the best use for global variables is to maintain a single consistent value as you run different content items. In this example, we will set a global variable to the current date, allowing us to filter target content for that date value by invoking the global variable.

The advantage of using a global variable is that its value is not contingent on the content item that is passing it. A local variable, when passed through a drilldown, must be set in the parent procedure, so a field must be added that contains values that the local variables can pass. This is not the case for a global variable, which is set externally to the procedure. However, since the global variable is not set by the procedure that passes it, the drill-down value that you select will not affect the value that is passed, unless the global variable is set to be dependent on a local variable.

The drill-down parameter options in WebFOCUS Designer provide a list of global variables that are already defined in your environment, so the first step is to set the global variable value. Next, you can create target content filtered by a field that can accept that value, and finally you can create the drill-down content that will pass the global variable to the target.

1. On the WebFOCUS Hub or the WebFOCUS Home Page, click Workspaces to open the Workspaces area.

2. In the +Content menu, point to Other, and then click Text Editor.


3. Click FOCEXEC (fex) to create a new WebFOCUS procedure using the text editor.

   This procedure will set a value for a new global variable.

   The text editor opens.

4. In the text editor, type the following:

   ```
   -SET &&CURRDATE = &YYMD;
   -TYPE &&CURRDATE
   ```
The first line sets the value of a new global variable, &CURRDATE, to today's date, represented by &YYMD. &YYMD is a system variable that always returns the current date in a YYMD (year-month-day) format. You can change CURRDATE to whatever you want, since it is just the name of the global variable that you are creating.

The second line displays the value of the global variable, &CURRDATE in this example, as text in the output using the -TYPE command, so you can make sure that it has been set properly.

Click Preview on the text editor toolbar. A new window opens with a message showing the result of the executed procedure. There is no actual output, but it should show the current date in YYMD format under the Detail area.

The global variable is now set for the duration of the WebFOCUS session. To ensure that the variable is always set when a user signs in, an administrator can set this procedure to run automatically using a setting in the WebFOCUS Administration Console. To configure this setting, complete the following steps:

1. Save the procedure that sets the global variable and return to the WebFOCUS Hub or Home Page.
2. In the Workspaces area, navigate to the location where you saved the procedure. Right-click it and click Properties.
3. Copy the value of the Path property, which is the IBFS path of the procedure that sets the global variable value in your environment.
4. On the WebFOCUS Hub, click the Management Center and then click Administration Console. Alternatively, on the WebFOCUS Home Page banner, open the Settings menu and then click Administration Console.

The WebFOCUS Administration Console opens.
5. In the navigation pane on the Configuration page of the Administration Console, click Other.
6. Paste the path of the procedure that sets the global variable value into the Paths to be executed on user Sign-in field.
7. Click Save.

When a message appears indicating that the new setting has been saved successfully, click OK and close the Administration Console.

5. Create a content item that will be the target of a drilldown that passes the global variable. We will create this item first since we need to be able to select a target item when we create the drilldown.

In this case, since the global variable that we have created is set to a date value, we will want to create target content that is filtered by a date field.
Create a new chart or report.

WebFOCUS Designer opens, and you are prompted to select a data source.

6. Navigate to and select a data source that includes a date field with data for the current date, and then click Select.

The WebFOCUS Designer canvas displays.

7. From the field list, drag a date field to the Filter toolbar to create a dynamic parameter filter. You do not need to select values for this filter control, since they will be supplied by the global variable.

The date control in WebFOCUS Designer provides a date range, so when we pass the global variable to the filter parameter, we will pass it as both the start and end date to filter our content to show data for just the current date.

8. Add fields to your content, and, optionally, change the content type and add more parameter filters. You can also add more content items to create a page by clicking Convert to page, and then dragging a field or container onto the page. All items on this page are affected by the filter controls on the Filter toolbar. You can use drilldowns to pass local parameter values to these filters alongside the global variable value that we will pass.

When you are finished creating the target content, click Save.

9. Create a new chart or report that will include drill-down links that pass the global variable that we configured to our target item.

On the WebFOCUS Hub, click the plus menu and then click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens, and you are prompted to select a data source. If you added any filters in addition to the one that will receive the global variable value, you should use the same data source as your target item.

10. Change the content type and add fields to create a content item to which you will add your drilldowns. If you added any filters to the target item in addition to the one that will receive the global variable, you should make sure that the fields used for those filters are added to this content item.

11. Right-click a dimension field in a report or a measure field in chart and click Configure drill downs.

The Configure Drill Downs dialog box opens.

12. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

The Content/Page drilldown type, which we are using to drill to the target content item, is selected by default.
13. In the Content/Page Path text box, click the file icon to select the item that you want to drill to.

Notice that the Parameters grid is automatically filled based on the filters in the selected page.

14. In the Load In area, select the location where the target page should run. It can be the same window where the report was run, in a new browser tab, or a user-specified location.

15. In the Parameters section, check whether the parameters that you want to pass have already been added. Parameters for start and end dates for a date range filter should appear automatically since the filter was created in the target item.

For both of these parameters, complete the following steps:

a. From the Type menu, select Global variable.

A drop-down menu appears in the Field/Value column.

b. In the Field-Value column, select the global variable that you defined earlier.

16. Repeat these steps for the second date parameter. Filters for date fields create ranges with a start and end date, by default. By setting these to the same date limits the date range to a single day.

17. Set values for any other parameters in the target report by specifying the field whose value should be passed based on the value that you select to execute the drilldown, or a static value that you always want to pass.

18. Click Apply to create the drilldowns.

19. On the Visualization toolbar, click Run in new window to run your content and test the drilldowns.

20. Execute a drilldown. It should run the target content, which should be filtered for the current date as specified by the global variable that was passed.

21. If everything works as expected, return to WebFOCUS Designer and save your content.

**Procedure:** How to Drill to a Webpage From a Selected Value

When you pass parameters using a URL drilldown, they are sent using GET requests. You can use this functionality to access different web pages based on the value that you select from your content.

In this example, we will use a URL drilldown to open a Wikipedia article for the country that we select.

1. In WebFOCUS Designer, create a chart or report using a field with country names as a sort field.

2. In a chart, right-click a measure field or, in a report, right-click the field to which you want to add drill-down links, and then click Configure drill downs.
The Configure Drill Downs dialog box opens.

3. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

4. Change the Type of the drilldown to URL.

5. In the URL text box, type the root URL to which the GET request will be added. For this example, type https://en.wikipedia.org/w/index.php.

A question mark, followed by the parameter name and value, will be appended to this URL.

6. Optionally, change the target location of the URL from Current Window, which opens the target URL in the same window or tab as the drill-down chart or report, to New Window, which opens the target URL in a new tab or window, or Window/Frame, which opens the URL in a user specified container.

7. Add a new parameter to the drilldown.
   a. Click the plus sign icon under Parameters to add a new parameter.
   b. In the Parameter Name column, type the name of the parameter. The URL that we are using in this example accepts a parameter called title, which is the name of the Wikipedia article to open.
   c. Leave the Type column set to Field. We want to pass dynamic field values through the URL drilldown so that the value that we click is reflected in the article that opens on click.
   d. Select the field whose value you want to pass. For this example, select the country field that you added to your chart or report.

8. Optionally, in the pane on the left, double-click the default drill-down name, for example, Drill Item 1, and type a new name for your drilldown. This name appears in the tooltip when you point to a drilldown link in a report, or when there are multiple drilldowns on a single field.

9. Click Apply to create the drilldown.

10. Click Run in new window to view your content at run time.

11. Click a hyperlink in a report or a section of a chart. The Wikipedia article opens for the value that you clicked.

Procedure: How to Execute a JavaScript Function From a Drilldown

You can trigger a JavaScript function when using a drilldown in your content. The parameters defined when setting up the drilldown are used as the arguments in the JavaScript function. This simple example uses the alert function, which requires no special setup or configuration, to display the dimension field value that a user clicks.

1. In WebFOCUS Designer, create a new chart or report and add at least one measure field and one dimension field.
2. In a chart, right-click a field in the default measure bucket, or in a report, right-click the field to which you want to add drill-down links, and click Configure drill downs.

The Configure Drill Downs dialog box opens.

3. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

4. Change the Type of the drilldown to JavaScript.

5. In the JavaScript Function text box, type alert, which is the name of the function used in this example. It opens a pop-up window displaying the value of the first argument as text.

6. Add a new parameter to the drilldown.
   a. Click the plus sign icon under Parameters to add a new parameter.
   b. To display a field value in the alert message, leave the Type column set to Field. Change the Type to Value to always display the same value in the alert.
   c. Select the field whose value you want to pass. It can be a measure field or a dimension field.

7. Optionally, in the pane on the left, double-click the default drill-down name, for example, Drill Item 1, and type a new name for your drilldown. This name appears in the tooltip when you point to a drilldown link in a report, or when there are multiple drilldowns on a single field.

8. Click Apply to create the drilldown.

9. Click Run in new window to run your chart or report.

   Your content runs in a new browser tab or window.
10. Click a hyperlink in a report or a section of a chart. An alert appears, displaying the value that you selected, as shown in the following image.

![Image of alert with email and sale year information]

**Procedure:** How to Execute a Custom JavaScript Function From a Drilldown

With some additional configuration, you can execute a custom JavaScript function from a drilldown link. This provides significant flexibility in defining what occurs when a drill-down link is clicked. In this example, we have created a JavaScript function that opens a mailto URL, dynamically populated with an email address and first name from our data source. The first name will be added to the subject line of the email. Since the email address in a mailto URL is not supplied as a key-value pair, we cannot do this using a URL drilldown.

1. First, define the custom JavaScript function using the text editor.
   a. On the WebFOCUS Hub or the WebFOCUS Home Page, click Workspaces.
   b. In the +Content menu, point to Other, then click Text Editor. The New Text Resource dialog box opens.
   c. On the Web tab, click JavaScript (Js).
      The text editor opens.
   d. Enter the code for your JavaScript function.
      In this example, the function to generate a mailto URL is called fnMail, and is coded as follows:

```javascript
function fnMail(Email, Name)
{
window.location = 'mailto:' + Email + '?Subject=Hello, ' + Name;
}
```
The two parameters that we will need to supply from the drilldown will be the email address, for the Email argument, and the first name, for the Name argument.

e. Save the new JavaScript file to your WebFOCUS Repository.

2. Create a new report using WebFOCUS Designer.

3. In WebFOCUS Designer, select a data source that includes email address and first name fields.

   In this example, we are using the wf_retail_lite.mas Master File, part of a sample dataset that can be added to your TIBCO WebFOCUS environment.

4. On the Content picker, change the content type to a report layout, either the Standard Report or Grid options.

5. Optionally, add filters to reduce the size of the report and the processing time that it requires.

6. Add the email address and first name fields to your report.

   If you are using the wf_retail_lite Master File as your data source, in the Dimensions area, expand Customer and then Full,Name, then double-click Email,Address and First,Name.

7. Add one or more measure fields to the report.

8. Right-click a field, for example, the email address field, in one of the buckets, and click Configure drill downs

   The Configure Drill Downs dialog box opens.

9. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

10. Change the Type of the drilldown to JavaScript.

11. In the JavaScript Function text box, type fnMail, which is the name that we gave to the function used in this example.

12. Add the first parameter, which supplies an email address, to the drilldown.

    a. Click the plus sign icon under Parameters to add a new parameter.

    b. Leave the Type column set to Field. The recipient of the email from the mailto URL should change depending on the value that we click in the report.

    c. Select the field whose value you want to pass. In this case, it is the email address field.

13. Add the second parameter, which supplies an associated first name, to the drilldown.

    a. Click the plus sign icon under Parameters to add a new parameter.

    b. Leave the Type column set to Field. The first name shown in the subject of the email from the mailto URL should change depending on the value that we click in the report.
c. Select the field whose value you want to pass. In this case, it is the first name field.

14. Optionally, in the pane on the left, double-click the default drill-down name, for example, *Drill Item 1*, and type a new name for your drilldown. This name appears in the tooltip when you point to a drilldown link in a report, or when there are multiple drilldowns on a single field.

15. Click *Apply* to create the drilldown.

16. Save the report and exit WebFOCUS Designer.

17. Finally, we must tell our report request where the custom JavaScript function is defined. We can use the SET JSURLS command to specify the location of the .js file that we created earlier. This command can be added to the edasprof server profile so that it is available to all procedures. This step must be performed by someone with administrative privileges on the WebFOCUS Reporting Server.

**Note:** As an alternative, you can add the SET JSURLS command to the Preprocessing Other component of a Reporting Object, then use it as the data source for your content.

On the WebFOCUS Hub, click *Management Center* and then click *Server Workspaces*.

Or, on the WebFOCUS Home Page, open the plus menu and click *Prepare and Manage Data*.

In the WebFOCUS Reporting Server browser interface, open the *Tools* menu and click *Workspace*.

The Server Workspace view opens.

18. On the resource tree, expand *Configuration Files*, then right-click *Server Profile - edasprof.prf* and click *Edit*.

19. On a new line, type `SET JSURLS=`

20. After the equals sign (=), in quotes, add the run-time URL for the .js file in which the function is defined, then close with a semicolon (;).

The run-time URL uses the following format:

```
http[s]://hostname:port/context_root/run/path_to_item
```

where:

- **hostname**
  
  Is the name of the system where WebFOCUS is installed.

- **port**
  
  Is the port number used by WebFOCUS.
context_root

Is the context root used for your WebFOCUS application. For example, ibi_apps.

path_to_item

Is the IBFS path of the JavaScript file in your WebFOCUS repository. You can find the path of a page by right-clicking it on the WebFOCUS Home Page and clicking Properties. The file path is listed as the Path property.

Slashes (/) between folder names should be retained literally instead of encoded in the URL, and the colon (:) should be removed after IBFS. For example:

http://localhost:8080/ibi_apps/run/IBFS/WFC/Repository/My_Workspace/~user/custom.js

The full SET JSURL command may resemble the following:

```
SET JSURLS='http://localhost:8080/ibi_apps/run/IBFS/WFC/Repository/My_Workspace/~user/custom.js';
```

21. Save your changes to edasprof.prf

22. Return to the Hub or Home Page and run your report, then click a drill-down link.

A new email opens with the To address and Subject line already filled, with different values depending on the link that you click.

Using a JavaScript Drilldown to Run a Chart or Report in a Target Panel on a Page

You can use a specific, pre-configured JavaScript function called portalDispatch to drill to a target chart or report, and run it an a specified target container on a page. This target container can be identified by a CSS class, which you can set using the Classes property for the content area within a container. The target container can be a basic panel container with a single content item, or a multi-content container, such as a tab, accordion, or carousel container, that contains multiple items. If the content area that contains the target item is part of a multi-content container, then it becomes visible immediately when the drilldown is executed. For more information on setting and using CSS classes, see Styling Pages With Custom CSS on page 810. The target chart or report, which you evoke to run in the target container, is referenced using the IBFS path, which you can find in the Path field when viewing the properties of an item on the Hub or Home Page. You can pass multiple items to multiple containers listed in sequence, and you can also pass the values of multiple fields from a single drill-down link to multiple parameters in the target item or items.
You can create the drill-down content and your page in three general steps. First, create one or more target charts or reports that you want to run when a drill-down link is clicked. You can add dynamic parameter filters to these items so that they are filtered based on the selected drill-down link. Next, create a chart or report with a drilldown that executes a JavaScript function called portalDispatch. The function arguments determine what items are run, and where they should run. Finally, assemble a page that contains the drill-down content and containers in which the target content can run. You must also ensure that the portalDispatch JavaScript function is recognized, by specifying the location of the .js file that contains it on the WebFOCUS Reporting Server.

Procedure: How to Create the Drill-Down Target Content

First, create one or more target charts or reports using WebFOCUS Designer.

In order to receive parameter values from your drilldown, the target content must have single select filters. Filters created in InfoAssist are single select by default, while those created in WebFOCUS Designer are multi-select by default, meaning that you must set them to accept a single filter value for them to accept passed parameter values.

1. On the WebFOCUS Hub or WebFOCUS Home Page, click Visualize Data.
   WebFOCUS Designer opens, where you are prompted to select a data source.
2. Select the data source that you want to use. You should use the same data source for the target content and the parent content containing the drill-down links.
3. Create your target content by adding fields to the appropriate field containers, and applying your preferred customizations and styling options.
4. Add prompted filters to your content, allowing it to be filtered based on the selected drill-down link. The field or fields used to filter the target content should be used as sort fields in the parent content that contains the drilldowns.
   Drag a field from the Data pane to the Filter toolbar. Optionally, select default values for your filters.
   Repeat these steps to allow the target content to accept multiple parameters from a drill-down link.
5. Make all of the prompted filters in your target content single select. Right-click each alphanumeric filter prompt and click Single.
6. Save the target chart or report.
7. Repeat steps 1 through 6 to create multiple target charts and reports. The portalDispatch function can invoke and pass parameters to multiple charts and reports at once.
Procedure: How to Create Content With JavaScript Drill-Down Links

Create the chart or report that will contain the drill-down links that run the target item or items that you created in the previous set of steps.

1. On the WebFOCUS Hub, open the plus menu and click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

   WebFOCUS Designer opens, prompting you to select a data source.

2. Select the data source that you want to use. This should be the same data source that you used for the target content in the How to Create the Drill-Down Target Content procedure.

3. Create the drill-down parent content, which can be either a chart or report, by adding measure and dimension fields to the appropriate buckets.

   The dimension fields that are used as dynamic parameter filters in the target content should be used as sort fields in the parent content.

4. Add drill-down links to your content. If you are creating a report, right-click a sort field, and if you are creating a chart, right-click a measure field. From the shortcut menu, click Configure drill downs.

   The Configure Drill Downs dialog box opens.

5. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on the left.

6. Select the JavaScript radio button to create a drill-down link that executes a JavaScript function.

7. In the JavaScript Function text box, type portalDispatch. This is a pre-existing function that has already been defined in a file in the default WebFOCUS installation.

   Note: If the filter in the item that is the target of your drilldown is multi-select, use multiselect_portalDispatch instead of portalDispatch. Parameter values are passed differently to multi-select and single-select filters, so you must use the drill-down JavaScript function that is compatible with the type of filter that you are using.

8. In the Request Parameters, click the plus button (+) to provide values of arguments in the JavaScript function. Each one occupies its own line in the parameter table. You will add at least 6 parameters, with extra parameter-field pairs if you want to pass multiple parameter values to the filters you set up in the target content.

   Specify the following parameter values in the JavaScript drilldown:

   a. Add a new parameter and change the Type to Value using the drop-down menu in the Type column. In the Field/Value column, type drillRefresh.
b. Click the plus button again to add another new parameter. Change the Type to Value and type self in the Field/Value column. Alternatively, if you do not want multi-content containers to immediately switch to display a specific target item, you can use self | _NO_FOCUS as the second argument. When using self for this argument, multi-content containers switch to show the last specified target item.

c. Add another new parameter. Change the Type to Value, and type the name of a CSS class that will identify the content area of the panel in which the drill-down target content will run.

For example, if you type panel1 in the Field/Value column when configuring the drill-down parameters, you will need to add panel1 to the Classes property of the content area of the container in the page where the drill-down content will run.

You can run multiple content items to multiple containers from the same drill-down link, in which case the class names should be separated by spaces. For example, panel1 panel2.

If you want to pass the same drill-down parameters to all panels on the page, use the _ALL argument and skip the next sub-step.

d. Add another new parameter. Change the Type to Value, and type or paste the IBFS path of the target content that you created in the How to Create the Drill-Down Target Content procedure.

To find the IBFS path of an item, right-click it on the Hub or Home Page and click Properties. The IBFS path of the item is listed in the Path field. You can copy it to paste into the Field/Value column when configuring the parameter for the target content.

If you want to run multiple content items, separate them with spaces. The order of the paths should be coordinated with the order of the container classes specified in step 8c. The first listed target item runs in the container with the first specified class, the second listed item runs in the container with the second specified class, and so on.

This value is not necessary if the procedure that you want to refresh is present on the page in the container content area with the class specified in step 8c. If this is the case, you may omit this argument of the drilldown and proceed to step 8e.

e. Add another new parameter. Change the Type to Value, and, in the Field/Value column, type the name of the parameter used to filter the target content. By default, this is the name of the field.

f. Add another new parameter. Leave the Type as Field, and, in the Field/Value column, select the field associated with the parameter name provided in step 8e.

g. If the target content has multiple dynamic parameter filters, repeat steps 8e and 8f to supply the other parameters as name-field pairs.
h. Once you have added all parameters to the drilldown, your drill-down configuration may resemble the one shown in the following image.

![Drilldown Configuration](image)

i. Click Apply to generate the drill-down links in your chart or report.

Your content now executes the portalDispatch JavaScript function when you click a value that includes drilldowns.

Next, create a page with containers where the target content will be run.

**Procedure:** How to Create a Page to Run the Drill-Down Target Content

Create a page to which you will add the content containing the drill-down links that you just created, and enough additional panels to run the content items that you set to run when a drilldown is executed. These panels will be identified by the classes set in step 8c of the previous procedure.
Before executing the drilldowns, you must also specify the path to the file containing the JavaScript function in the edasprof.prf server profile.

1. On the Hub or Home Page, click the plus button and then click Assemble Visualizations.

2. You are first prompted to select a page template. You can select one of the preset options, or select Blank to add your own containers to the page.

   The WebFOCUS Designer canvas opens.

3. Assemble the page where the target content created in the How to Create the Drill-Down Target Content procedure will loads when you click a drill-down link in the item created in the How to Create Content with JavaScript Drill-Down Links procedure.

   a. With the Content tab selected on the sidebar, navigate to the item that you created in How to Create Content with JavaScript Drill-Down Links, and drag it into a container or an empty area of the page.

      The item with the drilldowns displays on the page. Resize it as needed.

   b. Add a container for each drill-down target item created in How to Create the Drill-Down Target Content. The container can be empty, or contain an item that will be replaced with the drill-down target item. If you selected a page template, there may be containers available already. Note that you can have these items run in separate tabs, accordion panels, or slides of multi-content container.

   c. Select the content area of a target container by clicking inside it. On the Settings tab, in the Classes text box, type the name of the first class that you defined in step 8c of How to Create Content with JavaScript Drill-Down Links.

      If the content area that you select is part of a tab, accordion, or carousel container, when you execute the drilldown, the container immediately updates to display the target item. Alternatively, if you do not want to change the displayed items, you can use the self | _NO_FOCUS as the second argument.

      Repeat this step for any additional containers in which you want to run other content items, specified in step 8d of How to Create Content with JavaScript Drill-Down Links, using the class names defined in step 8c of that procedure.

4. Now that the content has been added and the containers have their classes set, save the page.

5. Finally, we must tell our report request where the custom JavaScript function is defined. We can use the SET JSURLS command to specify the location of the .js file in the WebFOCUS installation that includes the portalDispatch function. The SET JSURLS command can be added to the edasprof server profile to make it available to all procedures. This step must be performed by someone with administrative privileges on the WebFOCUS Reporting Server.
**Note:** As an alternative, you can add the SET JSURLS command to the Preprocessing Other component of a Reporting Object, then use it as the data source for your content.

a. On the WebFOCUS Hub, click *Management Center* and then click *Server Workspaces*.

Or, on the WebFOCUS Home Page, open the plus menu and click *Prepare and Manage Data*.

In the WebFOCUS Reporting Server browser interface, open the *Tools* menu and click *Workspace*.

The Server Workspace view opens.

b. On the resource tree, expand *Configuration Files*, then right-click *Server Profile - edasprof.prf* and click *Edit*.

c. On a new line, type *SET JSURLS = '/ibi_apps/tools/portalcanvas/iframeinterface.js'*

The partial URL points to the location in your WebFOCUS installation where the portalDispatch JavaScript function is defined. Note that if the context root of your installation is not ibi_apps, you must replace this part of the path with the custom context root that you are using.

d. Save your changes to edasprof.prf

6. Now that the JavaScript function is enabled, return to the Hub or Home Page, and run the WebFOCUS Designer page. Right-click the page, and click *Run in new window*.

The page runs in a new browser tab. Click a drill-down link in the parent item created in *How to Create Content with JavaScript Drill-Down Links*. One or more target items, created in *How to Create the Drill-Down Target Content*, run in another container on the page. These items are also filtered based on the value that you clicked, since you specified the parameter name and field when setting up the JavaScript function.

7. Optionally, click more drill-down links to update the filter values applied to the target content, or click the *Refresh* button on the page toolbar or container menu to reset the contents of the page.

### Changing Output Formats in a Chart or Report

The output format of your content determines the type of file that is generated when that content is run. Different output types enable different levels of run-time interactivity, embedding behavior, and compatibility with outside programs, so you can change the output type depending on how you intend to use your content and who the intended audience is.

You can change the output format for stand-alone charts and reports. Charts and reports created as part of a multi-content visualization use the Interactive output format, which provides run-time features such as tooltips, drill-downs, and on-chart filtering.
To change the output format of a stand-alone chart or report created in WebFOCUS Designer, use the Output Format menu on the Visualization toolbar. The Output Format menu is shown in the following image:

The following output format options are available:

- AHTML
- HTML5
- HTML
- PDF
- PPTX
- XLSX
- Select at runtime
At design time, the AHTML and HTML5 output formats use the responsive canvas. When using the responsive canvas, reports present In-Document Analytic paging controls at the bottom of the canvas that allow you to navigate through the pages of report. Some report styling properties are unavailable when using the responsive canvas. Charts in the AHTML and HTML5 output formats present informational tooltips and allow on-canvas filtering at design time.

The HTML, PDF, PPTX, and XLSX output formats use a paginated canvas at design time. Some report styling properties are only available when using the paginated canvas. You can scroll through an entire report using a scrollbar. Charts using the paginated canvas do not present interactive options, such as tooltips.

At run time, the HTML5 and HTML output formats are functionally equivalent. The two options are available to allow you to use the two different canvas types.

When you run your content, the HTML, HTML5, and AHTML options are browser-based formats, while PDF, PPTX, and XLSX output can be downloaded, distributed, and opened using standard office suite software. The Select at runtime option provides the ability to run a chart using any of the other output formats. Users can select a format at runtime from a filter control.
When creating a chart, the HTML and HTML5 output formats generate a basic chart, enhanced with JSON objects, that can be run in a web browser. The HTML and HTML5 chart formats automatically generate tooltips for different sections of a chart, allowing you to see detailed information at run-time on top of the quick, broad intuitions that a chart communicates. These tooltips provide run-time access to interactive features such as Auto Drill, which allows you to drill into data hierarchies used in the chart, and Auto Linking, which allows you to connect content that uses shared parameters associated with sort fields in the chart. The following image shows a chart that uses the HTML5 output format and has Auto Drill and Auto Linking options available from the tooltip.

The HTML5 format also enables you to run your chart with Insight, which allows you to modify, filter, and reformat a chart at run-time.
When creating a report, meanwhile, the HTML and HTML5 output formats generate a basic report that can be run in a web browser. The simplicity of the HTML and HTML5 output formats make them extremely flexible. Run-time interactivity is available in the form of hyperlinks, which provide access to Auto Drill and Auto Linking. An example of an HTML report with Auto Drill hyperlink behavior is shown in the following image.
Charts and reports using the AHTML format can also be run in a web browser. AHTML is a format that allows you to perform offline analysis using in-document analytic features. The AHTML format allows you to use Auto Drill and Auto Linking functionalities just like HTML. In addition to this, AHTML enables numerous features that allow you to reorganize and explore the data in an analytic chart without directly accessing the data source on which it is based. This includes the ability to filter the chart by lassoing values, view the data in the chart as a different chart type using the Chart Types menu, and create a new chart using the same fields while still in run time, download the chart, and more using the Options menu. An analytic chart with the Chart Types menu open is shown in the following image.
When the AHTML format is used in a report, in addition to the Options menu above the report, you can click a column header to filter the report, view the data in the report as a chart, and more. A menu of options appears, allowing you to explore and transform the report, as shown in the following image.

You can also click the arrows above each column header to sort the report by the values in that column.

When a chart or report using the AHTML output format is added to an assembled page, the Options menu becomes part of the container toolbar. It allows you to access the Chart/Rollup Tool to create new content from the same set of fields used in the original content, move the fields in a chart to different buckets, export, save, or print your content, and more.

To access your content in common desktop tools, use the PDF, PPTX, or XLSX output formats. When you run content that uses PDF, PPTX, or XLSX as the output format, a file is created in a .pdf, .pptx, or .xlsx format, respectively. The file opens in a browser viewer for that file type or is downloaded in the browser. The file can be opened using a tool compatible with the output file type. When the item is a chart, an image of the chart is embedded in the file. If the tool allows it, you can then right-click the image of the chart to save it as a separate image file.

Certain features may not be available, depending on the file type. For example, the PDF, PPTX, and XLSX output formats do not support Auto Linking, Auto Drill, or any other tooltip-based behavior, since a single, self-contained file is created.

Separate pages generated by page breaks or by the MultiPage bucket also behave differently, depending on the output file type. In PDF, a separate page is created for each page break or multipage value, and in PPTX, a separate slide is created. In Excel, however, separate pages are output to the same worksheet, similar to how page breaks and multipage values display in the HTML output format.
The following image shows an example of a chart created using the PDF output format viewed in a web browser.

The following image shows an example of a chart created using the PPTX output format viewed in Microsoft PowerPoint 2007.
The following image shows an example of a report created using the XLSX output format viewed in Excel 2007.

You can use the Select at runtime option to enable any of these output formats. When content using the Select at runtime option is added to a visualization as external content, a filter control appears at the top of the page, allowing you to select an output format at runtime. Items on the page that use Select at runtime are re-run in the selected output format. The Select at runtime option does not appear by default, but administrators can enable it from the InfoAssist Properties page of the Administration Console by selecting the User Selection check box in the Format Tab section.
Overview of In-Document Analytics

Setting the output format of a stand-alone chart or report to AHTML provides In-Document Analytic capabilities at run-time. Content that uses In-Document Analytics provides users with an interactive interface that allows the generation of real-time, dynamic charts and reports. Its versatility not only allows you to interact with your content by adding filters, sorting data, and generating new content, but it also allows for offline content access. You can package a data set with a combination of analytical views, resulting in highly intuitive and interactive self-service business intelligence. This gives you an edge in presentation and analysis, making it easy to develop and share concepts, ideas, and scenarios. An interactive report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems. If you are working with a larger data set, you can also zip the output files to reduce the file size when sending them through email.

**Note:** You may need to zip interactive content output files to reduce the file size, and send them through your email client.

Your users can explore and interact with your data using various analytical tools such as sorting, filtering, calculations, roll-ups, and pivoting. They can also experiment with different scenarios using various options.

All of the interactive content that you create functions independently of a server, and is portable, making it easy for your users to work with and analyze complex data without requiring the use of an external application, such as Microsoft Excel. With two types of users (developer and end user), the roles in development and delivery of materials are clear. The end user interacts with the content that the developer creates and deploys. They can obtain content without any additional plug-ins or programs should they choose to access your content remotely or offline, independent of a server.

**Note:** Each artifact that you create at run time is given a unique number for easy identification. This number is incremental but not consecutive, and is assigned automatically.
When you run content using an AHTML output format, you can review and continue to develop it using the available menus. For example, when you run a chart, you can select the chart menu to change the type of chart you are showing, as shown in the following image.
To add a new chart or edit your content, you can use the options available from the vertical Ellipsis menu, which is shown in the following image.

When you view your report or chart at full screen, a hamburger menu also displays, as shown in the following image. From this menu, you can exit full screen, save changes, or restore the dashboard.

For more information on In-Document Analytics, see the In-Document Analytics User's Guide.
Generating a Data Extract or Image From Content

In addition to the output formats that you can use when running your content, you can export a snapshot of a single chart or report as a data extract in an Excel spreadsheet, or as a .png image, which are downloaded from your browser. This allows you to quickly generate a representation of your content at any time, in a format that can be easily saved and distributed.

To generate the image or data extract, click the Application menu and, in the Export As section, click Data or Image. The file is downloaded using your browser.

When you export a data extract of your chart or report, it is downloaded as an Excel spreadsheet with the data displayed as a tabular report. This can help identify the precise values that are graphically represented in your chart. A spreadsheet is also easy to distribute. The following image shows part of the spreadsheet created by exporting a treemap chart as a data extract.
When you export an image, a snapshot of the item is taken as it currently exists, and saved in .png format. Headers, footers, and legends are included in the image, but external items such as filter controls are not. The following image, showing a treemap chart, was exported directly from WebFOCUS Designer.

Sales from 2015 to 2020

Once exported, you can open the image using a program on your machine capable of opening .png images, distribute the image, and even use it as a thumbnail for your content once you save it. To set a thumbnail, right-click the saved chart or report on the WebFOCUS Hub or WebFOCUS Home Page and click Properties. On the Advanced tab, select the Embedded thumbnail option and browse to the location where the exported image was saved. The thumbnail makes it easier to identify a content item on the Hub or Home Page, or in the Resources tree when assembling a visualization in WebFOCUS Designer.
Generating Instant Insights in TIBCO WebFOCUS Designer

You can easily run advanced analyses and generate visualizations and narratives on your data sets, without manually preparing and analyzing your data, or having prior knowledge of data science or statistics.

With one click, the Instant Insights capabilities in WebFOCUS Designer recognize trends in your data, generate customizable visualizations as charts with natural language headers, and categorize the charts into tabs. You can add these charts to the WebFOCUS Designer canvas and build a page, or add them to existing pages or dashboards. Then you can save and share your insights with others.

**Note:** For installation information, see the TIBCO WebFOCUS Installation and Configuration manual for your platform.

**Procedure:** How to Access Instant Insights

You can access the Instant Insights capabilities in the following ways:

- **In WebFOCUS Designer.** From the WebFOCUS Hub, click the plus menu, and then click *Create Visualizations*, or, from the WebFOCUS Home Page, click *Visualize Data*. Then select a data source from the dialog box.

- **In the WebFOCUS Hub.** Click the plus menu, and then click *Explore Data*. Then select a data source from the dialog box.

- **After Uploading a Data File.** From the WebFOCUS Hub, click the plus menu, and then click *Get Data*, or, from the WebFOCUS Home Page, click *Get Data*. Then select a file type, select a data source from the dialog box, click *Load*, and then click *Visualizations*.

- **After Connecting to a Data Source.** From the WebFOCUS Hub, click the plus menu, and then click *Get Data*, or, from the WebFOCUS Home Page, click *Get Data*. Then click a configured adapter, click an available connection, select a data source from the dialog box, and click *Add*.

For more information, see *Uploading Data Files* and *Connecting to Data Sources*.

**Procedure:** How to Generate Instant Insights

You can generate visualizations that give you insights into your data.

1. From the WebFOCUS Hub, click the plus menu, and then click *Create Visualizations*, or, from the WebFOCUS Home Page, click *Visualize Data*. 
The Select Data Source dialog box opens, as shown in the following image.

2. Select a data source from which you want to generate insights.
3. Click **Create Visualization** to generate insights in WebFOCUS Designer's Visualization tab.

**Note:** You can click **Prepare/Extract Data** to further prepare or extract data in WebFOCUS Designer's Data tab.

The WebFOCUS Designer Visualization tab opens, as shown in the following image.
**Note:** To ensure the most meaningful insights, set the canvas sample data limit to *All*.

From the Visualization toolbar, click the canvas data limit button, click the dialog *Sample* tab, select *All*, and click *Apply*, as shown in the following image:

4. From the sidebar, click *Insights*.

**Note:** If your data set contains multiple tables, you are given the option to select the table from which you want to generate insights, as shown in the following image.

The Insights panel opens and begins analyzing your data. You can continue working in WebFOCUS Designer while your data is being analyzed. A pop-up message appears to alert you when your insights are ready.

The total number of insights generated, with a time stamp, is displayed. If your data is dynamic, you can click the refresh icon to gain updated insights.
Your insights display as visualizations, or charts, in different accordions, which can be collapsed or expanded. Each insight includes an automated, header narrative that explains the trends in your data. Click the Action icon to run your chart in a new window, save your chart to a workspace, or copy your chart to the WebFOCUS Designer canvas.

Depending on your data set, your insights are generated and categorized into the following tabs:

- **Single Columns.** Displays results for single columns of data. Insights can show dominances and distributions.

- **Pairs of Columns.** Displays results for pairs of columns of data. Insights can show correlations and associations.

- **Time-series.** Displays results for single columns of data that change over time. Insights can show seasonality, trend, and outliers.

Distributions identify different types of frequency distributions. Dominances identify where one category dominates over another. Correlations identify where multiple measures show a similar trend or pattern. Associations identify how categorical columns are correlated.

Dominances are determined based on count function and average function. Count function is when the count value of one or two categories is much larger than other classes for dimensions. Average function is when the average value of a measure against categories in dimensions is significantly higher than in other categories.

If the count distinct of a dimension is five or less, a pie chart is generated. If the count distinct of a dimension is more than five, a bar chart is generated.

A pie chart identifying most frequent values or dominances is shown in the following image.
A bar chart identifying most frequent values or dominances is shown in the following image.

Bar charts include a yellow average line, so you can compare the dominant category with the average value.

A histogram identifying distributions is shown in the following image.

Histograms identify the underlying frequency distributions of a set of continuous data, such as right-skewed distribution, left-skewed distribution, normal distribution, and bimodal distribution.
A scatter plot identifying correlations is shown in the following image.

Scatter plots are generated for each pair of measures that have a high correlation score. Correlations identify where multiple measures show a similar trend or pattern.

A chi-square chart identifying associations is shown in the following image.

The color intensity of the cells indicates how much the combinations are more or less prevalent than if the variables were independent.
A line chart identifying trend and outliers is shown in the following image.

Line charts provide count and mean aggregated insights for all measures as a function of time. Purple points highlight cases where there are outliers in time dimensions.

**Procedure: How to Add Instant Insights to a Page**

You can add one or more charts to the page canvas.

1. Click the *Action* icon in the generated chart container.
   - A context menu opens, with options to copy content to the canvas, save the visualization to a workspace, or run the visualization in a new window.
2. Click *Copy content to canvas*.
   - Your chart is added to the page canvas. Multiple charts can be added to a page.

**Note:** When you copy a chart to the page canvas, if the data limit on the canvas does not match the sample data set used when generating Instant Insights, a data limit dialog box opens, as shown in the following image.
You have the option to use the current data limit setting, or to update the canvas with the Instant Insights sample data setting.

- **Use Current Data Limit.** Your chart is added to the page using the current canvas data limit setting.

- **Use Sample Data.** Your chart is added to the page using the sample data setting. Any other charts on the page are refreshed to reflect the sample data setting.

You can select the checkbox to stop showing the data limit messaging when adding charts.

**Procedure: How to Edit Instant Insights**

You can edit the charts generated by Instant Insights to customize the content you want.

1. Select your chart on the page.
2. On the sidebar, click **Fields**.

   The Fields tab opens, as shown in the following image.

   ![Fields tab in Instant Insights](image)

3. Drag fields into the Display panel buckets to modify your chart.
4. Right-click a field to select additional options.
**Note:** For more information about creating and customizing charts in WebFOCUS Designer, see *Creating Charts*.

**Procedure:** How to Save Instant Insights

You can save a chart, or a chart page. Then you can share your insights with others.

1. To save a chart, click the **Action** icon in the generated chart container. A context menu opens, with options to copy content to the canvas, save the visualization to a workspace, or run the visualization in a new window.

2. Click **save the visualization to a workspace**.
   The Save dialog opens, allowing you to name the chart and select a workspace location.

3. Click **OK**.
   You can now share your chart with others.

4. To save a chart page, click **Save** from the WebFOCUS Designer toolbar menu.
   The Save dialog opens, allowing you to name the chart page and select a workspace location.

5. Click **OK**.
   You can now share your page with others.

**Note:** To save as a standalone chart, select the **Outline** tab on the sidebar, right-click on the associated entry in the outline, and click the **Save as standalone** option.

**Generating Instant Insights in the TIBCO WebFOCUS Hub**

You can easily run advanced analyses and generate visualizations and narratives on your data sets, without manually preparing and analyzing your data, or having prior knowledge of data science or statistics.

With one click, Instant Insights can generate visualizations as charts with natural language headers. Then you can save your insights in a workspace and use them later within WebFOCUS Designer.

**Note:** For installation information, see the TIBCO WebFOCUS Installation and Configuration manual for your platform.
**Procedure:** How to Generate Instant Insights

You can generate visualizations that give you insights into your data.

1. From the WebFOCUS Hub, click the plus menu, and then click *Explore Data*.
   
The Select Data Source dialog box opens, as shown in the following image.

2. Select a data source from which you want to generate insights.
   
   Your insights are generated, as shown in the following image.

   **Note:** Insights are generated using data sampling of 100K data points.
The total number of insights generated, with a time stamp, is displayed. If your data is dynamic, you can click the refresh icon to gain updated insights.

Your insights display as visualizations, or charts, in different accordions, which can be collapsed or expanded. Each insight includes an automated, header narrative that explains the trends in your data.

Click Switch Data Source to return to the Select Data Source dialog box. Click the Action icon to run your chart in a new window, or save your chart to a workspace. Click Close to return to the WebFOCUS Hub.

Depending on your data set, your insights are generated and categorized into the following tabs:

- **Single Columns.** Displays results for single columns of data. Insights can show dominance and distributions.
- **Pairs of Columns.** Displays results for pairs of columns of data. Insights can show correlations and associations.
- **Time-series.** Displays results for single columns of data that change over time. Insights can show seasonality, trend, and outliers.

For more information on types of generated insights and charts, see *Generating Instant Insights in TIBCO WebFOCUS Designer*.

**Procedure:** **How to Save Instant Insights**

You can save your chart to a workspace.

1. To save a chart, click the Action icon in the generated chart container.
   
   A context menu opens, with options to save the visualization to a workspace, or run the visualization in a new window.

2. Click save the visualization to a workspace.
   
   The Save dialog opens, allowing you to name the chart and select a workspace location.

3. Click OK.
   
   The chart is now saved to your selected workspace. From your workspace, you can right-click your chart to run it, share it, or edit it within WebFOCUS Designer.
Procedure: How to Edit Instant Insights

After saving a chart to your workspace, you can open and edit it in WebFOCUS Designer.

Right-click your saved chart and click Edit.

Your chart opens in WebFOCUS Designer, as shown in the following image.

For more information on editing insights, see Generating Instant Insights in TIBCO WebFOCUS Designer.

Previewing Content

As you create content and pages in WebFOCUS Designer, you can preview them to see how your data displays in the chart, or to check the styling, run-time behavior, and filtering before publishing or sharing it with others. At any point in the development of your visualization, click Run in new window.

Clicking Run in new window runs the visualization in a new browser tab, allowing you to view your content at run-time while continuing to edit it in a separate window. If you click Run in new window again, the content is reloaded in the same new tab.

Once it is saved, you can also run your content from the WebFOCUS Hub or WebFOCUS Home Page by right-clicking it and clicking Run.
When you preview stand-alone charts and reports that contain required filter prompts, you are presented with an Autoprompt page. You can use the filter controls to set values for each filter, as shown in the following image.
Pages use containers to display multiple content items, and provide run-time options such as the ability to expand and collapse containers, navigate between items in a multi-content container, apply and clear filter selections, and even use custom functionality added using JavaScript. You can customize and style the entire page as well as sections, containers, and filter controls on the page using an intuitive set of options as well as CSS themes and custom CSS enhancements.

You can create a page in two ways. On the WebFOCUS Hub or the WebFOCUS Home Page, click the plus button and then click Assemble Visualizations to create pages using existing content from your environment. Alternatively, click the plus button and click Create Visualizations on the Hub, or click Visualize Data on the Home Page to create new content. When you create new content and click Convert to page, the visualization transforms from a single chart or report into a page.

You can run and share a page on its own, or add it to a portal to provide more context in combination with other pages.

In this chapter:

- Creating Pages
- Styling Pages
- Adding Panels to a Responsive Container
- Linking to External Content From a Page
- Enabling Container Customization
- Providing Access to Content Items and TIBCO WebFOCUS Tools
- Creating Custom Templates
- Passing Parameter Values to a Page
- Bookmarking Control Selections in a Page
- Exporting a Page as a PDF or Image
Creating Pages

You can create a page in two ways. Create a visualization with new content using the Create Visualizations option on the plus menu of the WebFOCUS Hub or the Visualize Data option on the WebFOCUS Home Page, and then transform the chart or report into a page by clicking Convert to page. You can then create new charts and reports directly within the page. Alternatively, you can create a page from existing content by clicking Assemble Visualizations on the plus menu of the WebFOCUS Hub or WebFOCUS Home Page to open WebFOCUS Designer in assemble mode. Once you select a page template, you can start adding content from your repository to the page. This content can include images, embedded URLs, and other existing content that is unavailable when you convert a single chart or report to a page.

Pages can include multiple sections, each with multiple containers for your content. Each of these containers can also be configured to contain multiple content items, providing a thoroughly comprehensive overview of your data. Pages also include run-time filtering, content navigation, and content customization, allowing users to analyze, explore, and enhance the information provided on each page.
To add a second item to a visualization, such as a chart or report, click Convert to page on the Visualization toolbar. This transforms the single content item into a page. The first content item is moved into a container. Click Add container, drag a container from the Container tab on the sidebar, or drag a field or existing content item into an empty area of the page to add a second container. A visualization to which a second content item has just been added is shown in the following image.

Select an item on the page from the canvas or the outline to edit it using a relevant set of tools and options, whether the item is a content item or a page component. The Settings and Format tabs on the Properties panel update accordingly. When assembling a page from existing content, you can also select multiple components, sections, or filters while holding down the Ctrl key in order to edit or style multiple items of the same type at once. Additionally, some options are applied hierarchically. For example, setting a theme for the page applies that theme to any sections, containers, and content items that use the default style option.

You can add more new content to the page by clicking Add container, or by clicking the Container tab on the sidebar and dragging a container onto an empty area of the page from the Resources panel. You can then select the content area of the new container and create a new chart or report within it. You can also drag a field onto an empty area of the page to create a new container and content item in the location where you dropped the field.
If you are creating a page from existing content, you start by selecting a page template. Select the Blank template to add content and containers to the page yourself, or select a preset layout with containers to which you can add your content. The InfoApp 1 template provides a collapsible filter panel and movable filter grid to which you can add filter controls, which are generated when you add parameterized content to the page. The Workbench template provides a resource tree that you can use to navigate to content items in your repository, which you can then run in the target container on the right. You can also create your own templates and save them in the Global Resources area of your repository.

Once you have selected a page template, you can add existing content from your repository to the page by clicking Content on the sidebar, and then navigating to and dragging an item onto the page or into a container. These items can be external charts, reports, HTML pages, URLs, images, and more. You can navigate between folders in the Resources panel and locate an item by name using the search bar.

You can also duplicate an item by right-clicking the container or subsection that contains it and clicking Duplicate. This makes it easy to develop content by maintaining the styling, fields, and other properties from the existing content item and container. The title of the duplicated item is reused, with the text (Copy) added to the end. If you duplicate the content in a single-item panel container, a new container with the same content is added to the page. When you right-click a multi-content container, you can click Duplicate Container to duplicate the entire container, including all content, or click Duplicate Content to duplicate only the visible tab, accordion panel, or carousel slide.

You can move and resize containers on the page to organize them, or select a preset layout from the Container tab of the Resources panel to automatically create and arrange containers into a preset pattern.

You can save space on the page by placing multiple content items together in a tab, carousel, or accordion container.

If you are creating a page from existing content, to change a standard panel container into a tab, accordion, or carousel container, select Content on the sidebar and then drag a content item onto the container, already populated with content, on the canvas. The entire container is highlighted, indicating that the item will be dropped into the container. When you release the item into the container, you are prompted to replace the existing content, add the item in a new tab, accordion panel, or carousel slide, or cancel the operation.
Alternatively, to instantly convert a container to another type, you can right-click it on the canvas and point to Convert to, then select a container type of your choice. If you convert a container with multiple items into a panel container, which only supports one content item, each content item from the original container is added to a separate panel container. For example, if you convert a tab container with three tabs into a panel container, three panel containers are created.

You can combine multiple, existing containers on a page into a single multi-content container. Hold the Ctrl key and click the toolbars of multiple containers to select them, then right-click a container, point to Combine, and select a container type to combine them into. You can combine containers into a tab, accordion, carousel, or panel group container. The Combine option is unavailable when combining existing link tile, grid, and panel group containers, and for the Explorer widget, since these are special containers that do not contain standard content.

You can also combine containers by holding the Ctrl key and dragging one container onto another. When you drop the container, the Combine containers dialog box opens, allowing you to select the type of container into which to combine the contents of the containers involved, or to cancel the operation. If you combine the selected containers, the new container occupies half of the page width and is placed within the available empty space on the page. Once the containers have been combined, you can hold the Ctrl key and drag other containers on the page into the grouped multi-content container or panel group.

To delete a container from a page, right-click it and click Delete container. If the container includes multiple items, you can click Delete Tab, Delete slide, or Delete Area to delete a single sub-component, depending on the container type. You can also delete the selected container or sub-component by pressing the Delete key.

When creating new content in a page, you can filter the entire page by dragging a field from the Resource panel into the Filter toolbar, just like when you create a content item. You can select default values for the filter from the resulting filter control, and right-click it to change other filter properties. If you are creating a page with existing content, then when parameterized items are added to a page, a badge appears on the Filters tab of the sidebar, alerting you that you can create filter controls. Open the Filters tab and click Add all filters to page to create filter controls for all parameters, or right-click an individual parameter in the list and click Add to page to create a filter control for a single parameter. These controls will apply filters to any items that are parameterized for the same amper variable and field.

As you create your page, you can click Run in new window to see a run-time view of your page, allowing you to interact with filtering, built in container controls, In-Document Analytics, and any unlocked or interactive content on the page. You can check these variables by clicking Info on the Visualization toolbar.
Be sure to periodically save your page by clicking Save on the WebFOCUS Designer toolbar.

**Styling Pages**

A number of tools in WebFOCUS Designer support your efforts to apply styling to pages and page components. You can resize content, hide content from smaller devices if it interferes with a responsive layout, edit page, section and container properties, apply filters, themes and styles, and create custom templates.

**Working With Content Containers**

When you add content to a page, it is automatically placed in a container. To move and resize the content item, move and resize the container into which it was placed by dragging the container or its resizing handles. You can also configure and style a container by selecting it on the page and then using the options on the Settings and Format tabs of the Properties panel. Note that the options for a container are separate from those for the content item inside the container. To select the container, click the container toolbar, or select a container from the Outline tab of the sidebar. Empty containers can be added to the page by selecting the Container tab on the sidebar and dragging the selected container type into the canvas. A highlighted area shows where the container will be placed.

There are several types of containers. The default container for a single item is a panel container. The panel container is a basic container type that includes a title bar and toolbar with a run-time menu, as shown in the following image.
The run-time menu provides the ability to refresh the content in the container by default. If the content currently visible in the container uses the AHTML output format, additional In-Document Analytic run-time options are added to this menu. For more information about In-Document Analytics, see *Overview of In-Document Analytics* on page 765. You can also add custom options to the run-time menu and to the container toolbar using embedded JavaScript. For more information, see *Enhancing Pages With Custom JavaScript* on page 812.

To add multiple items, such as charts, reports, and images, to a single container, use the tab, carousel, or accordion container types. These container types include the same features as the panel container, as well as controls to navigate between multiple content items. You can add another content item to a container by selecting the Content tab on the sidebar, navigating to an item, and dragging it onto the existing container. You are given options to add the new item to a new tab, panel, or slide, or replace the visible, existing item in the container.

In a tab container, navigate between items using the tabs below the title bar. You can double-click the text in a tab to change it, and right-click a tab to delete, duplicate, or reorder it. A tab container is shown in the following image.
A carousel container allows you to switch between content items by clicking a dot at the bottom of the container, or by clicking arrows that appear when you point to the left or right side of the container. When creating a page, right-click a carousel container to duplicate, reorder, or delete a slide. You can set a carousel container to automatically cycle between content items using the options described in *Automatically Advancing Slides in a Carousel Container* on page 799. A carousel container, with navigation arrows, is shown in the following image.

Accordian containers place content in collapsible panels. You can expand and collapse items in an accordion container by clicking a panel label. When creating a page, right-click an individual panel in an accordion container to rename, reorder, duplicate, or delete the panel. An accordian container is shown in the following image.
Other types of containers serve more specific purposes. The grid container type, only available in pages assembled from existing content, can be used as a filter container, as an alternative or in addition to the filter toolbar. Once you add filter controls from your content to a page, you can drag them from the default location in the filter toolbar into the grid control. Select the filter bar within the panel from the outline, and then select the Format tab to change the number of columns in the grid container. You can also drag a text label or submit button to the grid from the Control tab on the sidebar.

You can use a panel group container to keep a set of vertically arranged panels together when responsive folding occurs as the size of the page changes. To use a panel grid container, add it to the page, then drag new containers, content items, or fields into it. For more information, see Adding Panels to a Responsive Container on page 851.

A link tile container allows you to display a content item or image on a page that can be clicked to access additional, outside content. Drag the link tile container onto the page, then, from the Settings tab, use the link tile Background, Content, Attach all parameters, and Target properties, to set the displayed and target content, and configure how the link tile behaves. For more information, see Linking to External Content From a Page on page 852.

You can use the Explorer widget to provide access to the Workspaces view of the WebFOCUS Hub or WebFOCUS Home Page. This allows anyone accessing the page, or a portal containing the page, to open and run content items and create new content, depending on their privileges. In the Explorer widget, you can navigate through workspaces, folders, and content items from the Resources tree and Content area, and create new content using options in the +Content menu. For more information, see Providing Access to Content Items and TIBCO WebFOCUS Tools on page 859.

Right-click any type of container to access a shortcut menu of options. These include the ability to refresh the container content, change the title of the container, access the Settings or Format tabs, duplicate the visible content item, change the container type, or delete the container. If you select multiple containers, you also have the option to combine them into a tab, accordion, or carousel container.
Resizing Content on a Page

You can resize content on a page, at any time, using the sizing handles and the shaded placement area that appear on the canvas. When you hover over a container on the canvas, a series of handles appear. Drag a handle in the direction that you want to resize the item, as shown in the following image.

![Image of content resizing handles](image)

The content container snaps to the nearest row and column when you resize it. To change the number of columns in a section on the page, allowing more granular container widths, select a section, open the \textit{Format} tab, and select an option from the Number of Columns area. 12 is the default. You can also change the amount of space between containers by selecting the entire page and typing a size for the Margin property, on the Format tab.

Editing Page, Section, and Container Properties

The Properties panel displays the properties for the element that is selected. To access container properties, select a container from the canvas or outline. To access section properties, click the grid inside the canvas, or select a section from the outline. To access page properties, click the page header or the toolbar, or select a page from the outline. If the page header and the toolbar are hidden, you can also access page properties by clicking the canvas outside a grid section.

The following properties are available when you select an entire page.
Settings tab:

- **ID.** Contains a read-only unique CSS identifier.

- **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code.

- **Show page heading.** Toggles between hiding and showing the title in the header.

- **Show page toolbar.** Toggles between hiding and showing the page toolbar.

  - **Show page refresh.** Toggles between showing and hiding the refresh button on the page toolbar.

  - **Show export.** Toggles between showing and hiding the Export menu on the page toolbar. You can export a page as a PDF or as a .png image. Select just the PDF or just the Image check box to make just one of these export options available from the page, in which case the Export menu turns into an Export button.

- **Include Page Filters.** Select this check box to add a filter toolbar to the page, even if no filters have been added yet. Clear this check box to remove the filter toolbar.

  If Include Page Filters is selected, you can select one of the following options to change the position of the filter toolbar:

  - **Below Header.** The filter toolbar is placed below the page toolbar and header. This is the default.

  - **Above Header.** The filter toolbar is placed above the page toolbar and header.

  - **Left Position.** The filter toolbar is aligned vertically along the left side of the page, below the page header.

  - **Modal.** The filter toolbar is accessible in a modal window overlaid onto the page. Click the Show filters button on the page toolbar to open the modal window and make filter selections.

Format tab:

- **Theme.** Allows you to select a theme for the page. The default options are Designer 2018, Light, Midnight, and Vivid. Administrators can configure additional themes that will be available to users from this property. For more information, see Applying Themes and Styles to Pages on page 800.

- **Margin.** Controls the size of the margin between the border of the page and the content.
**Note:** If the margin property is set to 0, you cannot select a section on the page from the canvas or access the section shortcut menu options. As a workaround, change the margin property value to 20px temporarily to gain access to the section and its options.

- **Maximum width.** Controls the maximum width of the page.

- **Page Heading Style.** Provides a selection of typeface styles for the page heading. Additional header text formatting can be done using CSS. For example, you can assign a class to the page and use the font-family property to change the header text font.

The following properties are available for sections.

**Settings tab:**

- **ID.** Contains a read-only unique CSS identifier.

- **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code.

- **Collapsible.** Toggles between collapsible and noncollapsible modes of the selected section.

**Format tab:**

- **Style.** Allows you to choose a style for the selected section, or select Default to use the theme selected for the page.

- **Row height.** Sets the height of the section that is currently selected on the canvas. The default value is 60px.

  **Note:** Changing the row height does not change the margin, which can be configured on the page level.

- **Number of Columns.** Allows you to change the number of columns in a section, enabling more granular panel widths. Panels snap to the nearest column and row when you resize them. 12 columns are used by default, and 28, 45, and 80 column options are also available.

The following properties are available for containers.

**Settings tab:**

- **Container Settings.** Provides access to the following properties.

  - **ID.** Contains a read-only unique CSS identifier.

  - **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code.
Show title. Toggles between hiding and showing the title.

Show toolbar. Toggles between hiding and showing the container toolbar.

Show On. Allows you to hide the selected container or item from displaying on specified devices. The options include desktop, tablet, and mobile.

Autoplay interval. Available for carousel containers. Allows carousel slides to automatically cycle based on the selected interval, in seconds. When set to 0, autoplay is disabled.

Rerun content. Available for carousel containers. When the Autoplay interval is set to a value higher than 0, the Rerun content option allows you to refresh the content on each slide of a carousel container when it appears. If Rerun content is not enabled, then the content on each slide only loads the first time it appears.

Container Customization. Provides options that allow users to change the content in a page at run time. Includes the following properties.

Lock container. If disabled, allows users to change content in the panel at run time. This property is enabled by default.

Select content from. Allows you to set the initial directory that users will see when they click the Add content button.

Note: To see the full value displayed in the field, widen the Properties panel area by clicking the separator and dragging it to the right.

Lock path. When enabled, limits the content selection area to the directory that is specified in the Path property. This property is enabled by default.

Flatten list. If enabled, hides the folder hierarchy and the breadcrumb trail within the directory that is specified in the Path property. This property is disabled by default.

Note: This property is especially useful if you want to display different widgets to different users based on their roles. For example, you can create a series of subfolders with content and then apply security rules to show and hide these subfolders from users based on their group membership. Then you can configure the Path property to display the parent of these subfolders and flatten the list. Now each user can only see the widgets they are authorized to see in a simple list without any folders to navigate.

Hide tags. If enabled, hides tag buttons in a flattened list. This property is disabled by default. It remains inactive when the Flatten list property is disabled.

Initial view. Determines the initial view of the directory that users will see when they click the Add Content button. The options are Grid and List.
**Note:** Users can change the view at run time inside the Select Item dialog box.

Format tab:

- **Style.** Allows you to choose a style for the selected container or item.

The following options are available for content items in a page assembled from existing content. New content items in a page provide standard content creation options, in addition to these.

Settings tab:

- **Content Properties.** Provides access to the following properties.
  - **ID.** Contains a read-only unique CSS identifier of the content item. You can reference this ID in custom JavaScript and CSS code as well as drill-down targeting procedures.
  - **Classes.** Allows you to add one or more custom CSS classes that you can reference in custom JavaScript and CSS code as well as drill-down targeting procedures.

Format tab:

- **Content Format.** Provides access to the following property.
  - **Theme.** Select a theme to apply to the content item. You can explicitly select a theme, or have the item inherit the theme used in the page. When the item is part of a page assembled from existing content, you can also select **Use content theme** to use the theme originally applied to the item, ensuring that it does not get overwritten by the page or portal theme. For more information, see *Applying Themes and Styles to Pages* on page 800.

**Hiding Content From Devices**

You can choose to hide certain content items from smaller devices, especially when dealing with large or multi-faceted items like maps or HTML pages. When an item is hidden from a device, the other items around it re-flow into the empty space and retain the responsive layout.

**Procedure:** How to Hide a Content Item From Devices

1. In WebFOCUS Designer, select a large item that you want to hide from small-screen devices.

2. On the Properties panel, on the Settings tab, under the Show On property, click a device icon to hide the selected item from this type of device.

**Note:** All three device buttons are selected, by default, making the item visible on all devices. Manually clear the buttons to hide the item from specific device types.
An example of hiding a large item from mobile phones and tablets is shown in the following image.

3. Save the page.
4. Run the page on a device, from which the item was hidden.
The item does not display. All remaining content items rearrange to cover the empty space, as shown in the following image.
Automatically Advancing Slides in a Carousel Container

Using a carousel container is one way to put multiple charts, reports, and other content items into a single container. Carousel containers include an unobtrusive control that allows users to cycle through the items added to it, as shown in the following image.

Unlike tabbed or accordion containers, carousel containers also include the option to autoplay the content within them, allowing you to show all of the content in the carousel container without requiring user interaction.

To enable autoplay for a carousel container, select the container and open the Settings tab on the Properties panel. The Autoplay interval and Rerun content properties are available in the Container Settings section. To enable autoplay, set the Autoplay interval to a value higher than zero (0) to enable autoplay. The Autoplay interval is the amount of time, in seconds, that each slide is shown before advancing to the next slide.

When the Autoplay interval is set, the Rerun content option becomes available. This option is turned off, by default. When enabled, the content on a slide of the carousel container refreshes each time it is displayed. When Rerun content is not enabled, the content on each slide only loads the first time it is displayed, and it is not refreshed unless manually prompted from the menu on the container toolbar.
Applying Themes and Styles to Pages

While customizing your page, you can apply themes and styles to various page elements. The general theme of the page is defined by the Theme setting, which you can configure in the Properties panel, on the page level. A theme affects the look of the entire set of elements on the page, including colors, opacity, and typeface styles. Themes also dictate the color schemes available as styles on the Format tab when editing sections, filters, or containers.

By default, the theme selected for a page is passed on to content in the page. You can select content items inside a container and change the theme for each one individually from the Format tab. If the content item was added to the page from the Content tab, you can additionally choose to use the original theme of the content item, instead of inheriting the page theme or selecting a specific theme to use.

There are four themes that WebFOCUS Designer offers:

- Designer 2018
- Light
- Midnight
- Vivid

To add a theme to this list, create a folder in the Global Resources area, in the Custom folder within the Themes folder. In that folder, you can add a custom StyleSheet to use with charts and reports, and a custom CSS file to use for pages. The .sty file and .css file must both be named themes.

Note: To facilitate the creation of a custom theme, you can copy and modify properties from one of the themes included with WebFOCUS. This makes it easy to identify the default classes used in a WebFOCUS Designer page.

Once you select a theme, you can further modify it by configuring styles. You can also save your unique combination of a theme and styles as a custom theme.

Procedure: How to Apply a Theme to a Page

1. In WebFOCUS Designer, click the page toolbar to select the entire page, and then click the Format tab on the Properties panel.

   The style properties appear.

2. In the Page Style section, from the Theme property drop-down list, select the theme that you want to use.

   The page refreshes with the new theme.
3. Save your changes.

**Procedure: How to Apply Styles to Sections**

1. In WebFOCUS Designer, select a page section by clicking the background area near a container, or by selecting a section from the outline.
2. On the Properties panel, click the Format tab.
   
The Style properties appear.
3. Click a style that you want to use.
   
   **Note:** Styles are based on classes in the selected theme. For example, use the class .pd-style-default-color to configure the Default style of the theme, use the class .pd-style-color2 to configure Style 2 of the theme, and use the class .pd-style-color3 to configure Style 3 of the theme.

   The page refreshes and applies the style to the section, as shown in the following image, where the selection of Style 2 has made the first section blue.

4. Optionally, add more sections and apply styles to them.
5. Click the new section and apply a style to it, as described in step 3.
The page refreshes and applies the new style. You can apply different styles to different sections, as shown in the following image.

6. Save your changes.

**Procedure:** How to Apply Styles to Containers

1. In WebFOCUS Designer, create a visualization with multiple containers.
2. Click a container, and, on the Properties panel, click the *Format* tab.
   
The Style properties appear.
3. Click a style that you want to use.

   **Note:** Styles are based on classes in the selected theme. For example, use the class `.pd-style-default-color` to configure the Default style of the theme, use the class `.pd-style-color2` to configure Style 2 of the theme, and use the class `.pd-style-color3` to configure Style 3 of the theme.
The page refreshes and applies the style to the container, as shown in the following image.

4. Optionally apply styles to other containers on the canvas.
   
   **Note:** When creating a visualization from existing content, to apply the same style to multiple containers, multi-select containers by holding the Ctrl key, and then click a style button.

5. Save your changes.

**Procedure:** How to Create a Custom Theme

1. Sign in to WebFOCUS as an administrator.

2. On the Hub or Home Page, click Workspaces and, from the Resources tree, expand the Global Resources folder, and then expand the Themes folder.

3. Open the Custom folder, and then click the New folder button above the Resources tree.
   
   The New Folder dialog box opens.

4. Populate the Title field with the name of your custom theme, and click OK.
The custom theme folder is created. Your theme CSS file will reside in this folder. If you know which CSS classes should be used for your theme, you can create a new CSS text file, add your code, and save it with the name theme. The file must be called theme to be available for selection in WebFOCUS Designer. To facilitate the process, you can modify an existing theme CSS file. In this example, we copy and modify the theme CSS file for the Light theme.

5. Expand the Standard folder, and then expand the Light folder.

6. Copy the theme CSS file, and paste it inside your new custom theme folder.

The following image shows the correct hierarchy of the custom theme file.

![Theme Hierarchy](image)

**Note:** Do not modify the name of the theme CSS file. It is imperative that both the CSS file and StyleSheet in your custom theme folder are called theme. The name of the folder in which the file resides is the theme name that is visible in WebFOCUS Designer.

7. Right-click the newly copied theme CSS file, and then click *Edit*.

The Text Editor window opens.

8. Modify the code to achieve the desired look of the theme.

   In this example, you could change the background color from white #fff to yellow #ffff00.

9. Save and close the Text Editor.

10. Optionally, configure a related content theme by creating a StyleSheet (.sty) file called theme. You can copy this from an existing theme folder, such as the Light folder, as well.

   The styling properties in the StyleSheet will be applied automatically to content on the page when your custom theme is used, unless that content has a different theme explicitly assigned.
In WebFOCUS Designer, apply the new custom theme to a page, as described in *How to Apply a Theme to a Page* on page 800.

An example of a new theme applied to a page is shown in the following image.

Notice that the content theme, or StyleSheet, associated with the page theme was automatically applied to the content on the page.

Save your changes.

**Customizing Default Styling Options for Assembled Page Filters**

When applying filters to an assembled page, you can customize the default styling of your filters on the page level. You can set default parameters for the following styling options:

- **Label Positions.** Controls the position of the filter label in the relation to the control. The options are above, right, left, and no label.
- **Label Alignment.** Controls the alignment of the filter label. The options are left, right, and center.
- **Label/Control Split.** Controls the space ratio between the label and control inside the cell. This option is only available when the label position is set to right or left.
- **Control Object Width.** Sets the width of the control in relation to the filter cell. The options are:
  - **Auto.** Adjusts the width of the control automatically to accommodate the name of each value.
Max. Fills the entire filter cell. This is the default value.

Percentages. Set the control width to various percentages, as they relate to the filter cell.

Once the default filter styling options are configured on the page level, the new controls added to the page will reflect these specifications, regardless of whether they are added at design time or at run time using the Add Content button.

You can configure default filter styling in one of two ways: from the Filters tab on the sidebar and directly from the filter grid.

Procedure: How to Configure Filter Styling Defaults from the Filters Tab

You can set default styling for assembled page filters before you add any filters to your page.

1. Launch WebFOCUS Designer in the Assembled mode and add parameterized content to the canvas.
2. Click the ellipses icon in the upper-right corner of the Filters tab of the sidebar, and then point to View/Edit filter defaults, as shown in the following image.

3. Make your styling choices.

4. If you have any filters displayed on the canvas and want these new styling choices applied to them, select the Apply to all used filters checkbox.

5. Click OK.

6. Add some or all filters to the page.

Observe that the styling of your filters reflects the choices you just made.

**Procedure:** How to Configure Filter Styling Defaults from the Filter Grid

You can set default styling for assembled page filters directly from your filter grid. Using this method, you can also override the existing default styling that you configured earlier.

1. Launch WebFOCUS Designer in the Assembled mode and add parameterized content to the canvas.
2. From the Filters tab of the sidebar, right-click some of the filters, and click Add to page. Controls to your parameters are added to the page filter toolbar.

3. Right-click a filter control and point to View/Edit filter defaults, as shown in the following image.

![Image of the filter toolbar with View/Edit filter defaults option highlighted]

4. Make your styling choices, select the Apply to all used filters checkbox, and click OK. All filters that currently display on your filter toolbar change to reflect the new styling.

5. From the Filters tab on the sidebar, add another filter to the page.

Notice that this new filter displays the styling that existed prior to the steps we took in this procedure. You can now right-click this new filter control and make one of the following choices.

- Click Apply default styling to match this filter to the rest of the filters on the page.
Click Save filter style as default to ensure that all subsequent filters added to the page will match the styling of this filter.

**Note:** If you want to quickly change all existing filters on the page to match this new default styling, right-click the filter control again, point to View/Edit filter defaults, select the Apply to all used filters checkbox, and click OK.

For more information on filter styling, see *Styling Filter Controls in a Visualization* on page 631.

### Applying Custom CSS and JavaScript Code to a Page

You can apply custom cascading style sheet (CSS) properties and JavaScript code to a page, allowing you to significantly enhance the page with countless styling options and run-time behaviors using code that you write yourself. CSS makes it easy to style different elements on a page by applying various styling properties to them, while JavaScript is a robust programming language that you can use to customize a page with dynamic and interactive features not normally available in WebFOCUS Designer.

This feature is intended for content developers with CSS and JavaScript coding experience. The CSS and JavaScript options are available to developers, administrators, and users with text editor access.

You can add custom CSS and JavaScript to a page by typing code into the CSS and Javascript text editors, respectively. To access the CSS or JavaScript text editor, click Outline on the sidebar, and then select CSS or JavaScript. The text editor opens over the canvas, and you can type your code into it, as shown in the following image.
The code that you write can reference classes that you assign to different components on the page by selecting them and assigning a class name, using the Classes property on the Format tab.

To return to the canvas, click the close icon in the corner of the page.

When you use the text editor, the WebFOCUS Designer toolbar provides additional options to copy, cut, paste, and find and replace your text. The text editor also includes built-in features such as syntax highlighting, code folding, line numbering, autocomplete, alerts, indent guides, and a status bar. These features facilitate CSS and JavaScript code development and debugging by improving clarity and navigability in the text editor.

**Note:** Custom CSS and JavaScript is not displayed in the canvas. You must run the visualization to see the results of your custom code.

### Styling Pages With Custom CSS

Cascading style sheets, or CSS, is a commonly used language that allows you to style different components on a page. CSS properties include font style, text color, background color, and much more. Custom CSS can be applied to specific objects on a page by specifying a CSS class for the object, and then using a class selector in your CSS code.

To specify a CSS class for an object on a page, select the object and, on the Properties panel, type a class name into the text box for the Classes property. You can specify multiple classes for an object by separating the class names with spaces, and you are encouraged to use the same class names for multiple items on the page. When you assign attributes to a class in the CSS tab, they will affect all elements on the page that are assigned to that class.

### Procedure: How to Change the Color of a Panel Using CSS

You can change the background color of a panel by assigning a class to the panel and then adding the background-color attribute to the class using CSS.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and click *Create Visualizations*, or, on the WebFOCUS Home Page, click *Visualize Data*.

   WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

   Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Click the *Convert to page* button to transform the visualization from a single content item to a page.

4. Optionally, create new content in the visualization and add new containers to the page for additional content.
5. Select a container on the page.

6. On the Settings tab of the Properties panel, in the text box for the Classes property, type a class name of your choice, as shown in the following image.

7. Click Outline on the sidebar to display the visualization outline.

8. Click CSS.

   The CSS text editor opens.

9. Add a CSS declaration to change the background-color attribute for the class used by the panel.
   a. Reference the class name that you specified in the Classes property.

      Type a period (.) followed immediately by the class name, then an opening curly bracket ({}), and press the Enter key.

      The closing bracket is added automatically.

   b. Within the brackets, type background-color, followed by a colon and then a color string.

      For example, to make the color of a panel, for which panelclass is the value of the Classes property, to a bright blue, you could use the following CSS declaration.

      

\[
\text{.panelclass} \\
\quad \text{background-color: rgb(0,180,240);} \\
\]


10. Save the visualization and close WebFOCUS Designer.
11. Run the visualization from the Hub or Home Page.

The custom CSS is applied to the specified container.

**Enhancing Pages With Custom JavaScript**

You can use custom JavaScript to enhance the functionality of components on a page. Any component created on the page using the WebFOCUS Designer canvas can be modified in the JavaScript text editor by referencing a CSS class name specified in the Classes field of the Properties panel for the object, or using the WebFOCUS Designer JavaScript API, to standardized classes that correspond to different component types in a page or portal. Each component class can utilize a set of predefined methods in addition to custom JavaScript. You can even use JavaScript to add objects to a page entirely through code, without using the canvas at all.

**Procedure: How to Add a Button and a Menu Item to a Panel Container Using Custom JavaScript**

You can use custom JavaScript code to add a button and a menu item to a panel that you have added to a page. You can configure the button and menu item to execute a command of your choice, such as a URL call.

For information about different JavaScript object classes, see the [TIBCO WebFOCUS Designer JavaScript API Classes](#) on page 818 reference information below.

1. Open WebFOCUS Designer. On the WebFOCUS Hub, click the plus menu and click Create Visualizations, or, on the WebFOCUS Home Page, click Visualize Data.

WebFOCUS Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, WebFOCUS Designer loads with options to create a single content item.

3. Click the Convert to page button to transform the visualization from a single content item to a page.

4. Optionally, create new content in the visualization and add new containers to the page for additional content.

5. Select a container on the page.

6. On the Settings tab of the Properties panel, in the text box for the Classes property, type a class name of your choice.

7. Click Outline on the sidebar to display the visualization outline.
8. Click *JavaScript*.

The JavaScript text editor opens.

9. To have the button and menu item appear when the page loads, use the `iba_pageloaded` event listener by adding the following syntax:

```javascript
window.addEventListener("iba_pageloaded", function (e){
});
```

The code to add a button and menu item will go within this event listener command.

10. Add a button to the panel using JavaScript.

a. First, within the `iba_pageloaded` event listener, create a variable to represent the panel, such as the following:

```javascript
var panel = document.querySelector(".class").ibaObject;
```

where:

*panel*

Is the name of the variable that you define to represent the panel.

*class*

Is the name you previously typed in the Classes property for the panel on the page.

b. After the panel variable, define the style and appearance of the button and add it to the panel, such as in the following syntax example. This example uses a home icon and places the button before the default resize button:

```javascript
var button = panel.addButton(
    {"glyphClasses": "fa fa-home", "class": "buttonClass", "tooltip": "tooltip text"},
    ".pd-container-title-button-resize", true);
```

where:

*button*

Is the name of the variable that you define to represent the button.

*panel*

Is the variable representing the panel, defined in step 10a.

*fa fa-home*

Is a glyph class for a Font Awesome icon that looks like a house.
**buttonClass**

Is a CSS class assigned to the button itself. You can use this to apply CSS styling to the button, or reference the button elsewhere in your JavaScript code.

**tooltip text**

Is the text that you want to appear in the tooltip when you point to the button.

**.pd-container-title-button-resize**

Is the class of the resize button on the panel. This is the sibling of the button you are currently adding.

**true**

When the value of the before property is set to `true`, the button is placed before the sibling. Otherwise, it is placed after the sibling. If no sibling is specified, it is ordered last.

c. After defining the panel button, create an event listener that allows the button to execute a specified action. The following example causes the button to open the TIBCO website in a new window when it is clicked.

```
button.addEventListener("click", function(){
  window.open("https://www.tibco.com/");
});
```

where:

**button**

Is the variable name that you assigned to the button in step 10b.

11. Add a menu item to the panel’s run-time menu using JavaScript.

a. Create a variable to define the menu item, such as in the following example.

```
var menu = panel.addMenuItem({
  "text": "Menu text", "glyphClasses": "fa fa-globe","class": "menu-class"},
  ".class>.ibx_menu_item", true);
```

where:

**menu**

Is a variable name that you want to use to represent the menu item.

**panel**

Is the name of the variable representing the panel to which the menu is added.

**Menu text**

Is the text of the menu item.
fa fa-globe
Is a glyph class for a Font Awesome icon that looks like the Earth.

menu-class
Is a CSS class assigned to the menu item itself. You can use this to apply CSS styling to the menu item, or reference the menu item elsewhere in your JavaScript code.

".class>.ibx_menu_item"
Is a selector for the Refresh button in the panel menu, where class is the CSS class assigned to the panel using the Classes property.

true
When the value of the before property is set to true, the menu item is placed before the sibling, which in this case is the Refresh option. Otherwise, it is placed after the sibling. If no sibling is specified, it is ordered last in the menu.

b. After defining the menu item, create an event listener that allows the button to execute a specified action. The following example causes the menu item to run an HTML page in a new window through a URL call when it is clicked.

```javascript
menu.addEventListener("click", function(){
    window.open("http://localhost:8080/ibi_apps/run.bip?
BIP_REQUEST_TYPE=BIP_LAUNCH&BIP_folder=IBFS%253A%252FWFC%252FRepository%252FPublic%252F2019%252FHTML%252F&BIP_item=html_page.htm");
});
```

where:

menu
Is the variable name that you assigned to the menu item in step 11a.

The complete custom JavaScript may resemble the following.
window.addEventListener("iba_pageloaded", function (e){
    var panel = document.querySelector(".map-panel").ibaObject;
    var tibcosite = panel.addButton({
        "glyphClasses": "fa fa-home", "class": "tibcoButton", "tooltip": "Click to display help.",
        ".pd-container-title-button-resize", true);
    tibcosite.addEventListener("click", function(){
        window.open("https://www.tibco.com/");
    });
    var runReport = panel.addMenuItem({
        "text": "Country Report", "glyphClasses": "fa fa-globe","class": "globemenu",
        ".map-panel>.ibx_menu_item", true);
    runReport.addEventListener("click", function(){
        window.open("http://localhost:8080/ibi_apps/run.bip?BIP_REQUEST_TYPE=BIP_LAUNCH&BIP_folder=IBFS%253A%252FWFC%252FRepository%252FPublic%252F2019%252FHTML%252F&BIP_item=Basic_2_ctrl_page.htm");
    });
});

12. Save the page.

Changes made using custom CSS and JavaScript do not appear on the canvas at design time. To see the impact of your custom code, you must run the visualization.

13. On the Hub or Home Page, right-click the visualization that you just created and click Run in new window.

The visualization opens in a new browser tab or window, and the customized button and menu item are available. When clicked, they open the links you specified for them in a new tab or window.

Procedure: How to Use JavaScript to Automatically Resize an Image on a Page

Since the panels in a responsive page resize to fit the browser window, images added to the page may not always fit properly. If the image is too big, only part of the image may show in the panel, and scrollbars may be added. If the image is too small, the panel background may show around the image.

In order to autosize an image to fit a panel, you can use jQuery to set the height and width CSS properties for an image in a specified container. You can specify the container by referencing its class, which you can set using the Classes property on the Settings tab.

An example of the final JavaScript code is shown below:

```javascript
$('.'+class').closest('.'+grid-stack-item').addClass('autoheight');
$('.'+class + iframe').attr('scrolling','no').on('load', function(e){
    $(this).contents().find('img').height('100%');
    $(this).contents().find('img').width('100%');
});
```
where:

class

Is a class assigned to the panel that contains the image to be autosized.

.attr('scrolling','no')

Disables the generation of scrollbars in the container.

.height('100%'), .width('100%')

Sets the image to fill the height and width of the container. This may distort the image, depending on the dimensions of the container. As an alternative, replace 100% with auto for either the height or width, to maintain the height-to-width ratio at all sizes. Using auto may reveal the panel background or cut off part of the image, depending on the dimensions of the container.

1. On the Hub or Home Page, click the plus button and then click Assemble Visualizations.

WebFOCUS Designer opens to assemble a page from existing content.

2. With Content selected on the sidebar, navigate to the location of an image that has been uploaded to the Repository and drag the image onto the canvas.

The image is added to a container on the page. The size of the image in the container is the absolute size of the uploaded image file.

3. Optionally, resize and reposition the container that contains the image, and add other items to the page.

4. Select the container that holds the image. On the Settings tab of the Properties panel, type a class name of your choice into the Classes text box. This class will be used as an identifier for the container in the JavaScript code.

5. Click Outline on the sidebar, and then click JavaScript.

The JavaScript text editor opens.

6. Paste the following code into the text editor.

```javascript
$(
  '.class').closest('.grid-stack-item').addClass('autoheight');

$(
  '.class iframe').attr('scrolling','no').on('load', function(e){
    $(this).contents().find('img').height('100%');
    $(this).contents().find('img').width('100%');
  })
```

7. Replace class in the first two lines with the class name that you specified for the container in Step 4.

8. Click the red X in the top-right corner of the page to return to the page canvas.

The image still displays at its original size. The height and width properties are only applied when the page is run.
9. Optionally, on the canvas, select the container that contains the image and, on the Settings tab on the Properties panel, clear the Show title and Show toolbar check boxes to hide the container title and toolbar, so that the image is the only item in the container.

10. On the Visualization toolbar, click Run in new window to run the page and execute the JavaScript code that you just added.

The image stretches to fill the entire container at run time.

**TIBCO WebFOCUS Designer JavaScript API Classes**

As part of the WebFOCUS Designer JavaScript API, you can use the following predefined classes.

- **ibaObject**. The base automation object.
- **ibaAccordionContainer**. Accordion container automation object.
- **ibaCarouselContainer**. Carousel container automation object.
- **ibaContent**. Content panel automation object.
- **ibaPage**. Page automation object. The event iba_pageloading will be triggered on the global window object. event.data will be the ibaPage object.
- **ibaPanelContainer**. Panel container automation object.
- **ibaPortal**. Portal automation object.
- **ibaSection**. Page section automation object.
- **ibaTabContainer**. Tab container automation object.

A help plug-in with information about each class is packaged with your WebFOCUS installation. It is available through a URL at the following address:

http[s]://hostname:port/context/web_resource/doc/automation/index.html

where:

- **hostname**
  - Is the name of the machine on which the WebFOCUS Client is installed.

- **port**
  - Is the port number on which the server is listening.

- **context**
  - Is the context root of the WebFOCUS application. For example, *ibi_apps*.
Class: ibaObject

    new ibaObject(element)

Is the base automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

    element
    Is the node that is being automated.

Available methods include the following:

- **classId()**
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **customClasses(classes, remove)**
  Returns a string. Sets or gets custom classes.
  
  where:

    classes
    String.
    Optional. A space-separated list of classes to be added or removed.

    remove
    Boolean.
    Optional. If true, remove the classes specified in classes, otherwise add them.

- **element()**
  Returns an element, the DOM node that is being automated by this object.

Class: ibaPage

    new ibaPage(element)

Is the page automation object. Automation objects are created internally by the system. You never directly instantiate an automation object. The event iba_pageloading will be triggered on the global window object. event.data will be the ibaPage object.
where:

- **element**
  
  Is the node that is being automated.

The following triggers can be used with the page object:

- **event:iba_pageloaded.** The page is loaded in the running state.

- **event:iba_beforecontentdescribe.** Before the page content filtering information has been retrieved.

- **event:iba_contentdescribed.** After the page content filtering information has been retrieved, but before it has been processed.

- **event:iba_beforecontentload.** Before the content of a panel is about to load.

These are used in the following JavaScript syntax example:

```javascript
window.addEventListener("iba_pageloading", function (e){
  var page = e.data;
  page.element().addEventListener("iba_pageloaded", function(e){
    var page = e.data;
  });
  page.element().addEventListener("iba_beforecontentdescribe", function (e){
    var describeInfo = e.data;
    var path = describeInfo.path; // The path to the content being described
    // e.preventDefault() will stop the describe from happening
  });
  page.element().addEventListener("iba_contentdescribed", function (e){
    var describeInfo = e.data;
    var path = describeInfo.path; // The path to the content being described
    var wfDescribe = describeInfo.wfDescribe; // The filtering information of the
    // content being described
  });
  page.element().addEventListener("iba_beforecontentload", function (e){
    var loadInfo = e.data;
    var path = loadInfo.path; // The path to the content being described
    var defaultValues = loadInfo.defaultValues; // If default values are used to
    // run the content
    // e.preventDefault() will stop the page from retrieving the content
  });
});
```

If you add multiple pages with custom JavaScript to the same portal, the iba_pageloading event listener, for the global window object, will execute whenever any page in the portal loads. To execute your code only when a specific page loads, remove the event listener after the code executes for the desired page using the window.removeEventListener method.

The iba_pageloading event listener can be used to access the page being loaded, since it receives a page object as a parameter. The page object can be stored or used to assign additional event handlers to the page as shown below:
function onPageLoading(e) {
    var page = e.data;
    page.element().addEventListener("iba_pageloaded", function(e) {
        on load code
    });
    page.element().addEventListener("click", function(e) {
        on click code
    });
    window.removeEventListener("iba_pageloading", onPageLoading);
}

where:

function onPageLoading
    Is an iba_pageloading event listener function.

var page = e.data
    Accesses the page object via the event parameter.

on load code
    Code to be executed when the page loads.

on click code
    Code to be executed when the page is clicked.

window.removeEventListener("iba_pageloading", onPageLoading);
    Removes the iba_pageloading listener.

You can use the context member object to supply the context information for the page.

Available methods include the following:

- **addButton(options, sibling, before)**

    Returns an element, adding a button to the title bar of the page.

    where:

    options
        Object.

        One or more button options, which can include the following:

        - **icon.** A URL to an image file in .jpeg, .png, or .gif format.

        - **glyph.** A glyph or ligature, such as a Material icon.
- **glyphClasses**. Glyph classes. For example, 'material-icons'.
- **class**. Additional CSS classes.
- **tooltip**. A tooltip for the button.

**siblings**
Selector, element, or jQuery.
Optional. A sibling to add before or after. The default is Last.

**before**
Boolean.
Add button before or after the specified sibling.

- **addSection(options, sibling, before)**
  Returns an element, adding a section to the page.
  where:
  
  **options**
  Object.
  One or more section options, which can include the following:
  
  - **collapsible**. A Boolean value. When true, the section is collapsible.
  
  - **collapsed**. A Boolean value. When true, the section is created in a collapsed state.

  **siblings**
  Selector, element, or jQuery.
  Optional. A sibling to add before or after. The default is Last.

  **before**
  Boolean.
  Add the section before or after the specified sibling.

- **buttons(selector)**
  Returns the page title bar buttons as an array.
where:

`selector`

Selector, element, or jQuery.

Is the buttons selector. All is the default.

- `classList()`
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- `containers(selector)`
  Returns the page containers as an array.
  where:

  `selector`
  Selector, element, or jQuery.
  Is the containers selector. All is the default.

- `customClasses(classes, remove)`
  Returns a string. Sets or gets custom classes.
  where:

  `classes`
  String.
  Optional. A space-separated list of classes to be added or removed.

  `remove`
  Boolean.
  Optional. If true, remove the classes specified in `classes`, otherwise add them.

- `element()`
  Returns an element, the DOM node that is being automated by this object.

- `refreshFilters()`
  Use to redescribe the existing content and recreate filter panels.

- `removeButton(button)`
  Removes one or more buttons from the title bar of the page.
where:

- **button**

  Selector, element, or jQuery.

  Optional. Is a button selector. All is the default.

- **removeSection(selector)**

  Removes one or more sections from the page.

  where:

  - **selector**

    Selector, element, or jQuery.

    Optional. Is a section selector. All is the default.

- **sections(selector)**

  Returns the page sections as an array.

  where:

  - **selector**

    Selector, element, or jQuery.

    Is the section selector. All is the default.

- **title(title)**

  Sets the title of the page. If title is not passed, the title of the container is returned as a string or jQuery.

  where:

  - **title**

    String.

    Optional. Is the new title of the page.

**Class: ibaSection**

The ibaSection class extends ibaObject.

- **new ibaSection(element)**

  Is the page section automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.
where:

\textit{element}

Is the DOM node that is being automated.

Available methods include the following:

- \textbf{addContainer(\textit{type, title, col, row, colSpan, rowSpan})}

  Adds a new container to the section.

  where:

  \textit{type}

  String.

  Is one of the following container types:

  - 'pane'
  - 'tab'
  - 'accordion'
  - 'carousel'

  \textit{title}

  String.

  Is the container title.

  \textit{col}

  Integer.

  Optional. The column of the section to insert to. By default, the container is added to the first available column.

  \textit{row}

  Integer.

  Optional. The row of the section to insert to. By default, the container is added to the first available row.

  \textit{colSpan}

  Integer.

  Optional. The width of the container in columns. 3 is the default.
**rowSpan**

Integer.

Optional. The height of the container in rows. 5 is the default.

- **classList()**
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **collapsed(collapsed)**
  Makes the section collapsed, or returns the current collapsed state or a chainable automation object.
  
  where:

  - **collapsed**
    Boolean.

    Optional. If true, collapse the section. Otherwise, expand.

- **collapsible(collapsible)**
  Makes the section collapsible, or returns the current collapsible state or a chainable automation object.
  
  where:

  - **collapsible**
    Boolean.

    Optional. If true, make the section collapsible.

- **containers(selector)**
  Returns the containers in the section as an array.
  
  where:

  - **selector**
    Selector, element, or jQuery.

    An optional containers selector. All is the default.

- **customClasses(classes, remove)**
  Returns a string. Sets or gets custom classes.
where:

`classes`  
String.  
Optional. A space-separated list of classes to be added or removed.

`remove`  
Boolean.  
Optional. If true, remove the classes specified in `classes`, otherwise add them.

- **element()**  
  Returns an element, the DOM node that is being automated by this object.

**Class: ibaContainer**

```javascript
new ibaContainer(element)
```

Is the container automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

`element`  
Is the DOM node that is being automated.

Available methods include the following:

- **addButton(options, sibling, before)**  
  Returns an element, adding a button to the title bar of the container.

where:

`options`  
Object.  
One or more button options, which can include the following:

- **icon**. A URL to an image file in .jpeg, .png, or .gif format.
- **glyph**. A glyph or ligature, such as a Material icon.
- **glyphClasses**. Glyph classes. For example, 'material-icons'.
- **class**. Additional CSS classes.
- **tooltip.** A tooltip for the button.

  **sibling**
  
  Selector, element, or jQuery.
  
  Optional. A sibling to add before or after. The default is Last.

  **before**
  
  Boolean.
  
  Add button before or after the specified sibling.

- **addContent(path, description, replaceExisting)**

  Returns elements. Adds new content by replacing the content in the current content panel or adding a sub-panel.

  **where:**

  **path**
  
  String.
  
  Path of the content being added.

  **description**
  
  String.
  
  Description of the content being added.

  **replaceExisting**
  
  Boolean.
  
  Optional. When true, replace the existing content. When false, which is the default, add new content.

- **addMenuItem(options, sibling, before)**

  Returns an element, adding a menu item to the container menu.

  **where:**

  **options**
  
  Object.
  
  One or more menu item options, which can include the following:

  - **text.** The menu item text.
- **icon.** A URL to an image file in .jpeg, .png, or .gif format.
- **glyph.** A glyph or ligature, such as a Material icon.
- **glyphClasses.** Glyph classes. For example, 'material-icons'.
- **class.** Additional CSS classes.

`sibling`

Selector, element, or jQuery.

Optional. A sibling to add before or after. The default is Last.

`before`

Boolean.

Add the menu item before or after the specified sibling.

- **addMenuSeparator**(options, sibling, before)

  Returns an element, adding a separator to the container menu.

  where:

  - **options**
    
    Object.

    Menu separator options. You can use the class property to specify additional CSS classes.

  - **sibling**
    
    Selector, element, or jQuery.

    Optional. A sibling to add before or after. The default is Last.

  - **before**
    
    Boolean.

    Add menu separator before or after the specified sibling.

- **buttons**(selector)

  Returns the container title bar buttons as an array.

  where:

  - **selector**
    
    Selector, element, or jQuery.
Is the buttons selector. All is the default.

- **classList()**
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **contents(selector)**
  Returns the content panels in the container as an array.

  where:

  - selector
    Selector, element, or jQuery.

    Is the content selector. All is the default.

- **customClasses(classes, remove)**
  Returns a string. Sets or gets custom classes.

  where:

  - classes
    String.

    Optional. A space-separated list of classes to be added or removed.

  - remove
    Boolean.

    Optional. If true, remove the classes specified in classes, otherwise add them.

- **element()**
  Returns an element, the DOM node that is being automated by this object.

- **removeButton(button)**
  Removes one or more buttons from the title bar of the container.

  where:

  - button
    Selector, element, or jQuery.

    Optional. Is a button selector. All is the default.
Removes content from the container.

where:

```
selector
    Selector, element, or jQuery.
    Optional. Is a content selector. All is the default.
```

- **removeMenuItem(selector)**

Removes one or more menu items from the container menu.

where:

```
selector
    Selector, element, or jQuery.
    Optional. Is a menu item selector. All is the default.
```

- **removeMenuSeparator(selector)**

Removes one or more separators from the container.

where:

```
selector
    Selector, element, or jQuery.
    Optional. Is a menu separator selector. All is the default.
```

- **title(title)**

Sets the title of the container. If `title` is not passed, the title of the container is returned as a string or jQuery.

where:

```
title
    String.
    Optional. Is the new title of the container.
```

Class: `ibaAccordionContainer`

The `ibaAccordionContainer` class extends `ibaContainer`.

```
new ibaAccordionContainer(element)
```

Is the accordion container automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.
where:

**element**

Is the DOM node that is being automated.

Available methods include the following:

- **addButton**(options, sibling, before)
  
  Returns an element, adding a button to the title bar of the accordion container.
  
  where:

  - **options**
    
    Object.
    
    One or more button options, which can include the following:
    
    - **icon**. A URL to an image file in .jpeg, .png, or .gif format.
    
    - **glyph**. A glyph or ligature, such as a Material icon.
    
    - **glyphClasses**. Glyph classes. For example, 'material-icons'.
    
    - **class**. Additional CSS classes.
    
    - **tooltip**. A tooltip for the button.

  - **sibling**
    
    Selector, element, or jQuery.
    
    Optional. A sibling to add before or after. The default is Last.

  - **before**
    
    Boolean.
    
    Add button before or after the specified sibling.

- **addContent**(path, description, replaceExisting)
  
  Returns elements. Adds new content by replacing the content in the current content panel or adding a new accordion tab.

  where:

  - **path**
    
    String.
    
    Path of the content being added.
**description**

String.
Description of the content being added.

**replaceExisting**

Boolean.
Optional. When true, replace the existing content. When false, which is the default, add new content.

- **addMenuItem**(options, sibling, before)
  
  Returns an element, adding a menu item to the accordion container menu.

  where:

  **options**
  
  Object.
  One or more menu item options, which can include the following:

  - **text**. The menu item text.
  - **icon**. A URL to an image file in .jpeg, .png, or .gif format.
  - **glyph**. A glyph or ligature, such as a Material icon.
  - **glyphClasses**. Glyph classes. For example, 'material-icons'.
  - **class**. Additional CSS classes.

  **sibling**
  
  Selector, element, or jQuery.
  Optional. A sibling to add before or after. The default is Last.

  **before**
  
  Boolean.
  Add the menu item before or after the specified sibling.

- **addMenuSeparator**(options, sibling, before)
  
  Returns an element, adding a separator to the accordion container menu.
where:

- **options**
  - Object.
  - Menu separator options. You can use the class property to specify additional CSS classes.

- **sibling**
  - Selector, element, or jQuery.
  - Optional. A sibling to add before or after. The default is Last.

- **before**
  - Boolean.
  - Add menu separator before or after the specified sibling.

- **buttons(selector)**
  - Returns the container title bar buttons as an array.
  - where:
    - **selector**
      - Selector, element, or jQuery.
      - Is the buttons selector. All is the default.

- **classList()**
  - Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **contents(selector)**
  - Returns the content panels in the container as an array.
  - where:
    - **selector**
      - Selector, element, or jQuery.
      - Is the content selector. All is the default.

- **customClasses(classes, remove)**
  - Returns a string. Sets or gets custom classes.
where:

```classes```

String.

Optional. A space-separated list of classes to be added or removed.

```remove```

Boolean.

Optional. If true, remove the classes specified in `classes`, otherwise add them.

❑ `element()`

Returns an element, the DOM node that is being automated by this object.

❑ `removeButton(button)`

Removes one or more buttons from the title bar of the container.

where:

```button```

Selector, element, or jQuery.

Optional. Is a button selector. All is the default.

❑ `removeContent(selector)`

Removes content from the container.

where:

```selector```

Selector, element, or jQuery.

Optional. Is a content selector. All is the default.

❑ `removeMenuItem(selector)`

Removes one or more menu items from the container menu.

where:

```selector```

Selector, element, or jQuery.

Optional. Is a menu item selector. All is the default.

❑ `removeMenuSeparator(selector)`

Removes one or more separators from the container.
where:

`selector`
- Selector, element, or jQuery.
  - Optional. Is a menu separator selector. All is the default.

- **selectContent(selector)**
  Returns an element. Selects a content pane in the accordion container.
  where:

`selector`
- Selector, element, or jQuery.
  - Optional. Is a content selector. All is the default.

- **title(title)**
  Sets the title of the container. If `title` is not passed, the title of the container is returned as a string or jQuery.
  where:

`title`
- String.
  - Optional. Is the new title of the container.

*Class: ibaCarouselContainer*

The `ibaCarouselContainer` class extends `ibaContainer`.

`new ibaCarouselContainer(element)`

Is the carousel container automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

`element`
- Is the DOM node that is being automated.

Available methods include the following:

- **addButton(options, sibling, before)**
  Returns an element, adding a button to the title bar of the carousel container.
where:

**options**

Object. One or more button options, which can include the following:

- **icon.** A URL to an image file in .jpeg, .png, or .gif format.
- **glyph.** A glyph or ligature, such as a Material icon.
- **glyphClasses.** Glyph classes. For example, 'material-icons'.
- **class.** Additional CSS classes.
- **tooltip.** A tooltip for the button.

**Sibling**

Selector, element, or jQuery. Optional. A sibling to add before or after. The default is Last.

**before**

Boolean. Add button before or after the specified sibling.

- addContent(*path*, *description*, *replaceExisting*)

Returns elements. Adds new content by replacing the content in the current content panel or adding a new carousel slide.

where:

**path**

String. Path of the content being added.

**description**

String. Description of the content being added.

**replaceExisting**

Boolean.
Optional. When true, replace the existing content. When false, which is the default, add new content.

- **addMenuItem**(options, sibling, before)

  Returns an element, adding a menu item to the carousel container menu.

  where:

  - **options**
    - Object.
    - One or more menu item options, which can include the following:
      - **text**. The menu item text.
      - **icon**. A URL to an image file in .jpeg, .png, or .gif format.
      - **glyph**. A glyph or ligature, such as a Material icon.
      - **glyphClasses**. Glyph classes. For example, 'material-icons'.
      - **class**. Additional CSS classes.

  - **sibling**
    - Selector, element, or jQuery.
    - Optional. A sibling to add before or after. The default is Last.

  - **before**
    - Boolean.
    - Add the menu item before or after the specified sibling.

- **addMenuSeparator**(options, sibling, before)

  Returns an element, adding a separator to the carousel container menu.

  where:

  - **options**
    - Object.
    - Menu separator options. You can use the class property to specify additional CSS classes.

  - **sibling**
    - Selector, element, or jQuery.
Optional. A sibling to add before or after. The default is Last.

\textit{before}

Boolean.

Add menu separator before or after the specified sibling.

- \textbf{buttons(\textit{selector})}
  
  Returns the container title bar buttons as an array.

  where:

  \textit{selector}

  Selector, element, or jQuery.

  Is the buttons selector. All is the default.

- \textbf{classList()}
  
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- \textbf{contents(\textit{selector})}
  
  Returns the content panels in the container as an array.

  where:

  \textit{selector}

  Selector, element, or jQuery.

  Is the content selector. All is the default.

- \textbf{customClasses(\textit{classes, remove})}
  
  Returns a string. Sets or gets custom classes.

  where:

  \textit{classes}

  String.

  Optional. A space-separated list of classes to be added or removed.

  \textit{remove}

  Boolean.

  Optional. If true, remove the classes specified in \textit{classes}, otherwise add them.
- **element()**
  Returns an element, the DOM node that is being automated by this object.

- **removeButton(button)**
  Removes one or more buttons from the title bar of the container.
  where:

  - **button**
    Selector, element, or jQuery.
    Optional. Is a button selector. All is the default.

- **removeContent(selector)**
  Removes content from the container.
  where:

  - **selector**
    Selector, element, or jQuery.
    Optional. Is a content selector. All is the default.

- **removeMenuItem(selector)**
  Removes one or more menu items from the container menu.
  where:

  - **selector**
    Selector, element, or jQuery.
    Optional. Is a menu item selector. All is the default.

- **removeMenuSeparator(selector)**
  Removes one or more separators from the container.
  where:

  - **selector**
    Selector, element, or jQuery.
    Optional. Is a menu separator selector. All is the default.

- **selectContent(selector)**
  Returns an element. Selects a content pane in the carousel container.
where:

```javascript
selector
Selector, element, or jQuery.
Optional. Is a content selector. All is the default.
```

- title(title)
  Sets the title of the container. If title is not passed, the title of the container is returned as a string or jQuery.

  where:

  ```javascript
title
String.
Optional. Is the new title of the container.
```

Class: `ibaPanelContainer`

The `ibaPanelContainer` class extends `ibaContainer`.

```javascript
new ibaPanelContainer(element)
```

Is the panel container automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

```javascript
element
Is the DOM node that is being automated.
```

Available methods include the following:

- addButton(options, sibling, before)
  Returns an element, adding a button to the title bar of the panel container.

  where:

  ```javascript
  options
  Object.
  One or more button options, which can include the following:
  ```

  - icon. A URL to an image file in .jpeg, .png, or .gif format.
  ```

  - glyph. A glyph or ligature, such as a Material icon.
  ```

  - glyphClasses. Glyph classes. For example, 'material-icons'.
  ```
- **class.** Additional CSS classes.

- **tooltip.** A tooltip for the button.

**Sibling**

Selector, element, or jQuery.

Optional. A sibling to add before or after. The default is Last.

**before**

Boolean.

Add button before or after the specified sibling.

- **addContent(path, description, replaceExisting)**

Returns elements. Adds new content by replacing the content in the current content panel or adding a new panel.

where:

**path**

String.

Path of the content being added.

**description**

String.

Description of the content being added.

**replaceExisting**

Boolean.

Optional. When true, replace the existing content. When false, which is the default, add new content.

- **addMenuItem(options, sibling, before)**

Returns an element, adding a menu item to the container menu.

where:

**options**

Object.
One or more menu item options, which can include the following:

- **text.** The menu item text.
- **icon.** A URL to an image file in .jpeg, .png, or .gif format.
- **glyph.** A glyph or ligature, such as a Material icon.
- **glyphClasses.** Glyph classes. For example, 'material-icons'.
- **class.** Additional CSS classes.

**sibling**

Selector, element, or jQuery.

Optional. A sibling to add before or after. The default is Last.

**before**

Boolean.

Add the menu item before or after the specified sibling.

- **addMenuSeparator(options, sibling, before)**

  Returns an element, adding a separator to the container menu.

  where:

  **options**

  Object.

  Menu separator options. You can use the class property to specify additional CSS classes.

  **sibling**

  Selector, element, or jQuery.

  Optional. A sibling to add before or after. The default is Last.

  **before**

  Boolean.

  Add menu separator before or after the specified sibling.

- **buttons(selector)**

  Returns the container title bar buttons as an array.
where:

selector

Selector, element, or jQuery.

Is the buttons selector. All is the default.

楞 classId()楞

Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

楞 contents(selector)楞

Returns the content panels in the container as an array.

where:

selector

Selector, element, or jQuery.

Is the content selector. All is the default.

楞 customClasses(classes, remove)楞

Returns a string. Sets or gets custom classes.

where:

classes

String.

Optional. A space-separated list of classes to be added or removed.

remove

Boolean.

Optional. If true, remove the classes specified in classes, otherwise add them.

楞 element()楞

Returns an element, the DOM node that is being automated by this object.

楞 removeButton(button)楞

Removes one or more buttons from the title bar of the container.
where:

**button**

Selector, element, or jQuery.

Optional. Is a button selector. All is the default.

- **removeContent**(selector)

Removes content from the container.

where:

**selector**

Selector, element, or jQuery.

Optional. Is a content selector. All is the default.

- **removeMenuItem**(selector)

Removes one or more menu items from the container menu.

where:

**selector**

Selector, element, or jQuery.

Optional. Is a menu item selector. All is the default.

- **removeMenuSeparator**(selector)

Removes one or more separators from the container.

where:

**selector**

Selector, element, or jQuery.

Optional. Is a menu separator selector. All is the default.

- **title**(title)

Sets the title of the container. If *title* is not passed, the title of the container is returned as a string or jQuery.

where:

**title**

String.

Optional. Is the new title of the container.
Class: ibaTabContainer

The ibaTabContainer class extends ibaContainer.

```javascript
new ibaTabContainer(element)
```

Is the carousel container automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

`element`

Is the DOM node that is being automated.

Available methods include the following:

- **addButton**(options, sibling, before)

  Returns an element, adding a button to the title bar of the tab container.

  where:

  `options` Object.
  
  One or more button options, which can include the following:

  - **icon**. A URL to an image file in .jpeg, .png, or .gif format.
  - **glyph**. A glyph or ligature, such as a Material icon.
  - **glyphClasses**. Glyph classes. For example, 'material-icons'.
  - **class**. Additional CSS classes.
  - **tooltip**. A tooltip for the button.

  `sibling` Selector, element, or jQuery.
  
  Optional. A sibling to add before or after. The default is Last.

  `before` Boolean.
  
  Add button before or after the specified sibling.

- **addContent**(path, description, replaceExisting)
Returns elements. Adds new content by replacing the content in the current content panel or adding a new tab.

where:

- **path**
  - String.
  - Path of the content being added.

- **description**
  - String.
  - Description of the content being added.

- **replaceExisting**
  - Boolean.
  - Optional. When true, replace the existing content. When false, which is the default, add new content.

- **addMenuItems(options, sibling, before)**

  Returns an element, adding a menu item to the tab container menu.

  where:

  - **options**
    - Object.
    - One or more menu item options, which can include the following:
      - **text**. The menu item text.
      - **icon**. A URL to an image file in .jpeg, .png, or .gif format.
      - **glyph**. A glyph or ligature, such as a Material icon.
      - **glyphClasses**. Glyph classes. For example, 'material-icons'.
      - **class**. Additional CSS classes.

  - **sibling**
    - Selector, element, or jQuery.
    - Optional. A sibling to add before or after. The default is Last.
**before**

Boolean.

Add the menu item before or after the specified sibling.

- **addMenuSeparator(options, sibling, before)**

Returns an element, adding a separator to the tab container menu.

where:

**options**

Object.

Menu separator options. You can use the class property to specify additional CSS classes.

**sibling**

Selector, element, or jQuery.

Optional. A sibling to add before or after. The default is Last.

**before**

Boolean.

Add menu separator before or after the specified sibling.

- **buttons(selector)**

Returns the container title bar buttons as an array.

where:

**selector**

Selector, element, or jQuery.

Is the buttons selector. All is the default.

- **classId()**

Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **contents(selector)**

Returns the content panels in the container as an array.
where:

selector

Selector, element, or jQuery.

Is the content selector. All is the default.

- **customClasses**(classes, remove)

  Returns a string. Sets or gets custom classes.

  where:

  classes

  String.

  Optional. A space-separated list of classes to be added or removed.

  remove

  Boolean.

  Optional. If true, remove the classes specified in classes, otherwise add them.

- **element()**

  Returns an element, the DOM node that is being automated by this object.

- **removeButton**(button)

  Removes one or more buttons from the title bar of the container.

  where:

  button

  Selector, element, or jQuery.

  Optional. Is a button selector. All is the default.

- **removeContent**(selector)

  Removes content from the container.

  where:

  selector

  Selector, element, or jQuery.

  Optional. Is a content selector. All is the default.

- **removeMenuItem**(selector)

  Removes one or more menu items from the container menu.
where:

**selector**
Selector, element, or jQuery.
Optional. Is a menu item selector. All is the default.

- **removeMenuSeparator(selector)**
Removes one or more separators from the container.

  where:

  **selector**
  Selector, element, or jQuery.
  Optional. Is a menu separator selector. All is the default.

- **selectContent(selector)**
Returns an element. Selects a content pane in the tab container.

  where:

  **selector**
  Selector, element, or jQuery.
  Optional. Is a content selector. All is the default.

- **title(title)**
Sets the title of the container. If `title` is not passed, the title of the container is returned as a string or jQuery.

  where:

  **title**
  String.
  Optional. Is the new title of the container.

**Class: ibaContent**
The `ibaContent` class extends `ibaObject`.

```javascript
new ibaContent(element)
```

Is the content panel automation object. Automation objects are created internally by the system. You never directly instantiate an automation object.

where:

**element**
Is the DOM node that is being automated.
Available methods include the following:

- **classId()**
  Returns a string, which is the unique, automatically generated class ID of the object being automated. It can be used to filter enumerations.

- **customClasses(classes, remove)**
  Returns a string. Sets or gets custom classes.
  where:
  - **classes**
    String.
    Optional. A space-separated list of classes to be added or removed.
  - **remove**
    Boolean.
    Optional. If true, remove the classes specified in classes, otherwise add them.

- **element()**
  Returns an element, which is the DOM node that is being automated by this object.

- **path()**
  Returns the path of the content as a string.

**Adding Panels to a Responsive Container**

You can utilize responsive panel in panel behavior by adding items to a panel group container. When you run the page, top-level containers in the page, including the panel group container, fold responsively based on the size of the browser, and the panels within the panel group container fold based on its current size, independent of the rest of the page. Additionally, items in the panel group container are kept together when folding occurs, making the panel group container a good way to group together closely related content that you want to be visually separated from the other items on the page. This is particularly true when related items are arranged vertically, as items typically wrap based on rows.

To create a panel group container, click the Container tab on the sidebar, select the Panel group container, and drag it onto the canvas. You can then resize it like any other container.
To add a panel to a panel group container, drag a new content item or another container from the Container tab on the sidebar into it. You can then resize the new container inside the panel group container. You can also add an existing container on the page to a panel group by holding the Ctrl key and dragging the container into it.

Once you have created it, you can right-click an area of blank space within the panel group to duplicate it, delete the panel group and its contents, or remove the panel group but keep its constituent containers on the page. You can also right-click an item and click Move to canvas to remove it and any other concurrently selected panels from the panel group container. The item is moved to a nearby, empty area of the page. If you selected multiple panels inside a panel group, then they are placed on the canvas near the panel that you right-clicked.

You can also select the panel group and use the Properties panel to add a toolbar and title to the panel group container. Properties applied to the entire page or to the panel group container, such as margins or styling, affect all panels within it, unless specifically overridden.

**Linking to External Content From a Page**

The link tile widget provides additional innovative ways of using your content and incorporating it into your page. The link tile widget layers content in such a way that one content item becomes a click-through tile that opens another content item. This feature is especially useful when you need to incorporate a large or Insight-enabled item into a page and display it on all devices. The link tile widget can be used in pages assembled from existing content.
To add a link tile to a page, drag the link tile object from the Resources panel with Container selected on the sidebar. You configure a link tile using the Settings tab of the Properties panel, as shown in the following image.

When adding a link tile widget to a page, you configure the content that you want to display on the page using the Background property, the item that you want to link to using the Content property, and the location in which to open the linked content using the Target property. You can also add a tooltip to the link tile container to provide a description of the target content, providing information about what happens when a user clicks the link tile.

If the link tile background content is a procedure, filters can be created for and applied to it just like any other content item. The background behaves as a static image, so interactive features, such as chart tooltips or hyperlinks, are not enabled. Link tile target content can include WebFOCUS charts, reports, and pages, URLs, ReportCaster schedules, and more.
**Procedure: How to Use the Link Tile Widget**

1. Assemble a new page from existing content, or open an existing page in WebFOCUS Designer.
2. On the sidebar, click the **Container** tab.
3. Drag a link tile container from the Resources panel onto the page. The link tile container initially appears blank.
4. With the link tile selected on the page, expand the Link Tile area of the Settings tab on the Properties panel.
   
   **Note:** The link tile container does not include a title bar by default, so clicking the link tile on the canvas may only allow you to select the link tile background content. To select the link tile container more easily, use the outline.
5. In the Link Tile section of the Settings tab, click the ellipses button next to the Background option and navigate to the item from your repository that you would like to display in the link tile.
   
   You can select a FOCEXEC procedure such as a chart or report, a page, an image, a URL, an HTML page, and more. The item behaves as an image, so interactive features such as tooltips are not enabled.
6. Click the ellipses icon next to the Content option and select the target item. This content will run when users click on the link tile panel.
7. Optionally, select the **Tooltip** check box and type a description into the text box to provide information about the link tile target content.
8. Select the **Attach all parameters** check box if parameter filter selections from the page should be passed to the target content, or leave it unselected to open the target content without passing filter selections.
9. Determine how the target item will display. Select **Viewer** to run the target content item in an overlay on the same browser tab as the link tile, or select **New window** to run the item in a new browser tab.
10. Run the visualization using the Run in new window button to test the link tile behavior.
When you click the link tile, your target content opens as configured.

Enabling Container Customization

When creating a page with external content, you can enable users to select content to display at run time, which can make portal pages more engaging, useful, and interactive. With this feature you can also control which items users can access, by assigning a specific path to the Add content button in the Properties panel. This feature can be used with panel, tab, carousel, and accordion containers. If you enable this feature on a multi-content container, the Add content button automatically appears on every new tab, slide, or area. If you combine a container that is unlocked for container customization with another container, container customization is turned off in the resulting combined container.

Procedure: How to Configure the Container Customization Properties

1. In a visualization using external content, drag an empty panel or a content item onto the canvas.
2. With the panel or content item selected, in the Properties panel, on the Settings tab, disable the Lock container option.
   
   If you used an empty panel, the Add content icon displays in the middle of the selected panel.
3. If you want to direct your selection to a specific area in the repository, click the ellipses next to the Select content from property to select a default workspace or folder that you want to display for content selection at run time.
4. Keep the Lock path option selected, if you want to limit your selection to the path specified in the previous step. Otherwise, users can navigate to other workspaces to access content there in addition to the default path.
5. Optionally, select the Flatten list option, if you want to hide the folder hierarchy inside your selection area and only display items.
6. Optionally, select the Hide tags option, if you want to hide all tags from your selection area.
7. Configure the Initial View option, choosing either Grid or List, to set the initial appearance of the window where users select the content to display.

   Note: Users can change the view at run time inside the Select Item dialog box.
The following image shows an example of the configured Container Customization properties.

8. Save the page.

**Procedure:** How to Select Content at Run Time

1. Run the page that features interactive panels.
2. Click the Add content button, as shown in the following image.

If you enabled container customization for a container with content in it, click the Options menu and then click Replace, as shown in the following image.

The Select Item dialog box opens.

If the Lock path option is disabled, you can navigate between workspaces using the breadcrumb trail.

If the Flatten list option is disabled, you can navigate between the folders within the selection area hierarchy.

You can also use the search function, toggle between the Grid and List views, and refresh your selection area.
3. Make a selection and click *Add*.
   The selected item displays inside the panel.

4. To go back to the initial view of the interactive panel, click *Options*, and then click *Remove*, as shown in the following image.

   ![Stacked Bar - Sales by Month and Product Category](image1)

   The item is removed from the panel, and the *Add content* button displays.

5. To replace an item with another item, click *Options*, and then click *Replace*, as shown in the following image.

   ![My Dashboard](image2)

   The Select Item dialog box opens, and you can make a new selection.
**Note:** When the page is used in a portal, content customization changes that the user makes at run time to unlocked containers are remembered if the user has the Save Portal Customization privilege. If the user does not have this privilege or if the content customization changes are made to a standalone page, these changes are not remembered by WebFOCUS.

### Providing Access to Content Items and TIBCO WebFOCUS Tools

When assembling pages from existing content in WebFOCUS Designer, two preset containers are available that allow you to provide access to content saved to your Repository. These are the Workbench template and the Explorer widget. In addition to running content, the Explorer widget allows users to create new content using the same options that are available on the WebFOCUS Hub and Home Page.

The Workbench template provides a resource tree that is linked to another container on the page, using the CSS class `targetContainerForWorkBenchTree`. You can select the Workbench template from the Choose Template dialog box when you start assembling a page from existing content. It is not recommended to delete either of the containers that are added as part of the template, but if you right-click the target container and point to **Convert to**, you can change it from a tab container to a basic panel, or to an accordion or carousel container. You can also change the theme used in the page and the styles used by each of the containers. Content that you run in the workbench target container inherits the theme used in the page automatically.

When you run the page, you can run content items from your Repository, listed in the resource tree, in the section of the target container that is currently visible, by double-clicking them or by right-clicking them and clicking **Run**. To run an item in a new section of a tab, accordion, or carousel container, right-click it and click **Run in New Area**. This option is not available if you change the target container to a basic panel. Running items in a new area allows you to see the items that you previously ran by returning to the tab, accordion panel, or carousel slide where you ran them. If the items that you run include parameter filters, you can access filter controls in a modal window by clicking **Show filters** on the page toolbar. Note that if links within content items, such as drilldowns, links generated by Auto Linking, or hyperlinks in a web page, are set to run in a new browser tab or window, they will continue to do so when you access them in the workbench output container. Only content items accessed from the workbench resource tree run in the target container.
Another way to provide access to content in your repository from an assembled page is by using the Explorer widget. You can use the Explorer widget to provide access to the Workspaces area of the Hub or Home Page. This allows anyone accessing the page, or a portal containing the page, to open and run content items and create new content, depending on their privileges. To add the Explorer Widget to a page, select the Container tab on the sidebar and drag it onto the canvas. When you run a page with the Explorer widget, you can use it to navigate through workspaces, folders, and content items from the Resources tree and Content area, and create new content using options in the +Content menu. When an administrator uses the Redirect /ibi_apps to option in the Administration Console to enable a custom welcome page with the Explorer widget, you can provide an enhanced home page combining all of the options available from the Workspaces view with custom content of your choice.

By default, the Workbench template and Explorer widget fill the entire page in order to provide ample space to display any content items and content creation options. As a best practice, leave the Workbench template containers or Explorer widget as the only items on a page, and add that page to a portal with other pages whose contents you want to display.

Note that if you created pages with the Explorer widget in a prior release, some Hub or Home Page features may not be available when run in Release 8207. Open the page in WebFOCUS Designer, and replace the old Explorer widget with the new one to use the updated version.

**Procedure:** How to Use the Explorer Widget

You can add the Explorer widget to a page assembled from existing content.

1. On the WebFOCUS Hub or WebFOCUS Home Page, click the plus menu and then click **Assemble Visualizations**.
   
   WebFOCUS Designer opens.

2. In the Choose Template dialog box, select the **Blank** template.

3. From the **Container** tab on the sidebar, drag the **Explorer** widget onto the canvas.
   
   The widget displays on the page and incorporates the full display of the Workspaces view of the Hub or Home Page.

4. Click the maximize button on the Explorer widget container to fill your page.

5. Optimize the look of the page by removing the page and container titles and toolbars. Select the Explorer widget container and, on the **Settings** tab, clear the **Show title** and **Show toolbar** check boxes.
   
   Optionally, select the entire page and clear the **Show page heading** and **Show page toolbar** check boxes to show only the Explorer widget on the page.
An example of a completed page is shown in the following image.

6. Save your page.

The page can now be added to a portal as described in *Defining a Portal Structure* or used as a standalone item.
Creating Custom Templates

When you assemble a page from existing content in WebFOCUS Designer, the first step is to select a page template. WebFOCUS Designer provides a selection of preset templates, as shown in the following image.

Select the Blank template to start with a blank canvas to which you can add, reposition, and resize containers on your own. The Grid 2-1, Grid 2-1 Side, Grid 3-3-3, and Grid 4-2-1 templates provide a set of containers that are prearranged on the page. The InfoApp 1 template provides a collapsible filter panel and movable filter grid to which you can add filter controls, which are generated when you add parameterized content to the page. The Workbench template provides a resource tree that you can use to navigate to content items in your repository, which you can then run in the target container on the right.

In addition to the default templates that WebFOCUS Designer offers, you can create custom templates that reflect your unique layout. They are a great way to add structural variation or highly customized layouts to your page. Custom templates are also useful for organizations that have a set style for all of their pages. You must have administrator access to WebFOCUS to deploy custom templates.

Procedure: How to Create a Custom Template for WebFOCUS Designer Pages

1. Create a new page. On the WebFOCUS Hub or the WebFOCUS Home Page, click the plus button.
2. Click Assemble Visualizations.
   
   WebFOCUS Designer opens, and you are prompted to select a template.
3. Select one of the default templates that you want to use as the starting point for your custom template, to click Blank to build a new template from scratch.
4. Modify the page layout to reflect your preferences. For example, insert new sections, customize the sizing of each row in the template.

5. Save your new page to any folder and exit WebFOCUS Designer.

6. Optionally, apply a custom thumbnail to your template page. If you do not assign a custom thumbnail, the default thumbnail WebFOCUS associates with pages will display.

7. In the Workspace area of the Hub or Home Page, expand the Global Resources folder, and then expand the Page Templates folder.

   Two folders display inside the Page Templates folder: Standard and Custom.

8. Copy your new template page from its initial directory and paste it inside the Custom folder.

   The next time you launch WebFOCUS Designer using the Assemble Visualizations option, your custom template appears, as shown in the following image.

![Choose Template]

Once a custom template is created, you can configure access to it by using security rules to hide it from specific groups of users. To learn more about working with security rules, see the TIBCO WebFOCUS® Security and Administration manual.

**Passing Parameter Values to a Page**

When a page includes content with dynamic parameter filters, you can pass parameter values to it from external content to set the filter values when the page initially loads. For example, you can create a chart or report with drill-down links that points to the page, and configure the drilldowns in such a way that the value the user clicks in the chart or report is used as a filter value in the page. This allows users to navigate between content items and determine the scope of the information that they want to see.
If the page is the target of a link tile in another page, parameter values in the source page are passed to the target page automatically if the Attach all parameters option is enabled and the same parameter filters are present. This allows users to see the same set of values in the target page without having to set filter values again.

Parameter values can also be passed to a page using parameter name-value pairs in the run-time URL. The run-time URL uses the following format:

```
http[s]://hostname:port/context_root/run/path_to_item/?
&variable_name1=variable_value1&variable_name2=variable_value2
```

where:

- **hostname**
  - Is the name of the system where WebFOCUS is installed.

- **port**
  - Is the port number used by WebFOCUS.

- **context_root**
  - Is the context root used for your WebFOCUS application. For example, ibi_apps.

- **path_to_item**
  - Is the IBFS path of a page in your WebFOCUS repository. You can find the path of a page by right-clicking it on the WebFOCUS Hub or WebFOCUS Home Page and clicking Properties. The file path is listed as the Path property.

  Slashes (/) between folder names should be retained literally instead of encoded in the URL, and the colon (:) should be removed after IBFS. For example:

  ```
  http://localhost:8080/ibi_apps/run/IBFS/WFC/Repository/My_Workspace/~user/example_page
  &variable_name1=variable_value1&variable_name2=variable_value2
  ```

  Are one or more parameter name-value pairs. To pass multiple values to a multiselect parameter in the page, separately list the same parameter name multiple times with each distinct value. For example, the URL,

  ```
  http://localhost:8080/ibi_apps/run/IBFS/WFC/Repository/My_Workspace/~user/example_page?&TIME_YEAR=2018&TIME_YEAR=2019
  ```

  passes 2018 and 2019 to the &TIME_YEAR parameter.

**Note:** If multiple filters in a page use the same amper variable name, for example, if they come from different data sources, the value or values defined in the URL are passed to each of these filters.
Procedure: How to Pass Parameter Values to a Page Using a URL Drilldown

You can drill down from a chart or report procedure to a page created in WebFOCUS Designer. Drill-down parameters can be passed to the page to apply their values to any page filters.

1. Create and save a page that includes prompted filters. These filters can be created by adding parameterized external content to an assembled page and clicking Add all filters to page in the Filters tab of the sidebar, or can be created in a page with new content by dragging a field to the Filter toolbar.

The filters in this page will be populated with values passed from a drill-down report.

For information on creating a page, see Creating Pages on page 784.

2. Create a new report in InfoAssist.

On the Hub or Home Page, in the Workspaces view, click the +Content button, point to InfoAssist, and click Report or Chart.

InfoAssist opens and you are prompted to select a data source.

3. Select the same data source that was used to filter the page, and click Open.

The report or chart canvas appears.

4. Create content that is sorted by the same fields that are used as filters in the page. For example, if the page is filtered by Customer Business Region and Sale Year, create a report with those fields in the row bucket. Add other measures and dimensions to your content based on your needs and preferences.

5. Select an element of the chart or report to which to add drill-down links.

If you are passing multiple parameter values through the drilldown, selecting a section of the chart or report that represents multiple sort values may help clarify to the user which values will be passed.
For example, in the report shown in the following image, the Sale Year field is the secondary sort field while Customer Business Region is the primary sort field, so each row in the Sale Year column represents a sale year and a business region.

<table>
<thead>
<tr>
<th>Customer Business Region</th>
<th>Sale Year</th>
<th>Quantity Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>2014</td>
<td>115,367</td>
<td>$32,608,030.34</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>132,574</td>
<td>$39,630,841.14</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>193,158</td>
<td>$57,591,488.69</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>255,468</td>
<td>$76,647,406.85</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>464,797</td>
<td>$140,440,022.62</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>699,498</td>
<td>$215,398,344.26</td>
</tr>
<tr>
<td>North America</td>
<td>2014</td>
<td>46,386</td>
<td>$13,060,621.95</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td>61,246</td>
<td>$18,287,269.34</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>92,483</td>
<td>$27,473,407.52</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>147,038</td>
<td>$43,907,888.55</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>426,176</td>
<td>$128,662,736.78</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>694,386</td>
<td>$212,755,358.69</td>
</tr>
<tr>
<td>Oceania</td>
<td>2015</td>
<td>56</td>
<td>$14,736.30</td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>165</td>
<td>$48,743.31</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>374</td>
<td>$104,323.54</td>
</tr>
<tr>
<td></td>
<td>2018</td>
<td>1,321</td>
<td>$424,709.91</td>
</tr>
<tr>
<td></td>
<td>2019</td>
<td>6,481</td>
<td>$1,970,040.66</td>
</tr>
</tbody>
</table>

In this case, adding the drill-down links to the Sale Year column would allow you to choose from all of the available Customer Business Region and Sale Year values, whereas adding the links to the Customer Business Region column would only allow you to pass parameter values for the first sale year in each business region group. As an alternative to creating drilldowns on the lower level sort field, you could ensure that all parameter values are passed from a report by using repeating sort values. On the Format tab, in the Features group, click Repeat Sort Value.

6. On the Field tab, in the Links group, click Drill Down.

The Drill Down dialog box opens.

7. Change the drilldown type to a URL drilldown by selecting the Web Page radio button.
8. In the URL text box, type the run-time URL for the target page, without the parameters, using the format described above.

The URL format should resemble the following:

http[s]://hostname:port/context_root/run/path_to_page

You can get the path to the page by right-clicking it on the Hub or Home Page and clicking Properties. It displays as the Path property. When you add it to the run-time URL for the drilldown, remember to remove the colon (:) after IBFS.

9. In the Description text box, type the name of the drilldown. This name displays in the tooltip from your content.

10. In the Target drop-down menu, select the location where the target page should run. It can be in a new tab, the same window where the report was run, or a user-specified location.

11. In the Parameters section, click Add Parameter to create a parameter to pass to each filter on the target page that you wish to populate.
   a. In the Name text box, type the name of the parameter. Typically, this matches the field name. You can check the parameter names used in an assembled page by clicking the Info button.
   b. From the Type menu, choose whether the value to pass should be the field value associated with the user drill-down link selection, or a constant value.
   c. If you selected Field, use the Value menu to select a field from your content. If you selected Constant, type a constant value to pass to the page.

12. Repeat step 11 for all parameters whose values you want to pass to the target page, then click OK to create the drilldown.

In a report, drill-down links are added for each value of the field where the drilldown was created. In a chart, you can access drill-down links in a tooltip at run-time.

13. Run the chart or report.

14. At run-time, drill down to the target page.

   - If you created a chart, point to a section of the chart and click the drill-down link in the tooltip.
   - If you created a report, click a drill-down link. If that field of the report has multiple drilldowns associated with it, select the drilldown that you just created.

15. The page opens in a new browser tab or window. Notice that the value or values represented by your selection in the parent content item are applied as filter values in the page.
**Bookmarking Control Selections in a Page**

Bookmarking allows users to save filter control selections and other run-time content customizations that they make in a page so that they can easily reapply them when they run the page again later. This is especially useful when there are many filter controls on a page that a user may want to apply each time they access it. Bookmarks are personal to each user and can easily be created and deleted as needed.
Bookmarking is enabled automatically once the page has been saved, and is available in authored pages created with new content and in assembled pages built from existing content. To add a bookmark, make some filter selections when running a page, and then click the Bookmarks button, which appears on the page toolbar at run time. You are prompted to type a name for the bookmark. Click OK to apply it. A maximum of 46 characters display for each bookmark name. Once applied, the bookmark is added to the list, which you can open by clicking the drop-down menu arrow next to the Bookmarks button. Select a bookmark from the list to refresh the page and apply the associated set of filter values. The bookmark list also includes the Original page option, which reloads the page with the default filter values selected. From the bookmark list, you can also use the menu for each existing bookmark to rename or delete the bookmark, or make it your personal default set of filter values when you load the page, as shown in the following image.

Each user can create a maximum of ten personal bookmarks for a page. If you reach this limit on a page, delete an existing bookmark to add a new one. The Original page bookmark is always available and cannot be deleted.
Exporting a Page as a PDF or Image

Bookmarks also save certain user customizations made in the page. For example, if you use on-chart filtering in an authored page at run-time to create a new filter, you can create a bookmark to save it. In authored pages, you can also change the filter condition from included values to excluded values and change the aggregation operation, and in assembled pages, you can change the content that displays in unlocked containers. All of these changes are saved when you create a new bookmark.

Exporting a Page as a PDF or Image

You can instantly download a snapshot of your page as a PDF document or .png image using the Export to file menu on the page toolbar. This allows you and anyone running the page to quickly capture its current state, with filter selections applied, in a format that can be easily reused, distributed, added to PowerPoint presentations, and more. The ability to capture a snapshot at design time allows you to quickly capture multiple visual representations of your data as you develop your content, while the ability to capture a snapshot at runtime allows you or a user running the page to save images of it with the currently selected filter values.

When designing or running the page, the Export to file menu appears on the page toolbar by default. Click it to display options to download a snapshot of the page as a PDF or image, as shown in the following image.

The .pdf or .png file is downloaded using your browser. The file can be opened immediately and saved to distribute and reuse later.

The snapshot that is produced is a run-time representation of your content with styling and filtering, including on-chart filtering, applied. Since the exported file is an image, it is not interactive, so tooltips, scrolling, and other behavior are unavailable.

You can change the export options that are visible on the page toolbar. Select the entire page, then open the Settings tab. The Show export option and PDF and Image options are selected by default. Clear the PDF or Image check box to change the format available when exporting the page. If only one format is enabled, the Export to file option on the page toolbar changes from a menu to a button. You can also clear the Show export check box to remove the export option from the page.
The following considerations may affect page export behavior:

- If a container is maximized when you export the page, then only that container displays in the exported image or PDF file.

- Content in containers on a page may not appear correctly when exported from Internet Explorer.

- When exporting a page from Microsoft Edge, ensure that the containers on the page are large enough to display their contents without scroll bars. Otherwise, the content may overlap.

- XML files and procedures with an XML output format added to a page produce an error when exporting.

- Certain chart extensions, for example, the Sparkline KPI, KPI with Sparkline Large, and KPI Table extensions, may not render correctly in an exported page.

- If a container on a page contains a URL that does not have the same protocol, host name, and port number as that of the environment from which the page is run, the export cannot be performed due to same-origin policy restrictions.

- If a page has too many rows to fit onto a single page of a PDF document, then containers and their contents may be split by page breaks in the exported file.

- PDF documents in containers on a page, including charts and reports with a PDF output format, do not display when the page is exported.
Exporting a Page as a PDF or Image
Chapter 5

Building Portal Applications

The new generation WebFOCUS Portal is an analytical content management system that provides a flexible and interactive environment for both authors and consumers of data analytics. It allows users to access and share content, customize their portal experience, collaborate, and build sophisticated structures for data storytelling.

The key benefits of the portal are:

- Multi-level page navigation, which is especially useful in organizing large numbers of pages.
- Flexible page layout options for dashboards and InfoApps™.
- Mobile-friendly design that ensures responsive behavior on any device and with any type of content.
- Built-in page filter that is automatically enabled whenever users display parameterized content on a personal page.
- Modern styling featuring clean and streamlined UI and customizable themes.

In this chapter:

- Creating Portals
- Defining a Portal Structure
- Running Portals
- Targeting a Page to Open When Running a Portal
- Enabling and Sharing Personal Pages
- Customizing Portals
- Applying Themes to Portals
- Adding Icons to Portal Levels
- Customising User Menu Options
- Using a JavaScript Function to Navigate to a Designer Portal Page
- Configuring Dynamically Customized Designer Portals for Multiple SaaS Tenant Groups
Creating Portals

You can create a portal structure in your repository, which you can populate by adding pages. You can also configure the option for users to create personal pages.

Procedure: How to Create a Portal

1. In the Workspaces area, in the Resources tree, select the workspace or folder where you want to create the portal, click the +Content button, point to Application, and then click Portal.

The New Portal dialog box opens. There are three tabs in the New Portal dialog box:

- Properties
- Layout Options
- User Menu Options

2. Populate the fields of the Properties tab.

The following fields are available:

- **Title.** The title of the portal.
- **Name.** The name of the portal. This field is populated automatically to match the Title field. You can edit the field with a custom name, if you want.
- **Alias.** Creates an alias for your portal.
- **Maximum width.** Controls the maximum width of the portal, which includes the banner, all pages, and side navigation. If specified, overrides the Maximum width property set for pages in the portal.

  **Note:** The placeholder text changes to a pixel value when you enter a number.

- **URL.** A read-only field that displays the URL for the portal.

  **Note:** When you type an Alias value, the URL field automatically changes to reflect the new location.

- **Theme.** Allows you to select themes that can be customized.
An example of the Properties tab that has been populated with information is shown in the following image.

![New Portal](image)

3. Make your selections in the Layout Options tab.

   The following options are available:

   
   - **Banner.** Provides access to the following options:
     
     - **Enable banner in portal.** Activates the banner for your portal.
     
     **Note:** It is recommended to disable the banner if you plan to embed your portal into a third-party application.
If this option is enabled, the following options become available:

- **Enable top navigation in banner.** If selected, displays the folder structure as banner links rather than tabs. This option is only available for Top Navigation and Top & Side Navigation layouts.

- **With banner title.** When selected, displays the title of the portal in the banner.

- **With banner logo.** When selected, displays the portal logo in the banner.

- **Custom logo.** Allows you to customize a logo for your portal.

  If this option is enabled, the following options become available:

  - **Custom logo tooltip** Allows you to specify the tooltip text for your custom logo.

  - **Enable logo URL destination to return to default portal page.** If enabled, make your custom logo a clickable object that reverts the portal view to the default portal page.

  - **Custom logo URL destination.** If enabled, allows you to specify a custom URL that will display when your custom logo is clicked.

**Note:** You can go back to displaying the default TIBCO logo in your portal banner at any time, by clicking the *Reset to default logo* link.
An example of the Layout Options tab is shown in the following image.

4. Make your selections for the User Menu Options tab.

The following options are available.

- **Enable Create My Pages Menu.** If selected, enables users to create personal pages at run time.

- **Enable User Menu.** If selected, displays a user menu inside your portal and allows you to select which options will display in this menu.

  The following user menu options are available: Administration, Tools, Preferences, Help, Remove my customizations, Change Password, and Sign Out.

  **Note:** These options are subject to user permissions. To learn more about these options, see the Navigating Your WebFOCUS Environment technical content.
An example of the User Menu Options tab is shown in the following image.

5. Click *Create*.

The new portal structure is created in the specified workspace or folder. It is now ready to be populated with folders, pages, and shortcuts that serve as links to other pages.

6. To edit your portal, right-click it, and then click *Edit*.

The Edit Portal dialog box opens, where you can change your selections.
Defining a Portal Structure

Each portal is a conglomerate of various parts that you can use to make your portal a comprehensive representation of your data narrative. For example, you can add pages to your portal to showcase data. You can create sections and sub-sections to better organize your content. The structure of a portal can be as simple or as complex as required by your specific purpose. There are three content types that you can add to a portal:

- Folder
- Page
- Shortcut to a page

You can use these elements to define a portal structure by building a simple folder hierarchy.

**Procedure:** How to Define a Portal Structure Using Content

1. Create a portal as described in *Creating Portals*.
2. In the Workspaces area, in the Resources tree, select the portal you want to modify.
3. Using the +Content menu and the plus button, add content to create a portal navigation layout of your choice.

   You can create pages and folders to populate your portal. You can also use the Shortcut feature to link existing standalone pages to your portal.
The images below show an example of the initial view of the portal that consists of pages and folders.

These Folders and Pages Will Appear as Links and Tabs at Run Time

Portal Navigation at Run Time
When tabs or links overflow beyond the width of a page, an ellipsis icon displays allowing you to access the entire list of tabs or links, as shown in the following image.

4. Optionally, add more folders, subfolders, and pages to your portal.

The image below shows an example of how folders, subfolders, and pages make up the structure of a portal.

5. Once your portal is complete, you can publish it and make it available to other users.

**Procedure:** How to Use Shortcuts to Add Pages to a Portal

1. In the Resources tree, select a portal you want to modify.
2. Navigate to the level inside the portal where you want to add a page.
3. In the +Content menu, point to Other, and click Shortcut.
   The Select dialog box opens.

4. Using the breadcrumb trail, navigate to the page you want to add to your portal and click it.
   Notice that the Title and Name fields are inactive, as shown in the following image.

![Select dialog box](image)

5. Click Select.
   The page displays inside the portal structure with the Shortcut icon added to its page icon.

6. To change the page title, right-click the page, click Properties, edit the Title field in the Properties panel, and then click Save.
   The new page title displays.

**Running Portals**

You can run a portal from the following locations on the WebFOCUS Hub:

- Resources tree in the Workspaces area.
- Content section in the Workspaces area.
- Portals area of the Hub.

To run a portal, right-click it then click Run.
An example of a portal at run time is shown in the following image.

You can perform the following actions in the portal at run time:

- Navigate between pages and levels.
- Interact with content, including Insight-enabled items.
- Collapse the side navigation panel to maximize the space on a page.

To collapse the side panel, click the Collapse navigation arrow as shown in the following image.
This option is available in Two-level side and Three-level layouts.

- Add personal pages.

  To add a personal page, navigate to the My Pages level, and click the + icon, as shown in the following image.

- Select a layout for your personal page.

- Populate your personal page with content available to you in your repository.

  To add a content item to the personal page, click the Add content icon, as shown in the following image, and, in the Select Item dialog box, navigate to the item of your choice.

- Use the built-in filter window to refine your personalized content.

- Use the Bookmark feature to save a specific filtering configuration of your personal page.

- Share your personal pages with other users and groups in your organization.

- Use the User menu to access the utilities, help, and administrative settings that are available to you based on your role.

**Targeting a Page to Open When Running a Portal**

You can target a specific page or sub-page, while running a portal from an alias URL. This URL can then be saved and bookmarked similarly to any other page on the web. To learn more about creating an alias, see *Creating Portals*. 
Procedure: How to Target a Page to Open in a Portal at Run Time

1. Create a portal as described in Creating Portals, making sure to give your portal a unique alias.

   **Note:** If your exact alias already exists in the repository, you will not be able to save your portal. Modify the name of your alias to save your portal and close the New Portal dialog box.

2. Populate your new portal with levels, as described in Defining a Portal Structure.

3. Generate a URL to the level of your choice by applying the following sequence:

   \[ \text{http[s]}://\text{hostname:port}/ibi_apps/portal/\text{portal_alias}/\text{page}_2 \]

   where:

   \text{hostname:port} \\
   Are the host name and HTTP port of the web server or application server.

   \text{portal_alias} \\
   Is the name of your alias.

   \text{page}_2 \\
   Is the name of the level that you want to open when your portal runs.

In our example, we want the second tab to open when the portal runs. Follow these steps to achieve this result:

1. Locate the level within the portal structure that corresponds to the tab that you want to open at run time.

   In our example, we locate the Reports folder, as shown in the following image.

2. To easily locate the alias link, right-click your portal, click *Edit*, and copy the URL field value, as shown in the following image.
3. In a new browser window, paste your alias URL in the address bar, add / and the name of your level at the end of your URL, in our case /Reports.

Your URL is ready to be run.

4. Press Enter to run your URL.

The portal runs and opens the level that we selected, as shown in the following image.

![Image showing a portal with Reports sub-level selected](image)

5. Optionally, bookmark this URL for future use.

**Procedure:** How to Target a Sub-page to Open in a Portal at Run Time

By default, when a portal runs, the first page of the first tab displays. You can change this behavior by creating a direct link to a specific sub-level.

1. Create a portal and populate it with levels, as described in the previous procedure.

2. Generate a URL to the sub-level of your choice by applying the following sequence:

   `http[s]://hostname:port/ibi_apps/portal/portal_alias/menu_1/page_2`

   where:

   - **hostname:port**
     Are the host name and HTTP port of the web server or application server.

   - **portal_alias**
     Is the name of your alias.

   - **menu_1**
     Is the name of the level which contains the page that you want to display.

   - **page_2**
     Is the name of the page that you want to display.
In our example, we want the second page under the first tab to open when the portal runs. Follow these steps to achieve this result:

1. Locate the page within the portal structure that corresponds to the sub-level that you want to open at run time.

   In our example, we locate the Regional Sales page inside the Dashboards folder, as shown in the following image.

2. Locate and copy the alias URL, as described in the previous procedure.

3. In a new browser window, paste your alias URL in the address bar, and add the names of your level and sub-level, separated with the / symbols.

   In our case, we are adding /Dashboards/regional_sales.

   **Note:** The URL is case-sensitive. If you are unsure of the correct name of your level or sub-level, right-click this element in the Workspaces area, click Properties, and, in the Properties panel, check the Name field value.

3. Press Enter to run your URL.

   The portal runs and the second page of the first tab displays, as shown in the following image.
4. Optionally, bookmark this URL for future use.

**Enabling and Sharing Personal Pages**

Personal pages are created at run time by the user and allow the new level of versatility in a way users organize and use portals. Personal pages remain visible only to the user that created them, unless the user shares them. Personal pages reside inside the My Pages folder in the repository.

**Note:** This feature is available in the full version of WebFOCUS.

**Procedure: How to Enable Personal Pages**

1. In the Workspaces area, in the Resources tree, select the workspace or folder where you want to create the portal, click the +Content button, point to Application, and then click Portal.

   The New Portal dialog box opens.

2. Select Create My Pages menu.

3. Make the remaining selections for the new portal, and then click Create.

   The new portal is created in the specified workspace or folder.

4. Publish the portal.

   **Note:** This step is crucial for activating the My Pages menu.

   The personal pages are now enabled and can be added by users at run time.

**Procedure: How to Use Personal Pages**

1. Run the portal in which personal pages are enabled.

2. Click My Pages, and then click the + icon to add a new page.

   **Note:** Depending on your navigation layout, the My Pages area can display as a tab or as a banner link.
The New Page dialog box opens, as shown in the following image, where you can select a template and link to an existing standalone page in the repository.

3. Click a template of your choice.

The page displays a series of interactive panels, as shown in the following image.

4. Add content to the panels.

5. If parameterized content is added to a page, optionally, click the Show filters button to display available filters.

The Selections dialog box opens where you can apply filters to your content.

**Note:** You can save your content and filter selections by using the bookmark button.

6. Double-click the Page Heading and type a new title for your personal page.

7. Optionally, double-click the page title in the sidebar and type a new title.

8. To share the page with other users, click the Share button.
The Share with Others dialog box opens.

9. Type the names of users and groups with which you want to share your personal page and click OK.

   The page is now available to the specified users and the Share button changes color to blue.

10. To revoke access to the page, click the Share button again.

   The Share with Others dialog box opens where you can remove users or groups from the sharing list.

   Note: If your sharing privilege does not allow you to open the Share with Others dialog box, you can share or unshare your personal page simply by clicking the Share button. In this case, the page is shared with every user that has access to the workspace in which the portal resides.

11. To delete the page, click the Delete button.

### Customizing Portals

All users can remove their own customizations from a portal. Authors, developers and administrators can also remove customizations for all users. Customizations are made when users customize unlocked content inside base portal pages. Personal pages and edits to personal pages are not considered customizations and, therefore, they are not removed.

**Procedure:** How to Remove Customizations From a Portal in the Repository

1. In the Workspaces area, in the Resources tree, right-click a portal.
2. Point to Customizations and click one of the following options:

   - Remove my customizations. Removes your own customizations from a portal.
   - Remove customizations for all users. Removes all user customizations that were made to the interactive base pages in the portal.

**Procedure:** How to Remove Customizations From a Portal at Run Time

1. From the Menu Bar of a portal, click your username.
2. Click Remove my customizations.

   The customizations are removed from the interactive base pages in the portal.
Applying Themes to Portals

You can apply themes to a WebFOCUS portal to customize its look and feel. Themes can be applied to new portals inside the New Portal dialog box or to existing portals inside the Edit Portal dialog box. A theme affects the look of the entire set of elements of the portal, including colors, opacity, and typeface styles.

There are four themes that WebFOCUS offers:

- Designer 2018
- Light
- Midnight
- Vivid

Additionally, you can create your unique custom theme and apply it to a portal.

**Procedure:** How to Apply a Theme to a Portal

1. In the Workspaces area, right-click a portal that you want to modify, and then click **Edit**. The Edit Portal dialog box opens.
2. Select a theme of your choice from the Themes drop-down list, as shown in the following image.

![Themes drop-down list](image)

**Note:** The same setting can be configured for a new portal inside the New Portal dialog box.
3. Click **Save**. The selected theme is applied to the portal.

**Procedure:** How to Create a Custom Portal Theme

1. Sign in to WebFOCUS as an administrator.
2. In the Workspaces area, from the Resources tree, expand the Global Resources folder, and then expand the Themes folder.

3. Click the Custom folder, and then click New folder icon above the Resources tree. The New Folder dialog box opens.

4. Populate the Title field with the name of your custom theme, and click OK. The custom theme folder is created. Your theme CSS file will reside in this folder. If you know which CSS classes should be used for your theme, you can create a new text file, add your code, and save this file as a Cascading Style Sheet. Alternatively, you can modify an existing theme CSS file. In this example, we copy and modify the theme CSS file for the Light theme.

5. Expand the Standard folder, and then expand the Light folder.

6. Copy the theme CSS file, and paste it inside your new custom theme folder. The following image shows the correct hierarchy of the custom theme file.

![Custom Theme Hierarchy](image)

**Note:** Do not modify the name of the theme CSS file. It is required that it stays the same for all themes. The name of the folder in which the file resides is the theme name that is available in WebFOCUS Designer.

7. Right-click the theme CSS file that you copied, and then click Edit. The Text Editor opens in the new browser tab.

8. Modify the code to achieve the desired look of the theme.
In this example, we changed the sidebar, banner, and background colors, as shown in the following images.

9. Save and close the Text Editor.

10. In the Workspaces area, apply the new custom theme to a page, as described in Apply a Theme to a Portal.

11. Run your portal to view the new theme.
An example of a new theme applied to a portal is shown in the following image.

![Image of a portal with new theme applied]

**Note:** You can control access to themes, both standard and custom, by configuring the List And Read security rule for the theme folder. To learn more about security rules, see the *WebFOCUS Security and Administration* technical content.

### Adding Icons to Portal Levels

You can further customize your portal by adding icons to pages and folders.

**Procedure:** *How to Add Icons to Folders and Pages Inside a Portal*

1. Create a WebFOCUS Portal, as described in *Creating Portals*.
2. Select the level to which you want to add icons, and locate its parent level.

   In our example, we are enabling icons for the top level of navigation, so we will be configuring the portal folder itself.
3. Right-click the portal folder and then click *Properties*.

   The Properties panel opens.
4. Navigate to the *Advanced* tab, select the *Show menu icons for children* check box, and click *Save*.

   Now, any icons added to the top level pages and folders are visible.
5. Without closing the Properties panel, click the page or folder to which you want to add an icon.
6. In the Menu Icon field, type the CSS class of an icon you want to add.

The following image shows an example of adding an icon to the Marketing folder.

You can reference available icons and their CSS classes in the following websites:

- [https://fontawesome.com/v4.7.0.icons/](https://fontawesome.com/v4.7.0/icons/)
- [https://material.io/tools/icons/?style=baseline](https://material.io/tools/icons/?style=baseline)

Click an icon that you want to use in your portal and copy its CSS class. If you are using icons from the fontawesome.com website, your CSS class should look similar to the following:

```
fa fa-circle
```

**Note:** If you have a license for the Font Awesome Pro icon packs, you can use CSS classes for your Pro icons instead.

If you are using icons from the material.io website, your CSS class should look similar to the following:

```
material_icons pie-chart
```

7. Repeat the process for other folders and pages of your choice, making sure that the parent folder has the *Show menu icons for children* property selected.
**Note:** Depending on the type of your navigation layout, certain levels do not display icons. The second level of the two-level side navigation layout does not display icons. The third level of the three-level navigation layout does not display icons. All layouts display icons for the top level of navigation. Responsive menus on mobile devices display icons for all levels of navigation.

8. To see the icons applied, run your portal.

The following image shows the three-level navigation layout with icons added to the top and second levels.
When you resize the window, the same icons display in the side menu, as shown in the following images.

**Customising User Menu Options**

As you build a new Designer portal or edit an existing one, you can customize the number and nature of options that display in the User menu inside the portal at run time. This capability adds a layer of control over the features and tools that are exposed to the users of the portal.

**Procedure: How to Customize User Menu Options in a Designer Portal**

1. On the WebFOCUS Hub, in the Workspaces or Portals area, right-click the portal that you want to modify, and then click *Edit*.

   The Edit Portal dialog box opens.

2. Navigate to the User Menu Options tab.
Notice that the Enable User Menu option and the subsidiary options are enabled by default, as shown in the following image.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Layout Options</th>
<th>User Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Enable Create My Pages Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Enable User Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Administration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Tools</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Remove my customizations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Change Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Sign Out</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this scenario, we want to disable the Administration menu, thus preventing the user of this portal from accessing administrative tools.

3. Clear the *Administration* checkbox and click *Save*.

   **Note:** You can also perform this step at the point of creating a portal, as described in *Creating Portals* on page 874.

4. Right-click the portal, and then click *Run*. 

---

898
The portal runs, and the modified User menu displays, as shown in the following image.

Using a JavaScript Function to Navigate to a Designer Portal Page

You can use a JavaScript function to dynamically navigate to other pages within your Designer portal, and immediately filter them based on the value that you select. This feature is especially useful in portals that contain multiple portal pages, because it allows you to link to a specific page within it. You can also pass a parameter from a link in the source item to filter the content in the target page, such as charts or reports, to quickly navigate through and show related information in different areas of your portal.

To use the navigateToPage function to jump from one page in a portal to another, perform the following tasks:

1. **Create Parameterized Content.** Create charts and reports to which the links in your source report will point.

2. **Set Up a Portal for the Navigate to Page Function.** Create the landing page for the links and save it in a portal.

3. **Create Hyperlinks in a Source Report.** Create hyperlinks within a report, which you will configure to point to a page containing the parameterized content.

4. **Add the Source Report to a Page in the Portal.** Add the source report to a page and add it to the same portal to which the target content was added.

5. **Finalize the Configuration of the JavaScript Function.** Ensure that the navigateToPage JavaScript function can be executed by the source report.

**Stage One: Creating Parameterized Content**

In this stage, you build parameterized reports and charts that will serve as the targets for drill-down links in the source report that you will create later.
It is prudent to build this content before creating the source report for a couple of reasons. First of all, these content items generally show detailed information that expands upon the information in the report. You can decide upon the information that you want to show in these target items, and how they should be filtered. Additionally, when you create the drill-down links in the source report, you will need to provide the parameter that you want to pass to these target items, and include the associated field in the source report. You will also need to include the IBFS path to the page that contains these target items. Therefore, it will be easier to create the target items and add them to a page in the portal first, then add the source report that targets them to a new page in the same portal.

**Procedure:** How to Create Parameterized Content for Hyperlinks

1. From the WebFOCUS Hub, click the plus button, then click Create Visualizations.
   WebFOCUS Designer opens.
2. Select a data source. This data source should be used for both the target content that you are creating now, and the source report that you will create later.
3. Optionally, change the content type using the Content picker. The default content type is a vertical stacked bar chart.
4. Drag fields from the Data pane onto the canvas or into the appropriate buckets on the Settings tab to create a chart or report.
5. Drag a dimension field from the field list to the Filter toolbar to create a prompted filter.
   You will also add this field to the source report later, and create a drilldown to pass a selected value from the source report to the parameterized content that you are creating now. You do not need to select default filter values.
6. Optionally, repeat step 5 to create more filters for this item. You can add all of these fields to the drilldown source item to pass values for multiple fields at once.
7. Save your content and close WebFOCUS Designer.
8. Optionally, repeat steps 1-6 to create more content to add to the target page. Filter these items with the same field or fields if you would like to filter them all based on the value selected in the source report.
   Optionally, you can also click Convert to Page and then add new containers to create additional charts and reports in the same page on demand. If you choose to create new content directly within a page using this authored page workflow, skip steps 3 through 6 in Stage Two.
Stage Two: Setting Up a Portal for the Hyperlinks

In this stage, you will create a portal to which you will add a page containing the target content that you created previously.

Procedure: How to Set Up a Portal for the Hyperlinks

1. Create a portal.
   - On the WebFOCUS Hub, in the Workspaces area, select the folder in which you want to create your portal, then, in the +Content menu, point to Application, and then click Portal.

2. Give the portal a title, and optionally specify an alias, layout, and other configuration options.
   - Click Create to create the portal.

3. Create a new page. Click the plus menu and then click Assemble Visualizations.
   - WebFOCUS Designer opens.

4. Select a page template, or use the Blank template to arrange the content on the page yourself.
   - Once you select a page template, the page canvas opens.

5. Add the target content that you created in Stage One to the page.

6. Since you added prompted filters to the target content, a badge appears on the Filters tab on the sidebar.
   - Select the Filters tab on the sidebar and then click Add all filters to page.
   - Controls for all parameters are added to the Filter toolbar.

7. Save the page to the portal folder that you created in step 2, and then return to the WebFOCUS Hub.

Stage Three: Creating Hyperlinks in a Source Report

In this stage, you will create a simple report with hyperlinks that point to the target page in the portal.

Procedure: How to Create a JavaScript Drilldown in a Report

1. On the WebFOCUS Hub, click the plus menu and then click Create Visualizations.
   - WebFOCUS Designer opens.

2. Select the same data source that you used to create the target content in Stage One.
   - This report will contain drilldowns that pass parameter values to those target items, opening and filtering the page containing them when a link is clicked.
After you select a data source, the WebFOCUS Designer canvas loads.

3. Optionally, change the content type by selecting an option from the Content picker.

In this example, we will create a report, since drill-down links in reports appear as easily identifiable hyperlinked text values. Therefore, we will select either the grid or standard report content type. However, you can add drilldowns to any standard chart type as well. Drilldowns added to charts are available from tooltips when you point to an area of the chart.

4. Drag fields from the Field list into the appropriate buckets in the report. Add dimension fields to the Rows and Column Groups buckets, and measure fields to the Summaries bucket.

Make sure to add the field by which the target items are filtered to the Rows bucket.

5. The next step is to create drill-down links on the field that was used to filter the target items. Complete the following steps to add a JavaScript drilldown that navigates to the page that you created in Stage Two.

a. Right-click that field in the Rows bucket and click Configure drill downs. The Configure Drill Downs dialog box opens.

   If you added filters for multiple different fields to your target items, add the drilldowns to the lowest level sort field. Associated values for higher level sort fields will be included automatically.

b. Click the plus sign (+) button to create a new drilldown.

c. Select the JavaScript radio button to create a JavaScript drilldown.

d. In the JavaScript Function text box, type portalDispatch.

e. Add parameters to use in the portalDispatch function.

   Click the plus sign button in the Request Parameters section to add the first parameter.

f. For the first parameter, change the Type to Value using the drop-down menu, and type navigateToPage in the Field/Value column.

g. Add a second parameter by clicking the plus sign button. Change the Type to Value and enter the IBFS path to the drilldown target page that you created in Step Two into the Field/Value column.

   You can acquire the IBFS path of the page by right-clicking it in the object explorer on the WebFOCUS Hub clicking Properties. Copy the text in the Path field of the Properties panel, then paste it into the Field/Value column for the second drilldown parameter in the Configure Drill Downs dialog box in WebFOCUS Designer.

h. Add a third parameter. Change the Type to Value and, in the Field/Value column, type the name of the parameter that you want to pass.
Typically, the parameter name matches the name of the field. You can confirm the parameter name by opening the target page in WebFOCUS Designer, clicking the Info button, and noting the parameters listed in the Parameters/Filters category for the items on the page. Alternatively, select a filter control on the page and, on the Settings tab, scroll down to the Parameters section, which shows the name of the parameter associated with the filter control.

i. Add a fourth parameter. Leave the Type as Field and select the field in your report that is associated with the parameter that you are passing. This field must be present in the drilldown source content.

j. Optionally, if you wish to pass multiple parameters to the page, for example, if the page contains multiple filters, repeat steps 5h and 5i for each one.

The following image shows the parameters to drill to a page in a portal, passing values for both the PRODUCT_CATEGORY and TIME_YEAR parameters.

6. Click Apply to generate the drill-down links.

The hyperlinks are added to the entries of the selected field.

**Note:** The links remain inactive until the drilldown source report or chart is added to a page within the same portal as the target item.

7. Save the report.
Stage Four: Add the Source Report to a Page in the Portal

The drilldown source report or chart should be run within the same portal as its target item. Therefore, it should be added to a page within that same portal.

Procedure: How to Add a Report to a Page in a Portal

1. Create a new page. Click the plus menu and then click Assemble Visualizations.
   WebFOCUS Designer opens.

2. Select a page template, or use the Blank template to arrange the content on the page yourself.
   Once you select a page template, the page canvas opens.

3. Add the drilldown source content that you created in Stage Three to the page.

4. Optionally, add other complementary items to the same page.

5. Save the page to the portal folder that you created in Stage Two, and then return to the WebFOCUS Hub.

   Alternatively, you can save the page to another location in your Repository, and instead create a shortcut to that page within the portal folder structure.

6. You may wish to display the drill-down source report on the first page, so that you can quickly navigate to other items within the portal using the drill-down links instead of the portal tabs and menus. To ensure that the page containing this report appears first, set the sort order for the page or shortcut within the portal.

   a. Right-click the page or page shortcut that you want to appear first within the portal, and then click Properties.
      The Properties panel opens.

   b. Select the Advanced tab of the Properties panel.

   c. Type a numeric value in the Sort order text box.
      Items with lower sort order values appear first. Since we want the page with the drilldown source report to appear first, type a negative value, such as -1, into the Sort order text box, causing it to appear before items with the default sort order of 0.

   d. Click Save in the Properties panel to apply the new sort order.
Stage Five: Finalize the Configuration of the JavaScript Function

The portalDispatch JavaScript function is defined in a .js file in your WebFOCUS installation. In order for WebFOCUS to find and execute this function, you must configure the path on the WebFOCUS Reporting Server edasprof.prf profile using the JSURLS property. Properties set in edasprof.prf are applied to any procedures run against that WebFOCUS Reporting Server.

Procedure: How to Add a JavaScript File Path to edasprof.prf

1. On the sidebar of the WebFOCUS Hub, select the Management Center.
   Alternatively, navigate to the WebFOCUS Reporting Server browser interface using the URL: hostname:HTTPport
   where:
   
   hostname
   Is the name of the machine where the WebFOCUS Reporting Server is hosted.
   
   HTTPport
   Is the HTTP(S) port number. If running against HTTP, the default value is 8121.
   
   When running locally, the default address of the WebFOCUS Reporting Server browser interface is localhost:8121.

   In the Reporting Server browser interface, open the Tools menu, and click Workspace.
4. On a new line, paste the following text:

   SET JSURLS = '/ibi_apps/tools/portalcanvas/iframeinterface.js'

   Note: If your environment does not use the default context root, replace the ibi_apps context root in the JSURLS path above with the one used in your environment.
5. Save your edits to edasprof.prf.

You can now drill from the drilldown source report to the target page that you created. In the Workspaces view of the WebFOCUS Hub, right-click the portal in the object explorer or Resource tree and click Run. When the portal loads, click a drill-down link in the report. The target page loads and is automatically filtered for the value that you selected in the report. To filter the page again for a different filter value, select a new value from the filter control and click the Refresh button on the page toolbar.

**Configuring Dynamically Customized Designer Portals for Multiple SaaS Tenant Groups**

If your organization supports a diverse range of customer groups that cover multiple corporate entities or geographic regions, you may need to create portals that make a single set of information available to a variety of groups using a variety of corporate identities.

By organizing users from different functional or business groups into SaaS tenant workspaces and creating customized themes and logos for each one, you can create portals that make the same information available to diverse customer groups in multiple customized environments.
In this specialized portal configuration, each tenant workspace contains the users assigned to a specific entity. As shown in the following image, they also contain files for the logo and theme that customize the portal interface to a look and feel that is familiar and appropriate for the members of the selected group.

A centralized workspace containing users from all tenant groups, supports the portal itself. All development and maintenance of portal content take place within the central workspace, maximizing the efficiency of information delivery.

Users assigned to individual SaaS Tenant groups view these centralized portal pages using the logo and tenant theme that are appropriate for their group.

To allow for varying themes and logo files, the centralized portal uses symbolic IBFS Paths that present users with the portal theme and logo assigned to their group. Symbolic IBFS paths use pre-configured variables, such as ##{WF_PrimaryGroup}, to create a relative path to these resources that are resolved when a user runs the portal.

Once established, the Portal uses relative paths to theme and logo file images stored in SaaS tenant groups and provides administrators with a customized user interface that is efficient and easy to maintain.
Understanding the Configuration Requirements for Designer Portals That Use Multiple Themes or Logos

The configuration of a Designer Portal that supports multiple SaaS Tenant groups with varying themes and logos is a multiphase process that requires the creation of tenant workspaces for each tenant group and a separate workspace for the content portal.

As a best practice, we recommend that you use the following workflow when creating a Multi-SaaS Tenant portal using symbolic IBFS paths.

1. Have an administrator create the workspaces you will need.
   - You need a SaaS tenant workspace for each group that must use a different theme or logo.
   - You also need a separate enterprise workspace to contain the centralized portal that will be accessible to all tenant users.
     For more information, see the How to Create a Workspace topic in the TIBCO WebFOCUS® Security and Administration technical content.

2. Have an administrator or group administrator assign a sample user to each tenant workspace.
   - You need one sample user assigned to the top-level security group for each tenant workspace.
     The tenant workspace group must be defined as the primary group for each user.
   - Each sample tenant user must also be assigned to the Advanced Users security group in the workspace that supports the portal.
     For more information, see the How to Add a User to a Group topic in the TIBCO WebFOCUS® Security and Administration technical content.

3. Create a CSS Theme file for each tenant workspace.
   - Create a file named tenant_theme.css that contains classes that define the unique theme for each tenant.
   - Save the tenant_theme.css file in the Hidden_Content folder of the tenant workspace.

4. Assign a logo file to each tenant workspace.
   - In the Hidden_Content folder, create a sub-folder entitled Images.
   - Create a logo file for each tenant and place it in the Hidden_Content/Images folder for each tenant workspace.
5. Building Portal Applications

- Publish the Images folder and the logo file.
- Create any required tenant-specific portal pages for each tenant workspace.
  - Develop all content for the tenant-specific portal page within the tenant workspace. The use of content or data sources contained in other workspaces adds an extra group to the configuration that conflicts with the ability of the product to work with \#{WF_PrimaryGroup}.
  - Create and publish tenant-specific portal pages for each tenant group that requires them within their tenant workspace.
  - Create a shortcut for each portal page within the tenant workspace.
- Create a centralized portal that includes a symbolic path for tenant-theme.css files and logo image files.
  - Develop all content for centralized portal pages within the centralized portal workspace. The use of content or data sources contained in other workspaces adds an extra group to the configuration that conflicts with the ability of the product to work with \#{WF_PrimaryGroup}.
  - Create the portal in an enterprise workspace available to all.
  - Enter the IBFS Symbolic Path to the tenant_theme.css file using the \#{WF_PrimaryGroup} variable in the Theme field of the centralized portal.
  - Enter the IBFS Symbolic Path to the logo image file in the Logo field of the centralized portal.
  - Because you are using IBFS paths that point to the same location in each different workspace, ensure that you use the same location for the logo file and theme file in each tenant workspace.
- Add Linked Tenant Portal Pages to the Centralized Portal.
  - Copy and paste the shortcuts of tenant-specific pages that you created earlier to the centralized portal workspace.
- Publish Content.
  - Publish the centralized portal and all of its contents.
  - Ensure that content in all individual tenant workspaces is published.
- Test Portals.
  - Sign in as a user from each tenant group and run the portal.
Assigning Customized Logos to Tenant Workspaces for Designer Portals

The symbolic path defined in the Logo field of the centralized portal directs the call for a logo image to a customized logo file in the workspace of the user who issued the request to run the portal.

In order for this link to work successfully, each tenant workspace must contain its own logo file in the Images subfolder of the Hidden_Content folder within the tenant workspace.

Each logo image file must use the same name as the logo file identified in the Logo field of the centralized portal, “logo.”

Procedure: How to Create an Image Folder in Each Tenant Workspace

1. Sign in to WebFOCUS as an administrator and navigate to the Workspaces area.
2. In the Resources tree, expand the tenant workspace to which you want to add a customized CSS theme file.
3. Under your selected workspace, select Hidden Content.
4. In the content section, click the +Content button, point to Other, and then select Folder to open the New Folder window.
5. Enter Images in the Title field, and select OK.
6. Right-click the new Images folder and select Publish.
7. Repeat this procedure for each tenant workspace.
Procedure: How to Upload a Logo File to a Tenant Workspace

1. In the Workspaces area, in the Resources tree, select the tenant workspace to which you want to add a logo file, navigate to the Hidden_Content folder and then to the Images folder.
2. In the content section, click the +Content button, point to Other, and then select Upload file to locate the logo image file.
3. Navigate to the location of the logo file, select it, and then select Open to close the dialog box and complete the upload.
4. Right-click the new image file and select Publish.
5. Repeat this procedure for each tenant workspace.

Creating Tenant-Specific Theme CSS Files for Designer Portals

The tenant_theme.css file contains any additional customizations that alter the look and feel of the default portal frame and features.

To ensure that the symbolic IBFS Path in the main portal connects to the tenant_theme.css file for every tenant, you must save it in the Hidden_Content folder of each tenant workspace and include this folder in the full symbolic IBFS path. You must also use the same name for each tenant workspace theme file, tenant_theme.css.

You can use the text editor to create a .css file and enter the classes you wish to add or modify directly.

Procedure: How to Configure Customized CSS Theme Files for Tenant Workspaces Using the Text Editor

1. Navigate to the Workspaces area.
2. In the Resources tree, expand the tenant workspace to which you want to add a customized CSS theme file.
3. Under your selected workspace, select Hidden Content to open the Hidden Content folder.
4. In the content section, click the +Content button, point to Other, and then select Text Editor to open the New Text Resource window.
5. Under the Select a File Type banner, select Web, and then select Cascading Style Sheet (css) to open the Text Editor window.
6. Enter CSS classes and CSS properties that construct the theme that is unique to this tenant group in the Text Editor window.
7. When your customized tenant-theme.css file configuration is complete, select File and Save as, save the file as tenant_theme.css in the Hidden_Content folder of the tenant workspace, and close the text editor.
8. In the content section of the Hidden_Content folder, right-click the new tenant_theme.css file and select Publish.

9. Repeat this procedure for each tenant workspace.

Creating Tenant-Specific Designer Portal Pages

If an individual tenant group needs one or more portal pages that are to be visible only to members of that group, create these pages within the tenant workspace and link to them from the main centralized portal. This limitation ensures that members outside of the tenant group will not see pages intended only for the tenant group.

When you have created a tenant-specific portal page, create a shortcut to it within the tenant workspace. When you create the shortcut within the tenant workspace, the rules of that workspace apply to the shortcut as well as the portal page, and the Navigation bar in the centralized portal will display an entry for the portal page only to users who belong to the tenant group.

You must develop all content for the tenant-specific portal pages within the tenant workspace. The use of content or data sources contained in other workspaces adds an extra group to the configuration that conflicts with the ability of the product to work with ##{WF_PrimaryGroup}.

**Procedure:** How to Create a Visualization from New Content in WebFOCUS Designer

Use the following generalized steps to create a tenant-specific visualization from new content in WebFOCUS Designer:

1. On the WebFOCUS Hub, select Visualize Data to open WebFOCUS Designer in a new browser tab.
2. Select the tenant workspace, and select a data source available from that workspace to load options that create a single content item.
   
   **Note:** Select only data sources that are available within the workspace. Do not use data sources outside of the workspace.
3. Start the visualization by creating a new chart or report.
   
   a. From the Content picker, select a content type. You can choose from different chart types and report layouts
   
   b. With the Fields tab selected on the sidebar, drag fields from the Resources panel into the buckets in the Properties panel to create content.
      
      Or
      
      Double-click a field or drag it onto the canvas to add it to the default bucket for that field type.
c. If you want to filter your content, drag the field on which the filter should be based into the Filter toolbar or Filters bucket.

Prompted filters in the Filter toolbar affect the entire page, while static filters in the Filters bucket affect only the item for which they were created.

d. Use the options of the Format tab of the Properties panel to style your content.

4. To create a page that only contains a single item, select Page on the Designer toolbar and skip to step 7.

The item moves into a container, but no second container is added.

5. To create a page with multiple content items, select Add visualization on the Designer toolbar to turn the visualization into a page.

The first item you created moves into a container, and a second container is created.

a. Continue adding content to the page by dragging an existing content item from the Container tab on the sidebar, or by selecting Add visualization again to create a new container. You can then create a new content item as outlined in step 3.

b. You can also drag a field from the field list onto an empty area of the canvas to create a new container with content using that field.

6. Style and format areas on the page using the options on the Properties panel.

The entire page, sections, containers, filter controls, and filter cells all have their own set of styling and formatting options.

You can also preview the visualization to see run-time behavior by clicking Run in new window.

7. When you have finished creating your visualization, select Save and assign a name to it.

8. In the content section of the tenant workspace, right-click the new portal page and select Publish.

9. Repeat this procedure for any remaining tenant workspace that requires visualizations from new content.

10. Follow the procedure, How to Create a Visualization from Existing Content in WebFOCUS Designer on page 913 for any remaining tenant workspace that requires visualizations from existing content.

Procedure: How to Create a Visualization from Existing Content in WebFOCUS Designer

Use the following generalized steps to create a tenant-specific visualization from existing content in WebFOCUS Designer:

1. On the WebFOCUS Hub, select the plus button and then select Assemble Visualizations to open WebFOCUS Designer in a new browser tab.
2. In WebFOCUS Designer, select a template for the page. You can use a predefined template, or select Blank to build the page from scratch.

3. Add content to the page by selecting Content on the sidebar, navigating to an item in the Resources panel, and then dragging it onto the canvas.

   Or

   Create a container for an item by selecting Container on the sidebar and dragging a container onto the canvas, and then adding content to the container.

   **Note:** Select only content that was created within the workspace. Do not include content that was developed outside of the workspace.

4. Continue adding content to the page by performing the following steps.

   a. Add a new container by dragging it from the Container tab on the sidebar, or selecting Add visualization.

   b. Select Content on the sidebar to access items that you can add to containers on the page or drag directly onto the canvas.

5. Select different areas of the page, and style and format them using the options on the Properties panel.

   The entire page, sections, containers, filter controls, and filter cells all have their own set of styling and formatting options.

   You can also preview the visualization to see run-time behavior by clicking Run in new window.

6. When you have finished creating your visualization, select Save and assign a name to it.

7. In the content section, right-click the new portal page and select Publish.

8. Repeat this procedure for any remaining tenant workspace that requires visualizations from existing content.

9. Follow the procedure, How to Create a Visualization from New Content in WebFOCUS Designer on page 912 for any remaining tenant workspace that requires visualizations from new content.

**Procedure:** How to Create and Publish a Tenant-Specific Page Shortcut

To limit access to a tenant-specific portal page to members of the tenant group, create the shortcut to the page within the tenant workspace. You can copy the shortcut and paste it into the centralized portal structure later.

1. In the content section of the tenant workspace, right-click the tenant page, and select Create Shortcut.
2. Right-click the new shortcut, and select Publish.
3. Repeat this procedure for every tenant-specific portal page that must be included in the centralized portal.

**Creating a Centralized Designer Portal for Common Use**

The centralized portal contains all of the links to data sources and content that will be available to tenant users. Content pages, based on a portal template that uses a symbolic reference to tenant_theme.css files, make information available to all users in the appropriate format.

Enter the IBFS Symbolic Path to the variable style sheet file in the Theme field and the Logo field of the main portal. Because you are using IBFS paths that point to the same location in each different workspace, ensure that you use the same location for the logo and theme files in each tenant workspace.

You must develop all content for the centralized portal pages within the centralized portal workspace. The use of content or data sources contained in other workspaces adds an extra group to the configuration that conflicts with the ability of the product to work with ##{WF_PrimaryGroup}.

**Procedure: How to Create a Centralized Designer Portal With a Symbolic Reference to Tenant Theme Files**

1. Navigate to the Workspaces area.
2. In the Resources tree, select the workspace for the centralized portal.
3. In the +Content menu, point to Application, and then select Portal to open the New Portal dialog box.
4. Type a descriptive title for the portal in the Title field.
   As you type, WebFOCUS automatically assigns the value you type in the Title field, adjusted to conform to IBFS rules, to the Name field. You can edit or replace this value with a custom name if required.
   WebFOCUS also automatically assigns the appropriate IBFS Path to the portal, based on the location of the workspace and the title you enter, to the Path field, and an external version of the path that does not begin with the IBFS parameter in the URL field.
5. Enter a short name to reference your portal in the Alias field.
6. Enter the following relative path to the location of the logo file in the Logo field:

   IBFS:/WFC/Repository/##{WF_PrimaryGroup}/Hidden_Content/Images/logo.png
Where:

**IBFS:/WFC/Repository**

Is the opening path that identifies the IBFS system, the WebFOCUS Content subsystem, and the Repository where all content folders are located within the IBFS system.

**##{WF_PrimaryGroup}**

Is the variable that redirects the Path to the primary tenant workspace group to which the user working with the Portal belongs.

**Hidden_Content**

Is the folder within each tenant workspace that contains the theme and logo files.

**Image/logo.png**

Is the remaining path within the Hidden_Content folder to the logo file. This path must be consistent in all tenant workspaces. In this example, we use a .png file, but you can use other image file formats as well.

**Note:** You can confirm the validity of the path you use in this field by reviewing the path assigned to the tenant workspace folders in the Properties panel.

7. Select the layout for your portal in the Navigation field.

8. Enter the following relative path to the location of the theme file in the Theme field and delete the default value displayed in this field.

   **IBFS:/WFC/Repository/##{WF_PrimaryGroup}/Hidden_Content/tenant_theme.css**

   Where:

   **IBFS:/WFC/Repository**

   Is the opening path that identifies the IBFS system, the WebFOCUS Content subsystem, and the Repository where all content folders are located within the IBFS system.

   **##{WF_PrimaryGroup}**

   Is the variable that redirects the Path to the primary tenant workspace group to which the user working with the Portal belongs.

   **Hidden_Content/tenant_theme.css**

   Is the remaining path within each tenant workspace to the file containing the theme for members of that tenant group.

   **Note:** You can confirm the validity of the path you use in this field by reviewing the path assigned to the tenant workspace folders in the Properties panel.

9. If you want to allow users to create personal pages in this portal at run time, select the *Create My Pages* menu check box.
10. Select Create to close the dialog box and create the new portal structure in the centralized portal workspace.

11. Create pages and assemble content that must be visible to all tenant groups within the folder for the new centralized portal in the centralized portal workspace.

   **Note:** When creating pages for the centralized portal, you must only use content that was created within the workspace. Do not include content that was developed outside of the workspace.

### Adding Tenant-Specific Portal Pages to the Centralized Designer Portal

To include tenant-specific portal pages in the centralized designer portal, you must add shortcuts for the linked pages to the centralized portal.

To ensure that tenant-specific portal pages appear only to the tenant groups to whom they apply, you must create the shortcut to the page within the tenant workspace. You must then copy the shortcut from the tenant workspace and paste it to the portal folder within the workspace that contains the centralized portal.

By creating the shortcut within the tenant workspace, you inherit the security rules of that workspace when you copy and paste the shortcut to the centralized portal workspace. As a result, the shortcuts will be visible in the navigation bar only to tenants who are members of the group.

**Procedure:**  **How to Copy and Paste Shortcuts to Tenant-Specific Portal Pages to the Centralized Portal**

1. Navigate to the Workspaces area.
2. Expand the tenant workspace that contains the tenant page you want to include in the centralized portal.
3. Right-click the shortcut to the tenant-specific portal page to be included in the centralized portal, and click Copy.
4. Navigate to the workspace that contains the centralized portal.
5. Expand the folder for the centralized portal and navigate to the location inside the centralized portal folder structure at which you want to add the page.
6. When you reach the appropriate location within the centralized portal workspace, right-click anywhere in the content section and select Paste.
7. Repeat steps 2 - 6 for each shortcut in your selected workspace that must be included in the centralized portal.
8. Repeat this procedure for each tenant workspace that contains shortcuts to tenant-specific portal pages that must be included in the main portal.
Publishing Content

When the designer portal is ready and all tenant workspaces and tenant workspace groups are prepared, you must make the portal and related workspaces available by changing them to Published status.

Procedure: How to Publish a Designer Portal

1. Sign in as an administrator, if you are not signed in already.
2. Right-click the portal in the content section of the WebFOCUS Hub and select Publish from the shortcut menu.

Testing the Designer Portal User Experience

Before you can announce the availability of the portal for general use, you must first ensure that the appropriate theme and logo are assigned to the portal for users from each tenant group.

Remember that the portal fails to display content properly when you run it in the centralized enterprise workspace. You must base your testing on how the portal appears to users from each tenant group, not in the centralized workspace.

Procedure: How to Test the Portal User Experience

1. Sign in as a user from each tenant group and run the portal.
2. Ensure that the logo, styling, and tenant-specific pages are appropriate.
3. Ensure that common pages are available and conform to tenant-specific styling.
4. If you encounter unexpected results, review the portal and tenant workspace configurations to ensure that your configuration conforms to the shared portal design.
5. Repeat this procedure for each tenant group.

Configuring Dynamically Customized Collaborative Portals for Multiple SaaS Tenant Groups

If your organization supports a diverse range of customer groups that cover multiple corporate entities or geographic regions, you may need to create portals that make a single set of information available to a variety of groups using a variety of corporate identities.

By organizing users from different functional or business groups into SaaS tenant workspaces and creating customized themes and logos for each one, you can create portals that make the same information available to diverse customer groups in multiple customized environments.
In this specialized portal configuration, each tenant workspace contains the users assigned to a specific entity. As shown in the following image, they also contain files for the logo and theme that customize the portal interface to a look and feel that is familiar and appropriate for the members of the selected group.

A centralized workspace containing users from all tenant groups supports the portal itself. All development and maintenance of portal content take place within the centralized workspace, maximizing the efficiency of information delivery.

Users assigned to individual SaaS Tenant groups view these centralized portal pages using the logo and tenant theme that is appropriate for their group.

To allow for varying themes and logo files, the centralized portal uses symbolic IBFS Paths to present users with the portal theme and logo assigned to their group. Symbolic IBFS paths use pre-configured variables, such as ##{WF_PrimaryGroup}, to create a relative path to these resources that are resolved when a user runs the portal.

Once established, the Portal uses relative paths to theme and logo file images stored in SaaS tenant groups and provides administrators with a customized user interface that is efficient and easy to maintain.

**Procedure:** How to Understanding the Configuration Requirements for Collaborative Portals That Use Multiple Themes or Logos

The configuration of a Collaborative Portal that supports multiple SaaS Tenant groups with varying themes and logos is a multiphase process that requires the creation of tenant workspaces for each tenant group and a separate workspace for the content portal.
As a best practice, we recommend that you use the following workflow when creating a Multi-
SaaS Tenant portal using symbolic IBFS paths.

1. Have an administrator create the workspaces you will need.
   - You need a SaaS tenant workspace for each group that must use a different theme or
     logo.
   - You also need a separate enterprise workspace to contain the centralized portal that
     will be accessible to all tenant users.

     For more information, see the *How to Create a Workspace on the WebFOCUS Home
     Page* topic in the *TIBCO WebFOCUS® Security and Administration* technical content.

2. Have an administrator or group administrator assign a sample user to each security group.
   - Assign users in each tenant group to the workspace for that tenant. Assign users to
     the security group whose range of privileges most closely matches their
     responsibilities.
   - Assign all users to the same security group in the workspace that supports the portal.

     For more information, see the *How to Add a User to a Group* topic in the *TIBCO
     WebFOCUS® Security and Administration* technical content.

3. Create a Portal Page and a CSS Theme file for each tenant workspace.
   - Create tenant-specific portal pages for each tenant group that requires them within
     each tenant workspace.
   - Create a file named `tenant_theme.css` that contains classes that define the unique
     theme for each tenant.
   - Enter the `.bip-logo` class in the `tenant_theme.css` file and identify the address of the
     tenant workspace logo file in the `background-image` property.
   - Save the `tenant_theme.css` file in the Hidden_Content folder of the tenant workspace.

4. Assign a logo file to each tenant workspace.
   - In the Hidden_Content folder, create a sub-folder entitled Images.
   - Create a logo file for each tenant and place it in the Hidden_Content/Images folder for
     each tenant workspace.

5. Create a centralized portal that includes a symbolic path for Tenant-Theme.css files.
   - Create the portal in a common workspace available to all.
Enter the IBFS Symbolic Path to the tenant-theme.css file using the 
####\{WF_PrimaryGroup\} variable in the Custom Theme CSS field of the centralized portal.

Ensure that the tenant_theme.css file identifies the location of the logo file for that 
workstation.

Because you are using IBFS paths that point to the same location in each different 
workspace, ensure that you use the same location and file name for the logo and 
theme files in each tenant workspace.

6. Add Linked Tenant Portal Pages to the Centralized Portal.

Add any individual tenant pages to the centralized portal for those tenants that require 
them.

7. Publish Content.

Publish the centralized portal and the workspace that contains it.

Publish all individual tenant workspaces.

8. Test Portals.

Sign in as a user from each tenant group and run the portal.

Ensure that the logo, styling, and tenant-specific pages are appropriate.

Ensure that common pages are available and conform to tenant-specific styling.

9. Have an administrator or group administrator assign all remaining users to security 
groups.

Assign all users in each tenant group to the workspace for that tenant. Assign users to 
the security group whose range of privileges most closely matches their 
responsibilities.

Assign all users to the corresponding security group in the workspace that contains the 
portal.

For more information about assigning or mapping users to groups, see the TIBCO 
WebFOCUS® Security and Administration technical content.

Assigning Customized Logos to Tenant Workspaces

The symbolic path defined in the Custom Theme CSS field of the centralized portal redirects 
the call for a theme to a customized CSS theme file in the workspace of the user who issued 
the request to run the portal. In turn, the customized CSS theme file includes a property that 
identifies the logo to use for the tenant workspace.
This two-stage link enables users to overcome the limitation of the variable file path that can only call a single file, and ensures that the appropriate logo and theme are called for when users open the portal.

In order for this link to work successfully, each tenant workspace must contain its own tenant_theme.css file in the Hidden_Content folder, a subfolder within the Hidden_Content folder entitled Images, and its own logo image file within the Images subfolder.

Each CSS theme file must use the same name as the theme file identified in the Custom Theme CSS field of the centralized portal, "tenant_theme.css." You can use different names for logo image files, but you must ensure that the tenant_theme.css file for a workspace contains the correct name of the logo image file assigned to that workspace.

**Procedure:** How to Create an Image Folder in Each Tenant Workspace

1. Sign in to WebFOCUS as an administrator, and navigate to the Workspaces area.
2. In the Resources tree, expand the tenant workspace to which you want to add a customized CSS theme file.
3. Under your selected workspace, select Hidden Content.
4. In the content section, click the +Content button, point to Other, and then select Folder to open the New Folder window.
5. Enter Images in the Title field, and select OK.
6. Right-click the new Images folder and select Publish.
7. Repeat steps 1 through 6 for each tenant workspace that will access the centralized portal.

**Procedure:** How to Upload a Logo File to a Tenant Workspace

1. In the Workspaces area, in the Resources tree, expand the tenant workspace that contains the new copy of the logo file.
2. In the content section, click the +Content button, point to Other, and then select Upload file to locate the logo image file.
3. Navigate to the location of the logo file, select it, and then select Open to close the dialog box and complete the upload.
4. Right-click the new image file and select Publish.
5. Repeat this procedure for each tenant workspace.
Creating Tenant-Specific Theme CSS Files

The tenant_theme.css file contains the .bip-logo class that identifies the address of the tenant workspace logo file in the background-image property. It also contains any additional customizations that alter the look and feel of the default portal frame and features.

To ensure that the symbolic IBFS Path in the main portal connects to the tenant_theme.css file for every tenant, you must save it in the Hidden_Content folder of each tenant workspace and include this folder in the full symbolic IBFS path. You must also use the same name for each tenant workspace theme file, tenant_theme.css.

You can use the Page Designer to create this file interactively as described in how to configure customized CSS theme files for tenant workspaces using the CSS editor on page 923. As an alternative, you can use the text editor to create a CSS file and enter the classes you wish to add or modify. If you use this method, be sure to open the text editor from the Hidden_Content folder within the tenant workspace, and select the CSS format, and ensure that all entries conform to syntax requirements and include valid data.

Procedure: How to Configure Customized CSS Theme Files for Tenant Workspaces Using the CSS Editor

1. In the Workspaces area, in the Resources tree, expand the tenant workspace that requires a customized theme.

2. In the content section, click the +Content button, point to Other, and then select Collaborative Portal to launch the Portal Designer.

3. On the Layout tab, in the Portal group, click the Theme button splitter, then click Launch CSS Editor to open the Styling dialog box.

4. On the toolbar, click the Show the Element Inspector button, and then click the Inspect elements style information button.

   Your cursor changes to a crosshair. You can also click the Highlight inspected element button to pinpoint the element that you want to style more easily.

5. Click a portal element that you want to style. In this example, click the top banner.

   The Classes field is automatically populated with the correct CSS class name for the selected element, in our example bip-banner-top.

   Note: You can also select elements from the Elements drop-down list, or, if you know the CSS class name of the element, you can type it in the Classes field. You can also use the Search field to search for a CSS class using keywords.

6. In the CSS File Editor, click the Add Class text, type the name of your selected CSS class, preceded by a dot, and then press Enter.

   In our example, type .bip-banner-top
7. Click the Add property text below the class and type the name of the property and the value to assign to it, separated by a colon (:). Type a semi-colon (;) at the end of the statement, and then press the Enter key.

In our example, type background-color:#56b7e6;.

The banner instantly changes color to the specified hue, as shown in the following image.

![Example banner color change](image)

**Note:** If you have entered an invalid CSS class or attribute, the browser rejects it and the change is not reflected in the portal appearance. Any hexadecimal color value you enter is automatically converted into the equivalent RGB value.

8. Repeat steps 5 through 7 for each component of the portal theme that you must customize for this tenant group.

9. When your customizations are complete, add the .bip-logo class to the tenant_theme.css file as described in the following steps:
   a. In the CSS File Editor, click the Add Class text, type bip_logo, preceded by a dot, and then press the Enter key.
   b. Click the Add property text below the class name and enter: background-image:url("Images/logofilename")
      
      Where
      
      logofilename
      
      is the name of the image file that contains the logo.
   c. Click the Add property text below the entry and add the following properties and their values:
      
      background-position:center;
      
      background-repeat:no repeat;
      
      height:45 px;
width:150 px;

For example:

```css
.bip-logo {
  background-image:url("Image/CompanyOneLogo.png");
  background-position:center;
  background-repeat:no repeat;
  height:45 px;
  width:150 px;
}
```

10. Click the Save button in the Styling dialog box.

   If a custom CSS file is already applied to this portal, your changes will be saved in that file. If the changes are new, the Save As dialog box opens.

11. Navigate to the Hidden Content folder of the tenant workspace, name your new CSS file, tenant_theme.css and then click Save.

12. Close the Styling dialog box.

13. Click Save to save the file as tenant_theme.css in the Hidden_Content folder, and close the Portal Designer.

14. Repeat this procedure for each tenant workspace.

Creating Tenant-Specific Portal Pages

If an individual tenant group needs one or more portal pages that are to be visible only to members of that group, create these pages within the tenant workspace and link to them from the main centralized portal. This limitation ensures that members outside of the tenant group will not see pages intended only for the tenant group.

Procedure: How to Create a Tenant-Specific Portal Page

1. On the WebFOCUS Hub, navigate to the Workspaces area.

2. In the Resources tree, expand the tenant workspace to which you want to add a new portal page.

3. In the content section, click the +Content menu, point to Other, and then select Portal Page to open the Page Designer and the Add Page dialog box.

4. Select a template, and then click Create to open the portal page in the Page Designer.

5. Optionally, add content to the portal page.

6. Select the same page template as that which will be used for the main portal.

7. Type the name of the workspace in the Title field and accept the automatically-generated counterpart in the Name field.
8. On the ribbon, in the Preview group, select Themes, and select Configure CSS Files.

9. Select Browse next to the Custom Theme CSS field.

10. In the Open – IBFS:/WFC … dialog box, navigate to the Hidden_Content folder for this workspace and select tenant_theme.css.

11. Select Open to close the dialog box and assign the customized tenant theme to the tenant-specific portal page.

12. Click OK to close the Portal Theme Files dialog box.

13. Save and close the Page Designer.

   The new stand-alone portal page displays in the workspace. You can now copy, move, and link this portal page to portals.

14. Right-click the new page and select Publish.

15. Repeat this procedure for every tenant workspace that will use tenant-specific portal pages.

Creating a Centralized Portal for Common Use

The centralized portal contains all of the links to data sources and content that will be available to tenant users. Content pages, based on a portal template that uses a symbolic reference to tenant_theme.css files, make information available to all users in the appropriate format.

Enter the IBFS Symbolic Path to the variable style sheet file in the Custom Theme CSS field of the centralized portal. Because you are using an IBFS path that points to the same location in each different workspace, ensure that you use the same location for the logo and theme files in each tenant workspace.

Procedure: How to Create a Centralized Portal With a Symbolic Reference to Tenant Theme Files

1. On the WebFOCUS Hub, navigate to the Workspaces view.

2. In the Resources tree, expand the workspace for the centralized portal.

3. In the +Content menu, point to Other, and then select Collaborative Portal to open the New Portal dialog box.

4. Type a descriptive title for the portal in the Title field.

   As you type, WebFOCUS automatically assigns the value you type in the Title field, adjusted to conform to IBFS rules, to the Name field. You can edit or replace this value with a custom name if required.
WebFOCUS also automatically assigns the appropriate IBFS Path to the portal, based on the location of the workspace and the title you enter, to the Path field, and an external version of the path that does not begin with the IBFS parameter in the URL field.

5. Enter a short name to reference your portal in the Alias field.

6. Select Create to store these values and create the portal.

7. On the ribbon, in the Themes group, select Theme and enter the following path to the location of the theme file in the Custom Theme CSS field:

   \texttt{IBFS:/WFC/Repository/##{WF_PrimaryGroup}/Hidden\_Content/tenant\_theme.css}

   Where:

   \texttt{IBFS:/WFC/Repository}
   
   Is the opening path that identifies the IBFS system, the WebFOCUS Content subsystem, and the Repository where all content folders are located within the IBFS system.

   \texttt{##{WF_PrimaryGroup}}
   
   Is the variable that redirects the path to the primary tenant workspace group to which the user working with the portal belongs.

   \texttt{Hidden\_Content/tenant\_theme.css}
   
   Is the remaining path within each tenant workspace to the file containing the theme for members of that tenant group.

   \textbf{Note:} You can confirm the validity of the path you use in this field by reviewing the path assigned to the tenant workspace folders in the Properties panel.

8. Select remaining options, and add pages and other resources as described in \textit{Business Intelligence Portal} technical content.

9. When your configuration is complete, save your changes and close the Portal Designer window.

\section*{Adding Tenant-Specific Portal Pages to the Centralized Portal}

To include tenant-specific portal pages in the centralized portal, you must add them as linked pages to the centralized portal.

\textbf{Procedure: How to Create Additional Linked Portal Pages}

1. Right-click the collaborative portal in the centralized portal workspace and select \texttt{Edit} to open Page Designer.
2. Link to an existing portal page as described in the following steps:
   a. Click the Add Page icon to open the Add Page dialog box.
   b. Select the Link To Existing Page option, as shown in the following image.
      ![New Page Information](image)
   c. In the Open dialog box, select the tenant portal page from the tenant-workspace and select Open.
      The new linked portal page displays in the portal.
3. Repeat step 2 for each tenant-specific portal page.
4. When you have added all of the pages linked to tenant workspace portal pages, save and close the portal.

### Publishing Content

When the portal is ready and all tenant workspaces and tenant workspace groups are prepared, you must make the portal and related workspaces available by changing them to Published status to make the portal and its contents available to all users with their appropriate level of access.

**Procedure:** How to Publish a Portal

1. On the WebFOCUS Hub, navigate to the Workspaces area.
2. In the Resources tree, expand the workspace for the centralized portal.
3. Right-click the portal in the content section of the WebFOCUS Home Page and select Publish from the shortcut menu.

### Testing the Portal User Experience

Before you can announce availability of the portal for general use, you must first ensure that the appropriate theme and logo are assigned to the portal for users from each tenant group.
Procedure: How to Test the Portal User Experience

For each tenant group:

1. Sign in as a test user from each tenant group and run the portal.
2. Ensure that the logo, styling, and tenant-specific pages are appropriate.
3. Ensure that common pages are available and conform to tenant-specific styling.
4. If you encounter unexpected results, review the portal and tenant workspace configurations to ensure that your configuration conforms to the shared portal design.
Scheduling and Distributing Content

Learn how you can use schedules to distribute content to multiple recipients, create a distribution list to issue content to multiple recipients, create event-based schedules using alerts, and share your content right from the WebFOCUS Hub or Home Page.

In this chapter:

- Creating Event-based Schedules

Creating Event-based Schedules

In the business climate today, cutting costs and increasing profitability are critical. Organizations create and distribute reports for evaluating and taking action when management-defined conditions are not met. The evaluation can largely be automated using Alert reporting.

Alert reporting automates the evaluation of a defined condition to determine whether or not a report should be submitted. Recipients of the report know before they open it that they are receiving this report because there is an exception in their area of responsibility. This topic introduces and describes how you can create Alerts in WebFOCUS.

Alert Reporting

A data-driven Alert is an event that is prompted by a guideline that you define. This guideline can vary from the simple to the complex. For example, a simple guideline is to alert a sales manager when an order that exceeds $1 million is entered. An example of a more complex guideline is to alert a department manager when cumulative expenses exceed budget for any category. The report sent to the manager as a result of the Alert might show the most recent transactions, the amounts, and the sources.

Alert reporting is an integrated feature of WebFOCUS Managed Reporting and ReportCaster. An Alert report can be run interactively or by authorized users. You can use ReportCaster to schedule and distribute an Alert report. Burst capability can send targeted information to the people who need it, so that there is less information for each person to analyze.

Alerts work with all email clients. They are supported on the following mobile devices: iPhone®, iPad®, and email enabled mobile phones. Alerts can also be sent to any PC or laptop computer with email capability.
Alerts provide the following:

- **Alert tools.** Using Alert Assist, you can quickly set up test conditions (rules) that determine if an Alert condition should be triggered (true). This is called the Alert test. When the Alert test is triggered (true), the Alert result is run. An Alert result can be an existing report procedure or you can create the Alert result using InfoAssist.

- **Scheduling flexibility.** Optionally, you can schedule an Alert to run as often as every minute to evaluate the Alert test conditions.

**Components of an Alert**

The Alert feature requires the following components:

- **WebFOCUS Reporting Server.** This server is responsible for processing the procedure, accessing and retrieving the requested data, and creating the report when the Alert test is triggered (true).

- **Managed Reporting.** This environment is used to create and manage Alerts in the WebFOCUS repository.

An Alert consists of the following:

- Alert test

- Alert result

An Alert test is required to check whether or not a set of defined test conditions (rules) is met (true or false). An Alert test can be a WebFOCUS Test, which is a simple TABLE request that you create to define the condition to test for. Alternatively, an Alert test can be a Test for File Existence, which checks for the existence of a file that is accessible to the WebFOCUS Reporting Server to which the Alert test is submitted. The file does not need to be in the APP PATH. It just needs to be in a location where it can be found by the WebFOCUS Reporting Server.

The Test for File Existence file does not need to be an actual file with an extension. Testing for the existence of a folder is also valid.

If the Alert test is triggered (true), returns records, the Alert result request is processed. You have the option of creating the result report or selecting an existing report stored in the WebFOCUS repository that you are authorized to run.

**Alerts Created in the Browser**
When you select a new Alert from the Legacy Home Page or WebFOCUS Home Page, the WebFOCUS Alert Assist tool opens for the creation of components. Alert Assist is a Bindows™ application that is launched in a separate browser window.

When you select a new Alert from the WebFOCUS Hub or WebFOCUS Home Page, the WebFOCUS Alert Assist tool opens for the creation of components. Alert Assist is a Bindows™ application that is launched in a separate browser window.

The browser tab uses the generic name Alertn, where n is an index number starting at 1. All subsequent Alerts increase by 1. If you save the Alert, the dialog box is automatically set up with this generic name. However, you can change the name as desired.

If you select WebFOCUS Test in the browser, you are prompted to create the Alert test using InfoAssist. The version of InfoAssist that is invoked does not have field styling, heading, footing, or report options, such as OLAP and On-Demand Paging. The Alert test determines whether or not a specified condition is true. It is not the report that is displayed as the result of the Alert.

You can create the Alert result using InfoAssist, this time with all the available styling and report options. Alternatively, you can select an existing report stored in the WebFOCUS repository that you are authorized to run.

**Note:** It is recommended that you select an existing report for the Alert result request, as it is available to edit, run interactively, or schedule independently of the Alert. If you create the Alert result using InfoAssist within Alert Assist, you need to use Alert Assist and select the open option again to edit the request, because the Alert test and the report to be run are contained within the Alert procedure.

**Reference:** Alert Assist Sample Code Created With InfoAssist

In the sample code that follows, both the Alert test and the report to be run (Alert result) are created with InfoAssist. To keep the sample code simple, styling and report options, such as report headings and conditional styling, are not included in this request.

Notice that after the first TABLE request, there is a –IF statement that checks if the number of lines in the Alert test is equal to zero (–IF &LINES EQ 0). This test condition determines if the second TABLE request, to execute the report, should be triggered (true).

If the number of lines is greater than zero, then there are records that satisfy the Alert test, and the report is run. If the number of lines is equal to zero, then there are no records that satisfy the Alert test, and the report is not run.
/* Created by Alert Assist
** start of the test report
ENGINE INT CACHE SET ON
-DEFAULTH &WF_SUMMARY='Summary';
-DEFAULTH &WF_TITLE='WebFOCUS Report';
TABLE FILE ibisamp/wf_retail
SUM WF_RETAIL.WF_RETAIL_SALES.COGS_US
WF_RETAIL.WF_RETAIL_SALES.REVENUE_US
BY WF_RETAIL.WF_RETAIL_PRODUCT.PRODUCT_CATEGORY
BY WF_RETAIL.WF_RETAIL_PRODUCT.BRAND
WHERE WF_RETAIL.WF_RETAIL_SALES.COGS_US GT
WF_RETAIL.WF_RETAIL_SALES.REVENUE_US;
ON TABLE HOLD
ON TABLE NOTOTAL
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET SQUEEZE ON
ON TABLE SET EMPTYREPORT ON
ON TABLE SET HTMLENS ON
ON TABLE SET HTMLENCODE ON
ON TABLE SET CACHELINES 100
END
/* end of the test report
-* start of the test
-RUN
-IF &LINES EQ 0 GOTO ALERTEXIT;
-* end of the test
-* start of the output report
ENGINE INT CACHE SET ON
-"COMPONENT=Define_wf_retail"
DEFINE FILE ibisamp/wf_retail
Loss/D12.2=WF_RETAIL.WF_RETAIL_SALES.REVENUE_US -
WF_RETAIL.WF_RETAIL_SALES.COGS_US;
END
-DEFAULTH &WF_SUMMARY='Summary';
-DEFAULTH &WF_TITLE='WebFOCUS Report';
TABLE FILE ibisamp/wf_retail
SUM WF_RETAIL.WF_RETAIL_SALES.QUANTITY_SOLD
Loss
BY WF_RETAIL.WF_RETAIL_PRODUCT.BRAND
ACROSS WF_RETAIL.WF_RETAIL_TIME_SALES.TIME_QTR
WHERE WF_RETAIL.WF_RETAIL_SALES.COGS_US GT
WF_RETAIL.WF_RETAIL_SALES.REVENUE_US;
ON TABLE SUBHEAD
"Brand Revenue Loss"
ON TABLE FCHOLD FORMAT HTML
ON TABLE NOTOTAL
ON TABLE SET CACHELINES 100
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET SQUEEZE ON
ON TABLE SET HTMLCSS ON
ON TABLE SET HTMLENCODE ON
ON TABLE SET EMPTYREPORT ON
ON TABLE SET GRWIDTH 1
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/ENIADefault_combine.sty,$
TYPE=REPORT, TITLETEXT=&WF_TITLE.QUOTEDSTRING, SUMMARY=&WF_SUMMARY.QUOTEDSTRING, HFREEZE=OFF, $
TYPE=TABHEADING, LINE=1, JUSTIFY=CENTER, $
TYPE=TABHEADING, LINE=1, ITEM=1, OBJECT=TEXT, SIZE=14, STYLE=BOLD+ITALIC, $
ENDSTYLE
END
-* end of the output report
-* start of the options
-* end of the options
-ALERTEXIT
-* Finished by Alert Assist

**Procedure:**  How to Launch WebFOCUS Alert Assist

1. Sign in to WebFOCUS as an administrator or developer.
2. If you are working with the Hub or the WebFOCUS Home Page, launch WebFOCUS Alert Assist in one of the following ways:

- From the WebFOCUS Hub, select the Workspaces area. Select the workspace in which you want to create the alert, and in the +Content menu, point to Other, and click Alert.

- From the WebFOCUS Home Page, select the Workspaces area. Select the workspace in which you want to create the alert. If the +Content menu is visible, point to Other, and click Alert. If the Action bar is visible, click Alert.

- From the Legacy Home Page, in the Resources tree, right-click the workspace or folder where you want the alert to reside, point to New, and then click Alert.

WebFOCUS Alert Assist opens.

3. If you are working with the Legacy Home page, launch WebFOCUS Alert Assist by performing the following steps:

- In the Resources tree, right-click the workspace or folder where you want the alert to reside, point to New, and then click Alert.

The Tool Setup dialog box opens. It provides options for selecting a WebFOCUS Reporting Server and Application Paths.

**Note:** User access to the Tool Setup dialog box to specify WebFOCUS Reporting Server properties is controlled by a WebFOCUS security privilege. For information on WebFOCUS security privileges, see the *TIBCO WebFOCUS® Security and Administration* manual.
Select a WebFOCUS Reporting Server and Application Paths when not using the default WebFOCUS Reporting Server specified in the TIBCO WebFOCUS® Client configuration or the default application path for that WebFOCUS Reporting Server, as shown in the following image.

![Tool Setup dialog box](image)

**Note:** The Tool Setup dialog box is only available on the Legacy Home Page. On the WebFOCUS Home Page, you must set a WebFOCUS Reporting Server and Application Paths on the folder level in the Properties prior to creating content.

Click OK.

WebFOCUS Alert Assist opens.
Alert Assist Overview

When you create an Alert in the web browser, it invokes Alert Assist and then InfoAssist. Alert Assist has a user interface similar to InfoAssist. The following image shows the WebFOCUS Alert Assist interface.

![Alert Assist Main Menu](image)

Alert Assist Main Menu

In the upper-left corner of the browser window is the Main menu button, which provides access to the Alert Assist Main Menu. This menu contains the Save, Save As, Run, Close, and Exit options. Some of these options are also on the Alert Assist Quick Access toolbar.
The following image shows the expanded Alert Assist Main Menu.

**Save**

Saves the Alert. This option is disabled until both parts of the Alert are created.

**Save As**

Saves the current Alert with a new name. The Save As dialog box displays a field where you can type the new name. This option is disabled until both parts of the Alert are created.

**Run**

Submits the Alert procedure to the WebFOCUS Reporting Server. This option is active when both parts of the Alert have been created. The output always opens in a new browser.

**Close**

Closes the current Alert and prompts you to save any changes.

**Exit**

Exits the Alert Assist and prompts you to save any pending changes to the open Alert.
**Alert Assist Quick Launch Toolbar**

The Alert Assist Quick Launch toolbar contains the following buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Saves the Alert. This option is disabled until both parts of the Alert are created.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Reverts back by undoing one action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Moves forward by redoing one action.</td>
</tr>
<tr>
<td><img src="image" alt="Display" /></td>
<td>Displays the Alert procedure code in a read-only window.</td>
</tr>
<tr>
<td><img src="image" alt="Run" /></td>
<td>Submits the entire Alert procedure to the WebFOCUS Reporting Server. This option is active when both parts of the Alert have been created. The output always opens in a new browser.</td>
</tr>
</tbody>
</table>

**Ribbon**

Under the Alert Assist Quick Access toolbar is a ribbon. When Alert Assist first opens, none of the ribbon options are activated.
You must select the Test node or Result node to activate the New option, as shown in the following image.

You must create a Test to activate the remaining options, as shown in the following image.
The ribbon contains the following options:

**Navigation Group**

**New**
Displays a menu from which you can choose to create a new WebFOCUS report or WebFOCUS test, open an existing report, or test for file existence. This button is active when the Test node or Result node is selected. You can also find these options in the shortcut menus for the Test node and Result node.

**Open**
Invokes InfoAssist so that you can make changes to the report when an Alert test or Alert result is selected. The Open option is only activated after a report test is created.

**Edit**
Opens the report on FILENAME data source dialog box when an Alert test or Alert result is selected. You can then edit the report in a text editor.

**Run**
Runs the report in a new browser window when an Alert test or Alert result is selected.

**Delete Group**

**Delete**
Removes the report from the Test or Result node.

**The Life of an Alert**
Authorized users can run an Alert test interactively and optionally schedule it to be distributed by ReportCaster.
The following image shows basic Alert processing.

1. The developer, using Alert Assist or the Alert Wizard, creates an Alert test and designs the report that is run if the Alert condition is true.
2. If the Alert test is true, the WebFOCUS Reporting Server runs the Alert result.
3. If the Alert test is false, the Alert result is not run.
The following image shows scheduled Alert processing.

1. The developer, using Alert Assist or the Alert Wizard, creates an Alert test and designs the report that is run if the Alert condition is true.

2. If desired, an Alert schedule is created using ReportCaster.


4. When the ReportCaster Distribution Server processes a scheduled Alert procedure, it is submitted to the WebFOCUS Reporting Server to evaluate if the Alert test is true.
   a. If the Alert test is false, the Alert is returned to the queue for the next scheduled time.
   b. If the Alert test is true, the WebFOCUS Reporting Server runs the Alert result and returns the results to the ReportCaster Distribution Server. The ReportCaster Distribution Server distributes the Alert result to the recipients, as specified in the schedule.

Creating and Scheduling an Alert

The following procedures describe how to create an Alert test, and Alert result using Alert Assist, and how to schedule an Alert with ReportCaster.
Procedure:  How to Create an Alert Test

1. In the Alert Assist main window, right-click the Test node, and then point to New, as shown in the following image.

2. Select one of the following options:

   - **WebFOCUS Test.** Allows you to create a new report in a scaled-down version of InfoAssist. Proceed to step 3.

   - **Test for File Existence.** Allows you to select an existing report. Proceed to step 6.

   **Note:** The scaled-down version of InfoAssist is used to create basic TABLE requests with HOLD (not PCHOLD FORMAT) statements. It generates procedure syntax that is written to the Alert the same way as in earlier WebFOCUS releases. The Edit option on the ribbon allows you to open the editor and manually enter the procedure code or edit existing procedure code. When the test is saved from the editor, the syntax needs to be validated as having an ON TABLE HOLD statement, a prerequisite for an Alert test.

3. When you select WebFOCUS Test, InfoAssist opens. Select a Master File from the Open dialog box.

4. Create your report as desired, and then save it.

5. Close InfoAssist to return to Alert Assist.

6. When you select Test for File Existence, type the full path to the file accessible to the WebFOCUS Reporting Server that you want to check exists. Do not use a file name or folder path that includes spaces.
Testing a folder for existence is also valid. Type the full path to the folder accessible to the WebFOCUS Reporting Server. If the file is located, the Alert is triggered (true) and the Alert result report is run.

7. Click OK to save the Alert test.

**Procedure: How to Create an Alert Result**

1. In the Alert Assist main window, right-click the Result node and point to New, as shown in the following image.

2. Select one of the following options:

   - **New Report.** Allows you to create a new report, chart, document, or dashboard, using the full version of InfoAssist. Proceed to step 3.
   
   - **Existing Report.** Allows you to choose from the existing reports in the tree. Proceed to step 5.

3. If you select New Report, the Open dialog box opens. Select a Master File.

   InfoAssist opens, and you can create the report that will be run when the Alert test is triggered (true).

4. Save your report, and close the InfoAssist window to return to Alert Assist. Proceed to step 9.
5. If you select *Existing Report*, the Open dialog box opens. Select a report you are authorized to run from the tree.

6. Click *Open*.

   The Open dialog box closes and the selected report appears under the Result node.

7. Select *Save* from the Alert Assist menu. The Save As dialog box opens.

8. Type the Alert Title, and click *OK*.


   The Alert result is automatically run if the Alert test report is triggered (true). If you are authorized to schedule reports for distribution, you can optionally schedule the Alert.

**Note:** As you use Alert Assist to create reports, you may see messages that state Report Saved. Your changes to the report have been saved, but they are not written to the WebFOCUS Repository until the Alert is saved. If you exit Alert Assist before you click *Save* in the Alert Assist menu, the Alert is not saved.

**Procedure:** How to Schedule an Alert

1. Access the scheduling tool in one of the following ways:

   - From the WebFOCUS Hub, select the Workspaces area. Right-click the alert that you created, point to *Schedule*, and select a distribution method.

   - From the WebFOCUS Home page, right-click the alert, point to *Schedule*, and click the distribution method for your alert schedule. If the Action Bar is visible, you can also click the Schedule category, and then click *Schedule*.

   - From the Legacy Home Page, in the Resources tree, click the domain or folder where the Alert resides. In the WebFOCUS Explorer, click the Alert and then click *Schedule*. Select how the Alert report will be distributed when the Alert test is triggered (true).
The ReportCaster Basic Scheduling tool opens in a new browser window, as shown in the following image.

For more information on the Basic Scheduling tool and distribution options, see the *TIBCO WebFOCUS® ReportCaster Guide*.

2. Click Alert.

The Alert Options dialog box opens, as shown in the following image.
3. Select one of the following Alert Options:

- **Automatically Reset.** This option continues to run the schedule at the specified time and checks to confirm that the Alert test is no longer true before the Alert test is evaluated again. It is best to use this option when you do not want to receive the Alert result again until after the exception condition has been addressed and occurs again. For example, when the quantity in inventory is greater than 20,000, the Alert is triggered. You do not want to receive the report again until after the inventory is less than or equal to 20,000 for all products and then goes back over 20,000 again.

- **Continue After Alert.** This option continues to run the schedule at the specified time and distribute the report each time that the Alert test is true. It is best to use this option when you want to be notified at the interval specified in the schedule that the Alert test is true.

- **Deactivate Schedule After Alert.** This option deactivates the schedule after the Alert is triggered. The schedule has to be activated again for the Alert test to run after the Alert is triggered. It is best to use this option for one-time Alert tests. This is the default value.

- **Delay.** This option is best used when you want to allow a specific period of time to address the Alert test but want to be notified again if the Alert test has not been met. You can restart the Alert after a maximum of 99 hours, days, weeks, months, or years. For more information, see the TIBCO WebFOCUS® ReportCaster Guide technical content.

As you complete the creation of the schedule, remember to consider the burst option to distribute specific report values, instead of the entire report. When a report is burst, the distribution information must be provided in a distribution list, distribution file, or dynamic list for email distribution and an access list for library distribution. The email and library distribution options are the most effective for Alert reports because of the push versus pull notification through email. For more information on using the burst option in ReportCaster, see the TIBCO WebFOCUS® ReportCaster Guide.

4. Select the Properties tab and type a title and summary for the scheduled report.

5. Click Recurrence and specify when and how often to run the schedule.

   For more information on Recurrence options, see the TIBCO WebFOCUS® ReportCaster Guide.

6. Click Distribution and specify the destination information for where you want the report to be distributed. For more information on specifying schedule distribution information, see the TIBCO WebFOCUS® ReportCaster Guide.
7. If you wish to receive notifications of the Alert distribution, click Notification and specify the destination information for where you want the notification to be sent.

8. If your Alert uses parameters, check Parameters to review and specify parameter values. Ensure that you have the correct Path, Procedure, and Server Name. For more information on specifying parameter values when scheduling a report procedure (FEX), see the TIBCO WebFOCUS® ReportCaster Guide.

9. Click Save and close the ReportCaster Basic Scheduling tool.

   The schedule report now appears in the repository, and you can access it from the Hub or Home Page.

Checking Scheduled Alerts

When an Alert test is false (and therefore not activated), the Alert result report is not run. When an Alert schedule runs, information about the Alert test evaluation (true or false) and any error or warning messages that occur during schedule or Alert processing are written to the log file.

In order to track the completion of a scheduled Alert, or errors that occurred during processing without checking the log report for the Alert schedule, we recommend that you use the Schedule Notification option.

In the Scheduling tool, the Notification tab allows you to specify:

- The terms for supplying notification (Never, which is the default value, Always, or On Error).
- The level of detail in the notification (full notification or brief notification).
- The email addresses to distribute the notification information to.
SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, FOCUS, iWay, Omni-Gen, Omni-HealthData, and WebFOCUS are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle Corporation and/or its affiliates.

All other product and company names and marks mentioned in this document are the property of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms for a specific software version are released at the same time. See the readme file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.